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Abstract

				This document provides information and procedures relevant to Red Hat Virtualization administrators.
			






Chapter 1. Administering and Maintaining the Red Hat Virtualization Environment




			The Red Hat Virtualization environment requires an administrator to keep it running. As an administrator, your tasks include:
		
	
					Managing physical and virtual resources such as hosts and virtual machines. This includes upgrading and adding hosts, importing domains, converting virtual machines created on foreign hypervisors, and managing virtual machine pools.
				
	
					Monitoring the overall system resources for potential problems such as extreme load on one of the hosts, insufficient memory or disk space, and taking any necessary actions (such as migrating virtual machines to other hosts to lessen the load or freeing resources by shutting down machines).
				
	
					Responding to the new requirements of virtual machines (for example, upgrading the operating system or allocating more memory).
				
	
					Managing customized object properties using tags.
				
	
					Managing searches saved as public bookmarks.
				
	
					Managing user setup and setting permission levels.
				
	
					Troubleshooting for specific users or virtual machines for overall system functionality.
				
	
					Generating general and specific reports.
				


Global Configuration




				Accessed by clicking Administration → Configure, the Configure window allows you to configure a number of global resources for your Red Hat Virtualization environment, such as users, roles, system permissions, scheduling policies, instance types, and MAC address pools. This window allows you to customize the way in which users interact with resources in the environment, and provides a central location for configuring options that can be applied to multiple clusters.
			
Roles




					Roles are predefined sets of privileges that can be configured from Red Hat Virtualization Manager. Roles provide access and management permissions to different levels of resources in the data center, and to specific physical and virtual resources.
				

					With multilevel administration, any permissions which apply to a container object also apply to all individual objects within that container. For example, when a host administrator role is assigned to a user on a specific host, the user gains permissions to perform any of the available host operations, but only on the assigned host. However, if the host administrator role is assigned to a user on a data center, the user gains permissions to perform host operations on all hosts within the cluster of the data center.
				
Creating a New Role




						If the role you require is not on Red Hat Virtualization’s default list of roles, you can create a new role and customize it to suit your purposes.
					
Procedure
	
								Click Administration → Configure. This opens the Configure window. The Roles tab is selected by default, showing a list of default User and Administrator roles, and any custom roles.
							
	
								Click New.
							
	
								Enter the Name and Description of the new role.
							
	
								Select either Admin or User as the Account Type.
							
	
								Use the Expand All or Collapse All buttons to view more or fewer of the permissions for the listed objects in the Check Boxes to Allow Action list. You can also expand or collapse the options for each object.
							
	
								For each of the objects, select or clear the actions you want to permit or deny for the role you are setting up.
							
	
								Click OK to apply the changes. The new role displays on the list of roles.
							



Editing or Copying a Role




						You can change the settings for roles you have created, but you cannot change default roles. To change default roles, clone and modify them to suit your requirements.
					
Procedure
	
								Click Administration → Configure. This opens the Configure window, which shows a list of default User and Administrator roles, as well as any custom roles.
							
	
								Select the role you wish to change.
							
	
								Click Edit or Copy. This opens the Edit Role or Copy Role window.
							
	
								If necessary, edit the Name and Description of the role.
							
	
								Use the Expand All or Collapse All buttons to view more or fewer of the permissions for the listed objects. You can also expand or collapse the options for each object.
							
	
								For each of the objects, select or clear the actions you wish to permit or deny for the role you are editing.
							
	
								Click OK to apply the changes you have made.
							



User Role and Authorization Examples




						The following examples illustrate how to apply authorization controls for various scenarios, using the different features of the authorization system described in this chapter.
					
Example 1.1. Cluster Permissions

							Sarah is the system administrator for the accounts department of a company. All the virtual resources for her department are organized under a Red Hat Virtualization cluster called Accounts. She is assigned the ClusterAdmin role on the accounts cluster. This enables her to manage all virtual machines in the cluster, since the virtual machines are child objects of the cluster. Managing the virtual machines includes editing, adding, or removing virtual resources such as disks, and taking snapshots. It does not allow her to manage any resources outside this cluster. Because ClusterAdmin is an administrator role, it allows her to use the Administration Portal or the VM Portal to manage these resources.
						


Example 1.2. VM PowerUser Permissions

							John is a software developer in the accounts department. He uses virtual machines to build and test his software. Sarah has created a virtual desktop called johndesktop for him. John is assigned the UserVmManager role on the johndesktop virtual machine. This allows him to access this single virtual machine using the VM Portal. Because he has UserVmManager permissions, he can modify the virtual machine. Because UserVmManager is a user role, it does not allow him to use the Administration Portal.
						


Example 1.3. Data Center Power User Role Permissions

							Penelope is an office manager. In addition to her own responsibilities, she occasionally helps the HR manager with recruitment tasks, such as scheduling interviews and following up on reference checks. As per corporate policy, Penelope needs to use a particular application for recruitment tasks.
						

							While Penelope has her own machine for office management tasks, she wants to create a separate virtual machine to run the recruitment application. She is assigned PowerUserRole permissions for the data center in which her new virtual machine will reside. This is because to create a new virtual machine, she needs to make changes to several components within the data center, including creating the virtual disk in the storage domain.
						

							Note that this is not the same as assigning DataCenterAdmin privileges to Penelope. As a PowerUser for a data center, Penelope can log in to the VM Portal and perform virtual machine-specific actions on virtual machines within the data center. She cannot perform data center-level operations such as attaching hosts or storage to a data center.
						


Example 1.4. Network Administrator Permissions

							Chris works as the network administrator in the IT department. Her day-to-day responsibilities include creating, manipulating, and removing networks in the department’s Red Hat Virtualization environment. For her role, she requires administrative privileges on the resources and on the networks of each resource. For example, if Chris has NetworkAdmin privileges on the IT department’s data center, she can add and remove networks in the data center, and attach and detach networks for all virtual machines belonging to the data center.
						


Example 1.5. Custom Role Permissions

							Rachel works in the IT department, and is responsible for managing user accounts in Red Hat Virtualization. She needs permission to add user accounts and assign them the appropriate roles and permissions. She does not use any virtual machines herself, and should not have access to administration of hosts, virtual machines, clusters or data centers. There is no built-in role which provides her with this specific set of permissions. A custom role must be created to define the set of permissions appropriate to Rachel’s position.
						
Figure 1.1. UserManager Custom Role
[image: UserManager Custom Role]



							The UserManager custom role shown above allows manipulation of users, permissions and roles. These actions are organized under System - the top level object of the hierarchy shown in Object Hierarchy. This means they apply to all other objects in the system. The role is set to have an Account Type of Admin. This means that when she is assigned this role, Rachel can use both the Administration Portal and the VM Portal.
						




System Permissions




					Permissions enable users to perform actions on objects, where objects are either individual objects or container objects. Any permissions that apply to a container object also apply to all members of that container.
				
Figure 1.2. Permissions & Roles
[image: Permissions and Roles]


Figure 1.3. Red Hat Virtualization Object Hierarchy
[image: Object Hierarchy]


User Properties




						Roles and permissions are the properties of the user. Roles are predefined sets of privileges that permit access to different levels of physical and virtual resources. Multilevel administration provides a finely grained hierarchy of permissions. For example, a data center administrator has permissions to manage all objects in the data center, while a host administrator has system administrator permissions to a single physical host. A user can have permissions to use a single virtual machine but not make any changes to the virtual machine configurations, while another user can be assigned system permissions to a virtual machine.
					

User and Administrator Roles




						Red Hat Virtualization provides a range of pre-configured roles, from an administrator with system-wide permissions to an end user with access to a single virtual machine. While you cannot change or remove the default roles, you can clone and customize them, or create new roles according to your requirements. There are two types of roles:
					
	
								Administrator Role: Allows access to the Administration Portal for managing physical and virtual resources. An administrator role confers permissions for actions to be performed in the VM Portal; however, it has no bearing on what a user can see in the VM Portal.
							
	
								User Role: Allows access to the VM Portal for managing and accessing virtual machines and templates. A user role determines what a user can see in the VM Portal. Permissions granted to a user with an administrator role are reflected in the actions available to that user in the VM Portal.
							



User Roles Explained




						The table below describes basic user roles which confer permissions to access and configure virtual machines in the VM Portal.
					
Table 1.1. Red Hat Virtualization User Roles - Basic
	Role	Privileges	Notes
	 
										UserRole
									

									 	 
										Can access and use virtual machines and pools.
									

									 	 
										Can log in to the VM Portal, use assigned virtual machines and pools, view virtual machine state and details.
									

									 
	 
										PowerUserRole
									

									 	 
										Can create and manage virtual machines and templates.
									

									 	 
										Apply this role to a user for the whole environment with the Configure window, or for specific data centers or clusters. For example, if a PowerUserRole is applied on a data center level, the PowerUser can create virtual machines and templates in the data center.
									

									 
	 
										UserVmManager
									

									 	 
										System administrator of a virtual machine.
									

									 	 
										Can manage virtual machines and create and use snapshots. A user who creates a virtual machine in the VM Portal is automatically assigned the UserVmManager role on the machine.
									

									 




						The table below describes advanced user roles which allow you to do more fine tuning of permissions for resources in the VM Portal.
					
Table 1.2. Red Hat Virtualization User Roles - Advanced
	Role	Privileges	Notes
	 
										UserTemplateBasedVm
									

									 	 
										Limited privileges to only use Templates.
									

									 	 
										Can use templates to create virtual machines.
									

									 
	 
										DiskOperator
									

									 	 
										Virtual disk user.
									

									 	 
										Can use, view and edit virtual disks. Inherits permissions to use the virtual machine to which the virtual disk is attached.
									

									 
	 
										VmCreator
									

									 	 
										Can create virtual machines in the VM Portal.
									

									 	 
										This role is not applied to a specific virtual machine; apply this role to a user for the whole environment with the Configure window. Alternatively apply this role for specific data centers or clusters. When applying this role to a cluster, you must also apply the DiskCreator role on an entire data center, or on specific storage domains.
									

									 
	 
										TemplateCreator
									

									 	 
										Can create, edit, manage and remove virtual machine templates within assigned resources.
									

									 	 
										This role is not applied to a specific template; apply this role to a user for the whole environment with the Configure window. Alternatively apply this role for specific data centers, clusters, or storage domains.
									

									 
	 
										DiskCreator
									

									 	 
										Can create, edit, manage and remove virtual disks within assigned clusters or data centers.
									

									 	 
										This role is not applied to a specific virtual disk; apply this role to a user for the whole environment with the Configure window. Alternatively apply this role for specific data centers or storage domains.
									

									 
	 
										TemplateOwner
									

									 	 
										Can edit and delete the template, assign and manage user permissions for the template.
									

									 	 
										This role is automatically assigned to the user who creates a template. Other users who do not have TemplateOwner permissions on a template cannot view or use the template.
									

									 
	 
										VnicProfileUser
									

									 	 
										Logical network and network interface user for virtual machine and template.
									

									 	 
										Can attach or detach network interfaces from specific logical networks.
									

									 




Administrator Roles Explained




						The table below describes basic administrator roles which confer permissions to access and configure resources in the Administration Portal.
					
Table 1.3. Red Hat Virtualization System Administrator Roles - Basic
	Role	Privileges	Notes
	 
										SuperUser
									

									 	 
										System Administrator of the Red Hat Virtualization environment.
									

									 	 
										Has full permissions across all objects and levels, can manage all objects across all data centers.
									

									 
	 
										ClusterAdmin
									

									 	 
										Cluster Administrator.
									

									 	 
										Possesses administrative permissions for all objects underneath a specific cluster.
									

									 
	 
										DataCenterAdmin
									

									 	 
										Data Center Administrator.
									

									 	 
										Possesses administrative permissions for all objects underneath a specific data center except for storage.
									

									 



Important

							Do not use the administrative user for the directory server as the Red Hat Virtualization administrative user. Create a user in the directory server specifically for use as the Red Hat Virtualization administrative user.
						


						The table below describes advanced administrator roles which allow you to do more fine tuning of permissions for resources in the Administration Portal.
					
Table 1.4. Red Hat Virtualization System Administrator Roles - Advanced
	Role	Privileges	Notes
	 
										TemplateAdmin
									

									 	 
										Administrator of a virtual machine template.
									

									 	 
										Can create, delete, and configure the storage domains and network details of templates, and move templates between domains.
									

									 
	 
										StorageAdmin
									

									 	 
										Storage Administrator.
									

									 	 
										Can create, delete, configure, and manage an assigned storage domain.
									

									 
	 
										HostAdmin
									

									 	 
										Host Administrator.
									

									 	 
										Can attach, remove, configure, and manage a specific host.
									

									 
	 
										NetworkAdmin
									

									 	 
										Network Administrator.
									

									 	 
										Can configure and manage the network of a particular data center or cluster. A network administrator of a data center or cluster inherits network permissions for virtual pools within the cluster.
									

									 
	 
										VmPoolAdmin
									

									 	 
										System Administrator of a virtual pool.
									

									 	 
										Can create, delete, and configure a virtual pool; assign and remove virtual pool users; and perform basic operations on a virtual machine in the pool.
									

									 
	 
										GlusterAdmin
									

									 	 
										Gluster Storage Administrator.
									

									 	 
										Can create, delete, configure, and manage Gluster storage volumes.
									

									 
	 
										VmImporterExporter
									

									 	 
										Import and export Administrator of a virtual machine.
									

									 	 
										Can import and export virtual machines. Able to view all virtual machines and templates exported by other users.
									

									 




Assigning an Administrator or User Role to a Resource




						Assign administrator or user roles to resources to allow users to access or manage that resource.
					
Procedure
	
								Find and click the resource’s name. This opens the details view.
							
	
								Click the Permissions tab to list the assigned users, each user’s role, and the inherited permissions for the selected resource.
							
	
								Click Add.
							
	
								Enter the name or user name of an existing user into the Search text box and click Go. Select a user from the resulting list of possible matches.
							
	
								Select a role from the Role to Assign drop-down list.
							
	
								Click OK.
							



						The user now has the inherited permissions of that role enabled for that resource.
					
Important

							Avoid assigning global permissions to regular users on resources such as clusters because permissions are automatically inherited by resources that are lower in a system’s hierarchy. Set UserRole and all other user role permissions on specific resources such as virtual machines, pools or virtual machine pools, especially the latter.
						

							Assigning global permissions can cause two problems due to the inheritance of permissions:
						
	
									A regular user can automatically be granted permission to control virtual machine pools, even if the administrator assigning permissions did not intend for this to happen.
								
	
									The virtual machine portal might behave unexpectedly with pools.
								



							Therefore, it is strongly recommended to set UserRole and all other user role permissions on specific resources only, especially virtual machine pool resources, and not on resources from which other resources inherit permissions.
						


Removing an Administrator or User Role from a Resource




						Remove an administrator or user role from a resource; the user loses the inherited permissions associated with the role for that resource.
					
Procedure
	
								Find and click the resource’s name. This opens the details view.
							
	
								Click the Permissions tab to list the assigned users, the user’s role, and the inherited permissions for the selected resource.
							
	
								Select the user to remove from the resource.
							
	
								Click Remove.
							
	
								Click OK.
							



Managing System Permissions for a Data Center




						As the SuperUser, the system administrator manages all aspects of the Administration Portal. More specific administrative roles can be assigned to other users. These restricted administrator roles are useful for granting a user administrative privileges that limit them to a specific resource. For example, a DataCenterAdmin role has administrator privileges only for the assigned data center with the exception of the storage for that data center, and a ClusterAdmin has administrator privileges only for the assigned cluster.
					

						A data center administrator is a system administration role for a specific data center only. This is useful in virtualization environments with multiple data centers where each data center requires an administrator. The DataCenterAdmin role is a hierarchical model; a user assigned the data center administrator role for a data center can manage all objects in the data center with the exception of storage for that data center. Use the Configure button in the header bar to assign a data center administrator for all data centers in the environment.
					

						The data center administrator role permits the following actions:
					
	
								Create and remove clusters associated with the data center.
							
	
								Add and remove hosts, virtual machines, and pools associated with the data center.
							
	
								Edit user permissions for virtual machines associated with the data center.
							


Note

							You can only assign roles and permissions to existing users.
						


						You can change the system administrator of a data center by removing the existing system administrator and adding the new system administrator.
					

Data Center Administrator Roles Explained




						Data Center Permission Roles
					

						The table below describes the administrator roles and privileges applicable to data center administration.
					
Table 1.5. Red Hat Virtualization System Administrator Roles
	Role	Privileges	Notes
	 
										DataCenterAdmin
									

									 	 
										Data Center Administrator
									

									 	 
										Can use, create, delete, manage all physical and virtual resources within a specific data center except for storage, including clusters, hosts, templates and virtual machines.
									

									 
	 
										NetworkAdmin
									

									 	 
										Network Administrator
									

									 	 
										Can configure and manage the network of a particular data center. A network administrator of a data center inherits network permissions for virtual machines within the data center as well.
									

									 




Managing System Permissions for a Cluster




						As the SuperUser, the system administrator manages all aspects of the Administration Portal. More specific administrative roles can be assigned to other users. These restricted administrator roles are useful for granting a user administrative privileges that limit them to a specific resource. For example, a DataCenterAdmin role has administrator privileges only for the assigned data center with the exception of the storage for that data center, and a ClusterAdmin has administrator privileges only for the assigned cluster.
					

						A cluster administrator is a system administration role for a specific cluster only. This is useful in data centers with multiple clusters, where each cluster requires a system administrator. The ClusterAdmin role is a hierarchical model: a user assigned the cluster administrator role for a cluster can manage all objects in the cluster. Use the Configure button in the header bar to assign a cluster administrator for all clusters in the environment.
					

						The cluster administrator role permits the following actions:
					
	
								Create and remove associated clusters.
							
	
								Add and remove hosts, virtual machines, and pools associated with the cluster.
							
	
								Edit user permissions for virtual machines associated with the cluster.
							


Note

							You can only assign roles and permissions to existing users.
						


						You can also change the system administrator of a cluster by removing the existing system administrator and adding the new system administrator.
					

Cluster Administrator Roles Explained




						Cluster Permission Roles
					

						The table below describes the administrator roles and privileges applicable to cluster administration.
					
Table 1.6. Red Hat Virtualization System Administrator Roles
	Role	Privileges	Notes
	 
										ClusterAdmin
									

									 	 
										Cluster Administrator
									

									 	 
										Can use, create, delete, manage all physical and virtual resources in a specific cluster, including hosts, templates and virtual machines. Can configure network properties within the cluster such as designating display networks, or marking a network as required or non-required.
									

									 
										However, a ClusterAdmin does not have permissions to attach or detach networks from a cluster, to do so NetworkAdmin permissions are required.
									

									 
	 
										NetworkAdmin
									

									 	 
										Network Administrator
									

									 	 
										Can configure and manage the network of a particular cluster. A network administrator of a cluster inherits network permissions for virtual machines within the cluster as well.
									

									 




Managing System Permissions for a Network




						As the SuperUser, the system administrator manages all aspects of the Administration Portal. More specific administrative roles can be assigned to other users. These restricted administrator roles are useful for granting a user administrative privileges that limit them to a specific resource. For example, a DataCenterAdmin role has administrator privileges only for the assigned data center with the exception of the storage for that data center, and a ClusterAdmin has administrator privileges only for the assigned cluster.
					

						A network administrator is a system administration role that can be applied for a specific network, or for all networks on a data center, cluster, host, virtual machine, or template. A network user can perform limited administration roles, such as viewing and attaching networks on a specific virtual machine or template. You can use the Configure button in the header bar to assign a network administrator for all networks in the environment.
					

						The network administrator role permits the following actions:
					
	
								Create, edit and remove networks.
							
	
								Edit the configuration of the network, including configuring port mirroring.
							
	
								Attach and detach networks from resources including clusters and virtual machines.
							



						The user who creates a network is automatically assigned NetworkAdmin permissions on the created network. You can also change the administrator of a network by removing the existing administrator and adding the new administrator.
					

Network Administrator and User Roles Explained




						Network Permission Roles
					

						The table below describes the administrator and user roles and privileges applicable to network administration.
					
Table 1.7. Red Hat Virtualization Network Administrator and User Roles
	Role	Privileges	Notes
	 
										NetworkAdmin
									

									 	 
										Network Administrator for data center, cluster, host, virtual machine, or template. The user who creates a network is automatically assigned NetworkAdmin permissions on the created network.
									

									 	 
										Can configure and manage the network of a particular data center, cluster, host, virtual machine, or template. A network administrator of a data center or cluster inherits network permissions for virtual pools within the cluster. To configure port mirroring on a virtual machine network, apply the NetworkAdmin role on the network and the UserVmManager role on the virtual machine.
									

									 
	 
										VnicProfileUser
									

									 	 
										Logical network and network interface user for virtual machine and template.
									

									 	 
										Can attach or detach network interfaces from specific logical networks.
									

									 




Managing System Permissions for a Host




						As the SuperUser, the system administrator manages all aspects of the Administration Portal. More specific administrative roles can be assigned to other users. These restricted administrator roles are useful for granting a user administrative privileges that limit them to a specific resource. For example, a DataCenterAdmin role has administrator privileges only for the assigned data center with the exception of the storage for that data center, and a ClusterAdmin has administrator privileges only for the assigned cluster.
					

						A host administrator is a system administration role for a specific host only. This is useful in clusters with multiple hosts, where each host requires a system administrator. You can use the Configure button in the header bar to assign a host administrator for all hosts in the environment.
					

						The host administrator role permits the following actions:
					
	
								Edit the configuration of the host.
							
	
								Set up the logical networks.
							
	
								Remove the host.
							



						You can also change the system administrator of a host by removing the existing system administrator and adding the new system administrator.
					

Host Administrator Roles Explained




						Host Permission Roles
					

						The table below describes the administrator roles and privileges applicable to host administration.
					
Table 1.8. Red Hat Virtualization System Administrator Roles
	Role	Privileges	Notes
	 
										HostAdmin
									

									 	 
										Host Administrator
									

									 	 
										Can configure, manage, and remove a specific host. Can also perform network-related operations on a specific host.
									

									 




Managing System Permissions for a Storage Domain




						As the SuperUser, the system administrator manages all aspects of the Administration Portal. More specific administrative roles can be assigned to other users. These restricted administrator roles are useful for granting a user administrative privileges that limit them to a specific resource. For example, a DataCenterAdmin role has administrator privileges only for the assigned data center with the exception of the storage for that data center, and a ClusterAdmin has administrator privileges only for the assigned cluster.
					

						A storage administrator is a system administration role for a specific storage domain only. This is useful in data centers with multiple storage domains, where each storage domain requires a system administrator. Use the Configure button in the header bar to assign a storage administrator for all storage domains in the environment.
					

						The storage domain administrator role permits the following actions:
					
	
								Edit the configuration of the storage domain.
							
	
								Move the storage domain into maintenance mode.
							
	
								Remove the storage domain.
							


Note

							You can only assign roles and permissions to existing users.
						


						You can also change the system administrator of a storage domain by removing the existing system administrator and adding the new system administrator.
					

Storage Administrator Roles Explained




						Storage Domain Permission Roles
					

						The table below describes the administrator roles and privileges applicable to storage domain administration.
					
Table 1.9. Red Hat Virtualization System Administrator Roles
	Role	Privileges	Notes
	 
										StorageAdmin
									

									 	 
										Storage Administrator
									

									 	 
										Can create, delete, configure and manage a specific storage domain.
									

									 
	 
										GlusterAdmin
									

									 	 
										Gluster Storage Administrator
									

									 	 
										Can create, delete, configure and manage Gluster storage volumes.
									

									 




Managing System Permissions for a Virtual Machine Pool




						As the SuperUser, the system administrator manages all aspects of the Administration Portal. More specific administrative roles can be assigned to other users. These restricted administrator roles are useful for granting a user administrative privileges that limit them to a specific resource. For example, a DataCenterAdmin role has administrator privileges only for the assigned data center with the exception of the storage for that data center, and a ClusterAdmin has administrator privileges only for the assigned cluster.
					

						A virtual machine pool administrator is a system administration role for virtual machine pools in a data center. This role can be applied to specific virtual machine pools, to a data center, or to the whole virtualized environment; this is useful to allow different users to manage certain virtual machine pool resources.
					

						The virtual machine pool administrator role permits the following actions:
					
	
								Create, edit, and remove pools.
							
	
								Add and detach virtual machines from the pool.
							


Note

							You can only assign roles and permissions to existing users.
						


Virtual Machine Pool Administrator Roles Explained




						Pool Permission Roles
					

						The table below describes the administrator roles and privileges applicable to pool administration.
					
Table 1.10. Red Hat Virtualization System Administrator Roles
	Role	Privileges	Notes
	 
										VmPoolAdmin
									

									 	 
										System Administrator role of a virtual pool.
									

									 	 
										Can create, delete, and configure a virtual pool, assign and remove virtual pool users, and perform basic operations on a virtual machine.
									

									 
	 
										ClusterAdmin
									

									 	 
										Cluster Administrator
									

									 	 
										Can use, create, delete, manage all virtual machine pools in a specific cluster.
									

									 




Managing System Permissions for a Virtual Disk




						As the SuperUser, the system administrator manages all aspects of the Administration Portal. More specific administrative roles can be assigned to other users. These restricted administrator roles are useful for granting a user administrative privileges that limit them to a specific resource. For example, a DataCenterAdmin role has administrator privileges only for the assigned data center with the exception of the storage for that data center, and a ClusterAdmin has administrator privileges only for the assigned cluster.
					

						Red Hat Virtualization Manager provides two default virtual disk user roles, but no default virtual disk administrator roles. One of these user roles, the DiskCreator role, enables the administration of virtual disks from the VM Portal. This role can be applied to specific virtual machines, to a data center, to a specific storage domain, or to the whole virtualized environment; this is useful to allow different users to manage different virtual resources.
					

						The virtual disk creator role permits the following actions:
					
	
								Create, edit, and remove virtual disks associated with a virtual machine or other resources.
							
	
								Edit user permissions for virtual disks.
							


Note

							You can only assign roles and permissions to existing users.
						


Virtual Disk User Roles Explained




						Virtual Disk User Permission Roles
					

						The table below describes the user roles and privileges applicable to using and administrating virtual disks in the VM Portal.
					
Table 1.11. Red Hat Virtualization System Administrator Roles
	Role	Privileges	Notes
	 
										DiskOperator
									

									 	 
										Virtual disk user.
									

									 	 
										Can use, view and edit virtual disks. Inherits permissions to use the virtual machine to which the virtual disk is attached.
									

									 
	 
										DiskCreator
									

									 	 
										Can create, edit, manage and remove virtual disks within assigned clusters or data centers.
									

									 	 
										This role is not applied to a specific virtual disk; apply this role to a user for the whole environment with the Configure window. Alternatively apply this role for specific data centers, clusters, or storage domains.
									

									 



Setting a Legacy SPICE Cipher




							SPICE consoles use FIPS-compliant encryption by default, with a cipher string. The default SPICE cipher string is: kECDHE+FIPS:kDHE+FIPS:kRSA+FIPS:!eNULL:!aNULL
						

							This string is generally sufficient. However, if you have a virtual machine with an older operating system or SPICE client, where either one or the other does not support FIPS-compliant encryption, you must use a weaker cipher string. Otherwise, a connection security error may occur if you install a new cluster or a new host in an existing cluster and try to connect to that virtual machine.
						

							You can change the cipher string by using an Ansible playbook.
						

							Changing the cipher string
						
	
									On the Manager machine, create a file in the directory /usr/share/ovirt-engine/playbooks. For example:
								
# vim /usr/share/ovirt-engine/playbooks/change-spice-cipher.yml

	
									Enter the following in the file and save it:
								
name: oVirt - setup weaker SPICE encryption for old clients
hosts: hostname
vars:
  host_deploy_spice_cipher_string: 'DEFAULT:-RC4:-3DES:-DES'
roles:
  - ovirt-host-deploy-spice-encryption

	
									Run the file you just created:
								
# ansible-playbook -l hostname /usr/share/ovirt-engine/playbooks/change-spice-cipher.yml




							Alternatively, you can reconfigure the host with the Ansible playbook ovirt-host-deploy using the --extra-vars option with the variable host_deploy_spice_cipher_string:
						
# ansible-playbook -l hostname \
  --extra-vars host_deploy_spice_cipher_string=”DEFAULT:-RC4:-3DES:-DES” \
  /usr/share/ovirt-engine/playbooks/ovirt-host-deploy.yml



Scheduling Policies




					A scheduling policy is a set of rules that defines the logic by which virtual machines are distributed amongst hosts in the cluster that scheduling policy is applied to. Scheduling policies determine this logic via a combination of filters, weightings, and a load balancing policy. The filter modules apply hard enforcement and filter out hosts that do not meet the conditions specified by that filter. The weights modules apply soft enforcement, and are used to control the relative priority of factors considered when determining the hosts in a cluster on which a virtual machine can run.
				

					The Red Hat Virtualization Manager provides five default scheduling policies: Evenly_Distributed, Cluster_Maintenance, None, Power_Saving, and VM_Evenly_Distributed. You can also define new scheduling policies that provide fine-grained control over the distribution of virtual machines. Regardless of the scheduling policy, a virtual machine will not start on a host with an overloaded CPU. By default, a host’s CPU is considered overloaded if it has a load of more than 80% for 5 minutes, but these values can be changed using scheduling policies. See Scheduling Policies in the Administration Guide for more information about the properties of each scheduling policy.
				

					For detailed information about how scheduling policies work, see How does cluster scheduling policy work?.
				
Figure 1.4. Evenly Distributed Scheduling Policy
[image: Evenly Distributed Scheduling Policy]



					The Evenly_Distributed scheduling policy distributes the memory and CPU processing load evenly across all hosts in the cluster. Additional virtual machines attached to a host will not start if that host has reached the defined CpuOverCommitDurationMinutes, HighUtilization, VCpuToPhysicalCpuRatio, or MaxFreeMemoryForOverUtilized.
				

					The VM_Evenly_Distributed scheduling policy distributes virtual machines evenly between hosts based on a count of the virtual machines. The cluster is considered unbalanced if any host is running more virtual machines than the HighVmCount and there is at least one host with a virtual machine count that falls outside of the MigrationThreshold.
				
Figure 1.5. Power Saving Scheduling Policy
[image: Power Saving Scheduling Policy]



					The Power_Saving scheduling policy distributes the memory and CPU processing load across a subset of available hosts to reduce power consumption on underutilized hosts. Hosts with a CPU load below the low utilization value for longer than the defined time interval will migrate all virtual machines to other hosts so that it can be powered down. Additional virtual machines attached to a host will not start if that host has reached the defined high utilization value.
				

					Set the None policy to have no load or power sharing between hosts for running virtual machines. This is the default mode. When a virtual machine is started, the memory and CPU processing load is spread evenly across all hosts in the cluster. Additional virtual machines attached to a host will not start if that host has reached the defined CpuOverCommitDurationMinutes, HighUtilization, or MaxFreeMemoryForOverUtilized.
				

					The Cluster_Maintenance scheduling policy limits activity in a cluster during maintenance tasks. When the Cluster_Maintenance policy is set, no new virtual machines may be started, except highly available virtual machines. If host failure occurs, highly available virtual machines will restart properly and any virtual machine can migrate.
				
Creating a Scheduling Policy




						You can create new scheduling policies to control the logic by which virtual machines are distributed amongst a given cluster in your Red Hat Virtualization environment.
					
Procedure
	
								Click Administration → Configure.
							
	
								Click the Scheduling Policies tab.
							
	
								Click New.
							
	
								Enter a Name and Description for the scheduling policy.
							
	
								Configure filter modules:
							
	
										In the Filter Modules section, drag and drop the preferred filter modules to apply to the scheduling policy from the Disabled Filters section into the Enabled Filters section.
									
	
										Specific filter modules can also be set as the First, to be given highest priority, or Last, to be given lowest priority, for basic optimization. To set the priority, right-click any filter module, hover the cursor over Position and select First or Last.
									



	
								Configure weight modules:
							
	
										In the Weights Modules section, drag and drop the preferred weights modules to apply to the scheduling policy from the Disabled Weights section into the Enabled Weights & Factors section.
									
	
										Use the + and - buttons to the left of the enabled weight modules to increase or decrease the weight of those modules.
									



	
								Specify a load balancing policy:
							
	
										From the drop-down menu in the Load Balancer section, select the load balancing policy to apply to the scheduling policy.
									
	
										From the drop-down menu in the Properties section, select a load balancing property to apply to the scheduling policy and use the text field to the right of that property to specify a value.
									
	
										Use the + and - buttons to add or remove additional properties.
									



	
								Click OK.
							



Explanation of Settings in the New Scheduling Policy and Edit Scheduling Policy Window




						The following table details the options available in the New Scheduling Policy and Edit Scheduling Policy windows.
					
Table 1.12. New Scheduling Policy and Edit Scheduling Policy Settings
	Field Name	Description
	 
										Name
									

									 	 
										The name of the scheduling policy. This is the name used to refer to the scheduling policy in the Red Hat Virtualization Manager.
									

									 
	 
										Description
									

									 	 
										A description of the scheduling policy. This field is recommended but not mandatory.
									

									 
	 
										Filter Modules
									

									 	 
										A set of filters for controlling the hosts on which a virtual machine in a cluster can run. Enabling a filter will filter out hosts that do not meet the conditions specified by that filter, as outlined below:
									

									 	
												ClusterInMaintenance: Virtual machines being started on the host that are not configured for high availability filter out the host.
											
	
												CpuPinning: Hosts which do not satisfy the CPU pinning definition.
											
	
												Migration: Prevents migration to the same host.
											
	
												CPUOverloaded: Hosts with CPU usage that is above the defined HighUtilization threshold for the interval defined by the CpuOverCommitDurationMinutes.
											
	
												PinToHost: Hosts other than the host to which the virtual machine is pinned.
											
	
												CPU-Level: Hosts that do not meet the CPU topology of the virtual machine.
											
	
												VmAffinityGroups: Hosts that do not meet the affinity rules defined for the virtual machine.
											
	
												NUMA: Hosts that do not have NUMA nodes that can accommodate the virtual machine vNUMA nodes in terms of resources.
											
	
												InClusterUpgrade: Hosts that are running an earlier version of the operating system than the host that the virtual machine currently runs on.
											
	
												MDevice: Hosts that do not provide the required mediated device (mDev).
											
	
												Memory: Hosts that do not have sufficient memory to run the virtual machine.
											
	
												CPU: Hosts with fewer CPUs than the number assigned to the virtual machine.
											
	
												HostedEnginesSpares: Reserves space for the Manager virtual machine on a specified number of self-hosted engine nodes.
											
	
												Swap: Hosts that are not swapping within the threshold.
											
	
												VM leases ready: Hosts that do not support virtual machines configured with storage leases.
											
	
												VmToHostsAffinityGroups: Group of hosts that do not meet the conditions specified for a virtual machine that is a member of an affinity group. For example, that virtual machines in an affinity group must run on one of the hosts in a group or on a separate host that is excluded from the group.
											
	
												HostDevice: Hosts that do not support host devices required by the virtual machine.
											
	
												HA: Forces the Manager virtual machine in a self-hosted engine environment to run only on hosts with a positive high availability score.
											
	
												Emulated-Machine: Hosts which do not have proper emulated machine support.
											
	
												HugePages: Hosts that do not meet the required number of Huge Pages needed for the virtual machine’s memory.
											
	
												Migration-Tsc-Frequency: Hosts that do not have virtual machines with the same TSC frequency as the host currently running the virtual machine.
											
	
												Network: Hosts on which networks required by the network interface controller of a virtual machine are not installed, or on which the cluster’s display network is not installed.
											
	
												Label: Hosts that do not have the required affinity labels.
											
	
												Compatibility-Version: Hosts that do not have the correct cluster compatibility version support.
											



									 
	 
										Weights Modules
									

									 	 
										A set of weightings for controlling the relative priority of factors considered when determining the hosts in a cluster on which a virtual machine can run.
									

									 	
												VmAffinityGroups: Weights hosts in accordance with the affinity groups defined for virtual machines. This weight module determines how likely virtual machines in an affinity group are to run on the same host or on separate hosts in accordance with the parameters of that affinity group.
											
	
												InClusterUpgrade: Weight hosts in accordance with their operating system version. The weight penalizes hosts with earlier operating systems more than hosts with the same operating system as the host that the virtual machine is currently running on. This ensures that priority is always given to hosts with later operating systems.
											
	
												OptimalForCpuEvenDistribution: Weights hosts in accordance with their CPU usage, giving priority to hosts with lower CPU usage.
											
	
												CPU for high performance VMs: Prefers hosts that have more or an equal number of sockets, cores and threads than the VM.
											
	
												HA: Weights hosts in accordance with their high availability score.
											
	
												OptimalForCpuPowerSaving: Weights hosts in accordance with their CPU usage, giving priority to hosts with higher CPU usage.
											
	
												OptimalForMemoryPowerSaving: Weights hosts in accordance with their memory usage, giving priority to hosts with lower available memory.
											
	
												CPU and NUMA pinning compatibility: Weights hosts in accordance to pinning compatibility. When a virtual machine has both vNUMA and pinning defined, this weight module gives preference to hosts whose CPU pinning does not clash with the vNUMA pinning.
											
	
												VmToHostsAffinityGroups: Weights hosts in accordance with the affinity groups defined for virtual machines. This weight module determines how likely virtual machines in an affinity group are to run on one of the hosts in a group or on a separate host that is excluded from the group.
											
	
												OptimalForEvenGuestDistribution: Weights hosts in accordance with the number of virtual machines running on those hosts.
											
	
												OptimalForHaReservation: Weights hosts in accordance with their high availability score.
											
	
												OptimalForMemoryEvenDistribution: Weights hosts in accordance with their memory usage, giving priority to hosts with higher available memory.
											
	
												Fit VM to single host NUMA node: Weights hosts in accordance to whether a virtual machine fits into a single NUMA node. When a virtual machine does not have vNUMA defined, this weight module gives preference to hosts that can fit the virtual machine into a single physical NUMA.
											
	
												PreferredHosts: Preferred hosts have priority during virtual machine setup.
											



									 
	 
										Load Balancer
									

									 	 
										This drop-down menu allows you to select a load balancing module to apply. Load balancing modules determine the logic used to migrate virtual machines from hosts experiencing high usage to hosts experiencing lower usage.
									

									 
	 
										Properties
									

									 	 
										This drop-down menu allows you to add or remove properties for load balancing modules, and is only available when you have selected a load balancing module for the scheduling policy. No properties are defined by default, and the properties that are available are specific to the load balancing module that is selected. Use the + and - buttons to add or remove additional properties to or from the load balancing module.
									

									 





Instance Types




					Instance types can be used to define the hardware configuration of a virtual machine. Selecting an instance type when creating or editing a virtual machine will automatically fill in the hardware configuration fields. This allows users to create multiple virtual machines with the same hardware configuration without having to manually fill in every field.
				
Note

						Support for instance types is now deprecated, and will be removed in a future release.
					


					A set of predefined instance types are available by default, as outlined in the following table:
				
Table 1.13. Predefined Instance Types
	Name	Memory	vCPUs
	 
									Tiny
								

								 	 
									512 MB
								

								 	 
									1
								

								 
	 
									Small
								

								 	 
									2 GB
								

								 	 
									1
								

								 
	 
									Medium
								

								 	 
									4 GB
								

								 	 
									2
								

								 
	 
									Large
								

								 	 
									8 GB
								

								 	 
									2
								

								 
	 
									XLarge
								

								 	 
									16 GB
								

								 	 
									4
								

								 




					Administrators can also create, edit, and remove instance types from the Instance Types tab of the Configure window.
				

					Fields in the New Virtual Machine and Edit Virtual Machine windows that are bound to an instance type have a chain link image next to them ( 
					[image: 6121]
					 ). If the value of one of these fields is changed, the virtual machine will be detached from the instance type, changing to Custom, and the chain will appear broken ( 
					[image: 6122]
					 ). However, if the value is changed back, the chain will relink and the instance type will move back to the selected one.
				
Creating Instance Types




						Administrators can create new instance types, which can then be selected by users when creating or editing virtual machines.
					
Procedure
	
								Click Administration → Configure.
							
	
								Click the Instance Types tab.
							
	
								Click New.
							
	
								Enter a Name and Description for the instance type.
							
	
								Click Show Advanced Options and configure the instance type’s settings as required. The settings that appear in the New Instance Type window are identical to those in the New Virtual Machine window, but with the relevant fields only. See Explanation of Settings in the New Virtual Machine and Edit Virtual Machine Windows in the Virtual Machine Management Guide.
							
	
								Click OK.
							



						The new instance type will appear in the Instance Types tab in the Configure window, and can be selected from the Instance Type drop-down list when creating or editing a virtual machine.
					

Editing Instance Types




						Administrators can edit existing instance types from the Configure window.
					
Procedure
	
								Click Administration → Configure.
							
	
								Click the Instance Types tab.
							
	
								Select the instance type to be edited.
							
	
								Click Edit.
							
	
								Change the settings as required.
							
	
								Click OK.
							



						The configuration of the instance type is updated. When a new virtual machine based on this instance type is created, or when an existing virtual machine based on this instance type is updated, the new configuration is applied.
					

						Existing virtual machines based on this instance type will display fields, marked with a chain icon, that will be updated. If the existing virtual machines were running when the instance type was changed, the orange Pending Changes icon will appear beside them and the fields with the chain icon will be updated at the next restart.
					

Removing Instance Types



Procedure
	
								Click Administration → Configure.
							
	
								Click the Instance Types tab.
							
	
								Select the instance type to be removed.
							
	
								Click Remove.
							
	
								If any virtual machines are based on the instance type to be removed, a warning window listing the attached virtual machines will appear. To continue removing the instance type, select the Approve Operation check box. Otherwise click Cancel.
							
	
								Click OK.
							



						The instance type is removed from the Instance Types list and can no longer be used when creating a new virtual machine. Any virtual machines that were attached to the removed instance type will now be attached to Custom (no instance type).
					


MAC Address Pools




					MAC address pools define the range(s) of MAC addresses allocated for each cluster. A MAC address pool is specified for each cluster. By using MAC address pools, Red Hat Virtualization can automatically generate and assign MAC addresses to new virtual network devices, which helps to prevent MAC address duplication. MAC address pools are more memory efficient when all MAC addresses related to a cluster are within the range for the assigned MAC address pool.
				

					The same MAC address pool can be shared by multiple clusters, but each cluster has a single MAC address pool assigned. A default MAC address pool is created by Red Hat Virtualization and is used if another MAC address pool is not assigned. For more information about assigning MAC address pools to clusters see Creating a New Cluster.
				
Note

						If more than one Red Hat Virtualization cluster shares a network, do not rely solely on the default MAC address pool because the virtual machines of each cluster will try to use the same range of MAC addresses, leading to conflicts. To avoid MAC address conflicts, check the MAC address pool ranges to ensure that each cluster is assigned a unique MAC address range.
					


					The MAC address pool assigns the next available MAC address following the last address that was returned to the pool. If there are no further addresses left in the range, the search starts again from the beginning of the range. If there are multiple MAC address ranges with available MAC addresses defined in a single MAC address pool, the ranges take turns in serving incoming requests in the same way available MAC addresses are selected.
				
Creating MAC Address Pools




						You can create new MAC address pools.
					
Procedure
	
								Click Administration → Configure.
							
	
								Click the MAC Address Pools tab.
							
	
								Click Add.
							
	
								Enter the Name and Description of the new MAC address pool.
							
	
								Select the Allow Duplicates check box to allow a MAC address to be used multiple times in a pool. The MAC address pool will not automatically use a duplicate MAC address, but enabling the duplicates option means a user can manually use a duplicate MAC address.
							
Note

									If one MAC address pool has duplicates disabled, and another has duplicates enabled, each MAC address can be used once in the pool with duplicates disabled but can be used multiple times in the pool with duplicates enabled.
								


	
								Enter the required MAC Address Ranges. To enter multiple ranges click the plus button next to the From and To fields.
							
	
								Click OK.
							



Editing MAC Address Pools




						You can edit MAC address pools to change the details, including the range of MAC addresses available in the pool and whether duplicates are allowed.
					
Procedure
	
								Click Administration → Configure.
							
	
								Click the MAC Address Pools tab.
							
	
								Select the MAC address pool to be edited.
							
	
								Click Edit.
							
	
								Change the Name, Description, Allow Duplicates, and MAC Address Ranges fields as required.
							
Note

									When a MAC address range is updated, the MAC addresses of existing NICs are not reassigned. MAC addresses that were already assigned, but are outside of the new MAC address range, are added as user-specified MAC addresses and are still tracked by that MAC address pool.
								


	
								Click OK.
							



Editing MAC Address Pool Permissions




						After a MAC address pool has been created, you can edit its user permissions. The user permissions control which data centers can use the MAC address pool. See Roles for more information on adding new user permissions.
					
Procedure
	
								Click Administration → Configure.
							
	
								Click the MAC Address Pools tab.
							
	
								Select the required MAC address pool.
							
	
								Edit the user permissions for the MAC address pool:
							
	
										To add user permissions to a MAC address pool:
									
	
												Click Add in the user permissions pane at the bottom of the Configure window.
											
	
												Search for and select the required users.
											
	
												Select the required role from the Role to Assign drop-down list.
											
	
												Click OK to add the user permissions.
											



	
										To remove user permissions from a MAC address pool:
									
	
												Select the user permission to be removed in the user permissions pane at the bottom of the Configure window.
											
	
												Click Remove to remove the user permissions.
											









Removing MAC Address Pools




						You can remove a created MAC address pool if the pool is not associated with a cluster, but the default MAC address pool cannot be removed.
					
Procedure
	
								Click Administration → Configure.
							
	
								Click the MAC Address Pools tab.
							
	
								Select the MAC address pool to be removed.
							
	
								Click the Remove.
							
	
								Click OK.
							





Dashboard




				The Dashboard provides an overview of the Red Hat Virtualization system status by displaying a summary of Red Hat Virtualization’s resources and utilization. This summary can alert you to a problem and allows you to analyze the problem area.
			

				The information in the dashboard is updated every 15 minutes by default from Data Warehouse, and every 15 seconds by default by the Manager API, or whenever the Dashboard is refreshed. The Dashboard is refreshed when the user changes back from another page or when manually refreshed. The Dashboard does not automatically refresh. The inventory card information is supplied by the Manager API and the utilization information is supplied by Data Warehouse. The Dashboard is implemented as a UI plugin component, which is automatically installed and upgraded alongside the Manager.
			
Figure 1.6. The Dashboard
[image: Dashboard]


Prerequisites




					The Dashboard requires that Data Warehouse is installed and configured. See Installing and Configuring Data Warehouse in the Data Warehouse Guide.
				

Global Inventory




					The top section of the Dashboard provides a global inventory of the Red Hat Virtualization resources and includes items for data centers, clusters, hosts, storage domains, virtual machines, and events. Icons show the status of each resource and numbers show the quantity of the each resource with that status.
				
Figure 1.7. Global Inventory
[image: Dashboard Inventory]



					The title shows the number of a type of resource and their status is displayed below the title. Clicking on the resource title navigates to the related page in the Red Hat Virtualization Manager. The status for Clusters is always displayed as N/A.
				
Table 1.14. Resource Status
	Icon	Status
	 
									[image: Dashboard No Items]

								

								 	 
									None of that resource added to Red Hat Virtualization.
								

								 
	 
									[image: Dashboard Warning]

								

								 	 
									Shows the number of a resource with a warning status. Clicking on the icon navigates to the appropriate page with the search limited to that resource with a warning status. The search is limited differently for each resource:
								

								 	
											Data Centers: The search is limited to data centers that are not operational or non-responsive.
										
	
											Gluster Volumes: The search is limited to gluster volumes that are powering up, paused, migrating, waiting, suspended, or powering down.
										
	
											Hosts: The search is limited to hosts that are unassigned, in maintenance mode, installing, rebooting, preparing for maintenance, pending approval, or connecting.
										
	
											Storage Domains: The search is limited to storage domains that are uninitialized, unattached, inactive, in maintenance mode, preparing for maintenance, detaching, or activating.
										
	
											Virtual Machines: The search is limited to virtual machines that are powering up, paused, migrating, waiting, suspended, or powering down.
										
	
											Events: The search is limited to events with the severity of warning.
										



								 
	 
									[image: Dashboard Up]

								

								 	 
									Shows the number of a resource with an up status. Clicking on the icon navigates to the appropriate page with the search limited to resources that are up.
								

								 
	 
									[image: Dashboard Down]

								

								 	 
									Shows the number of a resource with a down status. Clicking on the icon navigates to the appropriate page with the search limited to resources with a down status. The search is limited differently for each resource:
								

								 	
											Data Centers: The search is limited to data centers that are uninitialized, in maintenance mode, or with a down status.
										
	
											Gluster Volumes: The search is limited to gluster volumes that are detached or inactive.
										
	
											Hosts: The search is limited to hosts that are non-responsive, have an error, have an installation error, non-operational, initializing, or down.
										
	
											Storage Domains: The search is limited to storage domains that are detached or inactive.
										
	
											Virtual Machines: The search is limited to virtual machines that are down, not responding, or rebooting.
										



								 
	 
									images:images/Dashboard_Alert.png[title="Alert icon"]
								

								 	 
									Shows the number of events with an alert status. Clicking on the icon navigates to Events with the search limited to events with the severity of alert.
								

								 
	 
									images:images/Dashboard_Error.png[title="Error icon"]
								

								 	 
									Shows the number of events with an error status. Clicking on the icon navigates to Events with the search limited to events with the severity of error.
								

								 




Global Utilization




					The Global Utilization section shows the system utilization of the CPU, Memory and Storage.
				
Figure 1.8. Global Utilization
[image: Dashboard Global Utilization]


	
							The top section shows the percentage of the available CPU, memory or storage and the over commit ratio. For example, the over commit ratio for the CPU is calculated by dividing the number of virtual cores by the number of physical cores that are available for the running virtual machines based on the latest data in Data Warehouse.
						
	
							The donut displays the usage in percentage for the CPU, memory or storage and shows the average usage for all hosts based on the average usage in the last 5 minutes. Hovering over a section of the donut will display the value of the selected section.
						
	
							The line graph at the bottom displays the trend in the last 24 hours. Each data point shows the average usage for a specific hour. Hovering over a point on the graph displays the time and the percentage used for the CPU graph and the amount of usage for the memory and storage graphs.
						


Top Utilized Resources



Figure 1.9. Top Utilized Resources (Memory)
[image: Top Utilized Resources]



						Clicking the donut in the global utilization section of the Dashboard will display a list of the top utilized resources for the CPU, memory or storage. For CPU and memory the pop-up shows a list of the ten hosts and virtual machines with the highest usage. For storage the pop-up shows a list of the top ten utilized storage domains and virtual machines. The arrow to the right of the usage bar shows the trend of usage for that resource in the last minute.
					


Cluster Utilization




					The Cluster Utilization section shows the cluster utilization for the CPU and memory in a heatmap.
				
Figure 1.10. Cluster Utilization
[image: Dashboard Cluster Utilization]


CPU




						The heatmap of the CPU utilization for a specific cluster that shows the average utilization of the CPU for the last 24 hours. Hovering over the heatmap displays the cluster name. Clicking on the heatmap navigates to Compute → Hosts and displays the results of a search on a specific cluster sorted by CPU utilization. The formula used to calculate the usage of the CPU by the cluster is the average host CPU utilization in the cluster. This is calculated by using the average host CPU utilization for each host over the last 24 hours to find the total average usage of the CPU by the cluster.
					

Memory




						The heatmap of the memory utilization for a specific cluster that shows the average utilization of the memory for the last 24 hours. Hovering over the heatmap displays the cluster name. Clicking on the heatmap navigates to Compute → Hosts and displays the results of a search on a specific cluster sorted by memory usage. The formula used to calculate the memory usage by the cluster is the total utilization of the memory in the cluster in GB. This is calculated by using the average host memory utilization for each host over the last 24 hours to find the total average usage of memory by the cluster.
					


Storage Utilization




					The Storage Utilization section shows the storage utilization in a heatmap.
				
Figure 1.11. Storage Utilization
[image: Storage Utilization]



					The heatmap shows the average utilization of the storage for the last 24 hours. The formula used to calculate the storage usage by the cluster is the total utilization of the storage in the cluster. This is calculated by using the average storage utilization for each host over the last 24 hours to find the total average usage of the storage by the cluster. Hovering over the heatmap displays the storage domain name. Clicking on the heatmap navigates to Storage → Domains with the storage domains sorted by utilization.
				


Searches



Performing Searches in Red Hat Virtualization




					The Administration Portal allows you to manage thousands of resources, such as virtual machines, hosts, users, and more. To perform a search, enter the search query (free-text or syntax-based) into the search bar, available on the main page for each resource. Search queries can be saved as bookmarks for future reuse, so you do not have to reenter a search query each time the specific search results are required. Searches are not case sensitive.
				

Search Syntax and Examples




					The syntax of the search queries for Red Hat Virtualization resources is as follows:
				

					result type: {criteria} [sortby sort_spec]
				

					Syntax Examples
				

					The following examples describe how the search query is used and help you to understand how Red Hat Virtualization assists with building search queries.
				
Table 1.15. Example Search Queries
	Example	Result
	 
									Hosts: Vms.status = up page 2
								

								 	 
									Displays page 2 of a list of all hosts running virtual machines that are up.
								

								 
	 
									Vms: domain = qa.company.com
								

								 	 
									Displays a list of all virtual machines running on the specified domain.
								

								 
	 
									Vms: users.name = Mary
								

								 	 
									Displays a list of all virtual machines belonging to users with the user name Mary.
								

								 
	 
									Events: severity > normal sortby time
								

								 	 
									Displays the list of all Events whose severity is higher than Normal, sorted by time.
								

								 




Search Auto-Completion




					The Administration Portal provides auto-completion to help you create valid and powerful search queries. As you type each part of a search query, a drop-down list of choices for the next part of the search opens below the Search Bar. You can either select from the list and then continue typing/selecting the next part of the search, or ignore the options and continue entering your query manually.
				

					The following table specifies by example how the Administration Portal auto-completion assists in constructing a query:
				

					Hosts: Vms.status = down
				
Table 1.16. Example Search Queries Using Auto-Completion
	Input	List Items Displayed	Action
	 
									h
								

								 	 
									Hosts (1 option only)
								

								 	 
									Select Hosts or type Hosts
								

								 
	 
									Hosts:
								

								 	 
									All host properties
								

								 	 
									Type v
								

								 
	 
									Hosts: v
								

								 	 
									host properties starting with a v
								

								 	 
									Select Vms or type Vms
								

								 
	 
									Hosts: Vms
								

								 	 
									All virtual machine properties
								

								 	 
									Type s
								

								 
	 
									Hosts: Vms.s
								

								 	 
									All virtual machine properties beginning with s
								

								 	 
									Select status or type status
								

								 
	 
									Hosts: Vms.status
								

								 	 
									=
								

								 
									!=
								

								 	 
									Select or type =
								

								 
	 
									Hosts: Vms.status =
								

								 	 
									All status values
								

								 	 
									Select or type down
								

								 




Search Result Type Options




					The result type allows you to search for resources of any of the following types:
				
	
							Vms for a list of virtual machines
						
	
							Host for a list of hosts
						
	
							Pools for a list of pools
						
	
							Template for a list of templates
						
	
							Events for a list of events
						
	
							Users for a list of users
						
	
							Cluster for a list of clusters
						
	
							DataCenter for a list of data centers
						
	
							Storage for a list of storage domains
						



					As each type of resource has a unique set of properties and a set of other resource types that it is associated with, each search type has a set of valid syntax combinations. You can also use the auto-complete feature to create valid queries easily.
				

Search Criteria




					You can specify the search criteria after the colon in the query. The syntax of {criteria} is as follows:
				

					<prop><operator><value>
				

					or
				

					<obj-type><prop><operator><value>
				

					Examples
				

					The following table describes the parts of the syntax:
				
Table 1.17. Example Search Criteria
	Part	Description	Values	Example	Note
	 
									prop
								

								 	 
									The property of the searched-for resource. Can also be the property of a resource type (see obj-type), or tag (custom tag).
								

								 	 
									Limit your search to objects with a certain property. For example, search for objects with a status property.
								

								 	 
									Status
								

								 	 
									N/A
								

								 
	 
									obj-type
								

								 	 
									A resource type that can be associated with the searched-for resource.
								

								 	 
									These are system objects, like data centers and virtual machines.
								

								 	 
									Users
								

								 	 
									N/A
								

								 
	 
									operator
								

								 	 
									Comparison operators.
								

								 	 
									=
								

								 
									!= (not equal)
								

								 
									>
								

								 
									<
								

								 
									>=
								

								 
									<=
								

								 	 
									N/A
								

								 	 
									Value options depend on property.
								

								 
	 
									Value
								

								 	 
									What the expression is being compared to.
								

								 	 
									String
								

								 
									Integer
								

								 
									Ranking
								

								 
									Date (formatted according to Regional Settings)
								

								 	 
									Jones
								

								 
									256
								

								 
									normal
								

								 	 	
											Wildcards can be used within strings.
										
	
											"" (two sets of quotation marks with no space between them) can be used to represent an un-initialized (empty) string.
										
	
											Double quotes should be used around a string or date containing spaces
										



								 




Search: Multiple Criteria and Wildcards




					Wildcards can be used in the <value> part of the syntax for strings. For example, to find all users beginning with m, enter m*.
				

					You can perform a search having two criteria by using the Boolean operators AND and OR. For example:
				

					Vms: users.name = m* AND status = Up
				

					This query returns all running virtual machines for users whose names begin with "m".
				

					Vms: users.name = m* AND tag = "paris-loc"
				

					This query returns all virtual machines tagged with "paris-loc" for users whose names begin with "m".
				

					When two criteria are specified without AND or OR, AND is implied. AND precedes OR, and OR precedes implied AND.
				

Search: Determining Search Order




					You can determine the sort order of the returned information by using sortby. Sort direction (asc for ascending, desc for descending) can be included.
				

					For example:
				

					events: severity > normal sortby time desc
				

					This query returns all Events whose severity is higher than Normal, sorted by time (descending order).
				

Searching for Data Centers




					The following table describes all search options for Data Centers.
				
Table 1.18. Searching for Data Centers
	Property (of resource or resource-type)	Type	Description (Reference)
	 
									Clusters.clusters-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the clusters associated with the data center.
								

								 
	 
									name
								

								 	 
									String
								

								 	 
									The name of the data center.
								

								 
	 
									description
								

								 	 
									String
								

								 	 
									A description of the data center.
								

								 
	 
									type
								

								 	 
									String
								

								 	 
									The type of data center.
								

								 
	 
									status
								

								 	 
									List
								

								 	 
									The availability of the data center.
								

								 
	 
									sortby
								

								 	 
									List
								

								 	 
									Sorts the returned results by one of the resource properties.
								

								 
	 
									page
								

								 	 
									Integer
								

								 	 
									The page number of results to display.
								

								 




					Example
				

					Datacenter: type = nfs and status != up
				

					This example returns a list of data centers with a storage type of NFS and status other than up.
				

Searching for Clusters




					The following table describes all search options for clusters.
				
Table 1.19. Searching Clusters
	Property (of resource or resource-type)	Type	Description (Reference)
	 
									Datacenter.datacenter-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the data center associated with the cluster.
								

								 
	 
									Datacenter
								

								 	 
									String
								

								 	 
									The data center to which the cluster belongs.
								

								 
	 
									name
								

								 	 
									String
								

								 	 
									The unique name that identifies the clusters on the network.
								

								 
	 
									description
								

								 	 
									String
								

								 	 
									The description of the cluster.
								

								 
	 
									initialized
								

								 	 
									String
								

								 	 
									True or False indicating the status of the cluster.
								

								 
	 
									sortby
								

								 	 
									List
								

								 	 
									Sorts the returned results by one of the resource properties.
								

								 
	 
									page
								

								 	 
									Integer
								

								 	 
									The page number of results to display.
								

								 




					Example
				

					Clusters: initialized = true or name = Default
				

					This example returns a list of clusters which are initialized or named Default.
				

Searching for Hosts




					The following table describes all search options for hosts.
				
Table 1.20. Searching for Hosts
	Property (of resource or resource-type)	Type	Description (Reference)
	 
									Vms.Vms-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the virtual machines associated with the host.
								

								 
	 
									Templates.templates-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the templates associated with the host.
								

								 
	 
									Events.events-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the events associated with the host.
								

								 
	 
									Users.users-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the users associated with the host.
								

								 
	 
									name
								

								 	 
									String
								

								 	 
									The name of the host.
								

								 
	 
									status
								

								 	 
									List
								

								 	 
									The availability of the host.
								

								 
	 
									external_status
								

								 	 
									String
								

								 	 
									The health status of the host as reported by external systems and plug-ins.
								

								 
	 
									cluster
								

								 	 
									String
								

								 	 
									The cluster to which the host belongs.
								

								 
	 
									address
								

								 	 
									String
								

								 	 
									The unique name that identifies the host on the network.
								

								 
	 
									cpu_usage
								

								 	 
									Integer
								

								 	 
									The percent of processing power used.
								

								 
	 
									mem_usage
								

								 	 
									Integer
								

								 	 
									The percentage of memory used.
								

								 
	 
									network_usage
								

								 	 
									Integer
								

								 	 
									The percentage of network usage.
								

								 
	 
									load
								

								 	 
									Integer
								

								 	 
									Jobs waiting to be executed in the run-queue per processor, in a given time slice.
								

								 
	 
									version
								

								 	 
									Integer
								

								 	 
									The version number of the operating system.
								

								 
	 
									cpus
								

								 	 
									Integer
								

								 	 
									The number of CPUs on the host.
								

								 
	 
									memory
								

								 	 
									Integer
								

								 	 
									The amount of memory available.
								

								 
	 
									cpu_speed
								

								 	 
									Integer
								

								 	 
									The processing speed of the CPU.
								

								 
	 
									cpu_model
								

								 	 
									String
								

								 	 
									The type of CPU.
								

								 
	 
									active_vms
								

								 	 
									Integer
								

								 	 
									The number of virtual machines currently running.
								

								 
	 
									migrating_vms
								

								 	 
									Integer
								

								 	 
									The number of virtual machines currently being migrated.
								

								 
	 
									committed_mem
								

								 	 
									Integer
								

								 	 
									The percentage of committed memory.
								

								 
	 
									tag
								

								 	 
									String
								

								 	 
									The tag assigned to the host.
								

								 
	 
									type
								

								 	 
									String
								

								 	 
									The type of host.
								

								 
	 
									datacenter
								

								 	 
									String
								

								 	 
									The data center to which the host belongs.
								

								 
	 
									sortby
								

								 	 
									List
								

								 	 
									Sorts the returned results by one of the resource properties.
								

								 
	 
									page
								

								 	 
									Integer
								

								 	 
									The page number of results to display.
								

								 




					Example
				

					Hosts: cluster = Default and Vms.os = rhel6
				

					This example returns a list of hosts which are part of the Default cluster and host virtual machines running the Red Hat Enterprise Linux 6 operating system.
				

Searching for Networks




					The following table describes all search options for networks.
				
Table 1.21. Searching for Networks
	Property (of resource or resource-type)	Type	Description (Reference)
	 
									Cluster_network.clusternetwork-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the cluster associated with the network.
								

								 
	 
									Host_Network.hostnetwork-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the host associated with the network.
								

								 
	 
									name
								

								 	 
									String
								

								 	 
									The human readable name that identifies the network.
								

								 
	 
									description
								

								 	 
									String
								

								 	 
									Keywords or text describing the network, optionally used when creating the network.
								

								 
	 
									vlanid
								

								 	 
									Integer
								

								 	 
									The VLAN ID of the network.
								

								 
	 
									stp
								

								 	 
									String
								

								 	 
									Whether Spanning Tree Protocol (STP) is enabled or disabled for the network.
								

								 
	 
									mtu
								

								 	 
									Integer
								

								 	 
									The maximum transmission unit for the logical network.
								

								 
	 
									vmnetwork
								

								 	 
									String
								

								 	 
									Whether the network is only used for virtual machine traffic.
								

								 
	 
									datacenter
								

								 	 
									String
								

								 	 
									The data center to which the network is attached.
								

								 
	 
									sortby
								

								 	 
									List
								

								 	 
									Sorts the returned results by one of the resource properties.
								

								 
	 
									page
								

								 	 
									Integer
								

								 	 
									The page number of results to display.
								

								 




					Example
				

					Network: mtu > 1500 and vmnetwork = true
				

					This example returns a list of networks with a maximum transmission unit greater than 1500 bytes, and which are set up for use by only virtual machines.
				

Searching for Storage




					The following table describes all search options for storage.
				
Table 1.22. Searching for Storage
	Property (of resource or resource-type)	Type	Description (Reference)
	 
									Hosts.hosts-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the hosts associated with the storage.
								

								 
	 
									Clusters.clusters-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the clusters associated with the storage.
								

								 
	 
									name
								

								 	 
									String
								

								 	 
									The unique name that identifies the storage on the network.
								

								 
	 
									status
								

								 	 
									String
								

								 	 
									The status of the storage domain.
								

								 
	 
									external_status
								

								 	 
									String
								

								 	 
									The health status of the storage domain as reported by external systems and plug-ins.
								

								 
	 
									datacenter
								

								 	 
									String
								

								 	 
									The data center to which the storage belongs.
								

								 
	 
									type
								

								 	 
									String
								

								 	 
									The type of the storage.
								

								 
	 
									free-size
								

								 	 
									Integer
								

								 	 
									The size (GB) of the free storage.
								

								 
	 
									used-size
								

								 	 
									Integer
								

								 	 
									The amount (GB) of the storage that is used.
								

								 
	 
									total_size
								

								 	 
									Integer
								

								 	 
									The total amount (GB) of the storage that is available.
								

								 
	 
									committed
								

								 	 
									Integer
								

								 	 
									The amount (GB) of the storage that is committed.
								

								 
	 
									sortby
								

								 	 
									List
								

								 	 
									Sorts the returned results by one of the resource properties.
								

								 
	 
									page
								

								 	 
									Integer
								

								 	 
									The page number of results to display.
								

								 




					Example
				

					Storage: free_size > 6 GB and total_size < 20 GB
				

					This example returns a list of storage with free storage space greater than 6 GB, or total storage space less than 20 GB.
				

Searching for Disks




					The following table describes all search options for disks.
				
Note

						You can use the Disk Type and Content Type filtering options to reduce the number of displayed virtual disks.
					

Table 1.23. Searching for Disks
	Property (of resource or resource-type)	Type	Description (Reference)
	 
									Datacenters.datacenters-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the data centers associated with the disk.
								

								 
	 
									Storages.storages-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the storage associated with the disk.
								

								 
	 
									alias
								

								 	 
									String
								

								 	 
									The human readable name that identifies the storage on the network.
								

								 
	 
									description
								

								 	 
									String
								

								 	 
									Keywords or text describing the disk, optionally used when creating the disk.
								

								 
	 
									provisioned_size
								

								 	 
									Integer
								

								 	 
									The virtual size of the disk.
								

								 
	 
									size
								

								 	 
									Integer
								

								 	 
									The size of the disk.
								

								 
	 
									actual_size
								

								 	 
									Integer
								

								 	 
									The actual size allocated to the disk.
								

								 
	 
									creation_date
								

								 	 
									Integer
								

								 	 
									The date the disk was created.
								

								 
	 
									bootable
								

								 	 
									String
								

								 	 
									Whether the disk can or cannot be booted. Valid values are one of 0, 1, yes, or no
								

								 
	 
									shareable
								

								 	 
									String
								

								 	 
									Whether the disk can or cannot be attached to more than one virtual machine at a time. Valid values are one of 0, 1, yes, or no
								

								 
	 
									format
								

								 	 
									String
								

								 	 
									The format of the disk. Can be one of unused, unassigned, cow, or raw.
								

								 
	 
									status
								

								 	 
									String
								

								 	 
									The status of the disk. Can be one of unassigned, ok, locked, invalid, or illegal.
								

								 
	 
									disk_type
								

								 	 
									String
								

								 	 
									The type of the disk. Can be one of image or lun.
								

								 
	 
									number_of_vms
								

								 	 
									Integer
								

								 	 
									The number of virtual machine(s) to which the disk is attached.
								

								 
	 
									vm_names
								

								 	 
									String
								

								 	 
									The name(s) of the virtual machine(s) to which the disk is attached.
								

								 
	 
									quota
								

								 	 
									String
								

								 	 
									The name of the quota enforced on the virtual disk.
								

								 
	 
									sortby
								

								 	 
									List
								

								 	 
									Sorts the returned results by one of the resource properties.
								

								 
	 
									page
								

								 	 
									Integer
								

								 	 
									The page number of results to display.
								

								 




					Example
				

					Disks: format = cow and provisioned_size > 8
				

					This example returns a list of virtual disks with QCOW format and an allocated disk size greater than 8 GB.
				

Searching for Volumes




					The following table describes all search options for volumes.
				
Table 1.24. Searching for Volumes
	Property (of resource or resource-type)	Type	Description (Reference)
	 
									Cluster
								

								 	 
									String
								

								 	 
									The name of the cluster associated with the volume.
								

								 
	 
									Cluster.cluster-prop
								

								 	 
									Depends on property type (examples: name, description, comment, architecture)
								

								 	 
									The property of the clusters associated with the volume.
								

								 
	 
									name
								

								 	 
									String
								

								 	 
									The human readable name that identifies the volume.
								

								 
	 
									type
								

								 	 
									String
								

								 	 
									Can be one of distribute, replicate, distributed_replicate, stripe, or distributed_stripe.
								

								 
	 
									transport_type
								

								 	 
									Integer
								

								 	 
									Can be one of TCP or RDMA.
								

								 
	 
									replica_count
								

								 	 
									Integer
								

								 	 
									Number of replica.
								

								 
	 
									stripe_count
								

								 	 
									Integer
								

								 	 
									Number of stripes.
								

								 
	 
									status
								

								 	 
									String
								

								 	 
									The status of the volume. Can be one of Up or Down.
								

								 
	 
									sortby
								

								 	 
									List
								

								 	 
									Sorts the returned results by one of the resource properties.
								

								 
	 
									page
								

								 	 
									Integer
								

								 	 
									The page number of results to display.
								

								 




					Example
				

					Volume: transport_type = rdma and stripe_count >= 2
				

					This example returns a list of volumes with transport type set to RDMA, and with 2 or more stripes.
				

Searching for Virtual Machines




					The following table describes all search options for virtual machines.
				
Note

						Currently, the Network Label, Custom Emulated Machine, and Custom CPU Type properties are not supported search parameters.
					

Table 1.25. Searching for Virtual Machines
	Property (of resource or resource-type)	Type	Description (Reference)
	 
									Hosts.hosts-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the hosts associated with the virtual machine.
								

								 
	 
									Templates.templates-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the templates associated with the virtual machine.
								

								 
	 
									Events.events-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the events associated with the virtual machine.
								

								 
	 
									Users.users-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the users associated with the virtual machine.
								

								 
	 
									Storage.storage-prop
								

								 	 
									Depends on the property type
								

								 	 
									The property of storage devices associated with the virtual machine.
								

								 
	 
									Vnic.vnic-prop
								

								 	 
									Depends on the property type
								

								 	 
									The property of the vNIC associated with the virtual machine.
								

								 
	 
									name
								

								 	 
									String
								

								 	 
									The name of the virtual machine.
								

								 
	 
									status
								

								 	 
									List
								

								 	 
									The availability of the virtual machine.
								

								 
	 
									ip
								

								 	 
									Integer
								

								 	 
									The IP address of the virtual machine.
								

								 
	 
									uptime
								

								 	 
									Integer
								

								 	 
									The number of minutes that the virtual machine has been running.
								

								 
	 
									domain
								

								 	 
									String
								

								 	 
									The domain (usually Active Directory domain) that groups these machines.
								

								 
	 
									os
								

								 	 
									String
								

								 	 
									The operating system selected when the virtual machine was created.
								

								 
	 
									creationdate
								

								 	 
									Date
								

								 	 
									The date on which the virtual machine was created.
								

								 
	 
									address
								

								 	 
									String
								

								 	 
									The unique name that identifies the virtual machine on the network.
								

								 
	 
									cpu_usage
								

								 	 
									Integer
								

								 	 
									The percent of processing power used.
								

								 
	 
									mem_usage
								

								 	 
									Integer
								

								 	 
									The percentage of memory used.
								

								 
	 
									network_usage
								

								 	 
									Integer
								

								 	 
									The percentage of network used.
								

								 
	 
									memory
								

								 	 
									Integer
								

								 	 
									The maximum memory defined.
								

								 
	 
									apps
								

								 	 
									String
								

								 	 
									The applications currently installed on the virtual machine.
								

								 
	 
									cluster
								

								 	 
									List
								

								 	 
									The cluster to which the virtual machine belongs.
								

								 
	 
									pool
								

								 	 
									List
								

								 	 
									The virtual machine pool to which the virtual machine belongs.
								

								 
	 
									loggedinuser
								

								 	 
									String
								

								 	 
									The name of the user currently logged in to the virtual machine.
								

								 
	 
									tag
								

								 	 
									List
								

								 	 
									The tags to which the virtual machine belongs.
								

								 
	 
									datacenter
								

								 	 
									String
								

								 	 
									The data center to which the virtual machine belongs.
								

								 
	 
									type
								

								 	 
									List
								

								 	 
									The virtual machine type (server or desktop).
								

								 
	 
									quota
								

								 	 
									String
								

								 	 
									The name of the quota associated with the virtual machine.
								

								 
	 
									description
								

								 	 
									String
								

								 	 
									Keywords or text describing the virtual machine, optionally used when creating the virtual machine.
								

								 
	 
									sortby
								

								 	 
									List
								

								 	 
									Sorts the returned results by one of the resource properties.
								

								 
	 
									page
								

								 	 
									Integer
								

								 	 
									The page number of results to display.
								

								 
	 
									next_run_configuration_exists
								

								 	 
									Boolean
								

								 	 
									The virtual machine has pending configuration changes.
								

								 




					Example
				

					Vms: template.name = Win* and user.name = ""
				

					This example returns a list of virtual machines whose base template name begins with Win and are assigned to any user.
				

					Example
				

					Vms: cluster = Default and os = windows7
				

					This example returns a list of virtual machines that belong to the Default cluster and are running Windows 7.
				

Searching for Pools




					The following table describes all search options for Pools.
				
Table 1.26. Searching for Pools
	Property (of resource or resource-type)	Type	Description (Reference)
	 
									name
								

								 	 
									String
								

								 	 
									The name of the pool.
								

								 
	 
									description
								

								 	 
									String
								

								 	 
									The description of the pool.
								

								 
	 
									type
								

								 	 
									List
								

								 	 
									The type of pool.
								

								 
	 
									sortby
								

								 	 
									List
								

								 	 
									Sorts the returned results by one of the resource properties.
								

								 
	 
									page
								

								 	 
									Integer
								

								 	 
									The page number of results to display.
								

								 




					Example
				

					Pools: type = automatic
				

					This example returns a list of pools with a type of automatic.
				

Searching for Templates




					The following table describes all search options for templates.
				
Table 1.27. Searching for Templates
	Property (of resource or resource-type)	Type	Description (Reference)
	 
									Vms.Vms-prop
								

								 	 
									String
								

								 	 
									The property of the virtual machines associated with the template.
								

								 
	 
									Hosts.hosts-prop
								

								 	 
									String
								

								 	 
									The property of the hosts associated with the template.
								

								 
	 
									Events.events-prop
								

								 	 
									String
								

								 	 
									The property of the events associated with the template.
								

								 
	 
									Users.users-prop
								

								 	 
									String
								

								 	 
									The property of the users associated with the template.
								

								 
	 
									name
								

								 	 
									String
								

								 	 
									The name of the template.
								

								 
	 
									domain
								

								 	 
									String
								

								 	 
									The domain of the template.
								

								 
	 
									os
								

								 	 
									String
								

								 	 
									The type of operating system.
								

								 
	 
									creationdate
								

								 	 
									Integer
								

								 	 
									The date on which the template was created.
								

								 
									Date format is mm/dd/yy.
								

								 
	 
									childcount
								

								 	 
									Integer
								

								 	 
									The number of virtual machines created from the template.
								

								 
	 
									mem
								

								 	 
									Integer
								

								 	 
									Defined memory.
								

								 
	 
									description
								

								 	 
									String
								

								 	 
									The description of the template.
								

								 
	 
									status
								

								 	 
									String
								

								 	 
									The status of the template.
								

								 
	 
									cluster
								

								 	 
									String
								

								 	 
									The cluster associated with the template.
								

								 
	 
									datacenter
								

								 	 
									String
								

								 	 
									The data center associated with the template.
								

								 
	 
									quota
								

								 	 
									String
								

								 	 
									The quota associated with the template.
								

								 
	 
									sortby
								

								 	 
									List
								

								 	 
									Sorts the returned results by one of the resource properties.
								

								 
	 
									page
								

								 	 
									Integer
								

								 	 
									The page number of results to display.
								

								 




					Example
				

					Template: Events.severity >= normal and Vms.uptime > 0
				

					This example returns a list of templates where events of normal or greater severity have occurred on virtual machines derived from the template, and the virtual machines are still running.
				

Searching for Users




					The following table describes all search options for users.
				
Table 1.28. Searching for Users
	Property (of resource or resource-type)	Type	Description (Reference)
	 
									Vms.Vms-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the virtual machines associated with the user.
								

								 
	 
									Hosts.hosts-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the hosts associated with the user.
								

								 
	 
									Templates.templates-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the templates associated with the user.
								

								 
	 
									Events.events-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the events associated with the user.
								

								 
	 
									name
								

								 	 
									String
								

								 	 
									The name of the user.
								

								 
	 
									lastname
								

								 	 
									String
								

								 	 
									The last name of the user.
								

								 
	 
									usrname
								

								 	 
									String
								

								 	 
									The unique name of the user.
								

								 
	 
									department
								

								 	 
									String
								

								 	 
									The department to which the user belongs.
								

								 
	 
									group
								

								 	 
									String
								

								 	 
									The group to which the user belongs.
								

								 
	 
									title
								

								 	 
									String
								

								 	 
									The title of the user.
								

								 
	 
									status
								

								 	 
									String
								

								 	 
									The status of the user.
								

								 
	 
									role
								

								 	 
									String
								

								 	 
									The role of the user.
								

								 
	 
									tag
								

								 	 
									String
								

								 	 
									The tag to which the user belongs.
								

								 
	 
									pool
								

								 	 
									String
								

								 	 
									The pool to which the user belongs.
								

								 
	 
									sortby
								

								 	 
									List
								

								 	 
									Sorts the returned results by one of the resource properties.
								

								 
	 
									page
								

								 	 
									Integer
								

								 	 
									The page number of results to display.
								

								 




					Example
				

					Users: Events.severity > normal and Vms.status = up or Vms.status = pause
				

					This example returns a list of users where events of greater than normal severity have occurred on their virtual machines AND the virtual machines are still running; or the users' virtual machines are paused.
				

Searching for Events




					The following table describes all search options you can use to search for events. Auto-completion is offered for many options as appropriate.
				
Table 1.29. Searching for Events
	Property (of resource or resource-type)	Type	Description (Reference)
	 
									Vms.Vms-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the virtual machines associated with the event.
								

								 
	 
									Hosts.hosts-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the hosts associated with the event.
								

								 
	 
									Templates.templates-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the templates associated with the event.
								

								 
	 
									Users.users-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the users associated with the event.
								

								 
	 
									Clusters.clusters-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the clusters associated with the event.
								

								 
	 
									Volumes.Volumes-prop
								

								 	 
									Depends on property type
								

								 	 
									The property of the volumes associated with the event.
								

								 
	 
									type
								

								 	 
									List
								

								 	 
									Type of the event.
								

								 
	 
									severity
								

								 	 
									List
								

								 	 
									The severity of the event: Warning/Error/Normal.
								

								 
	 
									message
								

								 	 
									String
								

								 	 
									Description of the event type.
								

								 
	 
									time
								

								 	 
									List
								

								 	 
									Day the event occurred.
								

								 
	 
									usrname
								

								 	 
									String
								

								 	 
									The user name associated with the event.
								

								 
	 
									event_host
								

								 	 
									String
								

								 	 
									The host associated with the event.
								

								 
	 
									event_vm
								

								 	 
									String
								

								 	 
									The virtual machine associated with the event.
								

								 
	 
									event_template
								

								 	 
									String
								

								 	 
									The template associated with the event.
								

								 
	 
									event_storage
								

								 	 
									String
								

								 	 
									The storage associated with the event.
								

								 
	 
									event_datacenter
								

								 	 
									String
								

								 	 
									The data center associated with the event.
								

								 
	 
									event_volume
								

								 	 
									String
								

								 	 
									The volume associated with the event.
								

								 
	 
									correlation_id
								

								 	 
									Integer
								

								 	 
									The identification number of the event.
								

								 
	 
									sortby
								

								 	 
									List
								

								 	 
									Sorts the returned results by one of the resource properties.
								

								 
	 
									page
								

								 	 
									Integer
								

								 	 
									The page number of results to display.
								

								 




					Example
				

					Events: Vms.name = testdesktop and Hosts.name = gonzo.example.com
				

					This example returns a list of events, where the event occurred on the virtual machine named testdesktop while it was running on the host gonzo.example.com.
				


Bookmarks



Saving a Query String as a Bookmark




					A bookmark can be used to remember a search query, and shared with other users.
				
Procedure
	
							Enter the desired search query in the search bar and perform the search.
						
	
							Click the star-shaped Bookmark button to the right of the search bar. This opens the New Bookmark window.
						
	
							Enter the Name of the bookmark.
						
	
							Edit the Search string field, if required.
						
	
							Click OK.
						



					Click the Bookmarks icon ( 
					[image: Bookmark]
					 ) in the header bar to find and select the bookmark.
				

Editing a Bookmark




					You can modify the name and search string of a bookmark.
				
Procedure
	
							Click the Bookmarks icon ( 
							[image: Bookmark]
							 ) in the header bar.
						
	
							Select a bookmark and click Edit.
						
	
							Change the Name and Search string fields as necessary.
						
	
							Click OK.
						



Deleting a Bookmark




					When a bookmark is no longer needed, remove it.
				
Procedure
	
							Click the Bookmarks icon ( 
							[image: Bookmark]
							 ) in the header bar.
						
	
							Select a bookmark and click Remove.
						
	
							Click OK.
						




Tags



Using Tags to Customize Interactions with Red Hat Virtualization




					After your Red Hat Virtualization platform is set up and configured to your requirements, you can customize the way you work with it using tags. Tags allow system resources to be arranged into groups or categories. This is useful when many objects exist in the virtualization environment and the administrator wants to concentrate on a specific set of them.
				

					This section describes how to create and edit tags, assign them to hosts or virtual machines and search using the tags as criteria. Tags can be arranged in a hierarchy that matches a structure, to fit the needs of the enterprise.
				

					To create, modify, and remove Administration Portal tags, click the Tags icon ( 
					[image: Tag]
					 ) in the header bar.
				

Creating a Tag




					Create tags so you can filter search results using tags.
				
Procedure
	
							Click the Tags icon ( 
							[image: Tag]
							 ) in the header bar.
						
	
							Click Add to create a new tag, or select a tag and click New to create a descendant tag.
						
	
							Enter the Name and Description of the new tag.
						
	
							Click OK.
						



Modifying a Tag




					You can edit the name and description of a tag.
				

					Modifying a Tag
				
	
							Click the Tags icon ( 
							[image: Tag]
							 ) in the header bar.
						
	
							Select the tag you want to modify and click Edit.
						
	
							Change the Name and Description fields as necessary.
						
	
							Click OK.
						



Deleting a Tag




					When a tag is no longer needed, remove it.
				
Procedure
	
							Click the Tags icon ( 
							[image: Tag]
							 ) in the header bar.
						
	
							Select the tag you want to delete and click Remove. A message warns you that removing the tag will also remove all descendants of the tag.
						
	
							Click OK.
						



					You have removed the tag and all its descendants. The tag is also removed from all the objects that it was attached to.
				

Adding and Removing Tags to and from Objects




					You can assign tags to and remove tags from hosts, virtual machines, and users.
				
Procedure
	
							Select the object(s) you want to tag or untag.
						
	
							Click More Actions ( 
							[image: moreactions]
							 ), then click Assign Tags.
						
	
							Select the check box to assign a tag to the object, or clear the check box to detach the tag from the object.
						
	
							Click OK.
						



					The specified tag is now added or removed as a custom property of the selected object(s).
				

Searching for Objects Using Tags




					Enter a search query using tag as the property and the desired value or set of values as criteria for the search.
				

					The objects tagged with the specified criteria are listed in the results list.
				
Note

						If you search for objects using tag as the property and the inequality operator (!=), for example, Host: Vms.tag!=server1, the results list does not include untagged objects.
					


Customizing Hosts with Tags




					You can use tags to store information about your hosts. You can then search for hosts based on tags. For more information on searches, see Searches.
				
Procedure
	
							Click Compute → Hosts and select a host.
						
	
							Click More Actions ( 
							[image: moreactions]
							 ), then click Assign Tags.
						
	
							Select the check boxes of applicable tags.
						
	
							Click OK.
						



					You have added extra, searchable information about your host as tags.
				



Chapter 2. Administering the Resources



Quality of Service




				Red Hat Virtualization allows you to define quality of service entries that provide fine-grained control over the level of input and output, processing, and networking capabilities that resources in your environment can access. Quality of service entries are defined at the data center level and are assigned to profiles created under clusters and storage domains. These profiles are then assigned to individual resources in the clusters and storage domains where the profiles were created.
			
Storage Quality of Service




					Storage quality of service defines the maximum level of throughput and the maximum level of input and output operations for a virtual disk in a storage domain. Assigning storage quality of service to a virtual disk allows you to fine tune the performance of storage domains and prevent the storage operations associated with one virtual disk from affecting the storage capabilities available to other virtual disks hosted in the same storage domain.
				
Creating a Storage Quality of Service Entry



Procedure
	
								Click Compute → Data Centers.
							
	
								Click a data center’s name. This opens the details view.
							
	
								Click the QoS tab.
							
	
								Under Storage, click New.
							
	
								Enter a QoS Name and a Description for the quality of service entry.
							
	
								Specify the Throughput quality of service by clicking one of the radio buttons:
							
	
										None
									
	
										Total - Enter the maximum permitted total throughput in the MB/s field.
									
	
										Read/Write - Enter the maximum permitted throughput for read operations in the left MB/s field, and the maximum permitted throughput for write operations in the right MB/s field.
									



	
								Specify the input and output (IOps) quality of service by clicking one of the radio buttons:
							
	
										None
									
	
										Total - Enter the maximum permitted number of input and output operations per second in the IOps field.
									
	
										Read/Write - Enter the maximum permitted number of input operations per second in the left IOps field, and the maximum permitted number of output operations per second in the right IOps field.
									



	
								Click OK.
							



						You have created a storage quality of service entry, and can create disk profiles based on that entry in data storage domains that belong to the data center.
					

Removing a Storage Quality of Service Entry




						Remove an existing storage quality of service entry.
					
Procedure
	
								Click Compute → Data Centers.
							
	
								Click a data center’s name. This opens the details view.
							
	
								Click the QoS tab.
							
	
								Under Storage, select a storage quality of service entry and click Remove.
							
	
								Click OK.
							



						If any disk profiles were based on that entry, the storage quality of service entry for those profiles is automatically set to [unlimited].
					


Virtual Machine Network Quality of Service




					Virtual machine network quality of service is a feature that allows you to create profiles for limiting both the inbound and outbound traffic of individual virtual network interface controllers. With this feature, you can limit bandwidth in a number of layers, controlling the consumption of network resources.
				
Creating a Virtual Machine Network Quality of Service Entry




						Create a virtual machine network quality of service entry to regulate network traffic when applied to a virtual network interface controller (vNIC) profile, also known as a virtual machine network interface profile.
					

						Creating a Virtual Machine Network Quality of Service Entry
					
	
								Click Compute → Data Centers.
							
	
								Click a data center’s name. This opens the details view.
							
	
								Click the QoS tab.
							
	
								Under VM Network, click New.
							
	
								Enter a Name for the virtual machine network quality of service entry.
							
	
								Enter the limits for the Inbound and Outbound network traffic.
							
	
								Click OK.
							



						You have created a virtual machine network quality of service entry that can be used in a virtual network interface controller.
					

Settings in the New Virtual Machine Network QoS and Edit Virtual Machine Network QoS Windows Explained




						Virtual machine network quality of service settings allow you to configure bandwidth limits for both inbound and outbound traffic on three distinct levels.
					
Table 2.1. Virtual Machine Network QoS Settings
	Field Name	Description
	 
										Data Center
									

									 	 
										The data center to which the virtual machine network QoS policy is to be added. This field is configured automatically according to the selected data center.
									

									 
	 
										Name
									

									 	 
										A name to represent the virtual machine network QoS policy within the Manager.
									

									 
	 
										Inbound
									

									 	 
										The settings to be applied to inbound traffic. Select or clear the Inbound check box to enable or disable these settings.
									

									 	
												Average: The average speed of inbound traffic.
											
	
												Peak: The speed of inbound traffic during peak times.
											
	
												Burst: The speed of inbound traffic during bursts.
											



									 
	 
										Outbound
									

									 	 
										The settings to be applied to outbound traffic. Select or clear the Outbound check box to enable or disable these settings.
									

									 	
												Average: The average speed of outbound traffic.
											
	
												Peak: The speed of outbound traffic during peak times.
											
	
												Burst: The speed of outbound traffic during bursts.
											



									 




						To change the maximum value allowed by the Average, Peak, or Burst fields, use the engine-config command to change the value of the MaxAverageNetworkQoSValue, MaxPeakNetworkQoSValue, or MaxBurstNetworkQoSValue configuration keys. You must restart the ovirt-engine service for any changes to take effect. For example:
					
# engine-config -s MaxAverageNetworkQoSValue=2048
# systemctl restart ovirt-engine

Removing a Virtual Machine Network Quality of Service Entry




						Remove an existing virtual machine network quality of service entry.
					
Procedure
	
								Click Compute → Data Centers.
							
	
								Click a data center’s name. This opens the details view.
							
	
								Click the QoS tab.
							
	
								Under VM Network, select a virtual machine network quality of service entry and click Remove.
							
	
								Click OK.
							




Host Network Quality of Service




					Host network quality of service configures the networks on a host to enable the control of network traffic through the physical interfaces. Host network quality of service allows for the fine tuning of network performance by controlling the consumption of network resources on the same physical network interface controller. This helps to prevent situations where one network causes other networks attached to the same physical network interface controller to no longer function due to heavy traffic. By configuring host network quality of service, these networks can now function on the same physical network interface controller without congestion issues.
				
Creating a Host Network Quality of Service Entry




						Create a host network quality of service entry.
					
Procedure
	
								Click Compute → Data Centers.
							
	
								Click a data center’s name. This opens the details view.
							
	
								Click the QoS tab.
							
	
								Under Host Network, click New.
							
	
								Enter a Qos Name and a description for the quality of service entry.
							
	
								Enter the desired values for Weighted Share, Rate Limit [Mbps], and Committed Rate [Mbps].
							
	
								Click OK.
							



Settings in the New Host Network Quality of Service and Edit Host Network Quality of Service Windows Explained




						Host network quality of service settings allow you to configure bandwidth limits for outbound traffic.
					
Table 2.2. Host Network QoS Settings
	Field Name	Description
	 
										Data Center
									

									 	 
										The data center to which the host network QoS policy is to be added. This field is configured automatically according to the selected data center.
									

									 
	 
										QoS Name
									

									 	 
										A name to represent the host network QoS policy within the Manager.
									

									 
	 
										Description
									

									 	 
										A description of the host network QoS policy.
									

									 
	 
										Outbound
									

									 	 
										The settings to be applied to outbound traffic.
									

									 	
												Weighted Share: Signifies how much of the logical link’s capacity a specific network should be allocated, relative to the other networks attached to the same logical link. The exact share depends on the sum of shares of all networks on that link. By default this is a number in the range 1-100.
											
	
												Rate Limit [Mbps]: The maximum bandwidth to be used by a network.
											
	
												Committed Rate [Mbps]: The minimum bandwidth required by a network. The Committed Rate requested is not guaranteed and will vary depending on the network infrastructure and the Committed Rate requested by other networks on the same logical link.
											



									 




						To change the maximum value allowed by the Rate Limit [Mbps] or Committed Rate [Mbps] fields, use the engine-config command to change the value of the MaxAverageNetworkQoSValue configuration key. You must restart the ovirt-engine service for the change to take effect. For example:
					
# engine-config -s MaxAverageNetworkQoSValue=2048
# systemctl restart ovirt-engine

Removing a Host Network Quality of Service Entry




						Remove an existing network quality of service entry.
					
Procedure
	
								Click Compute → Data Centers.
							
	
								Click a data center’s name. This opens the details view.
							
	
								Click the QoS tab.
							
	
								Under Host Network, select a host network quality of service entry and click Remove.
							
	
								Click OK when prompted.
							




CPU Quality of Service




					CPU quality of service defines the maximum amount of processing capability a virtual machine can access on the host on which it runs, expressed as a percent of the total processing capability available to that host. Assigning CPU quality of service to a virtual machine allows you to prevent the workload on one virtual machine in a cluster from affecting the processing resources available to other virtual machines in that cluster.
				
Creating a CPU Quality of Service Entry




						Create a CPU quality of service entry.
					
Procedure
	
								Click Compute → Data Centers.
							
	
								Click a data center’s name. This opens the details view.
							
	
								Click the QoS tab.
							
	
								Under CPU, click New.
							
	
								Enter a QoS Name and a Description for the quality of service entry.
							
	
								Enter the maximum processing capability the quality of service entry permits in the Limit (%) field. Do not include the % symbol.
							
	
								Click OK.
							



						You have created a CPU quality of service entry, and can create CPU profiles based on that entry in clusters that belong to the data center.
					

Removing a CPU Quality of Service Entry




						Remove an existing CPU quality of service entry.
					
Procedure
	
								Click Compute → Data Centers.
							
	
								Click a data center’s name. This opens the details view.
							
	
								Click the QoS tab.
							
	
								Under CPU, select a CPU quality of service entry and click Remove.
							
	
								Click OK.
							



						If any CPU profiles were based on that entry, the CPU quality of service entry for those profiles is automatically set to [unlimited].
					



Data Centers



Introduction to Data Centers




					A data center is a logical entity that defines the set of resources used in a specific environment. A data center is considered a container resource, in that it is comprised of logical resources, in the form of clusters and hosts; network resources, in the form of logical networks and physical NICs; and storage resources, in the form of storage domains.
				

					A data center can contain multiple clusters, which can contain multiple hosts; it can have multiple storage domains associated to it; and it can support multiple virtual machines on each of its hosts. A Red Hat Virtualization environment can contain multiple data centers; the data center infrastructure allows you to keep these centers separate.
				

					All data centers are managed from the single Administration Portal.
				
Figure 2.1. Data Centers
[image: Data Centers]



					Red Hat Virtualization creates a default data center during installation. You can configure the default data center, or set up new appropriately named data centers.
				

The Storage Pool Manager




					The Storage Pool Manager (SPM) is a role given to one of the hosts in the data center enabling it to manage the storage domains of the data center. The SPM entity can be run on any host in the data center; the Red Hat Virtualization Manager grants the role to one of the hosts. The SPM does not preclude the host from its standard operation; a host running as SPM can still host virtual resources.
				

					The SPM entity controls access to storage by coordinating the metadata across the storage domains. This includes creating, deleting, and manipulating virtual disks (images), snapshots, and templates, and allocating storage for sparse block devices (on SAN). This is an exclusive responsibility: only one host can be the SPM in the data center at one time to ensure metadata integrity.
				

					The Red Hat Virtualization Manager ensures that the SPM is always available. The Manager moves the SPM role to a different host if the SPM host encounters problems accessing the storage. When the SPM starts, it ensures that it is the only host granted the role; therefore it will acquire a storage-centric lease. This process can take some time.
				

SPM Priority




					The SPM role uses some of a host’s available resources. The SPM priority setting of a host alters the likelihood of the host being assigned the SPM role: a host with high SPM priority will be assigned the SPM role before a host with low SPM priority. Critical virtual machines on hosts with low SPM priority will not have to contend with SPM operations for host resources.
				

					You can change a host’s SPM priority in the SPM tab in the Edit Host window.
				

Data Center Tasks



Creating a New Data Center




						This procedure creates a data center in your virtualization environment. The data center requires a functioning cluster, host, and storage domain to operate.
					
Note

							After you set the Compatibility Version, you cannot lower the version number. Version regression is not supported.
						

							You can specify a MAC pool range for a cluster. Setting a MAC pool range is no longer supported.
						

Procedure
	
								Click Compute → Data Centers.
							
	
								Click New.
							
	
								Enter the Name and Description of the data center.
							
	
								Select the Storage Type, Compatibility Version, and Quota Mode of the data center from the drop-down menus.
							
	
								Click OK to create the data center and open the Data Center - Guide Me window.
							
	
								The Guide Me window lists the entities that need to be configured for the data center. Configure these entities or postpone configuration by clicking the Configure Later button. Configuration can be resumed by selecting the data center and clicking More Actions ( 
								[image: moreactions]
								 ), then clicking Guide Me.
							



						The new data center will remain Uninitialized until a cluster, host, and storage domain are configured for it; use Guide Me to configure these entities.
					

Explanation of Settings in the New Data Center and Edit Data Center Windows




						The table below describes the settings of a data center as displayed in the New Data Center and Edit Data Center windows. Invalid entries are outlined in orange when you click OK, prohibiting the changes being accepted. In addition, field prompts indicate the expected values or range of values.
					
Table 2.3. Data Center Properties
	Field	Description/Action
	 
										Name
									

									 	 
										The name of the data center. This text field has a 40-character limit and must be a unique name with any combination of uppercase and lowercase letters, numbers, hyphens, and underscores.
									

									 
	 
										Description
									

									 	 
										The description of the data center. This field is recommended but not mandatory.
									

									 
	 
										Storage Type
									

									 	 
										Choose Shared or Local storage type.
									

									 
										Different types of storage domains (iSCSI, NFS, FC, POSIX, and Gluster) can be added to the same data center. Local and shared domains, however, cannot be mixed.
									

									 
										You can change the storage type after the data center is initialized. See Changing the Data Center Storage Type.
									

									 
	 
										Compatibility Version
									

									 	 
										The version of Red Hat Virtualization.
									

									 
										After upgrading the Red Hat Virtualization Manager, the hosts, clusters and data centers may still be in the earlier version. Ensure that you have upgraded all the hosts, then the clusters, before you upgrade the Compatibility Level of the data center.
									

									 
	 
										Quota Mode
									

									 	 
										Quota is a resource limitation tool provided with Red Hat Virtualization. Choose one of:
									

									 	
												Disabled: Select if you do not want to implement Quota
											
	
												Audit: Select if you want to edit the Quota settings
											
	
												Enforced: Select to implement Quota
											



									 
	 
										Comment
									

									 	 
										Optionally add a plain text comment about the data center.
									

									 




Re-Initializing a Data Center: Recovery Procedure




						This recovery procedure replaces the master data domain of your data center with a new master data domain. You must re-initialize your master data domain if its data is corrupted. Re-initializing a data center allows you to restore all other resources associated with the data center, including clusters, hosts, and non-problematic storage domains.
					

						You can import any backup or exported virtual machines or templates into your new master data domain.
					
Procedure
	
								Click Compute → Data Centers and select the data center.
							
	
								Ensure that any storage domains attached to the data center are in maintenance mode.
							
	
								Click More Actions ( 
								[image: moreactions]
								 ), then click Re-Initialize Data Center.
							
	
								The Data Center Re-Initialize window lists all available (detached; in maintenance mode) storage domains. Click the radio button for the storage domain you are adding to the data center.
							
	
								Select the Approve operation check box.
							
	
								Click OK.
							



						The storage domain is attached to the data center as the master data domain and activated. You can now import any backup or exported virtual machines or templates into your new master data domain.
					

Removing a Data Center




						An active host is required to remove a data center. Removing a data center will not remove the associated resources.
					
Procedure
	
								Ensure the storage domains attached to the data center are in maintenance mode.
							
	
								Click Compute → Data Centers and select the data center to remove.
							
	
								Click Remove.
							
	
								Click OK.
							



Force Removing a Data Center




						A data center becomes Non Responsive if the attached storage domain is corrupt or if the host becomes Non Responsive. You cannot Remove the data center under either circumstance.
					

						Force Remove does not require an active host. It also permanently removes the attached storage domain.
					

						It may be necessary to Destroy a corrupted storage domain before you can Force Remove the data center.
					
Procedure
	
								Click Compute → Data Centers and select the data center to remove.
							
	
								Click More Actions ( 
								[image: moreactions]
								 ), then click Force Remove.
							
	
								Select the Approve operation check box.
							
	
								Click OK
							



						The data center and attached storage domain are permanently removed from the Red Hat Virtualization environment.
					

Changing the Data Center Storage Type




						You can change the storage type of the data center after it has been initialized. This is useful for data domains that are used to move virtual machines or templates around.
					

						Limitations
					
	
								Shared to Local - For a data center that does not contain more than one host and more than one cluster, since a local data center does not support it.
							
	
								Local to Shared - For a data center that does not contain a local storage domain.
							


Procedure
	
								Click Compute → Data Centers and select the data center to change.
							
	
								Click Edit.
							
	
								Change the Storage Type to the desired value.
							
	
								Click OK.
							



Changing the Data Center Compatibility Version




						Red Hat Virtualization data centers have a compatibility version. The compatibility version indicates the version of Red Hat Virtualization with which the data center is intended to be compatible. All clusters in the data center must support the desired compatibility level.
					
Prerequisites
	
								To change the data center compatibility level, you must first update the compatibility version of all clusters and virtual machines in the data center.
							


Procedure
	
								In the Administration Portal, click Compute → Data Centers.
							
	
								Select the data center to change and click Edit.
							
	
								Change the Compatibility Version to the desired value.
							
	
								Click OK. The Change Data Center Compatibility Version confirmation dialog opens.
							
	
								Click OK to confirm.
							




Data Centers and Storage Domains



Attaching an Existing Data Domain to a Data Center




						Data domains that are Unattached can be attached to a data center. Shared storage domains of multiple types (iSCSI, NFS, FC, POSIX, and Gluster) can be added to the same data center.
					
Procedure
	
								Click Compute → Data Centers.
							
	
								Click a data center’s name. This opens the details view.
							
	
								Click the Storage tab to list the storage domains already attached to the data center.
							
	
								Click Attach Data.
							
	
								Select the check box for the data domain to attach to the data center. You can select multiple check boxes to attach multiple data domains.
							
	
								Click OK.
							



						The data domain is attached to the data center and is automatically activated.
					

Attaching an Existing ISO domain to a Data Center




						An ISO domain that is Unattached can be attached to a data center. The ISO domain must be of the same Storage Type as the data center.
					

						Only one ISO domain can be attached to a data center.
					
Procedure
	
								Click Compute → Data Centers.
							
	
								Click a data center’s name. This opens the details view.
							
	
								Click the Storage tab to list the storage domains already attached to the data center.
							
	
								Click Attach ISO.
							
	
								Click the radio button for the appropriate ISO domain.
							
	
								Click OK.
							



						The ISO domain is attached to the data center and is automatically activated.
					

Attaching an Existing Export Domain to a Data Center



Note

							The export storage domain is deprecated. Storage data domains can be unattached from a data center and imported to another data center in the same environment, or in a different environment. Virtual machines, floating virtual disks, and templates can then be uploaded from the imported storage domain to the attached data center. See Importing Existing Storage Domains for information on importing storage domains.
						


						An export domain that is Unattached can be attached to a data center. Only one export domain can be attached to a data center.
					
Procedure
	
								Click Compute → Data Centers.
							
	
								Click a data center’s name. This opens the details view.
							
	
								Click the Storage tab to list the storage domains already attached to the data center.
							
	
								Click Attach Export.
							
	
								Click the radio button for the appropriate export domain.
							
	
								Click OK.
							



						The export domain is attached to the data center and is automatically activated.
					

Detaching a Storage Domain from a Data Center




						Detaching a storage domain from a data center stops the data center from associating with that storage domain. The storage domain is not removed from the Red Hat Virtualization environment; it can be attached to another data center.
					

						Data, such as virtual machines and templates, remains attached to the storage domain.
					
Warning

							Although it possible to detach the last master storage domain, this is not recommended.
						

							If the master storage domain is detached, it must be reinitialized.
						

							If the storage domain is reinitialized, all your data will be lost, and the storage domain might not find your disks again.
						

Procedure
	
								Click Compute → Data Centers.
							
	
								Click a data center’s name. This opens the details view.
							
	
								Click the Storage tab to list the storage domains attached to the data center.
							
	
								Select the storage domain to detach. If the storage domain is Active, click Maintenance.
							
	
								Click OK to initiate maintenance mode.
							
	
								Click Detach.
							
	
								Click OK.
							



						It can take up to several minutes for the storage domain to disappear from the details view.
					



Clusters



Introduction to Clusters




					A cluster is a logical grouping of hosts that share the same storage domains and have the same type of CPU (either Intel or AMD). If the hosts have different generations of CPU models, they use only the features present in all models.
				

					Each cluster in the system must belong to a data center, and each host in the system must belong to a cluster. Virtual machines are dynamically allocated to any host in a cluster and can be migrated between them, according to policies defined on the cluster and settings on the virtual machines. The cluster is the highest level at which power and load-sharing policies can be defined.
				

					The number of hosts and number of virtual machines that belong to a cluster are displayed in the results list under Host Count and VM Count, respectively.
				

					Clusters run virtual machines or Red Hat Gluster Storage Servers. These two purposes are mutually exclusive: A single cluster cannot support virtualization and storage hosts together.
				

					Red Hat Virtualization creates a default cluster in the default data center during installation.
				
Figure 2.2. Cluster
[image: Cluster]



Cluster Tasks



Note

						Some cluster options do not apply to Gluster clusters. For more information about using Red Hat Gluster Storage with Red Hat Virtualization, see Configuring Red Hat Virtualization with Red Hat Gluster Storage.
					

Creating a New Cluster




						A data center can contain multiple clusters, and a cluster can contain multiple hosts. All hosts in a cluster must have the same CPU architecture. To optimize your CPU types, create your hosts before you create your cluster. After creating the cluster, you can configure the hosts using the Guide Me button.
					
Procedure
	
								Click Compute → Clusters.
							
	
								Click New.
							
	
								Select the Data Center the cluster will belong to from the drop-down list.
							
	
								Enter the Name and Description of the cluster.
							
	
								Select a network from the Management Network drop-down list to assign the management network role.
							
	
								Select the CPU Architecture.
							
	
								For CPU Type, select the oldest CPU processor family among the hosts that will be part of this cluster. The CPU types are listed in order from the oldest to newest.
							
Important

									A hosts whose CPU processor family is older than the one you specify with CPU Type cannot be part of this cluster. For details, see Which CPU family should a RHEV3 or RHV4 cluster be set to?.
								


	
								Select the FIPS Mode of the cluster from the drop-down list.
							
	
								Select the Compatibility Version of the cluster from the drop-down list.
							
	
								Select the Switch Type from the drop-down list.
							
	
								Select the Firewall Type for hosts in the cluster, either Firewalld (default) or iptables.
							
Note

									iptables is only supported on Red Hat Enterprise Linux 7 hosts, in clusters with compatibility version 4.2 or 4.3. You can only add Red Hat Enterprise Linux 8 hosts to clusters with firewall type firewalld
								


	
								Select either the Enable Virt Service or Enable Gluster Service check box to define whether the cluster will be populated with virtual machine hosts or with Gluster-enabled nodes.
							
	
								Optionally select the Enable to set VM maintenance reason check box to enable an optional reason field when a virtual machine is shut down from the Manager, allowing the administrator to provide an explanation for the maintenance.
							
	
								Optionally select the Enable to set Host maintenance reason check box to enable an optional reason field when a host is placed into maintenance mode from the Manager, allowing the administrator to provide an explanation for the maintenance.
							
	
								Optionally select the /dev/hwrng source (external hardware device) check box to specify the random number generator device that all hosts in the cluster will use. The /dev/urandom source (Linux-provided device) is enabled by default.
							
	
								Click the Optimization tab to select the memory page sharing threshold for the cluster, and optionally enable CPU thread handling and memory ballooning on the hosts in the cluster.
							
	
								Click the Migration Policy tab to define the virtual machine migration policy for the cluster.
							
	
								Click the Scheduling Policy tab to optionally configure a scheduling policy, configure scheduler optimization settings, enable trusted service for hosts in the cluster, enable HA Reservation, and select a serial number policy.
							
	
								Click the Console tab to optionally override the global SPICE proxy, if any, and specify the address of a SPICE proxy for hosts in the cluster.
							
	
								Click the Fencing policy tab to enable or disable fencing in the cluster, and select fencing options.
							
	
								Click the MAC Address Pool tab to specify a MAC address pool other than the default pool for the cluster. For more options on creating, editing, or removing MAC address pools, see MAC Address Pools.
							
	
								Click OK to create the cluster and open the Cluster - Guide Me window.
							
	
								The Guide Me window lists the entities that need to be configured for the cluster. Configure these entities or postpone configuration by clicking the Configure Later button. Configuration can be resumed by selecting the cluster and clicking More Actions ( 
								[image: moreactions]
								 ), then clicking Guide Me.
							



General Cluster Settings Explained




						The table below describes the settings for the General tab in the New Cluster and Edit Cluster windows. Invalid entries are outlined in orange when you click OK, prohibiting the changes being accepted. In addition, field prompts indicate the expected values or range of values.
					
Table 2.4. General Cluster Settings
	Field	Description/Action
	 
										Data Center
									

									 	 
										The data center that will contain the cluster. The data center must be created before adding a cluster.
									

									 
	 
										Name
									

									 	 
										The name of the cluster. This text field has a 40-character limit and must be a unique name with any combination of uppercase and lowercase letters, numbers, hyphens, and underscores.
									

									 
	 
										Description / Comment
									

									 	 
										The description of the cluster or additional notes. These fields are recommended but not mandatory.
									

									 
	 
										Management Network
									

									 	 
										The logical network that will be assigned the management network role. The default is ovirtmgmt. This network will also be used for migrating virtual machines if the migration network is not properly attached to the source or the destination hosts.
									

									 
										On existing clusters, the management network can only be changed using the Manage Networks button in the Logical Networks tab in the details view.
									

									 
	 
										CPU Architecture
									

									 	 
										The CPU architecture of the cluster. All hosts in a cluster must run the architecture you specify. Different CPU types are available depending on which CPU architecture is selected.
									

									 	
												undefined: All other CPU types.
											
	
												x86_64: For Intel and AMD CPU types.
											
	
												ppc64: For IBM POWER CPU types.
											



									 
	 
										CPU Type
									

									 	 
										The oldest CPU family in the cluster. For a list of CPU types, see CPU Requirements in the Planning and Prerequisites Guide. You cannot change this after creating the cluster without significant disruption. Set CPU type to the oldest CPU model in the cluster. Only features present in all models can be used. For both Intel and AMD CPU types, the listed CPU models are in logical order from the oldest to the newest.
									

									 
	 
										Chipset/Firmware Type
									

									 	 
										This setting is only available if the CPU Architecture of the cluster is set to x86_64. This setting specifies the chipset and firmware type. Options are:
									

									 	
												Auto Detect: This setting automatically detects the chipset and firmware type. When Auto Detect is selected, the chipset and firmware are determined by the first host up in the cluster.
											
	
												I440FX Chipset with BIOS: Specifies the chipset to I440FX with a firmware type of BIOS.
											
	
												Q35 Chipset with BIOS: Specifies the Q35 chipset with a firmware type of BIOS without UEFI (Default for clusters with compatibility version 4.4).
											
	
												Q35 Chipset with UEFI Specifies the Q35 chipset with a firmware type of BIOS with UEFI. (Default for clusters with compatibility version 4.7)
											
	
												Q35 Chipset with UEFI SecureBoot Specifies the Q35 chipset with a firmware type of UEFI with SecureBoot, which authenticates the digital signatures of the boot loader.
											



									 
										For more information, see UEFI and the Q35 chipset in the Administration Guide.
									

									 
	 
										Change Existing VMs/Templates from 1440fx to Q35 Chipset with Bios
									

									 	 
										Select this check box to change existing workloads when the cluster’s chipset changes from I440FX to Q35.
									

									 
	 
										FIPS Mode
									

									 	 
										The FIPS mode used by the cluster. All hosts in the cluster must run the FIPS mode you specify or they will become non-operational.
									

									 	
												Auto Detect: This setting automatically detects whether FIPS mode is enabled or disabled. When Auto Detect is selected, the FIPS mode is determined by the first host up in the cluster.
											
	
												Disabled: This setting disables FIPS on the cluster.
											
	
												Enabled: This setting enables FIPS on the cluster.
											



									 
	 
										Compatibility Version
									

									 	 
										The version of Red Hat Virtualization. You will not be able to select a version earlier than the version specified for the data center.
									

									 
	 
										Switch Type
									

									 	 
										The type of switch used by the cluster. Linux Bridge is the standard Red Hat Virtualization switch. OVS provides support for Open vSwitch networking features.
									

									 
	 
										Firewall Type
									

									 	 
										Specifies the firewall type for hosts in the cluster, either firewalld (default) or iptables. iptables is only supported on Red Hat Enterprise Linux 7 hosts, in clusters with compatibility version 4.2 or 4.3. You can only add Red Hat Enterprise Linux 8 hosts to clusters with firewall type firewalld. If you change an existing cluster’s firewall type, you must reinstall all hosts in the cluster to apply the change.
									

									 
	 
										Default Network Provider
									

									 	 
										Specifies the default external network provider that the cluster will use. If you select Open Virtual Network (OVN), the hosts added to the cluster are automatically configured to communicate with the OVN provider.
									

									 
										If you change the default network provider, you must reinstall all hosts in the cluster to apply the change.
									

									 
	 
										Maximum Log Memory Threshold
									

									 	 
										Specifies the logging threshold for maximum memory consumption as a percentage or as an absolute value in MB. A message is logged if a host’s memory usage exceeds the percentage value or if a host’s available memory falls below the absolute value in MB. The default is 95%.
									

									 
	 
										Enable Virt Service
									

									 	 
										If this check box is selected, hosts in this cluster will be used to run virtual machines.
									

									 
	 
										Enable Gluster Service
									

									 	 
										If this check box is selected, hosts in this cluster will be used as Red Hat Gluster Storage Server nodes, and not for running virtual machines.
									

									 
	 
										Import existing gluster configuration
									

									 	 
										This check box is only available if the Enable Gluster Service radio button is selected. This option allows you to import an existing Gluster-enabled cluster and all its attached hosts to Red Hat Virtualization Manager.
									

									 
										The following options are required for each host in the cluster that is being imported:
									

									 	
												Hostname: Enter the IP or fully qualified domain name of the Gluster host server.
											
	
												Host ssh public key (PEM): Red Hat Virtualization Manager fetches the host’s SSH public key, to ensure you are connecting with the correct host.
											
	
												Password: Enter the root password required for communicating with the host.
											



									 
	 
										Additional Random Number Generator source
									

									 	 
										If the check box is selected, all hosts in the cluster have the additional random number generator device available. This enables passthrough of entropy from the random number generator device to virtual machines.
									

									 
	 
										Gluster Tuned Profile
									

									 	 
										This check box is only available if the Enable Gluster Service check box is selected. This option specifies the virtual-host tuning profile to enable more aggressive writeback of dirty memory pages, which benefits the host performance.
									

									 




Optimization Settings Explained




						Memory Considerations
					

						Memory page sharing allows virtual machines to use up to 200% of their allocated memory by utilizing unused memory in other virtual machines. This process is based on the assumption that the virtual machines in your Red Hat Virtualization environment will not all be running at full capacity at the same time, allowing unused memory to be temporarily allocated to a particular virtual machine.
					

						CPU Considerations
					
	
								For non-CPU-intensive workloads, you can run virtual machines with a total number of processor cores greater than the number of cores in the host (the number of processor cores for a single virtual machine must not exceed the number of cores in the host). The following benefits can be achieved:
							
	
										You can run a greater number of virtual machines, which reduces hardware requirements.
									
	
										You can configure virtual machines with CPU topologies that are otherwise not possible, such as when the number of virtual cores is between the number of host cores and the number of host threads.
									



	
								For best performance, and especially for CPU-intensive workloads, you should use the same topology in the virtual machine as in the host, so the host and the virtual machine expect the same cache usage. When the host has hyperthreading enabled, QEMU treats the host’s hyperthreads as cores, so the virtual machine is not aware that it is running on a single core with multiple threads. This behavior might impact the performance of a virtual machine, because a virtual core that actually corresponds to a hyperthread in the host core might share a single cache with another hyperthread in the same host core, while the virtual machine treats it as a separate core.
							



						The table below describes the settings for the Optimization tab in the New Cluster and Edit Cluster windows.
					
Table 2.5. Optimization Settings
	Field	Description/Action
	 
										Memory Optimization
									

									 	 	
												None - Disable memory overcommit: Disables memory page sharing.
											
	
												For Server Load - Allow scheduling of 150% of physical memory: Sets the memory page sharing threshold to 150% of the system memory on each host.
											
	
												For Desktop Load - Allow scheduling of 200% of physical memory: Sets the memory page sharing threshold to 200% of the system memory on each host.
											



									 
	 
										CPU Threads
									

									 	 
										Selecting the Count Threads As Cores check box enables hosts to run virtual machines with a total number of processor cores greater than the number of cores in the host (the number of processor cores for a single virtual machine must not exceed the number of cores in the host).
									

									 
										When this check box is selected, the exposed host threads are treated as cores that virtual machines can use. For example, a 24-core system with 2 threads per core (48 threads total) can run virtual machines with up to 48 cores each, and the algorithms to calculate host CPU load would compare load against twice as many potential utilized cores.
									

									 
	 
										Memory Balloon
									

									 	 
										Selecting the Enable Memory Balloon Optimization check box enables memory overcommitment on virtual machines running on the hosts in this cluster. When this check box is selected, the Memory Overcommit Manager (MoM) starts ballooning where and when possible, with a limitation of the guaranteed memory size of every virtual machine.
									

									 
										To have a balloon running, the virtual machine needs to have a balloon device with relevant drivers. Each virtual machine includes a balloon device unless specifically removed. Each host in this cluster receives a balloon policy update when its status changes to Up. If necessary, you can manually update the balloon policy on a host without having to change the status. See Updating the MoM Policy on Hosts in a Cluster.
									

									 
										It is important to understand that in some scenarios ballooning may collide with KSM. In such cases MoM will try to adjust the balloon size to minimize collisions. Additionally, in some scenarios ballooning may cause sub-optimal performance for a virtual machine. Administrators are advised to use ballooning optimization with caution.
									

									 
	 
										KSM control
									

									 	 
										Selecting the Enable KSM check box enables MoM to run Kernel Same-page Merging (KSM) when necessary and when it can yield a memory saving benefit that outweighs its CPU cost.
									

									 




Migration Policy Settings Explained




						A migration policy defines the conditions for live migrating virtual machines in the event of host failure. These conditions include the downtime of the virtual machine during migration, network bandwidth, and how the virtual machines are prioritized.
					
Table 2.6. Migration Policies Explained
	Policy	Description
	 
										Cluster default (Minimal downtime)
									

									 	 
										Overrides in vdsm.conf are still applied. The guest agent hook mechanism is disabled.
									

									 
	 
										Minimal downtime
									

									 	 
										A policy that lets virtual machines migrate in typical situations. Virtual machines should not experience any significant downtime. The migration will be aborted if the virtual machine migration does not converge after a long time (dependent on QEMU iterations, with a maximum of 500 milliseconds). The guest agent hook mechanism is enabled.
									

									 
	 
										Post-copy migration
									

									 	 
										When used, post-copy migration pauses the migrating virtual machine vCPUs on the source host, transfers only a minimum of memory pages, activates the virtual machine vCPUs on the destination host, and transfers the remaining memory pages while the virtual machine is running on the destination.
									

									 
										The post-copy policy first tries pre-copy to verify whether convergence can occur. The migration switches to post-copy if the virtual machine migration does not converge after a long time.
									

									 
										This significantly reduces the downtime of the migrated virtual machine, and also guarantees that the migration finishes regardless of how rapidly the memory pages of the source virtual machine change. It is optimal for migrating virtual machines in heavy continuous use, which would not be possible to migrate with standard pre-copy migration.
									

									 
										The disadvantage of this policy is that in the post-copy phase, the virtual machine may slow down significantly as the missing parts of memory are transferred between the hosts.
									

									 Warning

											If the network connection breaks prior to the completion of the post-copy process, the Manager pauses and then kills the running virtual machine. Do not use post-copy migration if the virtual machine availability is critical or if the migration network is unstable.
										


									 
	 
										Suspend workload if needed
									

									 	 
										A policy that lets virtual machines migrate in most situations, including virtual machines running heavy workloads. Because of this, virtual machines may experience a more significant downtime than with some of the other settings. The migration may still be aborted for extreme workloads. The guest agent hook mechanism is enabled.
									

									 




						The bandwidth settings define the maximum bandwidth of both outgoing and incoming migrations per host.
					
Table 2.7. Bandwidth Explained
	Policy	Description
	 
										Auto
									

									 	 
										Bandwidth is copied from the Rate Limit [Mbps] setting in the data center Host Network QoS. If the rate limit has not been defined, it is computed as a minimum of link speeds of sending and receiving network interfaces. If rate limit has not been set, and link speeds are not available, it is determined by local VDSM setting on sending host.
									

									 
	 
										Hypervisor default
									

									 	 
										Bandwidth is controlled by local VDSM setting on sending Host.
									

									 
	 
										Custom
									

									 	 
										Defined by user (in Mbps). This value is divided by the number of concurrent migrations (default is 2, to account for ingoing and outgoing migration). Therefore, the user-defined bandwidth must be large enough to accommodate all concurrent migrations.
									

									 
										For example, if the Custom bandwidth is defined as 600 Mbps, a virtual machine migration’s maximum bandwidth is actually 300 Mbps.
									

									 




						The resilience policy defines how the virtual machines are prioritized in the migration.
					
Table 2.8. Resilience Policy Settings
	Field	Description/Action
	 
										Migrate Virtual Machines
									

									 	 
										Migrates all virtual machines in order of their defined priority.
									

									 
	 
										Migrate only Highly Available Virtual Machines
									

									 	 
										Migrates only highly available virtual machines to prevent overloading other hosts.
									

									 
	 
										Do Not Migrate Virtual Machines
									

									 	 
										Prevents virtual machines from being migrated.
									

									 



Table 2.9. Additional Properties Settings
	Field	Description/Action
	 
										Enable Migration Encryption
									

									 	 
										Allows the virtual machine to be encrypted during migration.
									

									 	
												Cluster default
											
	
												Encrypt
											
	
												Don’t encrypt
											



									 
	 
										Parallel Migrations
									

									 	 
										Allows you to specify whether and how many parallel migration connections to use.
									

									 	
												Disabled: The virtual machine is migrated using a single, non-parallel connection.
											
	
												Auto: The number of parallel connections is automatically determined. This settings might automatically disable parallel connections.
											
	
												Auto Parallel: The number of parallel connections is automatically determined.
											
	
												Custom: Allows you to specify the preferred number of parallel Connections, the actual number may be lower.
											



									 
	 
										Number of VM Migration Connections
									

									 	 
										This setting is only available when Custom is selected. The preferred number of custom parallel migrations, between 2 and 255.
									

									 




Scheduling Policy Settings Explained




						Scheduling policies allow you to specify the usage and distribution of virtual machines between available hosts. Define the scheduling policy to enable automatic load balancing across the hosts in a cluster. Regardless of the scheduling policy, a virtual machine will not start on a host with an overloaded CPU. By default, a host’s CPU is considered overloaded if it has a load of more than 80% for 5 minutes, but these values can be changed using scheduling policies. See Scheduling Policies in the Administration Guide for more information.
					
Table 2.10. Scheduling Policy Tab Properties
	Field	Description/Action
	 
										Select Policy
									

									 	 
										Select a policy from the drop-down list.
									

									 	
												none: Disables load-balancing or power-sharing between hosts for already-running virtual machines. This is the default mode. When a virtual machine is started, the memory and CPU processing load is spread evenly across all hosts in the cluster. Additional virtual machines attached to a host will not start if that host has reached the defined CpuOverCommitDurationMinutes, HighUtilization, or MaxFreeMemoryForOverUtilized.
											
	
												evenly_distributed: Distributes the memory and CPU processing load evenly across all hosts in the cluster. Additional virtual machines attached to a host will not start if that host has reached the defined CpuOverCommitDurationMinutes, HighUtilization, VCpuToPhysicalCpuRatio, or MaxFreeMemoryForOverUtilized.
											
	
												cluster_maintenance: Limits activity in a cluster during maintenance tasks. No new virtual machines may be started, except highly available virtual machines. If host failure occurs, highly available virtual machines will restart properly and any virtual machine can migrate.
											
	
												power_saving: Distributes the memory and CPU processing load across a subset of available hosts to reduce power consumption on underutilized hosts. Hosts with a CPU load below the low utilization value for longer than the defined time interval will migrate all virtual machines to other hosts so that it can be powered down. Additional virtual machines attached to a host will not start if that host has reached the defined high utilization value.
											
	
												vm_evenly_distributed: Distributes virtual machines evenly between hosts based on a count of the virtual machines. The cluster is considered unbalanced if any host is running more virtual machines than the HighVmCount and there is at least one host with a virtual machine count that falls outside of the MigrationThreshold.
											



									 
	 
										Properties
									

									 	 
										The following properties appear depending on the selected policy. Edit them if necessary:
									

									 	
												HighVmCount: Sets the minimum number of virtual machines that must be running per host to enable load balancing. The default value is 10 running virtual machines on one host. Load balancing is only enabled when there is at least one host in the cluster that has at least HighVmCount running virtual machines.
											
	
												MigrationThreshold: Defines a buffer before virtual machines are migrated from the host. It is the maximum inclusive difference in virtual machine count between the most highly-utilized host and the least-utilized host. The cluster is balanced when every host in the cluster has a virtual machine count that falls inside the migration threshold. The default value is 5.
											
	
												SpmVmGrace: Defines the number of slots for virtual machines to be reserved on SPM hosts. The SPM host will have a lower load than other hosts, so this variable defines how many fewer virtual machines the SPM host can run in comparison to other hosts. The default value is 5.
											
	
												CpuOverCommitDurationMinutes: Sets the time (in minutes) that a host can run a CPU load outside of the defined utilization values before the scheduling policy takes action. The defined time interval protects against temporary spikes in CPU load activating scheduling policies and instigating unnecessary virtual machine migration. Maximum two characters. The default value is 2.
											
	
												HighUtilization: Expressed as a percentage. If the host runs with CPU usage at or above the high utilization value for the defined time interval, the Red Hat Virtualization Manager migrates virtual machines to other hosts in the cluster until the host’s CPU load is below the maximum service threshold. The default value is 80.
											
	
												LowUtilization: Expressed as a percentage. If the host runs with CPU usage below the low utilization value for the defined time interval, the Red Hat Virtualization Manager will migrate virtual machines to other hosts in the cluster. The Manager will power down the original host machine, and restart it again when load balancing requires or there are not enough free hosts in the cluster. The default value is 20.
											
	
												ScaleDown: Reduces the impact of the HA Reservation weight function, by dividing a host’s score by the specified amount. This is an optional property that can be added to any policy, including none.
											
	
												HostsInReserve: Specifies a number of hosts to keep running even though there are no running virtual machines on them. This is an optional property that can be added to the power_saving policy.
											
	
												EnableAutomaticHostPowerManagement: Enables automatic power management for all hosts in the cluster. This is an optional property that can be added to the power_saving policy. The default value is true.
											
	
												MaxFreeMemoryForOverUtilized: Specifies the minimum amount of free memory a host should have, in MB. If a host has less free memory than this amount, the RHV Manager considers the host overutilized. For example, if you set this property to 1000, a host that has less than 1 GB of free memory is overutilized.
											

												For details on how this property interacts with the power_saving and evenly_distributed policies, see MaxFreeMemoryForOverUtilized and MinFreeMemoryForUnderUtilized cluster scheduling policy properties.
											

												You can add this property to the power_saving and evenly_distributed policies. Although it appears among the list of properties for the vm_evenly_distributed policy, it does not apply to that policy.
											

	
												MinFreeMemoryForUnderUtilized: Specifies the maximum amount of free memory a host should have, in MB. If a host has more free memory than this amount, the RHV Manager scheduler considers the host underutilized. For example, if you set this parameter to 10000, a host that has more than 10 GB of free memory is underutilized.
											

												For details on how this property interacts with the power_saving and evenly_distributed policies, see MaxFreeMemoryForOverUtilized and MinFreeMemoryForUnderUtilized cluster scheduling policy properties.
											

												You can add this property to the power_saving and evenly_distributed policies. Although it appears among the list of properties for the vm_evenly_distributed policy, it does not apply to that policy.
											

	
												HeSparesCount: Sets the number of additional self-hosted engine nodes that must reserve enough free memory to start the Manager virtual machine if it migrates or shuts down. Other virtual machines are prevented from starting on a self-hosted engine node if doing so would not leave enough free memory for the Manager virtual machine. This is an optional property that can be added to the power_saving, vm_evenly_distributed, and evenly_distributed policies. The default value is 0.
											



									 
	 
										Scheduler Optimization
									

									 	 
										Optimize scheduling for host weighing/ordering.
									

									 	
												Optimize for Utilization: Includes weight modules in scheduling to allow best selection.
											
	
												Optimize for Speed: Skips host weighting in cases where there are more than ten pending requests.
											



									 
	 
										Enable Trusted Service
									

									 	 
										Enable integration with an OpenAttestation server. Before this can be enabled, use the engine-config tool to enter the OpenAttestation server’s details. IMPORTANT: OpenAttestation and Intel Trusted Execution Technology (Intel TXT) are no longer available.
									

									 
	 
										Enable HA Reservation
									

									 	 
										Enable the Manager to monitor cluster capacity for highly available virtual machines. The Manager ensures that appropriate capacity exists within a cluster for virtual machines designated as highly available to migrate in the event that their existing host fails unexpectedly.
									

									 
	 
										Serial Number Policy
									

									 	 
										Configure the policy for assigning serial numbers to each new virtual machine in the cluster:
									

									 	
												System Default: Use the system-wide defaults in the Manager database. To configure these defaults, use the engine configuration tool to set the values of the DefaultSerialNumberPolicy and DefaultCustomSerialNumber. These key-value pairs are saved in the vdc_options table of the Manager database.
											

												For DefaultSerialNumberPolicy:
											
	
														Default value: HOST_ID
													
	
														Possible values: HOST_ID, VM_ID, CUSTOM
													
	
														Command line example: engine-config --set DefaultSerialNumberPolicy=VM_ID
													
	
														Important: Restart the Manager to apply the configuration.
													



												For DefaultCustomSerialNumber:
											
	
														Default value: Dummy serial number
													
	
														Possible values: Any string (max length 255 characters)
													
	
														Command line example: engine-config --set DefaultCustomSerialNumber="My very special string value"
													
	
														Important: Restart the Manager to apply the configuration.
													



	
												Host ID: Set each new virtual machine’s serial number to the UUID of the host.
											
	
												Vm ID: Set each new virtual machine’s serial number to the UUID of the virtual machine.
											
	
												Custom serial number: Set each new virtual machine’s serial number to the value you specify in the following Custom Serial Number parameter.
											



									 
	 
										Custom Serial Number
									

									 	 
										Specify the custom serial number to apply to new virtual machines in the cluster.
									

									 




						When a host’s free memory drops below 20%, ballooning commands like mom.Controllers.Balloon - INFO Ballooning guest:half1 from 1096400 to 1991580 are logged to /var/log/vdsm/mom.log. /var/log/vdsm/mom.log is the Memory Overcommit Manager log file.
					

MaxFreeMemoryForOverUtilized and MinFreeMemoryForUnderUtilized cluster scheduling policy properties




						The scheduler has a background process that migrates virtual machines according to the current cluster scheduling policy and its parameters. Based on the various criteria and their relative weights in a policy, the scheduler continuously categorizes hosts as source hosts or destination hosts and migrates individual virtual machines from the former to the latter.
					

						The following description explains how the evenly_distributed and power_saving cluster scheduling policies interact with the MaxFreeMemoryForOverUtilized and MinFreeMemoryForUnderUtilized properties. Although both policies consider CPU and memory load, CPU load is not relevant for the MaxFreeMemoryForOverUtilized and MinFreeMemoryForUnderUtilized properties.
					

						If you define the MaxFreeMemoryForOverUtilized and MinFreeMemoryForUnderUtilized properties as part of the evenly_distributed policy:
					
	
								Hosts that have less free memory than MaxFreeMemoryForOverUtilized are overutilized and become source hosts.
							
	
								Hosts that have more free memory than MinFreeMemoryForUnderUtilized are underutilized and become destination hosts.
							
	
								If MaxFreeMemoryForOverUtilized is not defined, the scheduler does not migrate virtual machines based on the memory load. (It continues migrating virtual machines based on the policy’s other criteria, such as CPU load.)
							
	
								If MinFreeMemoryForUnderUtilized is not defined, the scheduler considers all hosts eligible to become destination hosts.
							



						If you define the MaxFreeMemoryForOverUtilized and MinFreeMemoryForUnderUtilized properties as part of the power_saving policy:
					
	
								Hosts that have less free memory than MaxFreeMemoryForOverUtilized are overutilized and become source hosts.
							
	
								Hosts that have more free memory than MinFreeMemoryForUnderUtilized are underutilized and become source hosts.
							
	
								Hosts that have more free memory than MaxFreeMemoryForOverUtilized are not overutilized and become destination hosts.
							
	
								Hosts that have less free memory than MinFreeMemoryForUnderUtilized are not underutilized and become destination hosts.
							
	
								The scheduler prefers migrating virtual machines to hosts that are neither overutilized nor underutilized. If there are not enough of these hosts, the scheduler can migrate virtual machines to underutilized hosts. If the underutilized hosts are not needed for this purpose, the scheduler can power them down.
							
	
								If MaxFreeMemoryForOverUtilized is not defined, no hosts are overutilized. Therefore, only underutilized hosts are source hosts, and destination hosts include all hosts in the cluster.
							
	
								If MinFreeMemoryForUnderUtilized is not defined, only overutilized hosts are source hosts, and hosts that are not overutilized are destination hosts.
							
	
								To prevent the host from overutilization of all the physical CPUs, define the virtual CPU to physical CPU ratio - VCpuToPhysicalCpuRatio with a value between 0.1 and 2.9. When this parameter is set, hosts with a lower CPU utilization are preferred when scheduling a virtual machine.
							

								If adding a virtual machine causes the ratio to exceed the limit, both the VCpuToPhysicalCpuRatio and the CPU utilization are considered.
							

								In a running environment, if the host VCpuToPhysicalCpuRatio exceeds 2.5, some virtual machines might be load balanced and moved to hosts with a lower VCpuToPhysicalCpuRatio.
							



Additional resources
	
								Cluster Scheduling Policy Settings
							



Cluster Console Settings Explained




						The table below describes the settings for the Console tab in the New Cluster and Edit Cluster windows.
					
Table 2.11. Console Settings
	Field	Description/Action
	 
										Define SPICE Proxy for Cluster
									

									 	 
										Select this check box to enable overriding the SPICE proxy defined in global configuration. This feature is useful in a case where the user (who is, for example, connecting via the VM Portal) is outside of the network where the hypervisors reside.
									

									 
	 
										Overridden SPICE proxy address
									

									 	 
										The proxy by which the SPICE client connects to virtual machines. The address must be in the following format:
									

									 
protocol://[host]:[port]

									 




Fencing Policy Settings Explained




						The table below describes the settings for the Fencing Policy tab in the New Cluster and Edit Cluster windows.
					
Table 2.12. Fencing Policy Settings
	Field	Description/Action
	 
										Enable fencing
									

									 	 
										Enables fencing on the cluster. Fencing is enabled by default, but can be disabled if required; for example, if temporary network issues are occurring or expected, administrators can disable fencing until diagnostics or maintenance activities are completed. Note that if fencing is disabled, highly available virtual machines running on non-responsive hosts will not be restarted elsewhere.
									

									 
	 
										Skip fencing if host has live lease on storage
									

									 	 
										If this check box is selected, any hosts in the cluster that are Non Responsive and still connected to storage will not be fenced.
									

									 
	 
										Skip fencing on cluster connectivity issues
									

									 	 
										If this check box is selected, fencing will be temporarily disabled if the percentage of hosts in the cluster that are experiencing connectivity issues is greater than or equal to the defined Threshold. The Threshold value is selected from the drop-down list; available values are 25, 50, 75, and 100.
									

									 
	 
										Skip fencing if gluster bricks are up
									

									 	 
										This option is only available when Red Hat Gluster Storage functionality is enabled. If this check box is selected, fencing is skipped if bricks are running and can be reached from other peers. See Chapter 2. Configure High Availability using Fencing Policies and Appendix A. Fencing Policies for Red Hat Gluster Storage in Maintaining Red Hat Hyperconverged Infrastructure for more information.
									

									 
	 
										Skip fencing if gluster quorum not met
									

									 	 
										This option is only available when Red Hat Gluster Storage functionality is enabled. If this check box is selected, fencing is skipped if bricks are running and shutting down the host will cause loss of quorum. See Chapter 2. Configure High Availability using Fencing Policies and Appendix A. Fencing Policies for Red Hat Gluster Storage in Maintaining Red Hat Hyperconverged Infrastructure for more information.
									

									 




Setting Load and Power Management Policies for Hosts in a Cluster




						The evenly_distributed and power_saving scheduling policies allow you to specify acceptable memory and CPU usage values, and the point at which virtual machines must be migrated to or from a host. The vm_evenly_distributed scheduling policy distributes virtual machines evenly between hosts based on a count of the virtual machines. Define the scheduling policy to enable automatic load balancing across the hosts in a cluster. For a detailed explanation of each scheduling policy, see Cluster Scheduling Policy Settings.
					
Procedure
	
								Click Compute → Clusters and select a cluster.
							
	
								Click Edit.
							
	
								Click the Scheduling Policy tab.
							
	
								Select one of the following policies:
							
	
										none
									
	
										vm_evenly_distributed
									
	
												Set the minimum number of virtual machines that must be running on at least one host to enable load balancing in the HighVmCount field.
											
	
												Define the maximum acceptable difference between the number of virtual machines on the most highly-utilized host and the number of virtual machines on the least-utilized host in the MigrationThreshold field.
											
	
												Define the number of slots for virtual machines to be reserved on SPM hosts in the SpmVmGrace field.
											
	
												Optionally, in the HeSparesCount field, enter the number of additional self-hosted engine nodes on which to reserve enough free memory to start the Manager virtual machine if it migrates or shuts down. See Configuring Memory Slots Reserved for the self-hosted engine for more information.
											



	
										evenly_distributed
									
	
												Set the time (in minutes) that a host can run a CPU load outside of the defined utilization values before the scheduling policy takes action in the CpuOverCommitDurationMinutes field.
											
	
												Enter the CPU utilization percentage at which virtual machines start migrating to other hosts in the HighUtilization field.
											
	
												Optionally, in the HeSparesCount field, enter the number of additional self-hosted engine nodes on which to reserve enough free memory to start the Manager virtual machine if it migrates or shuts down. See Configuring Memory Slots Reserved for the self-hosted engine for more information.
											
	
												Optionally, to prevent the host from overutilization of all the physical CPUs, define the virtual CPU to physical CPU ratio - VCpuToPhysicalCpuRatio with a value between 0.1 and 2.9. When this parameter is set, hosts with a lower CPU utilization are preferred when scheduling a virtual machine.
											

												If adding a virtual machine causes the ratio to exceed the limit, both the VCpuToPhysicalCpuRatio and the CPU utilization are considered.
											

												In a running environment, if the host VCpuToPhysicalCpuRatio exceeds 2.5, some virtual machines might be load balanced and moved to hosts with a lower VCpuToPhysicalCpuRatio.
											




	
										power_saving
									
	
												Set the time (in minutes) that a host can run a CPU load outside of the defined utilization values before the scheduling policy takes action in the CpuOverCommitDurationMinutes field.
											
	
												Enter the CPU utilization percentage below which the host will be considered under-utilized in the LowUtilization field.
											
	
												Enter the CPU utilization percentage at which virtual machines start migrating to other hosts in the HighUtilization field.
											
	
												Optionally, in the HeSparesCount field, enter the number of additional self-hosted engine nodes on which to reserve enough free memory to start the Manager virtual machine if it migrates or shuts down. See Configuring Memory Slots Reserved for the self-hosted engine for more information.
											






	
								Choose one of the following as the Scheduler Optimization for the cluster:
							
	
										Select Optimize for Utilization to include weight modules in scheduling to allow best selection.
									
	
										Select Optimize for Speed to skip host weighting in cases where there are more than ten pending requests.
									



	
								If you are using an OpenAttestation server to verify your hosts, and have set up the server’s details using the engine-config tool, select the Enable Trusted Service check box.
							



						OpenAttestation and Intel Trusted Execution Technology (Intel TXT) are no longer available.
					

	
								Optionally select the Enable HA Reservation check box to enable the Manager to monitor cluster capacity for highly available virtual machines.
							
	
								Optionally select a Serial Number Policy for the virtual machines in the cluster:
							
	
										System Default: Use the system-wide defaults, which are configured in the Manager database using the engine configuration tool and the DefaultSerialNumberPolicy and DefaultCustomSerialNumber key names. The default value for DefaultSerialNumberPolicy is to use the Host ID. See Scheduling Policies in the Administration Guide for more information.
									
	
										Host ID: Set each virtual machine’s serial number to the UUID of the host.
									
	
										Vm ID: Set each virtual machine’s serial number to the UUID of the virtual machine.
									
	
										Custom serial number: Set each virtual machine’s serial number to the value you specify in the following Custom Serial Number parameter.
									



	
								Click OK.
							



Updating the MoM Policy on Hosts in a Cluster




						The Memory Overcommit Manager handles memory balloon and KSM functions on a host. Changes to these functions for a cluster pass to hosts the next time a host moves to a status of Up after being rebooted or in maintenance mode. However, if necessary you can apply important changes to a host immediately by synchronizing the MoM policy while the host is Up. The following procedure must be performed on each host individually.
					
Procedure
	
								Click Compute → Clusters.
							
	
								Click the cluster’s name. This opens the details view.
							
	
								Click the Hosts tab and select the host that requires an updated MoM policy.
							
	
								Click Sync MoM Policy.
							



						The MoM policy on the host is updated without having to move the host to maintenance mode and back Up.
					

Creating a CPU Profile




						CPU profiles define the maximum amount of processing capability a virtual machine in a cluster can access on the host on which it runs, expressed as a percent of the total processing capability available to that host. CPU profiles are created based on CPU profiles defined under data centers, and are not automatically applied to all virtual machines in a cluster; they must be manually assigned to individual virtual machines for the profile to take effect.
					

						This procedure assumes you have already defined one or more CPU quality of service entries under the data center to which the cluster belongs.
					
Procedure
	
								Click Compute → Clusters.
							
	
								Click the cluster’s name. This opens the details view.
							
	
								Click the CPU Profiles tab.
							
	
								Click New.
							
	
								Enter a Name and a Description for the CPU profile.
							
	
								Select the quality of service to apply to the CPU profile from the QoS list.
							
	
								Click OK.
							



Removing a CPU Profile




						Remove an existing CPU profile from your Red Hat Virtualization environment.
					
Procedure
	
								Click Compute → Clusters.
							
	
								Click the cluster’s name. This opens the details view.
							
	
								Click the CPU Profiles tab and select the CPU profile to remove.
							
	
								Click Remove.
							
	
								Click OK.
							



						If the CPU profile was assigned to any virtual machines, those virtual machines are automatically assigned the default CPU profile.
					

Importing an Existing Red Hat Gluster Storage Cluster




						You can import a Red Hat Gluster Storage cluster and all hosts belonging to the cluster into Red Hat Virtualization Manager.
					

						When you provide details such as the IP address or host name and password of any host in the cluster, the gluster peer status command is executed on that host through SSH, then displays a list of hosts that are a part of the cluster. You must manually verify the fingerprint of each host and provide passwords for them. You will not be able to import the cluster if one of the hosts in the cluster is down or unreachable. As the newly imported hosts do not have VDSM installed, the bootstrap script installs all the necessary VDSM packages on the hosts after they have been imported, and reboots them.
					
Procedure
	
								Click Compute → Clusters.
							
	
								Click New.
							
	
								Select the Data Center the cluster will belong to.
							
	
								Enter the Name and Description of the cluster.
							
	
								Select the Enable Gluster Service check box and the Import existing gluster configuration check box.
							

								The Import existing gluster configuration field is only displayed if the Enable Gluster Service is selected.
							

	
								In the Hostname field, enter the host name or IP address of any server in the cluster.
							

								The host SSH Fingerprint displays to ensure you are connecting with the correct host. If a host is unreachable or if there is a network error, an error Error in fetching fingerprint displays in the Fingerprint field.
							

	
								Enter the Password for the server, and click OK.
							
	
								The Add Hosts window opens, and a list of hosts that are a part of the cluster displays.
							
	
								For each host, enter the Name and the Root Password.
							
	
								If you wish to use the same password for all hosts, select the Use a Common Password check box to enter the password in the provided text field.
							

								Click Apply to set the entered password all hosts.
							

								Verify that the fingerprints are valid and submit your changes by clicking OK.
							




						The bootstrap script installs all the necessary VDSM packages on the hosts after they have been imported, and reboots them. You have now successfully imported an existing Red Hat Gluster Storage cluster into Red Hat Virtualization Manager.
					

Explanation of Settings in the Add Hosts Window




						The Add Hosts window allows you to specify the details of the hosts imported as part of a Gluster-enabled cluster. This window appears after you have selected the Enable Gluster Service check box in the New Cluster window and provided the necessary host details.
					
Table 2.13. Add Gluster Hosts Settings
	Field	Description
	 
										Use a common password
									

									 	 
										Tick this check box to use the same password for all hosts belonging to the cluster. Enter the password in the Password field, then click the Apply button to set the password on all hosts.
									

									 
	 
										Name
									

									 	 
										Enter the name of the host.
									

									 
	 
										Hostname/IP
									

									 	 
										This field is automatically populated with the fully qualified domain name or IP of the host you provided in the New Cluster window.
									

									 
	 
										Root Password
									

									 	 
										Enter a password in this field to use a different root password for each host. This field overrides the common password provided for all hosts in the cluster.
									

									 
	 
										Fingerprint
									

									 	 
										The host fingerprint is displayed to ensure you are connecting with the correct host. This field is automatically populated with the fingerprint of the host you provided in the New Cluster window.
									

									 




Removing a Cluster




						Move all hosts out of a cluster before removing it.
					
Note

							You cannot remove the Default cluster, as it holds the Blank template. You can, however, rename the Default cluster and add it to a new data center.
						

Procedure
	
								Click Compute → Clusters and select a cluster.
							
	
								Ensure there are no hosts in the cluster.
							
	
								Click Remove.
							
	
								Click OK
							



Memory Optimization




						To increase the number of virtual machines on a host, you can use memory overcommitment, in which the memory you assign to virtual machines exceeds RAM and relies on swap space.
					

						However, there are potential problems with memory overcommitment:
					
	
								Swapping performance - Swap space is slower and consumes more CPU resources than RAM, impacting virtual machine performance. Excessive swapping can lead to CPU thrashing.
							
	
								Out-of-memory (OOM) killer - If the host runs out of swap space, new processes cannot start, and the kernel’s OOM killer daemon begins shutting down active processes such as virtual machine guests.
							



						To help overcome these shortcomings, you can do the following:
					
	
								Limit memory overcommitment using the Memory Optimization setting and the Memory Overcommit Manager (MoM).
							
	
								Make the swap space large enough to accommodate the maximum potential demand for virtual memory and have a safety margin remaining.
							
	
								Reduce virtual memory size by enabling memory ballooning and Kernel Same-page Merging (KSM).
							



Memory Optimization and Memory Overcommitment




						You can limit the amount of memory overcommitment by selecting one of the Memory Optimization settings: None (0%), 150%, or 200%.
					

						Each setting represents a percentage of RAM. For example, with a host that has 64 GB RAM, selecting 150% means you can overcommit memory by an additional 32 GB, for a total of 96 GB in virtual memory. If the host uses 4 GB of that total, the remaining 92 GB are available. You can assign most of that to the virtual machines (Memory Size on the System tab), but consider leaving some of it unassigned as a safety margin.
					

						Sudden spikes in demand for virtual memory can impact performance before the MoM, memory ballooning, and KSM have time to re-optimize virtual memory. To reduce that impact, select a limit that is appropriate for the kinds of applications and workloads you are running:
					
	
								For workloads that produce more incremental growth in demand for memory, select a higher percentage, such as 200% or 150%.
							
	
								For more critical applications or workloads that produce more sudden increases in demand for memory, select a lower percentage, such as 150% or None (0%). Selecting None helps prevent memory overcommitment but allows the MoM, memory balloon devices, and KSM to continue optimizing virtual memory.
							


Important

							Always test your Memory Optimization settings by stress testing under a wide range of conditions before deploying the configuration to production.
						


						To configure the Memory Optimization setting, click the Optimization tab in the New Cluster or Edit Cluster windows. See Cluster Optimization Settings Explained.
					

						Additional comments:
					
	
								The Host Statistics views display useful historical information for sizing the overcommitment ratio.
							
	
								The actual memory available cannot be determined in real time because the amount of memory optimization achieved by KSM and memory ballooning changes continuously.
							
	
								When virtual machines reach the virtual memory limit, new apps cannot start.
							
	
								When you plan the number of virtual machines to run on a host, use the maximum virtual memory (physical memory size and the Memory Optimization setting) as a starting point. Do not factor in the smaller virtual memory achieved by memory optimizations such as memory ballooning and KSM.
							



Swap Space and Memory Overcommitment




						Red Hat provides these recommendations for configuring swap space.
					

						When applying these recommendations, follow the guidance to size the swap space as "last effort memory" for a worst-case scenario. Use the physical memory size and Memory Optimization setting as a basis for estimating the total virtual memory size. Exclude any reduction of the virtual memory size from optimization by the MoM, memory ballooning, and KSM.
					
Important

							To help prevent an OOM condition, make the swap space large enough to handle a worst-case scenario and still have a safety margin available. Always stress-test your configuration under a wide range of conditions before deploying it to production.
						


The Memory Overcommit Manager (MoM)




						The Memory Overcommit Manager (MoM) does two things:
					
	
								It limits memory overcommitment by applying the Memory Optimization setting to the hosts in a cluster, as described in the preceding section.
							
	
								It optimizes memory by managing the memory ballooning and KSM, as described in the following sections.
							



						You do not need to enable or disable MoM.
					

						When a host’s free memory drops below 20%, ballooning commands like mom.Controllers.Balloon - INFO Ballooning guest:half1 from 1096400 to 1991580 are logged to /var/log/vdsm/mom.log, the Memory Overcommit Manager log file.
					

Memory Ballooning




						Virtual machines start with the full amount of virtual memory you have assigned to them. As virtual memory usage exceeds RAM, the host relies more on swap space. If enabled, memory ballooning lets virtual machines give up the unused portion of that memory. The freed memory can be reused by other processes and virtual machines on the host. The reduced memory footprint makes swapping less likely and improves performance.
					

						The virtio-balloon package that provides the memory balloon device and drivers ships as a loadable kernel module (LKM). By default, it is configured to load automatically. Adding the module to the denyist or unloading it disables ballooning.
					

						The memory balloon devices do not coordinate directly with each other; they rely on the host’s Memory Overcommit Manager (MoM) process to continuously monitor each virtual machine needs and instruct the balloon device to increase or decrease virtual memory.
					

						Performance considerations:
					
	
								Red Hat does not recommend memory ballooning and overcommitment for workloads that require continuous high-performance and low latency. See Configuring High-Performance Virtual Machines, Templates, and Pools.
							
	
								Use memory ballooning when increasing virtual machine density (economy) is more important than performance.
							
	
								Memory ballooning does not have a significant impact on CPU utilization. (KSM consumes some CPU resources, but consumption remains consistent under pressure.)
							



						To enable memory ballooning, click the Optimization tab in the New Cluster or Edit Cluster windows. Then select the Enable Memory Balloon Optimization checkbox. This setting enables memory overcommitment on virtual machines running on the hosts in this cluster. When this check box is selected, the MoM starts ballooning where and when possible, with a limitation of the guaranteed memory size of every virtual machine. See Cluster Optimization Settings Explained.
					

						Each host in this cluster receives a balloon policy update when its status changes to Up. If necessary, you can manually update the balloon policy on a host without having to change the status. See Updating the MoM Policy on Hosts in a Cluster.
					

Kernel Same-page Merging (KSM)




						When a virtual machine runs, it often creates duplicate memory pages for items such as common libraries and high-use data. Furthermore, virtual machines that run similar guest operating systems and applications produce duplicate memory pages in virtual memory.
					

						When enabled, Kernel Same-page Merging (KSM) examines the virtual memory on a host, eliminates duplicate memory pages, and shares the remaining memory pages across multiple applications and virtual machines. These shared memory pages are marked copy-on-write; if a virtual machine needs to write changes to the page, it makes a copy first before writing its modifications to that copy.
					

						While KSM is enabled, the MoM manages KSM. You do not need to configure or control KSM manually.
					

						KSM increases virtual memory performance in two ways. Because a shared memory page is used more frequently, the host is more likely to the store it in cache or main memory, which improves the memory access speed. Additionally, with memory overcommitment, KSM reduces the virtual memory footprint, reducing the likelihood of swapping and improving performance.
					

						KSM consumes more CPU resources than memory ballooning. The amount of CPU KSM consumes remains consistent under pressure. Running identical virtual machines and applications on a host provides KSM with more opportunities to merge memory pages than running dissimilar ones. If you run mostly dissimilar virtual machines and applications, the CPU cost of using KSM may offset its benefits.
					

						Performance considerations:
					
	
								After the KSM daemon merges large amounts of memory, the kernel memory accounting statistics may eventually contradict each other. If your system has a large amount of free memory, you might improve performance by disabling KSM.
							
	
								Red Hat does not recommend KSM and overcommitment for workloads that require continuous high-performance and low latency. See Configuring High-Performance Virtual Machines, Templates, and Pools.
							
	
								Use KSM when increasing virtual machine density (economy) is more important than performance.
							



						To enable KSM, click the Optimization tab in the New Cluster or Edit Cluster windows. Then select the Enable KSM checkbox. This setting enables MoM to run KSM when necessary and when it can yield a memory saving benefit that outweighs its CPU cost. See Cluster Optimization Settings Explained.
					

UEFI and the Q35 chipset




						The Intel Q35 chipset, the default chipset for new virtual machines, includes support for the Unified Extensible Firmware Interface (UEFI), which replaces legacy BIOS.
					

						Alternatively you can configure a virtual machine or cluster to use the legacy Intel i440fx chipset, which does not support UEFI.
					

						UEFI provides several advantages over legacy BIOS, including the following:
					
	
								A modern boot loader
							
	
								SecureBoot, which authenticates the digital signatures of the boot loader
							
	
								GUID Partition Table (GPT), which enables disks larger than 2 TB
							



						To use UEFI on a virtual machine, you must configure the virtual machine’s cluster for 4.4 compatibility or later. Then you can set UEFI for any existing virtual machine, or to be the default BIOS type for new virtual machines in the cluster. The following options are available:
					
Table 2.14. Available BIOS Types
	BIOS Type	Description
	 
										Q35 Chipset with Legacy BIOS
									

									 	 
										Legacy BIOS without UEFI (Default for clusters with compatibility version 4.4)
									

									 
	 
										Q35 Chipset with UEFI BIOS
									

									 	 
										BIOS with UEFI
									

									 
	 
										Q35 Chipset with SecureBoot
									

									 	 
										UEFI with SecureBoot, which authenticates the digital signatures of the boot loader
									

									 
	 
										Legacy
									

									 	 
										i440fx chipset with legacy BIOS
									

									 



Setting the BIOS type before installing the operating system

							You can configure a virtual machine to use the Q35 chipset and UEFI before installing an operating system. Converting a virtual machine from legacy BIOS to UEFI is not supported after installing an operating system.
						

Configuring a cluster to use the Q35 Chipset and UEFI




						After upgrading a cluster to Red Hat Virtualization 4.4, all virtual machines in the cluster run the 4.4 version of VDSM. You can configure a cluster’s default BIOS type, which determines the default BIOS type of any new virtual machines you create in that cluster. If necessary, you can override the cluster’s default BIOS type by specifying a different BIOS type when you create a virtual machine.
					
Procedure
	
								In the VM Portal or the Administration Portal, click Compute → Clusters.
							
	
								Select a cluster and click Edit.
							
	
								Click General.
							
	
								Define the default BIOS type for new virtual machines in the cluster by clicking the BIOS Type dropdown menu, and selecting one of the following:
							
	
										Legacy
									
	
										Q35 Chipset with Legacy BIOS
									
	
										Q35 Chipset with UEFI BIOS
									
	
										Q35 Chipset with SecureBoot
									



	
								From the Compatibility Version dropdown menu select 4.4. The Manager checks that all running hosts are compatible with 4.4, and if they are, the Manager uses 4.4 features.
							
	
								If any existing virtual machines in the cluster should use the new BIOS type, configure them to do so. Any new virtual machines in the cluster that are configured to use the BIOS type Cluster default now use the BIOS type you selected. For more information, see Configuring a virtual machine to use the Q35 Chipset and UEFI.
							


Note

							Because you can change the BIOS type only before installing an operating system, for any existing virtual machines that are configured to use the BIOS type Cluster default, change the BIOS type to the previous default cluster BIOS type. Otherwise the virtual machine might not boot. Alternatively, you can reinstall the virtual machine’s operating system.
						


Configuring a virtual machine to use the Q35 Chipset and UEFI




						You can configure a virtual machine to use the Q35 chipset and UEFI before installing an operating system. Converting a virtual machine from legacy BIOS to UEFI, or from UEFI to legacy BIOS, might prevent the virtual machine from booting. If you change the BIOS type of an existing virtual machine, reinstall the operating system.
					
Warning

							If the virtual machine’s BIOS type is set to Cluster default, changing the BIOS type of the cluster changes the BIOS type of the virtual machine. If the virtual machine has an operating system installed, changing the cluster BIOS type can cause booting the virtual machine to fail.
						

Procedure

							To configure a virtual machine to use the Q35 chipset and UEFI:
						
	
								In the VM Portal or the Administration Portal click Compute → Virtual Machines.
							
	
								Select a virtual machine and click Edit.
							
	
								On the General tab, click Show Advanced Options.
							
	
								Click System → Advanced Parameters.
							
	
								Select one of the following from the BIOS Type dropdown menu:
							
	
										Cluster default
									
	
										Q35 Chipset with Legacy BIOS
									
	
										Q35 Chipset with UEFI BIOS
									
	
										Q35 Chipset with SecureBoot
									



	
								Click OK.
							
	
								From the Virtual Machine portal or the Administration Portal, power off the virtual machine. The next time you start the virtual machine, it will run with the new BIOS type you selected.
							



Changing the Cluster Compatibility Version




						Red Hat Virtualization clusters have a compatibility version. The cluster compatibility version indicates the features of Red Hat Virtualization supported by all of the hosts in the cluster. The cluster compatibility is set according to the version of the least capable host operating system in the cluster.
					
Prerequisites
	
								To change the cluster compatibility level, you must first update all the hosts in your cluster to a level that supports your desired compatibility level. Check if there is an icon next to the host indicating an update is available.
							


Limitations
	
								Virtio NICs are enumerated as a different device after upgrading the cluster compatibility level to 4.6. Therefore, the NICs might need to be reconfigured. Red Hat recommends that you test the virtual machines before you upgrade the cluster by setting the cluster compatibility level to 4.6 on the virtual machine and verifying the network connection.
							

								If the network connection for the virtual machine fails, configure the virtual machine with a custom emulated machine that matches the current emulated machine, for example pc-q35-rhel8.3.0 for 4.5 compatibility version, before upgrading the cluster.
							



Procedure
	
								In the Administration Portal, click Compute → Clusters.
							
	
								Select the cluster to change and click Edit.
							
	
								On the General tab, change the Compatibility Version to the desired value.
							
	
								Click OK. The Change Cluster Compatibility Version confirmation dialog opens.
							
	
								Click OK to confirm.
							


Important

							An error message might warn that some virtual machines and templates are incorrectly configured. To fix this error, edit each virtual machine manually. The Edit Virtual Machine window provides additional validations and warnings that show what to correct. Sometimes the issue is automatically corrected and the virtual machine’s configuration just needs to be saved again. After editing each virtual machine, you will be able to change the cluster compatibility version.
						


						After updating a cluster’s compatibility version, you must update the cluster compatibility version of all running or suspended virtual machines by rebooting them from the Administration Portal, or using the REST API, or from within the guest operating system. Virtual machines that require a reboot are marked with the pending changes icon ( 
						[image: pendingchanges]
						 ). You cannot change the cluster compatibility version of a virtual machine snapshot that is in preview. You must first commit or undo the preview.
					

						In a self-hosted engine environment, the Manager virtual machine does not need to be restarted.
					

						Although you can wait to reboot the virtual machines at a convenient time, rebooting immediately is highly recommended so that the virtual machines use the latest configuration. Virtual machines that have not been updated run with the old configuration, and the new configuration could be overwritten if other changes are made to the virtual machine before the reboot.
					

						Once you have updated the compatibility version of all clusters and virtual machines in a data center, you can then change the compatibility version of the data center itself.
					



Logical Networks



Logical Network Tasks



Performing Networking Tasks




						Network → Networks provides a central location for users to perform logical network-related operations and search for logical networks based on each network’s property or association with other resources. The New, Edit and Remove buttons allow you to create, change the properties of, and delete logical networks within data centers.
					

						Click each network name and use the tabs in the details view to perform functions including:
					
	
								Attaching or detaching the networks to clusters and hosts
							
	
								Removing network interfaces from virtual machines and templates
							
	
								Adding and removing permissions for users to access and manage networks
							



						These functions are also accessible through each individual resource.
					
Warning

							Do not change networking in a data center or a cluster if any hosts are running as this risks making the host unreachable.
						

Important

							If you plan to use Red Hat Virtualization nodes to provide any services, remember that the services will stop if the Red Hat Virtualization environment stops operating.
						

							This applies to all services, but you should be especially aware of the hazards of running the following on Red Hat Virtualization:
						
	
									Directory Services
								
	
									DNS
								
	
									Storage
								




Creating a New Logical Network in a Data Center or Cluster




						Create a logical network and define its use in a data center, or in clusters in a data center.
					
Procedure
	
								Click Compute → Data Centers or Compute → Clusters.
							
	
								Click the data center or cluster name. The Details view opens.
							
	
								Click the Logical Networks tab.
							
	
								Open the New Logical Network window:
							
	
										From a data center details view, click New.
									
	
										From a cluster details view, click Add Network.
									



	
								Enter a Name, Description, and Comment for the logical network.
							
	
								Optional: Enable Enable VLAN tagging.
							
	
								Optional: Disable VM Network.
							
	
								Optional: Select the Create on external provider checkbox. This disables the network label and the VM network. See External Providers for details.
							
	
										Select the External Provider. The External Provider list does not include external providers that are in read-only mode.
									
	
										To create an internal, isolated network, select ovirt-provider-ovn on the External Provider list and leave Connect to physical network cleared.
									



	
								Enter a new label or select an existing label for the logical network in the Network Label text field.
							
	
								For MTU, either select Default (1500) or select Custom and specify a custom value.
							
Important

									After you create a network on an external provider, you cannot change the network’s MTU settings.
								

Important

									If you change the network’s MTU settings, you must propagate this change to the running virtual machines on the network: Hot unplug and replug every virtual machine’s vNIC that should apply the MTU setting, or restart the virtual machines. Otherwise, these interfaces fail when the virtual machine migrates to another host. For more information, see After network MTU change, some VMs and bridges have the old MTU and seeing packet drops and BZ#1766414.
								


	
								If you selected ovirt-provider-ovn from the External Provider drop-down list, define whether the network should implement Security Groups. See Logical Network General Settings Explained for details.
							
	
								From the Cluster tab, select the clusters to which the network will be assigned. You can also specify whether the logical network will be a required network.
							
	
								If the Create on external provider checkbox is selected, the Subnet tab is visible. From the Subnet tab, select the Create subnet and enter a Name, CIDR, and Gateway address, and select an IP Version for the subnet that the logical network will provide. You can also add DNS servers as required.
							
	
								From the vNIC Profiles tab, add vNIC profiles to the logical network as required.
							
	
								Click OK.
							



						If you entered a label for the logical network, it is automatically added to all host network interfaces with that label.
					
Note

							When creating a new logical network or making changes to an existing logical network that is used as a display network, any running virtual machines that use that network must be rebooted before the network becomes available or the changes are applied.
						


Editing a Logical Network



Important

							A logical network cannot be edited or moved to another interface if it is not synchronized with the network configuration on the host. See Editing Host Network Interfaces and Assigning Logical Networks to Hosts on how to synchronize your networks.
						

Important

							When changing the VM Network property of an existing logical network used as a display network, no new virtual machines can be started on a host already running virtual machines. Only hosts that have no running virtual machines after the change of the VM Network property can start new virtual machines.
						

Procedure
	
								Click Compute → Data Centers.
							
	
								Click the data center’s name. This opens the details view.
							
	
								Click the Logical Networks tab and select a logical network.
							
	
								Click Edit.
							
	
								Edit the necessary settings.
							
Note

									You can edit the name of a new or existing network, with the exception of the default network, without having to stop the virtual machines.
								


	
								Click OK.
							


Note

							Multi-host network configuration automatically applies updated network settings to all of the hosts within the data center to which the network is assigned. Changes can only be applied when virtual machines using the network are down. You cannot rename a logical network that is already configured on a host. You cannot disable the VM Network option while virtual machines or templates using that network are running.
						


Removing a Logical Network




						You can remove a logical network from Network → Networks or Compute → Data Centers. The following procedure shows you how to remove logical networks associated to a data center. For a working Red Hat Virtualization environment, you must have at least one logical network used as the ovirtmgmt management network.
					
Procedure
	
								Click Compute → Data Centers.
							
	
								Click a data center’s name. This opens the details view.
							
	
								Click the Logical Networks tab to list the logical networks in the data center.
							
	
								Select a logical network and click Remove.
							
	
								Optionally, select the Remove external network(s) from the provider(s) as well check box to remove the logical network both from the Manager and from the external provider if the network is provided by an external provider. The check box is grayed out if the external provider is in read-only mode.
							
	
								Click OK.
							



						The logical network is removed from the Manager and is no longer available.
					

Configuring a Non-Management Logical Network as the Default Route




						The default route used by hosts in a cluster is through the management network (ovirtmgmt). The following procedure provides instructions to configure a non-management logical network as the default route.
					

						Prerequisite:
					
	
								If you are using the default_route custom property, you need to clear the custom property from all attached hosts and then follow this procedure.
							



						Configuring the Default Route Role
					
	
								Click Network → Networks.
							
	
								Click the name of the non-management logical network to configure as the default route to access its details.
							
	
								Click the Clusters tab.
							
	
								Click Manage Network. This opens the Manage Network window.
							
	
								Select the Default Route checkbox for the appropriate cluster(s).
							
	
								Click OK.
							



						When networks are attached to a host, the default route of the host will be set on the network of your choice. It is recommended to configure the default route role before any host is added to your cluster. If your cluster already contains hosts, they may become out-of-sync until you sync your change to them.
					
Important Limitations with IPv6
	
								For IPv6, Red Hat Virtualization supports only static addressing.
							
	
								If both networks share a single gateway (are on the same subnet), you can move the default route role from the management network (ovirtmgmt) to another logical network.
							
	
								If the host and Manager are not on the same subnet, the Manager loses connectivity with the host because the IPv6 gateway has been removed.
							
	
								Moving the default route role to a non-management network removes the IPv6 gateway from the network interface and generates an alert: "On cluster clustername the 'Default Route Role' network is no longer network ovirtmgmt. The IPv6 gateway is being removed from this network."
							



Adding a static route on a host




						You can use nmstate to add static routes to hosts. This method requires you to configure the hosts directly, without using Red Hat Virtualization Manager.
					

						Static-routes you add are preserved as long as the related routed bridge, interface, or bond exists and has an IP address. Otherwise, the system removes the static route.
					
Important

							Except for adding or removing a static route on a host, always use the RHV Manager to configure host network settings in your cluster. For details, see Network Manager Stateful Configuration (nmstate).
						

Note

							The custom static-route is preserved so long as its interface/bond exists and has an IP address. Otherwise, it will be removed.
						

							As a result, VM networks behave differently from non-VM networks:
						
	
									VM networks are based on a bridge. Moving the network from one interfaces/bond to another does not affect the route on a VM Network.
								
	
									Non-VM networks are based on an interface. Moving the network from one interfaces/bond to another deletes the route related to the Non-VM network.
								



Prerequisites

							This procedure requires nmstate, which is only available if your environment uses:
						
	
								Red Hat Virtualization Manager version 4.4
							
	
								Red Hat Enterprise Linux hosts and Red Hat Virtualization Hosts that are based on Red Hat Enterprise Linux 8
							


Procedure
	
								Connect to the host you want to configure.
							
	
								On the host, create a static_route.yml file, with the following example content:
							
routes:
  config:
  - destination: 192.168.123.0/24
    next-hop-address: 192.168.178.1
    next-hop-interface: eth1

	
								Replace the example values shown with real values for your network.
							
	
								To route your traffic to a secondary added network, use next-hop-interface to specify an interface or network name.
							
	
										To use a non-virtual machine network, specify an interface such as eth1.
									
	
										To use a virtual machine network, specify a network name that is also the bridge name such as net1.
									



	
								Run this command:
							
$ nmstatectl set static_route.yml



Verification steps
	
								Run the IP route command, ip route, with the destination parameter value you set in static_route.yml. This should show the desired route. For example, run the following command:
							
$ ip route | grep 192.168.123.0`



Additional resources
	
								Network Manager Stateful Configuration (nmstate)
							
	
								Removing a static route on a host
							



Removing a static route on a host




						You can use nmstate to remove static routes from hosts. This method requires you to configure the hosts directly, without using Red Hat Virtualization Manager.
					
Important

							Except for adding or removing a static route on a host, always use the RHV Manager to configure host network settings in your cluster. For details, see Network Manager Stateful Configuration (nmstate).
						

Note

							The custom static-route is preserved so long as its interface/bond exists and has an IP address. Otherwise, it will be removed.
						

							As a result, VM networks behave differently from non-VM networks:
						
	
									VM networks are based on a bridge. Moving the network from one interfaces/bond to another does not affect the route on a VM Network.
								
	
									Non-VM networks are based on an interface. Moving the network from one interfaces/bond to another deletes the route related to the Non-VM network.
								



Prerequisites

							This procedure requires nmstate, which is only available if your environment uses:
						
	
								Red Hat Virtualization Manager version 4.4
							
	
								Red Hat Enterprise Linux hosts and Red Hat Virtualization Hosts that are based on Red Hat Enterprise Linux 8
							


Procedure
	
								Connect to the host you want to reconfigure.
							
	
								On the host, edit the static_route.yml file.
							
	
								Insert a line state: absent as shown in the following example.
							
	
								Add the value of next-hop-interface between the brackets of interfaces: []. The result should look similar to the example shown here.
							
routes:
  config:
  - destination: 192.168.123.0/24
    next-hop-address: 192.168.178.
    next-hop-interface: eth1
    state: absent
interfaces: [{“name”: eth1}]

	
								Run this command:
							
$ nmstatectl set static_route.yml



Verification steps
	
								Run the IP route command, ip route, with the destination parameter value you set in static_route.yml. This should no longer show the desired route. For example, run the following command:
							
$ ip route | grep 192.168.123.0`



Additional resources
	
								Network Manager Stateful Configuration (nmstate)
							
	
								Adding a static route on a host
							



Viewing or Editing the Gateway for a Logical Network




						Users can define the gateway, along with the IP address and subnet mask, for a logical network. This is necessary when multiple networks exist on a host and traffic should be routed through the specified network, rather than the default gateway.
					

						If multiple networks exist on a host and the gateways are not defined, return traffic will be routed through the default gateway, which may not reach the intended destination. This would result in users being unable to ping the host.
					

						Red Hat Virtualization handles multiple gateways automatically whenever an interface goes up or down.
					
Procedure
	
								Click Compute → Hosts.
							
	
								Click the host’s name. This opens the details view.
							
	
								Click the Network Interfaces tab to list the network interfaces attached to the host, and their configurations.
							
	
								Click Setup Host Networks.
							
	
								Hover your cursor over an assigned logical network and click the pencil icon. This opens the Edit Management Network window.
							



						The Edit Management Network window displays the network name, the boot protocol, and the IP, subnet mask, and gateway addresses. The address information can be manually edited by selecting a Static boot protocol.
					

Logical Network General Settings Explained




						The table below describes the settings for the General tab of the New Logical Network and Edit Logical Network window.
					
Table 2.15. New Logical Network and Edit Logical Network Settings
	Field Name	Description
	 
										Name
									

									 	 
										The name of the logical network. This text field must be a unique name with any combination of uppercase and lowercase letters, numbers, hyphens, and underscores.
									

									 
										Note that while the name of the logical network can be longer than 15 characters and can contain non-ASCII characters, the on-host identifier (vdsm_name) will differ from the name you defined. See Mapping VDSM Names to Logical Network Names for instructions on displaying a mapping of these names.
									

									 
	 
										Description
									

									 	 
										The description of the logical network. This text field has a 40-character limit.
									

									 
	 
										Comment
									

									 	 
										A field for adding plain text, human-readable comments regarding the logical network.
									

									 
	 
										Create on external provider
									

									 	 
										Allows you to create the logical network to an OpenStack Networking instance that has been added to the Manager as an external provider.
									

									 
										External Provider - Allows you to select the external provider on which the logical network will be created.
									

									 
	 
										Enable VLAN tagging
									

									 	 
										VLAN tagging is a security feature that gives all network traffic carried on the logical network a special characteristic. VLAN-tagged traffic cannot be read by interfaces that do not also have that characteristic. Use of VLANs on logical networks also allows a single network interface to be associated with multiple, differently VLAN-tagged logical networks. Enter a numeric value in the text entry field if VLAN tagging is enabled.
									

									 
	 
										VM Network
									

									 	 
										Select this option if only virtual machines use this network. If the network is used for traffic that does not involve virtual machines, such as storage communications, do not select this check box.
									

									 
	 
										Port Isolation
									

									 	 
										If this is set, virtual machines on the same host are prevented from communicating and seeing each other on this logical network. For this option to work on different hypervisors, the switches need to be configured with PVLAN/Port Isolation on the respective port/VLAN connected to the hypervisors, and not reflect back the frames with any hairpin setting.
									

									 
	 
										MTU
									

									 	 
										Choose either Default, which sets the maximum transmission unit (MTU) to the value given in the parenthesis (), or Custom to set a custom MTU for the logical network. You can use this to match the MTU supported by your new logical network to the MTU supported by the hardware it interfaces with. Enter a numeric value in the text entry field if Custom is selected. IMPORTANT: If you change the network’s MTU settings, you must propagate this change to the running virtual machines on the network: Hot unplug and replug every virtual machine’s vNIC that should apply the MTU setting, or restart the virtual machines. Otherwise, these interfaces fail when the virtual machine migrates to another host. For more information, see After network MTU change, some VMs and bridges have the old MTU and seeing packet drops and BZ#1766414.
									

									 
	 
										Network Label
									

									 	 
										Allows you to specify a new label for the network or select from existing labels already attached to host network interfaces. If you select an existing label, the logical network will be automatically assigned to all host network interfaces with that label.
									

									 
	 
										Security Groups
									

									 	 
										Allows you to assign security groups to the ports on this logical network. Disabled disables the security group feature. Enabled enables the feature. When a port is created and attached to this network, it will be defined with port security enabled. This means that access to/from the virtual machines will be subject to the security groups currently being provisioned. Inherit from Configuration enables the ports to inherit the behavior from the configuration file that is defined for all networks. By default, the file disables security groups. See Assigning Security Groups to Logical Networks for details.
									

									 




Logical Network Cluster Settings Explained




						The table below describes the settings for the Cluster tab of the New Logical Network window.
					
Table 2.16. New Logical Network Settings
	Field Name	Description
	 
										Attach/Detach Network to/from Cluster(s)
									

									 	 
										Allows you to attach or detach the logical network from clusters in the data center and specify whether the logical network will be a required network for individual clusters.
									

									 
										Name - the name of the cluster to which the settings will apply. This value cannot be edited.
									

									 
										Attach All - Allows you to attach or detach the logical network to or from all clusters in the data center. Alternatively, select or clear the Attach check box next to the name of each cluster to attach or detach the logical network to or from a given cluster.
									

									 
										Required All - Allows you to specify whether the logical network is a required network on all clusters. Alternatively, select or clear the Required check box next to the name of each cluster to specify whether the logical network is a required network for a given cluster.
									

									 




Logical Network vNIC Profiles Settings Explained




						The table below describes the settings for the vNIC Profiles tab of the New Logical Network window.
					
Table 2.17. New Logical Network Settings
	Field Name	Description
	 
										vNIC Profiles
									

									 	 
										Allows you to specify one or more vNIC profiles for the logical network. You can add or remove a vNIC profile to or from the logical network by clicking the plus or minus button next to the vNIC profile. The first field is for entering a name for the vNIC profile.
									

									 
										Public - Allows you to specify whether the profile is available to all users.
									

									 
										QoS - Allows you to specify a network quality of service (QoS) profile to the vNIC profile.
									

									 




Designate a Specific Traffic Type for a Logical Network with the Manage Networks Window




						Specify the traffic type for the logical network to optimize the network traffic flow.
					
Procedure
	
								Click Compute → Clusters.
							
	
								Click the cluster’s name. This opens the details view.
							
	
								Click the Logical Networks tab.
							
	
								Click Manage Networks.
							
	
								Select the appropriate check boxes and radio buttons.
							
	
								Click OK.
							


Note

							Logical networks offered by external providers must be used as virtual machine networks; they cannot be assigned special cluster roles such as display or migration.
						


Explanation of Settings in the Manage Networks Window




						The table below describes the settings for the Manage Networks window.
					
Table 2.18. Manage Networks Settings
	Field	Description/Action
	 
										Assign
									

									 	 
										Assigns the logical network to all hosts in the cluster.
									

									 
	 
										Required
									

									 	 
										A Network marked "required" must remain operational in order for the hosts associated with it to function properly. If a required network ceases to function, any hosts associated with it become non-operational.
									

									 
	 
										VM Network
									

									 	 
										A logical network marked "VM Network" carries network traffic relevant to the virtual machine network.
									

									 
	 
										Display Network
									

									 	 
										A logical network marked "Display Network" carries network traffic relevant to SPICE and to the virtual network controller.
									

									 
	 
										Migration Network
									

									 	 
										A logical network marked "Migration Network" carries virtual machine and storage migration traffic. If an outage occurs on this network, the management network (ovirtmgmt by default) will be used instead.
									

									 




Configuring virtual functions on a NIC



Note

							This is one in a series of topics that show how to set up and configure SR-IOV on Red Hat Virtualization. For more information, see Setting Up and Configuring SR-IOV
						


						Single Root I/O Virtualization (SR-IOV) enables you to use each PCIe endpoint as multiple separate devices by using physical functions (PFs) and virtual functions (VFs). A PCIe card can have between one and eight PFs. Each PF can have many VFs. The number of VFs it can have depends on the specific type of PCIe device.
					

						To configure SR-IOV-capable Network Interface Controllers (NICs), you use the Red Hat Virtualization Manager. There, you can configure the number of VFs on each NIC.
					

						You can configure a VF like you would configure a standalone NIC, including:
					
	
								Assigning one or more logical networks to the VF.
							
	
								Creating bonded interfaces with VFs.
							
	
								Assigning vNICs to VFs for direct device passthrough.
							



						By default, all virtual networks have access to the virtual functions. You can disable this default and specify which networks have access to a virtual function.
					
Prerequisite
	
								For a vNIC to be attached to a VF must, its passthrough property must be enabled. For details, see Enabling_Passthrough_on_a_vNIC_Profile.
							


Procedure
	
								Click Compute → Hosts.
							
	
								Click the name of an SR-IOV-capable host. This opens the details view.
							
	
								Click the Network Interfaces tab.
							
	
								Click Setup Host Networks.
							
	
								Select an SR-IOV-capable NIC, marked with a 
								[image: SR IOV icon]
								 , and click the pencil icon.
							
	
								Optional: To change the number of virtual functions, click the Number of VFs setting drop-down button and edit the Number of VFs text field.
							
Important

									Changing the number of VFs deletes all previous VFs on the network interface before creating the new VFs. This includes any VFs that have virtual machines directly attached.
								


	
								Optional: To limit which virtual networks have access virtual functions, select Specific networks.
							
	
										Select the networks that should have access to the VF, or use Labels to select networks based on their network labels.
									



	
								Click OK.
							
	
								In the Setup Host Networks window, click OK.
							




Virtual Network Interface Cards (vNICs)



vNIC Profile Overview




						A Virtual Network Interface Card (vNIC) profile is a collection of settings that can be applied to individual virtual network interface cards in the Manager. A vNIC profile allows you to apply Network QoS profiles to a vNIC, enable or disable port mirroring, and add or remove custom properties. A vNIC profile also offers an added layer of administrative flexibility in that permission to use (consume) these profiles can be granted to specific users. In this way, you can control the quality of service that different users receive from a given network.
					

Creating or Editing a vNIC Profile




						Create or edit a Virtual Network Interface Controller (vNIC) profile to regulate network bandwidth for users and groups.
					
Note

							If you are enabling or disabling port mirroring, all virtual machines using the associated profile must be in a down state before editing.
						

Procedure
	
								Click Network → Networks.
							
	
								Click the logical network’s name. This opens the details view.
							
	
								Click the vNIC Profiles tab.
							
	
								Click New or Edit.
							
	
								Enter the Name and Description of the profile.
							
	
								Select the relevant Quality of Service policy from the QoS list.
							
	
								Select a Network Filter from the drop-down list to manage the traffic of network packets to and from virtual machines. For more information on network filters, see Applying network filtering in the Red Hat Enterprise Linux Virtualization Deployment and Administration Guide.
							
	
								Select the Passthrough check box to enable passthrough of the vNIC and allow direct device assignment of a virtual function. Enabling the passthrough property will disable QoS, network filtering, and port mirroring as these are not compatible. For more information on passthrough, see Enabling Passthrough on a vNIC Profile.
							
	
								If Passthrough is selected, optionally deselect the Migratable check box to disable migration for vNICs using this profile. If you keep this check box selected, see Additional Prerequisites for Virtual Machines with SR-IOV-Enabled vNICs in the Virtual Machine Management Guide.
							
	
								Use the Port Mirroring and Allow all users to use this Profile check boxes to toggle these options.
							
	
								Select a custom property from the custom properties list, which displays Please select a key…​ by default. Use the + and - buttons to add or remove custom properties.
							
	
								Click OK.
							



						Apply this profile to users and groups to regulate their network bandwidth. If you edited a vNIC profile, you must either restart the virtual machine, or hot unplug and then hot plug the vNIC if the guest operating system supports vNIC hot plug and hot unplug.
					

Explanation of Settings in the VM Interface Profile Window



Table 2.19. VM Interface Profile Window
	Field Name	Description
	 
										Network
									

									 	 
										A drop-down list of the available networks to apply the vNIC profile to.
									

									 
	 
										Name
									

									 	 
										The name of the vNIC profile. This must be a unique name with any combination of uppercase and lowercase letters, numbers, hyphens, and underscores between 1 and 50 characters.
									

									 
	 
										Description
									

									 	 
										The description of the vNIC profile. This field is recommended but not mandatory.
									

									 
	 
										QoS
									

									 	 
										A drop-down list of the available Network Quality of Service policies to apply to the vNIC profile. QoS policies regulate inbound and outbound network traffic of the vNIC.
									

									 
	 
										Network Filter
									

									 	 
										A drop-down list of the available network filters to apply to the vNIC profile. Network filters improve network security by filtering the type of packets that can be sent to and from virtual machines. The default filter is vdsm-no-mac-spoofing, which is a combination of no-mac-spoofing and no-arp-mac-spoofing. For more information on the network filters provided by libvirt, see the Pre-existing network filters section of the Red Hat Enterprise Linux Virtualization Deployment and Administration Guide.
									

									 
										Use <No Network Filter> for virtual machine VLANs and bonds. On trusted virtual machines, choosing not to use a network filter can improve performance.
									

									 Note

											Red Hat no longer supports disabling filters by setting the EnableMACAntiSpoofingFilterRules parameter to false using the engine-config tool. Use the <No Network Filter> option instead.
										


									 
	 
										Passthrough
									

									 	 
										A check box to toggle the passthrough property. Passthrough allows a vNIC to connect directly to a virtual function of a host NIC. The passthrough property cannot be edited if the vNIC profile is attached to a virtual machine.
									

									 
										QoS, network filters, and port mirroring are disabled in the vNIC profile if passthrough is enabled.
									

									 
	 
										Migratable
									

									 	 
										A check box to toggle whether or not vNICs using this profile can be migrated. Migration is enabled by default on regular vNIC profiles; the check box is selected and cannot be changed. When the Passthrough check box is selected, Migratable becomes available and can be deselected, if required, to disable migration of passthrough vNICs.
									

									 
	 
										Failover
									

									 	 
										A drop-down menu to select available vNIC profiles that act as a failover device. Available only when the Passthrough and Migratable check boxes are checked.
									

									 
	 
										Port Mirroring
									

									 	 
										A check box to toggle port mirroring. Port mirroring copies layer 3 network traffic on the logical network to a virtual interface on a virtual machine. It it not selected by default. For further details, see Port Mirroring in the Technical Reference.
									

									 
	 
										Device Custom Properties
									

									 	 
										A drop-down menu to select available custom properties to apply to the vNIC profile. Use the + and - buttons to add and remove properties respectively.
									

									 
	 
										Allow all users to use this Profile
									

									 	 
										A check box to toggle the availability of the profile to all users in the environment. It is selected by default.
									

									 




Enabling Passthrough on a vNIC Profile



Note

							This is one in a series of topics that show how to set up and configure SR-IOV on Red Hat Virtualization. For more information, see Setting Up and Configuring SR-IOV
						


						The passthrough property of a vNIC profile enables a vNIC to be directly connected to a virtual function (VF) of an SR-IOV-enabled NIC. The vNIC will then bypass the software network virtualization and connect directly to the VF for direct device assignment.
					

						The passthrough property cannot be enabled if the vNIC profile is already attached to a vNIC; this procedure creates a new profile to avoid this. If a vNIC profile has passthrough enabled, QoS, network filters, and port mirroring cannot be enabled on the same profile.
					

						For more information on SR-IOV, direct device assignment, and the hardware considerations for implementing these in Red Hat Virtualization, see Hardware Considerations for Implementing SR-IOV.
					
Procedure
	
								Click Network → Networks.
							
	
								Click the logical network’s name. This opens the details view.
							
	
								Click the vNIC Profiles tab to list all vNIC profiles for that logical network.
							
	
								Click New.
							
	
								Enter the Name and Description of the profile.
							
	
								Select the Passthrough check box.
							
	
								Optionally deselect the Migratable check box to disable migration for vNICs using this profile. If you keep this check box selected, see Additional Prerequisites for Virtual Machines with SR-IOV-Enabled vNICs in the Virtual Machine Management Guide.
							
	
								If necessary, select a custom property from the custom properties list, which displays Please select a key…​ by default. Use the + and - buttons to add or remove custom properties.
							
	
								Click OK.
							



						The vNIC profile is now passthrough-capable. To use this profile to directly attach a virtual machine to a NIC or PCI VF, attach the logical network to the NIC and create a new PCI Passthrough vNIC on the desired virtual machine that uses the passthrough vNIC profile. For more information on these procedures respectively, see Editing Host Network Interfaces and Assigning Logical Networks to Hosts, and Adding a New Network Interface in the Virtual Machine Management Guide.
					

Enabling a vNIC profile for SR-IOV migration with failover




						Failover allows the selection of a profile that acts as a failover device during virtual machine migration when the VF needs to be detached, preserving virtual machine communication with minimal interruption.
					
Note

							Failover is a Technology Preview feature only. Technology Preview features are not supported with Red Hat production service-level agreements (SLAs) and might not be functionally complete, and Red Hat does not recommend using them for production. These features provide early access to upcoming product features, enabling customers to test functionality and provide feedback during the development process. For more information see Red Hat Technology Preview Features Support Scope.
						

Prerequisites
	
								The Passthrough and Migratable check boxes of the profile are selected.
							
	
								The failover network is attached to the host.
							
	
								In order to make a vNIC profile acting as failover editable, you must first remove any failover references.
							
	
								vNIC profiles that can act as failover are profiles that are not selected as Passthrough or are not connected to an External Network.
							


Procedure
	
								In the Administration Portal, go to Network → VNIC profiles, select the vNIC profile, click Edit and select a Failover vNIC profile from the drop down list.
							
	
								Click OK to save the profile settings.
							


Note

							Attaching two vNIC profiles that reference the same failover vNIC profile to the same virtual machine will fail in libvirt.
						


Removing a vNIC Profile




						Remove a vNIC profile to delete it from your virtualized environment.
					
Procedure
	
								Click Network → Networks.
							
	
								Click the logical network’s name. This opens the details view.
							
	
								Click the vNIC Profiles tab to display available vNIC profiles.
							
	
								Select one or more profiles and click Remove.
							
	
								Click OK.
							



Assigning Security Groups to vNIC Profiles



Note

							This feature is only available when ovirt-provider-ovn is added as an external network provider. Security groups cannot be created through the Red Hat Virtualization Manager. You must create security groups through OpenStack Networking on the ovirt-provider-ovn. For more information, see Project Security Management in the Red Hat OpenStack Platform Users and Identity Management Guide.
						


						You can assign security groups to the vNIC profile of networks that have been imported from an OpenStack Networking instance and that use the Open vSwitch plug-in. A security group is a collection of strictly enforced rules that allow you to filter inbound and outbound traffic over a network interface. The following procedure outlines how to attach a security group to a vNIC profile.
					
Note

							A security group is identified using the ID of that security group as registered in the Open Virtual Network (OVN) External Network Provider. You can find the IDs of security groups for a given tenant using the OpenStack Networking API, see List Security Groups in the OpenStack API Reference.
						

Procedure
	
								Click Network → Networks.
							
	
								Click the logical network’s name. This opens the details view.
							
	
								Click the vNIC Profiles tab.
							
	
								Click New, or select an existing vNIC profile and click Edit.
							
	
								From the custom properties drop-down list, select SecurityGroups. Leaving the custom property drop-down blank applies the default security settings, which permit all outbound traffic and intercommunication but deny all inbound traffic from outside of the default security group. Note that removing the SecurityGroups property later will not affect the applied security group.
							
	
								In the text field, enter the ID of the security group to attach to the vNIC profile.
							
	
								Click OK.
							



						You have attached a security group to the vNIC profile. All traffic through the logical network to which that profile is attached will be filtered in accordance with the rules defined for that security group.
					

User Permissions for vNIC Profiles




						Configure user permissions to assign users to certain vNIC profiles. Assign the VnicProfileUser role to a user to enable them to use the profile. Restrict users from certain profiles by removing their permission for that profile.
					

						User Permissions for vNIC Profiles
					
	
								Click Network → vNIC Profile.
							
	
								Click the vNIC profile’s name. This opens the details view.
							
	
								Click the Permissions tab to show the current user permissions for the profile.
							
	
								Click Add or Remove to change user permissions for the vNIC profile.
							
	
								In the Add Permissions to User window, click My Groups to display your user groups. You can use this option to grant permissions to other users in your groups.
							



						You have configured user permissions for a vNIC profile.
					


External Provider Networks



Importing Networks From External Providers




						To use networks from an Open Virtual Network (OVN), register the provider with the Manager. See Adding an External Network Provider for more information. Then, use the following procedure to import the networks provided by that provider into the Manager so the networks can be used by virtual machines.
					
Procedure
	
								Click Network → Networks.
							
	
								Click Import.
							
	
								From the Network Provider drop-down list, select an external provider. The networks offered by that provider are automatically discovered and listed in the Provider Networks list.
							
	
								Using the check boxes, select the networks to import in the Provider Networks list and click the down arrow to move those networks into the Networks to Import list.
							
	
								You can customize the name of the network that you are importing. To customize the name, click the network’s name in the Name column, and change the text.
							
	
								From the Data Center drop-down list, select the data center into which the networks will be imported.
							
	
								Optional: Clear the Allow All check box to prevent that network from being available to all users.
							
	
								Click Import.
							



						The selected networks are imported into the target data center and can be attached to virtual machines. See Adding a New Network Interface in the Virtual Machine Management Guide for more information.
					

Limitations to Using External Provider Networks




						The following limitations apply to using logical networks imported from an external provider in a Red Hat Virtualization environment.
					
	
								Logical networks offered by external providers must be used as virtual machine networks, and cannot be used as display networks.
							
	
								The same logical network can be imported more than once, but only to different data centers.
							
	
								You cannot edit logical networks offered by external providers in the Manager. To edit the details of a logical network offered by an external provider, you must edit the logical network directly from the external provider that provides that logical network.
							
	
								Port mirroring is not available for virtual network interface cards connected to logical networks offered by external providers.
							
	
								If a virtual machine uses a logical network offered by an external provider, that provider cannot be deleted from the Manager while the logical network is still in use by the virtual machine.
							
	
								Networks offered by external providers are non-required. As such, scheduling for clusters in which such logical networks have been imported will not take those logical networks into account during host selection. Moreover, it is the responsibility of the user to ensure the availability of the logical network on hosts in clusters in which such logical networks have been imported.
							



Configuring Subnets on External Provider Logical Networks




						A logical network provided by an external provider can only assign IP addresses to virtual machines if one or more subnets have been defined on that logical network. If no subnets are defined, virtual machines will not be assigned IP addresses. If there is one subnet, virtual machines will be assigned an IP address from that subnet, and if there are multiple subnets, virtual machines will be assigned an IP address from any of the available subnets. The DHCP service provided by the external network provider on which the logical network is hosted is responsible for assigning these IP addresses.
					

						While the Red Hat Virtualization Manager automatically discovers predefined subnets on imported logical networks, you can also add or remove subnets to or from logical networks from within the Manager.
					

						If you add Open Virtual Network (OVN) (ovirt-provider-ovn) as an external network provider, multiple subnets can be connected to each other by routers. To manage these routers, you can use the OpenStack Networking API v2.0. Please note, however, that ovirt-provider-ovn has a limitation: Source NAT (enable_snat in the OpenStack API) is not implemented.
					

Adding Subnets to External Provider Logical Networks




						Create a subnet on a logical network provided by an external provider.
					
Procedure
	
								Click Network → Networks.
							
	
								Click the logical network’s name. This opens the details view.
							
	
								Click the Subnets tab.
							
	
								Click New.
							
	
								Enter a Name and CIDR for the new subnet.
							
	
								From the IP Version drop-down list, select either IPv4 or IPv6.
							
	
								Click OK.
							


Note

							For IPv6, Red Hat Virtualization supports only static addressing.
						


Removing Subnets from External Provider Logical Networks




						Remove a subnet from a logical network provided by an external provider.
					
Procedure
	
								Click Network → Networks.
							
	
								Click the logical network’s name. This opens the details view.
							
	
								Click the Subnets tab.
							
	
								Select a subnet and click Remove.
							
	
								Click OK.
							



Assigning Security Groups to Logical Networks and Ports



Note

							This feature is only available when Open Virtual Network (OVN) is added as an external network provider (as ovirt-provider-ovn). Security groups cannot be created through the Red Hat Virtualization Manager. You must create security groups through OpenStack Networking API v2.0 or Ansible.
						


						A security group is a collection of strictly enforced rules that allow you to filter inbound and outbound traffic over a network. You can also use security groups to filter traffic at the port level.
					

						In Red Hat Virtualization 4.2.7, security groups are disabled by default.
					
Procedure
	
								Click Compute → Clusters.
							
	
								Click the cluster name. This opens the details view.
							
	
								Click the Logical Networks tab.
							
	
								Click Add Network and define the properties, ensuring that you select ovirt-provider-ovn from the External Providers drop-down list. For more information, see Creating a new logical network in a data center or cluster.
							
	
								Select Enabled from the Security Group drop-down list. For more details see Logical Network General Settings Explained.
							
	
								Click OK.
							
	
								Create security groups using either OpenStack Networking API v2.0 or Ansible.
							
	
								Create security group rules using either OpenStack Networking API v2.0 or Ansible.
							
	
								Update the ports with the security groups that you defined using either OpenStack Networking API v2.0 or Ansible.
							
	
								Optional. Define whether the security feature is enabled at the port level. Currently, this is only possible using the OpenStack Networking API. If the port_security_enabled attribute is not set, it will default to the value specified in the network to which it belongs.
							




Hosts and Networking



Network Manager Stateful Configuration (nmstate)




						Version 4.4 of Red Hat Virtualization (RHV) uses Network Manager Stateful Configuration (nmstate) to configure networking for RHV hosts that are based on RHEL 8. RHV version 4.3 and earlier use interface configuration (ifcfg) network scripts to manage host networking.
					

						To use nmstate, upgrade the Red Hat Virtualization Manager and hosts as described in the RHV Upgrade Guide.
					

						As an administrator, you do not need to install or configure nmstate. It is enabled by default and runs in the background.
					
Important

							Always use RHV Manager to modify the network configuration of hosts in your clusters. Otherwise, you might create an unsupported configuration.
						


						The change to nmstate is nearly transparent. It only changes how you configure host networking in the following ways:
					
	
								After you add a host to a cluster, always use the RHV Manager to modify the host network.
							
	
								Modifying the host network without using the Manager can create an unsupported configuration.
							
	
								To fix an unsupported configuration, you replace it with a supported one by using the Manager to synchronize the host network. For details, see Synchronizing Host Networks.
							
	
								The only situation where you modify host networks outside the Manager is to configure a static route on a host. For more details, see Adding a static route on a host.
							



						The change to nmstate improves how RHV Manager applies configuration changes you make in Cockpit and Anaconda before adding the host to the Manager. This fixes some issues, such as BZ#1680970 Static IPv6 Address is lost on host deploy if NM manages the interface.
					
Important

							If you use dnf or yum to manually update the nmstate package, restart vdsmd and supervdsmd on the host. For example:
						
# dnf update nmstate
# systemctl restart vdsmd supervdsmd

Important

							If you use dnf or yum to manually update the Network Manager package, restart NetworkManager on the host. For example:
						
# dnf update NetworkManager
# systemctl restart NetworkManager


Refreshing Host Capabilities




						When a network interface card is added to a host, the capabilities of the host must be refreshed to display that network interface card in the Manager.
					
Procedure
	
								Click Compute → Hosts and select a host.
							
	
								Click Management → Refresh Capabilities.
							



						The list of network interface cards in the Network Interfaces tab for the selected host is updated. Any new network interface cards can now be used in the Manager.
					

Editing Host Network Interfaces and Assigning Logical Networks to Hosts




						You can change the settings of physical host network interfaces, move the management network from one physical host network interface to another, and assign logical networks to physical host network interfaces. Bridge and ethtool custom properties are also supported.
					
Warning

							The only way to change the IP address of a host in Red Hat Virtualization is to remove the host and then to add it again.
						

							To change the VLAN settings of a host, see Editing VLAN Settings.
						

Important

							You cannot assign logical networks offered by external providers to physical host network interfaces; such networks are dynamically assigned to hosts as they are required by virtual machines.
						

Note

							If the switch has been configured to provide Link Layer Discovery Protocol (LLDP) information, you can hover your cursor over a physical network interface to view the switch port’s current configuration. This can help to prevent incorrect configuration. Check the following information prior to assigning logical networks:
						
	
									Port Description (TLV type 4) and System Name (TLV type 5) help to detect to which ports and on which switch the host’s interfaces are patched.
								
	
									Port VLAN ID shows the native VLAN ID configured on the switch port for untagged ethernet frames. All VLANs configured on the switch port are shown as VLAN Name and VLAN ID combinations.
								



Procedure
	
								Click Compute → Hosts.
							
	
								Click the host’s name. This opens the details view.
							
	
								Click the Network Interfaces tab.
							
	
								Click Setup Host Networks.
							
	
								Optionally, hover your cursor over host network interface to view configuration information provided by the switch.
							
	
								Attach a logical network to a physical host network interface by selecting and dragging the logical network into the Assigned Logical Networks area next to the physical host network interface.
							
Note

									If a NIC is connected to more than one logical network, only one of the networks can be non-VLAN. All the other logical networks must be unique VLANs.
								


	
								Configure the logical network:
							
	
										Hover your cursor over an assigned logical network and click the pencil icon. This opens the Edit Management Network window.
									
	
										From the IPv4 tab, select a Boot Protocol from None, DHCP, or Static. If you selected Static, enter the IP, Netmask / Routing Prefix, and the Gateway.
									
Note

											For IPv6, only static IPv6 addressing is supported. To configure the logical network, select the IPv6 tab and make the following entries:
										
	
													Set Boot Protocol to Static.
												
	
													For Routing Prefix, enter the length of the prefix using a forward slash and decimals. For example: /48
												
	
													IP: The complete IPv6 address of the host network interface. For example: 2001:db8::1:0:0:6
												
	
													Gateway: The source router’s IPv6 address. For example: 2001:db8::1:0:0:1
												



Note

											If you change the host’s management network IP address, you must reinstall the host for the new IP address to be configured.
										

											Each logical network can have a separate gateway defined from the management network gateway. This ensures traffic that arrives on the logical network will be forwarded using the logical network’s gateway instead of the default gateway used by the management network.
										

Important

											Set all hosts in a cluster to use the same IP stack for their management network; either IPv4 or IPv6 only. Dual stack is not supported.
										


	
										Use the QoS tab to override the default host network quality of service. Select Override QoS and enter the desired values in the following fields:
									
	
												Weighted Share: Signifies how much of the logical link’s capacity a specific network should be allocated, relative to the other networks attached to the same logical link. The exact share depends on the sum of shares of all networks on that link. By default this is a number in the range 1-100.
											
	
												Rate Limit [Mbps]: The maximum bandwidth to be used by a network.
											
	
												Committed Rate [Mbps]: The minimum bandwidth required by a network. The Committed Rate requested is not guaranteed and will vary depending on the network infrastructure and the Committed Rate requested by other networks on the same logical link.
											



	
										To configure a network bridge, click the Custom Properties tab and select bridge_opts from the drop-down list. Enter a valid key and value with the following syntax: key=value. Separate multiple entries with a whitespace character. The following keys are valid, with the values provided as examples. For more information on these parameters, see Explanation of bridge_opts Parameters.
									
forward_delay=1500
group_addr=1:80:c2:0:0:0
group_fwd_mask=0x0
hash_max=512
hello_time=200
max_age=2000
multicast_last_member_count=2
multicast_last_member_interval=100
multicast_membership_interval=26000
multicast_querier=0
multicast_querier_interval=25500
multicast_query_interval=13000
multicast_query_response_interval=1000
multicast_query_use_ifaddr=0
multicast_router=1
multicast_snooping=1
multicast_startup_query_count=2
multicast_startup_query_interval=3125

	
										To configure ethernet properties, click the Custom Properties tab and select ethtool_opts from the drop-down list. Enter a valid value using the format of the command-line arguments of ethtool. For example: :
									
--coalesce em1 rx-usecs 14 sample-interval 3 --offload em2 rx on lro on tso off --change em1 speed 1000 duplex half

										This field can accept wild cards. For example, to apply the same option to all of this network’s interfaces, use:
									
--coalesce * rx-usecs 14 sample-interval 3

										The ethtool_opts option is not available by default; you need to add it using the engine configuration tool. See How to Set Up Manager to Use Ethtool for more information. For more information on ethtool properties, see the manual page by typing man ethtool in the command line.
									

	
										To configure Fibre Channel over Ethernet (FCoE), click the Custom Properties tab and select fcoe from the drop-down list. Enter a valid key and value with the following syntax: key=value. At least enable=yes is required. You can also add dcb=[yes|no] and `auto_vlan=[yes|no]. Separate multiple entries with a whitespace character. The fcoe option is not available by default; you need to add it using the engine configuration tool. See How to Set Up Manager to Use FCoE for more information.
									
Note

											A separate, dedicated logical network is recommended for use with FCoE.
										


	
										To change the default network used by the host from the management network (ovirtmgmt) to a non-management network, configure the non-management network’s default route. See Configuring a Default Route for more information.
									
	
										If your logical network definition is not synchronized with the network configuration on the host, select the Sync network check box. For more information about unsynchronized hosts and how to synchronize them, see Synchronizing host networks.
									



	
								Select the Verify connectivity between Host and Engine check box to check network connectivity. This action only works if the host is in maintenance mode.
							
	
								Click OK.
							


Note

							If not all network interface cards for the host are displayed, click Management → Refresh Capabilities to update the list of network interface cards available for that host.
						

Troubleshooting

							In some cases, making multiple concurrent changes to a host network configuration using the Setup Host Networks window or setupNetwork command fails with an Operation failed: [Cannot setup Networks]. Another Setup Networks or Host Refresh process in progress on the host. Please try later.] error in the event log. This error indicates that some of the changes were not configured on the host. This happens because, to preserve the integrity of the configuration state, only a single setup network command can be processed at a time. Other concurrent configuration commands are queued for up to a default timeout of 20 seconds. To help prevent the above failure from happening, use the engine-config command to increase the timeout period of SetupNetworksWaitTimeoutSeconds beyond 20 seconds. For example:
						
# engine-config --set SetupNetworksWaitTimeoutSeconds=40
Additional resources
	
								Syntax for the engine-config Command
							
	
								setupnetworks POST
							



Synchronizing Host Networks




						The Manager defines a network interface as out-of-sync when the definition of the interface on the host differs from the definitions stored by the Manager.
					

						Out-of-sync networks appear with an Out-of-sync icon 
						[image: out of sync]
						 in the host’s Network Interfaces tab and with this icon 
						[image: out of sync setup]
						 in the Setup Host Networks window.
					

						When a host’s network is out of sync, the only activities that you can perform on the unsynchronized network in the Setup Host Networks window are detaching the logical network from the network interface or synchronizing the network.
					
Understanding How a Host Becomes out-of-sync

							A host will become out of sync if:
						
	
								You make configuration changes on the host rather than using the the Edit Logical Networks window, for example:
							
	
										Changing the VLAN identifier on the physical host.
									
	
										Changing the Custom MTU on the physical host.
									



	
								You move a host to a different data center with the same network name, but with different values/parameters.
							
	
								You change a network’s VM Network property by manually removing the bridge from the host.
							


Important

							If you change the network’s MTU settings, you must propagate this change to the running virtual machines on the network: Hot unplug and replug every virtual machine’s vNIC that should apply the MTU setting, or restart the virtual machines. Otherwise, these interfaces fail when the virtual machine migrates to another host. For more information, see After network MTU change, some VMs and bridges have the old MTU and seeing packet drops and BZ#1766414.
						

Preventing Hosts from Becoming Unsynchronized

							Following these best practices will prevent your host from becoming unsynchronized:
						
	
								Use the Administration Portal to make changes rather than making changes locally on the host.
							
	
								Edit VLAN settings according to the instructions in Editing VLAN Settings.
							


Synchronizing Hosts

							Synchronizing a host’s network interface definitions involves using the definitions from the Manager and applying them to the host. If these are not the definitions that you require, after synchronizing your hosts update their definitions from the Administration Portal. You can synchronize a host’s networks on three levels:
						
	
								Per logical network
							
	
								Per host
							
	
								Per cluster
							


Synchronizing Host Networks on the Logical Network Level
	
								Click Compute → Hosts.
							
	
								Click the host’s name. This opens the details view.
							
	
								Click the Network Interfaces tab.
							
	
								Click Setup Host Networks.
							
	
								Hover your cursor over the unsynchronized network and click the pencil icon. This opens the Edit Network window.
							
	
								Select the Sync network check box.
							
	
								Click OK to save the network change.
							
	
								Click OK to close the Setup Host Networks window.
							


Synchronizing a Host’s Networks on the Host level
	
								Click the Sync All Networks button in the host’s Network Interfaces tab to synchronize all of the host’s unsynchronized network interfaces.
							


Synchronizing a Host’s Networks on the Cluster level
	
								Click the Sync All Networks button in the cluster’s Logical Networks tab to synchronize all unsynchronized logical network definitions for the entire cluster.
							


Note

							You can also synchronize a host’s networks via the REST API. See syncallnetworks in the REST API Guide.
						


Editing a Host’s VLAN Settings




						To change the VLAN settings of a host, the host must be removed from the Manager, reconfigured, and re-added to the Manager.
					

						To keep networking synchronized, do the following:
					
	
								Put the host in maintenance mode.
							
	
								Manually remove the management network from the host. This will make the host reachable over the new VLAN.
							
	
								Add the host to the cluster. Virtual machines that are not connected directly to the management network can be migrated between hosts safely.
							



						The following warning message appears when the VLAN ID of the management network is changed:
					
Changing certain properties (e.g. VLAN, MTU) of the management network could lead to loss of connectivity to hosts in the data center, if its underlying network infrastructure isn't configured to accommodate the changes. Are you sure you want to proceed?

						Proceeding causes all of the hosts in the data center to lose connectivity to the Manager and causes the migration of hosts to the new management network to fail. The management network will be reported as "out-of-sync".
					
Important

							If you change the management network’s VLAN ID, you must reinstall the host to apply the new VLAN ID.
						


Adding Multiple VLANs to a Single Network Interface Using Logical Networks




						Multiple VLANs can be added to a single network interface to separate traffic on the one host.
					
Important

							You must have created more than one logical network, all with the Enable VLAN tagging check box selected in the New Logical Network or Edit Logical Network windows.
						

Procedure
	
								Click Compute → Hosts.
							
	
								Click the host’s name. This opens the details view.
							
	
								Click the Network Interfaces tab.
							
	
								Click Setup Host Networks.
							
	
								Drag your VLAN-tagged logical networks into the Assigned Logical Networks area next to the physical network interface. The physical network interface can have multiple logical networks assigned due to the VLAN tagging.
							
	
								Edit the logical networks:
							
	
										Hover your cursor over an assigned logical network and click the pencil icon.
									
	
										If your logical network definition is not synchronized with the network configuration on the host, select the Sync network check box.
									
	
										Select a Boot Protocol:
									
	
												None
											
	
												DHCP
											
	
												Static
											



	
										Provide the IP and Subnet Mask.
									
	
										Click OK.
									



	
								Select the Verify connectivity between Host and Engine check box to run a network check; this will only work if the host is in maintenance mode.
							
	
								Click OK.
							



						Add the logical network to each host in the cluster by editing a NIC on each host in the cluster. After this is done, the network will become operational.
					

						This process can be repeated multiple times, selecting and editing the same network interface each time on each host to add logical networks with different VLAN tags to a single network interface.
					
Copying host networks




							To save time, you can copy a source host’s network configuration to a target host in the same cluster.
						

							Copying the network configuration includes:
						
	
									Logical networks attached to the host, except the ovirtmgmt management network
								
	
									Bonds attached to interfaces
								


Limitations
	
									Do not copy network configurations that contain static IP addresses. Doing this sets the boot protocol in the target host to none.
								
	
									Copying a configuration to a target host with the same interface names as the source host but different physical network connections produces a wrong configuration.
								
	
									The target host must have an equal or greater number of interfaces than the source host. Otherwise, the operation fails.
								
	
									Copying QoS, DNS, and custom_properties is not supported.
								
	
									Network interface labels are not copied.
								


Warning

								Copying host networks replaces ALL network settings on the target host except its attachment to the ovirtmgmt management network.
							

Prerequisites
	
									The number of NICs on the target host must be equal or greater than those on the source host. Otherwise, the operation fails.
								
	
									The hosts must be in the same cluster.
								


Procedure
	
									In the Administration Portal, click Compute → Hosts.
								
	
									Select the source host whose configuration you want to copy.
								
	
									Click Copy Host Networks. This opens the Copy Host Networks window.
								
	
									Use Target Host to select the host that should receive the configuration. The list only shows hosts that are in the same cluster.
								
	
									Click Copy Host Networks.
								
	
									Verify the network settings of the target host
								


Tips
	
									Selecting multiple hosts disables the Copy Host Networks button and context menu.
								
	
									Instead of using the Copy Host Networks button, you can right-click a host and select Copy Host Networks from the context menu.
								
	
									The Copy Host Networks button is also available in any host’s details view.
								




Assigning Additional IPv4 Addresses to a Host Network




						A host network, such as the ovirtmgmt management network, is created with only one IP address when initially set up. This means that if a NIC’s configuration file is configured with multiple IP addresses, only the first listed IP address will be assigned to the host network. Additional IP addresses may be required if connecting to storage, or to a server on a separate private subnet using the same NIC.
					

						The vdsm-hook-extra-ipv4-addrs hook allows you to configure additional IPv4 addresses for host networks. For more information about hooks, see VDSM and Hooks.
					

						In the following procedure, the host-specific tasks must be performed on each host for which you want to configure additional IP addresses.
					
Procedure
	
								On the host that you want to configure additional IPv4 addresses for, install the VDSM hook package. The package needs to be installed manually on Red Hat Enterprise Linux hosts and Red Hat Virtualization Hosts.
							
# dnf install vdsm-hook-extra-ipv4-addrs

	
								On the Manager, run the following command to add the key:
							
# engine-config -s 'UserDefinedNetworkCustomProperties=ipv4_addrs=.*'

	
								Restart the ovirt-engine service:
							
# systemctl restart ovirt-engine.service

	
								In the Administration Portal, click Compute → Hosts.
							
	
								Click the host’s name. This opens the details view.
							
	
								Click the Network Interfaces tab and click Setup Host Networks.
							
	
								Edit the host network interface by hovering the cursor over the assigned logical network and clicking the pencil icon.
							
	
								Select ipv4_addr from the Custom Properties drop-down list and add the additional IP address and prefix (for example 5.5.5.5/24). Multiple IP addresses must be comma-separated.
							
	
								Click OK to close the Edit Network window.
							
	
								Click OK to close the Setup Host Networks window.
							



						The additional IP addresses will not be displayed in the Manager, but you can run the command ip addr show on the host to confirm that they have been added.
					

Adding Network Labels to Host Network Interfaces




						Using network labels allows you to greatly simplify the administrative workload associated with assigning logical networks to host network interfaces. Setting a label on a role network (for instance, a migration network or a display network) causes a mass deployment of that network on all hosts. Such mass additions of networks are achieved through the use of DHCP. This method of mass deployment was chosen over a method of typing in static addresses, because of the unscalable nature of the task of typing in many static IP addresses.
					

						There are two methods of adding labels to a host network interface:
					
	
								Manually, in the Administration Portal
							
	
								Automatically, with the LLDP Labeler service
							


Procedure
	
								Click Compute → Hosts.
							
	
								Click the host’s name. This opens the details view.
							
	
								Click the Network Interfaces tab.
							
	
								Click Setup Host Networks.
							
	
								Click Labels and right-click [New Label]. Select a physical network interface to label.
							
	
								Enter a name for the network label in the Label text field.
							
	
								Click OK.
							


Procedure

							You can automate the process of assigning labels to host network interfaces in the configured list of clusters with the LLDP Labeler service.
						
Configuring the LLDP Labeler




							By default, LLDP Labeler runs as an hourly service. This option is useful if you make hardware changes (for example, NICs, switches, or cables) or change switch configurations.
						
Prerequisites
	
									The interfaces must be connected to a Juniper switch.
								
	
									The Juniper switch must be configured to provide the Port VLAN using LLDP.
								


Procedure
	
									Configure the username and password in /etc/ovirt-lldp-labeler/conf.d/ovirt-lldp-credentials.conf:
								
	
											username - the username of the Manager administrator. The default is admin@internal.
										
	
											password - the password of the Manager administrator. The default is 123456.
										



	
									Configure the LLDP Labeler service by updating the following values in etc/ovirt-lldp-labeler/conf.d/ovirt-lldp-credentials.conf:
								
	
											clusters - a comma-separated list of clusters on which the service should run. Wildcards are supported. For example, Cluster* defines LLDP Labeler to run on all clusters starting with word Cluster. To run the service on all clusters in the data center, type *. The default is Def*.
										
	
											api_url - the full URL of the Manager’s API. The default is https://Manager_FQDN/ovirt-engine/api
										
	
											ca_file - the path to the custom CA certificate file. Leave this value empty if you do not use custom certificates. The default is empty.
										
	
											auto_bonding - enables LLDP Labeler’s bonding capabilities. The default is true.
										
	
											auto_labeling - enables LLDP Labeler’s labeling capabilities. The default is true.
										



	
									Optionally, you can configure the service to run at a different time interval by changing the value of OnUnitActiveSec in etc/ovirt-lldp-labeler/conf.d/ovirt-lldp-labeler.timer. The default is 1h.
								
	
									Configure the service to start now and at boot by entering the following command:
								
# systemctl enable --now ovirt-lldp-labeler

									To invoke the service manually, enter the following command:
								
# /usr/bin/python /usr/share/ovirt-lldp-labeler/ovirt_lldp_labeler_cli.py




							You have added a network label to a host network interface. Newly created logical networks with the same label are automatically assigned to all host network interfaces with that label. Removing a label from a logical network automatically removes that logical network from all host network interfaces with that label.
						


Changing the FQDN of a Host




						Use the following procedure to change the fully qualified domain name of hosts.
					
Procedure
	
								Place the host into maintenance mode so the virtual machines are live migrated to another host. See Moving a host to maintenance mode for more information. Alternatively, manually shut down or migrate all the virtual machines to another host. See Manually Migrating Virtual Machines in the Virtual Machine Management Guide for more information.
							
	
								Click Remove, and click OK to remove the host from the Administration Portal.
							
	
								Use the hostnamectl tool to update the host name. For more options, see Configure Host Names in the Red Hat Enterprise Linux 7 Networking Guide.
							
# hostnamectl set-hostname NEW_FQDN

	
								Reboot the host.
							
	
								Re-register the host with the Manager. See Adding standard hosts to the Manager for more information.
							


IPv6 Networking Support




							Red Hat Virtualization supports static IPv6 networking in most contexts.
						
Note

								Red Hat Virtualization requires IPv6 to remain enabled on the computer or virtual machine where you are running the Manager (also called "the Manager machine"). Do not disable IPv6 on the Manager machine, even if your systems do not use it.
							

Limitations for IPv6
	
									Only static IPv6 addressing is supported. Dynamic IPv6 addressing with DHCP or Stateless Address Autoconfiguration are not supported.
								
	
									Dual-stack addressing, IPv4 and IPv6, is not supported.
								
	
									OVN networking can be used with only IPv4 or IPv6.
								
	
									Switching clusters from IPv4 to IPv6 is not supported.
								
	
									Only a single gateway per host can be set for IPv6.
								
	
									If both networks share a single gateway (are on the same subnet), you can move the default route role from the management network (ovirtmgmt) to another logical network. The host and Manager should have the same IPv6 gateway. If the host and Manager are not on the same subnet, the Manager might lose connectivity with the host because the IPv6 gateway was removed.
								
	
									Using a glusterfs storage domain with an IPv6-addressed gluster server is not supported.
								



Setting Up and Configuring SR-IOV




							This topic summarizes the steps for setting up and configuring SR-IOV, with links out to topics that cover each step in detail.
						
Prerequisites

								Set up your hardware in accordance with the Hardware Considerations for Implementing SR-IOV
							
Procedure

								To set up and configure SR-IOV, complete the following tasks.
							
	
									Configuring a Host for PCI Passthrough.
								
	
									Editing the virtual function configuration on a NIC.
								
	
									Enabling passthrough on a vNIC Profile.
								
	
									Configuring Virtual Machines with SR-IOV-Enabled vNICs to Reduce Network Outage during Migration.
								


Notes
	
									The number of the 'passthrough' vNICs depends on the number of available virtual functions (VFs) on the host. For example, to run a virtual machine (VM) with three SR-IOV cards (vNICs), the host must have three or more VFs enabled.
								
	
									Hotplug and unplug are supported.
								
	
									Live migration is supported.
								
	
									To migrate a VM, the destination host must also have enough available VFs to receive the VM. During the migration, the VM releases a number of VFs on the source host and occupies the same number of VFs on the destination host.
								
	
									On the host, you will see a device, link, or ifcae like any other interface. That device disappears when it is attached to a VM, and reappears when it is released.
								
	
									Avoid attaching a host device directly to a VM for SR-IOV feature.
								
	
									To use a VF as a trunk port with several VLANs and configure the VLANs within the Guest, please see Cannot configure VLAN on SR-IOV VF interfaces inside the Virtual Machine.
								



							Here is an example of what the libvirt XML for the interface would look like:
						
  ----
  <interface type='hostdev'>
     <mac address='00:1a:yy:xx:vv:xx'/>
     <driver name='vfio'/>
     <source>
       <address type='pci' domain='0x0000' bus='0x05' slot='0x10' function='0x0'/>
     </source>
     <alias name='ua-18400536-5688-4477-8471-be720e9efc68'/>
     <address type='pci' domain='0x0000' bus='0x00' slot='0x08' function='0x0'/>
   </interface>
   ----
Troubleshooting

								The following example shows you how to get diagnostic information about the VFs attached to an interface.
							
# ip -s link show dev enp5s0f0

1: enp5s0f0: <BROADCAST,MULTICAST,UP,LOWER_UP> mtu 9000 qdisc mq state UP mode DEFAULT qlen 1000
    link/ether 86:e2:ba:c2:50:f0 brd ff:ff:ff:ff:ff:ff
    RX: bytes  packets  errors  dropped overrun mcast
    30931671   218401   0       0       0       19165434
    TX: bytes  packets  errors  dropped carrier collsns
    997136     13661    0       0       0       0
    vf 0 MAC 02:00:00:00:00:01, spoof checking on, link-state auto, trust off, query_rss off
    vf 1 MAC 00:1a:4b:16:01:5e, spoof checking on, link-state auto, trust off, query_rss off
    vf 2 MAC 02:00:00:00:00:01, spoof checking on, link-state auto, trust off, query_rss off
Additional Resources



	
										How to configure SR-IOV passthrough for RHV VM?
									
	
										How to configure bonding with SR-IOV VF(Virtual Function) in RHV
									
	
										How to enable host device passthrough and SR-IOV to allow assigning dedicated virtual NICs to virtual machines in RHV
									






Network Bonding



Bonding methods




						Network bonding combines multiple NICs into a bond device, with the following advantages:
					
	
								The transmission speed of bonded NICs is greater than that of a single NIC.
							
	
								Network bonding provides fault tolerance, because the bond device will not fail unless all its NICs fail.
							



						Using NICs of the same make and model ensures that they support the same bonding options and modes.
					
Important

							Red Hat Virtualization’s default bonding mode, (Mode 4) Dynamic Link Aggregation, requires a switch that supports 802.3ad.
						

							The logical networks of a bond must be compatible. A bond can support only 1 non-VLAN logical network. The rest of the logical networks must have unique VLAN IDs.
						

							Bonding must be enabled for the switch ports. Consult the manual provided by your switch vendor for specific instructions.
						


						You can create a network bond device using one of the following methods:
					
	
								Manually, in the Administration Portal, for a specific host
							
	
								Automatically, using LLDP Labeler, for unbonded NICs of all hosts in a cluster or data center
							



						If your environment uses iSCSI storage and you want to implement redundancy, follow the instructions for configuring iSCSI multipathing.
					

Creating a Bond Device in the Administration Portal




						You can create a bond device on a specific host in the Administration Portal. The bond device can carry both VLAN-tagged and untagged traffic.
					
Procedure
	
								Click Compute → Hosts.
							
	
								Click the host’s name. This opens the details view.
							
	
								Click the Network Interfaces tab to list the physical network interfaces attached to the host.
							
	
								Click Setup Host Networks.
							
	
								Check the switch configuration. If the switch has been configured to provide Link Layer Discovery Protocol (LLDP) information, hover your cursor over a physical NIC to view the switch port’s aggregation configuration.
							
	
								Drag and drop a NIC onto another NIC or onto a bond.
							
Note

									Two NICs form a new bond. A NIC and a bond adds the NIC to the existing bond.
								

									If the logical networks are incompatible, the bonding operation is blocked.
								


	
								Select the Bond Name and Bonding Mode from the drop-down menus. See Bonding Modes for details.
							

								If you select the Custom bonding mode, you can enter bonding options in the text field, as in the following examples:
							
	
										If your environment does not report link states with ethtool, you can set ARP monitoring by entering mode=1 arp_interval=1 arp_ip_target=192.168.0.2.
									
	
										You can designate a NIC with higher throughput as the primary interface by entering mode=1 primary=eth0.
									

										For a comprehensive list of bonding options and their descriptions, see the Linux Ethernet Bonding Driver HOWTO on Kernel.org.
									




	
								Click OK.
							
	
								Attach a logical network to the new bond and configure it. See Editing Host Network Interfaces and Assigning Logical Networks to Hosts for instructions.
							
Note

									You cannot attach a logical network directly to an individual NIC in the bond.
								


	
								Optionally, you can select Verify connectivity between Host and Engine if the host is in maintenance mode.
							
	
								Click OK.
							



Creating a Bond Device with the LLDP Labeler Service




						The LLDP Labeler service enables you to create a bond device automatically with all unbonded NICs, for all the hosts in one or more clusters or in the entire data center. The bonding mode is (Mode 4) Dynamic Link Aggregation(802.3ad).
					

						NICs with incompatible logical networks cannot be bonded.
					
Configuring the LLDP Labeler




							By default, LLDP Labeler runs as an hourly service. This option is useful if you make hardware changes (for example, NICs, switches, or cables) or change switch configurations.
						
Prerequisites
	
									The interfaces must be connected to a Juniper switch.
								
	
									The Juniper switch must be configured for Link Aggregation Control Protocol (LACP) using LLDP.
								


Procedure
	
									Configure the username and password in /etc/ovirt-lldp-labeler/conf.d/ovirt-lldp-credentials.conf:
								
	
											username - the username of the Manager administrator. The default is admin@internal.
										
	
											password - the password of the Manager administrator. The default is 123456.
										



	
									Configure the LLDP Labeler service by updating the following values in etc/ovirt-lldp-labeler/conf.d/ovirt-lldp-credentials.conf:
								
	
											clusters - a comma-separated list of clusters on which the service should run. Wildcards are supported. For example, Cluster* defines LLDP Labeler to run on all clusters starting with word Cluster. To run the service on all clusters in the data center, type *. The default is Def*.
										
	
											api_url - the full URL of the Manager’s API. The default is https://Manager_FQDN/ovirt-engine/api
										
	
											ca_file - the path to the custom CA certificate file. Leave this value empty if you do not use custom certificates. The default is empty.
										
	
											auto_bonding - enables LLDP Labeler’s bonding capabilities. The default is true.
										
	
											auto_labeling - enables LLDP Labeler’s labeling capabilities. The default is true.
										



	
									Optionally, you can configure the service to run at a different time interval by changing the value of OnUnitActiveSec in etc/ovirt-lldp-labeler/conf.d/ovirt-lldp-labeler.timer. The default is 1h.
								
	
									Configure the service to start now and at boot by entering the following command:
								
# systemctl enable --now ovirt-lldp-labeler

									To invoke the service manually, enter the following command:
								
# /usr/bin/python /usr/share/ovirt-lldp-labeler/ovirt_lldp_labeler_cli.py



	
									Attach a logical network to the new bond and configure it. See Editing Host Network Interfaces and Assigning Logical Networks to Hosts for instructions.
								
Note

										You cannot attach a logical network directly to an individual NIC in the bond.
									






Bonding Modes




						The packet dispersal algorithm is determined by the bonding mode. (See the Linux Ethernet Bonding Driver HOWTO for details). Red Hat Virtualization’s default bonding mode is (Mode 4) Dynamic Link Aggregation(802.3ad).
					

						Red Hat Virtualization supports the following bonding modes, because they can be used in virtual machine (bridged) networks:
					
	(Mode 1) Active-Backup
	
									One NIC is active. If the active NIC fails, one of the backup NICs replaces it as the only active NIC in the bond. The MAC address of this bond is visible only on the network adapter port. This prevents MAC address confusion that might occur if the MAC address of the bond were to change, reflecting the MAC address of the new active NIC.
								
	(Mode 2) Load Balance (balance-xor)
	
									The NIC that transmits packets is selected by performing an XOR operation on the source MAC address and the destination MAC address, multiplied by the modulo of the total number of NICs. This algorithm ensures that the same NIC is selected for each destination MAC address.
								
	(Mode 3) Broadcast
	
									Packets are transmitted to all NICs.
								
	(Mode 4) Dynamic Link Aggregation(802.3ad) (Default)
	
									The NICs are aggregated into groups that share the same speed and duplex settings . All the NICs in the active aggregation group are used.
								
Note

										(Mode 4) Dynamic Link Aggregation(802.3ad) requires a switch that supports 802.3ad.
									

										The bonded NICs must have the same aggregator IDs. Otherwise, the Manager displays a warning exclamation mark icon on the bond in the Network Interfaces tab and the ad_partner_mac value of the bond is reported as 00:00:00:00:00:00. You can check the aggregator IDs by entering the following command:
									
# cat /proc/net/bonding/bond0

										See Which bonding modes work when used with a bridge that virtual machine guests or containers connect to?.
									





						The following bonding modes are incompatible with virtual machine logical networks and therefore only non-VM logical networks can be attached to bonds using these modes:
					
	(Mode 0) Round-Robin
	
									The NICs transmit packets in sequential order. Packets are transmitted in a loop that begins with the first available NIC in the bond and ends with the last available NIC in the bond. Subsequent loops start with the first available NIC.
								
	(Mode 5) Balance-TLB, also called Transmit Load-Balance
	
									Outgoing traffic is distributed, based on the load, over all the NICs in the bond. Incoming traffic is received by the active NIC. If the NIC receiving incoming traffic fails, another NIC is assigned.
								
	(Mode 6) Balance-ALB, also called Adaptive Load-Balance
	
									(Mode 5) Balance-TLB is combined with receive load-balancing for IPv4 traffic. ARP negotiation is used for balancing the receive load.
								





Hosts



Introduction to Hosts




					Hosts, also known as hypervisors, are the physical servers on which virtual machines run. Full virtualization is provided by using a loadable Linux kernel module called Kernel-based Virtual Machine (KVM).
				

					KVM can concurrently host multiple virtual machines running either Windows or Linux operating systems. Virtual machines run as individual Linux processes and threads on the host machine and are managed remotely by the Red Hat Virtualization Manager. A Red Hat Virtualization environment has one or more hosts attached to it.
				

					Red Hat Virtualization supports two methods of installing hosts. You can use the Red Hat Virtualization Host (RHVH) installation media, or install hypervisor packages on a standard Red Hat Enterprise Linux installation.
				
Note

						You can identify the host type of an individual host in the Red Hat Virtualization Manager by selecting the host’s name. This opens the details view. Then look at the OS Description under Software.
					


					Hosts use tuned profiles, which provide virtualization optimizations. For more information on tuned, see the TuneD Profiles in Red Hat Enterprise Linux Monitoring and managing system status and performance.
				

					The Red Hat Virtualization Host has security features enabled. Security Enhanced Linux (SELinux) and the firewall are fully configured and on by default. The status of SELinux on a selected host is reported under SELinux mode in the General tab of the details view. The Manager can open required ports on Red Hat Enterprise Linux hosts when it adds them to the environment.
				

					A host is a physical 64-bit server with the Intel VT or AMD-V extensions running Red Hat Enterprise Linux 7 AMD64/Intel 64 version.
				

					A physical host on the Red Hat Virtualization platform:
				
	
							Must belong to only one cluster in the system.
						
	
							Must have CPUs that support the AMD-V or Intel VT hardware virtualization extensions.
						
	
							Must have CPUs that support all functionality exposed by the virtual CPU type selected upon cluster creation.
						
	
							Has a minimum of 2 GB RAM.
						
	
							Can have an assigned system administrator with system permissions.
						



					Administrators can receive the latest security advisories from the Red Hat Virtualization watch list. Subscribe to the Red Hat Virtualization watch list to receive new security advisories for Red Hat Virtualization products by email. Subscribe by completing this form:
				

					https://www.redhat.com/mailman/listinfo/rhsa-announce
				

Red Hat Virtualization Host




					Red Hat Virtualization Host (RHVH) is installed using a special build of Red Hat Enterprise Linux with only the packages required to host virtual machines. It uses an Anaconda installation interface based on the one used by Red Hat Enterprise Linux hosts, and can be updated through the Red Hat Virtualization Manager or via yum. Using the yum command is the only way to install additional packages and have them persist after an upgrade.
				

					RHVH features a Cockpit web interface for monitoring the host’s resources and performing administrative tasks. Direct access to RHVH via SSH or console is not supported, so the Cockpit web interface provides a graphical user interface for tasks that are performed before the host is added to the Red Hat Virtualization Manager, such as configuring networking or running terminal commands via the Terminal sub-tab.
				

					Access the Cockpit web interface at https://HostFQDNorIP:9090 in your web browser. Cockpit for RHVH includes a custom Virtualization dashboard that displays the host’s health status, SSH Host Key, self-hosted engine status, virtual machines, and virtual machine statistics.
				

					Starting in Red Hat Virtualization version 4.4 SP1 the RHVH uses systemd-coredump to gather, save and process core dumps. For more information, see the documentation for core dump storage configuration files and systemd-coredump service.
				

					In Red Hat Virtualization 4.4 and earlier RHVH uses the Automatic Bug Reporting Tool (ABRT) to collect meaningful debug information about application crashes. For more information, see the Red Hat Enterprise Linux System Administrator’s Guide.
				
Note

						Custom boot kernel arguments can be added to Red Hat Virtualization Host using the grubby tool. The grubby tool makes persistent changes to the grub.cfg file. Navigate to the Terminal sub-tab in the host’s Cockpit web interface to use grubby commands. See the Red Hat Enterprise Linux System Administrator’s Guide for more information.
					

Warning

						Do not create untrusted users on RHVH, as this can lead to exploitation of local security vulnerabilities.
					


Red Hat Enterprise Linux hosts




					You can use a Red Hat Enterprise Linux 7 installation on capable hardware as a host. Red Hat Virtualization supports hosts running Red Hat Enterprise Linux 7 Server AMD64/Intel 64 version with Intel VT or AMD-V extensions. To use your Red Hat Enterprise Linux machine as a host, you must also attach the Red Hat Enterprise Linux Server and Red Hat Virtualization subscriptions.
				

					Adding a host can take some time, as the following steps are completed by the platform: virtualization checks, installation of packages, and the creation of a bridge. Use the details view to monitor the process as the host and management system establish a connection.
				

					Optionally, you can install a Cockpit web interface for monitoring the host’s resources and performing administrative tasks. The Cockpit web interface provides a graphical user interface for tasks that are performed before the host is added to the Red Hat Virtualization Manager, such as configuring networking or running terminal commands via the Terminal sub-tab.
				
Important

						Third-party watchdogs should not be installed on Red Hat Enterprise Linux hosts, as they can interfere with the watchdog daemon provided by VDSM.
					


Satellite Host Provider Hosts




					Hosts provided by a Satellite host provider can also be used as virtualization hosts by the Red Hat Virtualization Manager. After a Satellite host provider has been added to the Manager as an external provider, any hosts that it provides can be added to and used in Red Hat Virtualization in the same way as Red Hat Virtualization Hosts (RHVH) and Red Hat Enterprise Linux hosts.
				

Host Tasks



Adding Standard Hosts to the Red Hat Virtualization Manager



Important

							Always use the RHV Manager to modify the network configuration of hosts in your clusters. Otherwise, you might create an unsupported configuration. For details, see Network Manager Stateful Configuration (nmstate).
						


						Adding a host to your Red Hat Virtualization environment can take some time, as the following steps are completed by the platform: virtualization checks, installation of packages, and creation of a bridge.
					
Procedure
	
								From the Administration Portal, click Compute → Hosts.
							
	
								Click New.
							
	
								Use the drop-down list to select the Data Center and Host Cluster for the new host.
							
	
								Enter the Name and the Address of the new host. The standard SSH port, port 22, is auto-filled in the SSH Port field.
							
	
								Select an authentication method to use for the Manager to access the host.
							
	
										Enter the root user’s password to use password authentication.
									
	
										Alternatively, copy the key displayed in the SSH PublicKey field to /root/.ssh/authorized_keys on the host to use public key authentication.
									



	
								Optionally, click the Advanced Parameters button to change the following advanced host settings:
							
	
										Disable automatic firewall configuration.
									
	
										Add a host SSH fingerprint to increase security. You can add it manually, or fetch it automatically.
									



	
								Optionally configure power management, where the host has a supported power management card. For information on power management configuration, see Host Power Management Settings Explained in the Administration Guide.
							
	
								Click OK.
							



						The new host displays in the list of hosts with a status of Installing, and you can view the progress of the installation in the Events section of the Notification Drawer ( 
						[image: EventsIcon]
						 ). After a brief delay the host status changes to Up.
					

Adding a Satellite Host Provider Host




						The process for adding a Satellite host provider host is almost identical to that of adding a Red Hat Enterprise Linux host except for the method by which the host is identified in the Manager. The following procedure outlines how to add a host provided by a Satellite host provider.
					
Procedure
	
								Click Compute → Hosts.
							
	
								Click New.
							
	
								Use the drop-down menu to select the Host Cluster for the new host.
							
	
								Select the Foreman/Satellite check box to display the options for adding a Satellite host provider host and select the provider from which the host is to be added.
							
	
								Select either Discovered Hosts or Provisioned Hosts.
							
	
										Discovered Hosts (default option): Select the host, host group, and compute resources from the drop-down lists.
									
	
										Provisioned Hosts: Select a host from the Providers Hosts drop-down list.
									

										Any details regarding the host that can be retrieved from the external provider are automatically set, and can be edited as desired.
									




	
								Enter the Name and SSH Port (Provisioned Hosts only) of the new host.
							
	
								Select an authentication method to use with the host.
							
	
										Enter the root user’s password to use password authentication.
									
	
										Copy the key displayed in the SSH PublicKey field to /root/.ssh/authorized_hosts on the host to use public key authentication (Provisioned Hosts only).
									



	
								You have now completed the mandatory steps to add a Red Hat Enterprise Linux host. Click the Advanced Parameters drop-down button to show the advanced host settings.
							
	
										Optionally disable automatic firewall configuration.
									
	
										Optionally add a host SSH fingerprint to increase security. You can add it manually, or fetch it automatically.
									



	
								You can configure the Power Management, SPM, Console, and Network Provider using the applicable tabs now; however, as these are not fundamental to adding a Red Hat Enterprise Linux host, they are not covered in this procedure.
							
	
								Click OK to add the host and close the window.
							



						The new host displays in the list of hosts with a status of Installing, and you can view the progress of the installation in the details view. After installation is complete, the status will update to Reboot. The host must be activated for the status to change to Up.
					

Setting up Satellite errata viewing for a host




						In the Administration Portal, you can configure a host to view errata from Red Hat Satellite. After you associate a host with a Red Hat Satellite provider, you can receive updates in the host configuration dashboard about available errata and their importance, and decide when it is practical to apply the updates.
					

						Red Hat Virtualization 4.4 supports viewing errata with Red Hat Satellite 6.6.
					
Prerequisites
	
								The Satellite server must be added as an external provider.
							
	
								The Manager and any hosts on which you want to view errata must be registered in the Satellite server by their respective FQDNs. This ensures that external content host IDs do not need to be maintained in Red Hat Virtualization.
							
Important

									Hosts added using an IP address cannot report errata.
								


	
								The Satellite account that manages the host must have Administrator permissions and a default organization set.
							
	
								The host must be registered to the Satellite server.
							
	
								Use Red Hat Satellite remote execution to manage packages on hosts.
							


Note

							The Katello agent is deprecated and will be removed in a future Satellite version. Migrate your processes to use the remote execution feature to update clients remotely.
						

Procedure
	
								Click Compute → Hosts and select the host.
							
	
								Click Edit.
							
	
								Select the Use Foreman/Satellite check box.
							
	
								Select the required Satellite server from the drop-down list.
							
	
								Click OK.
							



						The host is now configured to show the available errata, and their importance, in the same dashboard used to manage the host’s configuration.
					
Additional resources
	
								Adding a Red Hat Satellite Instance for Host Provisioning
							
	
								Host Management Without Goferd and Katello Agent in the Red Hat Satellite document Managing Hosts
							


Configuring a Host for PCI Passthrough



Note

								This is one in a series of topics that show how to set up and configure SR-IOV on Red Hat Virtualization. For more information, see Setting Up and Configuring SR-IOV
							


							Enabling PCI passthrough allows a virtual machine to use a host device as if the device were directly attached to the virtual machine. To enable the PCI passthrough function, you must enable virtualization extensions and the IOMMU function. The following procedure requires you to reboot the host. If the host is attached to the Manager already, ensure you place the host into maintenance mode first.
						
Prerequisites
	
									Ensure that the host hardware meets the requirements for PCI device passthrough and assignment. See PCI Device Requirements for more information.
								


Configuring a Host for PCI Passthrough
	
									Enable the virtualization extension and IOMMU extension in the BIOS. See Enabling Intel VT-x and AMD-V virtualization hardware extensions in BIOS in the Red Hat Enterprise Linux Virtualization Deployment and Administration Guide for more information.
								
	
									Enable the IOMMU flag in the kernel by selecting the Hostdev Passthrough & SR-IOV check box when adding the host to the Manager or by editing the grub configuration file manually.
								
	
											To enable the IOMMU flag from the Administration Portal, see Adding Standard Hosts to the Red Hat Virtualization Manager and Kernel Settings Explained.
										
	
											To edit the grub configuration file manually, see Enabling IOMMU Manually.
										



	
									For GPU passthrough, you need to run additional configuration steps on both the host and the guest system. See GPU device passthrough: Assigning a host GPU to a single virtual machine in Setting up an NVIDIA GPU for a virtual machine in Red Hat Virtualization for more information.
								


Enabling IOMMU Manually
	
									Enable IOMMU by editing the grub configuration file.
								
Note

										If you are using IBM POWER8 hardware, skip this step as IOMMU is enabled by default.
									

	
											For Intel, boot the machine, and append intel_iommu=on to the end of the GRUB_CMDLINE_LINUX line in the grub configuration file.
										
# vi /etc/default/grub
...
GRUB_CMDLINE_LINUX="nofb splash=quiet console=tty0 ... intel_iommu=on
...

	
											For AMD, boot the machine, and append amd_iommu=on to the end of the GRUB_CMDLINE_LINUX line in the grub configuration file.
										
# vi /etc/default/grub
…​
GRUB_CMDLINE_LINUX="nofb splash=quiet console=tty0 …​ amd_iommu=on
…​
Note

												If intel_iommu=on or an AMD IOMMU is detected, you can try adding iommu=pt. The pt option only enables IOMMU for devices used in passthrough and provides better host performance. However, the option might not be supported on all hardware. Revert to the previous option if the pt option doesn’t work for your host.
											

												If the passthrough fails because the hardware does not support interrupt remapping, you can consider enabling the allow_unsafe_interrupts option if the virtual machines are trusted. The allow_unsafe_interrupts is not enabled by default because enabling it potentially exposes the host to MSI attacks from virtual machines. To enable the option:
											
# vi /etc/modprobe.d
options vfio_iommu_type1 allow_unsafe_interrupts=1





	
									Refresh the grub.cfg file and reboot the host for these changes to take effect:
								
# grub2-mkconfig -o /boot/grub2/grub.cfg
# reboot




Enabling nested virtualization for all virtual machines



Important

								Using hooks to enable nested virtualization is a Technology Preview feature. Technology Preview features are not supported with Red Hat production service-level agreements (SLAs) and might not be functionally complete, and Red Hat does not recommend using them for production. These features provide early access to upcoming product features, enabling customers to test functionality and provide feedback during the development process. For more information, see Red Hat Technology Preview Features Support Scope.
							


							Nested virtualization enables virtual machines to host other virtual machines. For clarity, we will call these the parent virtual machines and nested virtual machines.
						

							Child virtual machines are only visible to and managed by users who have access to the parent virtual machine. They are not visible to Red Hat Virtualization (RHV) administrators.
						

							By default, nested virtualization is not enabled in RHV. To enable nested virtualization, you install a VDSM hook, vdsm-hook-nestedvt, on all of the hosts in the cluster. Then, all of the virtual machines that run on these hosts can function as parent virtual machines.
						

							You should only run parent virtual machines on hosts that support nested virtualization. If a parent virtual machine migrates to a host that does not support nested virtualization, its child virtual machines fail. To prevent this from happening, configure all of the hosts in the cluster to support nested virtualization. Otherwise, restrict parent virtual machines from migrating to hosts that do not support nested virtualization.
						
Warning

								Take precautions to prevent parent virtual machines from migrating to hosts that do not support nested virtualization.
							

Procedure
	
									In the Administration Portal, click Compute → Hosts.
								
	
									Select a host in the cluster where you want to enable nested virtualization and click Management → Maintenance and OK.
								
	
									Select the host again, click Host Console, and log into the host console.
								
	
									Install the VDSM hook:
								
# dnf install vdsm-hook-nestedvt

	
									Reboot the host.
								
	
									Log into the host console again and verify that nested virtualization is enabled:
								
$ cat /sys/module/kvm*/parameters/nested

									If this command returns Y or 1, the feature is enabled.
								

	
									Repeat this procedure for all of the hosts in the cluster.
								


Additional resources
	
									VDSM hooks
								



Enabling nested virtualization for individual virtual machines



Important

								Nested virtualization is a Technology Preview feature. Technology Preview features are not supported with Red Hat production service-level agreements (SLAs) and might not be functionally complete, and Red Hat does not recommend using them for production. These features provide early access to upcoming product features, enabling customers to test functionality and provide feedback during the development process. For more information see Red Hat Technology Preview Features Support Scope.
							


							Nested virtualization enables virtual machines to host other virtual machines. For clarity, we will call these the parent virtual machines and nested virtual machines.
						

							Child virtual machines are only visible to and managed by users who have access to the parent virtual machine. They are not visible to Red Hat Virtualization (RHV) administrators.
						

							To enable nested virtualization on specific virtual machines, not all virtual machines, you configure a host or hosts to support nested virtualization. Then you configure the virtual machine or virtual machines on run on those specific hosts and enable Pass-Through Host CPU. This option lets the virtual machines use the nested virtualization settings you just configured on the host. This option also restricts which hosts the virtual machines can run on and requires manual migration.
						

							Otherwise, to enable nested virtualization for all of the virtual machines in a cluster, see Enabling nested virtualization for all virtual machines
						

							Only run parent virtual machines on hosts that support nested virtualization. If you migrate a parent virtual machine to a host that does not support nested virtualization, its child virtual machines will fail.
						
Warning

								Do not migrate parent virtual machines to hosts that do not support nested virtualization.
							


							Avoid live migration of parent virtual machines that are running child virtual machines. Even if the source and destination hosts are identical and support nested virtualization, the live migration can cause the child virtual machines to fail. Instead, shut down virtual machines before migration.
						
Procedure

								Configure the hosts to support nested virtualization:
							
	
									In the Administration Portal, click Compute → Hosts.
								
	
									Select a host in the cluster where you want to enable nested virtualization and click Management → Maintenance and OK.
								
	
									Select the host again, click Host Console, and log into the host console.
								
	
									In the Edit Host window, select the Kernel tab.
								
	
									Under Kernel boot parameters, if the checkboxes are greyed-out, click RESET.
								
	
									Select Nested Virtualization and click OK.
								

									This action displays a kvm-<architecture>.nested=1 parameter in Kernel command line. The following steps add this parameter to the Current kernel CMD line.
								

	
									Click Installation → Reinstall.
								
	
									When the host status returns to Up, click Management → Restart under Power Management or SSH Management.
								
	
									Verify that nested virtualization is enabled. Log into the host console and enter:
								
$ cat /sys/module/kvm*/parameters/nested

									If this command returns Y or 1, the feature is enabled.
								

	
									Repeat this procedure for all of the hosts you need to run parent virtual machines.
								



							Enable nested virtualization in specific virtual machines:
						
	
									In the Administration Portal, click Compute → Virtual Machines.
								
	
									Select a virtual machine and click Edit
								
	
									In the Edit Vitual Machine window, click Show Advanced Options and select the Host tab.
								
	
									Under Start Running On, click Specific Host and select the host or hosts you configured to support nested virtualization.
								
	
									Under CPU Options, select Pass-Through Host CPU. This action automatically sets the Migration mode to Allow manual migration only.
								
Note

										In RHV version 4.2, you can only enable Pass-Through Host CPU when Do not allow migration is selected.
									




Additional resources
	
									VDSM hooks
								
	
									Creating nested virtual machines in the RHEL documentation.
								




Moving a Host to Maintenance Mode




						Many common maintenance tasks, including network configuration and deployment of software updates, require that hosts be placed into maintenance mode. Hosts should be placed into maintenance mode before any event that might cause VDSM to stop working properly, such as a reboot, or issues with networking or storage.
					

						When a host is placed into maintenance mode the Red Hat Virtualization Manager attempts to migrate all running virtual machines to alternative hosts. The standard prerequisites for live migration apply, in particular there must be at least one active host in the cluster with capacity to run the migrated virtual machines.
					
Note

							Virtual machines that are pinned to the host and cannot be migrated are shut down. You can check which virtual machines are pinned to the host by clicking Pinned to Host in the Virtual Machines tab of the host’s details view.
						


						Placing a Host into Maintenance Mode
					
	
								Click Compute → Hosts and select the desired host.
							
	
								Click Management → Maintenance. This opens the Maintenance Host(s) confirmation window.
							
	
								Optionally, enter a Reason for moving the host into maintenance mode, which will appear in the logs and when the host is activated again. Then, click OK
							
Note

									The host maintenance Reason field will only appear if it has been enabled in the cluster settings. See Cluster General Settings Explained for more information.
								


	
								Optionally, select the required options for hosts that support Gluster.
							

								Select the Ignore Gluster Quorum and Self-Heal Validations option to avoid the default checks. By default, the Manager checks that the Gluster quorum is not lost when the host is moved to maintenance mode. The Manager also checks that there is no self-heal activity that will be affected by moving the host to maintenance mode. If the Gluster quorum will be lost or if there is self-heal activity that will be affected, the Manager prevents the host from being placed into maintenance mode. Only use this option if there is no other way to place the host in maintenance mode.
							

								Select the Stop Gluster Service option to stop all Gluster services while moving the host to maintenance mode.
							
Note

									These fields will only appear in the host maintenance window when the selected host supports Gluster. See Replacing the Primary Gluster Storage Node in Maintaining Red Hat Hyperconverged Infrastructure for more information.
								


	
								Click OK to initiate maintenance mode.
							



						All running virtual machines are migrated to alternative hosts. If the host is the Storage Pool Manager (SPM), the SPM role is migrated to another host. The Status field of the host changes to Preparing for Maintenance, and finally Maintenance when the operation completes successfully. VDSM does not stop while the host is in maintenance mode.
					
Note

							If migration fails on any virtual machine, click Management → Activate on the host to stop the operation placing it into maintenance mode, then click Cancel Migration on the virtual machine to stop the migration.
						


Activating a Host from Maintenance Mode




						A host that has been placed into maintenance mode, or recently added to the environment, must be activated before it can be used. Activation may fail if the host is not ready; ensure that all tasks are complete before attempting to activate the host.
					
Procedure
	
								Click Compute → Hosts and select the host.
							
	
								Click Management → Activate.
							



						The host status changes to Unassigned, and finally Up when the operation is complete. Virtual machines can now run on the host. Virtual machines that were migrated off the host when it was placed into maintenance mode are not automatically migrated back to the host when it is activated, but can be migrated manually. If the host was the Storage Pool Manager (SPM) before being placed into maintenance mode, the SPM role does not return automatically when the host is activated.
					
Configuring Host Firewall Rules




							You can configure the host firewall rules so that they are persistent, using Ansible. The cluster must be configured to use firewalld.
						
Note

								Changing the firewalld zone is not supported.
							

Configuring Firewall Rules for Hosts
	
									On the Manager machine, edit ovirt-host-deploy-post-tasks.yml.example to add a custom firewall port:
								
# vi /etc/ovirt-engine/ansible/ovirt-host-deploy-post-tasks.yml.example
---
#
# Any additional tasks required to be executing during host deploy process can
# be added below
#
- name: Enable additional port on firewalld
  firewalld:
    port: "12345/tcp"
    permanent: yes
    immediate: yes
    state: enabled

	
									Save the file to another location as ovirt-host-deploy-post-tasks.yml.
								



							New or reinstalled hosts are configured with the updated firewall rules.
						

							Existing hosts must be reinstalled by clicking Installation → Reinstall and selecting Automatically configure host firewall.
						

Removing a Host




							Removing a host from your Red Hat Virtualization environment is sometimes necessary, such as when you need to reinstall a host.
						
Procedure
	
									Click Compute → Hosts and select the host.
								
	
									Click Management → Maintenance.
								
	
									Once the host is in maintenance mode, click Remove. The Remove Host(s) confirmation window opens.
								
	
									Select the Force Remove check box if the host is part of a Red Hat Gluster Storage cluster and has volume bricks on it, or if the host is non-responsive.
								
	
									Click OK.
								



Updating Hosts Between Minor Releases




							You can update all hosts in a cluster, or update individual hosts.
						
Updating All Hosts in a Cluster




								You can update all hosts in a cluster instead of updating hosts individually. This is particularly useful during upgrades to new versions of Red Hat Virtualization. See oVirt Cluster Upgrade for more information about the Ansible role used to automate the updates.
							

								Update one cluster at a time.
							
Limitations
	
										On RHVH, the update only preserves modified content in the /etc and /var directories. Modified data in other paths is overwritten during an update.
									
	
										If the cluster has migration enabled, virtual machines are automatically migrated to another host in the cluster.
									
	
										In a self-hosted engine environment, the Manager virtual machine can only migrate between self-hosted engine nodes in the same cluster. It cannot migrate to standard hosts.
									
	
										The cluster must have sufficient memory reserved for its hosts to perform maintenance. Otherwise, virtual machine migrations will hang and fail. You can reduce the memory usage of host updates by shutting down some or all virtual machines before updating hosts.
									
	
										You cannot migrate a pinned virtual machine (such as a virtual machine using a vGPU) to another host. Pinned virtual machines are shut down during the update, unless you choose to skip that host instead.
									


Procedure
	
										In the Administration Portal, click Compute → Clusters and select the cluster. The Upgrade status column shows if an upgrade is available for any hosts in the cluster.
									
	
										Click Upgrade.
									
	
										Select the hosts to update, then click Next.
									
	
										Configure the options:
									
	
												Stop Pinned VMs shuts down any virtual machines that are pinned to hosts in the cluster, and is selected by default. You can clear this check box to skip updating those hosts so that the pinned virtual machines stay running, such as when a pinned virtual machine is running important services or processes and you do not want it to shut down at an unknown time during the update.
											
	
												Upgrade Timeout (Minutes) sets the time to wait for an individual host to be updated before the cluster upgrade fails with a timeout. The default is 60. You can increase it for large clusters where 60 minutes might not be enough, or reduce it for small clusters where the hosts update quickly.
											
	
												Check Upgrade checks each host for available updates before running the upgrade process. It is not selected by default, but you can select it if you need to ensure that recent updates are included, such as when you have configured the Manager to check for host updates less frequently than the default.
											
	
												Reboot After Upgrade reboots each host after it is updated, and is selected by default. You can clear this check box to speed up the process if you are sure that there are no pending updates that require a host reboot.
											
	
												Use Maintenance Policy sets the cluster’s scheduling policy to cluster_maintenance during the update. It is selected by default, so activity is limited and virtual machines cannot start unless they are highly available. You can clear this check box if you have a custom scheduling policy that you want to keep using during the update, but this could have unknown consequences. Ensure your custom policy is compatible with cluster upgrade activity before disabling this option.
											



	
										Click Next.
									
	
										Review the summary of the hosts and virtual machines that are affected.
									
	
										Click Upgrade.
									
	
										A cluster upgrade status screen displays with a progress bar showing the precentage of completion, and a list of steps in the upgrade process that have completed. You can click Go to Event Log to open the log entries for the upgrade. Closing this screen does not interrupt the upgrade process.
									



								You can track the progress of host updates:
							
	
										in the Compute → Clusters view, the Upgrade Status column displays a progress bar that displays the percentage of completion.
									
	
										in the Compute → Hosts view
									
	
										in the Events section of the Notification Drawer ( 
										[image: EventsIcon]
										 ).
									



								You can track the progress of individual virtual machine migrations in the Status column of the Compute → Virtual Machines view. In large environments, you may need to filter the results to show a particular group of virtual machines.
							

Updating Individual Hosts




								Use the host upgrade manager to update individual hosts directly from the Administration Portal.
							
Note

									The upgrade manager only checks hosts with a status of Up or Non-operational, but not Maintenance.
								

Limitations
	
										On RHVH, the update only preserves modified content in the /etc and /var directories. Modified data in other paths is overwritten during an update.
									
	
										If the cluster has migration enabled, virtual machines are automatically migrated to another host in the cluster. Update a host when its usage is relatively low.
									
	
										In a self-hosted engine environment, the Manager virtual machine can only migrate between self-hosted engine nodes in the same cluster. It cannot migrate to standard hosts.
									
	
										The cluster must have sufficient memory reserved for its hosts to perform maintenance. Otherwise, virtual machine migrations will hang and fail. You can reduce the memory usage of host updates by shutting down some or all virtual machines before updating hosts.
									
	
										You cannot migrate a pinned virtual machine (such as a virtual machine using a vGPU) to another host. Pinned virtual machines must be shut down before updating the host.
									


Procedure
	
										Ensure that the correct repositories are enabled. To view a list of currently enabled repositories, run dnf repolist.
									
	
												For Red Hat Virtualization Hosts:
											
# subscription-manager repos --enable=rhvh-4-for-rhel-8-x86_64-rpms

	
												For Red Hat Enterprise Linux hosts:
											
# subscription-manager repos \
    --enable=rhel-8-for-x86_64-baseos-eus-rpms \
    --enable=rhel-8-for-x86_64-appstream-eus-rpms \
    --enable=rhv-4-mgmt-agent-for-rhel-8-x86_64-rpms \
    --enable=advanced-virt-for-rhel-8-x86_64-rpms \
    --enable=fast-datapath-for-rhel-8-x86_64-rpms

# subscription-manager release --set=8.6




	
										In the Administration Portal, click Compute → Hosts and select the host to be updated.
									
	
										Click Installation → Check for Upgrade and click OK.
									

										Open the Notification Drawer ( 
										[image: EventsIcon]
										 ) and expand the Events section to see the result.
									

	
										If an update is available, click Installation → Upgrade.
									
	
										Click OK to update the host. Running virtual machines are migrated according to their migration policy. If migration is disabled for any virtual machines, you are prompted to shut them down.
									

										The details of the host are updated in Compute → Hosts and the status transitions through these stages:
									

										Maintenance > Installing > Reboot > Up
									
Note

											If the update fails, the host’s status changes to Install Failed. From Install Failed you can click Installation → Upgrade again.
										





								Repeat this procedure for each host in the Red Hat Virtualization environment.
							
Note

									You should update the hosts from the Administration Portal. However, you can update the hosts using dnf upgrade instead.
								


Manually Updating Hosts



Caution

								This information is provided for advanced system administrators who need to update hosts manually, but Red Hat does not support this method. The procedure described in this topic does not include important steps, including certificate renewal, assuming advanced knowledge of such information. Red Hat supports updating hosts using the Administration Portal. For details, see Updating individual hosts or Updating all hosts in a cluster in the Administration Guide.
							


								You can use the dnf command to update your hosts. Update your systems regularly, to ensure timely application of security and bug fixes.
							
Limitations
	
										On RHVH, the update only preserves modified content in the /etc and /var directories. Modified data in other paths is overwritten during an update.
									
	
										If the cluster has migration enabled, virtual machines are automatically migrated to another host in the cluster. Update a host when its usage is relatively low.
									
	
										In a self-hosted engine environment, the Manager virtual machine can only migrate between self-hosted engine nodes in the same cluster. It cannot migrate to standard hosts.
									
	
										The cluster must have sufficient memory reserved for its hosts to perform maintenance. Otherwise, virtual machine migrations will hang and fail. You can reduce the memory usage of host updates by shutting down some or all virtual machines before updating hosts.
									
	
										You cannot migrate a pinned virtual machine (such as a virtual machine using a vGPU) to another host. Pinned virtual machines must be shut down before updating the host.
									


Procedure
	
										Ensure the correct repositories are enabled. You can check which repositories are currently enabled by running dnf repolist.
									
	
												For Red Hat Virtualization Hosts:
											
# subscription-manager repos --enable=rhvh-4-for-rhel-8-x86_64-rpms

	
												For Red Hat Enterprise Linux hosts:
											
# subscription-manager repos \
    --enable=rhel-8-for-x86_64-baseos-eus-rpms \
    --enable=rhel-8-for-x86_64-appstream-eus-rpms \
    --enable=rhv-4-mgmt-agent-for-rhel-8-x86_64-rpms \
    --enable=advanced-virt-for-rhel-8-x86_64-rpms \
    --enable=fast-datapath-for-rhel-8-x86_64-rpms

# subscription-manager release --set=8.6




	
										In the Administration Portal, click Compute → Hosts and select the host to be updated.
									
	
										Click Management → Maintenance and OK.
									
	
										For Red Hat Enterprise Linux hosts:
									
	
												Identify the current version of Red Hat Enterprise Linux:
											
# cat /etc/redhat-release

	
												Check which version of the redhat-release package is available:
											
# dnf --refresh info --available redhat-release

												This command shows any available updates. For example, when upgrading from Red Hat Enterprise Linux 8.2.z to 8.3, compare the version of the package with the currently installed version:
											
Available Packages
Name         : redhat-release
Version      : 8.3
Release      : 1.0.el8
…​
Caution

												The Red Hat Enterprise Linux Advanced Virtualization module is usually released later than the Red Hat Enterprise Linux y-stream. If no new Advanced Virtualization module is available yet, or if there is an error enabling it, stop here and cancel the upgrade. Otherwise you risk corrupting the host.
											


	
												If the Advanced Virtualization stream is available for Red Hat Enterprise Linux 8.3 or later, reset the virt module:
											
# dnf module reset virt
Note

													If this module is already enabled in the Advanced Virtualization stream, this step is not necessary, but it has no negative impact.
												

													You can see the value of the stream by entering:
												
# dnf module list virt


	
												Enable the virt module in the Advanced Virtualization stream with the following command:
											
	
														For RHV 4.4.2:
													
# dnf module enable virt:8.2

	
														For RHV 4.4.3 to 4.4.5:
													
# dnf module enable virt:8.3

	
														For RHV 4.4.6 to 4.4.10:
													
# dnf module enable virt:av

	
														For RHV 4.4 and later:
													
# dnf module enable virt:rhel
Note

															Starting with RHEL 8.6 the Advanced virtualization packages will use the standard virt:rhel module. For RHEL 8.4 and 8.5, only one Advanced Virtualization stream is used, rhel:av.
														








	
										Enable version 14 of the nodejs module:
									
# dnf module -y enable nodejs:14

	
										Update the host:
									
# dnf upgrade --nobest

	
										Reboot the host to ensure all updates are correctly applied.
									
Note

											Check the imgbased logs to see if any additional package updates have failed for a Red Hat Virtualization Host. If some packages were not successfully reinstalled after the update, check that the packages are listed in /var/imgbased/persisted-rpms. Add any missing packages then run rpm -Uvh /var/imgbased/persisted-rpms/*.
										





								Repeat this process for each host in the Red Hat Virtualization environment.
							


Reinstalling Hosts




							Reinstall Red Hat Virtualization Hosts (RHVH) and Red Hat Enterprise Linux hosts from the Administration Portal. The procedure includes stopping and restarting the host.
						
Warning

								When installing or reinstalling the host’s operating system, Red Hat strongly recommends that you first detach any existing non-OS storage that is attached to the host to avoid accidental initialization of these disks, and with that, potential data loss.
							

Prerequisites
	
									If the cluster has migration enabled, virtual machines can automatically migrate to another host in the cluster. Therefore, reinstall a host while its usage is relatively low.
								
	
									Ensure that the cluster has sufficient memory for its hosts to perform maintenance. If a cluster lacks memory, migration of virtual machines will hang and then fail. To reduce memory usage, shut down some or all of the virtual machines before moving the host to maintenance.
								
	
									Ensure that the cluster contains more than one host before performing a reinstall. Do not attempt to reinstall all the hosts at the same time. One host must remain available to perform Storage Pool Manager (SPM) tasks.
								


Procedure
	
									Click Compute → Hosts and select the host.
								
	
									Click Management → Maintenance and OK.
								
	
									Click Installation → Reinstall. This opens the Install Host window.
								
	
									Click OK to reinstall the host.
								



							After a host has been reinstalled and its status returns to Up, you can migrate virtual machines back to the host.
						
Important

								After you register a Red Hat Virtualization Host to the Red Hat Virtualization Manager and reinstall it, the Administration Portal may erroneously display its status as Install Failed. Click Management → Activate, and the host will change to an Up status and be ready for use.
							



Viewing Host Errata




						Errata for each host can be viewed after the host has been configured to receive errata information from the Red Hat Satellite server. For more information on configuring a host to receive errata information see Configuring Satellite Errata Management for a Host
					
Procedure
	
								Click Compute → Hosts.
							
	
								Click the host’s name. This opens the details view.
							
	
								Click the Errata tab.
							



Viewing the Health Status of a Host




						Hosts have an external health status in addition to their regular Status. The external health status is reported by plug-ins or external systems, or set by an administrator, and appears to the left of the host’s Name as one of the following icons:
					
	
								OK: No icon
							
	
								Info: 
								[image: Info]

							
	
								Warning: 
								[image: Warning]

							
	
								Error: 
								[image: Error]

							
	
								Failure: 
								[image: Failure]

							



						To view further details about the host’s health status, click the host’s name. This opens the details view, and click the Events tab.
					

						The host’s health status can also be viewed using the REST API. A GET request on a host will include the external_status element, which contains the health status.
					

						You can set a host’s health status in the REST API via the events collection. For more information, see Adding Events in the REST API Guide.
					

Viewing Host Devices




						You can view the host devices for each host in the Host Devices tab in the details view. If the host has been configured for direct device assignment, these devices can be directly attached to virtual machines for improved performance.
					

						For more information on the hardware requirements for direct device assignment, see Additional Hardware Considerations for Using Device Assignment in Hardware Considerations for Implementing SR-IOV.
					

						For more information on configuring the host for direct device assignment, see Configuring a Host for PCI Passthrough host tasks.
					

						For more information on attaching host devices to virtual machines, see Host Devices in the Virtual Machine Management Guide.
					
Procedure
	
								Click Compute → Hosts.
							
	
								Click the host’s name. This opens the details view.
							
	
								Click Host Devices tab.
							



						This tab lists the details of the host devices, including whether the device is attached to a virtual machine, and currently in use by that virtual machine.
					

Accessing Cockpit from the Administration Portal




						Cockpit is available by default on Red Hat Virtualization Hosts (RHVH) and Red Hat Enterprise Linux hosts. You can access the Cockpit web interface by typing the address into a browser, or through the Administration Portal.
					
Procedure
	
								In the Administration Portal, click Compute → Hosts and select a host.
							
	
								Click Host Console.
							



						The Cockpit login page opens in a new browser window.
					
Setting a Legacy SPICE Cipher




							SPICE consoles use FIPS-compliant encryption by default, with a cipher string. The default SPICE cipher string is: kECDHE+FIPS:kDHE+FIPS:kRSA+FIPS:!eNULL:!aNULL
						

							This string is generally sufficient. However, if you have a virtual machine with an older operating system or SPICE client, where either one or the other does not support FIPS-compliant encryption, you must use a weaker cipher string. Otherwise, a connection security error may occur if you install a new cluster or a new host in an existing cluster and try to connect to that virtual machine.
						

							You can change the cipher string by using an Ansible playbook.
						

							Changing the cipher string
						
	
									On the Manager machine, create a file in the directory /usr/share/ovirt-engine/playbooks. For example:
								
# vim /usr/share/ovirt-engine/playbooks/change-spice-cipher.yml

	
									Enter the following in the file and save it:
								
name: oVirt - setup weaker SPICE encryption for old clients
hosts: hostname
vars:
  host_deploy_spice_cipher_string: 'DEFAULT:-RC4:-3DES:-DES'
roles:
  - ovirt-host-deploy-spice-encryption

	
									Run the file you just created:
								
# ansible-playbook -l hostname /usr/share/ovirt-engine/playbooks/change-spice-cipher.yml




							Alternatively, you can reconfigure the host with the Ansible playbook ovirt-host-deploy using the --extra-vars option with the variable host_deploy_spice_cipher_string:
						
# ansible-playbook -l hostname \
  --extra-vars host_deploy_spice_cipher_string=”DEFAULT:-RC4:-3DES:-DES” \
  /usr/share/ovirt-engine/playbooks/ovirt-host-deploy.yml


Configuring Host Power Management Settings




						Configure your host power management device settings to perform host life-cycle operations (stop, start, restart) from the Administration Portal.
					

						You must configure host power management in order to utilize host high availability and virtual machine high availability. For more information about power management devices, see Power Management in the Technical Reference.
					
Procedure
	
								Click Compute → Hosts and select a host.
							
	
								Click Management → Maintenance, and click OK to confirm.
							
	
								When the host is in maintenance mode, click Edit.
							
	
								Click the Power Management tab.
							
	
								Select the Enable Power Management check box to enable the fields.
							
	
								Select the Kdump integration check box to prevent the host from fencing while performing a kernel crash dump.
							
Important

									If you enable or disable Kdump integration on an existing host, you must reinstall the host for kdump to be configured.
								


	
								Optionally, select the Disable policy control of power management check box if you do not want your host’s power management to be controlled by the Scheduling Policy of the host’s cluster.
							
	
								Click the plus (+) button to add a new power management device. The Edit fence agent window opens.
							
	
								Enter the User Name and Password of the power management device into the appropriate fields.
							
	
								Select the power management device Type in the drop-down list.
							
	
								Enter the IP address in the Address field.
							
	
								Enter the SSH Port number used by the power management device to communicate with the host.
							
	
								Enter the Slot number used to identify the blade of the power management device.
							
	
								Enter the Options for the power management device. Use a comma-separated list of 'key=value' entries.
							
	
										If both IPv4 and IPv6 IP addresses can be used (default), leave the Options field blank.
									
	
										If only IPv4 IP addresses can be used, enter inet4_only=1.
									
	
										If only IPv6 IP addresses can be used, enter inet6_only=1.
									



	
								Select the Secure check box to enable the power management device to connect securely to the host.
							
	
								Click Test to ensure the settings are correct. Test Succeeded, Host Status is: on will display upon successful verification.
							
	
								Click OK to close the Edit fence agent window.
							
	
								In the Power Management tab, optionally expand the Advanced Parameters and use the up and down buttons to specify the order in which the Manager will search the host’s cluster and dc (datacenter) for a fencing proxy.
							
	
								Click OK.
							


Note
	
									For IPv6, Red Hat Virtualization supports only static addressing.
								
	
									Dual-stack IPv4 and IPv6 addressing is not supported.
								




						The Management → Power Management drop-down menu is now enabled in the Administration Portal.
					

Configuring Host Storage Pool Manager Settings




						The Storage Pool Manager (SPM) is a management role given to one of the hosts in a data center to maintain access control over the storage domains. The SPM must always be available, and the SPM role will be assigned to another host if the SPM host becomes unavailable. As the SPM role uses some of the host’s available resources, it is important to prioritize hosts that can afford the resources.
					

						The Storage Pool Manager (SPM) priority setting of a host alters the likelihood of the host being assigned the SPM role: a host with high SPM priority will be assigned the SPM role before a host with low SPM priority.
					
Procedure
	
								Click Compute → Hosts.
							
	
								Click Edit.
							
	
								Click the SPM tab.
							
	
								Use the radio buttons to select the appropriate SPM priority for the host.
							
	
								Click OK.
							


Migrating a self-hosted engine host to a different cluster




							You cannot migrate a host that is configured as a self-hosted engine host to a data center or cluster other than the one in which the self-hosted engine virtual machine is running. All self-hosted engine hosts must be in the same data center and cluster.
						

							You need to disable the host from being a self-hosted engine host by undeploying the self-hosted engine configuration from the host.
						
Procedure
	
									Click Compute → Hosts and select the host.
								
	
									Click Management → Maintenance. The host’s status changes to Maintenance.
								
	
									Under Reinstall, select Hosted Engine UNDEPLOY.
								
	
									Click Reinstall.
								
Tip

									Alternatively, you can use the REST API undeploy_hosted_engine parameter.
								


	
									Click Edit.
								
	
									Select the target data center and cluster.
								
	
									Click OK.
								
	
									Click Management → Activate.
								


Additional resources
	
									Moving a Host to Maintenance mode
								
	
									Activating a Host from Maintenance Mode
								





Explanation of Settings and Controls in the New Host and Edit Host Windows



Host General Settings Explained




						These settings apply when editing the details of a host or adding new Red Hat Enterprise Linux hosts and Satellite host provider hosts.
					

						The General settings table contains the information required on the General tab of the New Host or Edit Host window.
					
Table 2.20. General settings
	Field Name	Description
	 
										Host Cluster
									

									 	 
										The cluster and data center to which the host belongs.
									

									 
	 
										Use Foreman/Satellite
									

									 	 
										Select or clear this check box to view or hide options for adding hosts provided by Satellite host providers. The following options are also available:
									

									 
										Discovered Hosts
									

									 	
												Discovered Hosts - A drop-down list that is populated with the name of Satellite hosts discovered by the engine.
											
	
												Host Groups -A drop-down list of host groups available.
											
	
												Compute Resources - A drop-down list of hypervisors to provide compute resources.
											



									 
										Provisioned Hosts
									

									 	
												Providers Hosts - A drop-down list that is populated with the name of hosts provided by the selected external provider. The entries in this list are filtered in accordance with any search queries that have been input in the Provider search filter.
											
	
												Provider search filter - A text field that allows you to search for hosts provided by the selected external provider. This option is provider-specific; see provider documentation for details on forming search queries for specific providers. Leave this field blank to view all available hosts.
											



									 
	 
										Name
									

									 	 
										The name of the host. This text field has a 40-character limit and must be a unique name with any combination of uppercase and lowercase letters, numbers, hyphens, and underscores.
									

									 
	 
										Comment
									

									 	 
										A field for adding plain text, human-readable comments regarding the host.
									

									 
	 
										Hostname
									

									 	 
										The IP address or resolvable host name of the host. If a resolvable hostname is used, you must ensure that all addresses that the hostname is resolved to match the IP addresses, IPv4 and IPv6, used by the management network of the host.
									

									 
	 
										Password
									

									 	 
										The password of the host’s root user. Set the password when adding the host. The password cannot be edited afterwards.
									

									 
	 
										Activate host after install
									

									 	 
										Select this checkbox to activate the host after successful installation. This is enabled by default and required for the hypervisors to be activated successfully.
									

									 
										After successful installation, you can clear this checkbox to switch the host status to Maintenance. This allows the administrator to perform additional configuration tasks on the hypervisors.
									

									 
	 
										Reboot host after install
									

									 	 
										Select this checkbox to reboot the host after it is installed. This is enabled by default.
									

									 Note

											Changing the kernel command line parameters of the host, or changing the firewall type of the cluster also require you to reboot the host.
										


									 
	 
										SSH Public Key
									

									 	 
										Copy the contents in the text box to the /root/.ssh/authorized_hosts file on the host to use the Manager’s SSH key instead of a password to authenticate with a host.
									

									 
	 
										Automatically configure host firewall
									

									 	 
										When adding a new host, the Manager can open the required ports on the host’s firewall. This is enabled by default. This is an Advanced Parameter.
									

									 
	 
										SSH Fingerprint
									

									 	 
										You can fetch the host’s SSH fingerprint, and compare it with the fingerprint you expect the host to return, ensuring that they match. This is an Advanced Parameter.
									

									 




Host Power Management Settings Explained




						The Power Management settings table contains the information required on the Power Management tab of the New Host or Edit Host windows. You can configure power management if the host has a supported power management card.
					
Table 2.21. Power Management Settings
	Field Name	Description
	 
										Enable Power Management
									

									 	 
										Enables power management on the host. Select this check box to enable the rest of the fields in the Power Management tab.
									

									 
	 
										Kdump integration
									

									 	 
										Prevents the host from fencing while performing a kernel crash dump, so that the crash dump is not interrupted. In Red Hat Enterprise Linux 7.1 and later, kdump is available by default. If kdump is available on the host, but its configuration is not valid (the kdump service cannot be started), enabling Kdump integration will cause the host (re)installation to fail. If you enable or disable Kdump integration on an existing host, you must reinstall the host.
									

									 
	 
										Disable policy control of power management
									

									 	 
										Power management is controlled by the Scheduling Policy of the host’s cluster. If power management is enabled and the defined low utilization value is reached, the Manager will power down the host machine, and restart it again when load balancing requires or there are not enough free hosts in the cluster. Select this check box to disable policy control.
									

									 
	 
										Agents by Sequential Order
									

									 	 
										Lists the host’s fence agents. Fence agents can be sequential, concurrent, or a mix of both.
									

									 	
												If fence agents are used sequentially, the primary agent is used first to stop or start a host, and if it fails, the secondary agent is used.
											
	
												If fence agents are used concurrently, both fence agents have to respond to the Stop command for the host to be stopped; if one agent responds to the Start command, the host will go up.
											



									 
										Fence agents are sequential by default. Use the up and down buttons to change the sequence in which the fence agents are used.
									

									 
										To make two fence agents concurrent, select one fence agent from the Concurrent with drop-down list next to the other fence agent. Additional fence agents can be added to the group of concurrent fence agents by selecting the group from the Concurrent with drop-down list next to the additional fence agent.
									

									 
	 
										Add Fence Agent
									

									 	 
										Click the + button to add a new fence agent. The Edit fence agent window opens. See the table below for more information on the fields in this window.
									

									 
	 
										Power Management Proxy Preference
									

									 	 
										By default, specifies that the Manager will search for a fencing proxy within the same cluster as the host, and if no fencing proxy is found, the Manager will search in the same dc (data center). Use the up and down buttons to change the sequence in which these resources are used. This field is available under Advanced Parameters.
									

									 




						The following table contains the information required in the Edit fence agent window.
					
Table 2.22. Edit fence agent Settings
	Field Name	Description
	 
										Address
									

									 	 
										The address to access your host’s power management device. Either a resolvable hostname or an IP address.
									

									 
	 
										User Name
									

									 	 
										User account with which to access the power management device. You can set up a user on the device, or use the default user.
									

									 
	 
										Password
									

									 	 
										Password for the user accessing the power management device.
									

									 
	 
										Type
									

									 	 
										The type of power management device in your host. Choose one of the following:
									

									 	
												apc - APC MasterSwitch network power switch. Not for use with APC 5.x power switch devices.
											
	
												apc_snmp - Use with APC 5.x power switch devices.
											
	
												bladecenter - IBM Bladecenter Remote Supervisor Adapter.
											
	
												cisco_ucs - Cisco Unified Computing System.
											
	
												drac5 - Dell Remote Access Controller for Dell computers.
											
	
												drac7 - Dell Remote Access Controller for Dell computers.
											
	
												eps - ePowerSwitch 8M+ network power switch.
											
	
												hpblade - HP BladeSystem.
											
	
												ilo, ilo2, ilo3, ilo4 - HP Integrated Lights-Out.
											
	
												ipmilan - Intelligent Platform Management Interface and Sun Integrated Lights Out Management devices.
											
	
												rsa - IBM Remote Supervisor Adapter.
											
	
												rsb - Fujitsu-Siemens RSB management interface.
											
	
												wti - WTI Network Power Switch.
											



									 
										For more information about power management devices, see Power Management in the Technical Reference.
									

									 
	 
										Port
									

									 	 
										The port number used by the power management device to communicate with the host.
									

									 
	 
										Slot
									

									 	 
										The number used to identify the blade of the power management device.
									

									 
	 
										Service Profile
									

									 	 
										The service profile name used to identify the blade of the power management device. This field appears instead of Slot when the device type is cisco_ucs.
									

									 
	 
										Options
									

									 	 
										Power management device specific options. Enter these as 'key=value'. See the documentation of your host’s power management device for the options available.
									

									 
										For Red Hat Enterprise Linux 7 hosts, if you are using cisco_ucs as the power management device, you also need to append ssl_insecure=1 to the Options field.
									

									 
	 
										Secure
									

									 	 
										Select this check box to allow the power management device to connect securely to the host. This can be done via ssh, ssl, or other authentication protocols depending on the power management agent.
									

									 




SPM Priority Settings Explained




						The SPM settings table details the information required on the SPM tab of the New Host or Edit Host window.
					
Table 2.23. SPM settings
	Field Name	Description
	 
										SPM Priority
									

									 	 
										Defines the likelihood that the host will be given the role of Storage Pool Manager (SPM). The options are Low, Normal, and High priority. Low priority means that there is a reduced likelihood of the host being assigned the role of SPM, and High priority means there is an increased likelihood. The default setting is Normal.
									

									 




Host Console Settings Explained




						The Console settings table details the information required on the Console tab of the New Host or Edit Host window.
					
Table 2.24. Console settings
	Field Name	Description
	 
										Override display address
									

									 	 
										Select this check box to override the display addresses of the host. This feature is useful in a case where the hosts are defined by internal IP and are behind a NAT firewall. When a user connects to a virtual machine from outside of the internal network, instead of returning the private address of the host on which the virtual machine is running, the machine returns a public IP or FQDN (which is resolved in the external network to the public IP).
									

									 
	 
										Display address
									

									 	 
										The display address specified here will be used for all virtual machines running on this host. The address must be in the format of a fully qualified domain name or IP.
									

									 
	 
										vGPU Placement
									

									 	 
										Specifies the preferred placement of vGPUs:
									

									 	
												Consolidated: Select this option if you prefer to run more vGPUs on available physical cards.
											
	
												Separated: Select this option if you prefer to run each vGPU on a separate physical card.
											



									 




Network Provider Settings Explained




						The Network Provider settings table details the information required on the Network Provider tab of the New Host or Edit Host window.
					
Table 2.25. Network Provider settings
	Field Name	Description
	 
										External Network Provider
									

									 	 
										If you have added an external network provider and want the host’s network to be provisioned by the external network provider, select one from the list.
									

									 




Kernel Settings Explained




						The Kernel settings table details the information required on the Kernel tab of the New Host or Edit Host window. Common kernel boot parameter options are listed as check boxes so you can easily select them.
					

						For more complex changes, use the free text entry field next to Kernel command line to add in any additional parameters required. If you change any kernel command line parameters, you must reinstall the host.
					
Important

							If the host is attached to the Manager, you must place the host into maintenance mode before making changes. After making the changes, reinstall the host to apply the changes.
						

Table 2.26. Kernel Settings
	Field Name	Description
	 
										Hostdev Passthrough & SR-IOV
									

									 	 
										Enables the IOMMU flag in the kernel so a virtual machine can use a host device as if it is attached directly to the virtual machine. The host hardware and firmware must also support IOMMU. The virtualization extension and IOMMU extension must be enabled on the hardware. See Configuring a Host for PCI Passthrough. IBM POWER8 has IOMMU enabled by default.
									

									 
	 
										Nested Virtualization
									

									 	 
										Enables the vmx or svm flag so virtual machines can run within virtual machines. This option is a Technology Preview feature: It is intended only for evaluation purposes. It is not supported for production purposes. To use this setting, you must install the vdsm-hook-nestedvt hook on the host. For details, see Enabling nested virtualization for all virtual machines and Enabling nested virtualization for individual virtual machines
									

									 
	 
										Unsafe Interrupts
									

									 	 
										If IOMMU is enabled but the passthrough fails because the hardware does not support interrupt remapping, you can consider enabling this option. Note that you should only enable this option if the virtual machines on the host are trusted; having the option enabled potentially exposes the host to MSI attacks from the virtual machines. This option is only intended to be used as a workaround when using uncertified hardware for evaluation purposes.
									

									 
	 
										PCI Reallocation
									

									 	 
										If your SR-IOV NIC is unable to allocate virtual functions because of memory issues, consider enabling this option. The host hardware and firmware must also support PCI reallocation. This option is only intended to be used as a workaround when using uncertified hardware for evaluation purposes.
									

									 
	 
										Blacklist Nouveau
									

									 	 
										Blocks the nouveau driver. Nouveau is a community driver for NVIDIA GPUs that conflicts with vendor-supplied drivers. The nouveau driver should be blocked when vendor drivers take precedence.
									

									 
	 
										SMT Disabled
									

									 	 
										Disables Simultaneous Multi Threading (SMT). Disabling SMT can mitigate security vulnerabilities, such as L1TF or MDS.
									

									 
	 
										FIPS mode
									

									 	 
										Enables FIPS mode. For details, see Enabling FIPS using the Manager.
									

									 
	 
										Kernel command line
									

									 	 
										This field allows you to append more kernel parameters to the default parameters.
									

									 



Note

							If the kernel boot parameters are grayed out, click the reset button and the options will be available.
						


Hosted Engine Settings Explained




						The Hosted Engine settings table details the information required on the Hosted Engine tab of the New Host or Edit Host window.
					
Table 2.27. Hosted Engine Settings
	Field Name	Description
	 
										Choose hosted engine deployment action
									

									 	 
										Three options are available:
									

									 	
												None - No actions required.
											
	
												Deploy - Select this option to deploy the host as a self-hosted engine node.
											
	
												Undeploy - For a self-hosted engine node, you can select this option to undeploy the host and remove self-hosted engine related configurations.
											



									 





Host Resilience



Host High Availability




						The Red Hat Virtualization Manager uses fencing to keep hosts in a cluster responsive. A Non Responsive host is different from a Non Operational host. Non Operational hosts can be communicated with by the Manager, but have an incorrect configuration, for example a missing logical network. Non Responsive hosts cannot be communicated with by the Manager.
					

						Fencing allows a cluster to react to unexpected host failures and enforce power saving, load balancing, and virtual machine availability policies. You should configure the fencing parameters for your host’s power management device and test their correctness from time to time. In a fencing operation, a non-responsive host is rebooted, and if the host does not return to an active status within a prescribed time, it remains non-responsive pending manual intervention and troubleshooting.
					
Note

							To automatically check the fencing parameters, you can configure the PMHealthCheckEnabled (false by default) and PMHealthCheckIntervalInSec (3600 sec by default) engine-config options.
						

							When set to true, PMHealthCheckEnabled will check all host agents at the interval specified by PMHealthCheckIntervalInSec, and raise warnings if it detects issues. See Syntax for the engine-config Command for more information about configuring engine-config options.
						


						Power management operations can be performed by Red Hat Virtualization Manager after it reboots, by a proxy host, or manually in the Administration Portal. All the virtual machines running on the non-responsive host are stopped, and highly available virtual machines are started on a different host. At least two hosts are required for power management operations.
					

						After the Manager starts up, it automatically attempts to fence non-responsive hosts that have power management enabled after the quiet time (5 minutes by default) has elapsed. The quiet time can be configured by updating the DisableFenceAtStartupInSec engine-config option.
					
Note

							The DisableFenceAtStartupInSec engine-config option helps prevent a scenario where the Manager attempts to fence hosts while they boot up. This can occur after a data center outage because a host’s boot process is normally longer than the Manager boot process.
						


						Hosts can be fenced automatically by the proxy host using the power management parameters, or manually by right-clicking on a host and using the options on the menu.
					
Important

							If a host runs virtual machines that are highly available, power management must be enabled and configured.
						


Power Management by Proxy in Red Hat Virtualization




						The Red Hat Virtualization Manager does not communicate directly with fence agents. Instead, the Manager uses a proxy to send power management commands to a host power management device. The Manager uses VDSM to execute power management device actions, so another host in the environment is used as a fencing proxy.
					

						You can select between:
					
	
								Any host in the same cluster as the host requiring fencing.
							
	
								Any host in the same data center as the host requiring fencing.
							



						A viable fencing proxy host has a status of either UP or Maintenance.
					

Setting Fencing Parameters on a Host




						The parameters for host fencing are set using the Power Management fields on the New Host or Edit Host windows. Power management enables the system to fence a troublesome host using an additional interface such as a Remote Access Card (RAC).
					

						All power management operations are done using a proxy host, as opposed to directly by the Red Hat Virtualization Manager. At least two hosts are required for power management operations.
					
Procedure
	
								Click Compute → Hosts and select the host.
							
	
								Click Edit.
							
	
								Click the Power Management tab.
							
	
								Select the Enable Power Management check box to enable the fields.
							
	
								Select the Kdump integration check box to prevent the host from fencing while performing a kernel crash dump.
							
Important

									If you enable or disable Kdump integration on an existing host, you must reinstall the host.
								


	
								Optionally, select the Disable policy control of power management check box if you do not want your host’s power management to be controlled by the Scheduling Policy of the host’s cluster.
							
	
								Click the + button to add a new power management device. The Edit fence agent window opens.
							
	
								Enter the Address, User Name, and Password of the power management device.
							
	
								Select the power management device Type from the drop-down list.
							
	
								Enter the SSH Port number used by the power management device to communicate with the host.
							
	
								Enter the Slot number used to identify the blade of the power management device.
							
	
								Enter the Options for the power management device. Use a comma-separated list of 'key=value' entries.
							
	
								Select the Secure check box to enable the power management device to connect securely to the host.
							
	
								Click the Test button to ensure the settings are correct. Test Succeeded, Host Status is: on will display upon successful verification.
							
Warning

									Power management parameters (userid, password, options, etc) are tested by Red Hat Virtualization Manager only during setup and manually after that. If you choose to ignore alerts about incorrect parameters, or if the parameters are changed on the power management hardware without the corresponding change in Red Hat Virtualization Manager, fencing is likely to fail when most needed.
								


	
								Click OK to close the Edit fence agent window.
							
	
								In the Power Management tab, optionally expand the Advanced Parameters and use the up and down buttons to specify the order in which the Manager will search the host’s cluster and dc (datacenter) for a fencing proxy.
							
	
								Click OK.
							



						You are returned to the list of hosts. Note that the exclamation mark next to the host’s name has now disappeared, signifying that power management has been successfully configured.
					

fence_kdump Advanced Configuration




						kdump
					

						Click the name of a host to view the status of the kdump service in the General tab of the details view:
					
	
								Enabled: kdump is configured properly and the kdump service is running.
							
	
								Disabled: the kdump service is not running (in this case kdump integration will not work properly).
							
	
								Unknown: happens only for hosts with an earlier VDSM version that does not report kdump status.
							



						For more information on installing and using kdump, see the Red Hat Enterprise Linux 7 Kernel Crash Dump Guide.
					

						fence_kdump
					

						Enabling Kdump integration in the Power Management tab of the New Host or Edit Host window configures a standard fence_kdump setup. If the environment’s network configuration is simple and the Manager’s FQDN is resolvable on all hosts, the default fence_kdump settings are sufficient for use.
					

						However, there are some cases where advanced configuration of fence_kdump is necessary. Environments with more complex networking may require manual changes to the configuration of the Manager, fence_kdump listener, or both. For example, if the Manager’s FQDN is not resolvable on all hosts with Kdump integration enabled, you can set a proper host name or IP address using engine-config:
					
engine-config -s FenceKdumpDestinationAddress=A.B.C.D

						The following example cases may also require configuration changes:
					
	
								The Manager has two NICs, where one of these is public-facing, and the second is the preferred destination for fence_kdump messages.
							
	
								You need to execute the fence_kdump listener on a different IP or port.
							
	
								You need to set a custom interval for fence_kdump notification messages, to prevent possible packet loss.
							



						Customized fence_kdump detection settings are recommended for advanced users only, as changes to the default configuration are only necessary in more complex networking setups.
					

fence_kdump listener Configuration




						Edit the configuration of the fence_kdump listener. This is only necessary in cases where the default configuration is not sufficient.
					
Procedure
	
								Create a new file (for example, my-fence-kdump.conf) in /etc/ovirt-engine/ovirt-fence-kdump-listener.conf.d/.
							
	
								Enter your customization with the syntax OPTION=value and save the file.
							
Important

									The edited values must also be changed in engine-config as outlined in the fence_kdump Listener Configuration Options table in Configuring fence-kdump on the Manager.
								


	
								Restart the fence_kdump listener:
							
# systemctl restart ovirt-fence-kdump-listener.service




						The following options can be customized if required:
					
Table 2.28. fence_kdump Listener Configuration Options
	Variable	Description	Default	Note
	 
										LISTENER_ADDRESS
									

									 	 
										Defines the IP address to receive fence_kdump messages on.
									

									 	 
										0.0.0.0
									

									 	 
										If the value of this parameter is changed, it must match the value of FenceKdumpDestinationAddress in engine-config.
									

									 
	 
										LISTENER_PORT
									

									 	 
										Defines the port to receive fence_kdump messages on.
									

									 	 
										7410
									

									 	 
										If the value of this parameter is changed, it must match the value of FenceKdumpDestinationPort in engine-config.
									

									 
	 
										HEARTBEAT_INTERVAL
									

									 	 
										Defines the interval in seconds of the listener’s heartbeat updates.
									

									 	 
										30
									

									 	 
										If the value of this parameter is changed, it must be half the size or smaller than the value of FenceKdumpListenerTimeout in engine-config.
									

									 
	 
										SESSION_SYNC_INTERVAL
									

									 	 
										Defines the interval in seconds to synchronize the listener’s host kdumping sessions in memory to the database.
									

									 	 
										5
									

									 	 
										If the value of this parameter is changed, it must be half the size or smaller than the value of KdumpStartedTimeout in engine-config.
									

									 
	 
										REOPEN_DB_CONNECTION_INTERVAL
									

									 	 
										Defines the interval in seconds to reopen the database connection which was previously unavailable.
									

									 	 
										30
									

									 	 
										-
									

									 
	 
										KDUMP_FINISHED_TIMEOUT
									

									 	 
										Defines the maximum timeout in seconds after the last received message from kdumping hosts after which the host kdump flow is marked as FINISHED.
									

									 	 
										60
									

									 	 
										If the value of this parameter is changed, it must be double the size or higher than the value of FenceKdumpMessageInterval in engine-config.
									

									 




Configuring fence_kdump on the Manager




						Edit the Manager’s kdump configuration. This is only necessary in cases where the default configuration is not sufficient. The current configuration values can be found using:
					
# engine-config -g OPTION
Procedure
	
								Edit kdump’s configuration using the engine-config command:
							
# engine-config -s OPTION=value
Important

									The edited values must also be changed in the fence_kdump listener configuration file as outlined in the Kdump Configuration Options table. See fence_kdump listener configuration.
								


	
								Restart the ovirt-engine service:
							
# systemctl restart ovirt-engine.service

	
								Reinstall all hosts with Kdump integration enabled, if required (see the table below).
							



						The following options can be configured using engine-config:
					
Table 2.29. Kdump Configuration Options
	Variable	Description	Default	Note
	 
										FenceKdumpDestinationAddress
									

									 	 
										Defines the hostname(s) or IP address(es) to send fence_kdump messages to. If empty, the Manager’s FQDN is used.
									

									 	 
										Empty string (Manager FQDN is used)
									

									 	 
										If the value of this parameter is changed, it must match the value of LISTENER_ADDRESS in the fence_kdump listener configuration file, and all hosts with Kdump integration enabled must be reinstalled.
									

									 
	 
										FenceKdumpDestinationPort
									

									 	 
										Defines the port to send fence_kdump messages to.
									

									 	 
										7410
									

									 	 
										If the value of this parameter is changed, it must match the value of LISTENER_PORT in the fence_kdump listener configuration file, and all hosts with Kdump integration enabled must be reinstalled.
									

									 
	 
										FenceKdumpMessageInterval
									

									 	 
										Defines the interval in seconds between messages sent by fence_kdump.
									

									 	 
										5
									

									 	 
										If the value of this parameter is changed, it must be half the size or smaller than the value of KDUMP_FINISHED_TIMEOUT in the fence_kdump listener configuration file, and all hosts with Kdump integration enabled must be reinstalled.
									

									 
	 
										FenceKdumpListenerTimeout
									

									 	 
										Defines the maximum timeout in seconds since the last heartbeat to consider the fence_kdump listener alive.
									

									 	 
										90
									

									 	 
										If the value of this parameter is changed, it must be double the size or higher than the value of HEARTBEAT_INTERVAL in the fence_kdump listener configuration file.
									

									 
	 
										KdumpStartedTimeout
									

									 	 
										Defines the maximum timeout in seconds to wait until the first message from the kdumping host is received (to detect that host kdump flow has started).
									

									 	 
										30
									

									 	 
										If the value of this parameter is changed, it must be double the size or higher than the value of SESSION_SYNC_INTERVAL in the fence_kdump listener configuration file, and FenceKdumpMessageInterval.
									

									 




Soft-Fencing Hosts




						Hosts can sometimes become non-responsive due to an unexpected problem, and though VDSM is unable to respond to requests, the virtual machines that depend upon VDSM remain alive and accessible. In these situations, restarting VDSM returns VDSM to a responsive state and resolves this issue.
					

						"SSH Soft Fencing" is a process where the Manager attempts to restart VDSM via SSH on non-responsive hosts. If the Manager fails to restart VDSM via SSH, the responsibility for fencing falls to the external fencing agent if an external fencing agent has been configured.
					

						Soft-fencing over SSH works as follows. Fencing must be configured and enabled on the host, and a valid proxy host (a second host, in an UP state, in the data center) must exist. When the connection between the Manager and the host times out, the following happens:
					
	
								On the first network failure, the status of the host changes to "connecting".
							
	
								The Manager then makes three attempts to ask VDSM for its status, or it waits for an interval determined by the load on the host. The formula for determining the length of the interval is configured by the configuration values TimeoutToResetVdsInSeconds (the default is 60 seconds) + [DelayResetPerVmInSeconds (the default is 0.5 seconds)]*(the count of running virtual machines on host) + [DelayResetForSpmInSeconds (the default is 20 seconds)] * 1 (if host runs as SPM) or 0 (if the host does not run as SPM). To give VDSM the maximum amount of time to respond, the Manager chooses the longer of the two options mentioned above (three attempts to retrieve the status of VDSM or the interval determined by the above formula).
							
	
								If the host does not respond when that interval has elapsed, vdsm restart is executed via SSH.
							
	
								If vdsm restart does not succeed in re-establishing the connection between the host and the Manager, the status of the host changes to Non Responsive and, if power management is configured, fencing is handed off to the external fencing agent.
							


Note

							Soft-fencing over SSH can be executed on hosts that have no power management configured. This is distinct from "fencing": fencing can be executed only on hosts that have power management configured.
						


Using Host Power Management Functions




						When power management has been configured for a host, you can access a number of options from the Administration Portal interface. While each power management device has its own customizable options, they all support the basic options to start, stop, and restart a host.
					
Procedure
	
								Click Compute → Hosts and select the host.
							
	
								Click the Management drop-down menu and select one of the following Power Management options:
							
	
										Restart: This option stops the host and waits until the host’s status changes to Down. When the agent has verified that the host is down, the highly available virtual machines are restarted on another host in the cluster. The agent then restarts this host. When the host is ready for use its status displays as Up.
									
	
										Start: This option starts the host and lets it join a cluster. When it is ready for use its status displays as Up.
									
	
										Stop: This option powers off the host. Before using this option, ensure that the virtual machines running on the host have been migrated to other hosts in the cluster. Otherwise the virtual machines will crash and only the highly available virtual machines will be restarted on another host. When the host has been stopped its status displays as Non-Operational.
									
Note

											If Power Management is not enabled, you can restart or stop the host by selecting it, clicking the Management drop-down menu, and selecting an SSH Management option, Restart or Stop.
										

Important

											When two fencing agents are defined on a host, they can be used concurrently or sequentially. For concurrent agents, both agents have to respond to the Stop command for the host to be stopped; and when one agent responds to the Start command, the host will go up. For sequential agents, to start or stop a host, the primary agent is used first; if it fails, the secondary agent is used.
										





	
								Click OK.
							


Additional resources
	
								Configuring ACPI for use with integrated fence devices
							



Manually Fencing or Isolating a Non-Responsive Host




						If a host unpredictably goes into a non-responsive state, for example, due to a hardware failure, it can significantly affect the performance of the environment. If you do not have a power management device, or if it is incorrectly configured, you can reboot the host manually.
					
Warning

							Do not select Confirm 'Host has been Rebooted' unless you have manually rebooted the host. Using this option while the host is still running can lead to a virtual machine image corruption.
						

Procedure
	
								In the Administration Portal, click Compute → Hosts and confirm the host’s status is Non Responsive.
							
	
								Manually reboot the host. This could mean physically entering the lab and rebooting the host.
							
	
								In the Administration Portal, select the host and click More Actions ( 
								[image: moreactions]
								 ), then click Confirm 'Host has been Rebooted'.
							
	
								Select the Approve Operation check box and click OK.
							
	
								If your hosts take an unusually long time to boot, you can set ServerRebootTimeout to specify how many seconds to wait before determining that the host is Non Responsive:
							
# engine-config --set ServerRebootTimeout=integer






Storage



About Red Hat Virtualization storage




					Red Hat Virtualization uses a centralized storage system for virtual disks, ISO files and snapshots. Storage networking can be implemented using:
				
	
							Network File System (NFS)
						


	
							Other POSIX compliant file systems
						
	
							Internet Small Computer System Interface (iSCSI)
						
	
							Local storage attached directly to the virtualization hosts
						
	
							Fibre Channel Protocol (FCP)
						
	
							Parallel NFS (pNFS)
						



					Setting up storage is a prerequisite for a new data center because a data center cannot be initialized unless storage domains are attached and activated.
				

					As a Red Hat Virtualization system administrator, you create, configure, attach and maintain storage for the virtualized enterprise. You must be familiar with the storage types and their use. Read your storage array vendor’s guides, and see Red Hat Enterprise Linux Managing storage devices for more information on the concepts, protocols, requirements, and general usage of storage.
				

					To add storage domains you must be able to successfully access the Administration Portal, and there must be at least one host connected with a status of Up.
				

					Red Hat Virtualization has three types of storage domains:
				
	
							Data Domain: A data domain holds the virtual hard disks and OVF files of all the virtual machines and templates in a data center. In addition, snapshots of the virtual machines are also stored in the data domain.
						

							The data domain cannot be shared across data centers. Data domains of multiple types (iSCSI, NFS, FC, POSIX, and Gluster) can be added to the same data center, provided they are all shared, rather than local, domains.
						

							You must attach a data domain to a data center before you can attach domains of other types to it.
						

	
							ISO Domain: ISO domains store ISO files (or logical CDs) used to install and boot operating systems and applications for the virtual machines. An ISO domain removes the data center’s need for physical media. An ISO domain can be shared across different data centers. ISO domains can only be NFS-based. Only one ISO domain can be added to a data center.
						
	
							Export Domain: Export domains are temporary storage repositories that are used to copy and move images between data centers and Red Hat Virtualization environments. Export domains can be used to backup virtual machines. An export domain can be moved between data centers, however, it can only be active in one data center at a time. Export domains can only be NFS-based. Only one export domain can be added to a data center.
						
Note

								The export storage domain is deprecated. Storage data domains can be unattached from a data center and imported to another data center in the same environment, or in a different environment. Virtual machines, floating virtual disks, and templates can then be uploaded from the imported storage domain to the attached data center. See Importing Existing Storage Domains for information on importing storage domains.
							




Important

						Only commence configuring and attaching storage for your Red Hat Virtualization environment once you have determined the storage needs of your data center(s).
					


Understanding Storage Domains




					A storage domain is a collection of images that have a common storage interface. A storage domain contains complete images of templates and virtual machines (including snapshots), or ISO files. A storage domain can be made of block devices (SAN - iSCSI or FCP) or a file system (NAS - NFS, GlusterFS, or other POSIX compliant file systems).
				

					By default, GlusterFS domains and local storage domains support 4K block size. 4K block size can provide better performance, especially when using large files, and it is also necessary when you use tools that require 4K compatibility, such as VDO.
				
Note

						GlusterFS Storage is deprecated, and will no longer be supported in future releases.
					


					On NFS, all virtual disks, templates, and snapshots are files.
				

					On SAN (iSCSI/FCP), each virtual disk, template or snapshot is a logical volume. Block devices are aggregated into a logical entity called a volume group, and then divided by LVM (Logical Volume Manager) into logical volumes for use as virtual hard disks. See Red Hat Enterprise Linux Configuring and managing logical volumes for more information on LVM.
				

					Virtual disks can have one of two formats, either QCOW2 or raw. The type of storage can be sparse or preallocated. Snapshots are always sparse but can be taken for disks of either format.
				

					Virtual machines that share the same storage domain can be migrated between hosts that belong to the same cluster.
				

Preparing and Adding NFS Storage



Preparing NFS Storage




						Set up NFS shares on your file storage or remote server to serve as storage domains on Red Hat Enterprise Virtualization Host systems. After exporting the shares on the remote storage and configuring them in the Red Hat Virtualization Manager, the shares will be automatically imported on the Red Hat Virtualization hosts.
					

						For information on setting up, configuring, mounting and exporting NFS, see Managing file systems for Red Hat Enterprise Linux 8.
					

						Specific system user accounts and system user groups are required by Red Hat Virtualization so the Manager can store data in the storage domains represented by the exported directories. The following procedure sets the permissions for one directory. You must repeat the chown and chmod steps for all of the directories you intend to use as storage domains in Red Hat Virtualization.
					
Prerequisites
	
								Install the NFS utils package.
							
# dnf install nfs-utils -y

	
								To check the enabled versions:
							
# cat /proc/fs/nfsd/versions

	
								Enable the following services:
							
# systemctl enable nfs-server
# systemctl enable rpcbind



Procedure
	
								Create the group kvm:
							
# groupadd kvm -g 36

	
								Create the user vdsm in the group kvm:
							
# useradd vdsm -u 36 -g kvm

	
								Create the storage directory and modify the access rights.
							
# mkdir /storage
# chmod 0755 /storage
# chown 36:36 /storage/

	
								Add the storage directory to /etc/exports with the relevant permissions.
							
# vi /etc/exports
# cat /etc/exports
 /storage *(rw)

	
								Restart the following services:
							
# systemctl restart rpcbind
# systemctl restart nfs-server

	
								To see which export are available for a specific IP address:
							
# exportfs
 /nfs_server/srv
               10.46.11.3/24
 /nfs_server       <world>



Note

							If changes in /etc/exports have been made after starting the services, the exportfs -ra command can be used to reload the changes. After performing all the above stages, the exports directory should be ready and can be tested on a different host to check that it is usable.
						


Adding NFS Storage




						This procedure shows you how to attach existing NFS storage to your Red Hat Virtualization environment as a data domain.
					

						If you require an ISO or export domain, use this procedure, but select ISO or Export from the Domain Function list.
					
Procedure
	
								In the Administration Portal, click Storage → Domains.
							
	
								Click New Domain.
							
	
								Enter a Name for the storage domain.
							
	
								Accept the default values for the Data Center, Domain Function, Storage Type, Format, and Host lists.
							
	
								Enter the Export Path to be used for the storage domain. The export path should be in the format of 123.123.0.10:/data (for IPv4), [2001:0:0:0:0:0:0:5db1]:/data (for IPv6), or domain.example.com:/data.
							
	
								Optionally, you can configure the advanced parameters:
							
	
										Click Advanced Parameters.
									
	
										Enter a percentage value into the Warning Low Space Indicator field. If the free space available on the storage domain is below this percentage, warning messages are displayed to the user and logged.
									
	
										Enter a GB value into the Critical Space Action Blocker field. If the free space available on the storage domain is below this value, error messages are displayed to the user and logged, and any new action that consumes space, even temporarily, will be blocked.
									
	
										Select the Wipe After Delete check box to enable the wipe after delete option. This option can be edited after the domain is created, but doing so will not change the wipe after delete property of disks that already exist.
									



	
								Click OK.
							



						The new NFS data domain has a status of Locked until the disk is prepared. The data domain is then automatically attached to the data center.
					

Increasing NFS Storage




						To increase the amount of NFS storage, you can either create a new storage domain and add it to an existing data center, or increase the available free space on the NFS server. For the former option, see Adding NFS Storage. The following procedure explains how to increase the available free space on the existing NFS server.
					
Procedure
	
								Click Storage → Domains.
							
	
								Click the NFS storage domain’s name. This opens the details view.
							
	
								Click the Data Center tab and click Maintenance to place the storage domain into maintenance mode. This unmounts the existing share and makes it possible to resize the storage domain.
							
	
								On the NFS server, resize the storage. For Red Hat Enterprise Linux 6 systems, see Red Hat Enterprise Linux 6 Storage Administration Guide. For Red Hat Enterprise Linux 7 systems, see Red Hat Enterprise Linux 7 Storage Administration Guide. For Red Hat Enterprise Linux 8 systems, see Resizing a partition.
							
	
								In the details view, click the Data Center tab and click Activate to mount the storage domain.
							




Preparing and adding local storage




					A virtual machine’s disk that uses a storage device that is physically installed on the virtual machine’s host is referred to as a local storage device.
				

					A storage device must be part of a storage domain. The storage domain type for local storage is referred to as a local storage domain.
				

					Configuring a host to use local storage automatically creates, and adds the host to, a new local storage domain, data center and cluster to which no other host can be added. Multiple-host clusters require that all hosts have access to all storage domains, which is not possible with local storage. Virtual machines created in a single-host cluster cannot be migrated, fenced, or scheduled.
				
Preparing local storage




						On Red Hat Virtualization Host (RHVH), local storage should always be defined on a file system that is separate from / (root). Use a separate logical volume or disk, to prevent possible loss of data during upgrades.
					
Procedure for Red Hat Enterprise Linux hosts
	
								On the host, create the directory to be used for the local storage:
							
# mkdir -p /data/images

	
								Ensure that the directory has permissions allowing read/write access to the vdsm user (UID 36) and kvm group (GID 36):
							
# chown 36:36 /data /data/images
# chmod 0755 /data /data/images



Procedure for Red Hat Virtualization Hosts

							Create the local storage on a logical volume:
						
	
								Create a local storage directory:
							
# mkdir /data
# lvcreate -L $SIZE rhvh -n data
# mkfs.ext4 /dev/mapper/rhvh-data
# echo "/dev/mapper/rhvh-data /data ext4 defaults,discard 1 2" >> /etc/fstab
# mount /data

	
								Mount the new local storage:
							
# mount -a

	
								Ensure that the directory has permissions allowing read/write access to the vdsm user (UID 36) and kvm group (GID 36):
							
# chown 36:36 /data /rhvh-data
# chmod 0755 /data /rhvh-data




Adding a local storage domain




						When adding a local storage domain to a host, setting the path to the local storage directory automatically creates and places the host in a local data center, local cluster, and local storage domain.
					
Procedure
	
								Click Compute → Hosts and select the host.
							
	
								Click Management → Maintenance and OK. The host’s status changes to Maintenance.
							
	
								Click Management → Configure Local Storage.
							
	
								Click the Edit buttons next to the Data Center, Cluster, and Storage fields to configure and name the local storage domain.
							
	
								Set the path to your local storage in the text entry field.
							
	
								If applicable, click the Optimization tab to configure the memory optimization policy for the new local storage cluster.
							
	
								Click OK.
							



						The Manager sets up the local data center with a local cluster, local storage domain. It also changes the host’s status to Up.
					
Verification
	
								Click Storage → Domains.
							
	
								Locate the local storage domain you just added.
							



						The domain’s status should be Active ( 
						[image: status active icon]
						 ), and the value in the Storage Type column should be Local on Host.
					

						You can now upload a disk image in the new local storage domain.
					


Preparing and Adding POSIX-compliant File System Storage



Preparing POSIX-compliant File System Storage




						POSIX file system support allows you to mount file systems using the same mount options that you would normally use when mounting them manually from the command line. This functionality is intended to allow access to storage not exposed using NFS, iSCSI, or FCP.
					

						Any POSIX-compliant file system used as a storage domain in Red Hat Virtualization must be a clustered file system, such as Global File System 2 (GFS2), and must support sparse files and direct I/O. The Common Internet File System (CIFS), for example, does not support direct I/O, making it incompatible with Red Hat Virtualization.
					

						For information on setting up and configuring POSIX-compliant file system storage, see Red Hat Enterprise Linux Global File System 2.
					
Important

							Do not mount NFS storage by creating a POSIX-compliant file system storage domain. Always create an NFS storage domain instead.
						


Adding POSIX-compliant File System Storage




						This procedure shows you how to attach existing POSIX-compliant file system storage to your Red Hat Virtualization environment as a data domain.
					
Procedure
	
								Click Storage → Domains.
							
	
								Click New Domain.
							
	
								Enter the Name for the storage domain.
							
	
								Select the Data Center to be associated with the storage domain. The data center selected must be of type POSIX (POSIX compliant FS). Alternatively, select (none).
							
	
								Select Data from the Domain Function drop-down list, and POSIX compliant FS from the Storage Type drop-down list.
							

								If applicable, select the Format from the drop-down menu.
							

	
								Select a host from the Host drop-down list.
							
	
								Enter the Path to the POSIX file system, as you would normally provide it to the mount command.
							
	
								Enter the VFS Type, as you would normally provide it to the mount command using the -t argument. See man mount for a list of valid VFS types.
							
	
								Enter additional Mount Options, as you would normally provide them to the mount command using the -o argument. The mount options should be provided in a comma-separated list. See man mount for a list of valid mount options.
							
	
								Optionally, you can configure the advanced parameters.
							
	
										Click Advanced Parameters.
									
	
										Enter a percentage value in the Warning Low Space Indicator field. If the free space available on the storage domain is below this percentage, warning messages are displayed to the user and logged.
									
	
										Enter a GB value in the Critical Space Action Blocker field. If the free space available on the storage domain is below this value, error messages are displayed to the user and logged, and any new action that consumes space, even temporarily, will be blocked.
									
	
										Select the Wipe After Delete check box to enable the wipe after delete option. This option can be edited after the domain is created, but doing so will not change the wipe after delete property of disks that already exist.
									



	
								Click OK.
							




Preparing and Adding Block Storage



Preparing iSCSI Storage




						Red Hat Virtualization supports iSCSI storage, which is a storage domain created from a volume group made up of LUNs. Volume groups and LUNs cannot be attached to more than one storage domain at a time.
					

						For information on setting up and configuring iSCSI storage, see Configuring an iSCSI target in Managing storage devices for Red Hat Enterprise Linux 8.
					
Important

							If you are using block storage and intend to deploy virtual machines on raw devices or direct LUNs and manage them with the Logical Volume Manager (LVM), you must create a filter to hide guest logical volumes. This will prevent guest logical volumes from being activated when the host is booted, a situation that could lead to stale logical volumes and cause data corruption. Use the vdsm-tool config-lvm-filter command to create filters for the LVM.
						

Important

							Red Hat Virtualization currently does not support block storage with a block size of 4K. You must configure block storage in legacy (512b block) mode.
						

Important

							If your host is booting from SAN storage and loses connectivity to the storage, the storage file systems become read-only and remain in this state after connectivity is restored.
						

							To prevent this situation, add a drop-in multipath configuration file on the root file system of the SAN for the boot LUN to ensure that it is queued when there is a connection:
						
# cat /etc/multipath/conf.d/host.conf
multipaths {
    multipath {
        wwid boot_LUN_wwid
        no_path_retry queue
    }


Adding iSCSI Storage




						This procedure shows you how to attach existing iSCSI storage to your Red Hat Virtualization environment as a data domain.
					
Procedure
	
								Click Storage → Domains.
							
	
								Click New Domain.
							
	
								Enter the Name of the new storage domain.
							
	
								Select a Data Center from the drop-down list.
							
	
								Select Data as the Domain Function and iSCSI as the Storage Type.
							
	
								Select an active host as the Host.
							
Important

									Communication to the storage domain is from the selected host and not directly from the Manager. Therefore, all hosts must have access to the storage device before the storage domain can be configured.
								


	
								The Manager can map iSCSI targets to LUNs or LUNs to iSCSI targets. The New Domain window automatically displays known targets with unused LUNs when the iSCSI storage type is selected. If the target that you are using to add storage does not appear, you can use target discovery to find it; otherwise proceed to the next step.
							
	
										Click Discover Targets to enable target discovery options. When targets have been discovered and logged in to, the New Domain window automatically displays targets with LUNs unused by the environment.
									
Note

											LUNs used externally for the environment are also displayed.
										


										You can use the Discover Targets options to add LUNs on many targets or multiple paths to the same LUNs.
									
Important

											If you use the REST API method discoveriscsi to discover the iscsi targets, you can use an FQDN or an IP address, but you must use the iscsi details from the discovered targets results to log in using the REST API method iscsilogin. See discoveriscsi in the REST API Guide for more information.
										


	
										Enter the FQDN or IP address of the iSCSI host in the Address field.
									
	
										Enter the port with which to connect to the host when browsing for targets in the Port field. The default is 3260.
									
	
										If CHAP is used to secure the storage, select the User Authentication check box. Enter the CHAP user name and CHAP password.
									
Note

											You can define credentials for an iSCSI target for a specific host with the REST API. See StorageServerConnectionExtensions: add in the REST API Guide for more information.
										


	
										Click Discover.
									
	
										Select one or more targets from the discovery results and click Login for one target or Login All for multiple targets.
									
Important

											If more than one path access is required, you must discover and log in to the target through all the required paths. Modifying a storage domain to add additional paths is currently not supported.
										

Important

											When using the REST API iscsilogin method to log in, you must use the iscsi details from the discovered targets results in the discoveriscsi method. See iscsilogin in the REST API Guide for more information.
										





	
								Click the + button next to the desired target. This expands the entry and displays all unused LUNs attached to the target.
							
	
								Select the check box for each LUN that you are using to create the storage domain.
							
	
								Optionally, you can configure the advanced parameters:
							
	
										Click Advanced Parameters.
									
	
										Enter a percentage value into the Warning Low Space Indicator field. If the free space available on the storage domain is below this percentage, warning messages are displayed to the user and logged.
									
	
										Enter a GB value into the Critical Space Action Blocker field. If the free space available on the storage domain is below this value, error messages are displayed to the user and logged, and any new action that consumes space, even temporarily, will be blocked.
									
	
										Select the Wipe After Delete check box to enable the wipe after delete option. This option can be edited after the domain is created, but doing so will not change the wipe after delete property of disks that already exist.
									
	
										Select the Discard After Delete check box to enable the discard after delete option. This option can be edited after the domain is created. This option is only available to block storage domains.
									



	
								Click OK.
							



						If you have configured multiple storage connection paths to the same target, follow the procedure in Configuring iSCSI Multipathing to complete iSCSI bonding.
					

						If you want to migrate your current storage network to an iSCSI bond, see Migrating a Logical Network to an iSCSI Bond.
					

Configuring iSCSI Multipathing




						iSCSI multipathing enables you to create and manage groups of logical networks and iSCSI storage connections. Multiple network paths between the hosts and iSCSI storage prevent host downtime caused by network path failure.
					

						The Manager connects each host in the data center to each target, using the NICs or VLANs that are assigned to the logical networks in the iSCSI bond.
					

						You can create an iSCSI bond with multiple targets and logical networks for redundancy.
					
Prerequisites
	
								One or more iSCSI targets
							
	
								One or more logical networks that meet the following requirements:
							
	
										Not defined as Required or VM Network
									
	
										Assigned to a host interface
									
	
										Assigned a static IP address in the same VLAN and subnet as the other logical networks in the iSCSI bond
									





Note

							Multipath is not supported for Self-Hosted Engine deployments.
						

Procedure
	
								Click Compute → Data Centers.
							
	
								Click the data center name. This opens the details view.
							
	
								In the iSCSI Multipathing tab, click Add.
							
	
								In the Add iSCSI Bond window, enter a Name and a Description.
							
	
								Select a logical network from Logical Networks and a storage domain from Storage Targets. You must select all the paths to the same target.
							
	
								Click OK.
							



						The hosts in the data center are connected to the iSCSI targets through the logical networks in the iSCSI bond.
					

Migrating a Logical Network to an iSCSI Bond




						If you have a logical network that you created for iSCSI traffic and configured on top of an existing network bond, you can migrate it to an iSCSI bond on the same subnet without disruption or downtime.
					
Procedure
	
								Modify the current logical network so that it is not Required:
							
	
										Click Compute → Clusters.
									
	
										Click the cluster name. This opens the details view.
									
	
										In the Logical Networks tab, select the current logical network (net-1) and click Manage Networks.
									
	
										Clear the Require check box and click OK.
									



	
								Create a new logical network that is not Required and not VM network:
							
	
										Click Add Network. This opens the New Logical Network window.
									
	
										In the General tab, enter the Name (net-2) and clear the VM network check box.
									
	
										In the Cluster tab, clear the Require check box and click OK.
									



	
								Remove the current network bond and reassign the logical networks:
							
	
										Click Compute → Hosts.
									
	
										Click the host name. This opens the details view.
									
	
										In the Network Interfaces tab, click Setup Host Networks.
									
	
										Drag net-1 to the right to unassign it.
									
	
										Drag the current bond to the right to remove it.
									
	
										Drag net-1 and net-2 to the left to assign them to physical interfaces.
									
	
										Click the pencil icon of net-2. This opens the Edit Network window.
									
	
										In the IPV4 tab, select Static.
									
	
										Enter the IP and Netmask/Routing Prefix of the subnet and click OK.
									



	
								Create the iSCSI bond:
							
	
										Click Compute → Data Centers.
									
	
										Click the data center name. This opens the details view.
									
	
										In the iSCSI Multipathing tab, click Add.
									
	
										In the Add iSCSI Bond window, enter a Name, select the networks, net-1 and net-2, and click OK.
									






						Your data center has an iSCSI bond containing the old and new logical networks.
					

Preparing FCP Storage




						Red Hat Virtualization supports SAN storage by creating a storage domain from a volume group made of pre-existing LUNs. Neither volume groups nor LUNs can be attached to more than one storage domain at a time.
					

						Red Hat Virtualization system administrators need a working knowledge of Storage Area Networks (SAN) concepts. SAN usually uses Fibre Channel Protocol (FCP) for traffic between hosts and shared external storage. For this reason, SAN may occasionally be referred to as FCP storage.
					

						For information on setting up and configuring FCP or multipathing on Red Hat Enterprise Linux, see the Storage Administration Guide and DM Multipath Guide.
					
Important

							If you are using block storage and intend to deploy virtual machines on raw devices or direct LUNs and manage them with the Logical Volume Manager (LVM), you must create a filter to hide guest logical volumes. This will prevent guest logical volumes from being activated when the host is booted, a situation that could lead to stale logical volumes and cause data corruption. Use the vdsm-tool config-lvm-filter command to create filters for the LVM.
						

Important

							Red Hat Virtualization currently does not support block storage with a block size of 4K. You must configure block storage in legacy (512b block) mode.
						

Important

							If your host is booting from SAN storage and loses connectivity to the storage, the storage file systems become read-only and remain in this state after connectivity is restored.
						

							To prevent this situation, add a drop-in multipath configuration file on the root file system of the SAN for the boot LUN to ensure that it is queued when there is a connection:
						
# cat /etc/multipath/conf.d/host.conf
multipaths {
    multipath {
        wwid boot_LUN_wwid
        no_path_retry queue
    }
  }


Adding FCP Storage




						This procedure shows you how to attach existing FCP storage to your Red Hat Virtualization environment as a data domain.
					
Procedure
	
								Click Storage → Domains.
							
	
								Click New Domain.
							
	
								Enter the Name of the storage domain.
							
	
								Select an FCP Data Center from the drop-down list.
							

								If you do not yet have an appropriate FCP data center, select (none).
							

	
								Select the Domain Function and the Storage Type from the drop-down lists. The storage domain types that are not compatible with the chosen data center are not available.
							
	
								Select an active host in the Host field. If this is not the first data domain in a data center, you must select the data center’s SPM host.
							
Important

									All communication to the storage domain is through the selected host and not directly from the Red Hat Virtualization Manager. At least one active host must exist in the system and be attached to the chosen data center. All hosts must have access to the storage device before the storage domain can be configured.
								


	
								The New Domain window automatically displays known targets with unused LUNs when Fibre Channel is selected as the storage type. Select the LUN ID check box to select all of the available LUNs.
							
	
								Optionally, you can configure the advanced parameters.
							
	
										Click Advanced Parameters.
									
	
										Enter a percentage value into the Warning Low Space Indicator field. If the free space available on the storage domain is below this percentage, warning messages are displayed to the user and logged.
									
	
										Enter a GB value into the Critical Space Action Blocker field. If the free space available on the storage domain is below this value, error messages are displayed to the user and logged, and any new action that consumes space, even temporarily, will be blocked.
									
	
										Select the Wipe After Delete check box to enable the wipe after delete option. This option can be edited after the domain is created, but doing so will not change the wipe after delete property of disks that already exist.
									
	
										Select the Discard After Delete check box to enable the discard after delete option. This option can be edited after the domain is created. This option is only available to block storage domains.
									



	
								Click OK.
							



						The new FCP data domain remains in a Locked status while it is being prepared for use. When ready, it is automatically attached to the data center.
					

Increasing iSCSI or FCP Storage




						There are several ways to increase iSCSI or FCP storage size:
					
	
								Add an existing LUN to the current storage domain.
							
	
								Create a new storage domain with new LUNs and add it to an existing data center. See Adding iSCSI Storage.
							
	
								Expand the storage domain by resizing the underlying LUNs.
							



						For information about configuring or resizing FCP storage, see Using Fibre Channel Devices in Managing storage devices for Red Hat Enterprise Linux 8.
					

						The following procedure explains how to expand storage area network (SAN) storage by adding a new LUN to an existing storage domain.
					

						Prerequisites
					
	
								The storage domain’s status must be UP.
							
	
								The LUN must be accessible to all the hosts whose status is UP, or else the operation will fail and the LUN will not be added to the domain. The hosts themselves, however, will not be affected. If a newly added host, or a host that is coming out of maintenance or a Non Operational state, cannot access the LUN, the host’s state will be Non Operational.
							



						Increasing an Existing iSCSI or FCP Storage Domain
					
	
								Click Storage → Domains and select an iSCSI or FCP domain.
							
	
								Click Manage Domain.
							
	
								Click Targets → LUNs and click the Discover Targets expansion button.
							
	
								Enter the connection information for the storage server and click Discover to initiate the connection.
							
	
								Click LUNs → Targets and select the check box of the newly available LUN.
							
	
								Click OK to add the LUN to the selected storage domain.
							



						This will increase the storage domain by the size of the added LUN.
					

						When expanding the storage domain by resizing the underlying LUNs, the LUNs must also be refreshed in the Administration Portal.
					

						Refreshing the LUN Size
					
	
								Click Storage → Domains and select an iSCSI or FCP domain.
							
	
								Click Manage Domain.
							
	
								Click LUNs → Targets.
							
	
								In the Additional Size column, click Add Additional_Storage_Size button of the LUN to refresh.
							
	
								Click OK to refresh the LUN to indicate the new storage size.
							



Reusing LUNs




						LUNs cannot be reused, as is, to create a storage domain or virtual disk. If you try to reuse the LUNs, the Administration Portal displays the following error message:
					
Physical device initialization failed. Please check that the device is empty and accessible by the host.

						A self-hosted engine shows the following error during installation:
					
[ ERROR ] Error creating Volume Group: Failed to initialize physical device: ("[u'/dev/mapper/000000000000000000000000000000000']",)
[ ERROR ] Failed to execute stage 'Misc configuration': Failed to initialize physical device: ("[u'/dev/mapper/000000000000000000000000000000000']",)

						Before the LUN can be reused, the old partitioning table must be cleared.
					
Procedure

							You must run this procedure on the correct LUN so that you do not inadvertently destroy data.
						

	
								Delete the partition mappings in <LUN_ID>:
							
kpartx -dv /dev/mapper/<LUN_ID>

	
								Erase the fileystem or raid signatures in <LUN_ID>:
							
wipefs -a /dev/mapper/<LUN_ID>

	
								Inform the operating system about the partition table changes on <LUN_ID>:
							
 partprobe




Removing stale LUNs




						When a storage domain is removed, stale LUN links can remain on the storage server. This can lead to slow multipath scans, cluttered log files, and LUN ID conflicts.
					

						Red Hat Virtualization does not manage the iSCSI servers and, therefore, cannot automatically remove LUNs when a storage domain is removed. The administrator can manually remove stale LUN links with the remove_stale_lun.yml Ansible role. This role removes stale LUN links from all hosts that belong to given data center. For more information about this role and its variables, see the Remove Stale LUN role in the oVirt Ansible collection.
					
Note

							It is assumed that you are running remove_stale_lun.yml from the engine machine as the engine ssh key is already added on all the hosts. If the playbook is not running on the engine machine, a user’s SSH key must be added to all hosts that belong to the data center, or the user must provide an appropriate inventory file.
						


Procedure
	
								Click Storage → Domains.
							
	
								Click the storage domain’s name. This opens the details view.
							
	
								Click the Data Center tab.
							
	
								Click Maintenance, then click OK.
							
	
								Click Detatch, then click OK.
							
	
								Click Remove.
							
	
								Click OK to remove the storage domain from the source environment.
							
	
								Remove the LUN from the storage server.
							
	
								Remove the stale LUNs from the host using Ansible:
							
# ansible-playbook --extra-vars "lun=<LUN>" /usr/share/ansible/collections/ansible_collections/ovirt/ovirt/roles/remove_stale_lun/examples/remove_stale_lun.yml

								where LUN is the LUN removed from the storage server in the steps above.
							
Note

									If you remove the stale LUN from the host using Ansible without first removing the LUN from the storage server, the stale LUN will reappear on the host the next time VDSM performs an iSCSI rescan.
								






Creating an LVM filter




						An LVM filter is a capability that can be set in /etc/lvm/lvm.conf to accept devices into or reject devices from the list of volumes based on a regex query. For example, to ignore /dev/cdrom you can use filter=["r|^/dev/cdrom$|"], or add the following parameter to the lvm command: lvs --config 'devices{filter=["r|cdrom|"]}'.
					

						This provides a simple way to prevent a host from scanning and activating logical volumes that are not required directly by the host. In particular, the solution addresses logical volumes on shared storage managed by RHV, and logical volumes created by a guest in RHV raw volumes. This solution is needed because scanning and activating other logical volumes may cause data corruption, slow boot, or other issues.
					

						The solution is to configure an LVM filter on each host, which allows the LVM on a host to scan only the logical volumes that are required by the host.
					

						You can use the command vdsm-tool config-lvm-filter to analyze the current LVM configuration and decide if a filter needs to be configured.
					

						If the LVM filter has not yet been configured, the command generates an LVM filter option for the host, and adds the option to the LVM configuration.
					
Scenario 1: An Unconfigured Host

							On a host yet to be configured, the command automatically configures the LVM once the user confirms the operation:
						
# vdsm-tool config-lvm-filter
Analyzing host...
Found these mounted logical volumes on this host:
logical volume:  /dev/mapper/vg0-lv_home
mountpoint:      /home
devices:         /dev/vda2
logical volume:  /dev/mapper/vg0-lv_root
mountpoint:      /
devices:         /dev/vda2
logical volume:  /dev/mapper/vg0-lv_swap
mountpoint:      [SWAP]
devices:         /dev/vda2
This is the recommended LVM filter for this host:
filter = [ "a|^/dev/vda2$|", "r|.*|" ]
This filter will allow LVM to access the local devices used by the
hypervisor, but not shared storage owned by VDSM. If you add a new
device to the volume group, you will need to edit the filter manually.
Configure LVM filter? [yes,NO] ? [NO/yes] yes
Configuration completed successfully!
Please reboot to verify the LVM configuration.

Scenario 2: A Configured Host

							If the host is already configured, the command simply informs the user that the LVM filter is already configured:
						
# vdsm-tool config-lvm-filter
Analyzing host...
LVM filter is already configured for Vdsm

Scenario 3: Manual Configuration Required

							If the host configuration does not match the configuration required by VDSM, the LVM filter will need to be configured manually:
						
# vdsm-tool config-lvm-filter
Analyzing host...
Found these mounted logical volumes on this host:
logical volume:  /dev/mapper/vg0-lv_home
mountpoint:      /home
devices:         /dev/vda2
logical volume:  /dev/mapper/vg0-lv_root
mountpoint:      /
devices:         /dev/vda2
logical volume:  /dev/mapper/vg0-lv_swap
mountpoint:      [SWAP]
devices:         /dev/vda2
This is the recommended LVM filter for this host:
filter = [ "a|^/dev/vda2$|", "r|.*|" ]
This filter will allow LVM to access the local devices used by the
hypervisor, but not shared storage owned by VDSM. If you add a new
device to the volume group, you will need to edit the filter manually.
This is the current LVM filter:
filter = [ "a|^/dev/vda2$|", "a|^/dev/vdb1$|", "r|.*|" ]
WARNING: The current LVM filter does not match the recommended filter,
Vdsm cannot configure the filter automatically.
Please edit /etc/lvm/lvm.conf and set the 'filter' option in the  'devices' section to the recommended value.
It is recommended to reboot after changing LVM filter.



Preparing and Adding Red Hat Gluster Storage



Preparing Red Hat Gluster Storage




						For information on setting up and configuring Red Hat Gluster Storage, see the Red Hat Gluster Storage Installation Guide.
					

						For the Red Hat Gluster Storage versions that are supported with Red Hat Virtualization, see Red Hat Gluster Storage Version Compatibility and Support.
					

Adding Red Hat Gluster Storage




						To use Red Hat Gluster Storage with Red Hat Virtualization, see Configuring Red Hat Virtualization with Red Hat Gluster Storage.
					

						For the Red Hat Gluster Storage versions that are supported with Red Hat Virtualization, see Red Hat Gluster Storage Version Compatibility and Support.
					


Importing Existing Storage Domains



Overview of Importing Existing Storage Domains




						Aside from adding new storage domains, which contain no data, you can import existing storage domains and access the data they contain. By importing storage domains, you can recover data in the event of a failure in the Manager database, and migrate data from one data center or environment to another.
					

						The following is an overview of importing each storage domain type:
					
	Data
	
									Importing an existing data storage domain allows you to access all of the virtual machines and templates that the data storage domain contains. After you import the storage domain, you must manually import virtual machines, floating disk images, and templates into the destination data center. The process for importing the virtual machines and templates that a data storage domain contains is similar to that for an export storage domain. However, because data storage domains contain all the virtual machines and templates in a given data center, importing data storage domains is recommended for data recovery or large-scale migration of virtual machines between data centers or environments.
								
Important

										You can import existing data storage domains that were attached to data centers with the correct supported compatibility level. See Supportability and constraints regarding importing Storage Domains and Virtual Machines from older RHV versions for more information.
									


	ISO
	
									Importing an existing ISO storage domain allows you to access all of the ISO files and virtual diskettes that the ISO storage domain contains. No additional action is required after importing the storage domain to access these resources; you can attach them to virtual machines as required.
								
	Export
	
									Importing an existing export storage domain allows you to access all of the virtual machine images and templates that the export storage domain contains. Because export domains are designed for exporting and importing virtual machine images and templates, importing export storage domains is recommended method of migrating small numbers of virtual machines and templates inside an environment or between environments. For information on exporting and importing virtual machines and templates to and from export storage domains, see Exporting and Importing Virtual Machines and Templates in the Virtual Machine Management Guide.
								
Note

										The export storage domain is deprecated. Storage data domains can be unattached from a data center and imported to another data center in the same environment, or in a different environment. Virtual machines, floating virtual disks, and templates can then be uploaded from the imported storage domain to the attached data center.
									

Warning

										Upon attaching a Storage Domain to the destination Data-Center, it may be upgraded to a newer Storage Domain format and may not re-attach to the source Data-Center. This breaks the use of a Data-Domain as a replacement for Export Domains.
									





Importing storage domains




						Import a storage domain that was previously attached to a data center in the same environment or in a different environment. This procedure assumes the storage domain is no longer attached to any data center in any environment, to avoid data corruption. To import and attach an existing data storage domain to a data center, the target data center must be initialized.
					
Procedure
	
								Click Storage → Domains.
							
	
								Click Import Domain.
							
	
								Select the Data Center you want to import the storage domain to.
							
	
								Enter a Name for the storage domain.
							
	
								Select the Domain Function and Storage Type from the drop-down lists.
							
	
								Select a host from the Host drop-down list.
							
Important

									All communication to the storage domain is through the selected host and not directly from the Red Hat Virtualization Manager. At least one active host must exist in the system and be attached to the chosen data center. All hosts must have access to the storage device before the storage domain can be configured.
								


	
								Enter the details of the storage domain.
							
Note

									The fields for specifying the details of the storage domain change depending on the values you select in the Domain Function and Storage Type lists. These fields are the same as those available for adding a new storage domain.
								


	
								Select the Activate Domain in Data Center check box to activate the storage domain after attaching it to the selected data center.
							
	
								Click OK.
							



						You can now import virtual machines and templates from the storage domain to the data center.
					
Warning

							Upon attaching a Storage Domain to the destination Data-Center, it may be upgraded to a newer Storage Domain format and may not re-attach to the source Data-Center. This breaks the use of a Data-Domain as a replacement for Export Domains.
						

Related information
	
								Importing Virtual Machines from a Data Domain
							
	
								Importing Templates from Imported Data Storage Domains
							



Migrating Storage Domains between Data Centers in the Same Environment




						Migrate a storage domain from one data center to another in the same Red Hat Virtualization environment to allow the destination data center to access the data contained in the storage domain. This procedure involves detaching the storage domain from one data center, and attaching it to a different data center.
					
Warning

							Migrating a data storage domain to a data center that has a higher compatibility level than the original data center upgrades the storage domain’s storage format version.
						


						If you want to move the storage domain back to the original data center for any reason, such as to migrate virtual machines to the new data center, be aware that the higher version prevents reattaching the data storage domain to the original data center.
					

						The Administration Portal prompts you to confirm that you want to update the storage domain format, for example, from V3 to V5. It also warns that you will not be able to attach it back to an older data center with a lower DC level.
					

						To work around this issue, you can create a target data center that has the same compatibility version as the source data center. When you no longer need to maintain the lower compatibility version, you can increase the target data center’s compatibility version.
					

						For details, see Supportability and constraints regarding importing Storage Domains and Virtual Machines from older RHV versions.
					
Procedure
	
								Shut down all virtual machines running on the required storage domain.
							
	
								Click Storage → Domains.
							
	
								Click the storage domain’s name. This opens the details view.
							
	
								Click the Data Center tab.
							
	
								Click Maintenance, then click OK.
							
	
								Click Detach, then click OK.
							
	
								Click Attach.
							
	
								Select the destination data center and click OK.
							



						The storage domain is attached to the destination data center and is automatically activated. You can now import virtual machines and templates from the storage domain to the destination data center.
					

Migrating Storage Domains between Data Centers in Different Environments




						Migrate a storage domain from one Red Hat Virtualization environment to another to allow the destination environment to access the data contained in the storage domain. This procedure involves removing the storage domain from one Red Hat Virtualization environment, and importing it into a different environment. To import and attach an existing data storage domain to a Red Hat Virtualization data center, the storage domain’s source data center must have the correct supported compatibility level.
					
Warning

							Migrating a data storage domain to a data center that has a higher compatibility level than the original data center upgrades the storage domain’s storage format version.
						


						If you want to move the storage domain back to the original data center for any reason, such as to migrate virtual machines to the new data center, be aware that the higher version prevents reattaching the data storage domain to the original data center.
					

						The Administration Portal prompts you to confirm that you want to update the storage domain format, for example, from V3 to V5. It also warns that you will not be able to attach it back to an older data center with a lower DC level.
					

						To work around this issue, you can create a target data center that has the same compatibility version as the source data center. When you no longer need to maintain the lower compatibility version, you can increase the target data center’s compatibility version.
					

						For details, see Supportability and constraints regarding importing Storage Domains and Virtual Machines from older RHV versions.
					
Procedure
	
								Log in to the Administration Portal of the source environment.
							
	
								Shut down all virtual machines running on the required storage domain.
							
	
								Click Storage → Domains.
							
	
								Click the storage domain’s name. This opens the details view.
							
	
								Click the Data Center tab.
							
	
								Click Maintenance, then click OK.
							
	
								Click Detach, then click OK.
							
	
								Click Remove.
							
	
								In the Remove Storage(s) window, ensure the Format Domain, i.e. Storage Content will be lost! check box is not selected. This step preserves the data in the storage domain for later use.
							
	
								Click OK to remove the storage domain from the source environment.
							
	
								Log in to the Administration Portal of the destination environment.
							
	
								Click Storage → Domains.
							
	
								Click Import Domain.
							
	
								Select the destination data center from the Data Center drop-down list.
							
	
								Enter a name for the storage domain.
							
	
								Select the Domain Function and Storage Type from the appropriate drop-down lists.
							
	
								Select a host from the Host drop-down list.
							
	
								Enter the details of the storage domain.
							
Note

									The fields for specifying the details of the storage domain change depending on the value you select in the Storage Type drop-down list. These fields are the same as those available for adding a new storage domain.
								


	
								Select the Activate Domain in Data Center check box to automatically activate the storage domain when it is attached.
							
	
								Click OK.
							



						The storage domain is attached to the destination data center in the new Red Hat Virtualization environment and is automatically activated. You can now import virtual machines and templates from the imported storage domain to the destination data center.
					
Warning

							Upon attaching a Storage Domain to the destination Data-Center, it may be upgraded to a newer Storage Domain format and may not re-attach to the source Data-Center. This breaks the use of a Data-Domain as a replacement for Export Domains.
						


Importing Templates from Imported Data Storage Domains




						Import a template from a data storage domain you have imported into your Red Hat Virtualization environment. This procedure assumes that the imported data storage domain has been attached to a data center and has been activated.
					
Procedure
	
								Click Storage → Domains.
							
	
								Click the imported storage domain’s name. This opens the details view.
							
	
								Click the Template Import tab.
							
	
								Select one or more templates to import.
							
	
								Click Import.
							
	
								For each template in the Import Templates(s) window, ensure the correct target cluster is selected in the Cluster list.
							
	
								Map external virtual machine vNIC profiles to profiles that are present on the target cluster(s):
							
	
										Click vNic Profiles Mapping.
									
	
										Select the vNIC profile to use from the Target vNic Profile drop-down list.
									
	
										If multiple target clusters are selected in the Import Templates window, select each target cluster in the Target Cluster drop-down list and ensure the mappings are correct.
									
	
										Click OK.
									



	
								Click OK.
							



						The imported templates no longer appear in the list under the Template Import tab.
					


Storage Tasks



Uploading Images to a Data Storage Domain




						You can upload virtual disk images and ISO images to your data storage domain in the Administration Portal or with the REST API.
					
Note

							To upload images with the REST API, see IMAGETRANSFERS and IMAGETRANSFER in the REST API Guide.
						


						QEMU-compatible virtual disks can be attached to virtual machines. Virtual disk types must be either QCOW2 or raw. Disks created from a QCOW2 virtual disk cannot be shareable, and the QCOW2 virtual disk file must not have a backing file.
					

						ISO images can be attached to virtual machines as CDROMs or used to boot virtual machines.
					
Prerequisites

							The upload function uses HTML 5 APIs, which requires your environment to have the following:
						
	
								Certificate authority, imported into the web browser used to access the Administration Portal.
							

								To import the certificate authority, browse to https://engine_address/ovirt-engine/services/pki-resource?resource=ca-certificate&format=X509-PEM-CA and enable all the trust settings. Refer to the instructions to install the certificate authority in Firefox, Internet Explorer, or Google Chrome.
							

	
								Browser that supports HTML 5, such as Firefox 35, Internet Explorer 10, Chrome 13, or later.
							


Procedure
	
								Click Storage → Disks.
							
	
								Select Start from the Upload menu.
							
	
								Click Choose File and select the image to upload.
							
	
								Fill in the Disk Options fields. See Explanation of Settings in the New Virtual Disk Window for descriptions of the relevant fields.
							
	
								Click OK.
							

								A progress bar indicates the status of the upload. You can pause, cancel, or resume uploads from the Upload menu.
							



Tip

						If the upload times out with the message, Reason: timeout due to transfer inactivity, increase the timeout value and restart the ovirt-engine service:
					
# engine-config -s TransferImageClientInactivityTimeoutInSeconds=6000
# systemctl restart ovirt-engine


Uploading the VirtIO image files to a storage domain




						The virtio-win_version.iso image contains the following for Windows virtual machines to improve performance and usability:
					
	
								VirtIO drivers
							
	
								an installer for the guest agents
							
	
								an installer for the drivers
							



						To install and upload the most recent version of virtio-win_version.iso:
					
	
								Install the image files on the Manager machine:
							
# dnf -y install virtio-win

								After you install it on the Manager machine, the image file is /usr/share/virtio-win/virtio-win_version.iso
							

	
								Upload the image file to a data storage domain that was not created locally during installation. For more information, see Uploading Images to a Data Storage Domain in the Administration Guide.
							
	
								Attach the image file to virtual machines.
							



						The virtual machines can now use the virtio drivers and agents.
					

						For information on attaching the image files to a virtual machine, see Installing the Guest Agents, Tools, and Drivers on Windows in the Virtual Machine Management Guide.
					

Uploading images to an ISO domain



Note

							The ISO domain is a deprecated storage domain type. The ISO Uploader tool, ovirt-iso-uploader, is removed in Red Hat Virtualization 4.4. You should upload ISO images to the data domain with the Administration Portal or with the REST API. See Uploading Images to a Data Storage Domain for details.
						

							Although the ISO domain is deprecated, this information is provided in case you must use an ISO domain.
						


						To upload an ISO image to an ISO storage domain in order to make it available from within the Manager, follow these steps.
					
Procedure
	
								Login as root to the host that belongs to the Data Center where your ISO storage domain resides.
							
	
								Get a directory tree of /rhv/data-center:
							
# tree /rhev/data-center
.
|-- 80dfacc7-52dd-4d75-ab82-4f9b8423dc8b
|   |-- 76d1ecba-b61d-45a4-8eb5-89ab710a6275 → /rhev/data-center/mnt/10.10.10.10:_rhevnfssd/76d1ecba-b61d-45a4-8eb5-89ab710a6275
|   |-- b835cd1c-111c-468d-ba70-fec5346af227 → /rhev/data-center/mnt/10.10.10.10:_rhevisosd/b835cd1c-111c-468d-ba70-fec5346af227
|   |-- mastersd → 76d1ecba-b61d-45a4-8eb5-89ab710a6275
|   |-- tasks → mastersd/master/tasks
|   `-- vms → mastersd/master/vms
|-- hsm-tasks
`-- mnt
    |-- 10.10.10.10:_rhevisosd
    |   |-- b835cd1c-111c-468d-ba70-fec5346af227
    |   |   |-- dom_md
    |   |   |   |-- ids
    |   |   |   |-- inbox
    |   |   |   |-- leases
    |   |   |   |-- metadata
    |   |   |   `-- outbox
    |   |   `-- images
    |   |       `-- 11111111-1111-1111-1111-111111111111
    |   `-- lost+found [error opening dir]

(output trimmed)

	
								Securely copy the image from the source location into the full path of 11111111-1111-1111-1111-111111111111:
							
# scp root@isosource:/isos/example.iso /rhev/data-center/mnt/10.96.4.50:_rhevisosd/b835cd1c-111c-468d-ba70-fec5346af227/images/11111111-1111-1111-1111-111111111111

	
								File permissions for the newly copied ISO image should be 36:36 (vdsm:kvm). If they are not, change user and group ownership of the ISO file to 36:36 (vdsm’s user and group):
							
# cd /rhev/data-center/mnt/10.96.4.50:_rhevisosd/b835cd1c-111c-468d-ba70-fec5346af227/images/11111111-1111-1111-1111-111111111111
# chown 36.36 example.iso




						The ISO image should now be available in the ISO domain in the data center.
					

Moving Storage Domains to Maintenance Mode




						A storage domain must be in maintenance mode before it can be detached and removed. This is required to redesignate another data domain as the master data domain.
					
Important

							You cannot move a storage domain into maintenance mode if a virtual machine has a lease on the storage domain. The virtual machine needs to be shut down, or the lease needs to be to removed or moved to a different storage domain first. See the Virtual Machine Management Guide for information about virtual machine leases.
						


						Expanding iSCSI domains by adding more LUNs can only be done when the domain is active.
					
Procedure
	
								Shut down all the virtual machines running on the storage domain.
							
	
								Click Storage → Domains.
							
	
								Click the storage domain’s name. This opens the details view.
							
	
								Click the Data Center tab.
							
	
								Click Maintenance.
							
Note

									The Ignore OVF update failure check box allows the storage domain to go into maintenance mode even if the OVF update fails.
								


	
								Click OK.
							



						The storage domain is deactivated and has an Inactive status in the results list. You can now edit, detach, remove, or reactivate the inactive storage domains from the data center.
					
Note

							You can also activate, detach, and place domains into maintenance mode using the Storage tab in the details view of the data center it is associated with.
						


Editing Storage Domains




						You can edit storage domain parameters through the Administration Portal. Depending on the state of the storage domain, either active or inactive, different fields are available for editing. Fields such as Data Center, Domain Function, Storage Type, and Format cannot be changed.
					
	
								Active: When the storage domain is in an active state, the Name, Description, Comment, Warning Low Space Indicator (%), Critical Space Action Blocker (GB), Wipe After Delete, and Discard After Delete fields can be edited. The Name field can only be edited while the storage domain is active. All other fields can also be edited while the storage domain is inactive.
							
	
								Inactive: When the storage domain is in maintenance mode or unattached, thus in an inactive state, you can edit all fields except Name, Data Center, Domain Function, Storage Type, and Format. The storage domain must be inactive to edit storage connections, mount options, and other advanced parameters. This is only supported for NFS, POSIX, and Local storage types.
							


Note

							iSCSI storage connections cannot be edited via the Administration Portal, but can be edited via the REST API. See Updating Storage Connections in the REST API Guide.
						

Editing an Active Storage Domain*
	
								Click Storage → Domains and select a storage domain.
							
	
								Click Manage Domain.
							
	
								Edit the available fields as required.
							
	
								Click OK.
							


Editing an Inactive Storage Domain
	
								Click Storage → Domains.
							
	
								If the storage domain is active, move it to maintenance mode:
							
	
										Click the storage domain’s name. This opens the details view.
									
	
										Click the Data Center tab.
									
	
										Click Maintenance.
									
	
										Click OK.
									



	
								Click Manage Domain.
							
	
								Edit the storage path and other details as required. The new connection details must be of the same storage type as the original connection.
							
	
								Click OK.
							
	
								Activate the storage domain:
							
	
										Click the storage domain’s name. This opens the details view.
									
	
										Click the Data Center tab.
									
	
										Click Activate.
									






Updating OVFs




						By default, OVFs are updated every 60 minutes. However, if you have imported an important virtual machine or made a critical update, you can update OVFs manually.
					
Procedure
	
								Click Storage → Domains.
							
	
								Select the storage domain and click More Actions ( 
								[image: moreactions]
								 ), then click Update OVFs.
							

								The OVFs are updated and a message appears in Events.
							




Activating Storage Domains from Maintenance Mode




						If you have been making changes to a data center’s storage, you have to put storage domains into maintenance mode. Activate a storage domain to resume using it.
					
	
								Click Storage → Domains.
							
	
								Click an inactive storage domain’s name. This opens the details view.
							
	
								Click the Data Centers tab.
							
	
								Click Activate.
							


Important

							If you attempt to activate the ISO domain before activating the data domain, an error message displays and the domain is not activated.
						


Detaching a Storage Domain from a Data Center




						Detach a storage domain from one data center to migrate it to another data center.
					
Procedure
	
								Click Storage → Domains.
							
	
								Click the storage domain’s name. This opens the details view.
							
	
								Click the Data Center tab.
							
	
								Click Maintenance.
							
	
								Click OK to initiate maintenance mode.
							
	
								Click Detach.
							
	
								Click OK to detach the storage domain.
							



						The storage domain has been detached from the data center, ready to be attached to another data center.
					

Attaching a Storage Domain to a Data Center




						Attach a storage domain to a data center.
					
Procedure
	
								Click Storage → Domains.
							
	
								Click the storage domain’s name. This opens the details view.
							
	
								Click the Data Center tab.
							
	
								Click Attach.
							
	
								Select the appropriate data center.
							
	
								Click OK.
							



						The storage domain is attached to the data center and is automatically activated.
					

Removing a Storage Domain




						You have a storage domain in your data center that you want to remove from the virtualized environment.
					
Procedure
	
								Click Storage → Domains.
							
	
								Move the storage domain to maintenance mode and detach it:
							
	
										Click the storage domain’s name. This opens the details view.
									
	
										Click the Data Center tab.
									
	
										Click Maintenance, then click OK.
									
	
										Click Detach, then click OK.
									



	
								Click Remove.
							
	
								Optionally select the Format Domain, i.e. Storage Content will be lost! check box to erase the content of the domain.
							
	
								Click OK.
							



						The storage domain is permanently removed from the environment.
					

Destroying a Storage Domain




						A storage domain encountering errors may not be able to be removed through the normal procedure. Destroying a storage domain forcibly removes the storage domain from the virtualized environment.
					
Procedure
	
								Click Storage → Domains.
							
	
								Select the storage domain and click More Actions ( 
								[image: moreactions]
								 ), then click Destroy.
							
	
								Select the Approve operation check box.
							
	
								Click OK.
							



Creating a Disk Profile




						Disk profiles define the maximum level of throughput and the maximum level of input and output operations for a virtual disk in a storage domain. Disk profiles are created based on storage profiles defined under data centers, and must be manually assigned to individual virtual disks for the profile to take effect.
					

						This procedure assumes you have already defined one or more storage quality of service entries under the data center to which the storage domain belongs.
					
Procedure
	
								Click Storage → Domains.
							
	
								Click the data storage domain’s name. This opens the details view.
							
	
								Click the Disk Profiles tab.
							
	
								Click New.
							
	
								Enter a Name and a Description for the disk profile.
							
	
								Select the quality of service to apply to the disk profile from the QoS list.
							
	
								Click OK.
							



Removing a Disk Profile




						Remove an existing disk profile from your Red Hat Virtualization environment.
					
Procedure
	
								Click Storage → Domains.
							
	
								Click the data storage domain’s name. This opens the details view.
							
	
								Click the Disk Profiles tab.
							
	
								Select the disk profile to remove.
							
	
								Click Remove.
							
	
								Click OK.
							



						If the disk profile was assigned to any virtual disks, the disk profile is removed from those virtual disks.
					

Viewing the Health Status of a Storage Domain




						Storage domains have an external health status in addition to their regular Status. The external health status is reported by plug-ins or external systems, or set by an administrator, and appears to the left of the storage domain’s Name as one of the following icons:
					
	
								OK: No icon
							
	
								Info: 
								[image: Info]

							
	
								Warning: 
								[image: Warning]

							
	
								Error: 
								[image: Error]

							
	
								Failure: 
								[image: Failure]

							



						To view further details about the storage domain’s health status, click the storage domain’s name. This opens the details view, and click the Events tab.
					

						The storage domain’s health status can also be viewed using the REST API. A GET request on a storage domain will include the external_status element, which contains the health status.
					

						You can set a storage domain’s health status in the REST API via the events collection. For more information, see Adding Events in the REST API Guide.
					

Setting Discard After Delete for a Storage Domain




						When the Discard After Delete check box is selected, a blkdiscard command is called on a logical volume when it is removed and the underlying storage is notified that the blocks are free. The storage array can use the freed space and allocate it when requested. Discard After Delete only works on block storage. The flag is not available on the Red Hat Virtualization Manager for file storage, for example NFS.
					

						Restrictions:
					
	
								Discard After Delete is only available on block storage domains, such as iSCSI or Fibre Channel.
							
	
								The underlying storage must support Discard.
							



						Discard After Delete can be enabled both when creating a block storage domain or when editing a block storage domain. See Preparing and Adding Block Storage and Editing Storage Domains.
					

Enabling 4K support on environments with more than 250 hosts




						By default, GlusterFS domains and local storage domains support 4K block size on Red Hat Virtualization environments with up to 250 hosts. 4K block size can provide better performance, especially when using large files, and it is also necessary when you use tools that require 4K compatibility, such as VDO.
					
Note

							GlusterFS Storage is deprecated, and will no longer be supported in future releases.
						


						The lockspace area that Sanlock allocates is 1 MB when the maximum number of hosts is the default 250. When you increase the maximum number of hosts when using 4K storage, the lockspace area is larger. For example, when using 2000 hosts, the lockspace area could be as large as 8 MB.
					

						You can enable 4K block support on environments with more than 250 hosts by setting the engine configuration parameter MaxNumberOfHostsInStoragePool.
					
Procedure
	
								On the Manager machine enable the required maximum number of hosts:
							
# engine-config -s MaxNumberOfHostsInStoragePool=NUMBER_OF_HOSTS

	
								Restart the JBoss Application Server:
							
# service jboss-as restart




						For example, if you have a cluster with 300 hosts, enter:
					
# engine-config -s MaxNumberOfHostsInStoragePool=300
# service jboss-as restart
Verification

							View the value of the MaxNumberOfHostsInStoragePool parameter on the Manager:
						
 # engine-config --get=MaxNumberOfHostsInStoragePool
 MaxNumberOfHostsInStoragePool: 250 version: general

Disabling 4K support




						By default, GlusterFS domains and local storage domains support 4K block size. 4K block size can provide better performance, especially when using large files, and it is also necessary when you use tools that require 4K compatibility, such as VDO.
					
Note

							GlusterFS Storage is deprecated, and will no longer be supported in future releases.
						


						You can disable 4K block support.
					
Procedure
	
								Ensure that 4K block support is enabled.
							
$ vdsm-client Host getCapabilities
…​
{
    "GLUSTERFS" : [
         0,
         512,
         4096,
    ]
    …​

	
								Edit /etc/vdsm/vdsm.conf.d/gluster.conf and set enable_4k_storage to false. For example:
							
$ vi  /etc/vdsm/vdsm.conf.d/gluster.conf

[gluster]
# Use to disable 4k support
# if needed.
enable_4k_storage = false




Monitoring available space in a storage domain




						You can monitor available space in a storage domain and create an alert to warn you when a storage domain is nearing capacity. You can also define a critical threshold at which point the domain shuts down.
					

						With Virtual Data Optimizer (VDO) and thin pool support, you might see more available space than is physically available. For VDO this behavior is expected, but the Manager cannot predict how much data you can actually write. The Warning Low Confirmed Space Indicator parameter notifies you when the domain is nearing physical space capacity and shows how much confirmed space remains. Confirmed space refers to the actual space available to write data.
					
Procedure
	
								In the Administration Portal, click Storage → Storage Domain and click the name of a storage domain.
							
	
								Click Manage Domain. The Manage Domains dialog box opens.
							
	
								Expand Advanced Parameters.
							
	
								For Warning Low Space Indicator (%) enter a percentage value. When the available space in the storage domain reaches this value, the Manager alerts you that the domain is nearing capacity.
							
	
								For Critical Space Action Blocker (GB), enter a value in gigabytes. When the available space in the storage domain reaches this value, the Manager shuts down.
							
	
								For Warning Low Confirmed Space Indicator (%) enter a percentage value. When the available space in the storage domain reaches this value, the Manager alerts you that the actual space available to write data is nearing capacity.
							





Pools



Introduction to Virtual Machine Pools




					A virtual machine pool is a group of virtual machines that are all clones of the same template and that can be used on demand by any user in a given group. Virtual machine pools allow administrators to rapidly configure a set of generalized virtual machines for users.
				

					Users access a virtual machine pool by taking a virtual machine from the pool. When a user takes a virtual machine from a pool, they are provided with any one of the virtual machines in the pool if any are available. That virtual machine will have the same operating system and configuration as that of the template on which the pool was based, but users may not receive the same member of the pool each time they take a virtual machine. Users can also take multiple virtual machines from the same virtual machine pool depending on the configuration of that pool.
				

					Virtual machine pools are stateless by default, meaning that virtual machine data and configuration changes are not persistent across reboots. However, the pool can be configured to be stateful, allowing changes made by a previous user to persist. However, if a user configures console options for a virtual machine taken from a virtual machine pool, those options will be set as the default for that user for that virtual machine pool.
				
Note

						Virtual machines taken from a pool are not stateless when accessed from the Administration Portal. This is because administrators need to be able to write changes to the disk if necessary.
					


					In principle, virtual machines in a pool are started when taken by a user, and shut down when the user is finished. However, virtual machine pools can also contain pre-started virtual machines. Pre-started virtual machines are kept in an up state, and remain idle until they are taken by a user. This allows users to start using such virtual machines immediately, but these virtual machines will consume system resources even while not in use due to being idle.
				

Creating a virtual machine pool




					You can create a virtual machine pool containing multiple virtual machines based on a common template. See Templates in the Virtual Machine Management Guide for information about sealing a virtual machine and creating a template.
				

					Sysprep File Configuration Options for Windows Virtual Machines
				

					Several sysprep file configuration options are available, depending on your requirements.
				

					If your pool does not need to join a domain, you can use the default sysprep file, located in /usr/share/ovirt-engine/conf/sysprep/.
				

					If your pool needs to join a domain, you can create a custom sysprep for each Windows operating system:
				
	
							Copy the relevant sections for each operating system from /usr/share/ovirt-engine/conf/osinfo-defaults.properties to a new file and save as 99-defaults.properties.
						
	
							In 99-defaults.properties, specify the Windows product activation key and the path of your new custom sysprep file:
						

							os.operating_system.productKey.value=Windows_product_activation_key …​ os.operating_system.sysprepPath.value = ${ENGINE_USR}/conf/sysprep/sysprep.operating_system
						


	
							Create a new sysprep file, specifying the domain, domain password, and domain administrator:
						
<Credentials>
    <Domain>__AD_Domain__</Domain>
    <Password>__Domain_Password__</Password>
    <Username>__Domain_Administrator__</Username>
</Credentials>





					If you need to configure different sysprep settings for different pools of Windows virtual machines, you can create a custom sysprep file in the Administration Portal (see Creating a Virtual Machine Pool below). See Using Sysprep to Automate the Configuration of Virtual Machines in the Virtual Machine Guide for more information.
				
Procedure
	
							Click Compute → Pools.
						
	
							Click New.
						
	
							Select a Cluster from the drop-down list.
						
	
							Select a Template and version from the drop-down menu. A template provides standard settings for all the virtual machines in the pool.
						
	
							Select an Operating System from the drop-down list.
						
	
							Use Optimized for to optimize virtual machines for Desktop or Server.
						
Note

								High Performance optimization is not recommended for pools because a high performance virtual machine is pinned to a single host and concrete resources. A pool containing multiple virtual machines with such a configuration would not run well.
							


	
							Enter a Name and, optionally, a Description and Comment.
						

							The Name of the pool is applied to each virtual machine in the pool, with a numeric suffix. You can customize the numbering of the virtual machines with ? as a placeholder.
						
Example 2.1. Pool Name and Virtual Machine Numbering Examples
	
										Pool: MyPool
									

										Virtual machines: MyPool-1, MyPool-2, …​ MyPool-10
									

	
										Pool: MyPool-???
									

										Virtual machines: MyPool-001, MyPool-002, …​ MyPool-010
									






	
							Enter the Number of VMs for the pool.
						
	
							Enter the number of virtual machines to be prestarted in the Prestarted field.
						
	
							Select the Maximum number of VMs per user that a single user is allowed to run in a session. The minimum is 1.
						
	
							Select the Delete Protection check box to enable delete protection. 
						
	
							If you are creating a pool of non-Windows virtual machines or if you are using the default sysprep, skip this step. If you are creating a custom sysprep file for a pool of Windows virtual machines:
						
	
									Click the Show Advanced Options button.
								
	
									Click the Initial Run tab and select the Use Cloud-Init/Sysprep check box.
								
	
									Click the Authentication arrow and enter the User Name and Password or select Use already configured password.
								
Note

										This User Name is the name of the local administrator. You can change its value from its default value (user) here in the Authentication section or in a custom sysprep file.
									


	
									Click the Custom Script arrow and paste the contents of the default sysprep file, located in /usr/share/ovirt-engine/conf/sysprep/, into the text box.
								
	
									You can modify the following values of the sysprep file:
								
	
											Key. If you do not want to use the pre-defined Windows activation product key, replace <![CDATA[$ProductKey$]]> with a valid product key:
										
<ProductKey>
    <Key><![CDATA[$ProductKey$]]></Key>
</ProductKey>

Example 2.2. Windows Product Key Example
<ProductKey>
    <Key>0000-000-000-000</Key>
</ProductKey>



	
											Domain that the Windows virtual machines will join, the domain’s Password, and the domain administrator’s Username:
										
<Credentials>
    <Domain>__AD_Domain__</Domain>
    <Password>__Domain_Password__</Password>
    <Username>__Domain_Administrator__</Username>
</Credentials>

Example 2.3. Domain Credentials Example
<Credentials>
    <Domain>addomain.local</Domain>
    <Password>12345678</Password>
    <Username>Sarah_Smith</Username>
</Credentials>


Note

												The Domain, Password, and Username are required to join the domain. The Key is for activation. You do not necessarily need both.
											

												The domain and credentials cannot be modified in the Initial Run tab.
											


	
											FullName of the local administrator:
										
<UserData>
...
    <FullName>__Local_Administrator__</FullName>
...
</UserData>


	
											DisplayName and Name of the local administrator:
										
<LocalAccounts>
    <LocalAccount wcm:action="add">
        <Password>
            <Value><![CDATA[$AdminPassword$]]></Value>
            <PlainText>true</PlainText>
        </Password>
        <DisplayName>__Local_Administrator__</DisplayName>
        <Group>administrators</Group>
        <Name>__Local_Administrator__</Name>
    </LocalAccount>
</LocalAccounts>


											The remaining variables in the sysprep file can be filled in on the Initial Run tab.
										







	
							Optional. Set a Pool Type:
						
	
									Click the Type tab and select a Pool Type:
								
	
											Manual - The administrator is responsible for explicitly returning the virtual machine to the pool.
										
	
											Automatic - The virtual machine is automatically returned to the virtual machine pool.
										



	
									Select the Stateful Pool check box to ensure that virtual machines are started in a stateful mode. This ensures that changes made by a previous user will persist on a virtual machine.
								
	
									Click OK.
								



	
							Optional. Override the SPICE proxy:
						
	
									In the Console tab, select the Override SPICE Proxy check box.
								
	
									In the Overridden SPICE proxy address text field, specify the address of a SPICE proxy to override the global SPICE proxy.
								
	
									Click OK.
								



	
							For a pool of Windows virtual machines, click Compute → Virtual Machines, select each virtual machine from the pool, and click Run → Run Once.
						
Note

								If the virtual machine does not start and Info [windeploy.exe] Found no unattend file appears in %WINDIR%\panther\UnattendGC\setupact.log, add the UnattendFile key to the registry of the Windows virtual machine that was used to create the template for the pool:
							
	
										Check that the Windows virtual machine has an attached secondary CD-ROM device with the unattend file, for example, A:\Unattend.xml.
									
	
										Select the virtual machine and click Run → Run once.
									
	
										Under Boot Options, check Attach Windows guest tools CD.
									
	
										Click Start, click Run, type regedit in the Open text box, and click OK.
									
	
										In the left pane, go to HKEY_LOCAL_MACHINE → SYSTEM → Setup.
									
	
										Right-click the right pane and select New → String Value.
									
	
										Enter UnattendFile as the key name.
									
	
										Double-click the new key and enter the unattend file name and path, for example, A:\Unattend.xml, as the key’s value.
									
	
										Save the registry, seal the Windows virtual machine, and create a new template. See Templates in the Virtual Machine Management Guide for details.
									







					You have created and configured a virtual machine pool with the specified number of identical virtual machines. You can view these virtual machines in Compute → Virtual Machines, or by clicking the name of a pool to open its details view; a virtual machine in a pool is distinguished from independent virtual machines by its icon.
				

Explanation of Settings and Controls in the New Pool and Edit Pool Windows



New Pool and Edit Pool General Settings Explained




						The following table details the information required on the General tab of the New Pool and Edit Pool windows that are specific to virtual machine pools. All other settings are identical to those in the New Virtual Machine window.
					
Table 2.30. General settings
	Field Name	Description
	 
										Template
									

									 	 
										The template and template sub-version on which the virtual machine pool is based. If you create a pool based on the latest sub-version of a template, all virtual machines in the pool, when rebooted, will automatically receive the latest template version. For more information on configuring templates for virtual machines see Virtual Machine General Settings Explained and Explanation of Settings in the New Template and Edit Template Windows in the Virtual Machine Management Guide.
									

									 
	 
										Description
									

									 	 
										A meaningful description of the virtual machine pool.
									

									 
	 
										Comment
									

									 	 
										A field for adding plain text human-readable comments regarding the virtual machine pool.
									

									 
	 
										Prestarted VMs
									

									 	 
										Allows you to specify the number of virtual machines in the virtual machine pool that will be started before they are taken and kept in that state to be taken by users. The value of this field must be between 0 and the total number of virtual machines in the virtual machine pool.
									

									 
	 
										Number of VMs/Increase number of VMs in pool by
									

									 	 
										Allows you to specify the number of virtual machines to be created and made available in the virtual machine pool. In the edit window it allows you to increase the number of virtual machines in the virtual machine pool by the specified number. By default, the maximum number of virtual machines you can create in a pool is 1000. This value can be configured using the MaxVmsInPool key of the engine-config command.
									

									 
	 
										Maximum number of VMs per user
									

									 	 
										Allows you to specify the maximum number of virtual machines a single user can take from the virtual machine pool at any one time. The value of this field must be between 1 and 32,767.
									

									 
	 
										Delete Protection
									

									 	 
										Allows you to prevent the virtual machines in the pool from being deleted.
									

									 
	 
										Sealed
									

									 	 
										Ensures that machine-specific settings from the template are not reproduced in virtual machines that are provisioned from the template. For more information about the sealing process, see Sealing a Windows Virtual Machine for Deployment as a Template
									

									 




New Pool and Edit Pool Type Settings Explained




						The following table details the information required on the Type tab of the New Pool and Edit Pool windows.
					
Table 2.31. Type settings
	Field Name	Description
	 
										Pool Type
									

									 	 
										This drop-down menu allows you to specify the type of the virtual machine pool. The following options are available:
									

									 	
												Automatic: After a user finishes using a virtual machine taken from a virtual machine pool, that virtual machine is automatically returned to the virtual machine pool.
											
	
												Manual: After a user finishes using a virtual machine taken from a virtual machine pool, that virtual machine is only returned to the virtual machine pool when an administrator manually returns the virtual machine.
											



									 
	 
										Stateful Pool
									

									 	 
										Specify whether the state of virtual machines in the pool is preserved when a virtual machine is passed to a different user. This means that changes made by a previous user will persist on the virtual machine.
									

									 




New Pool and Edit Pool Console Settings Explained




						The following table details the information required on the Console tab of the New Pool or Edit Pool window that is specific to virtual machine pools. All other settings are identical to those in the New Virtual Machine and Edit Virtual Machine windows.
					
Table 2.32. Console settings
	Field Name	Description
	 
										Override SPICE proxy
									

									 	 
										Select this check box to enable overriding the SPICE proxy defined in global configuration. This feature is useful in a case where the user (who is, for example, connecting via the VM Portal) is outside of the network where the hosts reside.
									

									 
	 
										Overridden SPICE proxy address
									

									 	 
										The proxy by which the SPICE client connects to virtual machines. This proxy overrides both the global SPICE proxy defined for the Red Hat Virtualization environment and the SPICE proxy defined for the cluster to which the virtual machine pool belongs, if any. The address must be in the following format:
									

									 
protocol://host:port

									 




Virtual Machine Pool Host Settings Explained




						The following table details the options available on the Host tab of the New Pool and Edit Pool windows.
					
Table 2.33. Virtual Machine Pool: Host Settings
	Field Name	Sub-element	Description
	 
										Start Running On
									

									 	 	 
										Defines the preferred host on which the virtual machine is to run. Select either:
									

									 	
												Any Host in Cluster - The virtual machine can start and run on any available host in the cluster.
											
	
												Specific Host(s) - The virtual machine will start running on a particular host in the cluster. However, the Manager or an administrator can migrate the virtual machine to a different host in the cluster depending on the migration and high-availability settings of the virtual machine. Select the specific host or group of hosts from the list of available hosts.
											



									 
	 
										CPU options
									

									 	 
										Pass-Through Host CPU
									

									 	 
										When selected, allows virtual machines to use the host’s CPU flags. When selected, Migration Options is set to Allow manual migration only.
									

									 
	 	 
										Migrate only to hosts with the same TSC frequency
									

									 	 
										When selected, this virtual machine can only be migrated to a host with the same TSC frequency. This option is only valid for High Performance virtual machines.
									

									 
	 
										Migration Options
									

									 	 
										Migration mode
									

									 	 
										Defines options to run and migrate the virtual machine. If the options here are not used, the virtual machine will run or migrate according to its cluster’s policy.
									

									 	
												Allow manual and automatic migration - The virtual machine can be automatically migrated from one host to another in accordance with the status of the environment, or manually by an administrator.
											
	
												Allow manual migration only - The virtual machine can only be migrated from one host to another manually by an administrator.
											
	
												Do not allow migration - The virtual machine cannot be migrated, either automatically or manually.
											



									 
	 	 
										Migration policy
									

									 	 
										Defines the migration convergence policy. If the check box is left unselected, the host determines the policy.
									

									 	
												Cluster default (Minimal downtime) - Overrides in vdsm.conf are still applied. The guest agent hook mechanism is disabled.
											
	
												Minimal downtime - Allows the virtual machine to migrate in typical situations. Virtual machines should not experience any significant downtime. The migration will be aborted if virtual machine migration does not converge after a long time (dependent on QEMU iterations, with a maximum of 500 milliseconds). The guest agent hook mechanism is enabled.
											
	
												Post-copy migration - When used, post-copy migration pauses the migrating virtual machine vCPUs on the source host, transfers only a minimum of memory pages, activates the virtual machine vCPUs on the destination host, and transfers the remaining memory pages while the virtual machine is running on the destination.
											

												The post-copy policy first tries pre-copy to verify whether convergence can occur. The migration switches to post-copy if the virtual machine migration does not converge after a long time.
											

												This significantly reduces the downtime of the migrated virtual machine, and also guarantees that the migration finishes regardless of how rapidly the memory pages of the source virtual machine change. It is optimal for migrating virtual machines in heavy continuous use, which would not be possible to migrate with standard pre-copy migration.
											

												The disadvantage of this policy is that in the post-copy phase, the virtual machine may slow down significantly as the missing parts of memory are transferred between the hosts.
											
Warning

													If the network connection breaks prior to the completion of the post-copy process, the Manager pauses and then kills the running virtual machine. Do not use post-copy migration if the virtual machine availability is critical or if the migration network is unstable.
												


	
												Suspend workload if needed - Allows the virtual machine to migrate in most situations, including when the virtual machine is running a heavy workload. Because of this, virtual machines may experience a more significant downtime than with some other settings. The migration may still be aborted for extreme workloads. The guest agent hook mechanism is enabled.
											



									 
	 	 
										Enable migration encryption
									

									 	 
										Allows the virtual machine to be encrypted during migration.
									

									 	
												Cluster default
											
	
												Encrypt
											
	
												Don’t encrypt
											



									 
	 	 
										Parallel Migrations
									

									 	 
										Allows you to specify whether and how many parallel migration connections to use.
									

									 	
												Cluster default: Parallel migration connections are determined by the cluster default.
											
	
												Disabled: The virtual machine is migrated using a single, non-parallel connection.
											
	
												Auto: The number of parallel connections is automatically determined. This settings might automatically disable parallel connections.
											
	
												Auto Parallel: The number of parallel connections is automatically determined.
											
	
												Custom: Allows you to specify the preferred number of parallel connections, the actual number may be lower.
											



									 
	 	 
										Number of VM Migration Connections
									

									 	 
										This setting is only available when Custom is selected. The preferred number of custom parallel migrations, between 2 and 255.
									

									 
	 
										Configure NUMA
									

									 	 
										NUMA Node Count
									

									 	 
										The number of virtual NUMA nodes available in a host that can be assigned to the virtual machine.
									

									 
	 	 
										NUMA Pinning
									

									 	 
										Opens the NUMA Topology window. This window shows the host’s total CPUs, memory, and NUMA nodes, and the virtual machine’s virtual NUMA nodes. You can manually pin virtual NUMA nodes to host NUMA nodes by clicking and dragging each vNUMA from the box on the right to a NUMA node on the left.
									

									 
										You can also set Tune Mode for memory allocation:
									

									 
										Strict - Memory allocation will fail if the memory cannot be allocated on the target node.
									

									 
										Preferred - Memory is allocated from a single preferred node. If sufficient memory is not available, memory can be allocated from other nodes.
									

									 
										Interleave - Memory is allocated across nodes in a round-robin algorithm.
									

									 
										If you define NUMA pinning, Migration Options is set to Allow manual migration only.
									

									 




New Pool and Edit Pool Resource Allocation Settings Explained




						The following table details the information required on the Resource Allocation tab of the New Pool and Edit Pool windows that are specific to virtual machine pools. All other settings are identical to those in the New Virtual Machine window. See Virtual Machine Resource Allocation Settings Explained in the Virtual Machine Management Guide for more information.
					
Table 2.34. Resource Allocation settings
	Field Name	Sub-element	Description
	 
										Disk Allocation
									

									 	 
										Auto select target
									

									 	 
										Select this check box to automatically select the storage domain that has the most free space. The Target and Disk Profile fields are disabled.
									

									 
	 	 
										Format
									

									 	 
										This field is read-only and always displays QCOW2.
									

									 




Editing a Virtual Machine Pool




						After a virtual machine pool has been created, its properties can be edited. The properties available when editing a virtual machine pool are identical to those available when creating a new virtual machine pool except that the Number of VMs property is replaced by Increase number of VMs in pool by.
					
Note

							When editing a virtual machine pool, the changes introduced affect only new virtual machines. Virtual machines that existed already at the time of the introduced changes remain unaffected.
						

Procedure
	
								Click Compute → Pools and select a virtual machine pool.
							
	
								Click Edit.
							
	
								Edit the properties of the virtual machine pool.
							
	
								Click Ok.
							



Prestarting Virtual Machines in a Pool




						The virtual machines in a virtual machine pool are powered down by default. When a user requests a virtual machine from a pool, a machine is powered up and assigned to the user. In contrast, a prestarted virtual machine is already running and waiting to be assigned to a user, decreasing the amount of time a user has to wait before being able to access a machine. When a prestarted virtual machine is shut down it is returned to the pool and restored to its original state. The maximum number of prestarted virtual machines is the number of virtual machines in the pool.
					

						Prestarted virtual machines are suitable for environments in which users require immediate access to virtual machines which are not specifically assigned to them. Only automatic pools can have prestarted virtual machines.
					
Procedure
	
								Click Compute → Pools and select the virtual machine pool.
							
	
								Click Edit.
							
	
								Enter the number of virtual machines to be prestarted in the Prestarted VMs field.
							
	
								Click the Type tab. Ensure Pool Type is set to Automatic.
							
	
								Click OK.
							



Adding Virtual Machines to a Virtual Machine Pool




						If you require more virtual machines than originally provisioned in a virtual machine pool, add more machines to the pool.
					
Procedure
	
								Click Compute → Pools and select the virtual machine pool.
							
	
								Click Edit.
							
	
								Enter the number of additional virtual machines in the Increase number of VMs in pool by field.
							
	
								Click OK.
							



Detaching Virtual Machines from a Virtual Machine Pool




						You can detach virtual machines from a virtual machine pool. Detaching a virtual machine removes it from the pool to become an independent virtual machine.
					
Procedure
	
								Click Compute → Pools.
							
	
								Click the pool’s name. This opens the details view.
							
	
								Click the Virtual Machines tab to list the virtual machines in the pool.
							
	
								Ensure the virtual machine has a status of Down; you cannot detach a running virtual machine.
							
	
								Select one or more virtual machines and click Detach.
							
	
								Click OK.
							


Note

							The virtual machine still exists in the environment and can be viewed and accessed from Compute → Virtual Machines. Note that the icon changes to denote that the detached virtual machine is an independent virtual machine.
						


Removing a Virtual Machine Pool




						You can remove a virtual machine pool from a data center. You must first either delete or detach all of the virtual machines in the pool. Detaching virtual machines from the pool will preserve them as independent virtual machines.
					
Procedure
	
								Click Compute → Pools and select the virtual machine pool.
							
	
								Click Remove.
							
	
								Click OK.
							





Virtual Disks



Understanding Virtual Machine Storage




					Red Hat Virtualization supports three storage types: NFS, iSCSI and FCP.
				

					In each type, a host known as the Storage Pool Manager (SPM) manages access between hosts and storage. The SPM host is the only node that has full access within the storage pool; the SPM can modify the storage domain metadata, and the pool’s metadata. All other hosts can only access virtual machine hard disk image data.
				

					By default in an NFS, local, or POSIX compliant data center, the SPM creates the virtual disk using a thin provisioned format as a file in a file system.
				

					In iSCSI and other block-based data centers, the SPM creates a volume group on top of the Logical Unit Numbers (LUNs) provided, and makes logical volumes to use as virtual disks. Virtual disks on block-based storage are preallocated by default.
				

					If the virtual disk is preallocated, a logical volume of the specified size in GB is created. The virtual machine can be mounted on a Red Hat Enterprise Linux server using kpartx, vgscan, vgchange or mount to investigate the virtual machine’s processes or problems.
				

					If the virtual disk is thinly provisioned, a 1 GB logical volume is created. The logical volume is continuously monitored by the host on which the virtual machine is running. As soon as the usage nears a threshold the host notifies the SPM, and the SPM extends the logical volume by 1 GB. The host is responsible for resuming the virtual machine after the logical volume has been extended. If the virtual machine goes into a paused state it means that the SPM could not extend the disk in time. This occurs if the SPM is too busy or if there is not enough storage space.
				

					A virtual disk with a preallocated (raw) format has significantly faster write speeds than a virtual disk with a thin provisioning (QCOW2) format. Thin provisioning takes significantly less time to create a virtual disk. The thin provision format is suitable for non-I/O intensive virtual machines. The preallocated format is recommended for virtual machines with high I/O writes. If a virtual machine is able to write more than 1 GB every four seconds, use preallocated disks where possible.
				

Understanding Virtual Disks




					Red Hat Virtualization features Preallocated (thick provisioned) and Sparse (thin provisioned) storage options.
				
	
							Preallocated
						

							A preallocated virtual disk allocates all the storage required for a virtual machine up front. For example, a 20 GB preallocated logical volume created for the data partition of a virtual machine will take up 20 GB of storage space immediately upon creation.
						

	
							Sparse
						

							A sparse allocation allows an administrator to define the total storage to be assigned to the virtual machine, but the storage is only allocated when required.
						

							For example, a 20 GB thin provisioned logical volume would take up 0 GB of storage space when first created. When the operating system is installed it may take up the size of the installed file, and would continue to grow as data is added up to a maximum of 20 GB size.
						




					You can view a virtual disk’s ID in Storage → Disks. The ID is used to identify a virtual disk because its device name (for example, /dev/vda0) can change, causing disk corruption. You can also view a virtual disk’s ID in /dev/disk/by-id.
				

					You can view the Virtual Size of a disk in Storage → Disks and in the Disks tab of the details view for storage domains, virtual machines, and templates. The Virtual Size is the total amount of disk space that the virtual machine can use. It is the number that you enter in the Size(GB) field when you create or edit a virtual disk.
				

					You can view the Actual Size of a disk in the Disks tab of the details view for storage domains and templates. This is the amount of disk space that has been allocated to the virtual machine so far. Preallocated disks show the same value for Virtual Size and Actual Size. Sparse disks may show different values, depending on how much disk space has been allocated.
				

					The possible combinations of storage types and formats are described in the following table.
				
Table 2.35. Permitted Storage Combinations
	Storage	Format	Type	Note
	 
									NFS
								

								 	 
									Raw
								

								 	 
									Preallocated
								

								 	 
									A file with an initial size that equals the amount of storage defined for the virtual disk, and has no formatting.
								

								 
	 
									NFS
								

								 	 
									Raw
								

								 	 
									Sparse
								

								 	 
									A file with an initial size that is close to zero, and has no formatting.
								

								 
	 
									NFS
								

								 	 
									QCOW2
								

								 	 
									Sparse
								

								 	 
									A file with an initial size that is close to zero, and has QCOW2 formatting. Subsequent layers will be QCOW2 formatted.
								

								 
	 
									SAN
								

								 	 
									Raw
								

								 	 
									Preallocated
								

								 	 
									A block device with an initial size that equals the amount of storage defined for the virtual disk, and has no formatting.
								

								 
	 
									SAN
								

								 	 
									QCOW2
								

								 	 
									Sparse
								

								 	 
									A block device with an initial size that is much smaller than the size defined for the virtual disk (currently 1 GB), and has QCOW2 formatting for which space is allocated as needed (currently in 1 GB increments).
								

								 




Settings to Wipe Virtual Disks After Deletion




					The wipe_after_delete flag, viewed in the Administration Portal as the Wipe After Delete check box will replace used data with zeros when a virtual disk is deleted. If it is set to false, which is the default, deleting the disk will open up those blocks for reuse but will not wipe the data. It is, therefore, possible for this data to be recovered because the blocks have not been returned to zero.
				

					The wipe_after_delete flag only works on block storage. On file storage, for example NFS, the option does nothing because the file system will ensure that no data exists.
				

					Enabling wipe_after_delete for virtual disks is more secure, and is recommended if the virtual disk has contained any sensitive data. This is a more intensive operation and users may experience degradation in performance and prolonged delete times.
				
Note

						The wipe after delete functionality is not the same as secure delete, and cannot guarantee that the data is removed from the storage, just that new disks created on same storage will not expose data from old disks.
					


					The wipe_after_delete flag default can be changed to true during the setup process (see Configuring the Red Hat Virtualization Manager), or by using the engine-config tool on the Red Hat Virtualization Manager. Restart the ovirt-engine service for the setting change to take effect.
				
Note

						Changing the wipe_after_delete flag’s default setting will not affect the Wipe After Delete property of disks that already exist.
					


					Setting SANWipeAfterDelete to Default to True Using the Engine Configuration Tool
				
	
							Run the engine-config tool with the --set action:
						
# engine-config --set SANWipeAfterDelete=true

	
							Restart the ovirt-engine service for the change to take effect:
						
# systemctl restart ovirt-engine.service




					The /var/log/vdsm/vdsm.log file located on the host can be checked to confirm that a virtual disk was successfully wiped and deleted.
				

					For a successful wipe, the log file will contain the entry, storage_domain_id/volume_id was zeroed and will be deleted. For example:
				
a9cb0625-d5dc-49ab-8ad1-72722e82b0bf/a49351a7-15d8-4932-8d67-512a369f9d61 was zeroed and will be deleted

					For a successful deletion, the log file will contain the entry, finished with VG:storage_domain_id LVs: list_of_volume_ids, img: image_id. For example:
				
finished with VG:a9cb0625-d5dc-49ab-8ad1-72722e82b0bf LVs: {'a49351a7-15d8-4932-8d67-512a369f9d61': ImgsPar(imgs=['11f8b3be-fa96-4f6a-bb83-14c9b12b6e0d'], parent='00000000-0000-0000-0000-000000000000')}, img: 11f8b3be-fa96-4f6a-bb83-14c9b12b6e0d

					An unsuccessful wipe will display a log message zeroing storage_domain_id/volume_id failed. Zero and remove this volume manually, and an unsuccessful delete will display Remove failed for some of VG: storage_domain_id zeroed volumes: list_of_volume_ids.
				

Shareable Disks in Red Hat Virtualization




					Some applications require storage to be shared between servers. Red Hat Virtualization allows you to mark virtual machine hard disks as Shareable and attach those disks to virtual machines. That way a single virtual disk can be used by multiple cluster-aware guests.
				

					Shared disks are not to be used in every situation. For applications like clustered database servers, and other highly available services, shared disks are appropriate. Attaching a shared disk to multiple guests that are not cluster-aware is likely to cause data corruption because their reads and writes to the disk are not coordinated.
				

					You cannot take a snapshot of a shared disk. Virtual disks that have snapshots taken of them cannot later be marked shareable.
				

					You can mark a disk shareable either when you create it, or by editing the disk later.
				
Important

						Only RAW format disks can be made shareable.
					


Read Only Disks in Red Hat Virtualization




					Some applications require administrators to share data with read-only rights. You can do this when creating or editing a disk attached to a virtual machine via the Disks tab in the details view of the virtual machine and selecting the Read Only check box. That way, a single disk can be read by multiple cluster-aware guests, while an administrator maintains writing privileges.
				

					You cannot change the read-only status of a disk while the virtual machine is running.
				
Important

						Mounting a journaled file system requires read-write access. Using the Read Only option is not appropriate for virtual disks that contain such file systems (e.g. EXT3, EXT4, or XFS).
					


Virtual Disk Tasks



Creating a Virtual Disk




						Image disk creation is managed entirely by the Manager. Direct LUN disks require externally prepared targets that already exist.
					

						You can create a virtual disk that is attached to a specific virtual machine. Additional options are available when creating an attached virtual disk, as specified in Explanation of Settings in the New Virtual Disk Window.
					

						Creating a Virtual Disk Attached to a Virtual Machine
					
	
								Click Compute → Virtual Machines.
							
	
								Click the virtual machine’s name. This opens the details view.
							
	
								Click the Disks tab.
							
	
								Click New.
							
	
								Click the appropriate button to specify whether the virtual disk will be an Image or Direct LUN disk.
							
	
								Select the options required for your virtual disk. The options change based on the disk type selected. See Explanation of Settings in the New Virtual Disk Window for more details on each option for each disk type.
							
	
								Click OK.
							



						You can also create a floating virtual disk that does not belong to any virtual machines. You can attach this disk to a single virtual machine, or to multiple virtual machines if the disk is shareable. Some options are not available when creating a virtual disk, as specified in Explanation of Settings in the New Virtual Disk Window.
					

						Creating a Floating Virtual Disk
					
	
								Click Storage → Disks.
							
	
								Click New.
							
	
								Click the appropriate button to specify whether the virtual disk will be an Image or Direct LUN disk.
							
	
								Select the options required for your virtual disk. The options change based on the disk type selected. See Explanation of Settings in the New Virtual Disk Window for more details on each option for each disk type.
							
	
								Click OK.
							



Explanation of settings in the New Virtual Disk window




						Because the New Virtual Disk windows for creating floating and attached virtual disks are very similar, their settings are described in a single section.
					
Table 2.36. New Virtual Disk and Edit Virtual Disk settings: Image
	Field Name	Description
	 
										Size(GB)
									

									 	 
										The size of the new virtual disk in GB.
									

									 
	 
										Alias
									

									 	 
										The name of the virtual disk, limited to 40 characters.
									

									 
	 
										Description
									

									 	 
										A description of the virtual disk. This field is recommended but not mandatory.
									

									 
	 
										Interface
									

									 	 
										This field only appears when creating an attached disk.
									

									 
										The virtual interface the disk presents to virtual machines. VirtIO is faster, but requires drivers. Red Hat Enterprise Linux 5 and later include these drivers. Windows does not include these drivers, but you can install them from the virtio-win ISO image. IDE and SATA devices do not require special drivers.
									

									 
										The interface type can be updated after stopping all virtual machines that the disk is attached to.
									

									 
	 
										Data Center
									

									 	 
										This field only appears when creating a floating disk.
									

									 
										The data center in which the virtual disk will be available.
									

									 
	 
										Storage Domain
									

									 	 
										The storage domain in which the virtual disk will be stored. The drop-down list shows all storage domains available in the given data center, and also shows the total space and currently available space in the storage domain.
									

									 
	 
										Allocation Policy
									

									 	 
										The provisioning policy for the new virtual disk.
									

									 	
												Preallocated allocates the entire size of the disk on the storage domain at the time the virtual disk is created. The virtual size and the actual size of a preallocated disk are the same. Preallocated virtual disks take more time to create than thin provisioned virtual disks, but have better read and write performance. Preallocated virtual disks are recommended for servers and other I/O intensive virtual machines. If a virtual machine is able to write more than 1 GB every four seconds, use preallocated disks where possible.
											
	
												Thin Provision allocates 1 GB at the time the virtual disk is created and sets a maximum limit on the size to which the disk can grow. The virtual size of the disk is the maximum limit; the actual size of the disk is the space that has been allocated so far. Thin provisioned disks are faster to create than preallocated disks and allow for storage over-commitment. Thin provisioned virtual disks are recommended for desktops.
											



									 
	 
										Disk Profile
									

									 	 
										The disk profile assigned to the virtual disk. Disk profiles define the maximum amount of throughput and the maximum level of input and output operations for a virtual disk in a storage domain. Disk profiles are defined on the storage domain level based on storage quality of service entries created for data centers.
									

									 
	 
										Activate Disk(s)
									

									 	 
										This field only appears when creating an attached disk.
									

									 
										Activate the virtual disk immediately after creation.
									

									 
	 
										Wipe After Delete
									

									 	 
										Allows you to enable enhanced security for deletion of sensitive material when the virtual disk is deleted.
									

									 
	 
										Bootable
									

									 	 
										This field only appears when creating an attached disk.
									

									 
										Allows you to enable the bootable flag on the virtual disk.
									

									 
	 
										Shareable
									

									 	 
										Allows you to attach the virtual disk to more than one virtual machine at a time.
									

									 
	 
										Read-Only
									

									 	 
										This field only appears when creating an attached disk.
									

									 
										Allows you to set the disk as read-only. The same disk can be attached as read-only to one virtual machine, and as rewritable to another.
									

									 
	 
										Enable Incremental Backup
									

									 	 
										Enables incremental backup on the virtual disk. Incremental backup requires disks to be formatted in QCOW2 format instead of RAW format. See Incremental backup and restore.
									

									 
	 
										Enable Discard
									

									 	 
										This field only appears when creating an attached disk.
									

									 
										Allows you to shrink a thin provisioned disk while the virtual machine is up. For block storage, the underlying storage device must support discard calls, and the option cannot be used with Wipe After Delete unless the underlying storage supports the discard_zeroes_data property. For file storage, the underlying file system and the block device must support discard calls. If all requirements are met, SCSI UNMAP commands issued from guest virtual machines is passed on by QEMU to the underlying storage to free up the unused space.
									

									 




						The Direct LUN settings can be displayed in either Targets > LUNs or LUNs > Targets. Targets > LUNs sorts available LUNs according to the host on which they are discovered, whereas LUNs > Targets displays a single list of LUNs.
					

						Fill in the fields in the Discover Targets section and click Discover to discover the target server. You can then click the Login All button to list the available LUNs on the target server and, using the radio buttons next to each LUN, select the LUN to add.
					

						Using LUNs directly as virtual machine hard disk images removes a layer of abstraction between your virtual machines and their data.
					

						The following considerations must be made when using a direct LUN as a virtual machine hard disk image:
					
	
								Live storage migration of direct LUN hard disk images is not supported.
							
	
								Direct LUN disks are not included in virtual machine exports.
							
	
								Direct LUN disks are not included in virtual machine snapshots.
							


Table 2.37. New Virtual Disk and Edit Virtual Disk settings: Direct LUN
	Field Name	Description
	 
										Alias
									

									 	 
										The name of the virtual disk, limited to 40 characters.
									

									 
	 
										Description
									

									 	 
										A description of the virtual disk. This field is recommended but not mandatory. By default the last 4 characters of the LUN ID is inserted into the field.
									

									 
										The default behavior can be configured by setting the PopulateDirectLUNDiskDescriptionWithLUNId configuration key to the appropriate value using the engine-config command. The configuration key can be set to -1 for the full LUN ID to be used, or 0 for this feature to be ignored. A positive integer populates the description with the corresponding number of characters of the LUN ID.
									

									 
	 
										Interface
									

									 	 
										This field only appears when creating an attached disk.
									

									 
										The virtual interface the disk presents to virtual machines. VirtIO is faster, but requires drivers. Red Hat Enterprise Linux 5 and later include these drivers. Windows does not include these drivers, but they can be installed from the virtio-win ISO . IDE and SATA devices do not require special drivers.
									

									 
										The interface type can be updated after stopping all virtual machines that the disk is attached to.
									

									 
	 
										Data Center
									

									 	 
										This field only appears when creating a floating disk.
									

									 
										The data center in which the virtual disk will be available.
									

									 
	 
										Host
									

									 	 
										The host on which the LUN will be mounted. You can select any host in the data center.
									

									 
	 
										Storage Type
									

									 	 
										The type of external LUN to add. You can select from either iSCSI or Fibre Channel.
									

									 
	 
										Discover Targets
									

									 	 
										This section can be expanded when you are using iSCSI external LUNs and Targets > LUNs is selected.
									

									 
										Address - The host name or IP address of the target server.
									

									 
										Port - The port by which to attempt a connection to the target server. The default port is 3260.
									

									 
										User Authentication - The iSCSI server requires User Authentication. The User Authentication field is visible when you are using iSCSI external LUNs.
									

									 
										CHAP user name - The user name of a user with permission to log in to LUNs. This field is accessible when the User Authentication check box is selected.
									

									 
										CHAP password - The password of a user with permission to log in to LUNs. This field is accessible when the User Authentication check box is selected.
									

									 
	 
										Activate Disk(s)
									

									 	 
										This field only appears when creating an attached disk.
									

									 
										Activate the virtual disk immediately after creation.
									

									 
	 
										Bootable
									

									 	 
										This field only appears when creating an attached disk.
									

									 
										Allows you to enable the bootable flag on the virtual disk.
									

									 
	 
										Shareable
									

									 	 
										Allows you to attach the virtual disk to more than one virtual machine at a time.
									

									 
	 
										Read-Only
									

									 	 
										This field only appears when creating an attached disk.
									

									 
										Allows you to set the disk as read-only. The same disk can be attached as read-only to one virtual machine, and as rewritable to another.
									

									 
	 
										Enable Discard
									

									 	 
										This field only appears when creating an attached disk.
									

									 
										Allows you to shrink a thin provisioned disk while the virtual machine is up. With this option enabled, SCSI UNMAP commands issued from guest virtual machines is passed on by QEMU to the underlying storage to free up the unused space.
									

									 
	 
										Enable SCSI Pass-Through
									

									 	 
										This field only appears when creating an attached disk.
									

									 
										Available when the Interface is set to VirtIO-SCSI. Selecting this check box enables passthrough of a physical SCSI device to the virtual disk. A VirtIO-SCSI interface with SCSI passthrough enabled automatically includes SCSI discard support. Read-Only is not supported when this check box is selected.
									

									 
										When this check box is not selected, the virtual disk uses an emulated SCSI device. Read-Only is supported on emulated VirtIO-SCSI disks.
									

									 
	 
										Allow Privileged SCSI I/O
									

									 	 
										This field only appears when creating an attached disk.
									

									 
										Available when the Enable SCSI Pass-Through check box is selected. Selecting this check box enables unfiltered SCSI Generic I/O (SG_IO) access, allowing privileged SG_IO commands on the disk. This is required for persistent reservations.
									

									 
	 
										Using SCSI Reservation
									

									 	 
										This field only appears when creating an attached disk.
									

									 
										Available when the Enable SCSI Pass-Through and Allow Privileged SCSI I/O check boxes are selected. Selecting this check box disables migration for any virtual machine using this disk, to prevent virtual machines that are using SCSI reservation from losing access to the disk.
									

									 



Important

							Mounting a journaled file system requires read-write access. Using the Read-Only option is not appropriate for virtual disks that contain such file systems (e.g. EXT3, EXT4, or XFS).
						


Overview of Live Storage Migration




						Virtual disks can be migrated from one storage domain to another while the virtual machine to which they are attached is running. This is referred to as live storage migration. When a disk attached to a running virtual machine is migrated, a snapshot of that disk’s image chain is created in the source storage domain, and the entire image chain is replicated in the destination storage domain. As such, ensure that you have sufficient storage space in both the source storage domain and the destination storage domain to host both the disk image chain and the snapshot. A new snapshot is created on each live storage migration attempt, even when the migration fails.
					

						Consider the following when using live storage migration:
					
	
								You can live migrate multiple disks at one time.
							
	
								Multiple disks for the same virtual machine can reside across more than one storage domain, but the image chain for each disk must reside on a single storage domain.
							
	
								You can live migrate disks between any two storage domains in the same data center.
							
	
								You cannot live migrate direct LUN hard disk images or disks marked as shareable.
							



Moving a Virtual Disk




						Move a virtual disk that is attached to a virtual machine or acts as a floating virtual disk from one storage domain to another. You can move a virtual disk that is attached to a running virtual machine; this is referred to as live storage migration. Alternatively, shut down the virtual machine before continuing.
					

						Consider the following when moving a disk:
					
	
								You can move multiple disks at the same time.
							
	
								You can move disks between any two storage domains in the same data center.
							
	
								If the virtual disk is attached to a virtual machine that was created based on a template and used the thin provisioning storage allocation option, you must copy the disks for the template on which the virtual machine was based to the same storage domain as the virtual disk.
							


Procedure
	
								Click Storage → Disks and select one or more virtual disks to move.
							
	
								Click Move.
							
	
								From the Target list, select the storage domain to which the virtual disk(s) will be moved.
							
	
								From the Disk Profile list, select a profile for the disk(s), if applicable.
							
	
								Click OK.
							



						The virtual disks are moved to the target storage domain. During the move procedure, the Status column displays Locked and a progress bar indicating the progress of the move operation.
					

Changing the Disk Interface Type




						Users can change a disk’s interface type after the disk has been created. This enables you to attach an existing disk to a virtual machine that requires a different interface type. For example, a disk using the VirtIO interface can be attached to a virtual machine requiring the VirtIO-SCSI or IDE interface. This provides flexibility to migrate disks for the purpose of backup and restore, or disaster recovery. The disk interface for shareable disks can also be updated per virtual machine. This means that each virtual machine that uses the shared disk can use a different interface type.
					

						To update a disk interface type, all virtual machines using the disk must first be stopped.
					
Changing a Disk Interface Type*
	
								Click Compute → Virtual Machines and stop the appropriate virtual machine(s).
							
	
								Click the virtual machine’s name. This opens the details view.
							
	
								Click the Disks tab and select the disk.
							
	
								Click Edit.
							
	
								From the Interface list, select the new interface type and click OK.
							



						You can attach a disk to a different virtual machine that requires a different interface type.
					
Attaching a Disk to a Different Virtual Machine using a Different Interface Type
	
								Click Compute → Virtual Machines and stop the appropriate virtual machine(s).
							
	
								Click the virtual machine’s name. This opens the details view.
							
	
								Click the Disks tab and select the disk.
							
	
								Click Remove, then click OK.
							
	
								Go back to Virtual Machines and click the name of the new virtual machine that the disk will be attached to.
							
	
								Click the Disks tab, then click Attach.
							
	
								Select the disk in the Attach Virtual Disks window and select the appropriate interface from the Interface drop-down.
							
	
								Click OK.
							



Copying a Virtual Disk




						You can copy a virtual disk from one storage domain to another. The copied disk can be attached to virtual machines.
					
Procedure
	
								Click Storage → Disks and select the virtual disk(s).
							
	
								Click Copy .
							
	
								Optionally, enter a new name in the Alias field.
							
	
								From the Target list, select the storage domain to which the virtual disk(s) will be copied.
							
	
								From the Disk Profile list, select a profile for the disk(s), if applicable.
							
	
								Click OK.
							



						The virtual disks have a status of Locked while being copied.
					

Improving disk performance




						In the Administration Portal, on the virtual machine’s Resource Allocation tab, the default I/O Threads Enabled setting is checked (enabled), and the number of threads is 1.
					

						Suppose a virtual machine has multiple disks that have VirtIO controllers, and its workloads make significant use of those controllers. In that case, you can improve performance by increasing the number of I/O threads.
					

						However, also consider that increasing the number of I/O threads decreases the virtual machine’s pool of threads. If your workloads do not use the VirtIO controllers and the threads you allocate to them, increasing the number of I/O threads might decrease overall performance.
					

						To find the optimal number of threads, benchmark the performance of your virtual machine running workloads before and after you adjust the number of threads.
					
Procedure
	
								On Compute → Virtual Machines, Power Off the virtual machine.
							
	
								Click the name of the virtual machine.
							
	
								In the details pane, click the Vm Devices tab.
							
	
								Count the number of controllers whose Type is virtio or virtio-scsi.
							
	
								Click Edit.
							
	
								In the Edit Virtual Machine window, click the Resource Allocation tab.
							
	
								Confirm that I/O Threads Enabled is checked (enabled).
							
	
								To the right of I/O Threads Enabled, increase the number of threads, but do not exceed number of controllers whose type is virtio or virtio-scsi.
							
	
								Click OK.
							
	
								In the details pane, click the Disks tab.
							
	
								For each disk, use More Actions ( 
								[image: moreactions]
								 ) to Deactivate and Activate the disk. This action remaps the disks to the controllers.
							
	
								Click Run to start the virtual machine.
							


Verification steps
	
								To see which controllers have an I/O thread, click Vm Devices in the details pane and look for ioThreadid= in the Spec Params column.
							
	
								To see the mapping of disks to controllers, log into the host machine and enter the following command:
							
# virsh -r dumpxml virtual_machine_name



Additional resources
	
								Configuring High-Performance Virtual Machines, Templates, and Pools
							
	
								Virtual Machine Resource Allocation Settings Explained
							



Uploading Images to a Data Storage Domain




						You can upload virtual disk images and ISO images to your data storage domain in the Administration Portal or with the REST API. See Uploading Images to a Data Storage Domain for details.
					

Importing a Disk Image from an Imported Storage Domain




						Import floating virtual disks from an imported storage domain.
					
Note

							Only QEMU-compatible disks can be imported into the Manager.
						

Procedure
	
								Click Storage → Domains.
							
	
								Click the name of an imported storage domain. This opens the details view.
							
	
								Click the Disk Import tab.
							
	
								Select one or more disks and click Import.
							
	
								Select the appropriate Disk Profile for each disk.
							
	
								Click OK.
							



Importing an Unregistered Disk Image from an Imported Storage Domain




						Import floating virtual disks from a storage domain. Floating disks created outside of a Red Hat Virtualization environment are not registered with the Manager. Scan the storage domain to identify unregistered floating disks to be imported.
					
Note

							Only QEMU-compatible disks can be imported into the Manager.
						

Procedure
	
								Click Storage → Domains.
							
	
								Click the storage domain’s name. This opens the details view.
							
	
								Click More Actions ( 
								[image: moreactions]
								 ), then click Scan Disks so that the Manager can identify unregistered disks.
							
	
								Click the Disk Import tab.
							
	
								Select one or more disk images and click Import.
							
	
								Select the appropriate Disk Profile for each disk.
							
	
								Click OK.
							



Importing a Virtual Disk from an OpenStack Image Service




						Virtual disks managed by an OpenStack Image Service can be imported into the Red Hat Virtualization Manager if that OpenStack Image Service has been added to the Manager as an external provider.
					
	
								Click Storage → Domains.
							
	
								Click the OpenStack Image Service domain’s name. This opens the details view.
							
	
								Click the Images tab and select an image.
							
	
								Click Import.
							
	
								Select the Data Center into which the image will be imported.
							
	
								From the Domain Name drop-down list, select the storage domain in which the image will be stored.
							
	
								Optionally, select a quota to apply to the image from the Quota drop-down list.
							
	
								Click OK.
							



						The disk can now be attached to a virtual machine.
					

Exporting a Virtual Disk to an OpenStack Image Service




						Virtual disks can be exported to an OpenStack Image Service that has been added to the Manager as an external provider.
					
Important

							Virtual disks can only be exported if they do not have multiple volumes, are not thin provisioned, and do not have any snapshots.
						

	
								Click Storage → Disks and select the disks to export.
							
	
								Click More Actions ( 
								[image: moreactions]
								 ), then click Export.
							
	
								From the Domain Name drop-down list, select the OpenStack Image Service to which the disks will be exported.
							
	
								From the Quota drop-down list, select a quota for the disks if a quota is to be applied.
							
	
								Click OK.
							



Reclaiming Virtual Disk Space




						Virtual disks that use thin provisioning do not automatically shrink after deleting files from them. For example, if the actual disk size is 100GB and you delete 50GB of files, the allocated disk size remains at 100GB, and the remaining 50GB is not returned to the host, and therefore cannot be used by other virtual machines. This unused disk space can be reclaimed by the host by performing a sparsify operation on the virtual machine’s disks. This transfers the free space from the disk image to the host. You can sparsify multiple virtual disks in parallel.
					

						Perform this operation before cloning a virtual machine, creating a template based on a virtual machine, or cleaning up a storage domain’s disk space.
					

						Limitations
					
	
								NFS storage domains must use NFS version 4.2 or higher.
							
	
								You cannot sparsify a disk that uses a direct LUN.
							
	
								You cannot sparsify a disk that uses a preallocated allocation policy. If you are creating a virtual machine from a template, you must select Thin from the Storage Allocation field, or if selecting Clone, ensure that the template is based on a virtual machine that has thin provisioning.
							
	
								You can only sparsify active snapshots.
							



						Sparsifying a Disk
					
	
								Click Compute → Virtual Machines and shut down the required virtual machine.
							
	
								Click the virtual machine’s name. This opens the details view.
							
	
								Click the Disks tab. Ensure that the disk’s status is OK.
							
	
								Click More Actions ( 
								[image: moreactions]
								 ), then click Sparsify.
							
	
								Click OK.
							



						A Started to sparsify event appears in the Events tab during the sparsify operation and the disk’s status displays as Locked. When the operation is complete, a Sparsified successfully event appears in the Events tab and the disk’s status displays as OK. The unused disk space has been returned to the host and is available for use by other virtual machines.
					



External Providers



Introduction to External Providers in Red Hat Virtualization




					In addition to resources managed by the Red Hat Virtualization Manager itself, Red Hat Virtualization can also take advantage of resources managed by external sources. The providers of these resources, known as external providers, can provide resources such as virtualization hosts, virtual machine images, and networks.
				

					Red Hat Virtualization currently supports the following external providers:
				
	Red Hat Satellite for Host Provisioning
	
								Satellite is a tool for managing all aspects of the life cycle of both physical and virtual hosts. In Red Hat Virtualization, hosts managed by Satellite can be added to and used by the Red Hat Virtualization Manager as virtualization hosts. After you add a Satellite instance to the Manager, the hosts managed by the Satellite instance can be added by searching for available hosts on that Satellite instance when adding a new host. For more information on installing Red Hat Satellite and managing hosts using Red Hat Satellite, see the Red Hat Satellite Quick Start Guide and Red Hat Satellite Managing Hosts.
							


	KubeVirt/Openshift Virtualization
	
								Openshift Virtualization (formerly container-native virtualization or "CNV") enables you to bring virtual machines (VMs) into containerized workflows so you can develop, manage, and deploy virtual machines side-by-side with containers and serverless. In RHV Manager, adding this provider is one of the requirements for using Openshift Virtualization. For details, see Adding KubeVirt/Openshift Virtualization as an external provider.
							
	OpenStack Image Service (Glance) for Image Management
	
								OpenStack Image Service provides a catalog of virtual machine images. In Red Hat Virtualization, these images can be imported into the Red Hat Virtualization Manager and used as floating disks or attached to virtual machines and converted into templates. After you add an OpenStack Image Service to the Manager, it appears as a storage domain that is not attached to any data center. Virtual disks in a Red Hat Virtualization environment can also be exported to an OpenStack Image Service as virtual disks.
							


Note

						Support for OpenStack Glance is now deprecated. This functionality will be removed in a later release.
					

	VMware for Virtual Machine Provisioning
	
								Virtual machines created in VMware can be converted using V2V (virt-v2v) and imported into a Red Hat Virtualization environment. After you add a VMware provider to the Manager, you can import the virtual machines it provides. V2V conversion is performed on a designated proxy host as part of the import operation.
							
	RHEL 5 Xen for Virtual Machine Provisioning
	
								Virtual machines created in RHEL 5 Xen can be converted using V2V (virt-v2v) and imported into a Red Hat Virtualization environment. After you add a RHEL 5 Xen host to the Manager, you can import the virtual machines it provides. V2V conversion is performed on a designated proxy host as part of the import operation.
							
	KVM for Virtual Machine Provisioning
	
								Virtual machines created in KVM can be imported into a Red Hat Virtualization environment. After you add a KVM host to the Manager, you can import the virtual machines it provides.
							
	Open Virtual Network (OVN) for Network Provisioning
	
								Open Virtual Network (OVN) is an Open vSwitch (OVS) extension that provides software-defined networks. After you add OVN to the Manager, you can import existing OVN networks, and create new OVN networks from the Manager. You can also automatically install OVN on the Manager using engine-setup.
							



Adding External Providers



Adding a Red Hat Satellite Instance for Host Provisioning




						Add a Satellite instance for host provisioning to the Red Hat Virtualization Manager. Red Hat Virtualization 4.2 is supported with Red Hat Satellite 6.1.
					
Procedure
	
								Click Administration → Providers.
							
	
								Click Add.
							
	
								Enter a Name and Description.
							
	
								Select Foreman/Satellite from the Type drop-down list.
							
	
								Enter the URL or fully qualified domain name of the machine on which the Satellite instance is installed in the Provider URL text field. You do not need to specify a port number.
							
Important

									IP addresses cannot be used to add a Satellite instance.
								


	
								Select the Requires Authentication check box.
							
	
								Enter the Username and Password for the Satellite instance. You must use the same user name and password as you would use to log in to the Satellite provisioning portal.
							
	
								Test the credentials:
							
	
										Click Test to test whether you can authenticate successfully with the Satellite instance using the provided credentials.
									
	
										If the Satellite instance uses SSL, the Import provider certificates window opens; click OK to import the certificate that the Satellite instance provides to ensure the Manager can communicate with the instance.
									



	
								Click OK.
							



Adding an OpenStack Image (Glance) Instance for Image Management



Note

							Support for OpenStack Glance is now deprecated. This functionality will be removed in a later release.
						


						Add an OpenStack Image (Glance) instance for image management to the Red Hat Virtualization Manager.
					
Procedure
	
								Click Administration → Providers.
							
	
								Click Add and enter the details in the General Settings tab. For more information on these fields, see Add Provider General Settings Explained.
							
	
								Enter a Name and Description.
							
	
								Select OpenStack Image from the Type drop-down list.
							
	
								Enter the URL or fully qualified domain name of the machine on which the OpenStack Image instance is installed in the Provider URL text field.
							
	
								Optionally, select the Requires Authentication check box and enter the Username and Password for the OpenStack Image instance user registered in Keystone. You must also define the authentication URL of the Keystone server by defining the Protocol (must be HTTP), Hostname, and API Port.
							

								Enter the Tenant for the OpenStack Image instance.
							

	
								Test the credentials:
							
	
										Click Test to test whether you can authenticate successfully with the OpenStack Image instance using the provided credentials.
									
	
										If the OpenStack Image instance uses SSL, the Import provider certificates window opens. Click OK to import the certificate that the OpenStack Image instance provides to ensure the Manager can communicate with the instance.
									



	
								Click OK.
							



Adding KubeVirt/Openshift Virtualization as an external provider




						To run virtual machines in a container on the OpenShift Container Platform, you add OpenShift as an external provider in Red Hat Virtualization.
					
Note

							This capability is known as OpenShift Virtualization.
						

Prerequisites
	
								In OpenShift Container Platform, your cluster is configured for OpenShift Virtualization.
							


Procedure
	
								In the RHV Administration Portal, go to Administration → Providers and click New.
							
	
								In Add Provider, set Type to KubeVirt/Openshift Virtualization.
							
	
								Enter the Provider URL and Token, which are required.
							
	
								Optional: Enter values for Advanced parameters such as Certificate Authority, Prometheus URL, and Prometheus Certificate Authority.
							
	
								Click Test to verify the connection to the new provider.
							
	
								Click OK to finish adding this new provider.
							


Verification steps
	
								In the RHV Administration Portal, click Compute → Clusters.
							
	
								Click the name of new cluster you just created. This cluster name, kubevirt for example, is based on the name of the provider. This action opens the cluster details view.
							
	
								Click the Hosts tab to verify that the status of the OpenShift Container Platform worker nodes is up.
							
Note

									The status of the control plane nodes is down, even if they are running, because they cannot host virtual machines.
								


	
								Use Compute → Virtual Machines to deploy a virtual machine to the new cluster.
							
	
								In the OpenShift Container Platform web console, in the Administrator perspective, use Workloads → Virtual Machines to view the virtual machine you deployed.
							


Additional resources
	
								About OpenShift Virtualization
							
	
								Add Provider General Settings Explained
							



Adding a VMware Instance as a Virtual Machine Provider




						Add a VMware vCenter instance to import virtual machines from VMware to the Red Hat Virtualization Manager.
					

						Red Hat Virtualization uses V2V to convert VMware virtual machines to the correct format before they are imported. The virt-v2v package must be installed on at least one host. The virt-v2v package is available by default on Red Hat Virtualization Hosts (RHVH) and is installed on Red Hat Enterprise Linux hosts as a dependency of VDSM when added to the Red Hat Virtualization environment. Red Hat Enterprise Linux hosts must be Red Hat Enterprise Linux 7.2 or later.
					
Note

							The virt-v2v package is not available on ppc64le architecture; these hosts cannot be used as proxy hosts.
						

Procedure
	
								Click Administration → Providers.
							
	
								Click Add.
							
	
								Enter a Name and Description.
							
	
								Select VMware from the Type drop-down list.
							
	
								Select the Data Center into which VMware virtual machines will be imported, or select Any Data Center to instead specify the destination data center during individual import operations.
							
	
								Enter the IP address or fully qualified domain name of the VMware vCenter instance in the vCenter field.
							
	
								Enter the IP address or fully qualified domain name of the host from which the virtual machines will be imported in the ESXi field.
							
	
								Enter the name of the data center in which the specified ESXi host resides in the Data Center field.
							
	
								If you have exchanged the SSL certificate between the ESXi host and the Manager, leave the Verify server’s SSL certificate check box selected to verify the ESXi host’s certificate. If not, clear the check box.
							
	
								Select a host in the chosen data center with virt-v2v installed to serve as the Proxy Host during virtual machine import operations. This host must also be able to connect to the network of the VMware vCenter external provider. If you selected Any Data Center above, you cannot choose the host here, but instead can specify a host during individual import operations.
							
	
								Enter the Username and Password for the VMware vCenter instance. The user must have access to the VMware data center and ESXi host on which the virtual machines reside.
							
	
								Test the credentials:
							
	
										Click Test to test whether you can authenticate successfully with the VMware vCenter instance using the provided credentials.
									
	
										If the VMware vCenter instance uses SSL, the Import provider certificates window opens; click OK to import the certificate that the VMware vCenter instance provides to ensure the Manager can communicate with the instance.
									



	
								Click OK.
							



						To import virtual machines from the VMware external provider, see Importing a Virtual Machine from a VMware Provider in the Virtual Machine Management Guide.
					

Adding a RHEL 5 Xen Host as a Virtual Machine Provider




						Add a RHEL 5 Xen host to import virtual machines from Xen to Red Hat Virtualization.
					

						Red Hat Virtualization uses V2V to convert RHEL 5 Xen virtual machines to the correct format before they are imported. The virt-v2v package must be installed on at least one host. The virt-v2v package is available by default on Red Hat Virtualization Hosts (RHVH) and is installed on Red Hat Enterprise Linux hosts as a dependency of VDSM when added to the Red Hat Virtualization environment. Red Hat Enterprise Linux hosts must be Red Hat Enterprise Linux 7.2 or later.
					
Note

							The virt-v2v package is not available on ppc64le architecture; these hosts cannot be used as proxy hosts.
						

Procedure
	
								Enable public key authentication between the proxy host and the RHEL 5 Xen host:
							
	
										Log in to the proxy host and generate SSH keys for the vdsm user.
									
# sudo -u vdsm ssh-keygen

	
										Copy the vdsm user’s public key to the RHEL 5 Xen host. The proxy host’s known_hosts file will also be updated to include the host key of the RHEL 5 Xen host.
									
# sudo -u vdsm ssh-copy-id root@xenhost.example.com

	
										Log in to the RHEL 5 Xen host to verify that the login works correctly.
									
# sudo -u vdsm ssh root@xenhost.example.com




	
								Click Administration → Providers.
							
	
								Click Add.
							
	
								Enter a Name and Description.
							
	
								Select XEN from the Type drop-down list.
							
	
								Select the Data Center into which Xen virtual machines will be imported, or select Any Data Center to specify the destination data center during individual import operations.
							
	
								Enter the URI of the RHEL 5 Xen host in the URI field.
							
	
								Select a host in the chosen data center with virt-v2v installed to serve as the Proxy Host during virtual machine import operations. This host must also be able to connect to the network of the RHEL 5 Xen external provider. If you selected Any Data Center above, you cannot choose the host here, but instead can specify a host during individual import operations.
							
	
								Click Test to test whether you can authenticate successfully with the RHEL 5 Xen host.
							
	
								Click OK.
							



						To import virtual machines from a RHEL 5 Xen external provider, see Importing a Virtual Machine from a RHEL 5 Xen Host in the Virtual Machine Management Guide.
					

Adding a KVM Host as a Virtual Machine Provider




						Add a KVM host to import virtual machines from KVM to Red Hat Virtualization Manager.
					
Procedure
	
								Enable public key authentication between the proxy host and the KVM host:
							
	
										Log in to the proxy host and generate SSH keys for the vdsm user.
									
# sudo -u vdsm ssh-keygen

	
										Copy the vdsm user’s public key to the KVM host. The proxy host’s known_hosts file will also be updated to include the host key of the KVM host.
									
# sudo -u vdsm ssh-copy-id root@kvmhost.example.com

	
										Log in to the KVM host to verify that the login works correctly.
									
# sudo -u vdsm ssh root@kvmhost.example.com




	
								Click Administration → Providers.
							
	
								Click Add.
							
	
								Enter a Name and Description.
							
	
								Select KVM from the Type drop-down list.
							
	
								Select the Data Center into which KVM virtual machines will be imported, or select Any Data Center to specify the destination data center during individual import operations.
							
	
								Enter the URI of the KVM host in the URI field.
							
qemu+ssh://root@host.example.com/system

	
								Select a host in the chosen data center to serve as the Proxy Host during virtual machine import operations. This host must also be able to connect to the network of the KVM external provider. If you selected Any Data Center in the Data Center field above, you cannot choose the host here. The field is greyed out and shows Any Host in Data Center. Instead you can specify a host during individual import operations.
							
	
								Optionally, select the Requires Authentication check box and enter the Username and Password for the KVM host. The user must have access to the KVM host on which the virtual machines reside.
							
	
								Click Test to test whether you can authenticate successfully with the KVM host using the provided credentials.
							
	
								Click OK.
							



						To import virtual machines from a KVM external provider, see Importing a Virtual Machine from a KVM Host in the Virtual Machine Management Guide.
					

Adding Open Virtual Network (OVN) as an External Network Provider




						You can use Open Virtual Network (OVN) to create overlay virtual networks that enable communication among the virtual machines without adding VLANs or changing the infrastructure. OVN is an extension of Open vSwitch (OVS) that provides native support for virtual L2 and L3 overlays.
					

						You can also connect an OVN network to a native Red Hat Virtualization network. See Connecting an OVN Network to a Physical Network for more information. This feature is available as a Technology Preview only.
					

						The ovirt-provider-ovn exposes an OpenStack Networking REST API. You can use this API to create networks, subnets, ports, and routers. For details, see OpenStack Networking API v2.0.
					

						For more details, see the Open vSwitch Documentation and Open vSwitch Manpages.
					
Installing a New OVN Network Provider




							Installing OVN using engine-setup performs the following steps:
						
	
									Sets up an OVN central server on the Manager machine.
								
	
									Adds OVN to Red Hat Virtualization as an external network provider.
								
	
									On the Default cluster only, sets the Default Network Provider to ovirt-provider-ovn.
								


Important
	
										Installing OVN changes the Default Network Provider setting on the Default cluster only, not on other clusters.
									
	
										Changing the Default Network Provider setting does not update hosts in that cluster to use the Default Network Provider.
									
	
										For hosts and virtual machines to use OVN, perform the addition tasks described in the "Next steps" at the end of this topic.
									



Procedure
	
									Optional: If you use a preconfigured answer file with engine-setup, add the following entry to install OVN:
								
OVESETUP_OVN/ovirtProviderOvn=bool:True

	
									Run engine-setup on the Manager machine.
								
	
									If you do not use a preconfigured answer file, answer Yes when the engine-setup asks:
								
Configuring ovirt-provider-ovn also sets the Default cluster's default network provider to ovirt-provider-ovn.
Non-Default clusters may be configured with an OVN after installation.
Configure ovirt-provider-ovn (Yes, No) [Yes]:

	
									Answer the following question:
								
Use default credentials (admin@internal) for ovirt-provider-ovn (Yes, No) [Yes]?:

									If Yes, engine-setup uses the default engine user and password specified earlier in the setup process. This option is only available during new installations.
								
oVirt OVN provider user[admin]:
oVirt OVN provider password[empty]:

									You can use the default values or specify the oVirt OVN provider user and password.
								



Note

								To change the authentication method later, you can edit the /etc/ovirt-provider-ovn/conf.d/10_engine_setup.conf file, or create a new /etc/ovirt-provider-ovn/conf.d/20_engine_setup.conf file. Restart the ovirt-provider-ovn service for the change to take effect. See oVirt external network provider for OVN for more information about OVN authentication.
							


Next steps

								Before you can create virtual machines that use a newly-installed OVN network, complete these additional steps:
							
	
									Add a network to the Default cluster.
								
	
											While doing so, select the Create on external provider check box. This creates a network based on ovirt-provider-ovn.
										
	
											Optional: To connect the OVN network to a physical network, select the Connect to physical network check box and specify the Red Hat Virtualization network to use.
										
	
											Optional: Determine whether the network should use a security group and select one from the Security Groups drop-down. For more information on the available options see Logical Network General Settings Explained.
										



	
									Add hosts to or reinstall the hosts on the Default cluster so they use the cluster’s new Default Network Provider, ovirt-provider-ovn.
								
	
									Optional: Edit non-Default clusters and set Default Network Provider to ovirt-provider-ovn.
								
	
											Optional: Reinstall the hosts on each non-Default cluster so they use the cluster’s new Default Network Provider, ovirt-provider-ovn.
										





Additional resources
	
									To configure your hosts to use an existing, non-default network, see Configuring Hosts for an OVN tunnel network.
								



Updating the OVN Tunnel Network on a Single Host




							You can update the OVN tunnel network on a single host with vdsm-tool:
						
# vdsm-tool ovn-config OVN_Central_IP Tunneling_IP_or_Network_Name Host_FQDN
Note

								The Host_FQDN must match the FQDN that is specified in the engine for this host.
							

Example 2.4. Updating a Host with vdsm-tool
# vdsm-tool ovn-config 192.168.0.1 MyNetwork MyFQDN



Connecting an OVN Network to a Physical Network



Important

								This feature relies on Open vSwitch support, which is available only as a Technology Preview in Red Hat Virtualization. Technology Preview features are not supported with Red Hat production service level agreements (SLAs), might not be functionally complete, and Red Hat does not recommend using them for production. These features provide early access to upcoming product features, enabling customers to test functionality and provide feedback during the development process.
							

								For more information on Red Hat Technology Preview features support scope, see Technology Preview Features Support Scope.
							


							You can create an external provider network that overlays a native Red Hat Virtualization network so that the virtual machines on each appear to be sharing the same subnet.
						
Important

								If you created a subnet for the OVN network, a virtual machine using that network will receive an IP address from there. If you want the physical network to allocate the IP address, do not create a subnet for the OVN network.
							

Prerequisites
	
									The cluster must have OVS selected as the Switch Type. Hosts added to this cluster must not have any pre-existing Red Hat Virtualization networks configured, such as the ovirtmgmt bridge.
								
	
									The physical network must be available on the hosts. You can enforce this by setting the physical network as required for the cluster (in the Manage Networks window, or the Cluster tab of the New Logical Network window).
								


Procedure
	
									Click Compute → Clusters.
								
	
									Click the cluster’s name. This opens the details view.
								
	
									Click the Logical Networks tab and click Add Network.
								
	
									Enter a Name for the network.
								
	
									Select the Create on external provider check box. ovirt-provider-ovn is selected by default.
								
	
									Select the Connect to physical network check box if it is not already selected by default.
								
	
									Choose the physical network to connect the new network to:
								
	
											Click the Data Center Network radio button and select the physical network from the drop-down list. This is the recommended option.
										
	
											Click the Custom radio button and enter the name of the physical network. If the physical network has VLAN tagging enabled, you must also select the Enable VLAN tagging check box and enter the physical network’s VLAN tag.
										
Important

												The physical network’s name must not be longer than 15 characters, or contain special characters.
											





	
									Click OK.
								



							////Removing for BZ2006228 include::topics/Adding_an_External_Network_Provider.adoc[leveloffset=+2]
						


Add Provider General Settings Explained




						The General tab in the Add Provider window allows you to register the core details of the external provider.
					
Table 2.38. Add Provider: General Settings
	Setting	Explanation
	 
										Name
									

									 	 
										A name to represent the provider in the Manager.
									

									 
	 
										Description
									

									 	 
										A plain text, human-readable description of the provider.
									

									 
	 
										Type
									

									 	 
										The type of external provider. Changing this setting alters the available fields for configuring the provider.
									

									 
										External Network Provider
									

									 	
												Networking Plugin: Determines which implementation of the driver will be used on the host to handle NIC operations. If an external network provider with the oVirt Network Provider for OVN plugin is added as the default network provider for a cluster, this also determines which driver will be installed on hosts added to the cluster.
											
	
												Automatic Synchronization: Allows you to specify whether the provider will be automatically synchronized with existing networks.
											
	
												Provider URL: The URL or fully qualified domain name of the machine on which the external network provider is hosted. You must add the port number for the external network provider to the end of the URL or fully qualified domain name. By default, this port number is 9696.
											
	
												Read Only: Allows you to specify whether the external network provider can be modified from the Administration Portal.
											
	
												Requires Authentication: Allows you to specify whether authentication is required to access the external network provider.
											
	
												Username: A user name for connecting to the external network provider. If you are authenticating with Active Directory, the user name must be in the format of username@domain@auth_profile instead of the default username@domain.
											
	
												Password: The password against which the above user name is to be authenticated.
											
	
												Protocol: The protocol used to communicate with the Keystone server. The default is HTTPS.
											
	
												Hostname: The IP address or hostname of the Keystone server.
											
	
												API port: The API port number of the Keystone server.
											
	
												API Version: The version of the Keystone server. The value is v2.0 and the field is disabled.
											
	
												Tenant Name: Optional. The name of the tenant of which the external network provider is a member.
											



									 
										Foreman/Satellite
									

									 	
												Provider URL: The URL or fully qualified domain name of the machine that hosts the Satellite instance. You do not need to add the port number to the end of the URL or fully qualified domain name.
											
	
												Requires Authentication: Allows you to specify whether authentication is required for the provider. Authentication is mandatory when Foreman/Satellite is selected.
											
	
												Username: A user name for connecting to the Satellite instance. This user name must be the user name used to log in to the provisioning portal on the Satellite instance.
											
	
												Password: The password against which the above user name is to be authenticated. This password must be the password used to log in to the provisioning portal on the Satellite instance.
											



									 
										KubeVirt/OpenShift Virtualization
									

									 	
												Provider URL: The URL or fully qualified domain name and port number of the OpenShift Container Platform API. By default, this port number is 6443.
											
	
												Token The OAuth access token for authenticating this connection to the API.
											
	
												Certificate Authority The CA certificate to be trusted when making https requests.
											
	
												Prometheus URL The URL for the OpenShift cluster’s prometheus service. If you do not provide this URL, the software will try to automatically detect this URL.
											
	
												Prometheus Certificate Authority The X509 certificate for prometheus. If you do not specify this CA, the provider uses the KubeVirt CA instead.
											



									 
										OpenStack Image
									

									 	
												Provider URL: The URL or fully qualified domain name of the machine on which the OpenStack Image service is hosted. You must add the port number for the OpenStack Image service to the end of the URL or fully qualified domain name. By default, this port number is 9292.
											
	
												Requires Authentication: Allows you to specify whether authentication is required to access the OpenStack Image service.
											
	
												Username: A user name for connecting to the Keystone server. This user name must be the user name for the OpenStack Image service registered in the Keystone instance of which the OpenStack Image service is a member.
											
	
												Password: The password against which the above user name is to be authenticated. This password must be the password for the OpenStack Image service registered in the Keystone instance of which the OpenStack Image service is a member.
											
	
												Protocol: The protocol used to communicate with the Keystone server. This must be set to HTTP.
											
	
												Hostname: The IP address or hostname of the Keystone server.
											
	
												API port: The API port number of the Keystone server.
											
	
												API Version: The version of the Keystone service. The value is v2.0 and the field is disabled.
											
	
												Tenant Name: The name of the OpenStack tenant of which the OpenStack Image service is a member.
											



									 
										OpenStack Volume
									

									 	
												Data Center: The data center to which OpenStack Volume storage volumes will be attached.
											
	
												Provider URL: The URL or fully qualified domain name of the machine on which the OpenStack Volume instance is hosted. You must add the port number for the OpenStack Volume instance to the end of the URL or fully qualified domain name. By default, this port number is 8776.
											
	
												Requires Authentication: Allows you to specify whether authentication is required to access the OpenStack Volume service.
											
	
												Username: A user name for connecting to the Keystone server. This user name must be the user name for OpenStack Volume registered in the Keystone instance of which the OpenStack Volume instance is a member.
											
	
												Password: The password against which the above user name is to be authenticated. This password must be the password for OpenStack Volume registered in the Keystone instance of which the OpenStack Volume instance is a member.
											
	
												Protocol: The protocol used to communicate with the Keystone server. This must be set to HTTP.
											
	
												Hostname: The IP address or hostname of the Keystone server.
											
	
												API port: The API port number of the Keystone server.
											
	
												API Version: The version of the Keystone server. The value is v2.0 and the field is disabled.
											
	
												Tenant Name: The name of the OpenStack tenant of which the OpenStack Volume instance is a member.
											



									 
										VMware
									

									 	
												Data Center: Specify the data center into which VMware virtual machines will be imported, or select Any Data Center to specify the destination data center during individual import operations (using the Import function in the Virtual Machines tab).
											
	
												vCenter: The IP address or fully qualified domain name of the VMware vCenter instance.
											
	
												ESXi: The IP address or fully qualified domain name of the host from which the virtual machines will be imported.
											
	
												Data Center: The name of the data center in which the specified ESXi host resides.
											
	
												Cluster: The name of the cluster in which the specified ESXi host resides.
											
	
												Verify server’s SSL certificate: Specify whether the ESXi host’s certificate will be verified on connection.
											
	
												Proxy Host: Select a host in the chosen data center with virt-v2v installed to serve as the host during virtual machine import operations. This host must also be able to connect to the network of the VMware vCenter external provider. If you selected Any Data Center, you cannot choose the host here, but can specify a host during individual import operations (using the Import function in the Virtual Machines tab).
											
	
												Username: A user name for connecting to the VMware vCenter instance. The user must have access to the VMware data center and ESXi host on which the virtual machines reside.
											
	
												Password: The password against which the above user name is to be authenticated.
											



									 
										RHEL 5 Xen
									

									 	
												Data Center: Specify the data center into which Xen virtual machines will be imported, or select Any Data Center to instead specify the destination data center during individual import operations (using the Import function in the Virtual Machines tab).
											
	
												URI: The URI of the RHEL 5 Xen host.
											
	
												Proxy Host: Select a host in the chosen data center with virt-v2v installed to serve as the host during virtual machine import operations. This host must also be able to connect to the network of the RHEL 5 Xen external provider. If you selected Any Data Center, you cannot choose the host here, but instead can specify a host during individual import operations (using the Import function in the Virtual Machines tab).
											



									 
										KVM
									

									 	
												Data Center: Specify the data center into which KVM virtual machines will be imported, or select Any Data Center to instead specify the destination data center during individual import operations (using the Import function in the Virtual Machines tab).
											
	
												URI: The URI of the KVM host.
											
	
												Proxy Host: Select a host in the chosen data center to serve as the host during virtual machine import operations. This host must also be able to connect to the network of the KVM external provider. If you selected Any Data Center, you cannot choose the host here, but instead can specify a host during individual import operations (using the Import function in the Virtual Machines tab).
											
	
												Requires Authentication: Allows you to specify whether authentication is required to access the KVM host.
											
	
												Username: A user name for connecting to the KVM host.
											
	
												Password: The password against which the above user name is to be authenticated.
											



									 
	 
										Test
									

									 	 
										Allows users to test the specified credentials. This button is available to all provider types.
									

									 





Editing an External Provider



Procedure
	
							Click Administration → Providers and select the external provider to edit.
						
	
							Click Edit.
						
	
							Change the current values for the provider to the preferred values.
						
	
							Click OK.
						



Removing an External Provider



Procedure
	
							Click Administration → Providers and select the external provider to remove.
						
	
							Click Remove.
						
	
							Click OK.
						





Chapter 3. Administering the Environment



Administering the Self-Hosted Engine



Maintaining the Self-hosted engine



Self-hosted engine maintenance modes explained




						The maintenance modes enable you to start, stop, and modify the Manager virtual machine without interference from the high-availability agents, and to restart and modify the self-hosted engine nodes in the environment without interfering with the Manager.
					

						There are three maintenance modes:
					
	
								global - All high-availability agents in the cluster are disabled from monitoring the state of the Manager virtual machine. The global maintenance mode must be applied for any setup or upgrade operations that require the ovirt-engine service to be stopped, such as upgrading to a later version of Red Hat Virtualization.
							
	
								local - The high-availability agent on the node issuing the command is disabled from monitoring the state of the Manager virtual machine. The node is exempt from hosting the Manager virtual machine while in local maintenance mode; if hosting the Manager virtual machine when placed into this mode, the Manager will migrate to another node, provided there is one available. The local maintenance mode is recommended when applying system changes or updates to a self-hosted engine node.
							
	
								none - Disables maintenance mode, ensuring that the high-availability agents are operating.
							



Setting local maintenance mode




						Enabling local maintenance mode stops the high-availability agent on a single self-hosted engine node.
					
Setting the local maintenance mode from the Administration Portal
	
								Put a self-hosted engine node into local maintenance mode:
							
	
										In the Administration Portal, click Compute → Hosts and select a self-hosted engine node.
									
	
										Click Management → Maintenance and OK. Local maintenance mode is automatically triggered for that node.
									



	
								After you have completed any maintenance tasks, disable the maintenance mode:
							
	
										In the Administration Portal, click Compute → Hosts and select the self-hosted engine node.
									
	
										Click Management → Activate.
									





Setting the local maintenance mode from the command line
	
								Log in to a self-hosted engine node and put it into local maintenance mode:
							
# hosted-engine --set-maintenance --mode=local

	
								After you have completed any maintenance tasks, disable the maintenance mode:
							
# hosted-engine --set-maintenance --mode=none




Setting global maintenance mode




						Enabling global maintenance mode stops the high-availability agents on all self-hosted engine nodes in the cluster.
					
Setting the global maintenance mode from the Administration Portal
	
								Put all of the self-hosted engine nodes into global maintenance mode:
							
	
										In the Administration Portal, click Compute → Hosts and select any self-hosted engine node.
									
	
										Click More Actions ( 
										[image: moreactions]
										 ), then click Enable Global HA Maintenance.
									



	
								After you have completed any maintenance tasks, disable the maintenance mode:
							
	
										In the Administration Portal, click Compute → Hosts and select any self-hosted engine node.
									
	
										Click More Actions ( 
										[image: moreactions]
										 ), then click Disable Global HA Maintenance.
									





Setting the global maintenance mode from the command line
	
								Log in to any self-hosted engine node and put it into global maintenance mode:
							
# hosted-engine --set-maintenance --mode=global

	
								After you have completed any maintenance tasks, disable the maintenance mode:
							
# hosted-engine --set-maintenance --mode=none





Administering the Manager Virtual Machine




					The hosted-engine utility provides many commands to help administer the Manager virtual machine. You can run hosted-engine on any self-hosted engine node. To see all available commands, run hosted-engine --help. For additional information on a specific command, run hosted-engine --command --help.
				
Updating the Self-Hosted Engine Configuration




						To update the self-hosted engine configuration, use the hosted-engine --set-shared-config command. This command updates the self-hosted engine configuration on the shared storage domain after the initial deployment.
					

						To see the current configuration values, use the hosted-engine --get-shared-config command.
					

						To see a list of all available configuration keys and their corresponding types, enter the following command:
					
# hosted-engine --set-shared-config key --type=type --help

						Where type is one of the following:
					
	 
										he_local
									

									 	 
										Sets values in the local instance of /etc/ovirt-hosted-engine/hosted-engine.conf on the local host, so only that host uses the new values. To enable the new value, restart the ovirt-ha-agent and ovirt-ha-broker services.
									

									 
	 
										he_shared
									

									 	 
										Sets values in /etc/ovirt-hosted-engine/hosted-engine.conf on shared storage, so all hosts that are deployed after a configuration change use these values. To enable the new value on a host, redeploy that host.
									

									 
	 
										ha
									

									 	 
										Sets values in /var/lib/ovirt-hosted-engine-ha/ha.conf on local storage. New settings take effect immediately.
									

									 
	 
										broker
									

									 	 
										Sets values in /var/lib/ovirt-hosted-engine-ha/broker.conf on local storage. Restart the ovirt-ha-broker service to enable new settings.
									

									 



Configuring Email Notifications




						You can configure email notifications using SMTP for any HA state transitions on the self-hosted engine nodes. The keys that can be updated include: smtp-server, smtp-port, source-email, destination-emails, and state_transition.
					

						To configure email notifications:
					
	
								On a self-hosted engine node, set the smtp-server key to the desired SMTP server address:
							
# hosted-engine --set-shared-config smtp-server smtp.example.com --type=broker
Note

									To verify that the self-hosted engine configuration file has been updated, run:
								
# hosted-engine --get-shared-config smtp-server --type=broker
broker : smtp.example.com, type : broker


	
								Check that the default SMTP port (port 25) has been configured:
							
# hosted-engine --get-shared-config smtp-port --type=broker
broker : 25, type : broker

	
								Specify an email address you want the SMTP server to use to send out email notifications. Only one address can be specified.
							
# hosted-engine --set-shared-config source-email source@example.com --type=broker

	
								Specify the destination email address to receive email notifications. To specify multiple email addresses, separate each address by a comma.
							
# hosted-engine --set-shared-config destination-emails destination1@example.com,destination2@example.com --type=broker




						To verify that SMTP has been properly configured for your self-hosted engine environment, change the HA state on a self-hosted engine node and check if email notifications were sent. For example, you can change the HA state by placing HA agents into maintenance mode. See Maintaining the Self-Hosted Engine for more information.
					


Configuring Memory Slots Reserved for the Self-Hosted Engine on Additional Hosts




					If the Manager virtual machine shuts down or needs to be migrated, there must be enough memory on a self-hosted engine node for the Manager virtual machine to restart on or migrate to it. This memory can be reserved on multiple self-hosted engine nodes by using a scheduling policy. The scheduling policy checks if enough memory to start the Manager virtual machine will remain on the specified number of additional self-hosted engine nodes before starting or migrating any virtual machines. See Creating a Scheduling Policy in the Administration Guide for more information about scheduling policies.
				

					To add more self-hosted engine nodes to the Red Hat Virtualization Manager, see Adding self-hosted engine nodes to the Manager.
				

					Configuring Memory Slots Reserved for the Self-Hosted Engine on Additional Hosts
				
	
							Click Compute → Clusters and select the cluster containing the self-hosted engine nodes.
						
	
							Click Edit.
						
	
							Click the Scheduling Policy tab.
						
	
							Click + and select HeSparesCount.
						
	
							Enter the number of additional self-hosted engine nodes that will reserve enough free memory to start the Manager virtual machine.
						
	
							Click OK.
						



Adding Self-Hosted Engine Nodes to the Red Hat Virtualization Manager




					Add self-hosted engine nodes in the same way as a standard host, with an additional step to deploy the host as a self-hosted engine node. The shared storage domain is automatically detected and the node can be used as a failover host to host the Manager virtual machine when required. You can also attach standard hosts to a self-hosted engine environment, but they cannot host the Manager virtual machine. Have at least two self-hosted engine nodes to ensure the Manager virtual machine is highly available. You can also add additional hosts using the REST API. See Hosts in the REST API Guide.
				
Prerequisites
	
							All self-hosted engine nodes must be in the same cluster.
						
	
							If you are reusing a self-hosted engine node, remove its existing self-hosted engine configuration. See Removing a Host from a Self-Hosted Engine Environment.
						


Procedure
	
							In the Administration Portal, click Compute → Hosts.
						
	
							Click New.
						

							For information on additional host settings, see Explanation of Settings and Controls in the New Host and Edit Host Windows in the Administration Guide.
						

	
							Use the drop-down list to select the Data Center and Host Cluster for the new host.
						
	
							Enter the Name and the Address of the new host. The standard SSH port, port 22, is auto-filled in the SSH Port field.
						
	
							Select an authentication method to use for the Manager to access the host.
						
	
									Enter the root user’s password to use password authentication.
								
	
									Alternatively, copy the key displayed in the SSH PublicKey field to /root/.ssh/authorized_keys on the host to use public key authentication.
								



	
							Optionally, configure power management, where the host has a supported power management card. For information on power management configuration, see Host Power Management Settings Explained in the Administration Guide.
						
	
							Click the Hosted Engine tab.
						
	
							Select Deploy.
						
	
							Click OK.
						



Reinstalling an Existing Host as a Self-Hosted Engine Node




					You can convert an existing, standard host in a self-hosted engine environment to a self-hosted engine node capable of hosting the Manager virtual machine.
				
Warning

						When installing or reinstalling the host’s operating system, Red Hat strongly recommends that you first detach any existing non-OS storage that is attached to the host to avoid accidental initialization of these disks, and with that, potential data loss.
					

Procedure
	
							Click Compute → Hosts and select the host.
						
	
							Click Management → Maintenance and OK.
						
	
							Click Installation → Reinstall.
						
	
							Click the Hosted Engine tab and select DEPLOY from the drop-down list.
						
	
							Click OK.
						



					The host is reinstalled with self-hosted engine configuration, and is flagged with a crown icon in the Administration Portal.
				

Booting the Manager Virtual Machine in Rescue Mode




					This topic describes how to boot the Manager virtual machine into rescue mode when it does not start. For more information, see Booting to Rescue Mode in the Red Hat Enterprise Linux System Administrator’s Guide.
				
	
							Connect to one of the hosted-engine nodes:
						
$ ssh root@host_address

	
							Put the self-hosted engine in global maintenance mode:
						
# hosted-engine --set-maintenance --mode=global

	
							Check if there is already a running instance of the Manager virtual machine:
						
# hosted-engine --vm-status

							If a Manager virtual machine instance is running, connect to its host:
						
# ssh root@host_address

	
							Shut down the virtual machine:
						
# hosted-engine --vm-shutdown
Note

								If the virtual machine does not shut down, execute the following command:
							
# hosted-engine --vm-poweroff


	
							Start the Manager virtual machine in pause mode:
						
hosted-engine --vm-start-paused

	
							Set a temporary VNC password:
						
hosted-engine --add-console-password

							The command outputs the necessary information you need to log in to the Manger virtual machine with VNC.
						

	
							Log in to the Manager virtual machine with VNC. The Manager virtual machine is still paused, so it appears to be frozen.
						
	
							Resume the Manager virtual machine with the following command on its host:
						
Warning

								After running the following command, the boot loader menu appears. You need to enter into rescue mode before the boot loader proceeds with the normal boot process. Read the next step about entering into rescue mode before proceeding with this command.
							

# /usr/bin/virsh -c qemu:///system?authfile=/etc/ovirt-hosted-engine/virsh_auth.conf resume HostedEngine

	
							Boot the Manager virtual machine in rescue mode.
						
	
							Disable global maintenance mode
						
# hosted-engine --set-maintenance --mode=none




					You can now run rescue tasks on the Manager virtual machine.
				

Removing a Host from a Self-Hosted Engine Environment




					To remove a self-hosted engine node from your environment, place the node into maintenance mode, undeploy the node, and optionally remove it. The node can be managed as a regular host after the HA services have been stopped, and the self-hosted engine configuration files have been removed.
				
Procedure
	
							In the Administration Portal, click Compute → Hosts and select the self-hosted engine node.
						
	
							Click Management → Maintenance and OK.
						
	
							Click Installation → Reinstall.
						
	
							Click the Hosted Engine tab and select UNDEPLOY from the drop-down list. This action stops the ovirt-ha-agent and ovirt-ha-broker services and removes the self-hosted engine configuration file.
						
	
							Click OK.
						
	
							Optionally, click Remove. This opens the Remove Host(s) confirmation window.
						
	
							Click OK.
						



Updating a Self-Hosted Engine




					To update a self-hosted engine from your current version to the latest version, you must place the environment in global maintenance mode and then follow the standard procedure for updating between minor versions.
				
Enabling global maintenance mode

					You must place the self-hosted engine environment in global maintenance mode before performing any setup or upgrade tasks on the Manager virtual machine.
				
Procedure
	
							Log in to one of the self-hosted engine nodes and enable global maintenance mode:
						
# hosted-engine --set-maintenance --mode=global

	
							Confirm that the environment is in global maintenance mode before proceeding:
						
# hosted-engine --vm-status

							You should see a message indicating that the cluster is in global maintenance mode.
						



Updating the Red Hat Virtualization Manager
Procedure
	
							On the Manager machine, check if updated packages are available:
						
# engine-upgrade-check

	
							Update the setup packages:
						
# yum update ovirt\*setup\* rh\*vm-setup-plugins

	
							Update the Red Hat Virtualization Manager with the engine-setup script. The engine-setup script prompts you with some configuration questions, then stops the ovirt-engine service, downloads and installs the updated packages, backs up and updates the database, performs post-installation configuration, and starts the ovirt-engine service.
						
# engine-setup

							When the script completes successfully, the following message appears:
						
Execution of setup completed successfully
Note

								The engine-setup script is also used during the Red Hat Virtualization Manager installation process, and it stores the configuration values supplied. During an update, the stored values are displayed when previewing the configuration, and might not be up to date if engine-config was used to update configuration after installation. For example, if engine-config was used to update SANWipeAfterDelete to true after installation, engine-setup will output "Default SAN wipe after delete: False" in the configuration preview. However, the updated values will not be overwritten by engine-setup.
							

Important

								The update process might take some time. Do not stop the process before it completes.
							


	
							Update the base operating system and any optional packages installed on the Manager:
						
# yum update --nobest
Important

								If you encounter a required Ansible package conflict during the update, see Cannot perform yum update on my RHV manager (ansible conflict).
							

Important

								If any kernel packages were updated:
							
	
										Disable global maintenance mode
									
	
										Reboot the machine to complete the update.
									






Related Information

						Disabling global maintenance mode
					
Disabling global maintenance mode
Procedure
	
							Log in to the Manager virtual machine and shut it down.
						
	
							Log in to one of the self-hosted engine nodes and disable global maintenance mode:
						
# hosted-engine --set-maintenance --mode=none

							When you exit global maintenance mode, ovirt-ha-agent starts the Manager virtual machine, and then the Manager automatically starts. It can take up to ten minutes for the Manager to start.
						

	
							Confirm that the environment is running:
						
# hosted-engine --vm-status

							The listed information includes Engine Status. The value for Engine status should be:
						
{"health": "good", "vm": "up", "detail": "Up"}
Note

								When the virtual machine is still booting and the Manager hasn’t started yet, the Engine status is:
							
{"reason": "bad vm status", "health": "bad", "vm": "up", "detail": "Powering up"}

								If this happens, wait a few minutes and try again.
							





Changing the FQDN of the Manager in a Self-Hosted Engine




					You can use the ovirt-engine-rename command to update records of the fully qualified domain name (FQDN) of the Manager.
				

					For details see Renaming the Manager with the Ovirt Engine Rename Tool.
				


Backups and Migration



Backing Up and Restoring the Red Hat Virtualization Manager



Backing up Red Hat Virtualization Manager - Overview




						Use the engine-backup tool to take regular backups of the Red Hat Virtualization Manager. The tool backs up the engine database and configuration files into a single file and can be run without interrupting the ovirt-engine service.
					

Syntax for the engine-backup Command




						The engine-backup command works in one of two basic modes:
					
# engine-backup --mode=backup
# engine-backup --mode=restore

						These two modes are further extended by a set of options that allow you to specify the scope of the backup and different credentials for the engine database. Run engine-backup --help for a full list of options and their function.
					

						Basic Options
					
	--mode
	
									Specifies whether the command performs a backup operation or a restore operation. The available options are: backup (set by default), restore, and verify. You must define the mode option for verify or restore operations.
								
	--file
	
									Specifies the path and name of a file (for example, file_name.backup) into which backups are saved in backup mode, and to be read as backup data in restore mode. The path is defined by default as /var/lib/ovirt-engine-backup/.
								
	--log
	
									Specifies the path and name of a file (for example, log_file_name) into which logs of the backup or restore operation are written. The path is defined by default as /var/log/ovirt-engine-backup/ .
								
	--scope
	
									Specifies the scope of the backup or restore operation. There are four options: all, to back up or restore all databases and configuration data (set by default); files, to back up or restore only files on the system; db, to back up or restore only the Manager database; and dwhdb, to back up or restore only the Data Warehouse database.
								

									The --scope option can be specified multiple times in the same engine-backup command.
								




						Manager Database Options
					

						The following options are only available when using the engine-backup command in restore mode. The option syntax below applies to restoring the Manager database. The same options exist for restoring the Data Warehouse database. See engine-backup --help for the Data Warehouse option syntax.
					
	--provision-db
	
									Creates a PostgreSQL database for the Manager database backup to be restored to. This is a required option when restoring a backup on a remote host or fresh installation that does not have a PostgreSQL database already configured. When this option is used in restore mode, the --restore-permissions option is added by default.
								
	--provision-all-databases
	
									Creates databases for all memory dumps included in the archive. When enabled, this is the default.
								
	--change-db-credentials
	
									Allows you to specify alternate credentials for restoring the Manager database using credentials other than those stored in the backup itself. See engine-backup --help for the additional parameters required by this option.
								
	--restore-permissions or --no-restore-permissions
	
									Restores or does not restore the permissions of database users. One of these options is required when restoring a backup. When the --provision-* option is used in restore mode, --restore-permissions is applied by default.
								
Note

										If a backup contains grants for extra database users, restoring the backup with the --restore-permissions and --provision-db (or --provision-dwh-db) options creates the extra users with random passwords. You must change these passwords manually if the extra users require access to the restored system. See How to grant access to an extra database user after restoring Red Hat Virtualization from a backup.
									





Creating a backup with the engine-backup command




						You can back up the Red Hat Virtualization Manager with the engine-backup command while the Manager is active. Append one of the following values to the --scope option to specify what you want to back up:
					
	all
	
									A full backup of all databases and configuration files on the Manager. This is the default setting for the --scope option.
								
	files
	
									A backup of only the files on the system
								
	db
	
									A backup of only the Manager database
								
	dwhdb
	
									A backup of only the Data Warehouse database
								
	cinderlibdb
	
									A backup of only the Cinderlib database
								
	grafanadb
	
									A backup of only the Grafana database
								



						You can specify the --scope option more than once.
					

						You can also configure the engine-backup command to back up additional files. It restores everything that it backs up.
					
Important

							To restore a database to a fresh installation of Red Hat Virtualization Manager, a database backup alone is not sufficient. The Manager also requires access to the configuration files. If you specify a scope other than all, you must also include --scope=files, or back up the file system.
						


						For a complete explanation of the engine-backup command, enter engine-backup --help on the Manager machine.
					
Procedure
	
								Log on to the Manager machine.
							
	
								Create a backup:
							
# engine-backup




						The following settings are applied by default:
					

						--scope=all
					

						--mode=backup
					

						The command generates the backup in /var/lib/ovirt-engine-backup/file_name.backup, and a log file in /var/log/ovirt-engine-backup/log_file_name.
					

						Use file_name.tar to restore the environment.
					

						The following examples demonstrate several different backup scenarios.
					
Example 3.1. Full backup
# engine-backup


Example 3.2. Manager database backup
# engine-backup --scope=files --scope=db


Example 3.3. Data Warehouse database backup
# engine-backup --scope=files --scope=dwhdb


Example 3.4. Adding specific files to the backup
	
									Make a directory to store configuration customizations for the engine-backup command:
								
# mkdir -p /etc/ovirt-engine-backup/engine-backup-config.d

	
									Create a text file in the new directory named ntp-chrony.sh with the following contents:
								
BACKUP_PATHS="${BACKUP_PATHS}
/etc/chrony.conf
/etc/ntp.conf
/etc/ovirt-engine-backup"

	
									When you run the engine-backup command, use --scope=files. The backup and restore includes /etc/chrony.conf, /etc/ntp.conf, and /etc/ovirt-engine-backup.
								





Restoring a Backup with the engine-backup Command




						Restoring a backup using the engine-backup command involves more steps than creating a backup does, depending on the restoration destination. For example, the engine-backup command can be used to restore backups to fresh installations of Red Hat Virtualization, on top of existing installations of Red Hat Virtualization, and using local or remote databases.
					
Important

							The version of the Red Hat Virtualization Manager (such as 4.4.8) used to restore a backup must be later than or equal to the Red Hat Virtualization Manager version (such as 4.4.7) used to create the backup. Starting with Red Hat Virtualization 4.4.7, this policy is strictly enforced by the engine-backup command. To view the version of Red Hat Virtualization contained in a backup file, unpack the backup file and read the value in the version file located in the root directory of the unpacked files.
						


Restoring a Backup to a Fresh Installation




						The engine-backup command can be used to restore a backup to a fresh installation of the Red Hat Virtualization Manager. The following procedure must be performed on a machine on which the base operating system has been installed and the required packages for the Red Hat Virtualization Manager have been installed, but the engine-setup command has not yet been run. This procedure assumes that the backup file or files can be accessed from the machine on which the backup is to be restored.
					
Procedure
	
								Log on to the Manager machine. If you are restoring the engine database to a remote host, you will need to log on to and perform the relevant actions on that host. Likewise, if also restoring the Data Warehouse to a remote host, you will need to log on to and perform the relevant actions on that host.
							
	
								Restore a complete backup or a database-only backup.
							
	
										Restore a complete backup:
									
# engine-backup --mode=restore --file=file_name --log=log_file_name --provision-db

										When the --provision-* option is used in restore mode, --restore-permissions is applied by default.
									

										If Data Warehouse is also being restored as part of the complete backup, provision the additional database:
									
engine-backup --mode=restore --file=file_name --log=log_file_name --provision-db --provision-dwh-db

	
										Restore a database-only backup by restoring the configuration files and database backup:
									
# engine-backup --mode=restore --scope=files --scope=db --file=file_name --log=log_file_name --provision-db

										The example above restores a backup of the Manager database.
									
# engine-backup --mode=restore --scope=files --scope=dwhdb --file=file_name --log=log_file_name --provision-dwh-db

										The example above restores a backup of the Data Warehouse database.
									

										If successful, the following output displays:
									
You should now run engine-setup.
Done.




	
								Run the following command and follow the prompts to configure the restored Manager:
							
# engine-setup




						The Red Hat Virtualization Manager has been restored to the version preserved in the backup. To change the fully qualified domain name of the new Red Hat Virtualization system, see The oVirt Engine Rename Tool.
					

Restoring a Backup to Overwrite an Existing Installation




						The engine-backup command can restore a backup to a machine on which the Red Hat Virtualization Manager has already been installed and set up. This is useful when you have taken a backup of an environment, performed changes on that environment, and then want to undo the changes by restoring the environment from the backup.
					

						Changes made to the environment since the backup was taken, such as adding or removing a host, will not appear in the restored environment. You must redo these changes.
					
Procedure
	
								Log in to the Manager machine.
							
	
								Remove the configuration files and clean the database associated with the Manager:
							
# engine-cleanup

								The engine-cleanup command only cleans the Manager database; it does not drop the database or delete the user that owns that database.
							

	
								Restore a full backup or a database-only backup. You do not need to create a new database or specify the database credentials because the user and database already exist.
							
	
										Restore a full backup:
									
# engine-backup --mode=restore --file=file_name --log=log_file_name --restore-permissions

	
										Restore a database-only backup by restoring the configuration files and the database backup:
									
# engine-backup --mode=restore --scope=files --scope=db --scope=dwhdb --file=file_name --log=log_file_name --restore-permissions
Note

											To restore only the Manager database (for example, if the Data Warehouse database is located on another machine), you can omit the --scope=dwhdb parameter.
										


										If successful, the following output displays:
									
You should now run engine-setup.
Done.




	
								Reconfigure the Manager:
							
# engine-setup




Restoring a Backup with Different Credentials




						The engine-backup command can restore a backup to a machine on which the Red Hat Virtualization Manager has already been installed and set up, but the credentials of the database in the backup are different to those of the database on the machine on which the backup is to be restored. This is useful when you have taken a backup of an installation and want to restore the installation from the backup to a different system.
					
Important

							When restoring a backup to overwrite an existing installation, you must run the engine-cleanup command to clean up the existing installation before using the engine-backup command. The engine-cleanup command only cleans the engine database, and does not drop the database or delete the user that owns that database. So you do not need to create a new database or specify the database credentials. However, if the credentials for the owner of the engine database are not known, you must change them before you can restore the backup.
						

Procedure
	
								Log in to the Red Hat Virtualization Manager machine.
							
	
								Run the following command and follow the prompts to remove the Manager’s configuration files and to clean the Manager’s database:
							
# engine-cleanup

	
								Change the password for the owner of the engine database if the credentials of that user are not known:
							
	
										Enter the postgresql command line:
									
# su - postgres -c 'psql'

	
										Change the password of the user that owns the engine database:
									
postgres=# alter role user_name encrypted password 'new_password';

										Repeat this for the user that owns the ovirt_engine_history database if necessary.
									




	
								Restore a complete backup or a database-only backup with the --change-db-credentials parameter to pass the credentials of the new database. The database_location for a database local to the Manager is localhost.
							
Note

									The following examples use a --*password option for each database without specifying a password, which prompts for a password for each database. Alternatively, you can use --*passfile=password_file options for each database to securely pass the passwords to the engine-backup tool without the need for interactive prompts.
								

	
										Restore a complete backup:
									
# engine-backup --mode=restore --file=file_name --log=log_file_name --change-db-credentials --db-host=database_location --db-name=database_name --db-user=engine --db-password --no-restore-permissions

										If Data Warehouse is also being restored as part of the complete backup, include the revised credentials for the additional database:
									
engine-backup --mode=restore --file=file_name --log=log_file_name --change-db-credentials --db-host=database_location --db-name=database_name --db-user=engine --db-password --change-dwh-db-credentials --dwh-db-host=database_location --dwh-db-name=database_name --dwh-db-user=ovirt_engine_history --dwh-db-password --no-restore-permissions

	
										Restore a database-only backup by restoring the configuration files and the database backup:
									
# engine-backup --mode=restore --scope=files --scope=db --file=file_name --log=log_file_name --change-db-credentials --db-host=database_location --db-name=database_name --db-user=engine --db-password --no-restore-permissions

										The example above restores a backup of the Manager database.
									
# engine-backup --mode=restore --scope=files --scope=dwhdb --file=file_name --log=log_file_name --change-dwh-db-credentials --dwh-db-host=database_location --dwh-db-name=database_name --dwh-db-user=ovirt_engine_history --dwh-db-password --no-restore-permissions

										The example above restores a backup of the Data Warehouse database.
									

										If successful, the following output displays:
									
You should now run engine-setup.
Done.




	
								Run the following command and follow the prompts to reconfigure the firewall and ensure the ovirt-engine service is correctly configured:
							
# engine-setup




Backing up and Restoring a Self-Hosted Engine




						You can back up a self-hosted engine and restore it in a new self-hosted environment. Use this procedure for tasks such as migrating the environment to a new self-hosted engine storage domain with a different storage type.
					

						When you specify a backup file during deployment, the backup is restored on a new Manager virtual machine, with a new self-hosted engine storage domain. The old Manager is removed, and the old self-hosted engine storage domain is renamed and can be manually removed after you confirm that the new environment is working correctly. Deploying on a fresh host is highly recommended; if the host used for deployment existed in the backed up environment, it will be removed from the restored database to avoid conflicts in the new environment. If you deploy on a new host, you must assign a unique name to the host. Reusing the name of an existing host included in the backup can cause conflicts in the new environment.
					

						The backup and restore operation involves the following key actions:
					
	
								Back up the original Manager using the engine-backup tool.
							
	
								Deploy a new self-hosted engine and restore the backup.
							
	
								Enable the Manager repositories on the new Manager virtual machine.
							
	
								Reinstall the self-hosted engine nodes to update their configuration.
							
	
								Remove the old self-hosted engine storage domain.
							



						This procedure assumes that you have access and can make changes to the original Manager.
					
Prerequisites
	
								A fully qualified domain name prepared for your Manager and the host. Forward and reverse lookup records must both be set in the DNS. The new Manager must have the same fully qualified domain name as the original Manager.
							
	
								The original Manager must be updated to the latest minor version. The version of the Red Hat Virtualization Manager (such as 4.4.8) used to restore a backup must be later than or equal to the Red Hat Virtualization Manager version (such as 4.4.7) used to create the backup. Starting with Red Hat Virtualization 4.4.7, this policy is strictly enforced by the engine-backup command. See Updating the Red Hat Virtualization Manager in the Upgrade Guide.
							
Note

									If you need to restore a backup, but do not have a new appliance, the restore process will pause, and you can log into the temporary Manager machine via SSH, register, subscribe, or configure channels as needed, and upgrade the Manager packages before resuming the restore process.
								


	
								The data center compatibility level must be set to the latest version to ensure compatibility with the updated storage version.
							
	
								There must be at least one regular host in the environment. This host (and any other regular hosts) will remain active to host the SPM role and any running virtual machines. If a regular host is not already the SPM, move the SPM role before creating the backup by selecting a regular host and clicking Management → Select as SPM.
							

								If no regular hosts are available, there are two ways to add one:
							
	
										Remove the self-hosted engine configuration from a node (but do not remove the node from the environment). See Removing a Host from a Self-Hosted Engine Environment.
									
	
										Add a new regular host. See Adding standard hosts to the Manager host tasks.
									





Backing up the Original Manager




							Back up the original Manager using the engine-backup command, and copy the backup file to a separate location so that it can be accessed at any point during the process.
						

							For more information about engine-backup --mode=backup options, see Backing Up and Restoring the Red Hat Virtualization Manager in the Administration Guide.
						
Procedure
	
									Log in to one of the self-hosted engine nodes and move the environment to global maintenance mode:
								
# hosted-engine --set-maintenance --mode=global

	
									Log in to the original Manager and stop the ovirt-engine service:
								
# systemctl stop ovirt-engine
# systemctl disable ovirt-engine
Note

										Though stopping the original Manager from running is not obligatory, it is recommended as it ensures no changes are made to the environment after the backup is created. Additionally, it prevents the original Manager and the new Manager from simultaneously managing existing resources.
									


	
									Run the engine-backup command, specifying the name of the backup file to create, and the name of the log file to create to store the backup log:
								
# engine-backup --mode=backup --file=file_name --log=log_file_name

	
									Copy the files to an external server. In the following example, storage.example.com is the fully qualified domain name of a network storage server that will store the backup until it is needed, and /backup/ is any designated folder or path.
								
# scp -p file_name log_file_name storage.example.com:/backup/

	
									If you do not require the Manager machine for other purposes, unregister it from Red Hat Subscription Manager:
								
# subscription-manager unregister

	
									Log in to one of the self-hosted engine nodes and shut down the original Manager virtual machine:
								
# hosted-engine --vm-shutdown




							After backing up the Manager, deploy a new self-hosted engine and restore the backup on the new virtual machine.
						

Restoring the Backup on a New Self-Hosted Engine




							Run the hosted-engine script on a new host, and use the --restore-from-file=path/to/file_name option to restore the Manager backup during the deployment.
						
Important

								If you are using iSCSI storage, and your iSCSI target filters connections according to the initiator’s ACL, the deployment may fail with a STORAGE_DOMAIN_UNREACHABLE error. To prevent this, you must update your iSCSI configuration before beginning the self-hosted engine deployment:
							
	
										If you are redeploying on an existing host, you must update the host’s iSCSI initiator settings in /etc/iscsi/initiatorname.iscsi. The initiator IQN must be the same as was previously mapped on the iSCSI target, or updated to a new IQN, if applicable.
									
	
										If you are deploying on a fresh host, you must update the iSCSI target configuration to accept connections from that host.
									



								Note that the IQN can be updated on the host side (iSCSI initiator), or on the storage side (iSCSI target).
							

Procedure
	
									Copy the backup file to the new host. In the following example, host.example.com is the FQDN for the host, and /backup/ is any designated folder or path.
								
# scp -p file_name host.example.com:/backup/

	
									Log in to the new host.
								
	
									If you are deploying on Red Hat Virtualization Host, ovirt-hosted-engine-setup is already installed, so skip this step. If you are deploying on Red Hat Enterprise Linux, install the ovirt-hosted-engine-setup package:
								
# dnf install ovirt-hosted-engine-setup

	
									Use the tmux window manager to run the script to avoid losing the session in case of network or terminal disruption.
								

									Install and run tmux:
								
# dnf -y install tmux
# tmux

	
									Run the hosted-engine script, specifying the path to the backup file:
								
# hosted-engine --deploy --restore-from-file=backup/file_name

									To escape the script at any time, use CTRL+D to abort deployment.
								

	
									Select Yes to begin the deployment.
								
	
									Configure the network. The script detects possible NICs to use as a management bridge for the environment.
								
	
									If you want to use a custom appliance for the virtual machine installation, enter the path to the OVA archive. Otherwise, leave this field empty to use the RHV-M Appliance.
								
	
									Enter the root password for the Manager.
								
	
									Enter an SSH public key that will allow you to log in to the Manager as the root user, and specify whether to enable SSH access for the root user.
								
	
									Enter the virtual machine’s CPU and memory configuration.
								
	
									Enter a MAC address for the Manager virtual machine, or accept a randomly generated one. If you want to provide the Manager virtual machine with an IP address via DHCP, ensure that you have a valid DHCP reservation for this MAC address. The deployment script will not configure the DHCP server for you.
								
	
									Enter the virtual machine’s networking details. If you specify Static, enter the IP address of the Manager.
								
Important

										The static IP address must belong to the same subnet as the host. For example, if the host is in 10.1.1.0/24, the Manager virtual machine’s IP must be in the same subnet range (10.1.1.1-254/24).
									


	
									Specify whether to add entries for the Manager virtual machine and the base host to the virtual machine’s /etc/hosts file. You must ensure that the host names are resolvable.
								
	
									Provide the name and TCP port number of the SMTP server, the email address used to send email notifications, and a comma-separated list of email addresses to receive these notifications:
								
	
									Enter a password for the admin@internal user to access the Administration Portal.
								

									The script creates the virtual machine. This can take some time if the RHV-M Appliance needs to be installed.
								
Note

										If the host becomes non operational, due to a missing required network or a similar problem, the deployment pauses and a message such as the following is displayed:
									
[ INFO  ] You can now connect to https://<host name>:6900/ovirt-engine/ and check the status of this host and eventually remediate it, please continue only when the host is listed as 'up'
[ INFO  ] TASK [ovirt.ovirt.hosted_engine_setup : include_tasks]
[ INFO  ] ok: [localhost]
[ INFO  ] TASK [ovirt.ovirt.hosted_engine_setup : Create temporary lock file]
[ INFO  ] changed: [localhost]
[ INFO  ] TASK [ovirt.ovirt.hosted_engine_setup : Pause execution until /tmp/ansible.<random>_he_setup_lock is removed, delete it once ready to proceed]

										Pausing the process allows you to:
									
	
												Connect to the Administration Portal using the provided URL.
											
	
												Assess the situation, find out why the host is non operational, and fix whatever is needed. For example, if this deployment was restored from a backup, and the backup included required networks for the host cluster, configure the networks, attaching the relevant host NICs to these networks.
											
	
												Once everything looks OK, and the host status is Up, remove the lock file presented in the message above. The deployment continues.
											




	
									Select the type of storage to use:
								
	
											For NFS, enter the version, full address and path to the storage, and any mount options.
										
Warning

												Do not use the old self-hosted engine storage domain’s mount point for the new storage domain, as you risk losing virtual machine data.
											


	
											For iSCSI, enter the portal details and select a target and LUN from the auto-detected lists. You can only select one iSCSI target during the deployment, but multipathing is supported to connect all portals of the same portal group.
										
Note

												To specify more than one iSCSI target, you must enable multipathing before deploying the self-hosted engine. See Red Hat Enterprise Linux DM Multipath for details. There is also a Multipath Helper tool that generates a script to install and configure multipath with different options.
											


	
											For Gluster storage, enter the full address and path to the storage, and any mount options.
										
Warning

												Do not use the old self-hosted engine storage domain’s mount point for the new storage domain, as you risk losing virtual machine data.
											

Important

												Only replica 1 and replica 3 Gluster storage are supported. Ensure you configure the volume as follows:
											
gluster volume set VOLUME_NAME group virt
gluster volume set VOLUME_NAME performance.strict-o-direct on
gluster volume set VOLUME_NAME network.remote-dio off
gluster volume set VOLUME_NAME storage.owner-uid 36
gluster volume set VOLUME_NAME storage.owner-gid 36
gluster volume set VOLUME_NAME network.ping-timeout 30


	
											For Fibre Channel, select a LUN from the auto-detected list. The host bus adapters must be configured and connected, and the LUN must not contain any existing data. To reuse an existing LUN, see Reusing LUNs in the Administration Guide.
										



	
									Enter the Manager disk size.
								

									The script continues until the deployment is complete.
								

	
									The deployment process changes the Manager’s SSH keys. To allow client machines to access the new Manager without SSH errors, remove the original Manager’s entry from the .ssh/known_hosts file on any client machines that accessed the original Manager.
								



							When the deployment is complete, log in to the new Manager virtual machine and enable the required repositories.
						

Enabling the Red Hat Virtualization Manager Repositories




							You need to log in and register the Manager machine with Red Hat Subscription Manager, attach the Red Hat Virtualization Manager subscription, and enable the Manager repositories.
						
Procedure
	
									Register your system with the Content Delivery Network, entering your Customer Portal user name and password when prompted:
								
# subscription-manager register
Note

										If you are using an IPv6 network, use an IPv6 transition mechanism to access the Content Delivery Network and subscription manager.
									


	
									Find the Red Hat Virtualization Manager subscription pool and record the pool ID:
								
# subscription-manager list --available

	
									Use the pool ID to attach the subscription to the system:
								
# subscription-manager attach --pool=pool_id
Note

										To view currently attached subscriptions:
									
# subscription-manager list --consumed

										To list all enabled repositories:
									
# dnf repolist


	
									Configure the repositories:
								
# subscription-manager repos \
    --disable='*' \
    --enable=rhel-8-for-x86_64-baseos-eus-rpms \
    --enable=rhel-8-for-x86_64-appstream-eus-rpms \
    --enable=rhv-4.4-manager-for-rhel-8-x86_64-rpms \
    --enable=fast-datapath-for-rhel-8-x86_64-rpms \
    --enable=jb-eap-7.4-for-rhel-8-x86_64-rpms \
    --enable=openstack-16.2-cinderlib-for-rhel-8-x86_64-rpms \
    --enable=rhceph-4-tools-for-rhel-8-x86_64-rpms

	
									Set the RHEL version to 8.6:
								
# subscription-manager release --set=8.6

	
									Enable the pki-deps module.
								
# dnf module -y enable pki-deps

	
									Enable version 12 of the postgresql module.
								
# dnf module -y enable postgresql:12

	
									Enable version 14 of the nodejs module:
								
# dnf module -y enable nodejs:14

	
									Synchronize installed packages to update them to the latest available versions.
								
# dnf distro-sync --nobest



Additional resources

								For information on modules and module streams, see the following sections in Installing, managing, and removing user-space components
							
	
									Module streams
								
	
									Selecting a stream before installation of packages
								
	
									Resetting module streams
								
	
									Switching to a later stream
								



							The Manager and its resources are now running in the new self-hosted environment. The self-hosted engine nodes must be reinstalled in the Manager to update their self-hosted engine configuration. Standard hosts are not affected. Perform the following procedure for each self-hosted engine node.
						

Reinstalling Hosts




							Reinstall Red Hat Virtualization Hosts (RHVH) and Red Hat Enterprise Linux hosts from the Administration Portal. The procedure includes stopping and restarting the host.
						
Warning

								When installing or reinstalling the host’s operating system, Red Hat strongly recommends that you first detach any existing non-OS storage that is attached to the host to avoid accidental initialization of these disks, and with that, potential data loss.
							

Prerequisites
	
									If the cluster has migration enabled, virtual machines can automatically migrate to another host in the cluster. Therefore, reinstall a host while its usage is relatively low.
								
	
									Ensure that the cluster has sufficient memory for its hosts to perform maintenance. If a cluster lacks memory, migration of virtual machines will hang and then fail. To reduce memory usage, shut down some or all of the virtual machines before moving the host to maintenance.
								
	
									Ensure that the cluster contains more than one host before performing a reinstall. Do not attempt to reinstall all the hosts at the same time. One host must remain available to perform Storage Pool Manager (SPM) tasks.
								


Procedure
	
									Click Compute → Hosts and select the host.
								
	
									Click Management → Maintenance and OK.
								
	
									Click Installation → Reinstall. This opens the Install Host window.
								
	
									Click the Hosted Engine tab and select DEPLOY from the drop-down list.
								
	
									Click OK to reinstall the host.
								



							After a host has been reinstalled and its status returns to Up, you can migrate virtual machines back to the host.
						
Important

								After you register a Red Hat Virtualization Host to the Red Hat Virtualization Manager and reinstall it, the Administration Portal may erroneously display its status as Install Failed. Click Management → Activate, and the host will change to an Up status and be ready for use.
							


							After reinstalling the self-hosted engine nodes, you can check the status of the new environment by running the following command on one of the nodes:
						
# hosted-engine --vm-status

							During the restoration, the old self-hosted engine storage domain was renamed, but was not removed from the new environment in case the restoration was faulty. After confirming that the environment is running normally, you can remove the old self-hosted engine storage domain.
						

Removing a Storage Domain




							You have a storage domain in your data center that you want to remove from the virtualized environment.
						
Procedure
	
									Click Storage → Domains.
								
	
									Move the storage domain to maintenance mode and detach it:
								
	
											Click the storage domain’s name. This opens the details view.
										
	
											Click the Data Center tab.
										
	
											Click Maintenance, then click OK.
										
	
											Click Detach, then click OK.
										



	
									Click Remove.
								
	
									Optionally select the Format Domain, i.e. Storage Content will be lost! check box to erase the content of the domain.
								
	
									Click OK.
								



							The storage domain is permanently removed from the environment.
						


Recovering a Self-Hosted Engine from an Existing Backup




						If a self-hosted engine is unavailable due to problems that cannot be repaired, you can restore it in a new self-hosted environment using a backup taken before the problem began, if one is available.
					

						When you specify a backup file during deployment, the backup is restored on a new Manager virtual machine, with a new self-hosted engine storage domain. The old Manager is removed, and the old self-hosted engine storage domain is renamed and can be manually removed after you confirm that the new environment is working correctly. Deploying on a fresh host is highly recommended; if the host used for deployment existed in the backed up environment, it will be removed from the restored database to avoid conflicts in the new environment. If you deploy on a new host, you must assign a unique name to the host. Reusing the name of an existing host included in the backup can cause conflicts in the new environment.
					

						Restoring a self-hosted engine involves the following key actions:
					
	
								Deploy a new self-hosted engine and restore the backup.
							
	
								Enable the Manager repositories on the new Manager virtual machine.
							
	
								Reinstall the self-hosted engine nodes to update their configuration.
							
	
								Remove the old self-hosted engine storage domain.
							



						This procedure assumes that you do not have access to the original Manager, and that the new host can access the backup file.
					
Prerequisites
	
								A fully qualified domain name prepared for your Manager and the host. Forward and reverse lookup records must both be set in the DNS. The new Manager must have the same fully qualified domain name as the original Manager.
							


Restoring the Backup on a New Self-Hosted Engine




							Run the hosted-engine script on a new host, and use the --restore-from-file=path/to/file_name option to restore the Manager backup during the deployment.
						
Important

								If you are using iSCSI storage, and your iSCSI target filters connections according to the initiator’s ACL, the deployment may fail with a STORAGE_DOMAIN_UNREACHABLE error. To prevent this, you must update your iSCSI configuration before beginning the self-hosted engine deployment:
							
	
										If you are redeploying on an existing host, you must update the host’s iSCSI initiator settings in /etc/iscsi/initiatorname.iscsi. The initiator IQN must be the same as was previously mapped on the iSCSI target, or updated to a new IQN, if applicable.
									
	
										If you are deploying on a fresh host, you must update the iSCSI target configuration to accept connections from that host.
									



								Note that the IQN can be updated on the host side (iSCSI initiator), or on the storage side (iSCSI target).
							

Procedure
	
									Copy the backup file to the new host. In the following example, host.example.com is the FQDN for the host, and /backup/ is any designated folder or path.
								
# scp -p file_name host.example.com:/backup/

	
									Log in to the new host.
								
	
									If you are deploying on Red Hat Virtualization Host, ovirt-hosted-engine-setup is already installed, so skip this step. If you are deploying on Red Hat Enterprise Linux, install the ovirt-hosted-engine-setup package:
								
# dnf install ovirt-hosted-engine-setup

	
									Use the tmux window manager to run the script to avoid losing the session in case of network or terminal disruption.
								

									Install and run tmux:
								
# dnf -y install tmux
# tmux

	
									Run the hosted-engine script, specifying the path to the backup file:
								
# hosted-engine --deploy --restore-from-file=backup/file_name

									To escape the script at any time, use CTRL+D to abort deployment.
								

	
									Select Yes to begin the deployment.
								
	
									Configure the network. The script detects possible NICs to use as a management bridge for the environment.
								
	
									If you want to use a custom appliance for the virtual machine installation, enter the path to the OVA archive. Otherwise, leave this field empty to use the RHV-M Appliance.
								
	
									Enter the root password for the Manager.
								
	
									Enter an SSH public key that will allow you to log in to the Manager as the root user, and specify whether to enable SSH access for the root user.
								
	
									Enter the virtual machine’s CPU and memory configuration.
								
	
									Enter a MAC address for the Manager virtual machine, or accept a randomly generated one. If you want to provide the Manager virtual machine with an IP address via DHCP, ensure that you have a valid DHCP reservation for this MAC address. The deployment script will not configure the DHCP server for you.
								
	
									Enter the virtual machine’s networking details. If you specify Static, enter the IP address of the Manager.
								
Important

										The static IP address must belong to the same subnet as the host. For example, if the host is in 10.1.1.0/24, the Manager virtual machine’s IP must be in the same subnet range (10.1.1.1-254/24).
									


	
									Specify whether to add entries for the Manager virtual machine and the base host to the virtual machine’s /etc/hosts file. You must ensure that the host names are resolvable.
								
	
									Provide the name and TCP port number of the SMTP server, the email address used to send email notifications, and a comma-separated list of email addresses to receive these notifications:
								
	
									Enter a password for the admin@internal user to access the Administration Portal.
								

									The script creates the virtual machine. This can take some time if the RHV-M Appliance needs to be installed.
								
Note

										If the host becomes non operational, due to a missing required network or a similar problem, the deployment pauses and a message such as the following is displayed:
									
[ INFO  ] You can now connect to https://<host name>:6900/ovirt-engine/ and check the status of this host and eventually remediate it, please continue only when the host is listed as 'up'
[ INFO  ] TASK [ovirt.ovirt.hosted_engine_setup : include_tasks]
[ INFO  ] ok: [localhost]
[ INFO  ] TASK [ovirt.ovirt.hosted_engine_setup : Create temporary lock file]
[ INFO  ] changed: [localhost]
[ INFO  ] TASK [ovirt.ovirt.hosted_engine_setup : Pause execution until /tmp/ansible.<random>_he_setup_lock is removed, delete it once ready to proceed]

										Pausing the process allows you to:
									
	
												Connect to the Administration Portal using the provided URL.
											
	
												Assess the situation, find out why the host is non operational, and fix whatever is needed. For example, if this deployment was restored from a backup, and the backup included required networks for the host cluster, configure the networks, attaching the relevant host NICs to these networks.
											
	
												Once everything looks OK, and the host status is Up, remove the lock file presented in the message above. The deployment continues.
											




	
									Select the type of storage to use:
								
	
											For NFS, enter the version, full address and path to the storage, and any mount options.
										
Warning

												Do not use the old self-hosted engine storage domain’s mount point for the new storage domain, as you risk losing virtual machine data.
											


	
											For iSCSI, enter the portal details and select a target and LUN from the auto-detected lists. You can only select one iSCSI target during the deployment, but multipathing is supported to connect all portals of the same portal group.
										
Note

												To specify more than one iSCSI target, you must enable multipathing before deploying the self-hosted engine. See Red Hat Enterprise Linux DM Multipath for details. There is also a Multipath Helper tool that generates a script to install and configure multipath with different options.
											


	
											For Gluster storage, enter the full address and path to the storage, and any mount options.
										
Warning

												Do not use the old self-hosted engine storage domain’s mount point for the new storage domain, as you risk losing virtual machine data.
											

Important

												Only replica 1 and replica 3 Gluster storage are supported. Ensure you configure the volume as follows:
											
gluster volume set VOLUME_NAME group virt
gluster volume set VOLUME_NAME performance.strict-o-direct on
gluster volume set VOLUME_NAME network.remote-dio off
gluster volume set VOLUME_NAME storage.owner-uid 36
gluster volume set VOLUME_NAME storage.owner-gid 36
gluster volume set VOLUME_NAME network.ping-timeout 30


	
											For Fibre Channel, select a LUN from the auto-detected list. The host bus adapters must be configured and connected, and the LUN must not contain any existing data. To reuse an existing LUN, see Reusing LUNs in the Administration Guide.
										



	
									Enter the Manager disk size.
								

									The script continues until the deployment is complete.
								

	
									The deployment process changes the Manager’s SSH keys. To allow client machines to access the new Manager without SSH errors, remove the original Manager’s entry from the .ssh/known_hosts file on any client machines that accessed the original Manager.
								



							When the deployment is complete, log in to the new Manager virtual machine and enable the required repositories.
						

Enabling the Red Hat Virtualization Manager Repositories




							You need to log in and register the Manager machine with Red Hat Subscription Manager, attach the Red Hat Virtualization Manager subscription, and enable the Manager repositories.
						
Procedure
	
									Register your system with the Content Delivery Network, entering your Customer Portal user name and password when prompted:
								
# subscription-manager register
Note

										If you are using an IPv6 network, use an IPv6 transition mechanism to access the Content Delivery Network and subscription manager.
									


	
									Find the Red Hat Virtualization Manager subscription pool and record the pool ID:
								
# subscription-manager list --available

	
									Use the pool ID to attach the subscription to the system:
								
# subscription-manager attach --pool=pool_id
Note

										To view currently attached subscriptions:
									
# subscription-manager list --consumed

										To list all enabled repositories:
									
# dnf repolist


	
									Configure the repositories:
								
# subscription-manager repos \
    --disable='*' \
    --enable=rhel-8-for-x86_64-baseos-eus-rpms \
    --enable=rhel-8-for-x86_64-appstream-eus-rpms \
    --enable=rhv-4.4-manager-for-rhel-8-x86_64-rpms \
    --enable=fast-datapath-for-rhel-8-x86_64-rpms \
    --enable=jb-eap-7.4-for-rhel-8-x86_64-rpms \
    --enable=openstack-16.2-cinderlib-for-rhel-8-x86_64-rpms \
    --enable=rhceph-4-tools-for-rhel-8-x86_64-rpms

	
									Set the RHEL version to 8.6:
								
# subscription-manager release --set=8.6

	
									Enable the pki-deps module.
								
# dnf module -y enable pki-deps

	
									Enable version 12 of the postgresql module.
								
# dnf module -y enable postgresql:12

	
									Enable version 14 of the nodejs module:
								
# dnf module -y enable nodejs:14

	
									Synchronize installed packages to update them to the latest available versions.
								
# dnf distro-sync --nobest



Additional resources

								For information on modules and module streams, see the following sections in Installing, managing, and removing user-space components
							
	
									Module streams
								
	
									Selecting a stream before installation of packages
								
	
									Resetting module streams
								
	
									Switching to a later stream
								



							The Manager and its resources are now running in the new self-hosted environment. The self-hosted engine nodes must be reinstalled in the Manager to update their self-hosted engine configuration. Standard hosts are not affected. Perform the following procedure for each self-hosted engine node.
						

Reinstalling Hosts




							Reinstall Red Hat Virtualization Hosts (RHVH) and Red Hat Enterprise Linux hosts from the Administration Portal. The procedure includes stopping and restarting the host.
						
Warning

								When installing or reinstalling the host’s operating system, Red Hat strongly recommends that you first detach any existing non-OS storage that is attached to the host to avoid accidental initialization of these disks, and with that, potential data loss.
							

Prerequisites
	
									If the cluster has migration enabled, virtual machines can automatically migrate to another host in the cluster. Therefore, reinstall a host while its usage is relatively low.
								
	
									Ensure that the cluster has sufficient memory for its hosts to perform maintenance. If a cluster lacks memory, migration of virtual machines will hang and then fail. To reduce memory usage, shut down some or all of the virtual machines before moving the host to maintenance.
								
	
									Ensure that the cluster contains more than one host before performing a reinstall. Do not attempt to reinstall all the hosts at the same time. One host must remain available to perform Storage Pool Manager (SPM) tasks.
								


Procedure
	
									Click Compute → Hosts and select the host.
								
	
									Click Management → Maintenance and OK.
								
	
									Click Installation → Reinstall. This opens the Install Host window.
								
	
									Click the Hosted Engine tab and select DEPLOY from the drop-down list.
								
	
									Click OK to reinstall the host.
								



							After a host has been reinstalled and its status returns to Up, you can migrate virtual machines back to the host.
						
Important

								After you register a Red Hat Virtualization Host to the Red Hat Virtualization Manager and reinstall it, the Administration Portal may erroneously display its status as Install Failed. Click Management → Activate, and the host will change to an Up status and be ready for use.
							


							After reinstalling the self-hosted engine nodes, you can check the status of the new environment by running the following command on one of the nodes:
						
# hosted-engine --vm-status

							During the restoration, the old self-hosted engine storage domain was renamed, but was not removed from the new environment in case the restoration was faulty. After confirming that the environment is running normally, you can remove the old self-hosted engine storage domain.
						

Removing a Storage Domain




							You have a storage domain in your data center that you want to remove from the virtualized environment.
						
Procedure
	
									Click Storage → Domains.
								
	
									Move the storage domain to maintenance mode and detach it:
								
	
											Click the storage domain’s name. This opens the details view.
										
	
											Click the Data Center tab.
										
	
											Click Maintenance, then click OK.
										
	
											Click Detach, then click OK.
										



	
									Click Remove.
								
	
									Optionally select the Format Domain, i.e. Storage Content will be lost! check box to erase the content of the domain.
								
	
									Click OK.
								



							The storage domain is permanently removed from the environment.
						


Overwriting a Self-Hosted Engine from an Existing Backup




						If a self-hosted engine is accessible, but is experiencing an issue such as database corruption, or a configuration error that is difficult to roll back, you can restore the environment to a previous state using a backup taken before the problem began, if one is available.
					

						Restoring a self-hosted engine’s previous state involves the following steps:
					
	
								Place the environment in global maintenance mode.
							
	
								Restore the backup on the Manager virtual machine.
							
	
								Disable global maintenance mode.
							



						For more information about engine-backup --mode=restore options, see Backing Up and Restoring the Manager.
					
Enabling global maintenance mode




							You must place the self-hosted engine environment in global maintenance mode before performing any setup or upgrade tasks on the Manager virtual machine.
						
Procedure
	
									Log in to one of the self-hosted engine nodes and enable global maintenance mode:
								
# hosted-engine --set-maintenance --mode=global

	
									Confirm that the environment is in global maintenance mode before proceeding:
								
# hosted-engine --vm-status

									You should see a message indicating that the cluster is in global maintenance mode.
								




Restoring a Backup to Overwrite an Existing Installation




							The engine-backup command can restore a backup to a machine on which the Red Hat Virtualization Manager has already been installed and set up. This is useful when you have taken a backup of an environment, performed changes on that environment, and then want to undo the changes by restoring the environment from the backup.
						

							Changes made to the environment since the backup was taken, such as adding or removing a host, will not appear in the restored environment. You must redo these changes.
						
Procedure
	
									Log in to the Manager machine.
								
	
									Remove the configuration files and clean the database associated with the Manager:
								
# engine-cleanup

									The engine-cleanup command only cleans the Manager database; it does not drop the database or delete the user that owns that database.
								

	
									Restore a full backup or a database-only backup. You do not need to create a new database or specify the database credentials because the user and database already exist.
								
	
											Restore a full backup:
										
# engine-backup --mode=restore --file=file_name --log=log_file_name --restore-permissions

	
											Restore a database-only backup by restoring the configuration files and the database backup:
										
# engine-backup --mode=restore --scope=files --scope=db --scope=dwhdb --file=file_name --log=log_file_name --restore-permissions
Note

												To restore only the Manager database (for example, if the Data Warehouse database is located on another machine), you can omit the --scope=dwhdb parameter.
											


											If successful, the following output displays:
										
You should now run engine-setup.
Done.




	
									Reconfigure the Manager:
								
# engine-setup




Disabling global maintenance mode



Procedure
	
									Log in to the Manager virtual machine and shut it down.
								
	
									Log in to one of the self-hosted engine nodes and disable global maintenance mode:
								
# hosted-engine --set-maintenance --mode=none

									When you exit global maintenance mode, ovirt-ha-agent starts the Manager virtual machine, and then the Manager automatically starts. It can take up to ten minutes for the Manager to start.
								

	
									Confirm that the environment is running:
								
# hosted-engine --vm-status

									The listed information includes Engine Status. The value for Engine status should be:
								
{"health": "good", "vm": "up", "detail": "Up"}
Note

										When the virtual machine is still booting and the Manager hasn’t started yet, the Engine status is:
									
{"reason": "bad vm status", "health": "bad", "vm": "up", "detail": "Powering up"}

										If this happens, wait a few minutes and try again.
									





							When the environment is running again, you can start any virtual machines that were stopped, and check that the resources in the environment are behaving as expected.
						



Migrating the Data Warehouse to a Separate Machine




					This section describes how to migrate the Data Warehouse database and service from the Red Hat Virtualization Manager machine to a separate machine. Hosting the Data Warehouse service on a separate machine reduces the load on each individual machine, and avoids potential conflicts caused by sharing CPU and memory resources with other processes.
				
Note

						Red Hat only supports installing the Data Warehouse database, the Data Warehouse service and Grafana all on the same machine as each other, even though you can install each of these components on separate machines from each other.
					


					You have the following migration options:
				
	
							You can migrate the Data Warehouse service away from the Manager machine and connect it with the existing Data Warehouse database (ovirt_engine_history).
						
	
							You can migrate the Data Warehouse database away from the Manager machine and then migrate the Data Warehouse service.
						


Migrating the Data Warehouse Database to a Separate Machine




						Migrate the Data Warehouse database (ovirt_engine_history) before you migrate the Data Warehouse service. Use engine-backup to create a database backup and restore it on the new database machine. For more information on engine-backup, run engine-backup --help.
					
Note

							Red Hat only supports installing the Data Warehouse database, the Data Warehouse service and Grafana all on the same machine as each other, even though you can install each of these components on separate machines from each other.
						


						The new database server must have Red Hat Enterprise Linux 8 installed.
					

						Enable the required repositories on the new database server.
					
Enabling the Red Hat Virtualization Manager Repositories




							You need to log in and register the Data Warehouse machine with Red Hat Subscription Manager, attach the Red Hat Virtualization Manager subscription, and enable the Manager repositories.
						
Procedure
	
									Register your system with the Content Delivery Network, entering your Customer Portal user name and password when prompted:
								
# subscription-manager register
Note

										If you are using an IPv6 network, use an IPv6 transition mechanism to access the Content Delivery Network and subscription manager.
									


	
									Find the Red Hat Virtualization Manager subscription pool and record the pool ID:
								
# subscription-manager list --available

	
									Use the pool ID to attach the subscription to the system:
								
# subscription-manager attach --pool=pool_id
Note

										To view currently attached subscriptions:
									
# subscription-manager list --consumed

										To list all enabled repositories:
									
# dnf repolist


	
									Configure the repositories:
								
# subscription-manager repos \
    --disable='*' \
    --enable=rhel-8-for-x86_64-baseos-eus-rpms \
    --enable=rhel-8-for-x86_64-appstream-eus-rpms \
    --enable=rhv-4.4-manager-for-rhel-8-x86_64-rpms \
    --enable=fast-datapath-for-rhel-8-x86_64-rpms \
    --enable=jb-eap-7.4-for-rhel-8-x86_64-rpms \
    --enable=openstack-16.2-cinderlib-for-rhel-8-x86_64-rpms \
    --enable=rhceph-4-tools-for-rhel-8-x86_64-rpms

	
									Set the RHEL version to 8.6:
								
# subscription-manager release --set=8.6

	
									Enable version 12 of the postgresql module.
								
# dnf module -y enable postgresql:12

	
									Enable version 14 of the nodejs module:
								
# dnf module -y enable nodejs:14

	
									Synchronize installed packages to update them to the latest available versions.
								
# dnf distro-sync --nobest



Additional resources

								For information on modules and module streams, see the following sections in Installing, managing, and removing user-space components
							
	
									Module streams
								
	
									Selecting a stream before installation of packages
								
	
									Resetting module streams
								
	
									Switching to a later stream
								



Migrating the Data Warehouse Database to a Separate Machine



Procedure
	
									Create a backup of the Data Warehouse database and configuration files on the Manager:
								
# engine-backup --mode=backup --scope=grafanadb --scope=dwhdb --scope=files --file=file_name --log=log_file_name

	
									Copy the backup file from the Manager to the new machine:
								
# scp /tmp/file_name root@new.dwh.server.com:/tmp

	
									Install engine-backup on the new machine:
								
# dnf install ovirt-engine-tools-backup

	
									Install the PostgreSQL server package:
								
# dnf install postgresql-server postgresql-contrib

	
									Initialize the PostgreSQL database, start the postgresql service, and ensure that this service starts on boot:
								
# su - postgres -c 'initdb'
# systemctl enable postgresql
# systemctl start postgresql

	
									Restore the Data Warehouse database on the new machine. file_name is the backup file copied from the Manager.
								
# engine-backup --mode=restore --scope=files --scope=grafanadb --scope=dwhdb --file=file_name --log=log_file_name --provision-dwh-db

									When the --provision-* option is used in restore mode, --restore-permissions is applied by default.
								




							The Data Warehouse database is now hosted on a separate machine from that on which the Manager is hosted. After successfully restoring the Data Warehouse database, a prompt instructs you to run the engine-setup command. Before running this command, migrate the Data Warehouse service.
						


Migrating the Data Warehouse Service to a Separate Machine




						You can migrate the Data Warehouse service installed and configured on the Red Hat Virtualization Manager to a separate machine. Hosting the Data Warehouse service on a separate machine helps to reduce the load on the Manager machine.
					

						Notice that this procedure migrates the Data Warehouse service only.
					

						To migrate the Data Warehouse database (ovirt_engine_history) prior to migrating the Data Warehouse service, see Migrating the Data Warehouse Database to a Separate Machine.
					
Note

							Red Hat only supports installing the Data Warehouse database, the Data Warehouse service and Grafana all on the same machine as each other, even though you can install each of these components on separate machines from each other.
						

Prerequisites
	
								You must have installed and configured the Manager and Data Warehouse on the same machine.
							
	
								To set up the new Data Warehouse machine, you must have the following:
							
	
										The password from the Manager’s /etc/ovirt-engine/engine.conf.d/10-setup-database.conf file.
									
	
										Allowed access from the Data Warehouse machine to the Manager database machine’s TCP port 5432.
									
	
										The username and password for the Data Warehouse database from the Manager’s /etc/ovirt-engine-dwh/ovirt-engine-dwhd.conf.d/10-setup-database.conf file.
									

										If you migrated the ovirt_engine_history database using the procedures described in Migrating the Data Warehouse Database to a Separate Machine, the backup includes these credentials, which you defined during the database setup on that machine.
									







						Installing this scenario requires four steps:
					
	
								Setting up the New Data Warehouse Machine
							
	
								Stopping the Data Warehouse service on the Manager machine
							
	
								Configuring the new Data Warehouse machine
							
	
								Disabling the Data Warehouse package on the Manager machine
							


Setting up the New Data Warehouse Machine




							Enable the Red Hat Virtualization repositories and install the Data Warehouse setup package on a Red Hat Enterprise Linux 8 machine:
						
	
									Enable the required repositories:
								
	
											Register your system with the Content Delivery Network, entering your Customer Portal user name and password when prompted:
										
# subscription-manager register

	
											Find the Red Hat Virtualization Manager subscription pool and record the pool ID:
										
# subscription-manager list --available

	
											Use the pool ID to attach the subscription to the system:
										
# subscription-manager attach --pool=pool_id

	
											Configure the repositories:
										
# subscription-manager repos \
    --disable='*' \
    --enable=rhel-8-for-x86_64-baseos-eus-rpms \
    --enable=rhel-8-for-x86_64-appstream-eus-rpms \
    --enable=rhv-4.4-manager-for-rhel-8-x86_64-rpms \
    --enable=fast-datapath-for-rhel-8-x86_64-rpms \
    --enable=jb-eap-7.4-for-rhel-8-x86_64-rpms

# subscription-manager release --set=8.6




	
									Enable the pki-deps module.
								
# dnf module -y enable pki-deps

	
									Ensure that all packages currently installed are up to date:
								
# dnf upgrade --nobest

	
									Install the ovirt-engine-dwh-setup package:
								
# dnf install ovirt-engine-dwh-setup




Stopping the Data Warehouse Service on the Manager Machine



Procedure
	
									Stop the Data Warehouse service:
								
# systemctl stop ovirt-engine-dwhd.service

	
									If the database is hosted on a remote machine, you must manually grant access by editing the postgres.conf file. Edit the /var/lib/pgsql/data/postgresql.conf file and modify the listen_addresses line so that it matches the following:
								
listen_addresses = '*'

									If the line does not exist or has been commented out, add it manually.
								

									If the database is hosted on the Manager machine and was configured during a clean setup of the Red Hat Virtualization Manager, access is granted by default.
								

	
									Restart the postgresql service:
								
# systemctl restart postgresql




Configuring the New Data Warehouse Machine




							The order of the options or settings shown in this section may differ depending on your environment.
						
	
									If you are migrating both the ovirt_engine_history database and the Data Warehouse service to the same machine, run the following, otherwise proceed to the next step.
								
# sed -i '/^ENGINE_DB_/d' \
        /etc/ovirt-engine-dwh/ovirt-engine-dwhd.conf.d/10-setup-database.conf

# sed -i \
     -e 's;^\(OVESETUP_ENGINE_CORE/enable=bool\):True;\1:False;' \
     -e '/^OVESETUP_CONFIG\/fqdn/d' \
     /etc/ovirt-engine-setup.conf.d/20-setup-ovirt-post.conf

	
									Remove the apache/grafana PKI files, so that they are regenerated by engine-setup with correct values:
								
# rm -f \
  /etc/pki/ovirt-engine/certs/apache.cer \
  /etc/pki/ovirt-engine/certs/apache-grafana.cer \
  /etc/pki/ovirt-engine/keys/apache.key.nopass \
  /etc/pki/ovirt-engine/keys/apache-grafana.key.nopass \
  /etc/pki/ovirt-engine/apache-ca.pem \
  /etc/pki/ovirt-engine/apache-grafana-ca.pem

	
									Run the engine-setup command to begin configuration of Data Warehouse on the machine:
								
# engine-setup

	
									Press Enter to accept the automatically detected host name, or enter an alternative host name and press Enter:
								
Host fully qualified DNS name of this server [autodetected host name]:

	
									Press Enter to automatically configure the firewall, or type No and press Enter to maintain existing settings:
								
Setup can automatically configure the firewall on this system.
Note: automatic configuration of the firewall may overwrite current settings.
Do you want Setup to configure the firewall? (Yes, No) [Yes]:

									If you choose to automatically configure the firewall, and no firewall managers are active, you are prompted to select your chosen firewall manager from a list of supported options. Type the name of the firewall manager and press Enter. This applies even in cases where only one option is listed.
								

	
									Enter the fully qualified domain name and password for the Manager. Press Enter to accept the default values in each other field:
								
Host fully qualified DNS name of the engine server []: engine-fqdn
Setup needs to do some actions on the remote engine server. Either automatically, using ssh as root to access it, or you will be prompted to manually perform each such action.
Please choose one of the following:
1 - Access remote engine server using ssh as root
2 - Perform each action manually, use files to copy content around
(1, 2) [1]:
ssh port on remote engine server [22]:
root password on remote engine server engine-fqdn: password

	
									Enter the FQDN and password for the Manager database machine. Press Enter to accept the default values in each other field:
								
Engine database host []: manager-db-fqdn
Engine database port [5432]:
Engine database secured connection (Yes, No) [No]:
Engine database name [engine]:
Engine database user [engine]:
Engine database password: password

	
									Confirm your installation settings:
								
Please confirm installation settings (OK, Cancel) [OK]:




							The Data Warehouse service is now configured on the remote machine. Proceed to disable the Data Warehouse service on the Manager machine.
						

Disabling the Data Warehouse Service on the Manager Machine



Prerequisites
	
									The Grafana service on the Manager machine is disabled:
								
# systemctl disable --now grafana-server.service



Procedure
	
									On the Manager machine, restart the Manager:
								
# service ovirt-engine restart

	
									Run the following command to modify the file /etc/ovirt-engine-setup.conf.d/20-setup-ovirt-post.conf and set the options to False:
								
# sed -i \
     -e 's;^\(OVESETUP_DWH_CORE/enable=bool\):True;\1:False;' \
     -e 's;^\(OVESETUP_DWH_CONFIG/remoteEngineConfigured=bool\):True;\1:False;' \
     /etc/ovirt-engine-setup.conf.d/20-setup-ovirt-post.conf

# sed -i \
     -e 's;^\(OVESETUP_GRAFANA_CORE/enable=bool\):True;\1:False;' \
     /etc/ovirt-engine-setup.conf.d/20-setup-ovirt-post.conf

	
									Disable the Data Warehouse service:
								
# systemctl disable ovirt-engine-dwhd.service

	
									Remove the Data Warehouse files:
								
# rm -f /etc/ovirt-engine-dwh/ovirt-engine-dwhd.conf.d/*.conf /var/lib/ovirt-engine-dwh/backups/*




							The Data Warehouse service is now hosted on a separate machine from the Manager.
						



Backing Up and Restoring Virtual Machines Using a Backup Storage Domain



Backup storage domains explained




						A backup storage domain is one that you can use specifically for storing and migrating virtual machines and virtual machine templates for the purpose of backing up and restoring for disaster recovery, migration, or any other backup/restore usage model. A backup domain differs from a non-backup domain in that all virtual machines on a backup domain are in a powered-down state. A virtual machine cannot run on a backup domain.
					

						You can set any data storage domain to be a backup domain. You can enable or disable this setting by selecting or deselecting a checkbox in the Manage Domain dialog box. You can enable this setting only after all virtual machines on that storage domain are stopped.
					

						You cannot start a virtual machine stored on a backup domain. The Manager blocks this and any other operation that might invalidate the backup. However, you can run a virtual machine based on a template stored on a backup domain if the virtual machine’s disks are not part of a backup domain.
					

						As with other types of storage domains, you can attach or detach backup domains to or from a data center. So, in addition to storing backups, you can use backup domains to migrate virtual machines between data centers.
					
Advantages

							Some reasons to use a backup domain, rather than an export domain, are listed here:
						
	
								You can have multiple backup storage domains in a data center, as opposed to only one export domain.
							
	
								You can dedicate a backup storage domain to use for backup and disaster recovery.
							
	
								You can transfer a backup of a virtual machine, a template, or a snapshot to a backup storage domain
							
	
								Migrating a large number of virtual machines, templates, or OVF files is significantly faster with backup domains than export domains.
							
	
								A backup domain uses disk space more efficiently than an export domain.
							
	
								Backup domains support both file storage (NFS, Gluster) and block storage (Fiber Channel and iSCSI). This contrasts with export domains, which only support file storage.
							
	
								You can dynamically enable and disable the backup setting for a storage domain, taking into account the restrictions.
							


Restrictions
	
								Any virtual machine or template on a _backup domain must have all its disks on that same domain.
							
	
								All virtual machines on a storage domain must be powered down before you can set it to be a backup domain.
							
	
								You cannot run a virtual machine that is stored on a backup domain, because doing so might manipulate the disk’s data.
							
	
								A backup domain cannot be the target of memory volumes because memory volumes are only supported for active virtual machines.
							
	
								You cannot preview a virtual machine on a backup domain.
							
	
								Live migration of a virtual machine to a backup domain is not possible.
							
	
								You cannot set a backup domain to be the master domain.
							
	
								You cannot set a Self-hosted engine’s domain to be a backup domain.
							
	
								Do not use the default storage domain as a backup domain.
							



Setting a data storage domain to be a backup domain



Prerequisites
	
								All disks belonging to a virtual machine or template on the storage domain must be on the same domain.
							
	
								All virtual machines on the domain must be powered down.
							


Procedure
	
								In the Administration Portal, select Storage → Domains.
							
	
								Create a new storage domain or select an existing storage domain and click Manage Domain. The Manage Domains dialog box opens.
							
	
								Under Advanced Parameters, select the Backup checkbox.
							



						The domain is now a backup domain.
					

Backing up or Restoring a Virtual Machine or Snapshot Using a Backup Domain




						You can back up a powered down virtual machine or snapshot. You can then store the backup on the same data center and restore it as needed, or migrate it to another data center.
					
Procedure: Backing Up a Virtual Machine
	
								Create a backup domain. See Setting a storage domain to be a backup domain backup domain.
							
	
								Create a new virtual machine based on the virtual machine you want to back up:
							
	
										To back up a snapshot, first create a virtual machine from a snapshot. See Creating a Virtual Machine from a Snapshot in the Virtual Machine Management Guide.
									
	
										To back up a virtual machine, first clone the virtual machine. See Cloning a Virtual Machine in the Virtual Machine Management Guide. Make sure the clone is powered down before proceeding.
									



	
								Export the new virtual machine to a backup domain. See Exporting a Virtual Machine to a Data Domain in the Virtual Machine Management Guide.
							


Procedure: Restoring a Virtual Machine
	
								Make sure that the backup storage domain that stores the virtual machine backup is attached to a data center.
							
	
								Import the virtual machine from the backup domain. See Importing Virtual Machines from a Data Domain.
							


Related information
	
								Importing storage domains
							
	
								Migrating storage domains between data centers in same environment
							
	
								Migrating storage domains between data centers in different environments
							




Backing Up and Restoring Virtual Machines Using the Backup and Restore API



The Backup and Restore API




						The backup and restore API is a collection of functions that allows you to perform full or file-level backup and restoration of virtual machines. The API combines several components of Red Hat Virtualization, such as live snapshots and the REST API, to create and work with temporary volumes that can be attached to a virtual machine containing backup software provided by an independent software provider.
					

						For supported third-party backup vendors, consult the Red Hat Virtualization Ecosystem.
					

Backing Up a Virtual Machine




						Use the backup and restore API to back up a virtual machine. This procedure assumes you have two virtual machines: the virtual machine to back up, and a virtual machine on which the software for managing the backup is installed.
					
Procedure
	
								Using the REST API, create a snapshot of the virtual machine to back up:
							
POST /api/vms/{vm:id}/snapshots/ HTTP/1.1
Accept: application/xml
Content-type: application/xml

<snapshot>
    <description>BACKUP</description>
</snapshot>
Note
	
											Here, replace {vm:id} with the VM ID of the virtual machine whose snapshot you are making. This ID is available from the General tab of the New Virtual Machine and Edit Virtual Machine windows in the Administration Portal and VM Portal.
										
	
											Taking a snapshot of a virtual machine stores its current configuration data in the data attribute of the configuration attribute in initialization under the snapshot.
										



Important

									You cannot take snapshots of disks marked as shareable or based on direct LUN disks.
								


	
								Retrieve the configuration data of the virtual machine from the data attribute under the snapshot:
							
GET /api/vms/{vm:id}/snapshots/{snapshot:id} HTTP/1.1
All-Content: true
Accept: application/xml
Content-type: application/xml
Note
	
											Here, replace {vm:id} with the ID of the virtual machine whose snapshot you made earlier. Replace {snapshot:id} with the snapshot ID.
										
	
											Add the All-Content: true header to retrieve additional OVF data in the response. The OVF data in the XML response is located within the VM configuration element, <initialization><configuration>. Later, you will use this data to restore the virtual machine.
										




	
								Get the snapshot ID:
							
GET /api/vms/{vm:id}/snapshots/ HTTP/1.1
Accept: application/xml
Content-type: application/xml

	
								Identify the disk ID of the snapshot:
							
GET /api/vms/{vm:id}/snapshots/{snapshot:id}/disks HTTP/1.1
Accept: application/xml
Content-type: application/xml

	
								Attach the snapshot to a backup virtual machine as an active disk attachment, with the correct interface type (for example, virtio_scsi):
							
POST /api/vms/{vm:id}/diskattachments/ HTTP/1.1
Accept: application/xml
Content-type: application/xml

<disk_attachment>
	<active>true</active>
	<interface>_virtio_scsi_</interface>
	<disk id="{disk:id}">
	<snapshot id="{snapshot:id}"/>
	</disk>
</disk_attachment>
Note

									Here, replace {vm:id} with the ID of the backup virtual machine, not the virtual machine whose snapshot you made earlier. Replace {disk:id} with the disk ID. Replace {snapshot:id} with the snapshot ID.
								


	
								Use the backup software on the backup virtual machine to back up the data on the snapshot disk.
							
	
								Remove the snapshot disk attachment from the backup virtual machine:
							
DELETE /api/vms/{vm:id}/diskattachments/{snapshot:id} HTTP/1.1
Accept: application/xml
Content-type: application/xml
Note

									Here, replace {vm:id} with the ID of the backup virtual machine, not the virtual machine whose snapshot you made earlier. Replace {snapshot:id} with the snapshot ID.
								


	
								Optionally, delete the snapshot:
							
DELETE /api/vms/{vm:id}/snapshots/{snapshot:id} HTTP/1.1
Accept: application/xml
Content-type: application/xml
Note

									Here, replace {vm:id} with the ID of the virtual machine whose snapshot you made earlier. Replace {snapshot:id} with the snapshot ID.
								





						You have backed up the state of a virtual machine at a fixed point in time using backup software installed on a separate virtual machine.
					

Restoring a Virtual Machine




						Restore a virtual machine that has been backed up using the backup and restore API. This procedure assumes you have a backup virtual machine on which the software used to manage the previous backup is installed.
					
Procedure
	
								In the Administration Portal, create a floating disk on which to restore the backup. See Creating a Virtual Disk for details on how to create a floating disk.
							
	
								Attach the disk to the backup virtual machine:
							
POST /api/vms/{vm:id}/disks/ HTTP/1.1
Accept: application/xml
Content-type: application/xml

<disk id="{disk:id}">
</disk>
Note

									Here, replace {vm:id} with the ID of this backup virtual machine, not the virtual machine whose snapshot you made earlier. Replace {disk:id} with the disk ID you got while backing up the virtual machine.
								


	
								Use the backup software to restore the backup to the disk.
							
	
								Detach the disk from the backup virtual machine:
							
DELETE /api/vms/{vm:id}/disks/{disk:id} HTTP/1.1
Accept: application/xml
Content-type: application/xml

<action>
    <detach>true</detach>
</action>
Note

									Here, replace {vm:id} with the ID of this backup virtual machine, not the virtual machine whose snapshot you made earlier. Replace {disk:id} with the disk ID.
								


	
								Create a new virtual machine using the configuration data of the virtual machine being restored:
							
POST /api/vms/ HTTP/1.1
Accept: application/xml
Content-type: application/xml

<vm>
    <cluster>
        <name>cluster_name</name>
    </cluster>
    <name>_NAME_</name>
      <initialization>
      <configuration>
  <data>
  <!-- omitting long ovf data -->
  </data>
      <type>ovf</type>
      </configuration>
      </initialization>
    ...
</vm>
Note

									To override any of the values in the ovf while creating the virtual machine, redefine the element before or after the initialization element. Not within the initialization element.
								


	
								Attach the disk to the new virtual machine:
							
POST /api/vms/{vm:id}/disks/ HTTP/1.1
Accept: application/xml
Content-type: application/xml

<disk id="{disk:id}">
</disk>
Note

									Here, replace {vm:id} with the ID of the new virtual machine, not the virtual machine whose snapshot you made earlier. Replace {disk:id} with the disk ID.
								





						You have restored a virtual machine using a backup that was created using the backup and restore API.
					


Backing Up and Restoring Virtual Machines Using the Incremental Backup and Restore API



Incremental Backup and Restore API




						Red Hat Virtualization provides an Incremental Backup API that you can use for full backups of QCOW2 or RAW virtual disks, or incremental backups of QCOW 2 virtual disks, without any temporary snapshots. Data is backed-up in RAW format, whether the virtual disk being backed up is QCOW2 or RAW. You can restore RAW guest data and either RAW or QCOW2 disks. The Incremental Backup API is part of the RHV REST API. You can backup virtual machines that are running or that are not.
					

						As a developer, you can use the API to develop a backup application.
					
Features

							Backups are simpler, faster and more robust than when using the Backup and Restore API. The Incremental Backup API provides improved integration with backup applications, with new support for backing up and restoring RAW guest data, regardless of the underlying disk format.
						

						If an invalid bitmap causes a backup to fail, you can remove a specific checkpoint in the backup chain. You do not need to run a full backup.
					
Limitations:
	
								Only disks in QCOW2 format can be backed up incrementally, not RAW format disks. The backup process saves the backed up data in RAW format.
							
	
								Only backed up data in RAW format can be restored.
							
	
								Incremental restore does not support restoring snapshots as they existed at the time of the backup, rather incremental restore restores only the data and not the structure of volumes or images in snapshots as they existed at the time of the backup. This limit is common in backup solutions for other systems.
							
	
								As is commonly the case with backup solutions, incremental restore restores only the data and not the structure of volumes or images in snapshots as they existed at the time of the backup.
							
	
								An unclean shutdown of a virtual machine, whatever the cause, might invalidate bitmaps on the disk, which invalidates the entire backup chain. Restoring an incremental backup using an invalid bitmap leads to corrupt virtual machine data.
							

								There is no way to detect an invalid bitmap, other than starting a backup. If the disk includes any invalid bitmaps, the operation fails.
							




						The following table describes the disk configurations that support incremental backup.
					
Note

							When you create a disk using the Administration portal, you set the storage type, provisioning type, and whether incremental backup is enabled or disabled. Based on these settings, the Manager determines the virtual disk format.
						

Table 3.1. Supported disk configurations for incremental backup
	Storage type	Provisioning type	When incremental backup is…​	Virtual disk format is…​
	 
										block
									

									 	 
										thin
									

									 	 
										enabled
									

									 	 
										qcow2
									

									 
	 
										block
									

									 	 
										preallocated
									

									 	 
										enabled
									

									 	 
										qcow2 (preallocated)
									

									 
	 
										file
									

									 	 
										thin
									

									 	 
										enabled
									

									 	 
										qcow2
									

									 
	 
										file
									

									 	 
										preallocated
									

									 	 
										enabled
									

									 	 
										qcow2 (preallocated)
									

									 
	 
										block
									

									 	 
										thin
									

									 	 
										disabled
									

									 	 
										qcow2
									

									 
	 
										block
									

									 	 
										preallocated
									

									 	 
										disabled
									

									 	 
										raw (preallocated)
									

									 
	 
										file
									

									 	 
										thin
									

									 	 
										disabled
									

									 	 
										raw (sparse)
									

									 
	 
										file
									

									 	 
										preallocated
									

									 	 
										disabled
									

									 	 
										raw (preallocated)
									

									 
	 
										network
									

									 	 
										Not applicable
									

									 	 
										disabled
									

									 	 
										raw
									

									 
	 
										lun
									

									 	 
										Not applicable
									

									 	 
										disabled
									

									 	 
										raw
									

									 



Incremental Backup Flow




							A backup application that uses the Incremental Backup API must follow this sequence to back up virtual machine disks that have already been enabled for incremental backup:
						
	
									The backup application uses the REST API to find virtual machine disks that should be included in the backup. Only disks in QCOW2 format are included.
								
	
									The backup application starts a full backup or an incremental backup. The API call specifies a virtual machine ID, an optional previous checkpoint ID, and a list of disks to back up. If the API call does not specify a previous checkpoint ID, a full backup begins, which includes all data in the specified disks, based on the current state of each disk.
								
	
									The engine prepares the virtual machine for backup. The virtual machine can continue running during the backup.
								
	
									The backup application polls the engine for the backup status, until the engine reports that the backup is ready to begin.
								
	
									When the backup is ready to begin, the backup application creates an image transfer object for every disk included in the backup.
								
	
									The backup application gets a list of changed blocks from ovirt-imageio for every image transfer. If a change list is not available, the backup application gets an error.
								
	
									The backup application downloads changed blocks in RAW format from ovirt-imageio and stores them in the backup media. If a list of changed blocks is not available, the backup application can fall back to copying the entire disk.
								
	
									The backup application finalizes all image transfers.
								
	
									The backup application finalizes the backup using the REST API.
								



Incremental Restore Flow




							A backup application that uses the Incremental Backup API must follow this sequence to restore virtual machine disks that have been backed up:
						
	
									The user selects a restore point based on available backups using the backup application.
								
	
									The backup application creates a new disk or a snapshot with an existing disk to hold the restored data.
								
	
									The backup application starts an upload image transfer for every disk, specifying format is raw. This enables format conversion when uploading RAW data to a QCOW2 disk.
								
	
									The backup application transfers the data included in this restore point to imageio using the API.
								
	
									The backup application finalizes the image transfers.
								



Incremental Backup and Restore API Tasks




							The Incremental Backup and Restore API is documented in the Red Hat Virtualization REST API Guide. The backup and restore flow requires the following actions.
						
	
									Enabling incremental backup on either a new or existing virtual disk:
								
	
											A new disk, using the Administration Portal
										
	
											An existing disk, using the Administration Portal
										
	
											A new or existing disk, using an API call
										



	
									Finding disks that are enabled for incremental backup
								
	
									Starting a full backup
								
	
									Starting an incremental backup
								
	
									Finalizing a backup
								
	
									Getting information about a backup
								
	
									Getting information about the disks in a backup
								
	
									Listing all checkpoints for a virtual machine
								
	
									Listing information for a specific virtual machine checkpoint
								
	
									Removing a checkpoint of a specific virtual machine
								
	
									Downloading an image transfer object to archive a backup
								
	
									Uploading an image transfer object to restore a backup
								
	
									Listing changed blocks
								
	
									Downloading and uploading changed blocks
								



Enabling Incremental Backup on a new virtual disk




							Enable incremental backup for a virtual disk to mark it as included in an incremental backup. When adding a disk, you can enable incremental backup for every disk, either with the REST API or using the Administration Portal. You can back up existing disks that are not enabled for incremental backup using full backup or in the same way you did previously.
						
Note

								The Manager does not require the disk to be enabled for it to be included in an incremental backup, but you can enable it to keep track of which disks are enabled.
							


							Because incremental backup requires disks to be formatted in QCOW2, use QCOW2 format instead of RAW format.
						
Procedure
	
									Add a new virtual disk. For more information see Creating a Virtual Disk.
								
	
									When configuring the disk, select the Enable Incremental Backup checkbox.
								


Additional resources
	
									Enabling incremental backup for a disk using the API.
								



Enabling Incremental Backup on an existing RAW virtual disk




							Because incremental backup is not supported for disks in RAW format, a QCOW2 format layer must exist on top of any RAW format disks in order to use incremental backup. Creating a snapshot generates a QCOW2 layer, enabling incremental backup on all disks that are included in the snapshot, from the point at which the snapshot is created.
						
Warning

								If the base layer of a disk uses RAW format, deleting the last snapshot and merging the top QCOW2 layer into the base layer converts the disk to RAW format, thereby disabling incremental backup if it was set. To re-enable incremental backup, you can create a new snapshot, including this disk.
							

Procedure
	
									In the Administration Portal, click Compute → Virtual Machines.
								
	
									Select a virtual machine and click the Disks tab.
								
	
									Click the Edit button. The Edit Disk dialog box opens.
								
	
									Select the Enable Incremental Backup checkbox.
								


Additional resources
	
									Enabling incremental backup for a disk using the API
								



Enabling incremental backup




							You can use a REST API request to enable incremental backup for a virtual machine’s disk.
						
Procedure
	
									Enable incremental backup for a new disk. For example, for a new disk on a virtual machine with ID 123, send this request:
								
POST /ovirt-engine/api/vms/123/diskattachments

									The request body should include backup set to incremental as part of a disk object, like this:
								
<disk_attachment>
    …​
    <disk>
       …​
       <backup>incremental</backup>
       …​
    </disk>
</disk_attachment>




							The response is:
						
<disk_attachment>
    …​
    <disk href="/ovirt-engine/api/disks/456" id="456"/>
    …​
</disk_attachment>
Additional resources
	
									DiskBackup enum in the REST API Guide for RHV
								



Finding disks that are enabled for incremental backup




							For the specified virtual machine, you can list the disks that are enabled for incremental backup, filtered according to the backup property.
						
Procedure
	
									List the disks that are attached to the virtual machine. For example, for a virtual machine with the ID 123, send this request:
								
GET /ovirt-engine/api/vms/123/diskattachments

									The response includes all disk_attachment objects, each of which includes one or more disk objects. For example:
								
<disk_attachments>
    <disk_attachment>
       …​
       <disk href="/ovirt-engine/api/disks/456" id="456"/>
       …​
    </disk_attachment>
    …​
</disk_attachments>

	
									Use the disk service to see the properties of a disk from the previous step. For example, for the disk with the ID 456, send this request:
								
GET /ovirt-engine/api/disks/456

									The response includes all properties for the disk. backup is set to none or incremental. For example:
								
<disk href="/ovirt-engine/api/disks/456" id="456">
    …​
    <backup>incremental</backup>
    …​
</disk>



Additional resources
	
									backup attribute of Disk struct
								
	
									DiskBackup enum
								



Starting a full backup




							After a full backup you can use the resulting checkpoint ID as the start point in the next incremental backup.
						

							When taking a backup of a running virtual machine, the process creates a scratch disk on the same storage domain as the disk being backed up. The backup process creates this disk to enable new data to be written to the running virtual machine during the backup. You can see this scratch disk in the Administration Portal during the backup. It is automatically deleted when the backup finishes.
						

							Starting a full backup requires a request call with a body, and includes a response.
						
Procedure
	
									Send a request specifying a virtual machine to back up. For example, specify a virtual machine with ID 123 like this:
								
POST /ovirt-engine/api/vms/123/backups

	
									In the request body, specify a disk to back up. For example, to start a full backup of a disk with ID 456, send the following request body:
								
<backup>
    <disks>
       <disk id="456" />
       …​
    </disks>
</backup>

									The response body should look similar to this:
								
<backup id="789">
    <disks>
       <disk id="456" />
       …​
       …​
    </disks>
    <status>initializing</status>
    <creation_date>
</backup>

									The response includes the following:
								
	
											The backup id
										
	
											The status of the backup, indicating that the backup is initializing.
										



	
									Poll the backup until the status is ready. The response includes to_checkpoint_id. Note this ID and use it for from_checkpoint_id in the next incremental backup.
								


Additional resources
	
									add method of the VmBackups service in the REST API Guide for RHV
								



Starting an incremental backup




							Once a full backup is completed for a given virtual disk, subsequent incremental backups that disk contain only the changes since the last backup. Use the value of to_checkpoint_id from the most recent backup as the value for from_checkpoint_id in the request body.
						

							When taking a backup of a running virtual machine, the process creates a scratch disk on the same storage domain as the disk being backed up. The backup process creates this disk to enable new data to be written to the running virtual machine during the backup. You can see this scratch disk in the Administration Portal during the backup. It is automatically deleted when the backup finishes.
						

							Starting an incremental backup or mixed backup requires a request call with a body, and includes a response.
						
Procedure
	
									Send a request specifying a virtual machine to back up. For example, specify a virtual machine with ID 123 like this:
								
POST /ovirt-engine/api/vms/123/backups

	
									In the request body, specify a disk to back up. For example, to start an incremental backup of a disk with ID 456, send the following request body:
								
<backup>
    <from_checkpoint_id>previous-checkpoint-uuid</from_checkpoint_id>
    <disks>
       <disk id="456" />
       …​
    </disks>
</backup>
Note

										In the request body, if you include a disk that is not included in the previous checkpoint, the request also runs a full backup of this disk. For example, a disk with ID 789 has not been backed up yet. To add a full backup of 789 to the above request body, send a request body like this:
									
<backup>
    <from_checkpoint_id>previous-checkpoint-uuid</from_checkpoint_id>
    <disks>
       <disk id="456" />
       <disk id="789" />
       …​
    </disks>
</backup>


									The response body should look similar to this:
								
<backup id="101112">
<from_checkpoint_id>previous-checkpoint-uuid</from_checkpoint_id>
<to_checkpoint_id>new-checkpoint-uuid</to_checkpoint_id>
    <disks>
       <disk id="456" />
       <disk id="789" />
       …​
       …​
    </disks>
    <status>initializing</status>
    <creation_date>
</backup>

									The response includes the following:
								
	
											The backup ID.
										
	
											The ID of any disk that was included in the backup.
										
	
											The status, indicating that the backup is initializing.
										



	
									Poll the backup until the status is ready. The response includes to_checkpoint_id. Note this ID and use it for from_checkpoint_id in the next incremental backup.
								


Additional resources
	
									add method of the VmBackups service in the REST API Guide for RHV.
								



Getting information about a backup




							You can get information about a backup that you can use to start a new incremental backup.
						

							The list method of the VmBackups service returns the following information about a backup:
						
	
									The ID of each disk that was backed up.
								
	
									The IDs of the start and end checkpoints of the backup.
								
	
									The ID of the disk image of the backup, for each disk included in the backup.
								
	
									The status of the backup.
								
	
									The date the backup was created.
								



							When the value of <status> is ready, the response includes <to_checkpoint_id> which should be used as the <from_checkpoint_id> in the next incremental backup and you can start downloading the disks to back up the virtual machine storage.
						
Procedure
	
									To get information about a backup with ID 456 of a virtual machine with ID 123, send a request like this:
								
GET /ovirt-engine/api/vms/456/backups/123

									The response includes the backup with ID 456, with <from_checkpoint_id> 999 and <to_checkpoint_id> 666. The disks included in the backup are referenced in the <link> element.
								
<backup id="456">
    <from_checkpoint_id>999</from_checkpoint_id>
    <to_checkpoint_id>666</to_checkpoint_id>
    <link href="/ovirt-engine/api/vms/456/backups/123/disks" rel="disks"/>
    <status>ready</status>
    <creation_date>
</backup>



Additional resources
	
									list method of the VmBackups service
								



Getting information about the disks in a backup




							You can get information about the disks that are part of the backup, including the backup mode that was used for each disk in a backup, which helps determine the mode that you use to download the backup.
						

							The list method of the VmBackupDisks service returns the following information about a backup:
						
	
									The ID and name of each disk that was backed up.
								
	
									The ID of the disk image of the backup, for each disk included in the backup.
								
	
									The disk format.
								
	
									The backup behavior supported by the disk.
								
	
									The backup type that was taken for the disk (full/incremental).
								


Procedure
	
									To get information about a backup with ID 456 of a virtual machine with ID 123, send a request like this:
								
GET /ovirt-engine/api/vms/456/backups/123/disks

									The response includes the disk with ID 789, and the ID of the disk image is 555.
								
<disks>
    <disk id="789">
        <name>vm1_Disk1</name>
        <actual_size>671744</actual_size>
        <backup>incremental</backup>
        <backup_mode>full</backup_mode>
        <format>cow</format>
        <image_id>555</image_id>
        <qcow_version>qcow2_v3</qcow_version>
        <status>locked</status>
        <storage_type>image</storage_type>
        <total_size>0</total_size>
    </disk>
</disks>



Additional resources
	
									list method of the VmBackupDisks service
								



Finalizing a backup




							Finalizing a backup ends the backup, unlocks resources, and performs cleanups. Use the finalize backup service method
						
Procedure
	
									To finalize a backup of a disk with ID 456 on a virtual machine with ID 123, send a request like this:
								
POST /vms/123/backups/456/finalize



Additional resources
	
									finalize POST in the REST API Guide.
								



Creating an image transfer object for incremental backup




							When the backup is ready to download, the backup application should create an imagetransfer object, which initiates a transfer for an incremental backup.
						

							Creating an image transfer object requires a request call with a body.
						
Procedure
	
									Send a request like this:
								
POST /ovirt-engine/api/imagetransfers

	
									In the request body, specify the following parameters:
								
	
											Disk ID.
										
	
											Backup ID.
										
	
											Direction of the disk set to download.
										
	
											Format of the disk set to raw.
										



									For example, to transfer a backup of a disk where the ID of the disk is 123 and the ID of the backup is 456, send the following request body:
								
<image_transfer>
    <disk id="123"/>
    <backup id="456"/>
    <direction>download</direction>
    <format>raw</format>
</image_transfer>



Additional resources
	
									add method for creating an imagetransfer object in the REST API Guide for RHV.
								



Creating an image transfer object for incremental restore




							To enable restoring raw data backed up using the incremental backup API to a QCOW2-formatted disk, the backup application should create an imagetransfer object.
						

							When the transfer format is raw and the underlying disk format is QCOW2, uploaded data is converted on the fly to QCOW2 format when writing to storage. Uploading data from a QCOW2 disk to a RAW disk is not supported.
						

							Creating an image transfer object requires a request call with a body.
						
Procedure
	
									Send a request like this:
								
POST /ovirt-engine/api/imagetransfers

	
									In the request body, specify the following parameters:
								
	
											Disk ID or snapshot ID.
										
	
											Direction of the disk set to upload.
										
	
											Format of the disk set to raw.
										



									For example, to transfer a backup of a disk where the ID of the disk is 123, send the following request body:
								
<image_transfer>
    <disk id="123"/>
    <direction>upload</direction>
    <format>raw</format>
</image_transfer>



Additional resources
	
									add method for creating an imagetransfer object in the REST API Guide for RHV.
								



Listing checkpoints for a virtual machine




							You can list all checkpoints for a virtual machine, including information for each checkpoint, by sending a request call.
						
Procedure
	
									Send a request specifying a virtual machine. For example, specify a virtual machine with ID 123 like this:
								
GET /vms/123/checkpoints/




							The response includes all the virtual machine checkpoints. Each checkpoint contains the following information:
						
	
									The checkpoint’s disks.
								
	
									The ID of the parent checkpoint.
								
	
									Creation date of the checkpoint.
								
	
									The virtual machine to which it belongs.
								



							For example:
						
<parent_id>, <creation_date> and the virtual machine it belongs to <vm>:
<checkpoints>
    <checkpoint id="456">
         <link href="/ovirt-engine/api/vms/vm-uuid/checkpoints/456/disks" rel="disks"/>
         <parent_id>parent-checkpoint-uuid</parent_id>
         <creation_date>xxx</creation_date>
         <vm href="/ovirt-engine/api/vms/123" id="123"/>
    </checkpoint>
</checkpoints>
Additional resources
	
									list method to list virtual machine checkpoints in the REST API Guide for RHV.
								



Listing a specific checkpoint for a virtual machine




							You can list information for a specific checkpoint for a virtual machine by sending a request call.
						
Procedure
	
									Send a request specifying a virtual machine. For example, specify a virtual machine with ID 123 and checkpoint ID 456 like this:
								
GET /vms/123/checkpoints/456




							The response includes the following information for the checkpoint:
						
	
									The checkpoint’s disks.
								
	
									The ID of the parent checkpoint.
								
	
									Creation date of the checkpoint.
								
	
									The virtual machine to which it belongs.
								



							For example:
						
<checkpoint id="456">
     <link href="/ovirt-engine/api/vms/vm-uuid/checkpoints/456/disks" rel="disks"/>
     <parent_id>parent-checkpoint-uuid</parent_id>
     <creation_date>xxx</creation_date>
     <vm href="/ovirt-engine/api/vms/123" id="123"/>
</checkpoint>
Additional resources
	
									list method to list virtual machine checkpoints in the REST API Guide for RHV.
								



Removing a checkpoint




							You can remove a checkpoint of a virtual machine by sending a DELETE request. You can remove a checkpoint on a virtual machine whether it is running or not.
						
Procedure
	
									Send a request specifying a virtual machine and a checkpoint. For example, specify a virtual machine with ID 123 and a checkpoint with ID 456 like this:
								
DELETE /vms/123/checkpoints/456/



Additional resources
	
									remove method of VmCheckpoint
								



Using the imageio API to transfer backup data




							Image transfer APIs start and stop an image transfer. The result is a transfer URL.
						

							You use the imageio API to actually transfer the data from the transfer URL.
						

							For complete information on using the imageio API, see the ovirt-imageio Images API reference.
						
Table 3.2. imageio Image API methods used in incremental backup and restore
	API request	Description	imageio Image API reference section
	 
											OPTIONS /images/{ticket-id} HTTP/1.1
										

										 	 
											Gets the server options, to find out what features the server supports.
										

										 	 
											See OPTIONS
										

										 
	 
											GET /images/{ticket-id}/extents
										

										 	 
											Gets information about disk image content and allocation, or about blocks that changed during an incremental backup. This information is known as extent information.
										

										 	 
											See EXTENTS
										

										 
	 
											GET /images/{ticket-id}/extent?context=dirty
										

										 	 
											The program doing image transfer needs to download changes from the backup. These changes are know as dirty extents. To download changes, send a request like this:
										

										 	 
											See EXTENTS→ Examples→ Request dirty extents
										

										 
	 
											PUT /images/{ticket-id}
										

										 	 
											The backup application creates a new disk or a snapshot with an existing disk to hold the restored data.
										

										 	 
											See PUT
										

										 



Additional resources

								The Red Hat Virtualization Python SDK includes several implementation examples you can use to get started with transferring backups:
							
	
									ovirt-imageio Images API reference
								
	
									Creating a disk
								
	
									Calling imagetransfer.create_transfer()
								
	
									a helper to simplify creating a transfer
								
	
									Using the Red Hat Virtualization Python SDK
								






Setting up errata viewing with Red Hat Satellite




				In the Administration Portal, you can configure Red Hat Virtualization to view errata from Red Hat Satellite in the Red Hat Virtualization Manager. After you associate your hosts, virtual machines, and the Manager with a Red Hat Satellite provider, you can receive updates about available errata and their importance, and decide when to apply them. For more information about Red Hat Satellite see the Red Hat Satellite Documentation.
			

				Red Hat Virtualization 4.4 supports viewing errata with Red Hat Satellite 6.6.
			
Prerequisites
	
						The Satellite server must be added as an external provider.
					
	
						The Manager, hosts, and virtual machines must all be registered in the Satellite server by their respective FQDNs. This ensures that external content host IDs do not need to be maintained in Red Hat Virtualization.
					
	
						The Satellite account that manages the Manager, hosts and virtual machines must have Administrator permissions and a default organization set.
					


Note

					The Katello agent is deprecated and will be removed in a future Satellite version. Migrate your processes to use the remote execution feature to update clients remotely.
				

Configuring Red Hat Virtualization errata

					To associate the Manager, host, and virtual machine with a Red Hat Satellite provider, complete the following tasks:
				
	
						Add the required Satellite server to the Manager as an external provider.
					
	
						Configure the required hosts to display available errata.
					
	
						Configure the required virtual machines to display available errata.
					


Viewing Red Hat Virtualization Manager errata
	
						Click Administration → Errata.
					
	
						Select the Security, Bugs, or Enhancements check boxes to view only those errata types.
					


Additional resources
	
						Configuring Satellite Errata Management for a Host
					
	
						Installing the Guest Agents, Tools, and Drivers on Linux in the Virtual Machine Management Guide for Red Hat Enterprise Linux virtual machines.
					
	
						Installing the Guest Agents, Tools, and Drivers on Windows in the Virtual Machine Management Guide for Windows virtual machines.
					
	
						Viewing Host Errata
					
	
						Configuring Satellite errata viewing for a virtual machine in the Virtual Machine Management Guide for more information.
					
	
						Viewing Red Hat Satellite errata for a virtual machine in the Virtual Machine Management Guide.
					



Renewing certificates before they expire




				In Red Hat Virtualization earlier than version 4.4 SP1, all certificates followed a 398 day lifetime. Starting in Red Hat Virtualization version 4.4 SP1, the self-signed internal certificates between hypervisors and the Manager follow a five year lifetime. Certificates visible to web browsers still follow the standard 398 day lifetime and must be renewed once per year.
			
Warning

					Do not let certificates expire. If they expire, the host and Manager stop responding, and recovery is an error-prone and time-consuming process.
				

Procedure
	
						Renew the host certificates:
					
	
								In the Administration Portal, click Compute → Hosts.
							
	
								Click Management → Maintenance and then click OK. The virtual machines should automatically migrate away from the host. If they are pinned or otherwise cannot be migrated, you must shut them down.
							
	
								When the host is in maintenance mode and there are no more virtual machines remaining on this host, click Installation → Enroll Certificate.
							
	
								When enrollment is complete, click Management → Activate.
							



	
						Renew the Manager certificates:
					
	
								Self-hosted engine only: log in to the host and put it in global maintenance mode.
							
# hosted-engine --set-maintenance --mode=global

	
								Self-hosted engine and standalone Manager: log in to the Manager and run engine-setup.
							
# engine-setup --offline

								The engine-setup script prompts you with configuration questions. Respond to the questions as appropriate or use an answers file.
							

	
								Enter Yes after the following engine-setup prompt:
							
Renew certificates? (Yes, No) [Yes]:

	
								Self-hosted engine only: log in to the host and disable global maintenance mode:
							
# hosted-engine --set-maintenance --mode=none






Additional resources
	
						How to manually renew RHV host SSL certificate if expired?
					



Automating Configuration Tasks using Ansible




				Ansible is an automation tool used to configure systems, deploy software, and perform rolling updates. Red Hat Virtualization includes a limited version of Ansible to automate RHV post-installation tasks such as data center setup and configuration, managing users, and virtual machine operations.
			

				Ansible provides an easier method of automating Red Hat Virtualization configuration compared to REST APIs and SDKs, and you can integrate with other Ansible modules. For more information about the Ansible modules available for Red Hat Virtualization, see the oVirt Ansible Collection in the Red Hat Ansible Automation Hub documentation.
			
Note

					Ansible Tower is a graphically enabled framework accessible through a web interface and REST APIs for Ansible. If you want support for Ansible Tower, then you must have an Ansible Tower license, which is not part of the Red Hat Virtualization subscription.
				


				See the Ansible documentation for alternate installation instructions, and information about using Ansible.
			
oVirt Ansible Collection




					oVirt Ansible Collection provides modules, roles, and plugins for managing various parts of the Red Hat Virtualization infrastructure. The modules are used for communication between Ansible and the Red Hat Virtualization Manager. Ansible roles provide a method of modularizing Ansible code by breaking up large playbooks into smaller reusable files that can be shared with other users. For more information about oVirt Ansible Collection, see the Automation Hub documentation.
				
Installing oVirt Ansible Collection from an RPM package




						You can install oVirt Ansible Collection for Red Hat Virtualization from the Red Hat Virtualization Manager repository.
					
Prerequisites

							To install oVirt Ansible Collection, you must subscribe to one of the following subscription channels:
						
	
								Using a Red Hat Virtualization subscription - rhv-4.4-manager-for-rhel-8-x86_64-rpms
							
	
								Using any Red Hat Enterprise Linux subscription - rhv-4-tools-for-rhel-8-x86_64-rpms
							


Procedure
	
								Run the following command to install the oVirt Ansible Collection on the Manager machine:
							
# dnf install ovirt-ansible-collection

	
								By default, the collection is installed to:
							

								/usr/share/ansible/collections/ansible_collections/redhat/rhv.
							

								The structure of the ovirt-ansible-collection package is as follows:
							

								/usr/share/ansible/collections/ansible_collections/redhat/rhv/usr/share/doc/ovirt-ansible-collection/
							




Installing oVirt Ansible Collection from Automation Hub




						Automation Hub is a new place that can be used to install oVirt Ansible Collection. To configure the environment, follow the instructions in oVirt Ansible Collection documentation.
					
Procedure
	
								Install the collection
							
# ansible-galaxy collection install redhat.rhv

	
								The Automation Hub currently does not install RPM dependencies. Make sure that you have these packages on the host where you execute the playbook:
							
	
										python3-ovirt-engine-sdk4
									
	
										python3-netaddr
									
	
										python3-jmespath
									
	
										python3-passlib
									






Using oVirt Ansible Collection to Configure Red Hat Virtualization




						The following procedure guides you through creating and running a playbook that uses oVirt Ansible Collection to configure Red Hat Virtualization. This example uses Ansible to connect to the Manager on the local machine and create a new data center.
					
Prerequisites
	
								Ensure that you have the Python SDK installed on the machine running the playbook.
							


Procedure
	
								Create your playbook.
							
- name: RHV infrastructure
  hosts: localhost
  connection: local
  gather_facts: false

  vars_files:
   # Contains variables to connect to the Manager
   - engine_vars.yml
   # Contains encrypted engine_password variable using ansible-vault
   - passwords.yml

  pre_tasks:
   # The use of redhat.rhv before ovirt_auth is to check if oVirt Ansible Collection is correctly loaded
   - name: Login to RHV
     redhat.rhv.ovirt_auth:
       hostname: "{{ engine_fqdn }}"
       username: "{{ engine_user }}"
       password: "{{ engine_password }}"
       ca_file: "{{ engine_cafile | default(omit) }}"
       insecure: "{{ engine_insecure | default(true) }}"
     tags:
       - always

 vars:
   data_center_name: mydatacenter
   data_center_description: mydatacenter
   data_center_local: false
   compatibility_version: 4.4

 roles:
   - infra
 collections:
   - redhat.rhv
 post_tasks:
   - name: Logout from RHV
     ovirt_auth:
       state: absent
       ovirt_auth: "{{ ovirt_auth }}"
     tags:
       - always




						You have successfully used the infra Ansible role from oVirt Ansible Collection to create a data center named mydatacenter.
					



Users and Roles



Introduction to Users




					In Red Hat Virtualization, there are two types of user domains: local domain and external domain. A default local domain called the internal domain and a default user admin is created during the the Manager installation process.
				

					You can create additional users on the internal domain using ovirt-aaa-jdbc-tool. User accounts created on local domains are known as local users. You can also attach external directory servers such as Red Hat Directory Server, Active Directory, OpenLDAP, and many other supported options to your Red Hat Virtualization environment and use them as external domains. User accounts created on external domains are known as directory users.
				

					Both local users and directory users need to be assigned with appropriate roles and permissions through the Administration Portal before they can function in the environment. There are two main types of user roles: end user and administrator. An end user role uses and manages virtual resources from the VM Portal. An administrator role maintains the system infrastructure using the Administration Portal. The roles can be assigned to the users for individual resources like virtual machines and hosts, or on a hierarchy of objects like clusters and data centers.
				

Introduction to Directory Servers




					During installation, Red Hat Virtualization Manager creates an admin user on the internal domain. The user is also referred to as admin@internal. This account is intended for use when initially configuring the environment and for troubleshooting. After you have attached an external directory server, added the directory users, and assigned them with appropriate roles and permissions, the admin@internal user can be disabled if it is not required.The directory servers supported are:
				
	
							389ds
						
	
							389ds RFC-2307 Schema
						
	
							Active Directory
						
	
							IBM Security Directory Server
						
	
							IBM Security Directory Server RFC-2307 Schema
						
	
							FreeIPA
						
	
							iDM
						
	
							Novell eDirectory RFC-2307 Schema
						
	
							OpenLDAP RFC-2307 Schema
						
	
							OpenLDAP Standard Schema
						
	
							Oracle Unified Directory RFC-2307 Schema
						
	
							RFC-2307 Schema (Generic)
						
	
							Red Hat Directory Server (RHDS)
						
	
							Red Hat Directory Server (RHDS) RFC-2307 Schema
						
	
							iPlanet
						


Important

						It is not possible to install Red Hat Virtualization Manager (rhevm) and IdM (ipa-server) on the same system. IdM is incompatible with the mod_ssl package, which is required by Red Hat Virtualization Manager.
					

Important

						If you are using Active Directory as your directory server, and you want to use sysprep in the creation of templates and virtual machines, then the Red Hat Virtualization administrative user must be delegated control over the Domain to:
					
	
								Join a computer to the domain
							
	
								Modify the membership of a group
							



						For information on creation of user accounts in Active Directory, see Create a New User Account.
					

						For information on delegation of control in Active Directory, see Delegate Control of an Organizational Unit.
					


Configuring an External LDAP Provider



Configuring an External LDAP Provider (Interactive Setup)



Note

							The ovirt-engine-extension-aaa-ldap is deprecated. For new installations, use Red Hat Single Sign On. For more information, see Installing and Configuring Red Hat Single Sign-On in the Administration Guide.
						


						The ovirt-engine-extension-aaa-ldap extension allows users to customize their external directory setup easily. The ovirt-engine-extension-aaa-ldap extension supports many different LDAP server types, and an interactive setup script is provided to assist you with the setup for most LDAP types.
					

						If the LDAP server type is not listed in the interactive setup script, or you want to do more customization, you can manually edit the configuration files. See Configuring an External LDAP Provider for more information.
					

						For an Active Directory example, see Attaching an Active Directory.
					
Prerequisites
	
								You must know the domain name of the DNS or the LDAP server.
							
	
								To set up secure connection between the LDAP server and the Manager, ensure that a PEM-encoded CA certificate has been prepared.
							
	
								Have at least one set of account name and password ready to perform search and login queries to the LDAP server.
							


Procedure
	
								On the Red Hat Virtualization Manager, install the LDAP extension package:
							
# dnf install ovirt-engine-extension-aaa-ldap-setup

	
								Run ovirt-engine-extension-aaa-ldap-setup to start the interactive setup:
							
# ovirt-engine-extension-aaa-ldap-setup

	
								Select an LDAP type by entering the corresponding number. If you are not sure which schema your LDAP server is, select the standard schema of your LDAP server type. For Active Directory, follow the procedure at Attaching_an_Active_Directory.
							
Available LDAP implementations:
 1 - 389ds
 2 - 389ds RFC-2307 Schema
 3 - Active Directory
 4 - IBM Security Directory Server
 5 - IBM Security Directory Server RFC-2307 Schema
 6 - IPA
 7 - Novell eDirectory RFC-2307 Schema
 8 - OpenLDAP RFC-2307 Schema
 9 - OpenLDAP Standard Schema
10 - Oracle Unified Directory RFC-2307 Schema
11 - RFC-2307 Schema (Generic)
12 - RHDS
13 - RHDS RFC-2307 Schema
14 - iPlanet
Please select:

	
								Press Enter to accept the default and configure domain name resolution for your LDAP server name:
							
It is highly recommended to use DNS resolution for LDAP server.
If for some reason you intend to use hosts or plain address disable DNS usage.
Use DNS (Yes, No) [Yes]:

	
								Select a DNS policy method:
							
	
										For option 1, the DNS servers listed in /etc/resolv.conf are used to resolve the IP address. Check that the /etc/resolv.conf file is updated with the correct DNS servers.
									
	
										For option 2, enter the fully qualified domain name (FQDN) or the IP address of the LDAP server. You can use the dig command with the SRV record to find out the domain name. An SRV record takes the following format:
									
_service._protocol.domain_name

										Example: dig _ldap._tcp.redhat.com SRV.
									

	
										For option 3, enter a space-separated list of LDAP servers. Use either the FQDN or IP address of the servers. This policy provides load-balancing between the LDAP servers. Queries are distributed among all LDAP servers according to the round-robin algorithm.
									
	
										For option 4, enter a space-separated list of LDAP servers. Use either the FQDN or IP address of the servers. This policy defines the first LDAP server to be the default LDAP server to respond to queries. If the first server is not available, the query will go to the next LDAP server on the list.
									
1 - Single server
2 - DNS domain LDAP SRV record
3 - Round-robin between multiple hosts
4 - Failover between multiple hosts
Please select:




	
								Select the secure connection method your LDAP server supports and specify the method to obtain a PEM-encoded CA certificate:
							
	
										File allows you to provide the full path to the certificate.
									
	
										URL allows you to specify a URL for the certificate.
									
	
										Inline allows you to paste the content of the certificate in the terminal.
									
	
										System allows you to specify the default location for all CA files.
									
	
										Insecure skips certificate validation, but the connection is still encrypted using TLS.
									
NOTE:
It is highly recommended to use secure protocol to access the LDAP server.
Protocol startTLS is the standard recommended method to do so.
Only in cases in which the startTLS is not supported, fallback to non standard ldaps protocol.
Use plain for test environments only.
Please select protocol to use (startTLS, ldaps, plain) [startTLS]: startTLS
Please select method to obtain PEM encoded CA certificate (File, URL, Inline, System, Insecure):
Please enter the password:
Note

											LDAPS stands for Lightweight Directory Access Protocol Over Secure Socket Links. For SSL connections, select the ldaps option.
										





	
								Enter the search user distinguished name (DN). The user must have permissions to browse all users and groups on the directory server. The search user must be specified in LDAP annotation. If anonymous search is allowed, press Enter without any input.
							
Enter search user DN (for example uid=username,dc=example,dc=com or leave empty for anonymous): uid=user1,ou=Users,ou=department-1,dc=example,dc=com
Enter search user password:

	
								Enter the base DN:
							
Please enter base DN (dc=redhat,dc=com) [dc=redhat,dc=com]: ou=department-1,dc=redhat,dc=com

	
								Select Yes if you intend to configure single sign-on for virtual machines. Note that the feature cannot be used with single sign-on to the Administration Portal feature. The script reminds you that the profile name must match the domain name. You will still need to follow the instructions in Configuring Single Sign-On for Virtual Machines in the Virtual Machine Management Guide.
							
Are you going to use Single Sign-On for Virtual Machines (Yes, No) [Yes]:

	
								Specify a profile name. The profile name is visible to users on the login page. This example uses redhat.com.
							
Note

									To rename the profile after the domain has been configured, edit the ovirt.engine.aaa.authn.profile.name attribute in the /etc/ovirt-engine/extensions.d/redhat.com-authn.properties file. Restart the ovirt-engine service for the changes to take effect.
								

Please specify profile name that will be visible to users: redhat.com
Figure 3.1. The Administration Portal Login Page
[image: Administration Portal Login Page]


Note

									Users must select the profile from the drop-down list when logging in for the first time. The information is stored in browser cookies and preselected the next time the user logs in.
								


	
								Test the login function to ensure your LDAP server is connected to your Red Hat Virtualization environment properly. For the login query, enter your user name and password:
							
NOTE:
It is highly recommended to test drive the configuration before applying it into engine.
Login sequence is executed automatically, but it is recommended to also execute Search sequence manually after successful Login sequence.

Please provide credentials to test login flow:
Enter user name:
Enter user password:
[ INFO  ] Executing login sequence…​
…​
[ INFO  ] Login sequence executed successfully

	
								Check that the user details are correct. If the user details are incorrect, select Abort:
							
Please make sure that user details are correct and group membership meets expectations (search for PrincipalRecord and GroupRecord titles).
Abort if output is incorrect.
Select test sequence to execute (Done, Abort, Login, Search) [Abort]:

	
								Manually testing the Search function is recommended. For the search query, select Principal for user accounts or Group for group accounts. Select Yes to Resolve Groups if you want the group account information for the user account to be returned. Three configuration files are created and displayed in the screen output.
							
Select test sequence to execute (Done, Abort, Login, Search) [Search]: Search
Select entity to search (Principal, Group) [Principal]:
Term to search, trailing '*' is allowed: testuser1
Resolve Groups (Yes, No) [No]:

	
								Select Done to complete the setup:
							
Select test sequence to execute (Done, Abort, Login, Search) [Abort]: Done
[ INFO  ] Stage: Transaction setup
[ INFO  ] Stage: Misc configuration
[ INFO  ] Stage: Package installation
[ INFO  ] Stage: Misc configuration
[ INFO  ] Stage: Transaction commit
[ INFO  ] Stage: Closing up
CONFIGURATION SUMMARY
Profile name is: redhat.com
The following files were created:
    /etc/ovirt-engine/aaa/redhat.com.properties
    /etc/ovirt-engine/extensions.d/redhat.com.properties
    /etc/ovirt-engine/extensions.d/redhat.com-authn.properties
[ INFO  ] Stage: Clean up
Log file is available at /tmp/ovirt-engine-extension-aaa-ldap-setup-20171004101225-mmneib.log:
[ INFO  ] Stage: Pre-termination
[ INFO  ] Stage: Termination

	
								Restart the ovirt-engine service. The profile you have created is now available on the Administration Portal and the VM Portal login pages. To assign the user accounts on the LDAP server appropriate roles and permissions, for example, to log in to the VM Portal, see Manager User Tasks.
							
# systemctl restart ovirt-engine.service



Note

							For more information, see the LDAP authentication and authorization extension README file at /usr/share/doc/ovirt-engine-extension-aaa-ldap-version.
						


Attaching an Active Directory



Note

							The ovirt-engine-extension-aaa-ldap is deprecated. For new installations, use Red Hat Single Sign On. For more information, see Installing and Configuring Red Hat Single Sign-On in the Administration Guide.
						

Prerequisites
	
								You need to know the Active Directory forest name. The forest name is also known as the root domain name.
							
Note

									Examples of the most common Active Directory configurations, which cannot be configured using the ovirt-engine-extension-aaa-ldap-setup tool, are provided in /usr/share/ovirt-engine-extension-aaa-ldap/examples/README.md.
								


	
								You need to either add the DNS server that can resolve the Active Directory forest name to the /etc/resolv.conf file on the Manager, or note down the Active Directory DNS servers and enter them when prompted by the interactive setup script.
							
	
								To set up secure connection between the LDAP server and the Manager, ensure a PEM-encoded CA certificate has been prepared. See Setting Up SSL or TLS Connections between the Manager and an LDAP Server for more information.
							
	
								Unless anonymous search is supported, a user with permissions to browse all users and groups must be available on the Active Directory to be used as the search user. Note down the search user’s distinguished name (DN). Do not use the administrative user for the Active Directory.
							
	
								You must have at least one account name and password ready to perform search and login queries to the Active Directory.
							
	
								If your Active Directory deployment spans multiple domains, be aware of the limitation described in the /usr/share/ovirt-engine-extension-aaa-ldap/profiles/ad.properties file.
							


Procedure
	
								On the Red Hat Virtualization Manager, install the LDAP extension package:
							
# dnf install ovirt-engine-extension-aaa-ldap-setup

	
								Run ovirt-engine-extension-aaa-ldap-setup to start the interactive setup:
							
# ovirt-engine-extension-aaa-ldap-setup

	
								Select an LDAP type by entering the corresponding number. The LDAP-related questions after this step are different for different LDAP types.
							
Available LDAP implementations:
 1 - 389ds
 2 - 389ds RFC-2307 Schema
 3 - Active Directory
 4 - IBM Security Directory Server
 5 - IBM Security Directory Server RFC-2307 Schema
 6 - IPA
 7 - Novell eDirectory RFC-2307 Schema
 8 - OpenLDAP RFC-2307 Schema
 9 - OpenLDAP Standard Schema
10 - Oracle Unified Directory RFC-2307 Schema
11 - RFC-2307 Schema (Generic)
12 - RHDS
13 - RHDS RFC-2307 Schema
14 - iPlanet
Please select: 3

	
								Enter the Active Directory forest name. If the forest name is not resolvable by your Manager’s DNS, the script prompts you to enter a space-separated list of Active Directory DNS server names.
							
Please enter Active Directory Forest name: ad-example.redhat.com
[ INFO  ] Resolving Global Catalog SRV record for ad-example.redhat.com
[ INFO  ] Resolving LDAP SRV record for ad-example.redhat.com

	
								Select the secure connection method your LDAP server supports and specify the method to obtain a PEM-encoded CA certificate. The file option allows you to provide the full path to the certificate. The URL option allows you to specify a URL to the certificate. Use the inline option to paste the content of the certificate in the terminal. The system option allows you to specify the location for all CA files. The insecure option allows you to use startTLS in insecure mode.
							
NOTE:
It is highly recommended to use secure protocol to access the LDAP server.
Protocol startTLS is the standard recommended method to do so.
Only in cases in which the startTLS is not supported, fallback to non standard ldaps protocol.
Use plain for test environments only.
Please select protocol to use (startTLS, ldaps, plain) [startTLS]: startTLS
Please select method to obtain PEM encoded CA certificate (File, URL, Inline, System, Insecure): File
Please enter the password:
Note

									LDAPS stands for Lightweight Directory Access Protocol Over Secure Socket Links. For SSL connections, select the ldaps option.
								

									For more information on creating a PEM-encoded CA certificate, see Setting Up SSL or TLS Connections between the Manager and an LDAP Server.
								


	
								Enter the search user distinguished name (DN). The user must have permissions to browse all users and groups on the directory server. The search user must be of LDAP annotation. If anonymous search is allowed, press Enter without any input.
							
Enter search user DN (empty for anonymous): cn=user1,ou=Users,dc=test,dc=redhat,dc=com
Enter search user password:

	
								Specify whether to use single sign-on for virtual machines. This feature is enabled by default, but cannot be used if single sign-on to the Administration Portal is enabled. The script reminds you that the profile name must match the domain name. You will still need to follow the instructions in Configuring Single Sign-On for Virtual Machines in the Virtual Machine Management Guide.
							
Are you going to use Single Sign-On for Virtual Machines (Yes, No) [Yes]:

	
								Specify a profile name. The profile name is visible to users on the login page. This example uses redhat.com.
							
Please specify profile name that will be visible to users:redhat.com
Figure 3.2. The Administration Portal Login Page
[image: Administration Portal Login Page]


Note

									Users need to select the desired profile from the drop-down list when logging in for the first time. The information is then stored in browser cookies and preselected the next time the user logs in.
								


	
								Test the search and login function to ensure your LDAP server is connected to your Red Hat Virtualization environment properly. For the login query, enter the account name and password. For the search query, select Principal for user accounts, and select Group for group accounts. Enter Yes to Resolve Groups if you want the group account information for the user account to be returned. Select Done to complete the setup. Three configuration files are created and displayed in the screen output.
							
NOTE:
It is highly recommended to test drive the configuration before applying it into engine.
Login sequence is executed automatically, but it is recommended to also execute Search sequence manually after successful Login sequence.
Select test sequence to execute (Done, Abort, Login, Search) [Abort]: Login
Enter search user name: testuser1
Enter search user password:
[ INFO  ] Executing login sequence...
...
Select test sequence to execute (Done, Abort, Login, Search) [Abort]: Search
Select entity to search (Principal, Group) [Principal]:
Term to search, trailing '*' is allowed: testuser1
Resolve Groups (Yes, No) [No]:
[ INFO  ] Executing login sequence...
...
Select test sequence to execute (Done, Abort, Login, Search) [Abort]: Done
[ INFO  ] Stage: Transaction setup
[ INFO  ] Stage: Misc configuration
[ INFO  ] Stage: Package installation
[ INFO  ] Stage: Misc configuration
[ INFO  ] Stage: Transaction commit
[ INFO  ] Stage: Closing up
          CONFIGURATION SUMMARY
          Profile name is: redhat.com
          The following files were created:
              /etc/ovirt-engine/aaa/redhat.com.properties
              /etc/ovirt-engine/extensions.d/redhat.com-authz.properties
              /etc/ovirt-engine/extensions.d/redhat.com-authn.properties
[ INFO  ] Stage: Clean up
          Log file is available at /tmp/ovirt-engine-extension-aaa-ldap-setup-20160114064955-1yar9i.log:
[ INFO  ] Stage: Pre-termination
[ INFO  ] Stage: Termination

	
								The profile you have created is now available on the Administration Portal and the VM Portal login pages. To assign the user accounts on the LDAP server appropriate roles and permissions, for example, to log in to the VM Portal, see Manager User Tasks.
							


Note

							For more information, see the LDAP authentication and authorization extension README file at /usr/share/doc/ovirt-engine-extension-aaa-ldap-version.
						


Configuring an External LDAP Provider (Manual Method)



Note

							The ovirt-engine-extension-aaa-ldap is deprecated. For new installations, use Red Hat Single Sign On. For more information, see Installing and Configuring Red Hat Single Sign-On in the Administration Guide.
						


						The ovirt-engine-extension-aaa-ldap extension uses the LDAP protocol to access directory servers and is fully customizable. Kerberos authentication is not required unless you want to enable the single sign-on to the VM Portal or the Administration Portal feature.
					

						If the interactive setup method in the previous section does not cover your use case, you can manually modify the configuration files to attach your LDAP server. The following procedure uses generic details. Specific values depend on your setup.
					
Procedure
	
								On the Red Hat Virtualization Manager, install the LDAP extension package:
							
# dnf install ovirt-engine-extension-aaa-ldap

	
								Copy the LDAP configuration template file into the /etc/ovirt-engine directory. Template files are available for active directories (ad) and other directory types (simple). This example uses the simple configuration template.
							
# cp -r /usr/share/ovirt-engine-extension-aaa-ldap/examples/simple/. /etc/ovirt-engine

	
								Rename the configuration files to match the profile name you want visible to users on the Administration Portal and the VM Portal login pages:
							
# mv /etc/ovirt-engine/aaa/profile1.properties /etc/ovirt-engine/aaa/example.properties
# mv /etc/ovirt-engine/extensions.d/profile1-authn.properties /etc/ovirt-engine/extensions.d/example-authn.properties
# mv /etc/ovirt-engine/extensions.d/profile1-authz.properties /etc/ovirt-engine/extensions.d/example-authz.properties

	
								Edit the LDAP property configuration file by uncommenting an LDAP server type and updating the domain and passwords fields:
							
#  vi /etc/ovirt-engine/aaa/example.properties
Example 3.5. Example profile: LDAP server section
# Select one
#
include = <openldap.properties>
#include = <389ds.properties>
#include = <rhds.properties>
#include = <ipa.properties>
#include = <iplanet.properties>
#include = <rfc2307-389ds.properties>
#include = <rfc2307-rhds.properties>
#include = <rfc2307-openldap.properties>
#include = <rfc2307-edir.properties>
#include = <rfc2307-generic.properties>

# Server
#
vars.server = ldap1.company.com

# Search user and its password.
#
vars.user = uid=search,cn=users,cn=accounts,dc=company,dc=com
vars.password = 123456

pool.default.serverset.single.server = ${global:vars.server}
pool.default.auth.simple.bindDN = ${global:vars.user}
pool.default.auth.simple.password = ${global:vars.password}



								To use TLS or SSL protocol to interact with the LDAP server, obtain the root CA certificate for the LDAP server and use it to create a public keystore file. Uncomment the following lines and specify the full path to the public keystore file and the password to access the file.
							
Note

									For more information on creating a public keystore file, see Setting Up SSL or TLS Connections between the Manager and an LDAP Server.
								

Example 3.6. Example profile: keystore section
# Create keystore, import certificate chain and uncomment
# if using tls.
pool.default.ssl.startTLS = true
pool.default.ssl.truststore.file = /full/path/to/myrootca.jks
pool.default.ssl.truststore.password = password



	
								Review the authentication configuration file. The profile name visible to users on the Administration Portal and the VM Portal login pages is defined by ovirt.engine.aaa.authn.profile.name. The configuration profile location must match the LDAP configuration file location. All fields can be left as default.
							
# vi /etc/ovirt-engine/extensions.d/example-authn.properties
Example 3.7. Example authentication configuration file
ovirt.engine.extension.name = example-authn
ovirt.engine.extension.bindings.method = jbossmodule
ovirt.engine.extension.binding.jbossmodule.module = org.ovirt.engine.extension.aaa.ldap
ovirt.engine.extension.binding.jbossmodule.class = org.ovirt.engine.extension.aaa.ldap.AuthnExtension
ovirt.engine.extension.provides = org.ovirt.engine.api.extensions.aaa.Authn
ovirt.engine.aaa.authn.profile.name = example
ovirt.engine.aaa.authn.authz.plugin = example-authz
config.profile.file.1 = ../aaa/example.properties



	
								Review the authorization configuration file. The configuration profile location must match the LDAP configuration file location. All fields can be left as default.
							
# vi /etc/ovirt-engine/extensions.d/example-authz.properties
Example 3.8. Example authorization configuration file
ovirt.engine.extension.name = example-authz
ovirt.engine.extension.bindings.method = jbossmodule
ovirt.engine.extension.binding.jbossmodule.module = org.ovirt.engine.extension.aaa.ldap
ovirt.engine.extension.binding.jbossmodule.class = org.ovirt.engine.extension.aaa.ldap.AuthzExtension
ovirt.engine.extension.provides = org.ovirt.engine.api.extensions.aaa.Authz
config.profile.file.1 = ../aaa/example.properties



	
								Ensure that the ownership and permissions of the configuration profile are appropriate:
							
# chown ovirt:ovirt /etc/ovirt-engine/aaa/example.properties
# chmod 600 /etc/ovirt-engine/aaa/example.properties

	
								Restart the engine service:
							
# systemctl restart ovirt-engine.service

	
								The example profile you have created is now available on the Administration Portal and the VM Portal login pages. To give the user accounts on the LDAP server appropriate permissions, for example, to log in to the VM Portal, see Manager User Tasks.
							


Note

							For more information, see the LDAP authentication and authorization extension README file at /usr/share/doc/ovirt-engine-extension-aaa-ldap-version.
						


Removing an External LDAP Provider




						This procedure shows you how to remove an external configured LDAP provider and its users.
					
Procedure
	
								Remove the LDAP provider configuration files, replacing the default name profile1:
							
# rm /etc/ovirt-engine/extensions.d/profile1-authn.properties
# rm /etc/ovirt-engine/extensions.d/profile1-authz.properties
# rm /etc/ovirt-engine/aaa/profile1.properties

	
								Restart the ovirt-engine service:
							
# systemctl restart ovirt-engine

	
								In the Administration Portal, in the Users resource tab, select the users of this provider (those whose Authorization provider is profile1-authz) and click Remove.
							




Configuring LDAP and Kerberos for Single Sign-on




					Single sign-on allows users to log in to the VM Portal or the Administration Portal without re-typing their passwords. Authentication credentials are obtained from the Kerberos server. To configure single sign-on to the Administration Portal and the VM Portal, you need to configure two extensions: ovirt-engine-extension-aaa-misc and ovirt-engine-extension-aaa-ldap; and two Apache modules: mod_auth_gssapi and mod_session. You can configure single sign-on that does not involve Kerberos, however this is outside the scope of this documentation.
				
Note

						If single sign-on to the VM Portal is enabled, single sign-on to virtual machines is not possible. With single sign-on to the VM Portal enabled, the VM Portal does not need to accept a password, so you cannot delegate the password to sign in to virtual machines.
					


					This example assumes the following:
				
	
							The existing Key Distribution Center (KDC) server uses the MIT version of Kerberos 5.
						
	
							You have administrative rights to the KDC server.
						
	
							The Kerberos client is installed on the Red Hat Virtualization Manager and user machines.
						
	
							The kadmin utility is used to create Kerberos service principals and keytab files.
						



					This procedure involves the following components:
				
	
							On the KDC server
						
	
									Create a service principal and a keytab file for the Apache service on the Red Hat Virtualization Manager.
								



	
							On the Red Hat Virtualization Manager
						
	
									Install the authentication and authorization extension packages and the Apache Kerberos authentication module.
								
	
									Configure the extension files.
								





Configuring Kerberos for the Apache Service



	
								On the KDC server, use the kadmin utility to create a service principal for the Apache service on the Red Hat Virtualization Manager. The service principal is a reference ID to the KDC for the Apache service.
							
# kadmin
kadmin> addprinc -randkey HTTP/fqdn-of-rhevm@REALM.COM

	
								Generate a keytab file for the Apache service. The keytab file stores the shared secret key.
							
Note

									The engine-backup command includes the file /etc/httpd/http.keytab when backing up and restoring. If you use a different name for the keytab file, make sure you back up and restore it.
								

kadmin> ktadd -k /tmp/http.keytab HTTP/fqdn-of-rhevm@REALM.COM
kadmin> quit

	
								Copy the keytab file from the KDC server to the Red Hat Virtualization Manager:
							
# scp /tmp/http.keytab root@rhevm.example.com:/etc/httpd

								== Configuring Single Sign-on to the VM Portal or Administration Portal
							

	
								On the Red Hat Virtualization Manager, ensure that the ownership and permissions for the keytab are appropriate:
							
# chown apache /etc/httpd/http.keytab
# chmod 400 /etc/httpd/http.keytab

	
								Install the authentication extension package, LDAP extension package, and the mod_auth_gssapi and mod_session Apache modules:
							
# dnf install ovirt-engine-extension-aaa-misc ovirt-engine-extension-aaa-ldap mod_auth_gssapi mod_session
Note

									The ovirt-engine-extension-aaa-ldap is deprecated. For new installations, use Red Hat Single Sign On. For more information, see Installing and Configuring Red Hat Single Sign-On in the Administration Guide.
								


	
								Copy the SSO configuration template file into the /etc/ovirt-engine directory. Template files are available for Active Directory (ad-sso) and other directory types (simple-sso). This example uses the simple SSO configuration template.
							
# cp -r /usr/share/ovirt-engine-extension-aaa-ldap/examples/simple-sso/. /etc/ovirt-engine

	
								Move ovirt-sso.conf into the Apache configuration directory.
							
Note

									The engine-backup command includes the file /etc/httpd/conf.d/ovirt-sso.conf when backing up and restoring. If you use a different name for this file, make sure you back up and restore it.
								

# mv /etc/ovirt-engine/aaa/ovirt-sso.conf /etc/httpd/conf.d

	
								Review the authentication method file. You do not need to edit this file, as the realm is automatically fetched from the keytab file.
							
# vi /etc/httpd/conf.d/ovirt-sso.conf
Example 3.9. Example authentication method file
<LocationMatch ^/ovirt-engine/sso/(interactive-login-negotiate|oauth/token-http-auth)|^/ovirt-engine/api>
  <If "req('Authorization') !~ /^(Bearer|Basic)/i">
    RewriteEngine on
    RewriteCond %{LA-U:REMOTE_USER} ^(.*)$
    RewriteRule ^(.*)$ - [L,NS,P,E=REMOTE_USER:%1]
    RequestHeader set X-Remote-User %{REMOTE_USER}s

    AuthType GSSAPI
    AuthName "Kerberos Login"

    # Modify to match installation
    GssapiCredStore keytab:/etc/httpd/http.keytab
    GssapiUseSessions On
    Session On
    SessionCookieName ovirt_gssapi_session path=/private;httponly;secure;

    Require valid-user
    ErrorDocument 401 "<html><meta http-equiv=\"refresh\" content=\"0; url=/ovirt-engine/sso/login-unauthorized\"/><body><a href=\"/ovirt-engine/sso/login-unauthorized\">Here</a></body></html>"
  </If>
</LocationMatch>



	
								Rename the configuration files to match the profile name you want visible to users on the Administration Portal and the VM Portal login pages:
							
# mv /etc/ovirt-engine/aaa/profile1.properties /etc/ovirt-engine/aaa/example.properties
# mv /etc/ovirt-engine/extensions.d/profile1-http-authn.properties /etc/ovirt-engine/extensions.d/example-http-authn.properties
# mv /etc/ovirt-engine/extensions.d/profile1-http-mapping.properties /etc/ovirt-engine/extensions.d/example-http-mapping.properties
# mv /etc/ovirt-engine/extensions.d/profile1-authz.properties /etc/ovirt-engine/extensions.d/example-authz.properties

	
								Edit the LDAP property configuration file by uncommenting an LDAP server type and updating the domain and passwords fields:
							
#  vi /etc/ovirt-engine/aaa/example.properties
Example 3.10. Example profile: LDAP server section
# Select one
include = <openldap.properties>
#include = <389ds.properties>
#include = <rhds.properties>
#include = <ipa.properties>
#include = <iplanet.properties>
#include = <rfc2307-389ds.properties>
#include = <rfc2307-rhds.properties>
#include = <rfc2307-openldap.properties>
#include = <rfc2307-edir.properties>
#include = <rfc2307-generic.properties>

# Server
#
vars.server = ldap1.company.com

# Search user and its password.
#
vars.user = uid=search,cn=users,cn=accounts,dc=company,dc=com
vars.password = 123456

pool.default.serverset.single.server = ${global:vars.server}
pool.default.auth.simple.bindDN = ${global:vars.user}
pool.default.auth.simple.password = ${global:vars.password}



								To use TLS or SSL protocol to interact with the LDAP server, obtain the root CA certificate for the LDAP server and use it to create a public keystore file. Uncomment the following lines and specify the full path to the public keystore file and the password to access the file.
							
Note

									For more information on creating a public keystore file, see Setting Up SSL or TLS Connections between the Manager and an LDAP Server.
								

Example 3.11. Example profile: keystore section
# Create keystore, import certificate chain and uncomment
# if using ssl/tls.
pool.default.ssl.startTLS = true
pool.default.ssl.truststore.file = /full/path/to/myrootca.jks
pool.default.ssl.truststore.password = password



	
								Review the authentication configuration file. The profile name visible to users on the Administration Portal and the VM Portal login pages is defined by ovirt.engine.aaa.authn.profile.name. The configuration profile location must match the LDAP configuration file location. All fields can be left as default.
							
# vi /etc/ovirt-engine/extensions.d/example-http-authn.properties
Example 3.12. Example authentication configuration file
ovirt.engine.extension.name = example-http-authn
ovirt.engine.extension.bindings.method = jbossmodule
ovirt.engine.extension.binding.jbossmodule.module = org.ovirt.engine.extension.aaa.misc
ovirt.engine.extension.binding.jbossmodule.class = org.ovirt.engine.extension.aaa.misc.http.AuthnExtension
ovirt.engine.extension.provides = org.ovirt.engine.api.extensions.aaa.Authn
ovirt.engine.aaa.authn.profile.name = example-http
ovirt.engine.aaa.authn.authz.plugin = example-authz
ovirt.engine.aaa.authn.mapping.plugin = example-http-mapping
config.artifact.name = HEADER
config.artifact.arg = X-Remote-User



	
								Review the authorization configuration file. The configuration profile location must match the LDAP configuration file location. All fields can be left as default.
							
#  vi /etc/ovirt-engine/extensions.d/example-authz.properties
Example 3.13. Example authorization configuration file
ovirt.engine.extension.name = example-authz
ovirt.engine.extension.bindings.method = jbossmodule
ovirt.engine.extension.binding.jbossmodule.module = org.ovirt.engine.extension.aaa.ldap
ovirt.engine.extension.binding.jbossmodule.class = org.ovirt.engine.extension.aaa.ldap.AuthzExtension
ovirt.engine.extension.provides = org.ovirt.engine.api.extensions.aaa.Authz
config.profile.file.1 = ../aaa/example.properties



	
								Review the authentication mapping configuration file. The configuration profile location must match the LDAP configuration file location. The configuration profile extension name must match the ovirt.engine.aaa.authn.mapping.plugin value in the authentication configuration file. All fields can be left as default.
							
# vi /etc/ovirt-engine/extensions.d/example-http-mapping.properties
Example 3.14. Example authentication mapping configuration file
ovirt.engine.extension.name = example-http-mapping
ovirt.engine.extension.bindings.method = jbossmodule
ovirt.engine.extension.binding.jbossmodule.module = org.ovirt.engine.extension.aaa.misc
ovirt.engine.extension.binding.jbossmodule.class = org.ovirt.engine.extension.aaa.misc.mapping.MappingExtension
ovirt.engine.extension.provides = org.ovirt.engine.api.extensions.aaa.Mapping
config.mapAuthRecord.type = regex
config.mapAuthRecord.regex.mustMatch = true
config.mapAuthRecord.regex.pattern = ^(?<user>.*?)((\\\\(?<at>@)(?<suffix>.*?)@.*)|(?<realm>@.*))$
config.mapAuthRecord.regex.replacement = ${user}${at}${suffix}



	
								Ensure that the ownership and permissions of the configuration files are appropriate:
							
# chown ovirt:ovirt /etc/ovirt-engine/aaa/example.properties
# chown ovirt:ovirt /etc/ovirt-engine/extensions.d/example-http-authn.properties
# chown ovirt:ovirt /etc/ovirt-engine/extensions.d/example-http-mapping.properties
# chown ovirt:ovirt /etc/ovirt-engine/extensions.d/example-authz.properties
# chmod 600 /etc/ovirt-engine/aaa/example.properties
# chmod 640 /etc/ovirt-engine/extensions.d/example-http-authn.properties
# chmod 640 /etc/ovirt-engine/extensions.d/example-http-mapping.properties
# chmod 640 /etc/ovirt-engine/extensions.d/example-authz.properties

	
								Restart the Apache service and the ovirt-engine service:
							
# systemctl restart httpd.service
# systemctl restart ovirt-engine.service





Installing and Configuring Red Hat Single Sign-On




					To use Red Hat Single Sign-On as your authorization method, you need to:
				
	
							Install Red Hat SSO.
						
	
							Configure the LDAP group mapper.
						
	
							Configure Apache on the Manager.
						
	
							Configure OVN provider credentials.
						
	
							Configure the Monitoring Portal (Grafana)
						


Note

						If Red Hat SSO is configured, previous LDAP sign ons will not work, as only a single authorization protocol may be used at a time.
					

Installing Red Hat SSO




						You can install Red Hat Single Sign-On by downloading a ZIP file and unpacking it, or by using an RPM file.
					

						Follow the installation instructions at Red Hat SSO Installation
					

						Prepare the following information:
					
	
								Path/location of the Open ID Connect server.
							
	
								The subscription channel for the correct repositories.
							
	
								Valid Red Hat subscription login credentials.
							



Configuring the LDAP group mapper



Procedure
	
								Add the LDAP groups mapper with the following information:
							
	
										Name: ldapgroups
									
	
										Mapper Type: group-ldap-mapper
									
	
										LDAP Groups DN: ou=groups,dc=example,dc=com
									
	
										Group Object Classes: groupofuniquenames (adapt this class according to your LDAP server setup)
									
	
										Membership LDAP Attribute: uniquemember (adapt this class according to your LDAP server setup)
									



	
								Click Save.
							
	
								Click Sync LDAP Groups to KeyCloak.
							
	
								At the bottom of the User Federation Provider page, click Synchronize all users.
							
	
								In the Clients tab, under Add Client, add ovirt-engine as the Client ID, and enter the engine url as the Root URL.
							
	
								Modify the Client Protocol to openid-connect and the Access Type to confidential.
							
	
								In the Clients tab, under Ovirt-engine > Advanced Settings, increase the Access Token Lifespan.
							
	
								Add https://rhvm.example.com:443/* as a valid redirect URI.
							
	
								The client secret is generated, and can be viewed in the Credentials tab.
							
	
								In the Clients tab under Create Mapper Protocol, create a mapper with the following settings:
							
	
										Name: groups
									
	
										Mapper Type: Group Membership
									
	
										Token Claim Name: groups
									
	
										Full group path: ON
									
	
										Add to ID token: ON
									
	
										Add to access token: ON
									
	
										Add to userinfo: ON
									



	
								Add the Builtin Protocol Mapper for username.
							
	
								Create the scopes needed by ovirt-engine, ovirt-app-api, ovirt-app-admin, and ovirt-ext=auth:sequence-priority=~.
							
	
								Use the scopes created in the previous step to set up optional client scopes for the ovirt-engine client.
							



Configuring Apache in the Manager



	
								Enable the mod_auth_openidc module.
							
# dnf module enable mod_auth_openidc:2.3 -y

	
								Configure Apache in the Manager
							
# dnf install mod_auth_openidc

	
								Create a new httpd config file ovirt-openidc.conf in /etc/httpd/conf.d/ with the following content:
							
LoadModule auth_openidc_module modules/mod_auth_openidc.so

OIDCProviderMetadataURL https://SSO.example.com/auth/realms/master/.well-known/openid-configuration
OIDCSSLValidateServer Off

OIDCClientID ovirt-engine
OIDCClientSecret <client_SSO _generated_key>
OIDCRedirectURI https://rhvm.example.com/ovirt-engine/callback
OIDCDefaultURL https://rhvm.example.com/ovirt-engine/login?scope=ovirt-app-admin+ovirt-app-portal+ovirt-ext%3Dauth%3Asequence-priority%3D%7E

# maps the prefered_username claim to the REMOTE_USER environment variable:

OIDCRemoteUserClaim <preferred_username>
OIDCCryptoPassphrase <random1234>

<LocationMatch ^/ovirt-engine/sso/(interactive-login-negotiate|oauth/token-http-auth)|^/ovirt-engine/callback>
    <If "req('Authorization') !~ /^(Bearer|Basic)/i">

      Require valid-user
      AuthType openid-connect

      ErrorDocument 401 "<html><meta http-equiv=\"refresh\" content=\"0; url=/ovirt-engine/sso/login-unauthorized\"/><body><a href=\"/ovirt-engine/sso/login-unauthorized\">Here</a></body></html>"
    </If>
</LocationMatch>

OIDCOAuthIntrospectionEndpoint https://SSO.example.com/auth/realms/master/protocol/openid-connect/token/introspect
OIDCOAuthSSLValidateServer    Off
OIDCOAuthIntrospectionEndpointParams token_type_hint=access_token
OIDCOAuthClientID ovirt-engine
OIDCOAuthClientSecret <client_SSO _generated_key>
OIDCOAuthRemoteUserClaim sub

<LocationMatch ^/ovirt-engine/(api$|api/)>
   AuthType oauth20
   Require valid-user
</LocationMatch>

	
								To save the configuration changes, restart httpd and ovirt-engine:
							
# systemctl restart httpd
# systemctl restart ovirt-engine

	
								Create the file openidc-authn.properties in /etc/ovirt-engine/extensions.d/ with the following content:
							
ovirt.engine.extension.name = openidc-authn
ovirt.engine.extension.bindings.method = jbossmodule
ovirt.engine.extension.binding.jbossmodule.module = org.ovirt.engine.extension.aaa.misc
ovirt.engine.extension.binding.jbossmodule.class = org.ovirt.engine.extension.aaa.misc.http.AuthnExtension
ovirt.engine.extension.provides = org.ovirt.engine.api.extensions.aaa.Authn
ovirt.engine.aaa.authn.profile.name = openidchttp
ovirt.engine.aaa.authn.authz.plugin = openidc-authz
ovirt.engine.aaa.authn.mapping.plugin = openidc-http-mapping
config.artifact.name = HEADER
config.artifact.arg = OIDC_CLAIM_preferred_username

	
								Create the file openidc-http-mapping.properties in /etc/ovirt-engine/extensions.d/ with the following content:
							
ovirt.engine.extension.name = openidc-http-mapping
ovirt.engine.extension.bindings.method = jbossmodule
ovirt.engine.extension.binding.jbossmodule.module = org.ovirt.engine.extension.aaa.misc
ovirt.engine.extension.binding.jbossmodule.class = org.ovirt.engine.extension.aaa.misc.mapping.MappingExtension
ovirt.engine.extension.provides = org.ovirt.engine.api.extensions.aaa.Mapping
config.mapAuthRecord.type = regex
config.mapAuthRecord.regex.mustMatch = false
config.mapAuthRecord.regex.pattern = ^(?<user>.*?)((\\\\(?<at>@)(?<suffix>.*?)@.*)|(?<realm>@.*))$
config.mapAuthRecord.regex.replacement = ${user}${at}${suffix}

	
								Create the file openidc-authz.properties in /etc/ovirt-engine/extensions.d/ with the following content:
							
ovirt.engine.extension.name = openidc-authz
ovirt.engine.extension.bindings.method = jbossmodule
ovirt.engine.extension.binding.jbossmodule.module = org.ovirt.engine.extension.aaa.misc
ovirt.engine.extension.binding.jbossmodule.class = org.ovirt.engine.extension.aaa.misc.http.AuthzExtension
ovirt.engine.extension.provides = org.ovirt.engine.api.extensions.aaa.Authz
config.artifact.name.arg = OIDC_CLAIM_preferred_username
config.artifact.groups.arg = OIDC_CLAIM_groups

	
								Create the file 99-enable-external-auth.conf in /etc/ovirt-engine/engine.conf.d/ with the following content:
							
ENGINE_SSO_ENABLE_EXTERNAL_SSO=true
ENGINE_SSO_EXTERNAL_SSO_LOGOUT_URI="${ENGINE_URI}/callback"
EXTERNAL_OIDC_USER_INFO_END_POINT=https://SSO.example.com/auth/realms/master/protocol/openid-connect/userinfo
EXTERNAL_OIDC_TOKEN_END_POINT=https://SSO.example.com/auth/realms/master/protocol/openid-connect/token
EXTERNAL_OIDC_LOGOUT_END_POINT=https://SSO.example.com/auth/realms/master/protocol/openid-connect/logout
EXTERNAL_OIDC_CLIENT_ID=ovirt-engine
EXTERNAL_OIDC_CLIENT_SECRET="<client_SSO _generated_key>"
EXTERNAL_OIDC_HTTPS_PKI_TRUST_STORE="/etc/pki/java/cacerts"
EXTERNAL_OIDC_HTTPS_PKI_TRUST_STORE_PASSWORD=""
EXTERNAL_OIDC_SSL_VERIFY_CHAIN=false
EXTERNAL_OIDC_SSL_VERIFY_HOST=false




Configuring OVN




						If you configured the ovirt-ovn-provider in the Manager, you need to configure the OVN provider credentials.
					
Procedure
	
								Create the file 20-setup-ovirt-provider-ovn.conf in /etc/ovirt-provider-ovn/conf.d/ with the following contents, where user1 belongs to the LDAP group ovirt-administrator, and openidchttp is the profile configured for aaa-ldap-misc.
							
[OVIRT]
ovirt-admin-user-name=user1@openidchttp

	
								Restart the ovirt-provider-ovn:
							
# systemctl restart ovirt-provider-ovn

	
								Log in to the Administration Portal, navigate to Administration → Providers, select ovirt-provider-ovn, and click Edit to update the password for the ovn provider.
							



Configuring the Monitoring Portal (Grafana)



Procedure
	
								Configure a client’s valid redirect URL:
							
	
										Select the client configured in earlier steps (ie. ovirt-engine)
									
	
										Add an additional valid Redirect URI for the Monitoring Portal(Grafana). Valid Redirect URIs: https://rhvm.example.com:443/ovirt-engine-grafana/login/generic_oauth/
									
	
										Select the Mappers tab.
									
	
										Click Create to create a new Mapper, and fill in the following fields:
									
	
												Name: realm role
											
	
												Mapper Type: User Realm Role
											
	
												Token Claim Name: realm_access.roles
											
	
												Claim JSON Type: String
											






	
								Configure Grafana specific roles:
							
	
										Select Roles from the main menu.
									
	
										Add the following roles: admin, editor, viewer.
									



	
								Assign Grafana specific roles to the desired groups:
							
	
										Select Groups from the main menu, and choose a desired group.
									
	
										Select Role Mappings.
									
	
										Move the desired roles from Available Roles to Assigned Roles.
									



	
								Configure Grafana - modify the section auth.generic_oauth in /etc/grafana/grafana.ini as follows. Replace the values in arrow brackets < > as needed.
							
(...)
#################################### Generic OAuth #######################
[auth.generic_oauth]
name = oVirt Engine Auth
enabled = true
allow_sign_up = true
client_id = ovirt-engine
client_secret = <client-secret-of-RH-SSO>
scopes = openid,ovirt-app-admin,ovirt-app-portal,ovirt-ext=auth:sequence-priority=~
email_attribute_name = email:primary
role_attribute_path = "contains(realm_access.roles[*], 'admin') && 'Admin' || contains(realm_access.roles[*], 'editor') && 'Editor' || 'Viewer'"
auth_url = https://<rh-sso-hostname>/auth/realms/<RH-SSO-REALM>/protocol/openid-connect/auth
token_url = https://<rh-sso-hostname>/auth/realms/<RH-SSO-REALM>/protocol/openid-connect/token
api_url = https://<rh-sso-hostname>/auth/realms/<RH-SSO-REALM>/protocol/openid-connect/userinfo
team_ids =
allowed_organizations =
tls_skip_verify_insecure = false
tls_client_cert =
tls_client_key =
tls_client_ca = /etc/pki/ovirt-engine/apache-ca.pem
send_client_credentials_via_post = false
(...)





User Authorization



User Authorization Model




						Red Hat Virtualization applies authorization controls based on the combination of the three components:
					
	
								The user performing the action
							
	
								The type of action being performed
							
	
								The object on which the action is being performed
							



User Actions




						For an action to be successfully performed, the user must have the appropriate permission for the object being acted upon. Each type of action has a corresponding permission.
					

						Some actions are performed on more than one object. For example, copying a template to another storage domain will impact both the template and the destination storage domain. The user performing an action must have appropriate permissions for all objects the action impacts.
					


Administering User Tasks From the Administration Portal



The Account Settings window




						The Administration → Account Settings window allows you to view or edit the following Administration Portal user settings:
					
	
								General tab:
							
	
										User Name - read only.
									
	
										E-mail - read only.
									
	
										Home Page:
									

										Default - #dashboard-main.
									

										Custom home page - enter only the last part of the URL, including hash mark (#). For example: #vms-snapshots;name-testVM.
									

	
										Serial Console
									

										User’s Public Key - enter the SSH public key that is used to access the Manager using a serial console.
									

	
										Tables
									

										Persist grid settings - saves the grid column settings on the server.
									




	
								Confirmations tab:
							

								Show confirmation dialog on Suspend VM - enables a confirmation dialog when the VM is suspended.
							




Adding Users and Assigning VM Portal Permissions




						Users must be created already before they can be added and assigned roles and permissions. The roles and permissions assigned in this procedure give the user the permission to log in to the VM Portal and to start creating virtual machines. The procedure also applies to group accounts.
					
Procedure
	
								On the header bar, click Administration → Configure. This opens the Configure window.
							
	
								Click System Permissions.
							
	
								Click Add. This opens the Add System Permission to User window.
							
	
								Select a profile under Search. The profile is the domain you want to search. Enter a name or part of a name in the search text field, and click GO. Alternatively, click GO to view a list of all users and groups.
							
	
								Select the check boxes for the appropriate users or groups.
							
	
								Select an appropriate role to assign under Role to Assign. The UserRole role gives the user account the permission to log in to the VM Portal.
							
	
								Click OK.
							



						Log in to the VM Portal to verify that the user account has the permissions to log in.
					

Viewing User Information



Procedure
	
								Click Administration → Users to display the list of authorized users.
							
	
								Click the user’s name. This opens the details view, usually with the General tab displaying general information, such as the domain name, email and status of the user.
							
	
								The other tabs allow you to view groups, permissions, quotas, and events for the user.
							



						For example, to view the groups to which the user belongs, click the Directory Groups tab.
					

Viewing User Permissions on Resources




						Users can be assigned permissions on specific resources or a hierarchy of resources. You can view the assigned users and their permissions on each resource.
					
Procedure
	
								Find and click the resource’s name. This opens the details view.
							
	
								Click the Permissions tab to list the assigned users, the user’s role, and the inherited permissions for the selected resource.
							



Removing Users




						When a user account is no longer required, remove it from Red Hat Virtualization.
					
Procedure
	
								Click Administration → Users to display the list of authorized users.
							
	
								Select the user to be removed. Ensure the user is not running any virtual machines.
							
	
								Click Remove, then click OK.
							



						The user is removed from Red Hat Virtualization, but not from the external directory.
					

Viewing Logged-In Users




						You can view the users who are currently logged in, along with session times and other details. Click Administration → Active User Sessions to view the Session DB ID, User Name, Authorization provider, User id, Source IP, Session Start Time, and Session Last Active Time for each logged-in user.
					

Terminating a User Session




						You can terminate the session of a user who is currently logged in.
					

						Terminating a User Session
					
	
								Click Administration → Active User Sessions.
							
	
								Select the user session to be terminated.
							
	
								Click Terminate Session.
							
	
								Click OK.
							




Administering User Tasks From the Command Line




					You can use the ovirt-aaa-jdbc-tool tool to manage user accounts on the internal domain. Changes made using the tool take effect immediately and do not require you to restart the ovirt-engine service. For a full list of user options, run ovirt-aaa-jdbc-tool user --help. Common examples are provided in this section.
				
Important

						You must be logged into the Manager machine.
					

Creating a New User




						You can create a new user account. The optional --attribute command specifies account details. For a full list of options, run ovirt-aaa-jdbc-tool user add --help.
					
# ovirt-aaa-jdbc-tool user add test1 --attribute=firstName=John --attribute=lastName=Doe
adding user test1...
user added successfully

						You can add the newly created user in the Administration Portal and assign the user appropriate roles and permissions. See Adding users for more information.
					

Setting a User Password




						You can create a password. You must set a value for --password-valid-to, otherwise the password expiry time defaults to the current time.
					

						+ The date format is yyyy-MM-dd HH:mm:ssX. Where X is the time zone offset from UTC. In this example, -0800 stands for GMT minus 8 hours. For zero offset, use the value Z.
					

						+ For more options, run ovirt-aaa-jdbc-tool user password-reset --help.
					
# ovirt-aaa-jdbc-tool user password-reset test1 --password-valid-to="2025-08-01 12:00:00-0800"
Password:
updating user test1...
user updated successfully
Note

							By default, the password policy for user accounts on the internal domain has the following restrictions:
						
	
									A minimum of 6 characters.
								
	
									Three previous passwords used cannot be set again during the password change.
								



							For more information on the password policy and other default settings, run ovirt-aaa-jdbc-tool settings show.
						


						Once the admin password is updated, the change must be manually propagated to ovirt-provider-ovn. Otherwise, the the admin user will become locked because the Red Hat Virtualization Manager will continue to use the old password to synchronize networks from ovirt-provider-ovn. To propogate the new password to ovirt-provider-ovn, do the following:
					
	
								In the Administration Portal, click Administration → Providers.
							
	
								Select ovirt-provider-ovn.
							
	
								Click Edit and enter the new password in the Password field.
							
	
								Click Test to test if authentication succeeds with the credentials you provided.
							
	
								When the authentication test succeeds, click OK.
							



Setting User Timeout




						You can set the user timeout period:
					
# engine-config --set UserSessionTimeOutInterval=integer

Pre-encrypting a User Password




						You can create a pre-encrypted user password using the ovirt-engine-crypto-tool script. This option is useful if you are adding users and passwords to the database with a script.
					
Note

							Passwords are stored in the Manager database in encrypted form. The ovirt-engine-crypto-tool script is used because all passwords must be encrypted with the same algorithm.
						

							If the password is pre-encrypted, password validity tests cannot be performed. The password will be accepted even if it does not comply with the password validation policy.
						

	
								Run the following command:
							
# /usr/share/ovirt-engine/bin/ovirt-engine-crypto-tool.sh pbe-encode

								The script will prompt you to enter the password.
							

								Alternatively, you can use the --password=file:file option to encrypt a single password that appears as the first line of a file. This option is useful for automation. In the following example, file is a text file containing a single password for encryption:
							
# /usr/share/ovirt-engine/bin/ovirt-engine-crypto-tool.sh pbe-encode --password=file:file

	
								Set the new password with the ovirt-aaa-jdbc-tool script, using the --encrypted option:
							
# ovirt-aaa-jdbc-tool user password-reset test1 --password-valid-to="2025-08-01 12:00:00-0800" --encrypted

	
								Enter and confirm the encrypted password:
							
Password:
Reenter password:
updating user test1...
user updated successfully




Viewing User Information




						You can view detailed user account information:
					
# ovirt-aaa-jdbc-tool user show test1

						This command displays more information than in the Administration Portal’s Administration → Users screen.
					

Editing User Information




						You can update user information, such as the email address:
					
# ovirt-aaa-jdbc-tool user edit test1 --attribute=email=jdoe@example.com

Removing a User




						You can remove a user account:
					
# ovirt-aaa-jdbc-tool user delete test1

						Remove the user from the Administration Portal. See Removing Users for more information.
					

Disabling the Internal Administrative User




						You can disable users on the local domains including the admin@internal user created during engine-setup. Make sure you have at least one user in the envrionment with full administrative permissions before disabling the default admin user.
					
Procedure
	
								Log in to the machine on which the Red Hat Virtualization Manager is installed.
							
	
								Make sure another user with the SuperUser role has been added to the environment. See Adding users for more information.
							
	
								Disable the default admin user:
							
# ovirt-aaa-jdbc-tool user edit admin --flag=+disabled



Note

							To enable a disabled user, run ovirt-aaa-jdbc-tool user edit username --flag=-disabled
						


Managing Groups




						You can use the ovirt-aaa-jdbc-tool tool to manage group accounts on your internal domain. Managing group accounts is similar to managing user accounts. For a full list of group options, run ovirt-aaa-jdbc-tool group --help. Common examples are provided in this section.
					

						Creating a Group
					

						This procedure shows you how to create a group account, add users to the group, and view the details of the group.
					
	
								Log in to the machine on which the Red Hat Virtualization Manager is installed.
							
	
								Create a new group:
							
# ovirt-aaa-jdbc-tool group add group1

	
								Add users to the group. The users must be created already.
							
# ovirt-aaa-jdbc-tool group-manage useradd group1 --user=test1
Note

									For a full list of the group-manage options, run ovirt-aaa-jdbc-tool group-manage --help.
								


	
								View group account details:
							
# ovirt-aaa-jdbc-tool group show group1

	
								Add the newly created group in the Administration Portal and assign the group appropriate roles and permissions. The users in the group inherit the roles and permissions of the group. See Adding users for more information.
							



						Creating Nested Groups
					

						This procedure shows you how to create groups within groups.
					
	
								Log in to the machine on which the Red Hat Virtualization Manager is installed.
							
	
								Create the first group:
							
# ovirt-aaa-jdbc-tool group add group1

	
								Create the second group:
							
# ovirt-aaa-jdbc-tool group add group1-1

	
								Add the second group to the first group:
							
# ovirt-aaa-jdbc-tool group-manage groupadd group1 --group=group1-1

	
								Add the first group in the Administration Portal and assign the group appropriate roles and permissions. See Adding users for more information.
							



Querying Users and Groups




						The query module allows you to query user and group information. For a full list of options, run ovirt-aaa-jdbc-tool query --help.
					

						Listing All User or Group Account Details
					

						This procedure shows you how to list all account information.
					
	
								Log in to the machine on which the Red Hat Virtualization Manager is installed.
							
	
								List the account details.
							
	
										All user account details:
									
# ovirt-aaa-jdbc-tool query --what=user

	
										All group account details:
									
# ovirt-aaa-jdbc-tool query --what=group







						Listing Filtered Account Details
					

						This procedure shows you how to apply filters when listing account information.
					
	
								Log in to the machine on which the Red Hat Virtualization Manager is installed.
							
	
								Filter account details using the --pattern parameter.
							
	
										List user account details with names that start with the character j.
									
# ovirt-aaa-jdbc-tool query --what=user --pattern="name=j*"

	
										List groups that have the department attribute set to marketing:
									
# ovirt-aaa-jdbc-tool query --what=group --pattern="department=marketing"







Managing Account Settings




						To change the default account settings, use the ovirt-aaa-jdbc-tool settings module.
					

						Updating Account Settings
					

						This procedure shows you how to update the default account settings.
					
	
								Log in to the machine on which the Red Hat Virtualization Manager is installed.
							
	
								Run the following command to show all the settings available:
							
# ovirt-aaa-jdbc-tool settings show

	
								Change the desired settings:
							
	
										This example updates the default log in session time to 60 minutes for all user accounts. The default value is 10080 minutes.
									
# ovirt-aaa-jdbc-tool settings set --name=MAX_LOGIN_MINUTES --value=60

	
										This example updates the number of failed login attempts a user can perform before the user account is locked. The default value is 5.
									
# ovirt-aaa-jdbc-tool settings set --name=MAX_FAILURES_SINCE_SUCCESS --value=3
Note

											To unlock a locked user account, run ovirt-aaa-jdbc-tool user unlock test1.
										









Configuring Additional Local Domains




					Creating additional local domains other than the default internal domain is also supported. This can be done using the ovirt-engine-extension-aaa-jdbc extension and allows you to create multiple domains without attaching external directory servers, though the use case may not be common for enterprise environments.
				

					Additionally created local domains will not get upgraded autonmatically during standard Red Hat Virtualization upgrades and need to be upgraded manually for each future release. For more information on creating additional local domains and how to upgrade the domains, see the README file at /usr/share/doc/ovirt-engine-extension-aaa-jdbc-version/README.admin.
				
Note

						The ovirt-engine-extension-aaa-jdbc extension is deprecated. For new installations, use Red Hat Single Sign On. For more information, see Installing and Configuring Red Hat Single Sign-On in the Administration Guide.
					



Quotas and Service Level Agreement Policy



Introduction to Quota




					Quota is a resource limitation tool provided with Red Hat Virtualization. Quota may be thought of as a layer of limitations on top of the layer of limitations set by User Permissions.
				

					Quota is a data center object.
				

					Quota allows administrators of Red Hat Virtualization environments to limit user access to memory, CPU, and storage. Quota defines the memory resources and storage resources an administrator can assign users. As a result users may draw on only the resources assigned to them. When the quota resources are exhausted, Red Hat Virtualization does not permit further user actions.
				

					There are two different kinds of Quota:
				
Table 3.3. The Two Different Kinds of Quota
	Quota type	Definition
	 
									Run-time Quota
								

								 	 
									This quota limits the consumption of runtime resources, like CPU and memory.
								

								 
	 
									Storage Quota
								

								 	 
									This quota limits the amount of storage available.
								

								 




					Quota, like SELinux, has three modes:
				
Table 3.4. Quota Modes
	Quota Mode	Function
	 
									Enforced
								

								 	 
									This mode puts into effect the quota that you have set in Audit mode, limiting resources to the group or user affected by the quota.
								

								 
	 
									Audit
								

								 	 
									This mode logs quota violations without blocking users and can be used to test quotas. In Audit mode, you can increase or decrease the amount of runtime quota and the amount of storage quota available to users affected by it.
								

								 
	 
									Disabled
								

								 	 
									This mode turns off the runtime and storage limitations defined by the quota.
								

								 




					When a user attempts to run a virtual machine, the specifications of the virtual machine are compared to the storage allowance and the runtime allowance set in the applicable quota.
				

					If starting a virtual machine causes the aggregated resources of all running virtual machines covered by a quota to exceed the allowance defined in the quota, then the Manager refuses to run the virtual machine.
				

					When a user creates a new disk, the requested disk size is added to the aggregated disk usage of all the other disks covered by the applicable quota. If the new disk takes the total aggregated disk usage above the amount allowed by the quota, disk creation fails.
				

					Quota allows for resource sharing of the same hardware. It supports hard and soft thresholds. Administrators can use a quota to set thresholds on resources. These thresholds appear, from the user’s point of view, as 100% usage of that resource. To prevent failures when the customer unexpectedly exceeds this threshold, the interface supports a "grace" amount by which the threshold can be briefly exceeded. Exceeding the threshold results in a warning sent to the customer.
				
Important

						Quota imposes limitations upon the running of virtual machines. Ignoring these limitations is likely to result in a situation in which you cannot use your virtual machines and virtual disks.
					

						When quota is running in enforced mode, virtual machines and disks that do not have quotas assigned cannot be used.
					

						To power on a virtual machine, a quota must be assigned to that virtual machine.
					

						To create a snapshot of a virtual machine, the disk associated with the virtual machine must have a quota assigned.
					

						When creating a template from a virtual machine, you are prompted to select the quota that you want the template to consume. This allows you to set the template (and all future machines created from the template) to consume a different quota than the virtual machine and disk from which the template is generated.
					


Shared Quota and Individually Defined Quota




					Users with SuperUser permissions can create quotas for individual users or quotas for groups.
				

					Group quotas can be set for Active Directory users. If a group of ten users are given a quota of 1 TB of storage and one of the ten users fills the entire terabyte, then the entire group will be in excess of the quota and none of the ten users will be able to use any of the storage associated with their group.
				

					An individual user’s quota is set for only the individual. Once the individual user has used up all of his or her storage or runtime quota, the user will be in excess of the quota and the user will no longer be able to use the storage associated with his or her quota.
				

Quota Accounting




					When a quota is assigned to a consumer or a resource, each action by that consumer or on the resource involving storage, vCPU, or memory results in quota consumption or quota release.
				

					Since the quota acts as an upper bound that limits the user’s access to resources, the quota calculations may differ from the actual current use of the user. The quota is calculated for the max growth potential and not the current usage.
				
Example 3.15. Accounting example

						A user runs a virtual machine with 1 vCPU and 1024 MB memory. The action consumes 1 vCPU and 1024 MB of the quota assigned to that user. When the virtual machine is stopped 1 vCPU and 1024 MB of RAM are released back to the quota assigned to that user. Run-time quota consumption is accounted for only during the actual run-time of the consumer.
					

						A user creates a virtual thin provision disk of 10 GB. The actual disk usage may indicate only 3 GB of that disk are actually in use. The quota consumption, however, would be 10 GB, the max growth potential of that disk.
					



Enabling and Changing a Quota Mode in a Data Center




					This procedure enables or changes the quota mode in a data center. You must select a quota mode before you can define quotas. You must be logged in to the Administration Portal to follow the steps of this procedure.
				

					Use Audit mode to test your quota to verify that it works as you expect it to. You do not need to have your quota in Audit mode to create or change a quota.
				
Procedure
	
							Click Compute → Data Centers and select a data center.
						
	
							Click Edit.
						
	
							In the Quota Mode drop-down list, change the quota mode to Enforced.
						
	
							Click OK.
						



					If you set the quota mode to Audit during testing, then you must change it to Enforced in order for the quota settings to take effect.
				

Creating a New Quota Policy




					You have enabled quota mode, either in Audit or Enforcing mode. You want to define a quota policy to manage resource usage in your data center.
				
Procedure
	
							Click Administration → Quota.
						
	
							Click Add.
						
	
							Fill in the Name and Description fields.
						
	
							Select a Data Center.
						
	
							In the Memory & CPU section, use the green slider to set Cluster Threshold.
						
	
							In the Memory & CPU section, use the blue slider to set Cluster Grace.
						
	
							Click the All Clusters or the Specific Clusters radio button. If you select Specific Clusters, select the check box of the clusters that you want to add a quota policy to.
						
	
							Click Edit. This opens the Edit Quota window.
						
	
									Under the Memory field, select either the Unlimited radio button (to allow limitless use of Memory resources in the cluster), or select the limit to radio button to set the amount of memory set by this quota. If you select the limit to radio button, input a memory quota in megabytes (MB) in the MB field.
								
	
									Under the CPU field, select either the Unlimited radio button or the limit to radio button to set the amount of CPU set by this quota. If you select the limit to radio button, input a number of vCPUs in the vCpus field.
								
	
									Click OK in the Edit Quota window.
								



	
							In the Storage section, use the green slider to set Storage Threshold.
						
	
							In the Storage section, use the blue slider to set Storage Grace.
						
	
							Click the All Storage Domains or the Specific Storage Domains radio button. If you select Specific Storage Domains, select the check box of the storage domains that you want to add a quota policy to.
						
	
							Click Edit. This opens the Edit Quota window.
						
	
									Under the Storage Quota field, select either the Unlimited radio button (to allow limitless use of Storage) or the limit to radio button to set the amount of storage to which quota will limit users. If you select the limit to radio button, input a storage quota size in gigabytes (GB) in the GB field.
								
	
									Click OK in the Edit Quota window.
								



	
							Click OK in the New Quota window.
						



Explanation of Quota Threshold Settings



Table 3.5. Quota thresholds and grace
	Setting	Definition
	 
									Cluster Threshold
								

								 	 
									The amount of cluster resources available per data center.
								

								 
	 
									Cluster Grace
								

								 	 
									The amount of the cluster available for the data center after exhausting the data center’s Cluster Threshold.
								

								 
	 
									Storage Threshold
								

								 	 
									The amount of storage resources available per data center.
								

								 
	 
									Storage Grace
								

								 	 
									The amount of storage available for the data center after exhausting the data center’s Storage Threshold.
								

								 




					If a quota is set to 100 GB with 20% Grace, then consumers are blocked from using storage after they use 120 GB of storage. If the same quota has a Threshold set at 70%, then consumers receive a warning when they exceed 70 GB of storage consumption (but they remain able to consume storage until they reach 120 GB of storage consumption.) Both "Threshold" and "Grace" are set relative to the quota. "Threshold" may be thought of as the "soft limit", and exceeding it generates a warning. "Grace" may be thought of as the "hard limit", and exceeding it makes it impossible to consume any more storage resources.
				

Assigning a Quota to an Object




					Assigning a Quota to a Virtual Machine
				
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click Edit.
						
	
							Select the quota you want the virtual machine to consume from the Quota drop-down list.
						
	
							Click OK.
						



					Assigning a Quota to a Disk
				
	
							Click Compute → Virtual Machines.
						
	
							Click a virtual machine’s name. This opens the details view.
						
	
							Click the Disks tab and select the disk you plan to associate with a quota.
						
	
							Click Edit.
						
	
							Select the quota you want the virtual disk to consume from the Quota drop-down list.
						
	
							Click OK.
						


Important

						Quota must be selected for all objects associated with a virtual machine, in order for that virtual machine to work. If you fail to select a quota for the objects associated with a virtual machine, the virtual machine will not work. The error that the Manager throws in this situation is generic, which makes it difficult to know if the error was thrown because you did not associate a quota with all of the objects associated with the virtual machine. It is not possible to take snapshots of virtual machines that do not have an assigned quota. It is not possible to create templates of virtual machines whose virtual disks do not have assigned quotas.
					


Using Quota to Limit Resources by User




					This procedure describes how to use quotas to limit the resources a user has access to.
				
Procedure
	
							Click Administration → Quota.
						
	
							Click the name of the target quota. This opens the details view.
						
	
							Click the Consumers tab.
						
	
							Click Add.
						
	
							In the Search field, type the name of the user you want to associate with the quota.
						
	
							Click GO.
						
	
							Select the check box next to the user’s name.
						
	
							Click OK.
						



					After a short time, the user will appear in the Consumers tab in the details view.
				

Editing Quotas




					This procedure describes how to change existing quotas.
				
Procedure
	
							Click Administration → Quota and select a quota.
						
	
							Click Edit.
						
	
							Edit the fields as required.
						
	
							Click OK.
						



Removing Quotas




					This procedure describes how to remove quotas.
				
Procedure
	
							Click Administration → Quota and select a quota.
						
	
							Click Remove.
						
	
							Click OK.
						



Service Level Agreement Policy Enforcement




					This procedure describes how to set service level agreement CPU features.
				
Procedure
	
							Click Compute → Virtual Machines.
						
	
							Click New, or select a virtual machine and click Edit.
						
	
							Click the Resource Allocation tab.
						
	
							Specify CPU Shares. Possible options are Low, Medium, High, Custom, and Disabled. Virtual machines set to High receive twice as many shares as Medium, and virtual machines set to Medium receive twice as many shares as virtual machines set to Low. Disabled instructs VDSM to use an older algorithm for determining share dispensation; usually the number of shares dispensed under these conditions is 1020.
						



					The CPU consumption of users is now governed by the policy you have set.
				


Event Notifications



Configuring Event Notifications in the Administration Portal




					The Red Hat Virtualization Manager can notify designated users via email when specific events occur in the environment that the Red Hat Virtualization Manager manages. To use this functionality, you must set up a mail transfer agent to deliver messages. Only email notifications can be configured through the Administration Portal. SNMP traps must be configured on the Manager machine.
				
Procedure
	
							Ensure that you have access to an email server that can accept automated messages from Manager and deliver them to a distribution list.
						
	
							Click Administration → Users and select a user.
						
	
							Click the user’s User Name to go to the details page.
						
	
							In the Event Notifier tab, click Manage Events.
						
	
							Use the Expand All button or the subject-specific expansion buttons to view the events.
						
	
							Select the appropriate check boxes.
						
	
							Enter an email address in the Mail Recipient field.
						
Note

								The email address can be a text message email address (for example, 1234567890@carrierdomainname.com) or an email group address that includes email addresses and text message email addresses.
							


	
							Click OK.
						
	
							On the Manager machine, copy ovirt-engine-notifier.conf to a new file called 90-email-notify.conf:
						
# cp /usr/share/ovirt-engine/services/ovirt-engine-notifier/ovirt-engine-notifier.conf /etc/ovirt-engine/notifier/notifier.conf.d/90-email-notify.conf

	
							Edit 90-email-notify.conf, deleting everything except the EMAIL Notifications section.
						
	
							Enter the correct email variables, as in the example below. This file overrides the values in the original ovirt-engine-notifier.conf file.
						
#---------------------#
# EMAIL Notifications #
#---------------------#

# The SMTP mail server address. Required.
MAIL_SERVER=myemailserver.example.com

# The SMTP port (usually 25 for plain SMTP, 465 for SMTP with SSL, 587 for SMTP with TLS)
MAIL_PORT=25

# Required if SSL or TLS enabled to authenticate the user. Used also to specify 'from' user address if mail server
# supports, when MAIL_FROM is not set. Address is in RFC822 format
MAIL_USER=

# Required to authenticate the user if mail server requires authentication or if SSL or TLS is enabled
SENSITIVE_KEYS="${SENSITIVE_KEYS},MAIL_PASSWORD"
MAIL_PASSWORD=

# Indicates type of encryption (none, ssl or tls) should be used to communicate with mail server.
MAIL_SMTP_ENCRYPTION=none

# If set to true, sends a message in HTML format.
HTML_MESSAGE_FORMAT=false

# Specifies 'from' address on sent mail in RFC822 format, if supported by mail server.
MAIL_FROM=rhevm2017@example.com

# Specifies 'reply-to' address on sent mail in RFC822 format.
MAIL_REPLY_TO=

# Interval to send smtp messages per # of IDLE_INTERVAL
MAIL_SEND_INTERVAL=1

# Amount of times to attempt sending an email before failing.
MAIL_RETRIES=4
Note

								See /etc/ovirt-engine/notifier/notifier.conf.d/README for more options.
							


	
							Enable and restart the ovirt-engine-notifier service to activate the changes you have made:
						
# systemctl daemon-reload
# systemctl enable ovirt-engine-notifier.service
# systemctl restart ovirt-engine-notifier.service




					The specified user now receives emails based on events in the Red Hat Virtualization environment. The selected events are displayed on the Event Notifier tab for that user.
				

Canceling Event Notifications in the Administration Portal




					A user has configured some unnecessary email notifications and wants them canceled.
				
Procedure
	
							Click Administration → Users.
						
	
							Click the user’s User Name. This opens the details view.
						
	
							Click the Event Notifier tab to list events for which the user receives email notifications.
						
	
							Click Manage Events.
						
	
							Use the Expand All button, or the subject-specific expansion buttons, to view the events.
						
	
							Clear the appropriate check boxes to remove notification for that event.
						
	
							Click OK.
						



Parameters for Event Notifications in ovirt-engine-notifier.conf




					The event notifier configuration file can be found in /usr/share/ovirt-engine/services/ovirt-engine-notifier/ovirt-engine-notifier.conf.
				
Table 3.6. ovirt-engine-notifier.conf variables
	Variable Name	Default	Remarks
	 
									SENSITIVE_KEYS
								

								 	 
									none
								

								 	 
									A comma-separated list of keys that will not be logged.
								

								 
	 
									JBOSS_HOME
								

								 	 
									/opt/rh/eap7/root/usr/share/wildfly
								

								 	 
									The location of the JBoss application server used by the Manager.
								

								 
	 
									ENGINE_ETC
								

								 	 
									/etc/ovirt-engine
								

								 	 
									The location of the etc directory used by the Manager.
								

								 
	 
									ENGINE_LOG
								

								 	 
									/var/log/ovirt-engine
								

								 	 
									The location of the logs directory used by the Manager.
								

								 
	 
									ENGINE_USR
								

								 	 
									/usr/share/ovirt-engine
								

								 	 
									The location of the usr directory used by the Manager.
								

								 
	 
									ENGINE_JAVA_MODULEPATH
								

								 	 
									${ENGINE_USR}/modules
								

								 	 
									The file path to which the JBoss modules are appended.
								

								 
	 
									NOTIFIER_DEBUG_ADDRESS
								

								 	 
									none
								

								 	 
									The address of a machine that can be used to perform remote debugging of the Java virtual machine that the notifier uses.
								

								 
	 
									NOTIFIER_STOP_TIME
								

								 	 
									30
								

								 	 
									The time, in seconds, after which the service will time out.
								

								 
	 
									NOTIFIER_STOP_INTERVAL
								

								 	 
									1
								

								 	 
									The time, in seconds, by which the timeout counter will be incremented.
								

								 
	 
									INTERVAL_IN_SECONDS
								

								 	 
									120
								

								 	 
									The interval in seconds between instances of dispatching messages to subscribers.
								

								 
	 
									IDLE_INTERVAL
								

								 	 
									30
								

								 	 
									The interval, in seconds, between which low-priority tasks will be performed.
								

								 
	 
									DAYS_TO_KEEP_HISTORY
								

								 	 
									0
								

								 	 
									This variable sets the number of days dispatched events will be preserved in the history table. If this variable is not set, events remain on the history table indefinitely.
								

								 
	 
									FAILED_QUERIES_NOTIFICATION_THRESHOLD
								

								 	 
									30
								

								 	 
									The number of failed queries after which a notification email is sent. A notification email is sent after the first failure to fetch notifications, and then once every time the number of failures specified by this variable is reached. If you specify a value of 0 or 1, an email will be sent with each failure.
								

								 
	 
									FAILED_QUERIES_NOTIFICATION_RECIPIENTS
								

								 	 
									none
								

								 	 
									The email addresses of the recipients to which notification emails will be sent. Email addresses must be separated by a comma. This entry has been deprecated by the FILTER variable.
								

								 
	 
									DAYS_TO_SEND_ON_STARTUP
								

								 	 
									0
								

								 	 
									The number of days of old events that will be processed and sent when the notifier starts. If the value is 0 and the service stops and starts after a while, all notifications between service stop and service start time will be lost, please set this value for 1 or a greater value if you want to get notifications on events that occured between service stop and start time.
								

								 
	 
									FILTER
								

								 	 
									exclude:*
								

								 	 
									The algorithm used to determine the triggers for and recipients of email notifications. The value for this variable comprises a combination of include or exclude, the event, and the recipient. For example, include:VDC_START(smtp:mail@example.com) ${FILTER}
								

								 
	 
									MAIL_SERVER
								

								 	 
									none
								

								 	 
									The SMTP mail server address. Required.
								

								 
	 
									MAIL_PORT
								

								 	 
									25
								

								 	 
									The port used for communication. Possible values include 25 for plain SMTP, 465 for SMTP with SSL, and 587 for SMTP with TLS.
								

								 
	 
									MAIL_USER
								

								 	 
									none
								

								 	 
									If SSL is enabled to authenticate the user, then this variable must be set. This variable is also used to specify the "from" user address when the MAIL_FROM variable is not set. Some mail servers do not support this functionality. The address is in RFC822 format.
								

								 
	 
									SENSITIVE_KEYS
								

								 	 
									${SENSITIVE_KEYS},MAIL_PASSWORD
								

								 	 
									Required to authenticate the user if the mail server requires authentication or if SSL or TLS is enabled.
								

								 
	 
									MAIL_PASSWORD
								

								 	 
									none
								

								 	 
									Required to authenticate the user if the mail server requires authentication or if SSL or TLS is enabled.
								

								 
	 
									MAIL_SMTP_ENCRYPTION
								

								 	 
									none
								

								 	 
									The type of encryption to be used in communication. Possible values are none, ssl, tls.
								

								 
	 
									HTML_MESSAGE_FORMAT
								

								 	 
									false
								

								 	 
									The mail server sends messages in HTML format if this variable is set to true.
								

								 
	 
									MAIL_FROM
								

								 	 
									none
								

								 	 
									This variable specifies a sender address in RFC822 format, if supported by the mail server.
								

								 
	 
									MAIL_REPLY_TO
								

								 	 
									none
								

								 	 
									This variable specifies reply-to addresses in RFC822 format on sent mail, if supported by the mail server.
								

								 
	 
									MAIL_SEND_INTERVAL
								

								 	 
									1
								

								 	 
									The number of SMTP messages to be sent for each IDLE_INTERVAL
								

								 
	 
									MAIL_RETRIES
								

								 	 
									4
								

								 	 
									The number of times to attempt to send an email before failing.
								

								 
	 
									SNMP_MANAGERS
								

								 	 
									none
								

								 	 
									The IP addresses or fully qualified domain names of machines that will act as the SNMP managers. Entries must be separated by a space and can contain a port number. For example, manager1.example.com manager2.example.com:164
								

								 
	 
									SNMP_COMMUNITY
								

								 	 
									public
								

								 	 
									(SNMP version 2 only) The SNMP community.
								

								 
	 
									SNMP_OID
								

								 	 
									1.3.6.1.4.1.2312.13.1.1
								

								 	 
									The default trap object identifiers for alerts. All trap types are sent, appended with event information, to the SNMP manager when this OID is defined. Note that changing the default trap prevents generated traps from complying with the Manager’s management information base.
								

								 
	 
									SNMP_VERSION
								

								 	 
									2
								

								 	 
									Defines which version of SNMP to use. SNMP version 2 and version 3 traps are supported. Possible values: 2 or 3.
								

								 
	 
									SNMP_ENGINE_ID
								

								 	 
									none
								

								 	 
									(SNMPv3) The Manager ID used for SNMPv3 traps. This ID is a unique identifier for the device that is connected through SNMP.
								

								 
	 
									SNMP_USERNAME
								

								 	 
									none
								

								 	 
									(SNMPv3) The user name used for SNMPv3 traps.
								

								 
	 
									SNMP_AUTH_PROTOCOL
								

								 	 
									none
								

								 	 
									(SNMPv3) The SNMPv3 authorization protocol. Possible values: MD5, SHA
								

								 
	 
									SNMP_AUTH_PASSPHRASE
								

								 	 
									none
								

								 	 
									(SNMPv3) The passphrase used when SNMP_SECURITY_LEVEL is set to AUTH_NOPRIV and AUTH_PRIV.
								

								 
	 
									SNMP_PRIVACY_PROTOCOL
								

								 	 
									none
								

								 	 
									(SNMPv3) The SNMPv3 privacy protocol. Possible values: AES128, AES192, AES256
								

								 Important

										AES192 and AES256 are not defined in RFC3826, so verify that your SNMP server supports those protocols before enabling them.
									


								 
	 
									SNMP_PRIVACY_PASSPHRASE
								

								 	 
									none
								

								 	 
									The SNMPv3 privacy passphrase, used when SNMP_SECURITY_LEVEL is set to AUTH_PRIV.
								

								 
	 
									SNMP_SECURITY_LEVEL
								

								 	 
									1
								

								 	 
									(SNMPv3) The SNMPv3 security level. Possible values: * 1 - NOAUTH_NOPRIV * 2 - AUTH_NOPRIV * 3 - AUTH_PRIV
								

								 
	 
									ENGINE_INTERVAL_IN_SECONDS
								

								 	 
									300
								

								 	 
									The interval, in seconds, between monitoring the machine on which the Manager is installed. The interval is measured from the time the monitoring is complete.
								

								 
	 
									ENGINE_MONITOR_RETRIES
								

								 	 
									3
								

								 	 
									The number of times the notifier attempts to monitor the status of the machine on which the Manager is installed in a given interval after a failure.
								

								 
	 
									ENGINE_TIMEOUT_IN_SECONDS
								

								 	 
									30
								

								 	 
									The time, in seconds, to wait before the notifier attempts to monitor the status of the machine on which the Manager is installed in a given interval after a failure.
								

								 
	 
									IS_HTTPS_PROTOCOL
								

								 	 
									false
								

								 	 
									This entry must be set to true if JBoss is being run in secured mode.
								

								 
	 
									SSL_PROTOCOL
								

								 	 
									TLS
								

								 	 
									The protocol used by JBoss configuration connector when SSL is enabled.
								

								 
	 
									SSL_IGNORE_CERTIFICATE_ERRORS
								

								 	 
									false
								

								 	 
									This value must be set to true if JBoss is running in secure mode and SSL errors is to be ignored.
								

								 
	 
									SSL_IGNORE_HOST_VERIFICATION
								

								 	 
									false
								

								 	 
									This value must be set to true if JBoss is running in secure mode and host name verification is to be ignored.
								

								 
	 
									REPEAT_NON_RESPONSIVE_NOTIFICATION
								

								 	 
									false
								

								 	 
									This variable specifies whether repeated failure messages will be sent to subscribers if the machine on which the Manager is installed is non-responsive.
								

								 
	 
									ENGINE_PID
								

								 	 
									/var/lib/ovirt-engine/ovirt-engine.pid
								

								 	 
									The path and file name of the PID of the Manager.
								

								 




Configuring the Red Hat Virtualization Manager to Send SNMP Traps




					Configure your Red Hat Virtualization Manager to send Simple Network Management Protocol (SNMP) traps to one or more external SNMP managers. SNMP traps contain system event information; they are used to monitor your Red Hat Virtualization environment. The number and type of traps sent to the SNMP manager can be defined within the Red Hat Virtualization Manager.
				

					Red Hat Virtualization supports SNMP version 2 and version 3. SNMP version 3 supports the following security levels:
				
	NoAuthNoPriv
	
								SNMP traps are sent without any authorization or privacy.
							
	AuthNoPriv
	
								SNMP traps are sent with password authorization but no privacy.
							
	AuthPriv
	
								SNMP traps are sent with password authorization and privacy.
							


Prerequisites
	
							One or more external SNMP managers are configured to receive traps.
						
	
							The IP addresses or fully qualified domain names of machines that will act as SNMP managers. Optionally, determine the port through which Manager receives trap notifications. The default is UDP port 162.
						
	
							The SNMP community (SNMP version 2 only). Multiple SNMP managers can belong to a single community. Management systems and agents can communicate only if they are within the same community. The default community is public.
						
	
							The trap object identifier for alerts. The Red Hat Virtualization Manager provides a default OID of 1.3.6.1.4.1.2312.13.1.1. All trap types are sent, appended with event information, to the SNMP manager when this OID is defined. Note that changing the default trap prevents generated traps from complying with the Manager’s management information base.
						
	
							An SNMP username, for SNMP version 3, security levels 1, 2, and 3.
						
	
							An SNMP passphrase, for SNMP version 3, security levels 2 and 3.
						
	
							An SNMP private passphrase, for SNMP version 3, security level 3.
						


Note

						The Red Hat Virtualization Manager provides management information bases at /usr/share/doc/ovirt-engine/mibs/OVIRT-MIB.txt and /usr/share/doc/ovirt-engine/mibs/REDHAT-MIB.txt. Load the MIBs in your SNMP manager before proceeding.
					


					Default SNMP configuration values exist on the Manager in the events notification daemon configuration file /usr/share/ovirt-engine/services/ovirt-engine-notifier/ovirt-engine-notifier.conf. The values outlined in the following procedure are based on the default or example values provided in this file. Do not edit this file directly, because system changes, such as upgrades, might remove any changes you make to this file. Instead, copy this file to /etc/ovirt-engine/notifier/notifier.conf.d/<integer>-snmp.conf, where <integer> is a number indicating the priority with which the file should run.
				
Procedure
	
							On the Manager, create the SNMP configuration file with the file name <integer>-snmp.conf, where <integer> is an integer that indicates the order in which files are processed. For example:
						
# vi /etc/ovirt-engine/notifier/notifier.conf.d/20-snmp.conf
Tip

							Copy the default SNMP settings from the events notification daemon configuration file /usr/share/ovirt-engine/services/ovirt-engine-notifier/ovirt-engine-notifier.conf. This file includes inline comments for all settings.
						


	
							Specify the SNMP manager(s), the SNMP community (SNMP version 2 only), and the OID in the format in this example:
						
SNMP_MANAGERS="manager1.example.com manager2.example.com:162"
SNMP_COMMUNITY=public
SNMP_OID=1.3.6.1.4.1.2312.13.1.1

	
							Define whether to use SNMP version 2 (default) or 3:
						
SNMP_VERSION=3

	
							Specify a value for SNMP_ENGINE_ID. For example:
						
SNMP_ENGINE_ID="80:00:00:00:01:02:05:05"

	
							With SNMP version 3, specify the security level for SNMP traps:
						

							Security level 1, NoAuthNoPriv traps:
						
SNMP_USERNAME=NoAuthNoPriv
SNMP_SECURITY_LEVEL=1

							Security level 2, AuthNoPriv traps, as user ovirtengine, with SNMP Auth passphrase authpass.
						
SNMP_USERNAME=ovirtengine
SNMP_AUTH_PROTOCOL=MD5
SNMP_AUTH_PASSPHRASE=authpass
SNMP_SECURITY_LEVEL=2

							Security level 3, AuthPriv traps, as user ovirtengine with SNMP Auth passphrase authpass and SNMP Priv passphrase privpass. For example:
						
SNMP_USERNAME=ovirtengine
SNMP_AUTH_PROTOCOL=MD5
SNMP_AUTH_PASSPHRASE=authpass
SNMP_PRIVACY_PROTOCOL=AES128
SNMP_PRIVACY_PASSPHRASE=privpass
SNMP_SECURITY_LEVEL=3

	
							Define which events to send to the SNMP manager:
						
Example 3.16. Event examples

								Send all events to the default SNMP profile:
							
FILTER="include:*(snmp:) ${FILTER}"

								Send all events with the severity ERROR or ALERT to the default SNMP profile:
							
FILTER="include:*:ERROR(snmp:) ${FILTER}"
FILTER="include:*:ALERT(snmp:) ${FILTER}"

								Send events for VDC_START to the specified email address:
							
FILTER="include:VDC_START(snmp:mail@example.com) ${FILTER}"

								Send events for everything but VDC_START to the default SNMP profile:
							
FILTER="exclude:VDC_START include:*(snmp:) ${FILTER}"

								This the default filter defined in ovirt-engine-notifier.conf; if you do not disable this filter or apply overriding filters, no notifications will be sent:
							
FILTER="exclude:*"



							VDC_START is an example of the audit log messages available. A full list of audit log messages can be found in /usr/share/doc/ovirt-engine/AuditLogMessages.properties. Alternatively, filter results within your SNMP manager.
						

	
							Save the file.
						
	
							Start the ovirt-engine-notifier service, and ensure that this service starts on boot:
						
# systemctl start ovirt-engine-notifier.service
# systemctl enable ovirt-engine-notifier.service




					Check your SNMP manager to ensure that traps are being received.
				
Note

						SNMP_MANAGERS, MAIL_SERVER, or both must be properly defined in /usr/share/ovirt-engine/services/ovirt-engine-notifier/ovirt-engine-notifier.conf or in an override file in order for the notifier service to run.
					

Sample SNMP configuration file

					This sample configuration file is based on settings in ovirt-engine-notifier.conf. A dedicated SNMP configuration file, such as this one, overrides the settings in ovirt-engine-notifier.conf.
				
Tip

					Copy the default SNMP settings from the events notification daemon configuration file /usr/share/ovirt-engine/services/ovirt-engine-notifier/ovirt-engine-notifier.conf to /etc/ovirt-engine/notifier/notifier.conf.d/<_integer_>-snmp.conf, where <_integer_> is a number indicating the priority with which the file should run. This file includes inline comments for all settings.
				

/etc/ovirt-engine/notifier/notifier.conf.d/20-snmp.conf

						

SNMP_MANAGERS="manager1.example.com manager2.example.com:162" [image: 1]
SNMP_COMMUNITY=public [image: 2]
SNMP_OID=1.3.6.1.4.1.2312.13.1.1 [image: 3]
FILTER="include:*(snmp:)" [image: 4]
SNMP_VERSION=3 [image: 5]
SNMP_ENGINE_ID="80:00:00:00:01:02:05:05" [image: 6]
SNMP_USERNAME=<username> [image: 7]
SNMP_AUTH_PROTOCOL=MD5 [image: 8]
SNMP_AUTH_PASSPHRASE=<authpass> [image: 9]
SNMP_PRIVACY_PROTOCOL=AES128 [image: 10]
SNMP_PRIVACY_PASSPHRASE=<privpass> [image: 11]
SNMP_SECURITY_LEVEL=3 [image: 12]


					
	[image: 1] 
	
							The IP addresses or fully qualified domain names of machines that will act as the SNMP managers. Entries must be separated by a space and can contain a port number. For example, manager1.example.com manager2.example.com:164
						

	[image: 2] 
	
							(SNMP version 2 only) Default SNMP Community String.
						

	[image: 3] 
	
							SNMP Trap Object Identifier for outgoing notifications. iso(1) org(3) dod(6) internet(1) private(4) enterprises(1) redhat(2312) ovirt(13) engine(1) notifier(1)
						
Note

								Changing the default will prevent generated traps from complying with OVIRT-MIB.txt.
							


	[image: 4] 
	
							The algorithm used to determine the triggers for and recipients of SNMP notifications.
						

	[image: 5] 
	
							SNMP Version. SNMP version 2 and version 3 traps are supported. 2 = SNMPv2, 3 = SNMPv3.
						

	[image: 6] 
	
							(SNMP version 3 only) The engine ID used for SNMP traps.
						

	[image: 7] 
	
							(SNMP version 3 only) The user name used for SNMP traps.
						

	[image: 8] 
	
							(SNMP version 3 only) The SNMP auth protocol. Supported values are MD5 and SHA. Required when SNMP_SECURITY_LEVEL is set to 2 (AUTH_NOPRIV) or 3 (AUTH_PRIV).
						

	[image: 9] 
	
							(SNMP version 3 only) The SNMP auth passphrase. Required when SNMP_SECURITY_LEVEL is set to 2 (AUTH_NOPRIV) or 3 (AUTH_PRIV).
						

	[image: 10] 
	
							(SNMP version 3 only) The SNMP privacy protocol. Supported values are AES128, AES192 and AES256. Be aware that AES192 and AES256 are not defined in RFC3826, so verify that your SNMP server supports those protocols before enabling them. Required when SNMP_SECURITY_LEVEL is set to 3 (AUTH_PRIV).
						

	[image: 11] 
	
							(SNMP version 3 only) The SNMP privacy passphrase. Required when SNMP_SECURITY_LEVEL is set to 3 (AUTH_PRIV).
						

	[image: 12] 
	
							(SNMP version 3 only) The SNMP security level. 1 = NOAUTH_NOPRIV, 2 = AUTH_NOPRIV, 3 = AUTH_PRIV.
						





Utilities



The oVirt Engine Rename Tool



The oVirt Engine Rename Tool




						When the engine-setup command is run in a clean environment, the command generates a number of certificates and keys that use the fully qualified domain name of the Manager supplied during the setup process. If the fully qualified domain name of the Manager must be changed later on (for example, due to migration of the machine hosting the Manager to a different domain), the records of the fully qualified domain name must be updated to reflect the new name. The ovirt-engine-rename command automates this task.
					

						The ovirt-engine-rename command updates records of the fully qualified domain name of the Manager in the following locations:
					
	
								/etc/ovirt-engine/engine.conf.d/10-setup-protocols.conf
							
	
								/etc/ovirt-engine/isouploader.conf.d/10-engine-setup.conf
							
	
								/etc/ovirt-engine/logcollector.conf.d/10-engine-setup.conf
							
	
								/etc/pki/ovirt-engine/cert.conf
							
	
								/etc/pki/ovirt-engine/cert.template
							
	
								/etc/pki/ovirt-engine/certs/apache.cer
							
	
								/etc/pki/ovirt-engine/keys/apache.key.nopass
							
	
								/etc/pki/ovirt-engine/keys/apache.p12
							


Note

							Are you sure you need to do this?
						

							Since version 4.0.4, it is possible to add more names to access the Manager web interface.
						
	
									Make sure the names you choose can resolve to an IP address of the Manager machine by adding relevant records to the DNS server or to /etc/hosts (use ping enginename or getent hosts enginename to check).
								
	
									Run the following:
								
  ----
  # echo 'SSO_ALTERNATE_ENGINE_FQDNS="alias1.example.com alias2.example.com"' \
  > /etc/ovirt-engine/engine.conf.d/99-custom-sso-setup.conf
  # systemctl restart ovirt-engine.service
  ----
. List the alternate names separated by spaces.




							It is also possible to add IP addresses of the Manager machine. However, using IP addresses instead of DNS names is not good practice.
						

Warning

							While the ovirt-engine-rename command creates a new certificate for the web server on which the Manager runs, it does not affect the certificate for the Manager or the certificate authority. Due to this, there is some risk involved in using the ovirt-engine-rename command, particularly in environments that have been upgraded from Red Hat Enterprise Virtualization 3.2 and earlier. Therefore, changing the fully qualified domain name of the Manager by running engine-cleanup and engine-setup is recommended where possible.
						

Warning

							During the upgrade process, the old hostname must be resolvable. If the oVirt Engine Rename Tool fails with the message [ ERROR ] Host name is not valid: <OLD FQDN> did not resolve into an IP address, add the old hostname to the /etc/hosts file, use the oVirt Engine Rename Tool, and then remove the old hostname from the /etc/hosts file.
						


Syntax for the oVirt Engine Rename Command




						The basic syntax for the ovirt-engine-rename command is:
					
# /usr/share/ovirt-engine/setup/bin/ovirt-engine-rename

						The command also accepts the following options:
					
	--newname=[new name]
	
									Allows you to specify the new fully qualified domain name for the Manager without user interaction.
								
	--log=[file]
	
									Allows you to specify the path and name of a file into which logs of the rename operation are to be written.
								
	--config=[file]
	
									Allows you to specify the path and file name of a configuration file to load into the rename operation.
								
	--config-append=[file]
	
									Allows you to specify the path and file name of a configuration file to append to the rename operation. This option can be used to specify the path and file name of an existing answer file to automate the rename operation.
								
	--generate-answer=[file]
	
									Allows you to specify the path and file name of the file in which your answers and the values changed by the ovirt-engine-rename command are recorded.
								



Renaming the Manager with the oVirt Engine Rename Tool




						You can use the ovirt-engine-rename command to update records of the fully qualified domain name (FQDN) of the Manager.
					

						The tool checks whether the Manager provides a local ISO or Data storage domain. If it does, the tool prompts the user to eject, shut down, or place into maintenance mode any virtual machine or storage domain connected to the storage before continuing with the operation. This ensures that virtual machines do not lose connectivity with their virtual disks, and prevents ISO storage domains from losing connectivity during the renaming process.
					
Procedure
	
								Prepare all DNS and other relevant records for the new FQDN.
							
	
								Update the DHCP server configuration if DHCP is used.
							
	
								Update the host name on the Manager.
							
	
								Run the following command:
							
# /usr/share/ovirt-engine/setup/bin/ovirt-engine-rename

	
								When prompted, press Enter to stop the engine service:
							
During execution engine service will be stopped (OK, Cancel) [OK]:

	
								When prompted, enter the new FQDN for the Manager:
							
New fully qualified server name:new_engine_fqdn




						The ovirt-engine-rename command updates records of the FQDN of the Manager.
					

						For a self-hosted engine, complete these additional steps:
					
	
								Run the following command on every existing self-hosted engine node:
							
# hosted-engine --set-shared-config fqdn new_engine_fqdn --type=he_local

								This command modifies the FQDN in each self-hosted engine node’s local copy of /etc/ovirt-hosted-engine-ha/hosted-engine.conf
							

	
								Run the following command on one of the self-hosted engine nodes:
							
# hosted-engine --set-shared-config fqdn new_engine_fqdn --type=he_shared

								This command modifies the FQDN in the main copy of /etc/ovirt-hosted-engine-ha/hosted-engine.conf on the shared storage domain.
							




						Now, all new and existing self-hosted engine nodes use the new FQDN.
					
Note

							The oVirt Engine Rename Tool is designed to work only on local machines. Changing the Manager name does not automatically update the name on remote Data Warehouse machines. Changing the names on remote DWH machines must be performed manually.
						


						For remote Data Warehouse deployments, follow these steps on the remote machine (not on the Manager machine):
					
	
								Remove the following PKI files:
							

								/etc/pki/ovirt-engine/apache-ca.pem/etc/pki/ovirt-engine/apache-grafana-ca.pem/etc/pki/ovirt-engine/certs/*/etc/pki/ovirt-engine/keys/*
							

	
								In the following files, update the Manager fqdn to the new name (for example, vm-new-name.local_lab_server.redhat.com):
							

								/etc/grafana/grafana.ini/etc/ovirt-engine-dwh/ovirt-engine-dwhd.conf.d/10-setup-database.conf/etc/ovirt-engine-setup.conf.d/20-setup-ovirt-post.conf
							

	
								Run engine-setup with the --offline switch to prevent updates at this time:
							
# engine-setup --offline





The Engine Configuration Tool



The Engine Configuration Tool




						The engine configuration tool is a command-line utility for configuring global settings for your Red Hat Virtualization environment. The tool interacts with a list of key-value mappings that are stored in the engine database, and allows you to retrieve and set the value of individual keys, and retrieve a list of all available configuration keys and values. Furthermore, different values can be stored for each configuration level in your Red Hat Virtualization environment.
					
Note

							Neither the Red Hat Virtualization Manager nor Red Hat JBoss Enterprise Application Platform need to be running to retrieve or set the value of a configuration key. Because the configuration key value-key mappings are stored in the engine database, they can be updated while the postgresql service is running. Changes are then applied when the ovirt-engine service is restarted.
						


Syntax for the engine-config Command




						You can run the engine configuration tool from the machine on which the Red Hat Virtualization Manager is installed. For detailed information on usage, print the help output for the command:
					
# engine-config --help

						Common tasks:
					
	
								List available configuration keys
							
# engine-config --list

	
								List available configuration values
							
# engine-config --all

	
								Retrieve value of configuration key
							
# engine-config --get KEY_NAME

								Replace KEY_NAME with the name of the preferred key to retrieve the value for the given version of the key. Use the --cver parameter to specify the configuration version of the value to be retrieved. If no version is provided, values for all existing versions are returned.
							

	
								Set value of configuration key
							
# engine-config --set KEY_NAME=KEY_VALUE --cver=VERSION

								Replace KEY_NAME with the name of the specific key to set, and replace KEY_VALUE with the value to be set. You must specify the VERSION in environments with more than one configuration version.
							

	
								Restart the ovirt-engine service to load changes
							

								The ovirt-engine service needs to be restarted for your changes to take effect.
							
# systemctl restart ovirt-engine.service





The USB Filter Editor



Installing the USB Filter Editor




						The USB Filter Editor is a Windows tool used to configure the usbfilter.txt policy file. The policy rules defined in this file allow or deny automatic passthrough of specific USB devices from client machines to virtual machines managed using the Red Hat Virtualization Manager. The policy file resides on the Red Hat Virtualization Manager in the following location: /etc/ovirt-engine/usbfilter.txt Changes to USB filter policies do not take effect unless the ovirt-engine service on the Red Hat Virtualization Manager is restarted.
					

						Download the USB Filter Editor installer from this "Installers and Images for Red Hat Virtualization Manager" topic.
					
Procedure
	
								On a Windows machine, extract the .msi intaller from the .zip file and run the .msi installer.
							
	
								Follow the steps of the installation wizard. Unless otherwise specified, the USB Filter Editor will be installed by default in either C:\Program Files\RedHat\USB Filter Editor or C:\Program Files(x86)\RedHat\USB Filter Editor depending on your version of Windows.
							
	
								A USB Filter Editor shortcut icon is created on your desktop.
							


Important

							Use a Secure Copy (SCP) client such as WinSCP to import and export filter policies from the Red Hat Virtualization Manager.
						


						The default USB device policy provides virtual machines with basic access to USB devices; update the policy to allow the use of additional USB devices.
					

The USB Filter Editor Interface




						Double-click the USB Filter Editor shortcut icon on your desktop.
					

						The Red Hat USB Filter Editor interface displays the Class, Vendor, Product, Revision, and Action for each USB device. Permitted USB devices are set to Allow in the Action column; prohibited devices are set to Block.
					
Table 3.7. USB Editor Fields
	Name	Description
	 
										Class
									

									 	 
										Type of USB device; for example, printers, mass storage controllers.
									

									 
	 
										Vendor
									

									 	 
										The manufacturer of the selected type of device.
									

									 
	 
										Product
									

									 	 
										The specific USB device model.
									

									 
	 
										Revision
									

									 	 
										The revision of the product.
									

									 
	 
										Action
									

									 	 
										Allow or block the specified device.
									

									 




						The USB device policy rules are processed in their listed order. Use the Up and Down buttons to move rules higher or lower in the list. The universal Block rule needs to remain as the lowest entry to ensure all USB devices are denied unless explicitly allowed in the USB Filter Editor.
					

Adding a USB Policy




						Double-click the USB Filter Editor shortcut icon on your desktop. This opens the editor.
					
Procedure
	
								Click Add.
							
	
								Use the USB Class, Vendor ID, Product ID, and Revision check boxes and lists to specify the device.
							

								Click the Allow button to permit virtual machines use of the USB device; click the Block button to prohibit the USB device from virtual machines.
							

								Click OK to add the selected filter rule to the list and close the window.
							
Example 3.17. Adding a Device

									The following is an example of how to add USB Class Smartcard, device EP-1427X-2 Ethernet Adapter, from manufacturer Acer Communications & Multimedia to the list of allowed devices.
								
[image: Adding a Device]




	
								Click File → Save to save the changes.
							



						You have added a USB policy to the USB Filter Editor. You need to export USB filter policies to the Red Hat Virtualization Manager for them to take effect.
					
Additional resources
	
								Exporting a USB Policy
							



Removing a USB Policy




						Double-click the USB Filter Editor shortcut icon on your desktop. This opens the editor.
					
Procedure
	
								Select the policy to be removed.
							
	
								Click Remove. A message displays prompting you to confirm that you want to remove the policy.
							
	
								Click Yes to confirm that you want to remove the policy.
							
	
								Click File → Save to save the changes.
							



						You have removed a USB policy from the USB Filter Editor. You need to export USB filter policies to the Red Hat Virtualization Manager for them to take effect.
					
Additional resources
	
								Exporting a USB Policy
							



Searching for USB Device Policies




						Search for attached USB devices to either allow or block them in the USB Filter Editor.
					

						Double-click the USB Filter Editor shortcut icon on your desktop. This opens the editor.
					
Procedure
	
								Click Search. The Attached USB Devices window displays a list of all the attached devices.
							
	
								Select the device and click Allow or Block as appropriate. Double-click the selected device to close the window. A policy rule for the device is added to the list.
							
	
								Use the Up and Down buttons to change the position of the new policy rule in the list.
							
	
								Click File → Save to save the changes.
							



						You have searched the attached USB devices. USB filter policies need to be exported to the Red Hat Virtualization Manager to take effect.
					

Exporting a USB Policy




						USB device policy changes need to be exported and uploaded to the Red Hat Virtualization Manager for the updated policy to take effect. Upload the policy and restart the ovirt-engine service.
					

						Double-click the USB Filter Editor shortcut icon on your desktop. This opens the editor.
					
Procedure
	
								Click Export; the Save As window opens.
							
	
								Save the file with a file name of usbfilter.txt.
							
	
								Using a Secure Copy client, such as WinSCP, upload the usbfilter.txt file to the server running Red Hat Virtualization Manager. The file must be placed in the following directory on the server: /etc/ovirt-engine/
							
	
								As the root user on the server running Red Hat Virtualization Manager, restart the ovirt-engine service.
							
# systemctl restart ovirt-engine.service




Importing a USB Policy




						An existing USB device policy must be downloaded and imported into the USB Filter Editor before you can edit it.
					
Procedure
	
								Using a Secure Copy client, such as WinSCP, download the usbfilter.txt file from the server running Red Hat Virtualization Manager. The file can be found in the following directory on the server: /etc/ovirt-engine/
							
	
								Double-click the USB Filter Editor shortcut icon on your desktop. This opens the editor.
							
	
								Click Import. This opens the Open window.
							
	
								Open the usbfilter.txt file that was downloaded from the server.
							




The Image discrepancies tool



Monitoring snapshot health with the image discrepancies tool




						The RHV Image Discrepancies tool analyzes image data in the Storage Domain and RHV Database. It alerts you if it finds discrepancies in volumes and volume attributes, but does not fix those discrepancies. Use this tool in a variety of scenarios, such as:
					
	
								Before upgrading versions, to avoid carrying over broken volumes or chains to the new version.
							
	
								Following a failed storage operation, to detect volumes or attributes in a bad state.
							
	
								After restoring the RHV database or storage from backup.
							
	
								Periodically, to detect potential problems before they worsen.
							
	
								To analyze a snapshot- or live storage migration-related issues, and to verify system health after fixing these types of problems.
							


Prerequisites
	
								Required Versions: this tool was introduced in RHV version 4.3.8 with rhv-log-collector-analyzer-0.2.15-0.el7ev.
							
	
								Because data collection runs simultaneously at different places and is not atomic, stop all activity in the environment that can modify the storage domains. That is, do not create or remove snapshots, edit, move, create, or remove disks. Otherwise, false detection of inconsistencies may occur. Virtual Machines can remain running normally during the process.
							


Procedure
	
								To run the tool, enter the following command on the RHV Manager:
							
# rhv-image-discrepancies

	
								If the tool finds discrepancies, rerun it to confirm the results, especially if there is a chance some operations were performed while the tool was running.
							


Note

							This tool includes any Export and ISO storage domains and may report discrepancies for them. If so, these can be ignored, as these storage domains do not have entries for images in the RHV database.
						

Understanding the results

							The tool reports the following:
						
	
								If there are volumes that appear on the storage but are not in the database, or appear in the database but are not on the storage.
							
	
								If some volume attributes differ between the storage and the database.
							



						Sample output:
					
 Checking storage domain c277ad93-0973-43d9-a0ca-22199bc8e801
    Looking for missing images...
    No missing images found
    Checking discrepancies between SD/DB attributes...
    image ef325650-4b39-43cf-9e00-62b9f7659020 has a different attribute capacity on storage(2696984576) and on DB(2696986624)
    image 852613ce-79ee-4adc-a56a-ea650dcb4cfa has a different attribute capacity on storage(5424252928) and on DB(5424254976)

 Checking storage domain c64637b4-f0e8-408c-b8af-6a52946113e2
    Looking for missing images...
    No missing images found
    Checking discrepancies between SD/DB attributes...
    No discrepancies found


The Log Collector Tool



Log Collector




						A log collection tool is included in the Red Hat Virtualization Manager. This allows you to easily collect relevant logs from across the Red Hat Virtualization environment when requesting support.
					

						The log collection command is ovirt-log-collector. You are required to log in as the root user and provide the administration credentials for the Red Hat Virtualization environment. The ovirt-log-collector -h command displays usage information, including a list of all valid options for the ovirt-log-collector command.
					

Syntax for the ovirt-log-collector Command




						The basic syntax for the log collector command is:
					
# ovirt-log-collector options  list all|clusters|datacenters
# ovirt-log-collector options collect

						The two supported modes of operation are list and collect.
					
	
								The list parameter lists either the hosts, clusters, or data centers attached to the Red Hat Virtualization Manager. You are able to filter the log collection based on the listed objects.
							
	
								The collect parameter performs log collection from the Red Hat Virtualization Manager. The collected logs are placed in an archive file under the /tmp/logcollector directory. The ovirt-log-collector command assigns each log a specific file name.
							



						Unless another parameter is specified, the default action is to list the available hosts together with the data center and cluster to which they belong. You will be prompted to enter user names and passwords to retrieve certain logs.
					

						There are numerous parameters to further refine the ovirt-log-collector command.
					

						General options
					
	--version
	
									Displays the version number of the command in use and returns to prompt.
								
	-h, --help
	
									Displays command usage information and returns to prompt.
								
	--conf-file=PATH
	
									Sets PATH as the configuration file the tool is to use.
								
	--local-tmp=PATH
	
									Sets PATH as the directory in which logs are saved. The default directory is /tmp/logcollector.
								
	--ticket-number=TICKET
	
									Sets TICKET as the ticket, or case number, to associate with the SOS report.
								
	--upload=FTP_SERVER
	
									Sets FTP_SERVER as the destination for retrieved logs to be sent using FTP.
								

									Do not use this option unless advised to by a Red Hat support representative.
								

	--log-file=PATH
	
									Sets PATH as the specific file name the command should use for the log output.
								
	--quiet
	
									Sets quiet mode, reducing console output to a minimum. Quiet mode is off by default.
								
	-v, --verbose
	
									Sets verbose mode, providing more console output. Verbose mode is off by default.
								
	--time-only
	
									Displays only information about time differences between hosts, without generating a full SOS report.
								



						Red Hat Virtualization Manager Options
					

						These options filter the log collection and specify authentication details for the Red Hat Virtualization Manager.
					

						These parameters can be combined for specific commands. For example, ovirt-log-collector --user=admin@internal --cluster ClusterA,ClusterB --hosts "SalesHost"* specifies the user as admin@internal and limits the log collection to only SalesHost hosts in clusters A and B.
					
	--no-hypervisors
	
									Omits virtualization hosts from the log collection.
								
	--one-hypervisor-per-cluster
	
									Collects the logs of one host (the SPM, if there is one) from each cluster.
								
	-u USER, --user=USER
	
									Sets the user name for login. The USER is specified in the format user@domain, where user is the user name and domain is the directory services domain in use. The user must exist in directory services and be known to the Red Hat Virtualization Manager.
								
	-r FQDN, --rhevm=FQDN
	
									Sets the fully qualified domain name of the Red Hat Virtualization Manager from which to collect logs, where FQDN is replaced by the fully qualified domain name of the Manager. It is assumed that the log collector is being run on the same local host as the Red Hat Virtualization Manager; the default value is localhost.
								
	-c CLUSTER, --cluster=CLUSTER
	
									Collects logs from the virtualization hosts in the nominated CLUSTER in addition to logs from the Red Hat Virtualization Manager. The cluster(s) for inclusion must be specified in a comma-separated list of cluster names or match patterns.
								
	-d DATACENTER, --data-center=DATACENTER
	
									Collects logs from the virtualization hosts in the nominated DATACENTER in addition to logs from the Red Hat Virtualization Manager. The data center(s) for inclusion must be specified in a comma-separated list of data center names or match patterns.
								
	-H HOSTS_LIST, --hosts=HOSTS_LIST
	
									Collects logs from the virtualization hosts in the nominated HOSTS_LIST in addition to logs from the Red Hat Virtualization Manager. The hosts for inclusion must be specified in a comma-separated list of host names, fully qualified domain names, or IP addresses. Match patterns are also valid.
								



						SSH Configuration
					
	--ssh-port=PORT
	
									Sets PORT as the port to use for SSH connections with virtualization hosts.
								
	-k KEYFILE, --key-file=KEYFILE
	
									Sets KEYFILE as the public SSH key to be used for accessing the virtualization hosts.
								
	--max-connections=MAX_CONNECTIONS
	
									Sets MAX_CONNECTIONS as the maximum concurrent SSH connections for logs from virtualization hosts. The default is 10.
								



						PostgreSQL Database Options
					

						The database user name and database name must be specified, using the pg-user and dbname parameters, if they have been changed from the default values.
					

						Use the pg-dbhost parameter if the database is not on the local host. Use the optional pg-host-key parameter to collect remote logs. The PostgreSQL SOS plugin must be installed on the database server for remote log collection to be successful.
					
	--no-postgresql
	
									Disables collection of database. The log collector will connect to the Red Hat Virtualization Manager PostgreSQL database and include the data in the log report unless the --no-postgresql parameter is specified.
								
	--pg-user=USER
	
									Sets USER as the user name to use for connections with the database server. The default is postgres.
								
	--pg-dbname=DBNAME
	
									Sets DBNAME as the database name to use for connections with the database server. The default is rhevm.
								
	--pg-dbhost=DBHOST
	
									Sets DBHOST as the host name for the database server. The default is localhost.
								
	--pg-host-key=KEYFILE
	
									Sets KEYFILE as the public identity file (private key) for the database server. This value is not set by default; it is required only where the database does not exist on the local host.
								



Basic Log Collector Usage




						When the ovirt-log-collector command is run without specifying any additional parameters, its default behavior is to collect all logs from the Red Hat Virtualization Manager and its attached hosts. It will also collect database logs unless the --no-postgresql parameter is added. In the following example, log collector is run to collect all logs from the Red Hat Virtualization Manager and three attached hosts.
					
Example 3.18. Log Collector Usage
# ovirt-log-collector
INFO: Gathering oVirt Engine information...
INFO: Gathering PostgreSQL the oVirt Engine database and log files from localhost...
Please provide REST API password for the admin@internal oVirt Engine user (CTRL+D to abort):
About to collect information from 3 hypervisors. Continue? (Y/n):
INFO: Gathering information from selected hypervisors...
INFO: collecting information from 192.168.122.250
INFO: collecting information from 192.168.122.251
INFO: collecting information from 192.168.122.252
INFO: finished collecting information from 192.168.122.250
INFO: finished collecting information from 192.168.122.251
INFO: finished collecting information from 192.168.122.252
Creating compressed archive...
INFO Log files have been collected and placed in /tmp/logcollector/sosreport-rhn-account-20110804121320-ce2a.tar.xz.
The MD5 for this file is 6d741b78925998caff29020df2b2ce2a and its size is 26.7M




The Engine Vacuum Tool



The Engine Vacuum Tool




						The Engine Vacuum tool maintains PostgreSQL databases by updating tables and removing dead rows, allowing disk space to be reused. See the PostgreSQL documentation for information about the VACUUM command and its parameters.
					

						The Engine Vacuum command is engine-vacuum. You must log in as the root user and provide the administration credentials for the Red Hat Virtualization environment.
					

						Alternatively, the Engine Vacuum tool can be run while using the engine-setup command to customize an existing installation:
					
$ engine-setup
...
[ INFO  ] Stage: Environment customization
...
Perform full vacuum on the engine database engine@localhost?
This operation may take a while depending on this setup health and the
configuration of the db vacuum process.
See https://www.postgresql.org/docs/12/static/sql-vacuum.html
(Yes, No) [No]:

						The Yes option runs the Engine Vacuum tool in full vacuum verbose mode.
					

Engine Vacuum Modes




						Engine Vacuum has two modes:
					
	Standard Vacuum
	
									Frequent standard vacuuming is recommended.
								

									Standard vacuum removes dead row versions in tables and indexes and marks the space as available for future reuse. Frequently updated tables should be vacuumed on a regular basis. However, standard vacuum does not return the space to the operating system.
								

									Standard vacuum, with no parameters, processes every table in the current database.
								

	Full Vacuum
	
									Full vacuum is not recommended for routine use, but should only be run when a significant amount of space needs to be reclaimed from within the table.
								

									Full vacuum compacts the tables by writing a new copy of the table file with no dead space, thereby enabling the operating system to reclaim the space. Full vacuum can take a long time.
								

									Full vacuum requires extra disk space for the new copy of the table, until the operation completes and the old copy is deleted. Because full vacuum requires an exclusive lock on the table, it cannot be run in parallel with other uses of the table.
								




Syntax for the engine-vacuum Command




						The basic syntax for the engine-vacuum command is:
					
# engine-vacuum
# engine-vacuum option

						Running the engine-vacuum command with no options performs a standard vacuum.
					

						There are several parameters to further refine the engine-vacuum command.
					

						General Options
					
	-h --help
	
									Displays information on how to use the engine-vacuum command.
								
	-a
	
									Runs a standard vacuum, analyzes the database, and updates the optimizer statistics.
								
	-A
	
									Analyzes the database and updates the optimizer statistics, without vacuuming.
								
	-f
	
									Runs a full vacuum.
								
	-v
	
									Runs in verbose mode, providing more console output.
								
	-t table_name
	
									Vacuums a specific table or tables.
								
# engine-vacuum -f -v -t vm_dynamic -t vds_dynamic





The VDSM to Network Name Mapping Tool



Mapping VDSM Names to Logical Network Names




						If the name of a logical network is longer than 15 characters or contains non-ASCII characters, the system automatically generates an on-host identifier (vdsm_name) name; it comprises the letters on and the first 13 characters of the network’s unique identifier, for example, ona1b2c3d4e5f6g. It is this name that appears in the host’s log files. To view a list of logical network names and their auto-generated network name, use the VDSM-to-Network-Name Mapping tool located in /usr/share/ovirt-engine/bin/.
					
Procedure
	
								The first time you run the tool, define a PASSWORD environment variable, which is the password of a database user with read access to the Manager database. For example, run:
							
# export PASSWORD=DatabaseUserPassword

	
								Run the VDSM-to-Network-Name Mapping tool:
							
# vdsm_to_network_name_map  --user USER

								where USER is the database user with read access to the Manager database, whose password is assigned to the PASSWORD environment variable.
							




						The tool displays a list of logical network names that are mapped to their equivalent on-host identifiers.
					
Additional Flags

							You can run the tool with the following flags:
						

						--host is the hostname/IP address of the database server. The default value is localhost.
					

						--port is the port number of the database server. The default value is 5432. --database is the name of the database. The default value is engine, which is the Manager database.
					

						--secure enables a secure connection with the database. By default the tool is run without a secure connection.
					




Chapter 4. Gathering Information About the Environment



Monitoring and observability




				This chapter provides a number of ways to monitor and obtain metrics and logs from your Red Hat Virtualization system. These methods include:
			
	
						Using Data Warehouse and Grafana to monitor RHV
					
	
						Sending metrics to a remote instance of Elasticsearch
					
	
						Deploying Insights in Red Hat Virtualization Manager
					


Using Data Warehouse and Grafana to monitor RHV



Grafana overview




						Grafana is a web-based UI tool used to display reports based on data collected from the oVirt Data Warehouse PostgreSQL database under the database name ovirt_engine_history. For details of the available report dashboards, see Grafana dashboards and Grafana website - dashboards.
					

						Data from the Manager is collected every minute and aggregated in hourly and daily aggregations. The data is retained according to the scale setting defined in the Data Warehouse configuration during engine-setup (Basic or Full scale):
					
	
								Basic (default) - samples data saved for 24 hours, hourly data saved for 1 month, daily data - no daily aggregations saved.
							
	
								Full (recommended)- samples data saved for 24 hours, hourly data saved for 2 months, daily aggregations saved for 5 years.
							



						Full sample scaling may require migrating the Data Warehouse to a separate virtual machine.
					
	
								For Data Warehouse scaling instructions, see Changing the Data Warehouse Sampling Scale.
							
	
								For instructions on migrating the Data Warehouse to or installing on a separate machine, see Migrating Data Warehouse to a Separate Machine and Installing and Configuring Data Warehouse on a Separate Machine.
							


Note

							Red Hat only supports installing the Data Warehouse database, the Data Warehouse service and Grafana all on the same machine as each other, even though you can install each of these components on separate machines from each other.
						


Installation




						Grafana integration is enabled and installed by default when you run Red Hat Virtualization Manager engine-setup in a Stand Alone Manager installation, and in the Self-Hosted engine installation.
					
Note

							Grafana is not installed by default and you may need to install it manually under some scenarios such as performing an upgrade from an earlier version of RHV, restoring a backup, or when the Data Warehouse is migrated to a separate machine.
						


						To enable Grafana integration manually:
					
	
								Put the environment in global maintenance mode:
							
# hosted-engine --set-maintenance --mode=global

	
								Log in to the machine where you want to install Grafana. This should be the same machine where the Data Warehouse is configured; usually the Manager machine.
							
	
								Run the engine-setup command as follows:
							
# engine-setup --reconfigure-optional-components

	
								Answer Yes to install Grafana on this machine:
							
Configure Grafana on this host (Yes, No) [Yes]:

	
								Disable global maintenance mode:
							
# hosted-engine --set-maintenance --mode=none




						To access the Grafana dashboards:
					
	
								Go to https://<engine FQDN or IP address>/ovirt-engine-grafana
							



						or
					
	
								Click Monitoring Portal in the web administration welcome page for the Administration Portal.
							


Configuring Grafana for Single Sign-on




							The Manager engine-setup automatically configures Grafana to allow existing users on the Manager to log in with SSO from the Administration Portal, but does not automatically create users. You need to create new users (Invite in the Grafana UI), confirm the new user, and then they can log in.
						
	
									Set an email address for the user in the Manager, if it is not already defined.
								
	
									Log in to Grafana with an existing admin user (the initially configured admin).
								
	
									Go to Configuration → Users and select Invite.
								
	
									Input the email address and name, and select a Role.
								
	
									Send the invitation using one of these options:
								
	
											Select Send invite mail and click Submit. For this option, you need an operational local mail server configured on the Grafana machine.
										

											or
										

	
											Select Pending Invites
										
	
													Locate the entry you want
												
	
													Select Copy invite
												
	
													Copy and use this link to create the account by pasting it directly into a browser address bar, or by sending it to another user.
												









							If you use the Pending Invites option, no email is sent, and the email address does not really need to exist - any valid looking address will work, as long as it’s configured as the email address of a Manager user.
						
To log in with this account:
	
									Log in to the Red Hat Virtualization web administration welcome page using the account that has this email address.
								
	
									Select Monitoring Portal to open the Grafana dashboard.
								
	
									Select Sign in with oVirt Engine Auth.
								




Built-in Grafana dashboards




						The following dashboards are available in the initial Grafana setup to report Data Center, Cluster, Host, and Virtual Machine data:
					
Table 4.1. Built-in Grafana dashboards
	Dashboard type	Content
	 
										Executive dashboards
									

									 	 	
												System dashboard - resource usage and up-time for hosts and storage domains in the system, according to the latest configurations.
											
	
												Data Center dashboard - resource usage, peaks, and up-time for clusters, hosts, and storage domains in a selected data center, according to the latest configurations.
											
	
												Cluster dashboard - resource usage, peaks, over-commit, and up-time for hosts and virtual machines in a selected cluster, according to the latest configurations.
											
	
												Host dashboard - latest and historical configuration details and resource usage metrics of a selected host over a selected period.
											
	
												Virtual Machine dashboard - latest and historical configuration details and resource usage metrics of a selected virtual machine over a selected period.
											
	
												Executive dashboard - user resource usage and number of operating systems for hosts and virtual machines in selected clusters over a selected period.
											



									 
	 
										Inventory dashboards
									

									 	 	
												Inventory dashboard - number of hosts, virtual machines, and running virtual machines, resources usage and over-commit rates for selected data centers, according to the latest configurations.
											
	
												Hosts Inventory dashboard - FQDN, VDSM version, operating system, CPU model, CPU cores, memory size, create date, delete date, and hardware details for selected hosts, according to the latest configurations.
											
	
												Storage Domains Inventory dashboard - domain type, storage type, available disk size, used disk size, total disk size, creation date, and delete date for selected storage domains over a selected period.
											
	
												Virtual Machines Inventory dashboard - template name, operating system, CPU cores, memory size, create date, and delete date for selected virtual machines, according to the latest configurations.
											



									 
	 
										Service Level dashboards
									

									 	 	
												Uptime dashboard - planned downtime, unplanned downtime, and total time for the hosts, high availability virtual machines, and all virtual machines in selected clusters in a selected period.
											
	
												Hosts Uptime dashboard - the uptime, planned downtime, and unplanned downtime for selected hosts in a selected period.
											
	
												Virtual Machines Uptime dashboard - the uptime, planned downtime, and unplanned downtime for selected virtual machines in a selected period.
											
	
												Cluster Quality of Service
											
	
														Hosts dashboard - the time selected hosts have performed above and below the CPU and memory threshold in a selected period.
													
	
														Virtual Machines dashboard - the time selected virtual machines have performed above and below the CPU and memory threshold in a selected period.
													






									 
	 
										Trend dashboards
									

									 	 	
												Trend dashboard - usage rates for the 5 most and least utilized virtual machines and hosts by memory and by CPU in selected clusters over a selected period.
											
	
												Hosts Trend dashboard - resource usage (number of virtual machines, CPU, memory, and network Tx/Rx) for selected hosts over a selected period.
											
	
												Virtual Machines Trend dashboard -resource usage (CPU, memory, network Tx/Rx, disk I/O) for selected virtual machines over a selected period.
											
	
												Hosts Resource Usage dashboard - daily and hourly resource usage (number of virtual machines, CPU, memory, network Tx/Rx) for selected hosts in a selected period.
											
	
												Virtual Machines Resource Usage dashboard - daily and hourly resource usage (CPU, memory, network Tx/Rx, disk I/O) for selected virtual machines in a selected period.
											



									 



Note

							The Grafana dashboards includes direct links to the Red Hat Virtualization Administration Portal, allowing you to quickly view additional details for your clusters, hosts, and virtual machines.
						


Customized Grafana dashboards




						You can create customized dashboards or copy and modify existing dashboards according to your reporting needs.
					
Note

							Built-in dashboards cannot be customized.
						



Sending metrics and logs to a remote instance of Elasticsearch



Note

						Red Hat does not own or maintain Elasticsearch. You need to have a working familiarity with Elasticsearch setup and maintenance to deploy this option.
					


					You can configure the Red Hat Virtualization Manager and hosts to send metrics data and logs to your existing Elasticsearch instance.
				

					To do this, run the Ansible role that configures collectd and rsyslog on the Manager and all hosts to collect engine.log, vdsm.log, and collectd metrics, and send them to your Elasticsearch instance.
				

					For more information, including a full list with explanations of available Metrics Schema, see Sending RHV monitoring data to a remote Elasticsearch instance.
				
Installing collectd and rsyslog




						Deploy collectd and rsyslog on the hosts to collect logs and metrics.
					
Note

							You do not need to repeat this procedure for new hosts. Every new host that is added is automatically configured by the Manager to send the data to Elasticsearch during host-deploy.
						

Procedure
	
								Log in to the Manager machine using SSH.
							
	
								Copy /etc/ovirt-engine-metrics/config.yml.example to create /etc/ovirt-engine-metrics/config.yml.d/config.yml:
							
# cp /etc/ovirt-engine-metrics/config.yml.example /etc/ovirt-engine-metrics/config.yml.d/config.yml

	
								Edit the ovirt_env_name and elasticsearch_host parameters in config.yml and save the file. The following additional parameters can be added to the file:
							
use_omelasticsearch_cert: false
rsyslog_elasticsearch_usehttps_metrics: !!str off
rsyslog_elasticsearch_usehttps_logs: !!str off
	
										When using certificates, set use_omelasticsearch_cert to true.
									
	
										To disable logs or metrics, use the rsyslog_elasticsearch_usehttps_metrics and/or rsyslog_elasticsearch_usehttps_logs parameters.
									



	
								Deploy collectd and rsyslog on the hosts:
							
# /usr/share/ovirt-engine-metrics/setup/ansible/configure_ovirt_machines_for_metrics.sh

								The configure_ovirt_machines_for_metrics.sh script runs an Ansible role that includes linux-system-roles (see Administration and configuration tasks using System Roles in RHEL) and uses it to deploy and configure rsyslog on the host. rsyslog collects metrics from collectd and sends them to Elasticsearch.
							




Logging schema and analyzing logs




						Use the Discover page to interactively explore data collected from RHV. Each set of results that is collected is referred to as a document. Documents are collected from the following log files:
					
	
								engine.log - contains all oVirt Engine UI crashes, Active Directory lookups, database issues, and other events.
							
	
								vdsm.log - the log file for the VDSM, the Manager’s agent on the virtualization hosts, and contains host-related events.
							



						The following fields are available:
					
	parameter	description
	 
										_id
									

									 	 
										The unique ID of the document
									

									 
	 
										_index
									

									 	 
										The ID of the index to which the document belongs. The index with the project.ovirt-logs prefix is the only relevant index in the Discover page.
									

									 
	 
										hostname
									

									 	 
										For the engine.log this is the hostname of the Manager. For the vdsm.log this is the hostname of the host.
									

									 
	 
										level
									

									 	 
										The log record severity: TRACE, DEBUG, INFO, WARN, ERROR, FATAL.
									

									 
	 
										message
									

									 	 
										The body of the document message.
									

									 
	 
										ovirt.class
									

									 	 
										The name of a Java class that produced this log.
									

									 
	 
										ovirt.correlationid
									

									 	 
										For the engine.log only. This ID is used to correlate the multiple parts of a single task performed by the Manager.
									

									 
	 
										ovirt.thread
									

									 	 
										The name of a Java thread inside which the log record was produced.
									

									 
	 
										tag
									

									 	 
										Predefined sets of metadata that can be used to filter the data.
									

									 
	 
										@timestamp
									

									 	 
										The [time](Troubleshooting#information-is-missing-from-kibana) that the record was issued.
									

									 
	 
										_score
									

									 	 
										N/A
									

									 
	 
										_type
									

									 	 
										N/A
									

									 
	 
										ipaddr4
									

									 	 
										The machine’s IP address.
									

									 
	 
										ovirt.cluster_name
									

									 	 
										For the vdsm.log only. The name of the cluster to which the host belongs.
									

									 
	 
										ovirt.engine_fqdn
									

									 	 
										The Manager’s FQDN.
									

									 
	 
										ovirt.module_lineno
									

									 	 
										The file and line number within the file that ran the command defined in ovirt.class.
									

									 




Deploying Insights




					To deploy Red Hat Insights on an existing Red Hat Enterprise Linux (RHEL) system with Red Hat Virtualization Manager installed, complete these tasks:
				
	
							Register the system to the Red Hat Insights application.
						
	
							Enable data collection from the Red Hat Virtualization environment.
						


Register the system to Red Hat Insights




						Register the system to communicate with the Red Hat Insights service and to view results displayed in the Red Hat Insights console.
					
[root@server ~]# insights-client --register

Enable data collection from the Red Hat Virtualization environment




						Modify the /etc/ovirt-engine/rhv-log-collector-analyzer/rhv-log-collector-analyzer.conf file to include the following line:
					
upload-json=True

View your Insights results in the Insights Console




						System and infrastructure results can be viewed in the Insights console. The Overview tab provides a dashboard view of current risks to your infrastructure. From this starting point, you can investigate how a specific rule is affecting your system, or take a system-based approach to view all the rule matches that pose a risk to the system.
					
Procedure
	
								Select Rule hits by severity to view rules by the Total Risk they pose to your infrastructure (Critical, Important, Moderate, or Low).
							

								Or
							

	
								Select Rule hits by category to see the type of risk they pose to your infrastructure (Availability, Stability, Performance, or Security).
							
	
								Search for a specific rule by name, or scroll through the list of rules to see high-level information about risk, systems exposed, and availability of Ansible Playbook to automate remediation.
							
	
								Click a rule to see a description of the rule, learn more from relevant knowledge base articles, and view a list of systems that are affected.
							
	
								Click a system to see specific information about detected issues and steps to resolve the issue.
							





Log Files



Manager Installation Log Files



Table 4.2. Installation
	Log File	Description
	 
									/var/log/ovirt-engine/engine-cleanup_yyyy_mm_dd_hh_mm_ss.log
								

								 	 
									Log from the engine-cleanup command. This is the command used to reset a Red Hat Virtualization Manager installation. A log is generated each time the command is run. The date and time of the run is used in the filename to allow multiple logs to exist.
								

								 
	 
									/var/log/ovirt-engine/engine-db-install-yyyy_mm_dd_hh_mm_ss.log
								

								 	 
									Log from the engine-setup command detailing the creation and configuration of the engine database.
								

								 
	 
									/var/log/ovirt-engine/ovirt-engine-dwh-setup-yyyy_mm_dd_hh_mm_ss.log
								

								 	 
									Log from the ovirt-engine-dwh-setup command. This is the command used to create the ovirt_engine_history database for reporting. A log is generated each time the command is run. The date and time of the run is used in the filename to allow multiple logs to exist concurrently.
								

								 
	 
									/var/log/ovirt-engine/setup/ovirt-engine-setup-yyyymmddhhmmss.log
								

								 	 
									Log from the engine-setup command. A log is generated each time the command is run. The date and time of the run is used in the filename to allow multiple logs to exist concurrently.
								

								 




Red Hat Virtualization Manager Log Files



Table 4.3. Service Activity
	Log File	Description
	 
									/var/log/ovirt-engine/engine.log
								

								 	 
									Reflects all Red Hat Virtualization Manager GUI crashes, Active Directory lookups, Database issues, and other events.
								

								 
	 
									/var/log/ovirt-engine/host-deploy
								

								 	 
									Log files from hosts deployed from the Red Hat Virtualization Manager.
								

								 
	 
									/var/lib/ovirt-engine/setup-history.txt
								

								 	 
									Tracks the installation and upgrade of packages associated with the Red Hat Virtualization Manager.
								

								 
	 
									/var/log/httpd/ovirt-requests-log
								

								 	 
									Logs files from requests made to the Red Hat Virtualization Manager via HTTPS, including how long each request took.
								

								 
									A Correlation-Id header is included to allow you to compare requests when comparing a log file with /var/log/ovirt-engine/engine.log.
								

								 
	 
									/var/log/ovn-provider/ovirt-provider-ovn.log
								

								 	 
									Logs the activities of the OVN provider. For information about Open vSwitch logs, see the Open vSwitch documentation.
								

								 




SPICE Log Files




					SPICE log files are useful when troubleshooting SPICE connection issues. To start SPICE debugging, change the log level to debugging. Then, identify the log location.
				

					Both the clients used to access the guest machines and the guest machines themselves have SPICE log files. For client-side logs, if a SPICE client was launched using the native client, for which a console.vv file is downloaded, use the remote-viewer command to enable debugging and generate log output.
				
SPICE Logs for Hypervisor SPICE Servers



Table 4.4. SPICE Logs for Hypervisor SPICE Servers
	Log Type	Log Location	To Change Log Level:
	 
										Host/Hypervisor SPICE Server
									

									 	 
										/var/log/libvirt/qemu/(guest_name).log
									

									 	 
										Run export SPICE_DEBUG_LEVEL=5 on the host/hypervisor prior to launching the guest. This variable is parsed by QEMU, and if run system-wide will print the debugging information of all virtual machines on the system. This command must be run on each host in the cluster. This command works only on a per-host/hypervisor basis, not a per-cluster basis.
									

									 




SPICE Logs for Guest Machines



Table 4.5. spice-vdagent Logs for Guest Machines
	Log Type	Log Location	To Change Log Level:
	 
										Windows Guest
									

									 	 
										C:\Windows\Temp\vdagent.log
									

									 
										C:\Windows\Temp\vdservice.log
									

									 	 
										Not applicable
									

									 
	 
										Red Hat Enterprise Linux Guest
									

									 	 
										Use journalctl as the root user.
									

									 	 
										To run the spice-vdagentd service in debug mode, as the root user create a /etc/sysconfig/spice-vdagentd file with this entry: SPICE_VDAGENTD_EXTRA_ARGS=”-d -d”
									

									 
										To run spice-vdagent in debug mode, from the command line:
									

									 
$ killall - u $USER spice-vdagent
$ spice-vdagent -x -d [-d] [ |& tee spice-vdagent.log ]

									 




SPICE Logs for SPICE Clients Launched Using console.vv Files




						For Linux client machines:
					
	
								Enable SPICE debugging by running the remote-viewer command with the --spice-debug option. When prompted, enter the connection URL, for example, spice://virtual_machine_IP:port.
							
#  remote-viewer --spice-debug

	
								To run SPICE client with the debug parameter and to pass a .vv file to it, download the console.vv file and run the remote-viewer command with the --spice-debug option and specify the full path to the console.vv file.
							
# remote-viewer --spice-debug /path/to/console.vv




						For Windows client machines:
					
	
								In versions of virt-viewer 2.0-11.el7ev and later, virt-viewer.msi installs virt-viewer and debug-viewer.exe.
							
	
								Run the remote-viewer command with the spice-debug argument and direct the command at the path to the console:
							
remote-viewer --spice-debug path\to\console.vv

	
								To view logs, connect to the virtual machine, and you will see a command prompt running GDB that prints standard output and standard error of remote-viewer.
							




Host Log Files



	Log File	Description
	 
									/var/log/messages
								

								 	 
									The log file used by libvirt. Use journalctl to view the log. You must be a member of the adm, systemd-journal, or wheel groups to view the log.
								

								 
	 
									/var/log/vdsm/spm-lock.log
								

								 	 
									Log file detailing the host’s ability to obtain a lease on the Storage Pool Manager role. The log details when the host has acquired, released, renewed, or failed to renew the lease.
								

								 
	 
									/var/log/vdsm/vdsm.log
								

								 	 
									Log file for VDSM, the Manager’s agent on the host(s).
								

								 
	 
									/tmp/ovirt-host-deploy-Date.log
								

								 	 
									A host deployment log that is copied to the Manager as /var/log/ovirt-engine/host-deploy/ovirt-Date-Host-Correlation_ID.log after the host has been successfully deployed.
								

								 
	 
									/var/log/vdsm/import/import-UUID-Date.log
								

								 	 
									Log file detailing virtual machine imports from a KVM host, a VMWare provider, or a RHEL 5 Xen host, including import failure information. UUID is the UUID of the virtual machine that was imported and Date is the date and time that the import began.
								

								 
	 
									/var/log/vdsm/supervdsm.log
								

								 	 
									Logs VDSM tasks that were executed with superuser permissions.
								

								 
	 
									/var/log/vdsm/upgrade.log
								

								 	 
									VDSM uses this log file during host upgrades to log configuration changes.
								

								 
	 
									/var/log/vdsm/mom.log
								

								 	 
									Logs the activities of the VDSM’s memory overcommitment manager.
								

								 



Setting debug-level logging for Red Hat Virtualization services



Note

						Setting logging to debug-level may expose sensitive information such as passwords or internal VM data. Make sure that non-trusted or unauthorized users do not have access to debug logs.
					


					You can set the logs of the following Red Hat Virtualization (RHV) services to debug-level by modifying the sysconfig file of each service.
				
Table 4.6. RHV services and sysconfig file paths
	Service	File path
	 
									ovirt-engine.service
								

								 	 
									/etc/sysconfig/ovirt-engine
								

								 
	 
									ovirt-engine-dwhd.service
								

								 	 
									/etc/sysconfig/ovirt-engine-dwhd
								

								 
	 
									ovirt-fence-kdump-listener.service
								

								 	 
									/etc/sysconfig/ovirt-fence-kdump-listener
								

								 
	 
									ovirt-websocket-proxy.service
								

								 	 
									/etc/sysconfig/ovirt-websocket-proxy
								

								 




					This modification affects logging done by the Python wrapper, not the main service process.
				

					Setting logging to debug-level is useful for debugging issues related to start up - for example, if the main process fails to start due to a missing or incorrect Java runtime or library.
				
Prerequisites
	
							Verify that the sysconfig file you want to modify exists. If necessary, create it.
						


Procedure
	
							Add the following to the sysconfig file of the service:
						
OVIRT_SERVICE_DEBUG=1

	
							Restart the service:
						
# systemctl restart <service>




					The sysconfig log file of the service is now set to debug-level.
				

					Logging caused by this setting goes to the system log, so the logs it generates can be found in /var/log/messages, not in the service-specific log file, or by using the journalctl command.
				

Main configuration files for Red Hat Virtualization services




					In addition to a sysconfig file, each of these Red Hat Virtualization (RHV) services has another configuration file that is used more often.
				
Table 4.7. RHV services and configuration files
	Service	sysconfig file path	Main configuration file
	 
									ovirt-engine.service
								

								 	 
									/etc/sysconfig/ovirt-engine
								

								 	 
									/etc/ovirt-engine/engine.conf.d/*.conf
								

								 
	 
									ovirt-engine-dwhd.service
								

								 	 
									/etc/sysconfig/ovirt-engine-dwhd
								

								 	 
									/etc/ovirt-engine-dwh/ovirt-engine-dwhd.conf.d/*.conf
								

								 
	 
									ovirt-fence-kdump-listener.service
								

								 	 
									/etc/sysconfig/ovirt-fence-kdump-listener
								

								 	 
									/etc/ovirt-engine/ovirt-fence-kdump-listener.conf.d/*.conf
								

								 
	 
									ovirt-websocket-proxy.service
								

								 	 
									/etc/sysconfig/ovirt-websocket-proxy
								

								 	 
									/etc/ovirt-engine/ovirt-websocket-proxy.conf.d/*.conf
								

								 




Setting Up a Host Logging Server




					Hosts generate and update log files, recording their actions and problems. Collecting these log files centrally simplifies debugging.
				

					This procedure should be used on your centralized log server. You could use a separate logging server, or use this procedure to enable host logging on the Red Hat Virtualization Manager.
				
Procedure
	
							Check to see if the firewall allows traffic on the UDP 514 port, and is open to syslog service traffic:
						
# firewall-cmd --query-service=syslog

							If the output is no, allow traffic on the UDP 514 port with:
						
# firewall-cmd --add-service=syslog --permanent
# firewall-cmd --reload

	
							Create a new .conf file on the syslog server, for example, /etc/rsyslog.d/from_remote.conf, and add the following lines:
						
template(name="DynFile" type="string" string="/var/log/%HOSTNAME%/%PROGRAMNAME%.log")
RuleSet(name="RemoteMachine"){  action(type="omfile" dynaFile="DynFile")  }
Module(load="imudp")
Input(type="imudp" port="514" ruleset="RemoteMachine")

	
							Restart the rsyslog service:
						
# systemctl restart rsyslog.service

	
							Log in to the hypervisor, and in the /etc/rsyslog.conf add the following line:
						
*.info;mail.none;authpriv.none;cron.none @<syslog-FQDN>:514

	
							Restart the rsyslog service on the hypervisor.
						
# systemctl restart rsyslog.service




					Your centralized log server is now configured to receive and store the messages and secure logs from your virtualization hosts.
				

Enabling SyslogHandler to pass RHV Manager logs to a remote syslog server




					This implementation uses the JBoss EAP SyslogHandler log manager and enables passing log records from the engine.log and server.log to a syslog server.
				
Note

						RHV versions earlier than RHV 4.4.10 featured similar functionality provided by ovirt-engine-extension-logger-log4j. That package was removed in RHV 4.4.10 and replaced by a new implementation using the JBoss EAP SyslogHandler log manager. If you have been using ovirt-engine-extension-logger-log4j in earlier RHV versions, following an upgrade to RHV 4.4.10, perform following steps:
					
	
								Manually configure sending log records to a remote syslog server using the guidelines provided in this chapter.
							
	
								Manually remove the ovirt-engine-extension-logger-log4j configuration files (remove the /etc/ovirt-engine/extensions.d/Log4jLogger.properties configuration file).
							




					Use this procedure on the central syslog server. You can use a separate logging server, or use this procedure to pass the engine.log and server.log files from the Manager to the syslog server. See also the configuration procedure Setting up a Host Logging Server.
				
Configuring the SyslogHandler implementation
	
							Create the configuration file 90-syslog.conf in the /etc/ovirt-engine/engine.conf.d directory and add the following content:
						
SYSLOG_HANDLER_ENABLED=true
SYSLOG_HANDLER_SERVER_HOSTNAME=localhost
SYSLOG_HANDLER_FACILITY=USER_LEVEL

	
							Install and configure rsyslog.
						
# dnf install rsyslog

	
							Configure SELinux to allow rsyslog traffic.
						
# semanage port -a -t syslogd_port_t -p udp 514

	
							Create the configuration file /etc/rsyslog.d/rhvm.conf and add the following content:
						
user.* /var/log/jboss.log
module(load="imudp") # needs to be done just once
input(type="imudp" port="514")

	
							Restart the rsyslog service.
						
# systemctl restart rsyslog.service

	
							If the firewall is enabled and active, run the following command to add the necessary rules for opening the rsyslog ports in Firewalld:
						
# firewall-cmd --permanent --add-port=514/udp
# firewall-cmd --reload

	
							Restart Red Hat Virtualization Manager.
						
# systemctl restart ovirt-engine




					The syslog server can now receive and store the engine.log files.
				



Appendix A. VDSM Service and Hooks




			The VDSM service is used by the Red Hat Virtualization Manager to manage Red Hat Virtualization Hosts (RHVH) and Red Hat Enterprise Linux hosts. VDSM manages and monitors the host’s storage, memory, and network resources. It also coordinates virtual machine creation, statistics gathering, log collection and other host administration tasks. VDSM is run as a daemon on each host managed by Red Hat Virtualization Manager. It answers XML-RPC calls from clients. The Red Hat Virtualization Manager functions as a VDSM client.
		

			VDSM is extensible via hooks. Hooks are scripts executed on the host when key events occur. When a supported event occurs VDSM runs any executable hook scripts in /usr/libexec/vdsm/hooks/nn_event-name/ on the host in alphanumeric order. By convention each hook script is assigned a two digit number, included at the front of the file name, to ensure that the order in which the scripts will be run in is clear. You are able to create hook scripts in any programming language, Python will however be used for the examples contained in this chapter.
		

			Note that all scripts defined on the host for the event are executed. If you require that a given hook is only executed for a subset of the virtual machines which run on the host then you must ensure that the hook script itself handles this requirement by evaluating the Custom Properties associated with the virtual machine.
		
Warning

				VDSM hooks can interfere with the operation of Red Hat Virtualization. A bug in a VDSM hook has the potential to cause virtual machine crashes and loss of data. VDSM hooks should be implemented with caution and tested rigorously. The Hooks API is new and subject to significant change in the future.
			


			You can extend VDSM with event-driven hooks. Extending VDSM with hooks is an experimental technology, and this chapter is intended for experienced developers.
		

			By setting custom properties on virtual machines it is possible to pass additional parameters, specific to a given virtual machine, to the hook scripts.
		
Installing a VDSM hook




				By default, VDSM hooks are not installed. If you need a specific hook, you must install it manually.
			
Prerequisites
	
						The host repository must be enabled.
					
	
						You are logged into the host with root permissions.
					


Procedure
	
						Get a list of available hooks:
					
# dnf list vdsm\*hook\*

	
						Put the host in maintenance mode.
					
	
						Install the desired VDSM hook package on the host:
					
# dnf install <vdsm-hook-name>

						For example, to install the vdsm-hook-vhostmd package on the host, enter the following:
					
# dnf install vdsm-hook-vhostmd

	
						Restart the host.
					


Additional resources
	
						Enabling the Red Hat Virtualization Host Repository
					
	
						Enabling the Red Hat Enterprise Linux host Repositories
					



Supported VDSM Events



Table A.1. Supported VDSM Events
	Name	Description
	 
								before_vm_start
							

							 	 
								Before virtual machine starts.
							

							 
	 
								after_vm_start
							

							 	 
								After virtual machine starts.
							

							 
	 
								before_vm_cont
							

							 	 
								Before virtual machine continues.
							

							 
	 
								after_vm_cont
							

							 	 
								After virtual machine continues.
							

							 
	 
								before_vm_pause
							

							 	 
								Before virtual machine pauses.
							

							 
	 
								after_vm_pause
							

							 	 
								After virtual machine pauses.
							

							 
	 
								before_vm_hibernate
							

							 	 
								Before virtual machine hibernates.
							

							 
	 
								after_vm_hibernate
							

							 	 
								After virtual machine hibernates.
							

							 
	 
								before_vm_dehibernate
							

							 	 
								Before virtual machine dehibernates.
							

							 
	 
								after_vm_dehibernate
							

							 	 
								After virtual machine dehibernates.
							

							 
	 
								before_vm_migrate_source
							

							 	 
								Before virtual machine migration, run on the source host from which the migration is occurring.
							

							 
	 
								after_vm_migrate_source
							

							 	 
								After virtual machine migration, run on the source host from which the migration is occurring.
							

							 
	 
								before_vm_migrate_destination
							

							 	 
								Before virtual machine migration, run on the destination host to which the migration is occurring.
							

							 
	 
								after_vm_migrate_destination
							

							 	 
								After virtual machine migration, run on the destination host to which the migration is occurring.
							

							 
	 
								after_vm_destroy
							

							 	 
								After virtual machine destruction.
							

							 
	 
								before_vdsm_start
							

							 	 
								Before VDSM is started on the host. before_vdsm_start hooks are executed as the user root, and do not inherit the environment of the VDSM process.
							

							 
	 
								after_vdsm_stop
							

							 	 
								After VDSM is stopped on the host. after_vdsm_stop hooks are executed as the user root, and do not inherit the environment of the VDSM process.
							

							 
	 
								before_nic_hotplug
							

							 	 
								Before the NIC is hot plugged into the virtual machine.
							

							 
	 
								after_nic_hotplug
							

							 	 
								After the NIC is hot plugged into the virtual machine.
							

							 
	 
								before_nic_hotunplug
							

							 	 
								Before the NIC is hot unplugged from the virtual machine
							

							 
	 
								after_nic_hotunplug
							

							 	 
								After the NIC is hot unplugged from the virtual machine.
							

							 
	 
								after_nic_hotplug_fail
							

							 	 
								After hot plugging the NIC to the virtual machine fails.
							

							 
	 
								after_nic_hotunplug_fail
							

							 	 
								After hot unplugging the NIC from the virtual machine fails.
							

							 
	 
								before_disk_hotplug
							

							 	 
								Before the disk is hot plugged into the virtual machine.
							

							 
	 
								after_disk_hotplug
							

							 	 
								After the disk is hot plugged into the virtual machine.
							

							 
	 
								before_disk_hotunplug
							

							 	 
								Before the disk is hot unplugged from the virtual machine
							

							 
	 
								after_disk_hotunplug
							

							 	 
								After the disk is hot unplugged from the virtual machine.
							

							 
	 
								after_disk_hotplug_fail
							

							 	 
								After hot plugging the disk to the virtual machine fails.
							

							 
	 
								after_disk_hotunplug_fail
							

							 	 
								After hot unplugging the disk from the virtual machine fails.
							

							 
	 
								before_device_create
							

							 	 
								Before creating a device that supports custom properties.
							

							 
	 
								after_device_create
							

							 	 
								After creating a device that supports custom properties.
							

							 
	 
								before_update_device
							

							 	 
								Before updating a device that supports custom properties.
							

							 
	 
								after_update_device
							

							 	 
								After updating a device that supports custom properties.
							

							 
	 
								before_device_destroy
							

							 	 
								Before destroying a device that supports custom properties.
							

							 
	 
								after_device_destroy
							

							 	 
								After destroying a device that supports custom properties.
							

							 
	 
								before_device_migrate_destination
							

							 	 
								Before device migration, run on the destination host to which the migration is occurring.
							

							 
	 
								after_device_migrate_destination
							

							 	 
								After device migration, run on the destination host to which the migration is occurring.
							

							 
	 
								before_device_migrate_source
							

							 	 
								Before device migration, run on the source host from which the migration is occurring.
							

							 
	 
								after_device_migrate_source
							

							 	 
								After device migration, run on the source host from which the migration is occurring.
							

							 
	 
								after_network_setup
							

							 	 
								After setting up the network when starting a host machine.
							

							 
	 
								before_network_setup
							

							 	 
								Before setting up the network when starting a host machine.
							

							 




The VDSM Hook Environment




				Most hook scripts are run as the vdsm user and inherit the environment of the VDSM process. The exceptions are hook scripts triggered by the before_vdsm_start and after_vdsm_stop events. Hook scripts triggered by these events run as the root user and do not inherit the environment of the VDSM process.
			

The VDSM Hook Domain XML Object




				VDSM uses the libvirt domain XML format to define virtual machines. The UUID of the virtual machine may be deduced from the domain XML, but it is also available as the environment variable vmId.
			

				When hook scripts are started, the _hook_domxml variable is appended to the environment. This variable contains the path of the libvirt domain XML representation of the relevant virtual machine.
			

				Some hooks are an exception to this rule. The following hooks contain the XML representation of the NIC, not the virtual machine:
			
	
						*_nic_hotplug_*
					
	
						*_nic_hotunplug_*
					
	
						*_update_device
					
	
						*_device_create
					
	
						*_device_migrate_*
					


Important

					The before_migration_destination and before_dehibernation hooks currently receive the domain XML from the source host. The domain XML at the destination will be different.
				


Defining Custom Properties




				The custom properties that are accepted by the Red Hat Virtualization Manager - and in turn passed to custom hooks - are defined using the engine-config command. Run this command as the root user on the host where Red Hat Virtualization Manager is installed.
			

				The UserDefinedVMProperties and CustomDeviceProperties configuration keys are used to store the names of the custom properties supported. Regular expressions defining the valid values for each named custom property are also contained in these configuration keys.
			

				Multiple custom properties are separated by a semi-colon. Note that when setting the configuration key, any existing value it contained is overwritten. When combining new and existing custom properties, all of the custom properties in the command used to set the key’s value must be included.
			

				Once the configuration key has been updated, the ovirt-engine service must be restarted for the new values to take effect.
			
Example A.1. Virtual Machine Properties - Defining the smartcard Custom Property
	
							Check the existing custom properties defined by the UserDefinedVMProperties configuration key using the following command:
						
# engine-config -g UserDefinedVMProperties

							As shown by the output below, the custom property memory is already defined. The regular expression ^[0-9]+$ ensures that the custom property will only ever contain numeric characters.
						
# engine-config -g UserDefinedVMProperties
UserDefinedVMProperties:  version: 4.3
UserDefinedVMProperties:  version: 4.4
UserDefinedVMProperties : memory=^[0-9]+$ version: 4.4

	
							Because the memory custom property is already defined in the UserDefinedVMProperties configuration key, the new custom property must be appended to it. The additional custom property, smartcard, is added to the configuration key’s value. The new custom property is able to hold a value of true or false.
						
# engine-config -s UserDefinedVMProperties='memory=^[0-9]+$;smartcard=^(true|false)$' --cver=4.4

	
							Verify that the custom properties defined by the UserDefinedVMProperties configuration key have been updated correctly.
						
# engine-config -g UserDefinedVMProperties
UserDefinedVMProperties:  version: 4.3
UserDefinedVMProperties:  version: 4.4
UserDefinedVMProperties : memory=^[0-9]+$;smartcard=^(true|false)$ version: 4.4

	
							Finally, the ovirt-engine service must be restarted for the configuration change to take effect.
						
# systemctl restart ovirt-engine.service





Example A.2. Device Properties - Defining the interface Custom Property
	
							Check the existing custom properties defined by the CustomDeviceProperties configuration key using the following command:
						
# engine-config -g CustomDeviceProperties

							As shown by the output below, no custom properties have yet been defined.
						
# engine-config -g CustomDeviceProperties
CustomDeviceProperties:  version: 4.3
CustomDeviceProperties:  version: 4.4

	
							The interface custom property does not already exist, so it can be appended as is. In this example, the value of the speed sub-property is set to a range of 0 to 99999, and the value of the duplex sub-property is set to a selection of either full or half.
						
# engine-config -s CustomDeviceProperties="{type=interface;prop={speed=^([0-9]{1,5})$;duplex=^(full|half)$}}" --cver=4.4

	
							Verify that the custom properties defined by the CustomDeviceProperties configuration key have been updated correctly.
						
# engine-config -g CustomDeviceProperties
UserDefinedVMProperties:  version: 4.3
UserDefinedVMProperties:  version: 4.4
UserDefinedVMProperties : {type=interface;prop={speed=^([0-9]{1,5})$;duplex=^(full|half)$}} version: 4.4

	
							Finally, the ovirt-engine service must be restarted for the configuration change to take effect.
						
# systemctl restart ovirt-engine.service






Setting Virtual Machine Custom Properties




				Once custom properties are defined in the Red Hat Virtualization Manager, you can begin setting them on virtual machines. Custom properties are set on the Custom Properties tab of the New Virtual Machine and Edit Virtual Machine windows in the Administration Portal.
			

				You can also set custom properties from the Run Virtual Machine(s) dialog box. Custom properties set from the Run Virtual Machine(s) dialog box will only apply to the virtual machine until it is next shutdown.
			

				The Custom Properties tab provides a facility for you to select from the list of defined custom properties. Once you select a custom property key an additional field will display allowing you to enter a value for that key. Add additional key/value pairs by clicking the + button and remove them by clicking the - button.
			

Evaluating Virtual Machine Custom Properties in a VDSM Hook




				Each key set in the Custom Properties field for a virtual machine is appended as an environment variable when calling hook scripts. Although the regular expressions used to validate the Custom Properties field provide some protection you should ensure that your scripts also validate that the inputs provided match their expectations.
			
Example A.3. Evaluating Custom Properties

					This short Python example checks for the existence of the custom property key1. If the custom property is set then the value is printed to standard error. If the custom property is not set then no action is taken.
				
#!/usr/bin/python

import os
import sys

if os.environ.has_key('key1'):
	sys.stderr.write('key1 value was : %s\n' % os.environ['key1'])
else:
    sys.exit(0)



Using the VDSM Hooking Module




				VDSM ships with a Python hooking module, providing helper functions for VDSM hook scripts. This module is provided as an example, and is only relevant to VDSM hooks written in Python.
			

				The hooking module supports reading of a virtual machine’s libvirt XML into a DOM object. Hook scripts can then use Python’s built-in xml.dom library to manipulate the object.
			

				The modified object can then be saved back to libvirt XML using the hooking module. The hooking module provides the following functions to support hook development:
			
Table A.2. Hooking module functions
	Name	Argument	Description
	 
								tobool
							

							 	 
								string
							

							 	 
								Converts a string "true" or "false" to a Boolean value
							

							 
	 
								read_domxml
							

							 	 
								-
							

							 	 
								Reads the virtual machine’s libvirt XML into a DOM object
							

							 
	 
								write_domxml
							

							 	 
								DOM object
							

							 	 
								Writes the virtual machine’s libvirt XML from a DOM object
							

							 




VDSM Hook Execution




				before_vm_start scripts can edit the domain XML in order to change VDSM’s definition of a virtual machine before it reaches libvirt. Caution must be exercised in doing so. Hook scripts have the potential to disrupt the operation of VDSM, and buggy scripts can result in outages to the Red Hat Virtualization environment. In particular, ensure you never change the UUID of the domain, and do not attempt to remove a device from the domain without sufficient background knowledge.
			

				Both before_vdsm_start and after_vdsm_stop hook scripts are run as the root user. Other hook scripts that require root access to the system must be written to use the sudo command for privilege escalation. To support this the /etc/sudoers must be updated to allow the vdsm user to use sudo without reentering a password. This is required as hook scripts are executed non-interactively.
			
Example A.4. Configuring sudo for VDSM Hooks

					In this example the sudo command will be configured to allow the vdsm user to run the /bin/chown command as root.
				
	
							Log into the virtualization host as root.
						
	
							Open the /etc/sudoers file in a text editor.
						
	
							Add this line to the file:
						
vdsm ALL=(ALL) NOPASSWD: /bin/chown

							This specifies that the vdsm user has the ability to run the /bin/chown command as the root user. The NOPASSWD parameter indicates that the user will not be prompted to enter their password when calling sudo.
						




					Once this configuration change has been made VDSM hooks are able to use the sudo command to run /bin/chown as root. This Python code uses sudo to execute /bin/chown as root on the file /my_file.
				
retcode = subprocess.call( ["/usr/bin/sudo", "/bin/chown", "root", "/my_file"] )



				The standard error stream of hook scripts is collected in VDSM’s log. This information is used to debug hook scripts.
			

VDSM Hook Return Codes




				Hook scripts must return one of the return codes shown in hook return codes. The return code will determine whether further hook scripts are processed by VDSM.
			
Table A.3. Hook Return Codes
	Code	Description
	 
								0
							

							 	 
								The hook script ended successfully
							

							 
	 
								1
							

							 	 
								The hook script failed, other hooks should be processed
							

							 
	 
								2
							

							 	 
								The hook script failed, no further hooks should be processed
							

							 
	 
								>2
							

							 	 
								Reserved
							

							 




VDSM Hook Examples




				The example hook scripts provided in this section are strictly not supported by Red Hat. You must ensure that any and all hook scripts that you install to your system, regardless of source, are thoroughly tested for your environment.
			
Example A.5. NUMA Node Tuning

					Purpose:
				

					This hook script allows for tuning the allocation of memory on a NUMA host based on the numaset custom property. Where the custom property is not set no action is taken.
				

					Configuration String:
				
numaset=^(interleave|strict|preferred):[\^]?\d+(-\d+)?(,[\^]?\d+(-\d+)?)*$

					The regular expression used allows the numaset custom property for a given virtual machine to specify both the allocation mode (interleave, strict, preferred) and the node to use. The two values are separated by a colon (:). The regular expression allows specification of the nodeset as:
				
	
							that a specific node (numaset=strict:1, specifies that only node 1 be used), or
						
	
							that a range of nodes be used (numaset=strict:1-4, specifies that nodes 1 through 4 be used), or
						
	
							that a specific node not be used (numaset=strict:^3, specifies that node 3 not be used), or
						
	
							any comma-separated combination of the above (numaset=strict:1-4,6, specifies that nodes 1 to 4, and 6 be used).
						



					Script:
				

					/usr/libexec/vdsm/hooks/before_vm_start/50_numa
				
#!/usr/bin/python

import os
import sys
import hooking
import traceback

'''
numa hook
=========
add numa support for domain xml:

<numatune>
    <memory mode="strict" nodeset="1-4,^3" />
</numatune>

memory=interleave|strict|preferred

numaset="1" (use one NUMA node)
numaset="1-4" (use 1-4 NUMA nodes)
numaset="^3" (don't use NUMA node 3)
numaset="1-4,^3,6" (or combinations)

syntax:
    numa=strict:1-4
'''

if os.environ.has_key('numa'):
    try:
        mode, nodeset = os.environ['numa'].split(':')

        domxml = hooking.read_domxml()

        domain = domxml.getElementsByTagName('domain')[0]
        numas = domxml.getElementsByTagName('numatune')

        if not len(numas) > 0:
            numatune = domxml.createElement('numatune')
            domain.appendChild(numatune)

            memory = domxml.createElement('memory')
            memory.setAttribute('mode', mode)
            memory.setAttribute('nodeset', nodeset)
            numatune.appendChild(memory)

            hooking.write_domxml(domxml)
        else:
            sys.stderr.write('numa: numa already exists in domain xml')
            sys.exit(2)
    except:
        sys.stderr.write('numa: [unexpected error]: %s\n' % traceback.format_exc())
        sys.exit(2)




Appendix B. Custom Network Properties



Explanation of bridge_opts Parameters



Table B.1. bridge_opts parameters
	Parameter	Description
	 
								forward_delay
							

							 	 
								Sets the time, in deciseconds, a bridge will spend in the listening and learning states. If no switching loop is discovered in this time, the bridge will enter forwarding state. This allows time to inspect the traffic and layout of the network before normal network operation.
							

							 
	 
								group_addr
							

							 	 
								To send a general query, set this value to zero. To send a group-specific and group-and-source-specific queries, set this value to a 6-byte MAC address, not an IP address. Allowed values are 01:80:C2:00:00:0x except 01:80:C2:00:00:01, 01:80:C2:00:00:02 and 01:80:C2:00:00:03.
							

							 
	 
								group_fwd_mask
							

							 	 
								Enables bridge to forward link local group addresses. Changing this value from the default will allow non-standard bridging behavior.
							

							 
	 
								hash_max
							

							 	 
								The maximum amount of buckets in the hash table. This takes effect immediately and cannot be set to a value less than the current number of multicast group entries. Value must be a power of two.
							

							 
	 
								hello_time
							

							 	 
								Sets the time interval, in deciseconds, between sending 'hello' messages, announcing bridge position in the network topology. Applies only if this bridge is the Spanning Tree root bridge.
							

							 
	 
								max_age
							

							 	 
								Sets the maximum time, in deciseconds, to receive a 'hello' message from another root bridge before that bridge is considered dead and takeover begins.
							

							 
	 
								multicast_last_member_count
							

							 	 
								Sets the number of 'last member' queries sent to the multicast group after receiving a 'leave group' message from a host.
							

							 
	 
								multicast_last_member_interval
							

							 	 
								Sets the time, in deciseconds, between 'last member' queries.
							

							 
	 
								multicast_membership_interval
							

							 	 
								Sets the time, in deciseconds, that a bridge will wait to hear from a member of a multicast group before it stops sending multicast traffic to the host.
							

							 
	 
								multicast_querier
							

							 	 
								Sets whether the bridge actively runs a multicast querier or not. When a bridge receives a 'multicast host membership' query from another network host, that host is tracked based on the time that the query was received plus the multicast query interval time. If the bridge later attempts to forward traffic for that multicast membership, or is communicating with a querying multicast router, this timer confirms the validity of the querier. If valid, the multicast traffic is delivered via the bridge’s existing multicast membership table; if no longer valid, the traffic is sent via all bridge ports.Broadcast domains with, or expecting, multicast memberships should run at least one multicast querier for improved performance.
							

							 
	 
								multicast_querier_interval
							

							 	 
								Sets the maximum time, in deciseconds, between last 'multicast host membership' query received from a host to ensure it is still valid.
							

							 
	 
								multicast_query_use_ifaddr
							

							 	 
								Boolean. Defaults to '0', in which case the querier uses 0.0.0.0 as source address for IPv4 messages. Changing this sets the bridge IP as the source address.
							

							 
	 
								multicast_query_interval
							

							 	 
								Sets the time, in deciseconds, between query messages sent by the bridge to ensure validity of multicast memberships. At this time, or if the bridge is asked to send a multicast query for that membership, the bridge checks its own multicast querier state based on the time that a check was requested plus multicast_query_interval. If a multicast query for this membership has been sent within the last multicast_query_interval, it is not sent again.
							

							 
	 
								multicast_query_response_interval
							

							 	 
								Length of time, in deciseconds, a host is allowed to respond to a query once it has been sent.Must be less than or equal to the value of the multicast_query_interval.
							

							 
	 
								multicast_router
							

							 	 
								Allows you to enable or disable ports as having multicast routers attached. A port with one or more multicast routers will receive all multicast traffic. A value of 0 disables completely, a value of 1 enables the system to automatically detect the presence of routers based on queries, and a value of 2 enables ports to always receive all multicast traffic.
							

							 
	 
								multicast_snooping
							

							 	 
								Toggles whether snooping is enabled or disabled. Snooping allows the bridge to listen to the network traffic between routers and hosts to maintain a map to filter multicast traffic to the appropriate links.This option allows the user to re-enable snooping if it was automatically disabled due to hash collisions, however snooping will not be re-enabled if the hash collision has not been resolved.
							

							 
	 
								multicast_startup_query_count
							

							 	 
								Sets the number of queries sent out at startup to determine membership information.
							

							 
	 
								multicast_startup_query_interval
							

							 	 
								Sets the time, in deciseconds, between queries sent out at startup to determine membership information.
							

							 




How to Set Up Red Hat Virtualization Manager to Use Ethtool




				You can configure ethtool properties for host network interface cards from the Administration Portal. The ethtool_opts key is not available by default and needs to be added to the Manager using the engine configuration tool. You also need to install the required VDSM hook package on the hosts.
			

				Adding the ethtool_opts Key to the Manager
			
	
						On the Manager, run the following command to add the key:
					
# engine-config -s UserDefinedNetworkCustomProperties=ethtool_opts=.* --cver=4.4

	
						Restart the ovirt-engine service:
					
# systemctl restart ovirt-engine.service

	
						On the hosts that you want to configure ethtool properties, install the VDSM hook package. The package is available by default on Red Hat Virtualization Host but needs to be installed on Red Hat Enterprise Linux hosts.
					
# dnf install vdsm-hook-ethtool-options




				The ethtool_opts key is now available in the Administration Portal. See Editing Host Network Interfaces and Assigning Logical Networks to Hosts to apply ethtool properties to logical networks.
			

How to Set Up Red Hat Virtualization Manager to Use FCoE




				You can configure Fibre Channel over Ethernet (FCoE) properties for host network interface cards from the Administration Portal. The fcoe key is not available by default and needs to be added to the Manager using the engine configuration tool. You can check whether fcoe has already been enabled by running the following command:
			
# engine-config -g UserDefinedNetworkCustomProperties

				You also need to install the required VDSM hook package on the hosts. Depending on the FCoE card on the hosts, special configuration may also be needed; see Configuring Fibre Channel over Ethernet in Red Hat Enterprise Linux Managing storage devices.
			
Procedure
	
						On the Manager, run the following command to add the key:
					
# engine-config -s UserDefinedNetworkCustomProperties='fcoe=^((enable|dcb|auto_vlan)=(yes|no),?)*$'

	
						Restart the ovirt-engine service:
					
# systemctl restart ovirt-engine.service

	
						Install the VDSM hook package on each of the Red Hat Enterprise Linux hosts on which you want to configure FCoE properties. The package is available by default on Red Hat Virtualization Host (RHVH).
					
# dnf install vdsm-hook-fcoe




				The fcoe key is now available in the Administration Portal. See Editing Host Network Interfaces and Assigning Logical Networks to Hosts to apply FCoE properties to logical networks.
			


Appendix C. Red Hat Virtualization User Interface Plugins



About Red Hat Virtualization User Interface Plug-ins




				Red Hat Virtualization supports plug-ins that expose non-standard features. This makes it easier to use the Red Hat Virtualization Administration Portal to integrate with other systems. Each interface plug-in represents a set of user interface extensions that can be packaged and distributed for use with Red Hat Virtualization.
			

				Red Hat Virtualization’s User Interface plug-ins integrate with the Administration Portal directly on the client using the JavaScript programming language. Plug-ins are invoked by the Administration Portal and executed in the web browser’s JavaScript runtime. User Interface plug-ins can use the JavaScript language and its libraries.
			

				At key events during runtime, the Administration Portal invokes individual plug-ins via event handler functions representing Administration-Portal-to-plug-in communication. Although the Administration Portal supports multiple event-handler functions, a plug-in declares functions which are of interest only to its implementation. Each plug-in must register relevant event handler functions as part of the plug-in bootstrap sequence before the plug-in is put to use by the administration portal.
			

				To facilitate the plug-in-to-Administration-Portal communication that drives the User Interface extension, the Administration Portal exposes the plug-in API as a global (top-level) pluginApi JavaScript object that individual plug-ins can consume. Each plug-in obtains a separate pluginApi instance, allowing the Administration Portal to control plug-in API-function invocation for each plug-in with respect to the plug-in’s life cycle.
			

Red Hat Virtualization User Interface Plugin Lifecycle




				The basic life cycle of a User Interface Plug-in divides into three stages:
			
	
						Plug-in discovery.
					
	
						Plug-in loading.
					
	
						Plug-in bootstrapping.
					


Red Hat Virtualization User Interface Plug-in Discovery




					Creating plug-in descriptors is the first step in the plug-in discovery process. Plug-in descriptors contain important plug-in metadata and optional default plug-in-specific configurations.
				

					As part of handling administration portal HTML page requests (HTTP GET), User Interface plug-in infrastructure attempts to discover and load plug-in descriptors from your local file system. For each plug-in descriptor, the infrastructure also attempts to load corresponding plug-in user configurations used to override default plug-in-specific configurations (if any exist) and tweak plug-in runtime behavior. Plug-in user configuration is optional. After loading descriptors and corresponding user configuration files, oVirt Engine aggregates User Interface plug-in data and embeds it into the administration portal HTML page for runtime evaluation.
				

					By default, plug-in descriptors reside in $ENGINE_USR/ui-plug-ins, with a default mapping of ENGINE_USR=/usr/share/ovirt-engine as defined by oVirt Engine local configuration. Plug-in descriptors are expected to comply with JSON format specifications, but plug-in descriptors allow Java/C++ style comments (of both /* and // varieties) in addition to the JSON format specifications.
				

					By default, plug-in user configuration files reside in $ENGINE_ETC/ui-plug-ins, with a default mapping of ENGINE_ETC=/etc/ovirt-engine as defined by oVirt Engine local configuration. Plug-in user configuration files are expected to comply with same content format rules as plug-in descriptors.
				
Note

						Plug-in user configuration files generally follow the <descriptorFileName>-config.json naming convention.
					


Red Hat Virtualization User Interface Plug-in Loading




					After a plug-in has been discovered and its data is embedded into the administration portal HTML page, administration portal tries to load the plug-in as part of application startup (unless you have configured it not to load as part of application startup).
				

					For each plug-in that has been discovered, the administration portal creates an HTML iframe element that is used to load its host page. The plug-in host page is necessary to begin the plug-in bootstrap process, which (the bootstrap process) is used to evaluate the plug-in code in the context of the plug-in’s iframe element. User interface plug-in infrastructure supports serving plug-in resource files (such as the plug-in host page) from the local file system. The plug-in host page is loaded into the iframe element and the plug-in code is evaluated. After the plug-in code is evaluated, the plug-in communicates with the administration portal by means of the plug-in API.
				

Red Hat Virtualization User Interface Plug-in Bootstrapping




					A typical plug-in bootstrap sequence consists of following steps:
				

					Plug-in Bootstrap Sequence
				
	
							Obtain pluginApi instance for the given plug-in
						
	
							Obtain runtime plug-in configuration object (optional)
						
	
							Register relevant event handler functions
						
	
							Notify UI plug-in infrastructure to proceed with plug-in initialization
						



					The following code snippet illustrates the above mentioned steps in practice:
				
// Access plug-in API using 'parent' due to this code being evaluated within the context of an iframe element.
// As 'parent.pluginApi' is subject to Same-Origin Policy, this will only work when WebAdmin HTML page and plug-in
// host page are served from same origin. WebAdmin HTML page and plug-in host page will always be on same origin
// when using UI plug-in infrastructure support to serve plug-in resource files.
var api = parent.pluginApi('MyPlugin');

// Runtime configuration object associated with the plug-in (or an empty object).
var config = api.configObject();

// Register event handler function(s) for later invocation by UI plug-in infrastructure.
api.register({
	    // UiInit event handler function.
		UiInit: function() {
				// Handle UiInit event.
					window.alert('Favorite music band is ' + config.band);
					    }
});

// Notify UI plug-in infrastructure to proceed with plug-in initialization.
api.ready();


User Interface Plugin-related Files and Their Locations



Table C.1. UI Plugin-related Files and their Locations
	File	Location	Remarks
	 
								Plug-in descriptor files (meta-data)
							

							 	 
								/usr/share/ovirt-engine/ui-plugins/my-plugin.json
							

							 	 
	 
								Plug-in user configuration files
							

							 	 
								/etc/ovirt-engine/ui-plugins/my-plugin-config.json
							

							 	 
	 
								Plug-in resource files
							

							 	 
								/usr/share/ovirt-engine/ui-plugins/<resourcePath>/PluginHostPage.html
							

							 	 
								<resourcePath> is defined by the corresponding attribute in the plug-in descriptor.
							

							 




Example User Interface Plug-in Deployment




				Follow these instructions to create a user interface plug-in that runs a Hello World! program when you sign in to the Red Hat Virtualization Manager Administration Portal.
			

				Deploying a Hello World! Plug-in
			
	
						Create a plug-in descriptor by creating the following file in the Manager at /usr/share/ovirt-engine/ui-plugins/helloWorld.json:
					
{
    "name": "HelloWorld",
    "url": "/ovirt-engine/webadmin/plugin/HelloWorld/start.html",
    "resourcePath": "hello-files"
}

	
						Create the plug-in host page by creating the following file in the Manager at /usr/share/ovirt-engine/ui-plugins/hello-files/start.html:
					
<!DOCTYPE html><html><head>
<script>
    var api = parent.pluginApi('HelloWorld');
    api.register({
	UiInit: function() { window.alert('Hello world'); }
    });
    api.ready();
</script>
</head><body></body></html>




				If you have successfully implemented the Hello World! plug-in, you will see this screen when you sign in to the Administration Portal:
			
Figure C.1. A Successful Implementation of the Hello World! Plug-in
[image: Successful Implementation notice]




Appendix D. Enabling FIPS in Red Hat Virtualization




			You can set up Red Hat Virtualization to be compliant with the Federal Information Processing Standard (FIPS), specifically FIPS 140-2. You can enable FIPS mode selectively, on specific virtual machines, bare metal machines, or across your entire environment, based on your organization’s FIPS compliance requirements.
		

			You can create a FIPS-enabled bare metal machine in RHV 4.4 by either installing the operating system in FIPS mode, or by switching the system into FIPS mode after installing the operating system. However, you must switch to FIPS mode before installing and configuring Red Hat Virtualization to avoid introducing system conflicts.
		
Important

				Red Hat recommends installing RHEL 8 with FIPS mode enabled as opposed to enabling FIPS mode later. Enabling FIPS mode during the installation ensures that the system generates all keys with FIPS-approved algorithms and continuous monitoring tests in place.
			


			You enable FIPS first on each bare metal machine, and then in the Manager.
		
	
					Enabling FIPS in a self-hosted engine
				
	
					Enabling FIPS in RHEL hosts and the standalone Manager
				


Enabling FIPS in a self-hosted engine




				You can enable FIPS in a self-hosted engine during deployment when using the command-line.
			
Procedure
	
						Start the self-hosted engine deployment script. See Installing Red Hat Virtualization as a self-hosted engine using the command line.
					
	
						When the deployment script prompts Do you want to enable FIPS?, enter Yes
					


Verification

					Verify that FIPS is enabled by entering the command fips-mode-setup --check on the host. The command should return FIPS mode is enabled:
				
# fips-mode-setup --check
FIPS mode is enabled.

Enabling FIPS in RHV hosts and the standalone Manager




				You can enable FIPS mode when installing a Red Hat Enterprise Linux (RHEL) host or Red Hat Virtualization Host (RHVH). For details, see Installing a RHEL 8 system with FIPS mode enabled in the guide Security hardening for Red Hat Enterprise Linux 8. Red Hat does not support switching a provisioned host or Manager machine to FIPS mode
			
Verification

					Verify that FIPS is enabled by entering the command fips-mode-setup --check on the host. The command should return FIPS mode is enabled:
				
# fips-mode-setup --check
FIPS mode is enabled.

Additional resources



	
						Installing Red Hat Virtualization Hosts
					
	
						Configuring and Applying SCAP Policies During Installation
					
	
						Installers and Images for Red Hat Virtualization Manager (v. 4.4 for x86_64)
					
	
						Security policies available in the SCAP Security Guide
					
	
						Security Hardening for Red Hat Enterprise Linux 8
					




Appendix E. Red Hat Virtualization and encrypted communication



Replacing the Red Hat Virtualization Manager CA Certificate




				You can configure your organization’s third-party CA certificate to authenticate users connecting to the Red Hat Virtualization Manager over HTTPS.
			

				Third-party CA certificates are not used for authentication between the Manager and hosts or for disk transfer URLs. These HTTPS connections use the self-signed certificate generated by the Manager.
			
Important

					When you switch to a custom HTTPS certificate, you must use your own CA certificate distribution to make that certificate available on clients.
				

					If you are integrating with Red Hat Satellite, you need to manually import the correct certificate into Satellite.
				


				If you received the private key and certificate from your CA in a P12 file, use the following procedure to extract them. For other file formats, contact your CA. After extracting the private key and certificate, proceed to Replacing the Red Hat Virtualization Manager Apache CA Certificate.
			
Extracting the Certificate and Private Key from a P12 Bundle




					The internal CA stores the internally generated key and certificate in a P12 file, in /etc/pki/ovirt-engine/keys/apache.p12. Store your new file in the same location. The following procedure assumes that the new P12 file is in /tmp/apache.p12.
				
Warning

						Do not change the permissions and ownerships for the /etc/pki directory or any subdirectories. The permission for the /etc/pki and the /etc/pki/ovirt-engine directory must remain as the default, 755.
					

Procedure
	
							Back up the current apache.p12 file:
						
# cp -p /etc/pki/ovirt-engine/keys/apache.p12 /etc/pki/ovirt-engine/keys/apache.p12.bck

	
							Replace the current file with the new file:
						
# cp /tmp/apache.p12 /etc/pki/ovirt-engine/keys/apache.p12

	
							Extract the private key and certificate to the required locations:
						
# openssl pkcs12 -in /etc/pki/ovirt-engine/keys/apache.p12 -nocerts -nodes > /tmp/apache.key
# openssl pkcs12 -in /etc/pki/ovirt-engine/keys/apache.p12 -nokeys > /tmp/apache.cer

							If the file is password protected, add -passin pass:password to the command, replacing password with the required password.
						



Important

						For new Red Hat Virtualization installations, you must complete all of the steps in this procedure.
					


Replacing the Red Hat Virtualization Manager Apache CA Certificate




					You configure your organization’s third-party CA certificate to authenticate users connecting to the Administration Portal and the VM Portal over HTTPS.
				
Warning

						Do not change the permissions and ownerships for the /etc/pki directory or any subdirectories. The permission for the /etc/pki and the /etc/pki/ovirt-engine directory must remain as the default, 755.
					

Prerequisites
	
							Third-party CA (Certificate Authority) certificate. It is provided as a PEM file. The certificate chain must be complete up to the root certificate. The chain’s order is critical and must be from the last intermediate certificate to the root certificate. This procedure assumes that the third-party CA certificate is provided in /tmp/3rd-party-ca-cert.pem.
						
	
							Private key that you want to use for Apache httpd. It must not have a password. This procedure assumes that it is located in /tmp/apache.key.
						
	
							Certificate issued by the CA. This procedure assumes that it is located in /tmp/apache.cer.
						


Procedure
	
							If you are using a self-hosted engine, put the environment into global maintenance mode.
						
# hosted-engine --set-maintenance --mode=global

							For more information, see Maintaining the Self-Hosted Engine.
						

	
							Add your CA certificate to the host-wide trust store:
						
# cp /tmp/3rd-party-ca-cert.pem /etc/pki/ca-trust/source/anchors
# update-ca-trust

	
							The Manager has been configured to use /etc/pki/ovirt-engine/apache-ca.pem, which is symbolically linked to /etc/pki/ovirt-engine/ca.pem. Remove the symbolic link:
						
# rm /etc/pki/ovirt-engine/apache-ca.pem

	
							Save your CA certificate as /etc/pki/ovirt-engine/apache-ca.pem:
						
# cp /tmp/3rd-party-ca-cert.pem /etc/pki/ovirt-engine/apache-ca.pem

	
							Back up the existing private key and certificate:
						
# cp /etc/pki/ovirt-engine/keys/apache.key.nopass /etc/pki/ovirt-engine/keys/apache.key.nopass.bck
# cp /etc/pki/ovirt-engine/certs/apache.cer /etc/pki/ovirt-engine/certs/apache.cer.bck

	
							Copy the private key to the required location:
						
# cp /tmp/apache.key /etc/pki/ovirt-engine/keys/apache.key.nopass

	
							Set the private key owner to root and set the permissions to 0640:
						
# chown root:ovirt  /etc/pki/ovirt-engine/keys/apache.key.nopass
# chmod 640 /etc/pki/ovirt-engine/keys/apache.key.nopass

	
							Copy the certificate to the required location:
						
# cp /tmp/apache.cer /etc/pki/ovirt-engine/certs/apache.cer

	
							Set the certificate owner to root and set the permissions to 0644:
						
# chown root:ovirt /etc/pki/ovirt-engine/certs/apache.cer
# chmod 644 /etc/pki/ovirt-engine/certs/apache.cer

	
							Restart the Apache server:
						
# systemctl restart httpd.service

	
							Create a new trust store configuration file, /etc/ovirt-engine/engine.conf.d/99-custom-truststore.conf, with the following parameters:
						
ENGINE_HTTPS_PKI_TRUST_STORE="/etc/pki/java/cacerts"
ENGINE_HTTPS_PKI_TRUST_STORE_PASSWORD=""

	
							Copy the /etc/ovirt-engine/ovirt-websocket-proxy.conf.d/10-setup.conf file, and rename it with an index number that is greater than 10 (for example, 99-setup.conf). Add the following parameters to the new file:
						
SSL_CERTIFICATE=/etc/pki/ovirt-engine/certs/apache.cer
SSL_KEY=/etc/pki/ovirt-engine/keys/apache.key.nopass

	
							Restart the websocket-proxy service:
						
# systemctl restart ovirt-websocket-proxy.service

	
							If you manually changed the /etc/ovirt-provider-ovn/conf.d/10-setup-ovirt-provider-ovn.conf file, or are using a configuration file from an older installation, make sure that the Manager is still configured to use /etc/pki/ovirt-engine/apache-ca.pem as the certificate source.
						
	
							Create the /etc/ovirt-engine-backup/engine-backup-config.d directory:
						
# mkdir -p /etc/ovirt-engine-backup/engine-backup-config.d

	
							Create the /etc/ovirt-engine-backup/engine-backup-config.d/update-system-wide-pki.sh file with the following content. This enables ovirt-engine-backup to automatically update the system on restore.
						
BACKUP_PATHS="${BACKUP_PATHS}
/etc/ovirt-engine-backup"
cp -f /etc/pki/ovirt-engine/apache-ca.pem \
  /etc/pki/ca-trust/source/anchors/3rd-party-ca-cert.pem
update-ca-trust

	
							Restart the ovirt-provider-ovn service:
						
# systemctl restart ovirt-provider-ovn.service

	
							Restart the ovirt-imageio service:
						
# systemctl restart ovirt-imageio.service

	
							Restart the ovirt-engine service:
						
# systemctl restart ovirt-engine.service

	
							If you are using a self-hosted engine, turn off global maintenance mode:
						
# hosted-engine --set-maintenance --mode=none




					Your users can now connect to the Administration Portal and VM Portal without seeing a certificate warning.
				


Setting Up Encrypted Communication between the Manager and an LDAP Server




				To set up encrypted communication between the Red Hat Virtualization Manager and an LDAP server, obtain the root CA certificate of the LDAP server, copy the root CA certificate to the Manager, and create a PEM-encoded CA certificate. The keystore type can be any Java-supported type. The following procedure uses the Java KeyStore (JKS) format.
			
Note

					For more information on creating a PEM-encoded CA certificate and importing certificates, see the X.509 CERTIFICATE TRUST STORE section of the README file at /usr/share/doc/ovirt-engine-extension-aaa-ldap-<version>.
				

Note

					The ovirt-engine-extension-aaa-ldap is deprecated. For new installations, use Red Hat Single Sign On. For more information, see Installing and Configuring Red Hat Single Sign-On in the Administration Guide.
				

Procedure
	
						On the Red Hat Virtualization Manager, copy the root CA certificate of the LDAP server to the /tmp directory and import the root CA certificate using keytool to create a PEM-encoded CA certificate. The following command imports the root CA certificate at /tmp/myrootca.pem and creates a PEM-encoded CA certificate myrootca.jks under /etc/ovirt-engine/aaa/. Note down the certificate’s location and password. If you are using the interactive setup tool, this is all the information you need. If you are configuring the LDAP server manually, follow the rest of the procedure to update the configuration files.
					
$ keytool -importcert -noprompt -trustcacerts -alias myrootca -file /tmp/myrootca.pem -keystore /etc/ovirt-engine/aaa/myrootca.jks -storepass password

	
						Update the /etc/ovirt-engine/aaa/profile1.properties file with the certificate information:
					
Note

							${local:_basedir} is the directory where the LDAP property configuration file resides and points to the /etc/ovirt-engine/aaa directory. If you created the PEM-encoded CA certificate in a different directory, replace ${local:_basedir} with the full path to the certificate.
						

	
								To use startTLS (recommended):
							
# Create keystore, import certificate chain and uncomment
pool.default.ssl.startTLS = true
pool.default.ssl.truststore.file = ${local:_basedir}/myrootca.jks
pool.default.ssl.truststore.password = password

	
								To use SSL:
							
# Create keystore, import certificate chain and uncomment
pool.default.serverset.single.port = 636
pool.default.ssl.enable = true
pool.default.ssl.truststore.file = ${local:_basedir}/myrootca.jks
pool.default.ssl.truststore.password = password







				To continue configuring an external LDAP provider, see Configuring an External LDAP Provider. To continue configuring LDAP and Kerberos for Single Sign-on, see Configuring LDAP and Kerberos for Single Sign-on.
			

Enabling encrypted VNC consoles for FIPS




				You can set up encrypted VNC consoles to work with a Red Hat Virtualization (RHV) Manager and hosts that have FIPS enabled.
			

				To set up encrypted VNC consoles, you complete the following procedures:
			
	
						Enable FIPS in RHV.
					
	
						Configure the cluster to enable VNC Encryption.
					
	
						Run the VNC SASL ansible playbook on each host.
					
	
						Configure the Remote Viewer to trust the Manager’s CA certificate.
					


Configuring the cluster to enable VNC Encryption



Prerequisites
	
							FIPS must be enabled on the cluster.
						


Procedure
	
							In the Administration Portal, click Compute → Clusters.
						
	
							Select the cluster where you plan to enable VNC encryption and click Edit. The Edit Cluster window opens.
						
	
							Select the Console tab.
						
	
							Select the Enable VNC Encryption checkbox and click OK.
						



Running the VNC SASL Ansible playbook for each host



Procedure
	
							In the Administration Portal, put the FIPS-enabled hosts into maintenance mode:
						
	
									Click Compute → Hosts.
								
	
									In the Virtual Machines column, verify that each host has zero virtual machines.
								

									Perform a live migration to remove virtual machines from hosts, if necessary. See Migrating Virtual Machines Between Hosts.
								

	
									Select each host and click Management → Maintenance and OK.
								



	
							Connect to the command line of the machine where the Manager is running.
						
	
									Standalone Manager:
								
# ssh root@rhvm

	
									Self-hosted engine: Click Compute → Virtual Machines to select the self-hosted engine virtual machine, named HostedEngine by default, and then click Console.
								



	
							Run the VNC SASL Ansible playbook for each host:
						
# cd /usr/share/ovirt-engine/ansible-runner-service-project/project/
# ansible-playbook --ask-pass --inventory=<hostname> ovirt-vnc-sasl.yml <1>
	
	
									Specify the Hostname displayed on Compute → Hosts.
								




	
							Select the host and click Installation → Reinstall.
						
	
							After reinstallation, select the host and click Management → Restart.
						
	
							After rebooting, select the host and click Management → Activate.
						


VNC SASL Ansible playbook error message

					When running the VNC SASL Ansible playbook, the task might fail with the following error message:
				
Using a SSH password instead of a key is not possible because Host Key checking is enabled and sshpass does not support this.  Please add this host’s fingerprint to your known_hosts file to manage this host.

					To solve this problem, disable host key checking by doing one of the following:
				
	
							Disable host key checking permanently by uncommenting the following line in /etc/ansible/ansible.cfg:
						
#host_key_checking = False

	
							Disable host key checking temporarily by running the following command:
						
export ANSIBLE_HOST_KEY_CHECKING=False



Additional resources
	
							Configuring and Applying SCAP Policies During Installation
						
	
							Installers and Images for Red Hat Virtualization Manager (v. 4.3 for x86_64)
						



Configuring the Remote Viewer to trust the Manager’s CA certificate




					Configure the Remote Viewer console on your client machine, virt-viewer or remote-viewer, to trust the RHV Manager’s certificate authority (CA)
				
Procedure
	
							Navigate to https://<engine_address>/ovirt-engine/services/pki-resource?resource=ca-certificate&format=X509-PEM-CA.
						
	
							Enable all the trust settings.
						
	
							On the client machine where you plan to run the VNC console, create a directory for the certificate file:
						
$ mkdir ~/.pki/CA
Warning

								If this step generates an error such as mkdir: cannot create directory ‘/home/example_user/.pki/CA’: File exists, take precautions to avoid overwriting ~/.pki/CA/cacert.pem in the next step. For example, include the current date in the filename.
							


	
							Download the certificate:
						
$ curl -k -o ~/.pki/CA/cacert-<today’s date>.pem '\https://<engine_address>/ovirt-engine/services/pki-resource?resource=ca-certificate&format=X509-PEM-CA'

	
							Install the certificate authority in your browser:
						
	
									Firefox
								
	
									Internet Explorer
								
	
									Google Chrome.
								



	
							Install the SASL SCRAM libraries on the client machine:
						
$ sudo dnf install cyrus-sasl-scram



Verification steps
	
							Run a virtual machine on one of the FIPS-enabled hosts you created.
						
	
							Connect to the virtual machine using a VNC console.
						


Additional resources
	
							Installing Console Components
						
	
							Replacing the Manager CA Certificate
						





Appendix F. Proxies



SPICE Proxy



SPICE Proxy Overview




					The SPICE Proxy is a tool used to connect SPICE Clients to virtual machines when the SPICE Clients are outside the network that connects the hypervisors. Setting up a SPICE Proxy consists of installing Squid on a machine and configuring the firewall to allow proxy traffic. Turning a SPICE Proxy on consists of using engine-config on the Manager to set the key SpiceProxyDefault to a value consisting of the name and port of the proxy. Turning a SPICE Proxy off consists of using engine-config on the Manager to remove the value to which the key SpiceProxyDefault has been set.
				
Important

						The SPICE Proxy can only be used in conjunction with the standalone SPICE client, and cannot be used to connect to virtual machines using noVNC.
					


SPICE Proxy Machine Setup




					This procedure explains how to set up a machine as a SPICE Proxy. A SPICE Proxy makes it possible to connect to the Red Hat Virtualization network from outside the network. We use Squid in this procedure to provide proxy services.
				
Procedure
	
							Install Squid on the Proxy machine:
						
# dnf install squid

	
							Open /etc/squid/squid.conf. Change:
						
http_access deny CONNECT !SSL_ports

							to:
						
http_access deny CONNECT !Safe_ports

	
							Start the squid service and enable it to run automatically after reboot:
						
# systemctl enable squid.service --now

	
							Enable incoming requests to the squid service in the default firewalld zone:
						
# firewall-cmd --permanent --add-service=squid

	
							Make this firewall rule persistent in the runtime configuration:
						
# firewall-cmd --reload

	
							Confirm that the squid service appears in the list of firewall services:
						
# firewall-cmd --list-services
ssh dhcpv6-client squid




					You have now set up a machine as a SPICE proxy. Before connecting to the Red Hat Virtualization network from outside the network, activate the SPICE proxy.
				

Turning On a SPICE Proxy




					This procedure explains how to activate (or turn on) the SPICE proxy.
				
Procedure
	
							On the Manager, use the engine-config tool to set a proxy:
						
# engine-config -s SpiceProxyDefault=someProxy

	
							Restart the ovirt-engine service:
						
# systemctl restart ovirt-engine.service

							The proxy must have this form:
						
protocol://[host]:[port]
Note

								Only SPICE clients shipped with Red Hat Enterprise Linux 6.7, Red Hat Enterprise Linux 7.2, or later, support HTTPS proxies. Earlier clients only support HTTP. If HTTPS is specified for earlier clients, the client will ignore the proxy setting and attempt a direct connection to the host.
							





					SPICE Proxy is now activated (turned on). It is now possible to connect to the Red Hat Virtualization network through the SPICE proxy.
				

Turning Off a SPICE Proxy




					This procedure explains how to turn off (deactivate) a SPICE proxy.
				
Procedure
	
							Log in to the Manager:
						
$ ssh root@[IP of Manager]

	
							Run the following command to clear the SPICE proxy:
						
# engine-config -s SpiceProxyDefault=""

	
							Restart the Manager:
						
# systemctl restart ovirt-engine.service




					SPICE proxy is now deactivated (turned off). It is no longer possible to connect to the Red Hat Virtualization network through the SPICE proxy.
				


Squid Proxy



Installing and Configuring a Squid Proxy




					This section explains how to install and configure a Squid proxy to the VM Portal. A Squid proxy server is used as a content accelerator. It caches frequently-viewed content, reducing bandwidth and improving response times.
				
Procedure
	
							Obtain a keypair and certificate for the HTTPS port of the Squid proxy server. You can obtain this keypair the same way that you would obtain a keypair for another SSL/TLS service. The keypair is in the form of two PEM files which contain the private key and the signed certificate. For this procedure, we assume that they are named proxy.key and proxy.cer.
						
Note

								The keypair and certificate can also be generated using the certificate authority of the engine. If you already have the private key and certificate for the proxy and do not want to generate it with the engine certificate authority, skip to the next step.
							


	
							Choose a host name for the proxy. Then, choose the other components of the distinguished name of the certificate for the proxy.
						
Note

								It is good practice to use the same country and same organization name used by the engine itself. Find this information by logging in to the machine where the Manager is installed and running the following command:
							
openssl x509 -in /etc/pki/ovirt-engine/ca.pem -noout -text | grep DirName

								This command outputs something like this:
							
subject= /C=US/O=Example Inc./CN=engine.example.com.81108

								The relevant part here is /C=US/O=Example Inc.. Use this to build the complete distinguished name for the certificate for the proxy:
							
/C=US/O=Example Inc./CN=proxy.example.com


	
							Log in to the proxy machine and generate a certificate signing request:
						
# openssl req -newkey rsa:2048 -subj '/C=US/O=Example Inc./CN=proxy.example.com' -nodes -keyout proxy.key -out proxy.req
Important

								You must include the quotes around the distinguished name for the certificate. The -nodes option ensures that the private key is not encrypted; this means that you do not need to enter the password to start the proxy server.
							


							The command generates two files: proxy.key and proxy.req. proxy.key is the private key. Keep this file safe. proxy.req is the certificate signing request. proxy.req does not require any special protection.
						

	
							To generate the signed certificate, copy the certificate signing request file from the proxy machine to the Manager machine:
						
# scp proxy.req engine.example.com:/etc/pki/ovirt-engine/requests/.

	
							Log in to the Manager machine and sign the certificate:
						
# /usr/share/ovirt-engine/bin/pki-enroll-request.sh --name=proxy --days=3650 --subject='/C=US/O=Example Inc./CN=proxy.example.com'

							This signs the certificate and makes it valid for 10 years (3650 days). Set the certificate to expire earlier, if you prefer.
						

	
							The generated certificate file is available in the directory /etc/pki/ovirt-engine/certs and should be named proxy.cer. On the proxy machine, copy this file from the Manager machine to your current directory:
						
# scp engine.example.com:/etc/pki/ovirt-engine/certs/proxy.cer .

	
							Ensure both proxy.key and proxy.cer are present on the proxy machine:
						
# ls -l proxy.key proxy.cer

	
							Install the Squid proxy server package on the proxy machine:
						
# dnf install squid

	
							Move the private key and signed certificate to a place where the proxy can access them, for example to the /etc/squid directory:
						
# cp proxy.key proxy.cer /etc/squid/.

	
							Set permissions so that the squid user can read these files:
						
# chgrp squid /etc/squid/proxy.*
# chmod 640 /etc/squid/proxy.*

	
							The Squid proxy must verify the certificate used by the engine. Copy the Manager certificate to the proxy machine. This example uses the file path /etc/squid:
						
# scp engine.example.com:/etc/pki/ovirt-engine/ca.pem /etc/squid/.
Note

								The default CA certificate is located in /etc/pki/ovirt-engine/ca.pem on the Manager machine.
							


	
							Set permissions so that the squid user can read the certificate file:
						
# chgrp squid /etc/squid/ca.pem
# chmod 640 /etc/squid/ca.pem

	
							If SELinux is in enforcing mode, change the context of port 443 using the semanage tool to permit Squid to use port 443:
						
# dnf install policycoreutils-python
# semanage port -m -p tcp -t http_cache_port_t 443

	
							Replace the existing Squid configuration file with the following:
						
https_port 443 key=/etc/squid/proxy.key cert=/etc/squid/proxy.cer ssl-bump defaultsite=engine.example.com
cache_peer engine.example.com parent 443 0 no-query originserver ssl sslcafile=/etc/squid/ca.pem name=engine login=PASSTHRU
cache_peer_access engine allow all
ssl_bump allow all
http_access allow all

	
							Restart the Squid proxy server:
						
# systemctl restart squid.service



Note

						Squid Proxy in the default configuration will terminate its connection after 15 idle minutes. To increase the amount of time before Squid Proxy terminates its idle connection, adjust the read_timeout option in squid.conf (for instance read_timeout 10 hours).
					



Websocket Proxy



Websocket Proxy Overview




					The websocket proxy allows users to connect to virtual machines via a noVNC console.
				

					The websocket proxy can be installed and configured on the Red Hat Virtualization Manager machine during the initial configuration (see Configuring the Red Hat Virtualization Manager).
				



Appendix G. Branding



Branding



Re-Branding the Manager




					Various aspects of the Red Hat Virtualization Manager can be customized, such as the icons used by and text displayed in pop-up windows and the links shown on the Welcome Page. This allows you to re-brand the Manager and gives you fine-grained control over the end look and feel presented to administrators and users.
				

					The files required to customize the Manager are located in the /etc/ovirt-engine/branding/ directory on the system on which the Manager is installed. The files comprise a set of cascading style sheet files that are used to style various aspects of the graphical user interface and a set of properties files that contain messages and links that are incorporated into various components of the Manager.
				

					To customize a component, edit the file for that component and save the changes. The next time you open or refresh that component, the changes will be applied.
				

Login Screen




					The login screen is the login screen used by both the Administration Portal and VM Portal. The elements of the login screen that can be customized are as follows:
				
	
							The border
						
	
							The header image on the left
						
	
							The header image on the right
						
	
							The header text
						



					The classes for the login screen are located in common.css.
				

Administration Portal Screen




					The administration portal screen is the main screen that is shown when you log into the Administration Portal. The elements of the administration portal screen that can be customized are as follows:
				
	
							The logo
						
	
							The left background image
						
	
							The center background image
						
	
							The right background image
						
	
							The text to the right of the logo
						



					The classes for the administration portal screen are located in web_admin.css.
				

VM Portal Screen




					The VM Portal screen is the screen that is shown when you log into the VM Portal. The elements of the VM Portal screen that can be customized are as follows:
				
	
							The logo
						
	
							The center background image
						
	
							The right background image
						
	
							The border around the main grid
						
	
							The text above the Logged in user label
						



					The classes for the VM Portal screen are located in user_portal.css.
				

Pop-Up Windows




					Pop-up windows are all windows in the Manager that allow you to create, edit or update an entity such as a host or virtual machine. The elements of pop-up windows that can be customized are as follows:
				
	
							The border
						
	
							The header image on the left
						
	
							The header center image (repeated)
						



					The classes for pop-up windows are located in common.css.
				

Tabs




					Many pop-up windows in the Administration Portal include tabs. The elements of these tabs that can be customized are as follows:
				
	
							Active
						
	
							Inactive
						



					The classes for tabs are located in common.css and user_portal.css.
				

The Welcome Page




					The Welcome Page is the page that is initially displayed when you visit the homepage of the Manager. In addition to customizing the overall look and feel, you can also make other changes such as adding links to the page for additional documentation or internal websites by editing a template file. The elements of the Welcome Page that can be customized are as follows:
				
	
							The page title
						
	
							The header (left, center and right)
						
	
							The error message
						
	
							The link to forward and the associated message for that link
						
	
							Add a message banner or preamble
						



					The classes for the Welcome Page are located in welcome_style.css.
				

					The Template File
				

					The template file for the Welcome Page is a regular HTML file of the name welcome_page.template that does not contain HTML, HEAD or BODY tags. This file is inserted directly into the Welcome Page itself, and acts as a container for the content that is displayed in the Welcome Page. As such, you must edit this file to add new links or change the content itself. Another feature of the template file is that it contains placeholder text such as {user_portal} that is replaced by corresponding text in the messages.properties file when the Welcome Page is processed.
				

					The Preamble
				

					You can add a custom message banner to the Welcome Page by adding a preamble.template containing the banner text and a preamble.css file defining the banner size, and linking them in the branding.properties file. Sample files are available at sample preamble template.
				
Note

						In an engine upgrade, the custom message banner remains in place and will work without issue. Following engine backup and restore, during engine restore, the custom message banner needs to be manually restored and verified.
					


The Page Not Found Page




					The Page Not Found page is a page that is displayed when you open a link to a page that cannot be found in the Red Hat Virtualization Manager. The elements of the Page Not Found page that can be customized are as follows:
				
	
							The page title
						
	
							The header (left, center and right)
						
	
							The error message
						
	
							The link to forward and the associated message for that link
						



					The classes for the Page Not Found page are located in welcome_style.css.
				



Appendix H. System Accounts



Red Hat Virtualization Manager User Accounts




				A number of system user accounts are created to support Red Hat Virtualization when the rhevm package is installed. Each system user has a default user identifier (UID). The system user accounts created are:
			
	
						The vdsm user (UID 36). Required for support tools that mount and access NFS storage domains.
					
	
						The ovirt user (UID 108). Owner of the ovirt-engine Red Hat JBoss Enterprise Application Platform instance.
					
	
						The ovirt-vmconsole user (UID 498). Required for the guest serial console.
					



Red Hat Virtualization Manager Groups




				A number of system user groups are created to support Red Hat Virtualization when the rhevm package is installed. Each system user group has a default group identifier (GID). The system user groups created are:
			
	
						The kvm group (GID 36). Group members include:
					
	
						The vdsm user.
					
	
						The ovirt group (GID 108). Group members include:
					
	
						The ovirt user.
					
	
						The ovirt-vmconsole group (GID 498). Group members include:
					
	
						The ovirt-vmconsole user.
					



Virtualization Host User Accounts




				A number of system user accounts are created on the virtualization host when the vdsm and qemu-kvm-rhev packages are installed. Each system user has a default user identifier (UID). The system user accounts created are:
			
	
						The vdsm user (UID 36).
					
	
						The qemu user (UID 107).
					
	
						The sanlock user (UID 179).
					
	
						The ovirt-vmconsole user (UID 498).
					


Important

					The user identifiers (UIDs) and group identifiers (GIDs) allocated may vary between systems. The vdsm user is fixed to a UID of 36 and the kvm group is fixed to a GID of 36.
				

					If UID 36 or GID 36 is already used by another account on the system a conflict will arise during installation of the vdsm and qemu-kvm-rhev packages.
				


Virtualization Host Groups




				A number of system user groups are created on the virtualization host when the vdsm and qemu-kvm-rhev packages are installed. Each system user group has a default group identifier (GID). The system user groups created are:
			
	
						The kvm group (GID 36). Group members include:
					
	
						The qemu user.
					
	
						The sanlock user.
					
	
						The qemu group (GID 107). Group members include:
					
	
						The vdsm user.
					
	
						The sanlock user.
					
	
						The ovirt-vmconsole group (GID 498). Group members include:
					
	
						The ovirt-vmconsole user.
					


Important

					The user identifiers (UIDs) and group identifiers (GIDs) allocated may vary between systems. The vdsm user is fixed to a UID of 36 and the kvm group is fixed to a GID of 36.
				

					If UID 36 or GID 36 is already used by another account on the system a conflict will arise during installation of the vdsm and qemu-kvm-rhev packages.
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			Copyright © 2022 Red Hat, Inc.
		

			Licensed under the (Creative Commons Attribution–ShareAlike 4.0 International License). Derived from documentation for the (oVirt Project). If you distribute this document or an adaptation of it, you must provide the URL for the original version.
		

			Modified versions must remove all Red Hat trademarks.
		

			Red Hat, Red Hat Enterprise Linux, the Red Hat logo, the Shadowman logo, JBoss, OpenShift, Fedora, the Infinity logo, and RHCE are trademarks of Red Hat, Inc., registered in the United States and other countries.
		

			Linux® is the registered trademark of Linus Torvalds in the United States and other countries.
		

			Java® is a registered trademark of Oracle and/or its affiliates.
		

			XFS® is a trademark of Silicon Graphics International Corp. or its subsidiaries in the United States and/or other countries.
		

			MySQL® is a registered trademark of MySQL AB in the United States, the European Union and other countries.
		

			Node.js® is an official trademark of Joyent. Red Hat Software Collections is not formally related to or endorsed by the official Joyent Node.js open source or commercial project.
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# Highlight.js

Highlight.js — это подсветчик синтаксиса, написанный на JavaScript. Он работает
и в браузере, и на сервере. Он работает с практически любой HTML разметкой, не
зависит от каких-либо фреймворков и умеет автоматически определять язык.


## Начало работы

Минимум, что нужно сделать для использования highlight.js на веб-странице — это
подключить библиотеку, CSS-стили и вызывать [`initHighlightingOnLoad`][1]:

```html
<link rel="stylesheet" href="/path/to/styles/default.css">
<script src="/path/to/highlight.pack.js"></script>
<script>hljs.initHighlightingOnLoad();</script>
```

Библиотека найдёт и раскрасит код внутри тегов `<pre><code>`, попытавшись
автоматически определить язык. Когда автоопределение не срабатывает, можно явно
указать язык в атрибуте class:

```html
<pre><code class="html">...</code></pre>
```

Список поддерживаемых классов языков доступен в [справочнике по классам][8].
Класс также можно предваоить префиксами `language-` или `lang-`.

Чтобы отключить подсветку для какого-то блока, используйте класс `nohighlight`:

```html
<pre><code class="nohighlight">...</code></pre>
```

## Инициализация вручную

Чтобы иметь чуть больше контроля за инициализацией подсветки, вы можете
использовать функции [`highlightBlock`][2] и [`configure`][3]. Таким образом
можно управлять тем, *что* подсвечивать и *когда*.

Вот пример инициализация, эквивалентной вызову [`initHighlightingOnLoad`][1], но
с использованием jQuery:

```javascript
$(document).ready(function() {
  $('pre code').each(function(i, block) {
    hljs.highlightBlock(block);
  });
});
```

Вы можете использовать любые теги разметки вместо `<pre><code>`. Если
используете контейнер, не сохраняющий переводы строк, вам нужно сказать
highlight.js использовать для них тег `<br>`:

```javascript
hljs.configure({useBR: true});

$('div.code').each(function(i, block) {
  hljs.highlightBlock(block);
});
```

Другие опции можно найти в документации функции [`configure`][3].


## Установка библиотеки

Highlight.js можно использовать в браузере прямо с CDN хостинга или скачать
индивидуальную сборку, а также установив модуль на сервере. На
[страница загрузки][4] подробно описаны все варианты.

Обратите внимание, что библиотека не предназначена для использования в виде
исходного кода на GitHub, а требует отдельной сборки. Если вам не подходит ни
один из готовых вариантов, читайте [документацию по сборке][5].


## Лицензия

Highlight.js распространяется под лицензией BSD. Подробнее читайте файл
[LICENSE][10].


## Ссылки

Официальный сайт билиотеки расположен по адресу <https://highlightjs.org/>.

Более подробная документация по API и другим темам расположена на
<http://highlightjs.readthedocs.org/>.

Авторы и контрибьютора перечислена в файле [AUTHORS.ru.txt][9] file.

[1]: http://highlightjs.readthedocs.org/en/latest/api.html#inithighlightingonload
[2]: http://highlightjs.readthedocs.org/en/latest/api.html#highlightblock-block
[3]: http://highlightjs.readthedocs.org/en/latest/api.html#configure-options
[4]: https://highlightjs.org/download/
[5]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[8]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[9]: https://github.com/isagalaev/highlight.js/blob/master/AUTHORS.ru.txt
[10]: https://github.com/isagalaev/highlight.js/blob/master/LICENSE
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/*! jQuery v1.7.1 jquery.com | jquery.org/license */
(function(a,b){function cy(a){return f.isWindow(a)?a:a.nodeType===9?a.defaultView||a.parentWindow:!1}function cv(a){if(!ck[a]){var b=c.body,d=f("<"+a+">").appendTo(b),e=d.css("display");d.remove();if(e==="none"||e===""){cl||(cl=c.createElement("iframe"),cl.frameBorder=cl.width=cl.height=0),b.appendChild(cl);if(!cm||!cl.createElement)cm=(cl.contentWindow||cl.contentDocument).document,cm.write((c.compatMode==="CSS1Compat"?"<!doctype html>":"")+"<html><body>"),cm.close();d=cm.createElement(a),cm.body.appendChild(d),e=f.css(d,"display"),b.removeChild(cl)}ck[a]=e}return ck[a]}function cu(a,b){var c={};f.each(cq.concat.apply([],cq.slice(0,b)),function(){c[this]=a});return c}function ct(){cr=b}function cs(){setTimeout(ct,0);return cr=f.now()}function cj(){try{return new a.ActiveXObject("Microsoft.XMLHTTP")}catch(b){}}function ci(){try{return new a.XMLHttpRequest}catch(b){}}function cc(a,c){a.dataFilter&&(c=a.dataFilter(c,a.dataType));var d=a.dataTypes,e={},g,h,i=d.length,j,k=d[0],l,m,n,o,p;for(g=1;g<i;g++){if(g===1)for(h in a.converters)typeof h=="string"&&(e[h.toLowerCase()]=a.converters[h]);l=k,k=d[g];if(k==="*")k=l;else if(l!=="*"&&l!==k){m=l+" "+k,n=e[m]||e["* "+k];if(!n){p=b;for(o in e){j=o.split(" ");if(j[0]===l||j[0]==="*"){p=e[j[1]+" "+k];if(p){o=e[o],o===!0?n=p:p===!0&&(n=o);break}}}}!n&&!p&&f.error("No conversion from "+m.replace(" "," to ")),n!==!0&&(c=n?n(c):p(o(c)))}}return c}function cb(a,c,d){var e=a.contents,f=a.dataTypes,g=a.responseFields,h,i,j,k;for(i in g)i in d&&(c[g[i]]=d[i]);while(f[0]==="*")f.shift(),h===b&&(h=a.mimeType||c.getResponseHeader("content-type"));if(h)for(i in e)if(e[i]&&e[i].test(h)){f.unshift(i);break}if(f[0]in d)j=f[0];else{for(i in d){if(!f[0]||a.converters[i+" "+f[0]]){j=i;break}k||(k=i)}j=j||k}if(j){j!==f[0]&&f.unshift(j);return d[j]}}function ca(a,b,c,d){if(f.isArray(b))f.each(b,function(b,e){c||bE.test(a)?d(a,e):ca(a+"["+(typeof e=="object"||f.isArray(e)?b:"")+"]",e,c,d)});else if(!c&&b!=null&&typeof b=="object")for(var e in b)ca(a+"["+e+"]",b[e],c,d);else d(a,b)}function b_(a,c){var d,e,g=f.ajaxSettings.flatOptions||{};for(d in c)c[d]!==b&&((g[d]?a:e||(e={}))[d]=c[d]);e&&f.extend(!0,a,e)}function b$(a,c,d,e,f,g){f=f||c.dataTypes[0],g=g||{},g[f]=!0;var h=a[f],i=0,j=h?h.length:0,k=a===bT,l;for(;i<j&&(k||!l);i++)l=h[i](c,d,e),typeof l=="string"&&(!k||g[l]?l=b:(c.dataTypes.unshift(l),l=b$(a,c,d,e,l,g)));(k||!l)&&!g["*"]&&(l=b$(a,c,d,e,"*",g));return l}function bZ(a){return function(b,c){typeof b!="string"&&(c=b,b="*");if(f.isFunction(c)){var d=b.toLowerCase().split(bP),e=0,g=d.length,h,i,j;for(;e<g;e++)h=d[e],j=/^\+/.test(h),j&&(h=h.substr(1)||"*"),i=a[h]=a[h]||[],i[j?"unshift":"push"](c)}}}function bC(a,b,c){var d=b==="width"?a.offsetWidth:a.offsetHeight,e=b==="width"?bx:by,g=0,h=e.length;if(d>0){if(c!=="border")for(;g<h;g++)c||(d-=parseFloat(f.css(a,"padding"+e[g]))||0),c==="margin"?d+=parseFloat(f.css(a,c+e[g]))||0:d-=parseFloat(f.css(a,"border"+e[g]+"Width"))||0;return d+"px"}d=bz(a,b,b);if(d<0||d==null)d=a.style[b]||0;d=parseFloat(d)||0;if(c)for(;g<h;g++)d+=parseFloat(f.css(a,"padding"+e[g]))||0,c!=="padding"&&(d+=parseFloat(f.css(a,"border"+e[g]+"Width"))||0),c==="margin"&&(d+=parseFloat(f.css(a,c+e[g]))||0);return d+"px"}function bp(a,b){b.src?f.ajax({url:b.src,async:!1,dataType:"script"}):f.globalEval((b.text||b.textContent||b.innerHTML||"").replace(bf,"/*$0*/")),b.parentNode&&b.parentNode.removeChild(b)}function bo(a){var b=c.createElement("div");bh.appendChild(b),b.innerHTML=a.outerHTML;return b.firstChild}function bn(a){var b=(a.nodeName||"").toLowerCase();b==="input"?bm(a):b!=="script"&&typeof a.getElementsByTagName!="undefined"&&f.grep(a.getElementsByTagName("input"),bm)}function bm(a){if(a.type==="checkbox"||a.type==="radio")a.defaultChecked=a.checked}function bl(a){return typeof a.getElementsByTagName!="undefined"?a.getElementsByTagName("*"):typeof a.querySelectorAll!="undefined"?a.querySelectorAll("*"):[]}function bk(a,b){var c;if(b.nodeType===1){b.clearAttributes&&b.clearAttributes(),b.mergeAttributes&&b.mergeAttributes(a),c=b.nodeName.toLowerCase();if(c==="object")b.outerHTML=a.outerHTML;else if(c!=="input"||a.type!=="checkbox"&&a.type!=="radio"){if(c==="option")b.selected=a.defaultSelected;else if(c==="input"||c==="textarea")b.defaultValue=a.defaultValue}else a.checked&&(b.defaultChecked=b.checked=a.checked),b.value!==a.value&&(b.value=a.value);b.removeAttribute(f.expando)}}function bj(a,b){if(b.nodeType===1&&!!f.hasData(a)){var c,d,e,g=f._data(a),h=f._data(b,g),i=g.events;if(i){delete h.handle,h.events={};for(c in i)for(d=0,e=i[c].length;d<e;d++)f.event.add(b,c+(i[c][d].namespace?".":"")+i[c][d].namespace,i[c][d],i[c][d].data)}h.data&&(h.data=f.extend({},h.data))}}function bi(a,b){return f.nodeName(a,"table")?a.getElementsByTagName("tbody")[0]||a.appendChild(a.ownerDocument.createElement("tbody")):a}function U(a){var b=V.split("|"),c=a.createDocumentFragment();if(c.createElement)while(b.length)c.createElement(b.pop());return c}function T(a,b,c){b=b||0;if(f.isFunction(b))return f.grep(a,function(a,d){var e=!!b.call(a,d,a);return e===c});if(b.nodeType)return f.grep(a,function(a,d){return a===b===c});if(typeof b=="string"){var d=f.grep(a,function(a){return a.nodeType===1});if(O.test(b))return f.filter(b,d,!c);b=f.filter(b,d)}return f.grep(a,function(a,d){return f.inArray(a,b)>=0===c})}function S(a){return!a||!a.parentNode||a.parentNode.nodeType===11}function K(){return!0}function J(){return!1}function n(a,b,c){var d=b+"defer",e=b+"queue",g=b+"mark",h=f._data(a,d);h&&(c==="queue"||!f._data(a,e))&&(c==="mark"||!f._data(a,g))&&setTimeout(function(){!f._data(a,e)&&!f._data(a,g)&&(f.removeData(a,d,!0),h.fire())},0)}function m(a){for(var b in a){if(b==="data"&&f.isEmptyObject(a[b]))continue;if(b!=="toJSON")return!1}return!0}function l(a,c,d){if(d===b&&a.nodeType===1){var e="data-"+c.replace(k,"-$1").toLowerCase();d=a.getAttribute(e);if(typeof d=="string"){try{d=d==="true"?!0:d==="false"?!1:d==="null"?null:f.isNumeric(d)?parseFloat(d):j.test(d)?f.parseJSON(d):d}catch(g){}f.data(a,c,d)}else d=b}return d}function h(a){var b=g[a]={},c,d;a=a.split(/\s+/);for(c=0,d=a.length;c<d;c++)b[a[c]]=!0;return b}var c=a.document,d=a.navigator,e=a.location,f=function(){function J(){if(!e.isReady){try{c.documentElement.doScroll("left")}catch(a){setTimeout(J,1);return}e.ready()}}var e=function(a,b){return new e.fn.init(a,b,h)},f=a.jQuery,g=a.$,h,i=/^(?:[^#<]*(<[\w\W]+>)[^>]*$|#([\w\-]*)$)/,j=/\S/,k=/^\s+/,l=/\s+$/,m=/^<(\w+)\s*\/?>(?:<\/\1>)?$/,n=/^[\],:{}\s]*$/,o=/\\(?:["\\\/bfnrt]|u[0-9a-fA-F]{4})/g,p=/"[^"\\\n\r]*"|true|false|null|-?\d+(?:\.\d*)?(?:[eE][+\-]?\d+)?/g,q=/(?:^|:|,)(?:\s*\[)+/g,r=/(webkit)[ \/]([\w.]+)/,s=/(opera)(?:.*version)?[ \/]([\w.]+)/,t=/(msie) ([\w.]+)/,u=/(mozilla)(?:.*? rv:([\w.]+))?/,v=/-([a-z]|[0-9])/ig,w=/^-ms-/,x=function(a,b){return(b+"").toUpperCase()},y=d.userAgent,z,A,B,C=Object.prototype.toString,D=Object.prototype.hasOwnProperty,E=Array.prototype.push,F=Array.prototype.slice,G=String.prototype.trim,H=Array.prototype.indexOf,I={};e.fn=e.prototype={constructor:e,init:function(a,d,f){var g,h,j,k;if(!a)return this;if(a.nodeType){this.context=this[0]=a,this.length=1;return this}if(a==="body"&&!d&&c.body){this.context=c,this[0]=c.body,this.selector=a,this.length=1;return this}if(typeof a=="string"){a.charAt(0)!=="<"||a.charAt(a.length-1)!==">"||a.length<3?g=i.exec(a):g=[null,a,null];if(g&&(g[1]||!d)){if(g[1]){d=d instanceof e?d[0]:d,k=d?d.ownerDocument||d:c,j=m.exec(a),j?e.isPlainObject(d)?(a=[c.createElement(j[1])],e.fn.attr.call(a,d,!0)):a=[k.createElement(j[1])]:(j=e.buildFragment([g[1]],[k]),a=(j.cacheable?e.clone(j.fragment):j.fragment).childNodes);return e.merge(this,a)}h=c.getElementById(g[2]);if(h&&h.parentNode){if(h.id!==g[2])return f.find(a);this.length=1,this[0]=h}this.context=c,this.selector=a;return this}return!d||d.jquery?(d||f).find(a):this.constructor(d).find(a)}if(e.isFunction(a))return f.ready(a);a.selector!==b&&(this.selector=a.selector,this.context=a.context);return e.makeArray(a,this)},selector:"",jquery:"1.7.1",length:0,size:function(){return this.length},toArray:function(){return F.call(this,0)},get:function(a){return a==null?this.toArray():a<0?this[this.length+a]:this[a]},pushStack:function(a,b,c){var d=this.constructor();e.isArray(a)?E.apply(d,a):e.merge(d,a),d.prevObject=this,d.context=this.context,b==="find"?d.selector=this.selector+(this.selector?" ":"")+c:b&&(d.selector=this.selector+"."+b+"("+c+")");return d},each:function(a,b){return e.each(this,a,b)},ready:function(a){e.bindReady(),A.add(a);return this},eq:function(a){a=+a;return a===-1?this.slice(a):this.slice(a,a+1)},first:function(){return this.eq(0)},last:function(){return this.eq(-1)},slice:function(){return this.pushStack(F.apply(this,arguments),"slice",F.call(arguments).join(","))},map:function(a){return this.pushStack(e.map(this,function(b,c){return a.call(b,c,b)}))},end:function(){return this.prevObject||this.constructor(null)},push:E,sort:[].sort,splice:[].splice},e.fn.init.prototype=e.fn,e.extend=e.fn.extend=function(){var a,c,d,f,g,h,i=arguments[0]||{},j=1,k=arguments.length,l=!1;typeof i=="boolean"&&(l=i,i=arguments[1]||{},j=2),typeof i!="object"&&!e.isFunction(i)&&(i={}),k===j&&(i=this,--j);for(;j<k;j++)if((a=arguments[j])!=null)for(c in a){d=i[c],f=a[c];if(i===f)continue;l&&f&&(e.isPlainObject(f)||(g=e.isArray(f)))?(g?(g=!1,h=d&&e.isArray(d)?d:[]):h=d&&e.isPlainObject(d)?d:{},i[c]=e.extend(l,h,f)):f!==b&&(i[c]=f)}return i},e.extend({noConflict:function(b){a.$===e&&(a.$=g),b&&a.jQuery===e&&(a.jQuery=f);return e},isReady:!1,readyWait:1,holdReady:function(a){a?e.readyWait++:e.ready(!0)},ready:function(a){if(a===!0&&!--e.readyWait||a!==!0&&!e.isReady){if(!c.body)return setTimeout(e.ready,1);e.isReady=!0;if(a!==!0&&--e.readyWait>0)return;A.fireWith(c,[e]),e.fn.trigger&&e(c).trigger("ready").off("ready")}},bindReady:function(){if(!A){A=e.Callbacks("once memory");if(c.readyState==="complete")return setTimeout(e.ready,1);if(c.addEventListener)c.addEventListener("DOMContentLoaded",B,!1),a.addEventListener("load",e.ready,!1);else if(c.attachEvent){c.attachEvent("onreadystatechange",B),a.attachEvent("onload",e.ready);var b=!1;try{b=a.frameElement==null}catch(d){}c.documentElement.doScroll&&b&&J()}}},isFunction:function(a){return e.type(a)==="function"},isArray:Array.isArray||function(a){return e.type(a)==="array"},isWindow:function(a){return a&&typeof a=="object"&&"setInterval"in a},isNumeric:function(a){return!isNaN(parseFloat(a))&&isFinite(a)},type:function(a){return a==null?String(a):I[C.call(a)]||"object"},isPlainObject:function(a){if(!a||e.type(a)!=="object"||a.nodeType||e.isWindow(a))return!1;try{if(a.constructor&&!D.call(a,"constructor")&&!D.call(a.constructor.prototype,"isPrototypeOf"))return!1}catch(c){return!1}var d;for(d in a);return d===b||D.call(a,d)},isEmptyObject:function(a){for(var b in a)return!1;return!0},error:function(a){throw new Error(a)},parseJSON:function(b){if(typeof b!="string"||!b)return null;b=e.trim(b);if(a.JSON&&a.JSON.parse)return a.JSON.parse(b);if(n.test(b.replace(o,"@").replace(p,"]").replace(q,"")))return(new Function("return "+b))();e.error("Invalid JSON: "+b)},parseXML:function(c){var d,f;try{a.DOMParser?(f=new DOMParser,d=f.parseFromString(c,"text/xml")):(d=new ActiveXObject("Microsoft.XMLDOM"),d.async="false",d.loadXML(c))}catch(g){d=b}(!d||!d.documentElement||d.getElementsByTagName("parsererror").length)&&e.error("Invalid XML: "+c);return d},noop:function(){},globalEval:function(b){b&&j.test(b)&&(a.execScript||function(b){a.eval.call(a,b)})(b)},camelCase:function(a){return a.replace(w,"ms-").replace(v,x)},nodeName:function(a,b){return a.nodeName&&a.nodeName.toUpperCase()===b.toUpperCase()},each:function(a,c,d){var f,g=0,h=a.length,i=h===b||e.isFunction(a);if(d){if(i){for(f in a)if(c.apply(a[f],d)===!1)break}else for(;g<h;)if(c.apply(a[g++],d)===!1)break}else if(i){for(f in a)if(c.call(a[f],f,a[f])===!1)break}else for(;g<h;)if(c.call(a[g],g,a[g++])===!1)break;return a},trim:G?function(a){return a==null?"":G.call(a)}:function(a){return a==null?"":(a+"").replace(k,"").replace(l,"")},makeArray:function(a,b){var c=b||[];if(a!=null){var d=e.type(a);a.length==null||d==="string"||d==="function"||d==="regexp"||e.isWindow(a)?E.call(c,a):e.merge(c,a)}return c},inArray:function(a,b,c){var d;if(b){if(H)return H.call(b,a,c);d=b.length,c=c?c<0?Math.max(0,d+c):c:0;for(;c<d;c++)if(c in b&&b[c]===a)return c}return-1},merge:function(a,c){var d=a.length,e=0;if(typeof c.length=="number")for(var f=c.length;e<f;e++)a[d++]=c[e];else while(c[e]!==b)a[d++]=c[e++];a.length=d;return a},grep:function(a,b,c){var d=[],e;c=!!c;for(var f=0,g=a.length;f<g;f++)e=!!b(a[f],f),c!==e&&d.push(a[f]);return d},map:function(a,c,d){var f,g,h=[],i=0,j=a.length,k=a instanceof e||j!==b&&typeof j=="number"&&(j>0&&a[0]&&a[j-1]||j===0||e.isArray(a));if(k)for(;i<j;i++)f=c(a[i],i,d),f!=null&&(h[h.length]=f);else for(g in a)f=c(a[g],g,d),f!=null&&(h[h.length]=f);return h.concat.apply([],h)},guid:1,proxy:function(a,c){if(typeof c=="string"){var d=a[c];c=a,a=d}if(!e.isFunction(a))return b;var f=F.call(arguments,2),g=function(){return a.apply(c,f.concat(F.call(arguments)))};g.guid=a.guid=a.guid||g.guid||e.guid++;return g},access:function(a,c,d,f,g,h){var i=a.length;if(typeof c=="object"){for(var j in c)e.access(a,j,c[j],f,g,d);return a}if(d!==b){f=!h&&f&&e.isFunction(d);for(var k=0;k<i;k++)g(a[k],c,f?d.call(a[k],k,g(a[k],c)):d,h);return a}return i?g(a[0],c):b},now:function(){return(new Date).getTime()},uaMatch:function(a){a=a.toLowerCase();var b=r.exec(a)||s.exec(a)||t.exec(a)||a.indexOf("compatible")<0&&u.exec(a)||[];return{browser:b[1]||"",version:b[2]||"0"}},sub:function(){function a(b,c){return new a.fn.init(b,c)}e.extend(!0,a,this),a.superclass=this,a.fn=a.prototype=this(),a.fn.constructor=a,a.sub=this.sub,a.fn.init=function(d,f){f&&f instanceof e&&!(f instanceof a)&&(f=a(f));return e.fn.init.call(this,d,f,b)},a.fn.init.prototype=a.fn;var b=a(c);return a},browser:{}}),e.each("Boolean Number String Function Array Date RegExp Object".split(" "),function(a,b){I["[object "+b+"]"]=b.toLowerCase()}),z=e.uaMatch(y),z.browser&&(e.browser[z.browser]=!0,e.browser.version=z.version),e.browser.webkit&&(e.browser.safari=!0),j.test(" ")&&(k=/^[\s\xA0]+/,l=/[\s\xA0]+$/),h=e(c),c.addEventListener?B=function(){c.removeEventListener("DOMContentLoaded",B,!1),e.ready()}:c.attachEvent&&(B=function(){c.readyState==="complete"&&(c.detachEvent("onreadystatechange",B),e.ready())});return e}(),g={};f.Callbacks=function(a){a=a?g[a]||h(a):{};var c=[],d=[],e,i,j,k,l,m=function(b){var d,e,g,h,i;for(d=0,e=b.length;d<e;d++)g=b[d],h=f.type(g),h==="array"?m(g):h==="function"&&(!a.unique||!o.has(g))&&c.push(g)},n=function(b,f){f=f||[],e=!a.memory||[b,f],i=!0,l=j||0,j=0,k=c.length;for(;c&&l<k;l++)if(c[l].apply(b,f)===!1&&a.stopOnFalse){e=!0;break}i=!1,c&&(a.once?e===!0?o.disable():c=[]:d&&d.length&&(e=d.shift(),o.fireWith(e[0],e[1])))},o={add:function(){if(c){var a=c.length;m(arguments),i?k=c.length:e&&e!==!0&&(j=a,n(e[0],e[1]))}return this},remove:function(){if(c){var b=arguments,d=0,e=b.length;for(;d<e;d++)for(var f=0;f<c.length;f++)if(b[d]===c[f]){i&&f<=k&&(k--,f<=l&&l--),c.splice(f--,1);if(a.unique)break}}return this},has:function(a){if(c){var b=0,d=c.length;for(;b<d;b++)if(a===c[b])return!0}return!1},empty:function(){c=[];return this},disable:function(){c=d=e=b;return this},disabled:function(){return!c},lock:function(){d=b,(!e||e===!0)&&o.disable();return this},locked:function(){return!d},fireWith:function(b,c){d&&(i?a.once||d.push([b,c]):(!a.once||!e)&&n(b,c));return this},fire:function(){o.fireWith(this,arguments);return this},fired:function(){return!!e}};return o};var i=[].slice;f.extend({Deferred:function(a){var b=f.Callbacks("once memory"),c=f.Callbacks("once memory"),d=f.Callbacks("memory"),e="pending",g={resolve:b,reject:c,notify:d},h={done:b.add,fail:c.add,progress:d.add,state:function(){return e},isResolved:b.fired,isRejected:c.fired,then:function(a,b,c){i.done(a).fail(b).progress(c);return this},always:function(){i.done.apply(i,arguments).fail.apply(i,arguments);return this},pipe:function(a,b,c){return f.Deferred(function(d){f.each({done:[a,"resolve"],fail:[b,"reject"],progress:[c,"notify"]},function(a,b){var c=b[0],e=b[1],g;f.isFunction(c)?i[a](function(){g=c.apply(this,arguments),g&&f.isFunction(g.promise)?g.promise().then(d.resolve,d.reject,d.notify):d[e+"With"](this===i?d:this,[g])}):i[a](d[e])})}).promise()},promise:function(a){if(a==null)a=h;else for(var b in h)a[b]=h[b];return a}},i=h.promise({}),j;for(j in g)i[j]=g[j].fire,i[j+"With"]=g[j].fireWith;i.done(function(){e="resolved"},c.disable,d.lock).fail(function(){e="rejected"},b.disable,d.lock),a&&a.call(i,i);return i},when:function(a){function m(a){return function(b){e[a]=arguments.length>1?i.call(arguments,0):b,j.notifyWith(k,e)}}function l(a){return function(c){b[a]=arguments.length>1?i.call(arguments,0):c,--g||j.resolveWith(j,b)}}var b=i.call(arguments,0),c=0,d=b.length,e=Array(d),g=d,h=d,j=d<=1&&a&&f.isFunction(a.promise)?a:f.Deferred(),k=j.promise();if(d>1){for(;c<d;c++)b[c]&&b[c].promise&&f.isFunction(b[c].promise)?b[c].promise().then(l(c),j.reject,m(c)):--g;g||j.resolveWith(j,b)}else j!==a&&j.resolveWith(j,d?[a]:[]);return k}}),f.support=function(){var b,d,e,g,h,i,j,k,l,m,n,o,p,q=c.createElement("div"),r=c.documentElement;q.setAttribute("className","t"),q.innerHTML="   <link/><table></table><a href='/a' style='top:1px;float:left;opacity:.55;'>a</a><input type='checkbox'/>",d=q.getElementsByTagName("*"),e=q.getElementsByTagName("a")[0];if(!d||!d.length||!e)return{};g=c.createElement("select"),h=g.appendChild(c.createElement("option")),i=q.getElementsByTagName("input")[0],b={leadingWhitespace:q.firstChild.nodeType===3,tbody:!q.getElementsByTagName("tbody").length,htmlSerialize:!!q.getElementsByTagName("link").length,style:/top/.test(e.getAttribute("style")),hrefNormalized:e.getAttribute("href")==="/a",opacity:/^0.55/.test(e.style.opacity),cssFloat:!!e.style.cssFloat,checkOn:i.value==="on",optSelected:h.selected,getSetAttribute:q.className!=="t",enctype:!!c.createElement("form").enctype,html5Clone:c.createElement("nav").cloneNode(!0).outerHTML!=="<:nav></:nav>",submitBubbles:!0,changeBubbles:!0,focusinBubbles:!1,deleteExpando:!0,noCloneEvent:!0,inlineBlockNeedsLayout:!1,shrinkWrapBlocks:!1,reliableMarginRight:!0},i.checked=!0,b.noCloneChecked=i.cloneNode(!0).checked,g.disabled=!0,b.optDisabled=!h.disabled;try{delete q.test}catch(s){b.deleteExpando=!1}!q.addEventListener&&q.attachEvent&&q.fireEvent&&(q.attachEvent("onclick",function(){b.noCloneEvent=!1}),q.cloneNode(!0).fireEvent("onclick")),i=c.createElement("input"),i.value="t",i.setAttribute("type","radio"),b.radioValue=i.value==="t",i.setAttribute("checked","checked"),q.appendChild(i),k=c.createDocumentFragment(),k.appendChild(q.lastChild),b.checkClone=k.cloneNode(!0).cloneNode(!0).lastChild.checked,b.appendChecked=i.checked,k.removeChild(i),k.appendChild(q),q.innerHTML="",a.getComputedStyle&&(j=c.createElement("div"),j.style.width="0",j.style.marginRight="0",q.style.width="2px",q.appendChild(j),b.reliableMarginRight=(parseInt((a.getComputedStyle(j,null)||{marginRight:0}).marginRight,10)||0)===0);if(q.attachEvent)for(o in{submit:1,change:1,focusin:1})n="on"+o,p=n in q,p||(q.setAttribute(n,"return;"),p=typeof q[n]=="function"),b[o+"Bubbles"]=p;k.removeChild(q),k=g=h=j=q=i=null,f(function(){var a,d,e,g,h,i,j,k,m,n,o,r=c.getElementsByTagName("body")[0];!r||(j=1,k="position:absolute;top:0;left:0;width:1px;height:1px;margin:0;",m="visibility:hidden;border:0;",n="style='"+k+"border:5px solid #000;padding:0;'",o="<div "+n+"><div></div></div>"+"<table "+n+" cellpadding='0' cellspacing='0'>"+"<tr><td></td></tr></table>",a=c.createElement("div"),a.style.cssText=m+"width:0;height:0;position:static;top:0;margin-top:"+j+"px",r.insertBefore(a,r.firstChild),q=c.createElement("div"),a.appendChild(q),q.innerHTML="<table><tr><td style='padding:0;border:0;display:none'></td><td>t</td></tr></table>",l=q.getElementsByTagName("td"),p=l[0].offsetHeight===0,l[0].style.display="",l[1].style.display="none",b.reliableHiddenOffsets=p&&l[0].offsetHeight===0,q.innerHTML="",q.style.width=q.style.paddingLeft="1px",f.boxModel=b.boxModel=q.offsetWidth===2,typeof q.style.zoom!="undefined"&&(q.style.display="inline",q.style.zoom=1,b.inlineBlockNeedsLayout=q.offsetWidth===2,q.style.display="",q.innerHTML="<div style='width:4px;'></div>",b.shrinkWrapBlocks=q.offsetWidth!==2),q.style.cssText=k+m,q.innerHTML=o,d=q.firstChild,e=d.firstChild,h=d.nextSibling.firstChild.firstChild,i={doesNotAddBorder:e.offsetTop!==5,doesAddBorderForTableAndCells:h.offsetTop===5},e.style.position="fixed",e.style.top="20px",i.fixedPosition=e.offsetTop===20||e.offsetTop===15,e.style.position=e.style.top="",d.style.overflow="hidden",d.style.position="relative",i.subtractsBorderForOverflowNotVisible=e.offsetTop===-5,i.doesNotIncludeMarginInBodyOffset=r.offsetTop!==j,r.removeChild(a),q=a=null,f.extend(b,i))});return b}();var j=/^(?:\{.*\}|\[.*\])$/,k=/([A-Z])/g;f.extend({cache:{},uuid:0,expando:"jQuery"+(f.fn.jquery+Math.random()).replace(/\D/g,""),noData:{embed:!0,object:"clsid:D27CDB6E-AE6D-11cf-96B8-444553540000",applet:!0},hasData:function(a){a=a.nodeType?f.cache[a[f.expando]]:a[f.expando];return!!a&&!m(a)},data:function(a,c,d,e){if(!!f.acceptData(a)){var g,h,i,j=f.expando,k=typeof c=="string",l=a.nodeType,m=l?f.cache:a,n=l?a[j]:a[j]&&j,o=c==="events";if((!n||!m[n]||!o&&!e&&!m[n].data)&&k&&d===b)return;n||(l?a[j]=n=++f.uuid:n=j),m[n]||(m[n]={},l||(m[n].toJSON=f.noop));if(typeof c=="object"||typeof c=="function")e?m[n]=f.extend(m[n],c):m[n].data=f.extend(m[n].data,c);g=h=m[n],e||(h.data||(h.data={}),h=h.data),d!==b&&(h[f.camelCase(c)]=d);if(o&&!h[c])return g.events;k?(i=h[c],i==null&&(i=h[f.camelCase(c)])):i=h;return i}},removeData:function(a,b,c){if(!!f.acceptData(a)){var d,e,g,h=f.expando,i=a.nodeType,j=i?f.cache:a,k=i?a[h]:h;if(!j[k])return;if(b){d=c?j[k]:j[k].data;if(d){f.isArray(b)||(b in d?b=[b]:(b=f.camelCase(b),b in d?b=[b]:b=b.split(" ")));for(e=0,g=b.length;e<g;e++)delete d[b[e]];if(!(c?m:f.isEmptyObject)(d))return}}if(!c){delete j[k].data;if(!m(j[k]))return}f.support.deleteExpando||!j.setInterval?delete j[k]:j[k]=null,i&&(f.support.deleteExpando?delete a[h]:a.removeAttribute?a.removeAttribute(h):a[h]=null)}},_data:function(a,b,c){return f.data(a,b,c,!0)},acceptData:function(a){if(a.nodeName){var b=f.noData[a.nodeName.toLowerCase()];if(b)return b!==!0&&a.getAttribute("classid")===b}return!0}}),f.fn.extend({data:function(a,c){var d,e,g,h=null;if(typeof a=="undefined"){if(this.length){h=f.data(this[0]);if(this[0].nodeType===1&&!f._data(this[0],"parsedAttrs")){e=this[0].attributes;for(var i=0,j=e.length;i<j;i++)g=e[i].name,g.indexOf("data-")===0&&(g=f.camelCase(g.substring(5)),l(this[0],g,h[g]));f._data(this[0],"parsedAttrs",!0)}}return h}if(typeof a=="object")return this.each(function(){f.data(this,a)});d=a.split("."),d[1]=d[1]?"."+d[1]:"";if(c===b){h=this.triggerHandler("getData"+d[1]+"!",[d[0]]),h===b&&this.length&&(h=f.data(this[0],a),h=l(this[0],a,h));return h===b&&d[1]?this.data(d[0]):h}return this.each(function(){var b=f(this),e=[d[0],c];b.triggerHandler("setData"+d[1]+"!",e),f.data(this,a,c),b.triggerHandler("changeData"+d[1]+"!",e)})},removeData:function(a){return this.each(function(){f.removeData(this,a)})}}),f.extend({_mark:function(a,b){a&&(b=(b||"fx")+"mark",f._data(a,b,(f._data(a,b)||0)+1))},_unmark:function(a,b,c){a!==!0&&(c=b,b=a,a=!1);if(b){c=c||"fx";var d=c+"mark",e=a?0:(f._data(b,d)||1)-1;e?f._data(b,d,e):(f.removeData(b,d,!0),n(b,c,"mark"))}},queue:function(a,b,c){var d;if(a){b=(b||"fx")+"queue",d=f._data(a,b),c&&(!d||f.isArray(c)?d=f._data(a,b,f.makeArray(c)):d.push(c));return d||[]}},dequeue:function(a,b){b=b||"fx";var c=f.queue(a,b),d=c.shift(),e={};d==="inprogress"&&(d=c.shift()),d&&(b==="fx"&&c.unshift("inprogress"),f._data(a,b+".run",e),d.call(a,function(){f.dequeue(a,b)},e)),c.length||(f.removeData(a,b+"queue "+b+".run",!0),n(a,b,"queue"))}}),f.fn.extend({queue:function(a,c){typeof a!="string"&&(c=a,a="fx");if(c===b)return f.queue(this[0],a);return this.each(function(){var b=f.queue(this,a,c);a==="fx"&&b[0]!=="inprogress"&&f.dequeue(this,a)})},dequeue:function(a){return this.each(function(){f.dequeue(this,a)})},delay:function(a,b){a=f.fx?f.fx.speeds[a]||a:a,b=b||"fx";return this.queue(b,function(b,c){var d=setTimeout(b,a);c.stop=function(){clearTimeout(d)}})},clearQueue:function(a){return this.queue(a||"fx",[])},promise:function(a,c){function m(){--h||d.resolveWith(e,[e])}typeof a!="string"&&(c=a,a=b),a=a||"fx";var d=f.Deferred(),e=this,g=e.length,h=1,i=a+"defer",j=a+"queue",k=a+"mark",l;while(g--)if(l=f.data(e[g],i,b,!0)||(f.data(e[g],j,b,!0)||f.data(e[g],k,b,!0))&&f.data(e[g],i,f.Callbacks("once memory"),!0))h++,l.add(m);m();return d.promise()}});var o=/[\n\t\r]/g,p=/\s+/,q=/\r/g,r=/^(?:button|input)$/i,s=/^(?:button|input|object|select|textarea)$/i,t=/^a(?:rea)?$/i,u=/^(?:autofocus|autoplay|async|checked|controls|defer|disabled|hidden|loop|multiple|open|readonly|required|scoped|selected)$/i,v=f.support.getSetAttribute,w,x,y;f.fn.extend({attr:function(a,b){return f.access(this,a,b,!0,f.attr)},removeAttr:function(a){return this.each(function(){f.removeAttr(this,a)})},prop:function(a,b){return f.access(this,a,b,!0,f.prop)},removeProp:function(a){a=f.propFix[a]||a;return this.each(function(){try{this[a]=b,delete this[a]}catch(c){}})},addClass:function(a){var b,c,d,e,g,h,i;if(f.isFunction(a))return this.each(function(b){f(this).addClass(a.call(this,b,this.className))});if(a&&typeof a=="string"){b=a.split(p);for(c=0,d=this.length;c<d;c++){e=this[c];if(e.nodeType===1)if(!e.className&&b.length===1)e.className=a;else{g=" "+e.className+" ";for(h=0,i=b.length;h<i;h++)~g.indexOf(" "+b[h]+" ")||(g+=b[h]+" ");e.className=f.trim(g)}}}return this},removeClass:function(a){var c,d,e,g,h,i,j;if(f.isFunction(a))return this.each(function(b){f(this).removeClass(a.call(this,b,this.className))});if(a&&typeof a=="string"||a===b){c=(a||"").split(p);for(d=0,e=this.length;d<e;d++){g=this[d];if(g.nodeType===1&&g.className)if(a){h=(" "+g.className+" ").replace(o," ");for(i=0,j=c.length;i<j;i++)h=h.replace(" "+c[i]+" "," ");g.className=f.trim(h)}else g.className=""}}return this},toggleClass:function(a,b){var c=typeof a,d=typeof b=="boolean";if(f.isFunction(a))return this.each(function(c){f(this).toggleClass(a.call(this,c,this.className,b),b)});return this.each(function(){if(c==="string"){var e,g=0,h=f(this),i=b,j=a.split(p);while(e=j[g++])i=d?i:!h.hasClass(e),h[i?"addClass":"removeClass"](e)}else if(c==="undefined"||c==="boolean")this.className&&f._data(this,"__className__",this.className),this.className=this.className||a===!1?"":f._data(this,"__className__")||""})},hasClass:function(a){var b=" "+a+" ",c=0,d=this.length;for(;c<d;c++)if(this[c].nodeType===1&&(" "+this[c].className+" ").replace(o," ").indexOf(b)>-1)return!0;return!1},val:function(a){var c,d,e,g=this[0];{if(!!arguments.length){e=f.isFunction(a);return this.each(function(d){var g=f(this),h;if(this.nodeType===1){e?h=a.call(this,d,g.val()):h=a,h==null?h="":typeof h=="number"?h+="":f.isArray(h)&&(h=f.map(h,function(a){return a==null?"":a+""})),c=f.valHooks[this.nodeName.toLowerCase()]||f.valHooks[this.type];if(!c||!("set"in c)||c.set(this,h,"value")===b)this.value=h}})}if(g){c=f.valHooks[g.nodeName.toLowerCase()]||f.valHooks[g.type];if(c&&"get"in c&&(d=c.get(g,"value"))!==b)return d;d=g.value;return typeof d=="string"?d.replace(q,""):d==null?"":d}}}}),f.extend({valHooks:{option:{get:function(a){var b=a.attributes.value;return!b||b.specified?a.value:a.text}},select:{get:function(a){var b,c,d,e,g=a.selectedIndex,h=[],i=a.options,j=a.type==="select-one";if(g<0)return null;c=j?g:0,d=j?g+1:i.length;for(;c<d;c++){e=i[c];if(e.selected&&(f.support.optDisabled?!e.disabled:e.getAttribute("disabled")===null)&&(!e.parentNode.disabled||!f.nodeName(e.parentNode,"optgroup"))){b=f(e).val();if(j)return b;h.push(b)}}if(j&&!h.length&&i.length)return f(i[g]).val();return h},set:function(a,b){var c=f.makeArray(b);f(a).find("option").each(function(){this.selected=f.inArray(f(this).val(),c)>=0}),c.length||(a.selectedIndex=-1);return c}}},attrFn:{val:!0,css:!0,html:!0,text:!0,data:!0,width:!0,height:!0,offset:!0},attr:function(a,c,d,e){var g,h,i,j=a.nodeType;if(!!a&&j!==3&&j!==8&&j!==2){if(e&&c in f.attrFn)return f(a)[c](d);if(typeof a.getAttribute=="undefined")return f.prop(a,c,d);i=j!==1||!f.isXMLDoc(a),i&&(c=c.toLowerCase(),h=f.attrHooks[c]||(u.test(c)?x:w));if(d!==b){if(d===null){f.removeAttr(a,c);return}if(h&&"set"in h&&i&&(g=h.set(a,d,c))!==b)return g;a.setAttribute(c,""+d);return d}if(h&&"get"in h&&i&&(g=h.get(a,c))!==null)return g;g=a.getAttribute(c);return g===null?b:g}},removeAttr:function(a,b){var c,d,e,g,h=0;if(b&&a.nodeType===1){d=b.toLowerCase().split(p),g=d.length;for(;h<g;h++)e=d[h],e&&(c=f.propFix[e]||e,f.attr(a,e,""),a.removeAttribute(v?e:c),u.test(e)&&c in a&&(a[c]=!1))}},attrHooks:{type:{set:function(a,b){if(r.test(a.nodeName)&&a.parentNode)f.error("type property can't be changed");else if(!f.support.radioValue&&b==="radio"&&f.nodeName(a,"input")){var c=a.value;a.setAttribute("type",b),c&&(a.value=c);return b}}},value:{get:function(a,b){if(w&&f.nodeName(a,"button"))return w.get(a,b);return b in a?a.value:null},set:function(a,b,c){if(w&&f.nodeName(a,"button"))return w.set(a,b,c);a.value=b}}},propFix:{tabindex:"tabIndex",readonly:"readOnly","for":"htmlFor","class":"className",maxlength:"maxLength",cellspacing:"cellSpacing",cellpadding:"cellPadding",rowspan:"rowSpan",colspan:"colSpan",usemap:"useMap",frameborder:"frameBorder",contenteditable:"contentEditable"},prop:function(a,c,d){var e,g,h,i=a.nodeType;if(!!a&&i!==3&&i!==8&&i!==2){h=i!==1||!f.isXMLDoc(a),h&&(c=f.propFix[c]||c,g=f.propHooks[c]);return d!==b?g&&"set"in g&&(e=g.set(a,d,c))!==b?e:a[c]=d:g&&"get"in g&&(e=g.get(a,c))!==null?e:a[c]}},propHooks:{tabIndex:{get:function(a){var c=a.getAttributeNode("tabindex");return c&&c.specified?parseInt(c.value,10):s.test(a.nodeName)||t.test(a.nodeName)&&a.href?0:b}}}}),f.attrHooks.tabindex=f.propHooks.tabIndex,x={get:function(a,c){var d,e=f.prop(a,c);return e===!0||typeof e!="boolean"&&(d=a.getAttributeNode(c))&&d.nodeValue!==!1?c.toLowerCase():b},set:function(a,b,c){var d;b===!1?f.removeAttr(a,c):(d=f.propFix[c]||c,d in a&&(a[d]=!0),a.setAttribute(c,c.toLowerCase()));return c}},v||(y={name:!0,id:!0},w=f.valHooks.button={get:function(a,c){var d;d=a.getAttributeNode(c);return d&&(y[c]?d.nodeValue!=="":d.specified)?d.nodeValue:b},set:function(a,b,d){var e=a.getAttributeNode(d);e||(e=c.createAttribute(d),a.setAttributeNode(e));return e.nodeValue=b+""}},f.attrHooks.tabindex.set=w.set,f.each(["width","height"],function(a,b){f.attrHooks[b]=f.extend(f.attrHooks[b],{set:function(a,c){if(c===""){a.setAttribute(b,"auto");return c}}})}),f.attrHooks.contenteditable={get:w.get,set:function(a,b,c){b===""&&(b="false"),w.set(a,b,c)}}),f.support.hrefNormalized||f.each(["href","src","width","height"],function(a,c){f.attrHooks[c]=f.extend(f.attrHooks[c],{get:function(a){var d=a.getAttribute(c,2);return d===null?b:d}})}),f.support.style||(f.attrHooks.style={get:function(a){return a.style.cssText.toLowerCase()||b},set:function(a,b){return a.style.cssText=""+b}}),f.support.optSelected||(f.propHooks.selected=f.extend(f.propHooks.selected,{get:function(a){var b=a.parentNode;b&&(b.selectedIndex,b.parentNode&&b.parentNode.selectedIndex);return null}})),f.support.enctype||(f.propFix.enctype="encoding"),f.support.checkOn||f.each(["radio","checkbox"],function(){f.valHooks[this]={get:function(a){return a.getAttribute("value")===null?"on":a.value}}}),f.each(["radio","checkbox"],function(){f.valHooks[this]=f.extend(f.valHooks[this],{set:function(a,b){if(f.isArray(b))return a.checked=f.inArray(f(a).val(),b)>=0}})});var z=/^(?:textarea|input|select)$/i,A=/^([^\.]*)?(?:\.(.+))?$/,B=/\bhover(\.\S+)?\b/,C=/^key/,D=/^(?:mouse|contextmenu)|click/,E=/^(?:focusinfocus|focusoutblur)$/,F=/^(\w*)(?:#([\w\-]+))?(?:\.([\w\-]+))?$/,G=function(a){var b=F.exec(a);b&&(b[1]=(b[1]||"").toLowerCase(),b[3]=b[3]&&new RegExp("(?:^|\\s)"+b[3]+"(?:\\s|$)"));return b},H=function(a,b){var c=a.attributes||{};return(!b[1]||a.nodeName.toLowerCase()===b[1])&&(!b[2]||(c.id||{}).value===b[2])&&(!b[3]||b[3].test((c["class"]||{}).value))},I=function(a){return f.event.special.hover?a:a.replace(B,"mouseenter$1 mouseleave$1")};
f.event={add:function(a,c,d,e,g){var h,i,j,k,l,m,n,o,p,q,r,s;if(!(a.nodeType===3||a.nodeType===8||!c||!d||!(h=f._data(a)))){d.handler&&(p=d,d=p.handler),d.guid||(d.guid=f.guid++),j=h.events,j||(h.events=j={}),i=h.handle,i||(h.handle=i=function(a){return typeof f!="undefined"&&(!a||f.event.triggered!==a.type)?f.event.dispatch.apply(i.elem,arguments):b},i.elem=a),c=f.trim(I(c)).split(" ");for(k=0;k<c.length;k++){l=A.exec(c[k])||[],m=l[1],n=(l[2]||"").split(".").sort(),s=f.event.special[m]||{},m=(g?s.delegateType:s.bindType)||m,s=f.event.special[m]||{},o=f.extend({type:m,origType:l[1],data:e,handler:d,guid:d.guid,selector:g,quick:G(g),namespace:n.join(".")},p),r=j[m];if(!r){r=j[m]=[],r.delegateCount=0;if(!s.setup||s.setup.call(a,e,n,i)===!1)a.addEventListener?a.addEventListener(m,i,!1):a.attachEvent&&a.attachEvent("on"+m,i)}s.add&&(s.add.call(a,o),o.handler.guid||(o.handler.guid=d.guid)),g?r.splice(r.delegateCount++,0,o):r.push(o),f.event.global[m]=!0}a=null}},global:{},remove:function(a,b,c,d,e){var g=f.hasData(a)&&f._data(a),h,i,j,k,l,m,n,o,p,q,r,s;if(!!g&&!!(o=g.events)){b=f.trim(I(b||"")).split(" ");for(h=0;h<b.length;h++){i=A.exec(b[h])||[],j=k=i[1],l=i[2];if(!j){for(j in o)f.event.remove(a,j+b[h],c,d,!0);continue}p=f.event.special[j]||{},j=(d?p.delegateType:p.bindType)||j,r=o[j]||[],m=r.length,l=l?new RegExp("(^|\\.)"+l.split(".").sort().join("\\.(?:.*\\.)?")+"(\\.|$)"):null;for(n=0;n<r.length;n++)s=r[n],(e||k===s.origType)&&(!c||c.guid===s.guid)&&(!l||l.test(s.namespace))&&(!d||d===s.selector||d==="**"&&s.selector)&&(r.splice(n--,1),s.selector&&r.delegateCount--,p.remove&&p.remove.call(a,s));r.length===0&&m!==r.length&&((!p.teardown||p.teardown.call(a,l)===!1)&&f.removeEvent(a,j,g.handle),delete o[j])}f.isEmptyObject(o)&&(q=g.handle,q&&(q.elem=null),f.removeData(a,["events","handle"],!0))}},customEvent:{getData:!0,setData:!0,changeData:!0},trigger:function(c,d,e,g){if(!e||e.nodeType!==3&&e.nodeType!==8){var h=c.type||c,i=[],j,k,l,m,n,o,p,q,r,s;if(E.test(h+f.event.triggered))return;h.indexOf("!")>=0&&(h=h.slice(0,-1),k=!0),h.indexOf(".")>=0&&(i=h.split("."),h=i.shift(),i.sort());if((!e||f.event.customEvent[h])&&!f.event.global[h])return;c=typeof c=="object"?c[f.expando]?c:new f.Event(h,c):new f.Event(h),c.type=h,c.isTrigger=!0,c.exclusive=k,c.namespace=i.join("."),c.namespace_re=c.namespace?new RegExp("(^|\\.)"+i.join("\\.(?:.*\\.)?")+"(\\.|$)"):null,o=h.indexOf(":")<0?"on"+h:"";if(!e){j=f.cache;for(l in j)j[l].events&&j[l].events[h]&&f.event.trigger(c,d,j[l].handle.elem,!0);return}c.result=b,c.target||(c.target=e),d=d!=null?f.makeArray(d):[],d.unshift(c),p=f.event.special[h]||{};if(p.trigger&&p.trigger.apply(e,d)===!1)return;r=[[e,p.bindType||h]];if(!g&&!p.noBubble&&!f.isWindow(e)){s=p.delegateType||h,m=E.test(s+h)?e:e.parentNode,n=null;for(;m;m=m.parentNode)r.push([m,s]),n=m;n&&n===e.ownerDocument&&r.push([n.defaultView||n.parentWindow||a,s])}for(l=0;l<r.length&&!c.isPropagationStopped();l++)m=r[l][0],c.type=r[l][1],q=(f._data(m,"events")||{})[c.type]&&f._data(m,"handle"),q&&q.apply(m,d),q=o&&m[o],q&&f.acceptData(m)&&q.apply(m,d)===!1&&c.preventDefault();c.type=h,!g&&!c.isDefaultPrevented()&&(!p._default||p._default.apply(e.ownerDocument,d)===!1)&&(h!=="click"||!f.nodeName(e,"a"))&&f.acceptData(e)&&o&&e[h]&&(h!=="focus"&&h!=="blur"||c.target.offsetWidth!==0)&&!f.isWindow(e)&&(n=e[o],n&&(e[o]=null),f.event.triggered=h,e[h](),f.event.triggered=b,n&&(e[o]=n));return c.result}},dispatch:function(c){c=f.event.fix(c||a.event);var d=(f._data(this,"events")||{})[c.type]||[],e=d.delegateCount,g=[].slice.call(arguments,0),h=!c.exclusive&&!c.namespace,i=[],j,k,l,m,n,o,p,q,r,s,t;g[0]=c,c.delegateTarget=this;if(e&&!c.target.disabled&&(!c.button||c.type!=="click")){m=f(this),m.context=this.ownerDocument||this;for(l=c.target;l!=this;l=l.parentNode||this){o={},q=[],m[0]=l;for(j=0;j<e;j++)r=d[j],s=r.selector,o[s]===b&&(o[s]=r.quick?H(l,r.quick):m.is(s)),o[s]&&q.push(r);q.length&&i.push({elem:l,matches:q})}}d.length>e&&i.push({elem:this,matches:d.slice(e)});for(j=0;j<i.length&&!c.isPropagationStopped();j++){p=i[j],c.currentTarget=p.elem;for(k=0;k<p.matches.length&&!c.isImmediatePropagationStopped();k++){r=p.matches[k];if(h||!c.namespace&&!r.namespace||c.namespace_re&&c.namespace_re.test(r.namespace))c.data=r.data,c.handleObj=r,n=((f.event.special[r.origType]||{}).handle||r.handler).apply(p.elem,g),n!==b&&(c.result=n,n===!1&&(c.preventDefault(),c.stopPropagation()))}}return c.result},props:"attrChange attrName relatedNode srcElement altKey bubbles cancelable ctrlKey currentTarget eventPhase metaKey relatedTarget shiftKey target timeStamp view which".split(" "),fixHooks:{},keyHooks:{props:"char charCode key keyCode".split(" "),filter:function(a,b){a.which==null&&(a.which=b.charCode!=null?b.charCode:b.keyCode);return a}},mouseHooks:{props:"button buttons clientX clientY fromElement offsetX offsetY pageX pageY screenX screenY toElement".split(" "),filter:function(a,d){var e,f,g,h=d.button,i=d.fromElement;a.pageX==null&&d.clientX!=null&&(e=a.target.ownerDocument||c,f=e.documentElement,g=e.body,a.pageX=d.clientX+(f&&f.scrollLeft||g&&g.scrollLeft||0)-(f&&f.clientLeft||g&&g.clientLeft||0),a.pageY=d.clientY+(f&&f.scrollTop||g&&g.scrollTop||0)-(f&&f.clientTop||g&&g.clientTop||0)),!a.relatedTarget&&i&&(a.relatedTarget=i===a.target?d.toElement:i),!a.which&&h!==b&&(a.which=h&1?1:h&2?3:h&4?2:0);return a}},fix:function(a){if(a[f.expando])return a;var d,e,g=a,h=f.event.fixHooks[a.type]||{},i=h.props?this.props.concat(h.props):this.props;a=f.Event(g);for(d=i.length;d;)e=i[--d],a[e]=g[e];a.target||(a.target=g.srcElement||c),a.target.nodeType===3&&(a.target=a.target.parentNode),a.metaKey===b&&(a.metaKey=a.ctrlKey);return h.filter?h.filter(a,g):a},special:{ready:{setup:f.bindReady},load:{noBubble:!0},focus:{delegateType:"focusin"},blur:{delegateType:"focusout"},beforeunload:{setup:function(a,b,c){f.isWindow(this)&&(this.onbeforeunload=c)},teardown:function(a,b){this.onbeforeunload===b&&(this.onbeforeunload=null)}}},simulate:function(a,b,c,d){var e=f.extend(new f.Event,c,{type:a,isSimulated:!0,originalEvent:{}});d?f.event.trigger(e,null,b):f.event.dispatch.call(b,e),e.isDefaultPrevented()&&c.preventDefault()}},f.event.handle=f.event.dispatch,f.removeEvent=c.removeEventListener?function(a,b,c){a.removeEventListener&&a.removeEventListener(b,c,!1)}:function(a,b,c){a.detachEvent&&a.detachEvent("on"+b,c)},f.Event=function(a,b){if(!(this instanceof f.Event))return new f.Event(a,b);a&&a.type?(this.originalEvent=a,this.type=a.type,this.isDefaultPrevented=a.defaultPrevented||a.returnValue===!1||a.getPreventDefault&&a.getPreventDefault()?K:J):this.type=a,b&&f.extend(this,b),this.timeStamp=a&&a.timeStamp||f.now(),this[f.expando]=!0},f.Event.prototype={preventDefault:function(){this.isDefaultPrevented=K;var a=this.originalEvent;!a||(a.preventDefault?a.preventDefault():a.returnValue=!1)},stopPropagation:function(){this.isPropagationStopped=K;var a=this.originalEvent;!a||(a.stopPropagation&&a.stopPropagation(),a.cancelBubble=!0)},stopImmediatePropagation:function(){this.isImmediatePropagationStopped=K,this.stopPropagation()},isDefaultPrevented:J,isPropagationStopped:J,isImmediatePropagationStopped:J},f.each({mouseenter:"mouseover",mouseleave:"mouseout"},function(a,b){f.event.special[a]={delegateType:b,bindType:b,handle:function(a){var c=this,d=a.relatedTarget,e=a.handleObj,g=e.selector,h;if(!d||d!==c&&!f.contains(c,d))a.type=e.origType,h=e.handler.apply(this,arguments),a.type=b;return h}}}),f.support.submitBubbles||(f.event.special.submit={setup:function(){if(f.nodeName(this,"form"))return!1;f.event.add(this,"click._submit keypress._submit",function(a){var c=a.target,d=f.nodeName(c,"input")||f.nodeName(c,"button")?c.form:b;d&&!d._submit_attached&&(f.event.add(d,"submit._submit",function(a){this.parentNode&&!a.isTrigger&&f.event.simulate("submit",this.parentNode,a,!0)}),d._submit_attached=!0)})},teardown:function(){if(f.nodeName(this,"form"))return!1;f.event.remove(this,"._submit")}}),f.support.changeBubbles||(f.event.special.change={setup:function(){if(z.test(this.nodeName)){if(this.type==="checkbox"||this.type==="radio")f.event.add(this,"propertychange._change",function(a){a.originalEvent.propertyName==="checked"&&(this._just_changed=!0)}),f.event.add(this,"click._change",function(a){this._just_changed&&!a.isTrigger&&(this._just_changed=!1,f.event.simulate("change",this,a,!0))});return!1}f.event.add(this,"beforeactivate._change",function(a){var b=a.target;z.test(b.nodeName)&&!b._change_attached&&(f.event.add(b,"change._change",function(a){this.parentNode&&!a.isSimulated&&!a.isTrigger&&f.event.simulate("change",this.parentNode,a,!0)}),b._change_attached=!0)})},handle:function(a){var b=a.target;if(this!==b||a.isSimulated||a.isTrigger||b.type!=="radio"&&b.type!=="checkbox")return a.handleObj.handler.apply(this,arguments)},teardown:function(){f.event.remove(this,"._change");return z.test(this.nodeName)}}),f.support.focusinBubbles||f.each({focus:"focusin",blur:"focusout"},function(a,b){var d=0,e=function(a){f.event.simulate(b,a.target,f.event.fix(a),!0)};f.event.special[b]={setup:function(){d++===0&&c.addEventListener(a,e,!0)},teardown:function(){--d===0&&c.removeEventListener(a,e,!0)}}}),f.fn.extend({on:function(a,c,d,e,g){var h,i;if(typeof a=="object"){typeof c!="string"&&(d=c,c=b);for(i in a)this.on(i,c,d,a[i],g);return this}d==null&&e==null?(e=c,d=c=b):e==null&&(typeof c=="string"?(e=d,d=b):(e=d,d=c,c=b));if(e===!1)e=J;else if(!e)return this;g===1&&(h=e,e=function(a){f().off(a);return h.apply(this,arguments)},e.guid=h.guid||(h.guid=f.guid++));return this.each(function(){f.event.add(this,a,e,d,c)})},one:function(a,b,c,d){return this.on.call(this,a,b,c,d,1)},off:function(a,c,d){if(a&&a.preventDefault&&a.handleObj){var e=a.handleObj;f(a.delegateTarget).off(e.namespace?e.type+"."+e.namespace:e.type,e.selector,e.handler);return this}if(typeof a=="object"){for(var g in a)this.off(g,c,a[g]);return this}if(c===!1||typeof c=="function")d=c,c=b;d===!1&&(d=J);return this.each(function(){f.event.remove(this,a,d,c)})},bind:function(a,b,c){return this.on(a,null,b,c)},unbind:function(a,b){return this.off(a,null,b)},live:function(a,b,c){f(this.context).on(a,this.selector,b,c);return this},die:function(a,b){f(this.context).off(a,this.selector||"**",b);return this},delegate:function(a,b,c,d){return this.on(b,a,c,d)},undelegate:function(a,b,c){return arguments.length==1?this.off(a,"**"):this.off(b,a,c)},trigger:function(a,b){return this.each(function(){f.event.trigger(a,b,this)})},triggerHandler:function(a,b){if(this[0])return f.event.trigger(a,b,this[0],!0)},toggle:function(a){var b=arguments,c=a.guid||f.guid++,d=0,e=function(c){var e=(f._data(this,"lastToggle"+a.guid)||0)%d;f._data(this,"lastToggle"+a.guid,e+1),c.preventDefault();return b[e].apply(this,arguments)||!1};e.guid=c;while(d<b.length)b[d++].guid=c;return this.click(e)},hover:function(a,b){return this.mouseenter(a).mouseleave(b||a)}}),f.each("blur focus focusin focusout load resize scroll unload click dblclick mousedown mouseup mousemove mouseover mouseout mouseenter mouseleave change select submit keydown keypress keyup error contextmenu".split(" "),function(a,b){f.fn[b]=function(a,c){c==null&&(c=a,a=null);return arguments.length>0?this.on(b,null,a,c):this.trigger(b)},f.attrFn&&(f.attrFn[b]=!0),C.test(b)&&(f.event.fixHooks[b]=f.event.keyHooks),D.test(b)&&(f.event.fixHooks[b]=f.event.mouseHooks)}),function(){function x(a,b,c,e,f,g){for(var h=0,i=e.length;h<i;h++){var j=e[h];if(j){var k=!1;j=j[a];while(j){if(j[d]===c){k=e[j.sizset];break}if(j.nodeType===1){g||(j[d]=c,j.sizset=h);if(typeof b!="string"){if(j===b){k=!0;break}}else if(m.filter(b,[j]).length>0){k=j;break}}j=j[a]}e[h]=k}}}function w(a,b,c,e,f,g){for(var h=0,i=e.length;h<i;h++){var j=e[h];if(j){var k=!1;j=j[a];while(j){if(j[d]===c){k=e[j.sizset];break}j.nodeType===1&&!g&&(j[d]=c,j.sizset=h);if(j.nodeName.toLowerCase()===b){k=j;break}j=j[a]}e[h]=k}}}var a=/((?:\((?:\([^()]+\)|[^()]+)+\)|\[(?:\[[^\[\]]*\]|['"][^'"]*['"]|[^\[\]'"]+)+\]|\\.|[^ >+~,(\[\\]+)+|[>+~])(\s*,\s*)?((?:.|\r|\n)*)/g,d="sizcache"+(Math.random()+"").replace(".",""),e=0,g=Object.prototype.toString,h=!1,i=!0,j=/\\/g,k=/\r\n/g,l=/\W/;[0,0].sort(function(){i=!1;return 0});var m=function(b,d,e,f){e=e||[],d=d||c;var h=d;if(d.nodeType!==1&&d.nodeType!==9)return[];if(!b||typeof b!="string")return e;var i,j,k,l,n,q,r,t,u=!0,v=m.isXML(d),w=[],x=b;do{a.exec(""),i=a.exec(x);if(i){x=i[3],w.push(i[1]);if(i[2]){l=i[3];break}}}while(i);if(w.length>1&&p.exec(b))if(w.length===2&&o.relative[w[0]])j=y(w[0]+w[1],d,f);else{j=o.relative[w[0]]?[d]:m(w.shift(),d);while(w.length)b=w.shift(),o.relative[b]&&(b+=w.shift()),j=y(b,j,f)}else{!f&&w.length>1&&d.nodeType===9&&!v&&o.match.ID.test(w[0])&&!o.match.ID.test(w[w.length-1])&&(n=m.find(w.shift(),d,v),d=n.expr?m.filter(n.expr,n.set)[0]:n.set[0]);if(d){n=f?{expr:w.pop(),set:s(f)}:m.find(w.pop(),w.length===1&&(w[0]==="~"||w[0]==="+")&&d.parentNode?d.parentNode:d,v),j=n.expr?m.filter(n.expr,n.set):n.set,w.length>0?k=s(j):u=!1;while(w.length)q=w.pop(),r=q,o.relative[q]?r=w.pop():q="",r==null&&(r=d),o.relative[q](k,r,v)}else k=w=[]}k||(k=j),k||m.error(q||b);if(g.call(k)==="[object Array]")if(!u)e.push.apply(e,k);else if(d&&d.nodeType===1)for(t=0;k[t]!=null;t++)k[t]&&(k[t]===!0||k[t].nodeType===1&&m.contains(d,k[t]))&&e.push(j[t]);else for(t=0;k[t]!=null;t++)k[t]&&k[t].nodeType===1&&e.push(j[t]);else s(k,e);l&&(m(l,h,e,f),m.uniqueSort(e));return e};m.uniqueSort=function(a){if(u){h=i,a.sort(u);if(h)for(var b=1;b<a.length;b++)a[b]===a[b-1]&&a.splice(b--,1)}return a},m.matches=function(a,b){return m(a,null,null,b)},m.matchesSelector=function(a,b){return m(b,null,null,[a]).length>0},m.find=function(a,b,c){var d,e,f,g,h,i;if(!a)return[];for(e=0,f=o.order.length;e<f;e++){h=o.order[e];if(g=o.leftMatch[h].exec(a)){i=g[1],g.splice(1,1);if(i.substr(i.length-1)!=="\\"){g[1]=(g[1]||"").replace(j,""),d=o.find[h](g,b,c);if(d!=null){a=a.replace(o.match[h],"");break}}}}d||(d=typeof b.getElementsByTagName!="undefined"?b.getElementsByTagName("*"):[]);return{set:d,expr:a}},m.filter=function(a,c,d,e){var f,g,h,i,j,k,l,n,p,q=a,r=[],s=c,t=c&&c[0]&&m.isXML(c[0]);while(a&&c.length){for(h in o.filter)if((f=o.leftMatch[h].exec(a))!=null&&f[2]){k=o.filter[h],l=f[1],g=!1,f.splice(1,1);if(l.substr(l.length-1)==="\\")continue;s===r&&(r=[]);if(o.preFilter[h]){f=o.preFilter[h](f,s,d,r,e,t);if(!f)g=i=!0;else if(f===!0)continue}if(f)for(n=0;(j=s[n])!=null;n++)j&&(i=k(j,f,n,s),p=e^i,d&&i!=null?p?g=!0:s[n]=!1:p&&(r.push(j),g=!0));if(i!==b){d||(s=r),a=a.replace(o.match[h],"");if(!g)return[];break}}if(a===q)if(g==null)m.error(a);else break;q=a}return s},m.error=function(a){throw new Error("Syntax error, unrecognized expression: "+a)};var n=m.getText=function(a){var b,c,d=a.nodeType,e="";if(d){if(d===1||d===9){if(typeof a.textContent=="string")return a.textContent;if(typeof a.innerText=="string")return a.innerText.replace(k,"");for(a=a.firstChild;a;a=a.nextSibling)e+=n(a)}else if(d===3||d===4)return a.nodeValue}else for(b=0;c=a[b];b++)c.nodeType!==8&&(e+=n(c));return e},o=m.selectors={order:["ID","NAME","TAG"],match:{ID:/#((?:[\w\u00c0-\uFFFF\-]|\\.)+)/,CLASS:/\.((?:[\w\u00c0-\uFFFF\-]|\\.)+)/,NAME:/\[name=['"]*((?:[\w\u00c0-\uFFFF\-]|\\.)+)['"]*\]/,ATTR:/\[\s*((?:[\w\u00c0-\uFFFF\-]|\\.)+)\s*(?:(\S?=)\s*(?:(['"])(.*?)\3|(#?(?:[\w\u00c0-\uFFFF\-]|\\.)*)|)|)\s*\]/,TAG:/^((?:[\w\u00c0-\uFFFF\*\-]|\\.)+)/,CHILD:/:(only|nth|last|first)-child(?:\(\s*(even|odd|(?:[+\-]?\d+|(?:[+\-]?\d*)?n\s*(?:[+\-]\s*\d+)?))\s*\))?/,POS:/:(nth|eq|gt|lt|first|last|even|odd)(?:\((\d*)\))?(?=[^\-]|$)/,PSEUDO:/:((?:[\w\u00c0-\uFFFF\-]|\\.)+)(?:\((['"]?)((?:\([^\)]+\)|[^\(\)]*)+)\2\))?/},leftMatch:{},attrMap:{"class":"className","for":"htmlFor"},attrHandle:{href:function(a){return a.getAttribute("href")},type:function(a){return a.getAttribute("type")}},relative:{"+":function(a,b){var c=typeof b=="string",d=c&&!l.test(b),e=c&&!d;d&&(b=b.toLowerCase());for(var f=0,g=a.length,h;f<g;f++)if(h=a[f]){while((h=h.previousSibling)&&h.nodeType!==1);a[f]=e||h&&h.nodeName.toLowerCase()===b?h||!1:h===b}e&&m.filter(b,a,!0)},">":function(a,b){var c,d=typeof b=="string",e=0,f=a.length;if(d&&!l.test(b)){b=b.toLowerCase();for(;e<f;e++){c=a[e];if(c){var g=c.parentNode;a[e]=g.nodeName.toLowerCase()===b?g:!1}}}else{for(;e<f;e++)c=a[e],c&&(a[e]=d?c.parentNode:c.parentNode===b);d&&m.filter(b,a,!0)}},"":function(a,b,c){var d,f=e++,g=x;typeof b=="string"&&!l.test(b)&&(b=b.toLowerCase(),d=b,g=w),g("parentNode",b,f,a,d,c)},"~":function(a,b,c){var d,f=e++,g=x;typeof b=="string"&&!l.test(b)&&(b=b.toLowerCase(),d=b,g=w),g("previousSibling",b,f,a,d,c)}},find:{ID:function(a,b,c){if(typeof b.getElementById!="undefined"&&!c){var d=b.getElementById(a[1]);return d&&d.parentNode?[d]:[]}},NAME:function(a,b){if(typeof b.getElementsByName!="undefined"){var c=[],d=b.getElementsByName(a[1]);for(var e=0,f=d.length;e<f;e++)d[e].getAttribute("name")===a[1]&&c.push(d[e]);return c.length===0?null:c}},TAG:function(a,b){if(typeof b.getElementsByTagName!="undefined")return b.getElementsByTagName(a[1])}},preFilter:{CLASS:function(a,b,c,d,e,f){a=" "+a[1].replace(j,"")+" ";if(f)return a;for(var g=0,h;(h=b[g])!=null;g++)h&&(e^(h.className&&(" "+h.className+" ").replace(/[\t\n\r]/g," ").indexOf(a)>=0)?c||d.push(h):c&&(b[g]=!1));return!1},ID:function(a){return a[1].replace(j,"")},TAG:function(a,b){return a[1].replace(j,"").toLowerCase()},CHILD:function(a){if(a[1]==="nth"){a[2]||m.error(a[0]),a[2]=a[2].replace(/^\+|\s*/g,"");var b=/(-?)(\d*)(?:n([+\-]?\d*))?/.exec(a[2]==="even"&&"2n"||a[2]==="odd"&&"2n+1"||!/\D/.test(a[2])&&"0n+"+a[2]||a[2]);a[2]=b[1]+(b[2]||1)-0,a[3]=b[3]-0}else a[2]&&m.error(a[0]);a[0]=e++;return a},ATTR:function(a,b,c,d,e,f){var g=a[1]=a[1].replace(j,"");!f&&o.attrMap[g]&&(a[1]=o.attrMap[g]),a[4]=(a[4]||a[5]||"").replace(j,""),a[2]==="~="&&(a[4]=" "+a[4]+" ");return a},PSEUDO:function(b,c,d,e,f){if(b[1]==="not")if((a.exec(b[3])||"").length>1||/^\w/.test(b[3]))b[3]=m(b[3],null,null,c);else{var g=m.filter(b[3],c,d,!0^f);d||e.push.apply(e,g);return!1}else if(o.match.POS.test(b[0])||o.match.CHILD.test(b[0]))return!0;return b},POS:function(a){a.unshift(!0);return a}},filters:{enabled:function(a){return a.disabled===!1&&a.type!=="hidden"},disabled:function(a){return a.disabled===!0},checked:function(a){return a.checked===!0},selected:function(a){a.parentNode&&a.parentNode.selectedIndex;return a.selected===!0},parent:function(a){return!!a.firstChild},empty:function(a){return!a.firstChild},has:function(a,b,c){return!!m(c[3],a).length},header:function(a){return/h\d/i.test(a.nodeName)},text:function(a){var b=a.getAttribute("type"),c=a.type;return a.nodeName.toLowerCase()==="input"&&"text"===c&&(b===c||b===null)},radio:function(a){return a.nodeName.toLowerCase()==="input"&&"radio"===a.type},checkbox:function(a){return a.nodeName.toLowerCase()==="input"&&"checkbox"===a.type},file:function(a){return a.nodeName.toLowerCase()==="input"&&"file"===a.type},password:function(a){return a.nodeName.toLowerCase()==="input"&&"password"===a.type},submit:function(a){var b=a.nodeName.toLowerCase();return(b==="input"||b==="button")&&"submit"===a.type},image:function(a){return a.nodeName.toLowerCase()==="input"&&"image"===a.type},reset:function(a){var b=a.nodeName.toLowerCase();return(b==="input"||b==="button")&&"reset"===a.type},button:function(a){var b=a.nodeName.toLowerCase();return b==="input"&&"button"===a.type||b==="button"},input:function(a){return/input|select|textarea|button/i.test(a.nodeName)},focus:function(a){return a===a.ownerDocument.activeElement}},setFilters:{first:function(a,b){return b===0},last:function(a,b,c,d){return b===d.length-1},even:function(a,b){return b%2===0},odd:function(a,b){return b%2===1},lt:function(a,b,c){return b<c[3]-0},gt:function(a,b,c){return b>c[3]-0},nth:function(a,b,c){return c[3]-0===b},eq:function(a,b,c){return c[3]-0===b}},filter:{PSEUDO:function(a,b,c,d){var e=b[1],f=o.filters[e];if(f)return f(a,c,b,d);if(e==="contains")return(a.textContent||a.innerText||n([a])||"").indexOf(b[3])>=0;if(e==="not"){var g=b[3];for(var h=0,i=g.length;h<i;h++)if(g[h]===a)return!1;return!0}m.error(e)},CHILD:function(a,b){var c,e,f,g,h,i,j,k=b[1],l=a;switch(k){case"only":case"first":while(l=l.previousSibling)if(l.nodeType===1)return!1;if(k==="first")return!0;l=a;case"last":while(l=l.nextSibling)if(l.nodeType===1)return!1;return!0;case"nth":c=b[2],e=b[3];if(c===1&&e===0)return!0;f=b[0],g=a.parentNode;if(g&&(g[d]!==f||!a.nodeIndex)){i=0;for(l=g.firstChild;l;l=l.nextSibling)l.nodeType===1&&(l.nodeIndex=++i);g[d]=f}j=a.nodeIndex-e;return c===0?j===0:j%c===0&&j/c>=0}},ID:function(a,b){return a.nodeType===1&&a.getAttribute("id")===b},TAG:function(a,b){return b==="*"&&a.nodeType===1||!!a.nodeName&&a.nodeName.toLowerCase()===b},CLASS:function(a,b){return(" "+(a.className||a.getAttribute("class"))+" ").indexOf(b)>-1},ATTR:function(a,b){var c=b[1],d=m.attr?m.attr(a,c):o.attrHandle[c]?o.attrHandle[c](a):a[c]!=null?a[c]:a.getAttribute(c),e=d+"",f=b[2],g=b[4];return d==null?f==="!=":!f&&m.attr?d!=null:f==="="?e===g:f==="*="?e.indexOf(g)>=0:f==="~="?(" "+e+" ").indexOf(g)>=0:g?f==="!="?e!==g:f==="^="?e.indexOf(g)===0:f==="$="?e.substr(e.length-g.length)===g:f==="|="?e===g||e.substr(0,g.length+1)===g+"-":!1:e&&d!==!1},POS:function(a,b,c,d){var e=b[2],f=o.setFilters[e];if(f)return f(a,c,b,d)}}},p=o.match.POS,q=function(a,b){return"\\"+(b-0+1)};for(var r in o.match)o.match[r]=new RegExp(o.match[r].source+/(?![^\[]*\])(?![^\(]*\))/.source),o.leftMatch[r]=new RegExp(/(^(?:.|\r|\n)*?)/.source+o.match[r].source.replace(/\\(\d+)/g,q));var s=function(a,b){a=Array.prototype.slice.call(a,0);if(b){b.push.apply(b,a);return b}return a};try{Array.prototype.slice.call(c.documentElement.childNodes,0)[0].nodeType}catch(t){s=function(a,b){var c=0,d=b||[];if(g.call(a)==="[object Array]")Array.prototype.push.apply(d,a);else if(typeof a.length=="number")for(var e=a.length;c<e;c++)d.push(a[c]);else for(;a[c];c++)d.push(a[c]);return d}}var u,v;c.documentElement.compareDocumentPosition?u=function(a,b){if(a===b){h=!0;return 0}if(!a.compareDocumentPosition||!b.compareDocumentPosition)return a.compareDocumentPosition?-1:1;return a.compareDocumentPosition(b)&4?-1:1}:(u=function(a,b){if(a===b){h=!0;return 0}if(a.sourceIndex&&b.sourceIndex)return a.sourceIndex-b.sourceIndex;var c,d,e=[],f=[],g=a.parentNode,i=b.parentNode,j=g;if(g===i)return v(a,b);if(!g)return-1;if(!i)return 1;while(j)e.unshift(j),j=j.parentNode;j=i;while(j)f.unshift(j),j=j.parentNode;c=e.length,d=f.length;for(var k=0;k<c&&k<d;k++)if(e[k]!==f[k])return v(e[k],f[k]);return k===c?v(a,f[k],-1):v(e[k],b,1)},v=function(a,b,c){if(a===b)return c;var d=a.nextSibling;while(d){if(d===b)return-1;d=d.nextSibling}return 1}),function(){var a=c.createElement("div"),d="script"+(new Date).getTime(),e=c.documentElement;a.innerHTML="<a name='"+d+"'/>",e.insertBefore(a,e.firstChild),c.getElementById(d)&&(o.find.ID=function(a,c,d){if(typeof c.getElementById!="undefined"&&!d){var e=c.getElementById(a[1]);return e?e.id===a[1]||typeof e.getAttributeNode!="undefined"&&e.getAttributeNode("id").nodeValue===a[1]?[e]:b:[]}},o.filter.ID=function(a,b){var c=typeof a.getAttributeNode!="undefined"&&a.getAttributeNode("id");return a.nodeType===1&&c&&c.nodeValue===b}),e.removeChild(a),e=a=null}(),function(){var a=c.createElement("div");a.appendChild(c.createComment("")),a.getElementsByTagName("*").length>0&&(o.find.TAG=function(a,b){var c=b.getElementsByTagName(a[1]);if(a[1]==="*"){var d=[];for(var e=0;c[e];e++)c[e].nodeType===1&&d.push(c[e]);c=d}return c}),a.innerHTML="<a href='#'></a>",a.firstChild&&typeof a.firstChild.getAttribute!="undefined"&&a.firstChild.getAttribute("href")!=="#"&&(o.attrHandle.href=function(a){return a.getAttribute("href",2)}),a=null}(),c.querySelectorAll&&function(){var a=m,b=c.createElement("div"),d="__sizzle__";b.innerHTML="<p class='TEST'></p>";if(!b.querySelectorAll||b.querySelectorAll(".TEST").length!==0){m=function(b,e,f,g){e=e||c;if(!g&&!m.isXML(e)){var h=/^(\w+$)|^\.([\w\-]+$)|^#([\w\-]+$)/.exec(b);if(h&&(e.nodeType===1||e.nodeType===9)){if(h[1])return s(e.getElementsByTagName(b),f);if(h[2]&&o.find.CLASS&&e.getElementsByClassName)return s(e.getElementsByClassName(h[2]),f)}if(e.nodeType===9){if(b==="body"&&e.body)return s([e.body],f);if(h&&h[3]){var i=e.getElementById(h[3]);if(!i||!i.parentNode)return s([],f);if(i.id===h[3])return s([i],f)}try{return s(e.querySelectorAll(b),f)}catch(j){}}else if(e.nodeType===1&&e.nodeName.toLowerCase()!=="object"){var k=e,l=e.getAttribute("id"),n=l||d,p=e.parentNode,q=/^\s*[+~]/.test(b);l?n=n.replace(/'/g,"\\$&"):e.setAttribute("id",n),q&&p&&(e=e.parentNode);try{if(!q||p)return s(e.querySelectorAll("[id='"+n+"'] "+b),f)}catch(r){}finally{l||k.removeAttribute("id")}}}return a(b,e,f,g)};for(var e in a)m[e]=a[e];b=null}}(),function(){var a=c.documentElement,b=a.matchesSelector||a.mozMatchesSelector||a.webkitMatchesSelector||a.msMatchesSelector;if(b){var d=!b.call(c.createElement("div"),"div"),e=!1;try{b.call(c.documentElement,"[test!='']:sizzle")}catch(f){e=!0}m.matchesSelector=function(a,c){c=c.replace(/\=\s*([^'"\]]*)\s*\]/g,"='$1']");if(!m.isXML(a))try{if(e||!o.match.PSEUDO.test(c)&&!/!=/.test(c)){var f=b.call(a,c);if(f||!d||a.document&&a.document.nodeType!==11)return f}}catch(g){}return m(c,null,null,[a]).length>0}}}(),function(){var a=c.createElement("div");a.innerHTML="<div class='test e'></div><div class='test'></div>";if(!!a.getElementsByClassName&&a.getElementsByClassName("e").length!==0){a.lastChild.className="e";if(a.getElementsByClassName("e").length===1)return;o.order.splice(1,0,"CLASS"),o.find.CLASS=function(a,b,c){if(typeof b.getElementsByClassName!="undefined"&&!c)return b.getElementsByClassName(a[1])},a=null}}(),c.documentElement.contains?m.contains=function(a,b){return a!==b&&(a.contains?a.contains(b):!0)}:c.documentElement.compareDocumentPosition?m.contains=function(a,b){return!!(a.compareDocumentPosition(b)&16)}:m.contains=function(){return!1},m.isXML=function(a){var b=(a?a.ownerDocument||a:0).documentElement;return b?b.nodeName!=="HTML":!1};var y=function(a,b,c){var d,e=[],f="",g=b.nodeType?[b]:b;while(d=o.match.PSEUDO.exec(a))f+=d[0],a=a.replace(o.match.PSEUDO,"");a=o.relative[a]?a+"*":a;for(var h=0,i=g.length;h<i;h++)m(a,g[h],e,c);return m.filter(f,e)};m.attr=f.attr,m.selectors.attrMap={},f.find=m,f.expr=m.selectors,f.expr[":"]=f.expr.filters,f.unique=m.uniqueSort,f.text=m.getText,f.isXMLDoc=m.isXML,f.contains=m.contains}();var L=/Until$/,M=/^(?:parents|prevUntil|prevAll)/,N=/,/,O=/^.[^:#\[\.,]*$/,P=Array.prototype.slice,Q=f.expr.match.POS,R={children:!0,contents:!0,next:!0,prev:!0};f.fn.extend({find:function(a){var b=this,c,d;if(typeof a!="string")return f(a).filter(function(){for(c=0,d=b.length;c<d;c++)if(f.contains(b[c],this))return!0});var e=this.pushStack("","find",a),g,h,i;for(c=0,d=this.length;c<d;c++){g=e.length,f.find(a,this[c],e);if(c>0)for(h=g;h<e.length;h++)for(i=0;i<g;i++)if(e[i]===e[h]){e.splice(h--,1);break}}return e},has:function(a){var b=f(a);return this.filter(function(){for(var a=0,c=b.length;a<c;a++)if(f.contains(this,b[a]))return!0})},not:function(a){return this.pushStack(T(this,a,!1),"not",a)},filter:function(a){return this.pushStack(T(this,a,!0),"filter",a)},is:function(a){return!!a&&(typeof a=="string"?Q.test(a)?f(a,this.context).index(this[0])>=0:f.filter(a,this).length>0:this.filter(a).length>0)},closest:function(a,b){var c=[],d,e,g=this[0];if(f.isArray(a)){var h=1;while(g&&g.ownerDocument&&g!==b){for(d=0;d<a.length;d++)f(g).is(a[d])&&c.push({selector:a[d],elem:g,level:h});g=g.parentNode,h++}return c}var i=Q.test(a)||typeof a!="string"?f(a,b||this.context):0;for(d=0,e=this.length;d<e;d++){g=this[d];while(g){if(i?i.index(g)>-1:f.find.matchesSelector(g,a)){c.push(g);break}g=g.parentNode;if(!g||!g.ownerDocument||g===b||g.nodeType===11)break}}c=c.length>1?f.unique(c):c;return this.pushStack(c,"closest",a)},index:function(a){if(!a)return this[0]&&this[0].parentNode?this.prevAll().length:-1;if(typeof a=="string")return f.inArray(this[0],f(a));return f.inArray(a.jquery?a[0]:a,this)},add:function(a,b){var c=typeof a=="string"?f(a,b):f.makeArray(a&&a.nodeType?[a]:a),d=f.merge(this.get(),c);return this.pushStack(S(c[0])||S(d[0])?d:f.unique(d))},andSelf:function(){return this.add(this.prevObject)}}),f.each({parent:function(a){var b=a.parentNode;return b&&b.nodeType!==11?b:null},parents:function(a){return f.dir(a,"parentNode")},parentsUntil:function(a,b,c){return f.dir(a,"parentNode",c)},next:function(a){return f.nth(a,2,"nextSibling")},prev:function(a){return f.nth(a,2,"previousSibling")},nextAll:function(a){return f.dir(a,"nextSibling")},prevAll:function(a){return f.dir(a,"previousSibling")},nextUntil:function(a,b,c){return f.dir(a,"nextSibling",c)},prevUntil:function(a,b,c){return f.dir(a,"previousSibling",c)},siblings:function(a){return f.sibling(a.parentNode.firstChild,a)},children:function(a){return f.sibling(a.firstChild)},contents:function(a){return f.nodeName(a,"iframe")?a.contentDocument||a.contentWindow.document:f.makeArray(a.childNodes)}},function(a,b){f.fn[a]=function(c,d){var e=f.map(this,b,c);L.test(a)||(d=c),d&&typeof d=="string"&&(e=f.filter(d,e)),e=this.length>1&&!R[a]?f.unique(e):e,(this.length>1||N.test(d))&&M.test(a)&&(e=e.reverse());return this.pushStack(e,a,P.call(arguments).join(","))}}),f.extend({filter:function(a,b,c){c&&(a=":not("+a+")");return b.length===1?f.find.matchesSelector(b[0],a)?[b[0]]:[]:f.find.matches(a,b)},dir:function(a,c,d){var e=[],g=a[c];while(g&&g.nodeType!==9&&(d===b||g.nodeType!==1||!f(g).is(d)))g.nodeType===1&&e.push(g),g=g[c];return e},nth:function(a,b,c,d){b=b||1;var e=0;for(;a;a=a[c])if(a.nodeType===1&&++e===b)break;return a},sibling:function(a,b){var c=[];for(;a;a=a.nextSibling)a.nodeType===1&&a!==b&&c.push(a);return c}});var V="abbr|article|aside|audio|canvas|datalist|details|figcaption|figure|footer|header|hgroup|mark|meter|nav|output|progress|section|summary|time|video",W=/ jQuery\d+="(?:\d+|null)"/g,X=/^\s+/,Y=/<(?!area|br|col|embed|hr|img|input|link|meta|param)(([\w:]+)[^>]*)\/>/ig,Z=/<([\w:]+)/,$=/<tbody/i,_=/<|&#?\w+;/,ba=/<(?:script|style)/i,bb=/<(?:script|object|embed|option|style)/i,bc=new RegExp("<(?:"+V+")","i"),bd=/checked\s*(?:[^=]|=\s*.checked.)/i,be=/\/(java|ecma)script/i,bf=/^\s*<!(?:\[CDATA\[|\-\-)/,bg={option:[1,"<select multiple='multiple'>","</select>"],legend:[1,"<fieldset>","</fieldset>"],thead:[1,"<table>","</table>"],tr:[2,"<table><tbody>","</tbody></table>"],td:[3,"<table><tbody><tr>","</tr></tbody></table>"],col:[2,"<table><tbody></tbody><colgroup>","</colgroup></table>"],area:[1,"<map>","</map>"],_default:[0,"",""]},bh=U(c);bg.optgroup=bg.option,bg.tbody=bg.tfoot=bg.colgroup=bg.caption=bg.thead,bg.th=bg.td,f.support.htmlSerialize||(bg._default=[1,"div<div>","</div>"]),f.fn.extend({text:function(a){if(f.isFunction(a))return this.each(function(b){var c=f(this);c.text(a.call(this,b,c.text()))});if(typeof a!="object"&&a!==b)return this.empty().append((this[0]&&this[0].ownerDocument||c).createTextNode(a));return f.text(this)},wrapAll:function(a){if(f.isFunction(a))return this.each(function(b){f(this).wrapAll(a.call(this,b))});if(this[0]){var b=f(a,this[0].ownerDocument).eq(0).clone(!0);this[0].parentNode&&b.insertBefore(this[0]),b.map(function(){var a=this;while(a.firstChild&&a.firstChild.nodeType===1)a=a.firstChild;return a}).append(this)}return this},wrapInner:function(a){if(f.isFunction(a))return this.each(function(b){f(this).wrapInner(a.call(this,b))});return this.each(function(){var b=f(this),c=b.contents();c.length?c.wrapAll(a):b.append(a)})},wrap:function(a){var b=f.isFunction(a);return this.each(function(c){f(this).wrapAll(b?a.call(this,c):a)})},unwrap:function(){return this.parent().each(function(){f.nodeName(this,"body")||f(this).replaceWith(this.childNodes)}).end()},append:function(){return this.domManip(arguments,!0,function(a){this.nodeType===1&&this.appendChild(a)})},prepend:function(){return this.domManip(arguments,!0,function(a){this.nodeType===1&&this.insertBefore(a,this.firstChild)})},before:function(){if(this[0]&&this[0].parentNode)return this.domManip(arguments,!1,function(a){this.parentNode.insertBefore(a,this)});if(arguments.length){var a=f.clean(arguments);a.push.apply(a,this.toArray());return this.pushStack(a,"before",arguments)}},after:function(){if(this[0]&&this[0].parentNode)return this.domManip(arguments,!1,function(a){this.parentNode.insertBefore(a,this.nextSibling)});if(arguments.length){var a=this.pushStack(this,"after",arguments);a.push.apply(a,f.clean(arguments));return a}},remove:function(a,b){for(var c=0,d;(d=this[c])!=null;c++)if(!a||f.filter(a,[d]).length)!b&&d.nodeType===1&&(f.cleanData(d.getElementsByTagName("*")),f.cleanData([d])),d.parentNode&&d.parentNode.removeChild(d);return this},empty:function()
{for(var a=0,b;(b=this[a])!=null;a++){b.nodeType===1&&f.cleanData(b.getElementsByTagName("*"));while(b.firstChild)b.removeChild(b.firstChild)}return this},clone:function(a,b){a=a==null?!1:a,b=b==null?a:b;return this.map(function(){return f.clone(this,a,b)})},html:function(a){if(a===b)return this[0]&&this[0].nodeType===1?this[0].innerHTML.replace(W,""):null;if(typeof a=="string"&&!ba.test(a)&&(f.support.leadingWhitespace||!X.test(a))&&!bg[(Z.exec(a)||["",""])[1].toLowerCase()]){a=a.replace(Y,"<$1></$2>");try{for(var c=0,d=this.length;c<d;c++)this[c].nodeType===1&&(f.cleanData(this[c].getElementsByTagName("*")),this[c].innerHTML=a)}catch(e){this.empty().append(a)}}else f.isFunction(a)?this.each(function(b){var c=f(this);c.html(a.call(this,b,c.html()))}):this.empty().append(a);return this},replaceWith:function(a){if(this[0]&&this[0].parentNode){if(f.isFunction(a))return this.each(function(b){var c=f(this),d=c.html();c.replaceWith(a.call(this,b,d))});typeof a!="string"&&(a=f(a).detach());return this.each(function(){var b=this.nextSibling,c=this.parentNode;f(this).remove(),b?f(b).before(a):f(c).append(a)})}return this.length?this.pushStack(f(f.isFunction(a)?a():a),"replaceWith",a):this},detach:function(a){return this.remove(a,!0)},domManip:function(a,c,d){var e,g,h,i,j=a[0],k=[];if(!f.support.checkClone&&arguments.length===3&&typeof j=="string"&&bd.test(j))return this.each(function(){f(this).domManip(a,c,d,!0)});if(f.isFunction(j))return this.each(function(e){var g=f(this);a[0]=j.call(this,e,c?g.html():b),g.domManip(a,c,d)});if(this[0]){i=j&&j.parentNode,f.support.parentNode&&i&&i.nodeType===11&&i.childNodes.length===this.length?e={fragment:i}:e=f.buildFragment(a,this,k),h=e.fragment,h.childNodes.length===1?g=h=h.firstChild:g=h.firstChild;if(g){c=c&&f.nodeName(g,"tr");for(var l=0,m=this.length,n=m-1;l<m;l++)d.call(c?bi(this[l],g):this[l],e.cacheable||m>1&&l<n?f.clone(h,!0,!0):h)}k.length&&f.each(k,bp)}return this}}),f.buildFragment=function(a,b,d){var e,g,h,i,j=a[0];b&&b[0]&&(i=b[0].ownerDocument||b[0]),i.createDocumentFragment||(i=c),a.length===1&&typeof j=="string"&&j.length<512&&i===c&&j.charAt(0)==="<"&&!bb.test(j)&&(f.support.checkClone||!bd.test(j))&&(f.support.html5Clone||!bc.test(j))&&(g=!0,h=f.fragments[j],h&&h!==1&&(e=h)),e||(e=i.createDocumentFragment(),f.clean(a,i,e,d)),g&&(f.fragments[j]=h?e:1);return{fragment:e,cacheable:g}},f.fragments={},f.each({appendTo:"append",prependTo:"prepend",insertBefore:"before",insertAfter:"after",replaceAll:"replaceWith"},function(a,b){f.fn[a]=function(c){var d=[],e=f(c),g=this.length===1&&this[0].parentNode;if(g&&g.nodeType===11&&g.childNodes.length===1&&e.length===1){e[b](this[0]);return this}for(var h=0,i=e.length;h<i;h++){var j=(h>0?this.clone(!0):this).get();f(e[h])[b](j),d=d.concat(j)}return this.pushStack(d,a,e.selector)}}),f.extend({clone:function(a,b,c){var d,e,g,h=f.support.html5Clone||!bc.test("<"+a.nodeName)?a.cloneNode(!0):bo(a);if((!f.support.noCloneEvent||!f.support.noCloneChecked)&&(a.nodeType===1||a.nodeType===11)&&!f.isXMLDoc(a)){bk(a,h),d=bl(a),e=bl(h);for(g=0;d[g];++g)e[g]&&bk(d[g],e[g])}if(b){bj(a,h);if(c){d=bl(a),e=bl(h);for(g=0;d[g];++g)bj(d[g],e[g])}}d=e=null;return h},clean:function(a,b,d,e){var g;b=b||c,typeof b.createElement=="undefined"&&(b=b.ownerDocument||b[0]&&b[0].ownerDocument||c);var h=[],i;for(var j=0,k;(k=a[j])!=null;j++){typeof k=="number"&&(k+="");if(!k)continue;if(typeof k=="string")if(!_.test(k))k=b.createTextNode(k);else{k=k.replace(Y,"<$1></$2>");var l=(Z.exec(k)||["",""])[1].toLowerCase(),m=bg[l]||bg._default,n=m[0],o=b.createElement("div");b===c?bh.appendChild(o):U(b).appendChild(o),o.innerHTML=m[1]+k+m[2];while(n--)o=o.lastChild;if(!f.support.tbody){var p=$.test(k),q=l==="table"&&!p?o.firstChild&&o.firstChild.childNodes:m[1]==="<table>"&&!p?o.childNodes:[];for(i=q.length-1;i>=0;--i)f.nodeName(q[i],"tbody")&&!q[i].childNodes.length&&q[i].parentNode.removeChild(q[i])}!f.support.leadingWhitespace&&X.test(k)&&o.insertBefore(b.createTextNode(X.exec(k)[0]),o.firstChild),k=o.childNodes}var r;if(!f.support.appendChecked)if(k[0]&&typeof (r=k.length)=="number")for(i=0;i<r;i++)bn(k[i]);else bn(k);k.nodeType?h.push(k):h=f.merge(h,k)}if(d){g=function(a){return!a.type||be.test(a.type)};for(j=0;h[j];j++)if(e&&f.nodeName(h[j],"script")&&(!h[j].type||h[j].type.toLowerCase()==="text/javascript"))e.push(h[j].parentNode?h[j].parentNode.removeChild(h[j]):h[j]);else{if(h[j].nodeType===1){var s=f.grep(h[j].getElementsByTagName("script"),g);h.splice.apply(h,[j+1,0].concat(s))}d.appendChild(h[j])}}return h},cleanData:function(a){var b,c,d=f.cache,e=f.event.special,g=f.support.deleteExpando;for(var h=0,i;(i=a[h])!=null;h++){if(i.nodeName&&f.noData[i.nodeName.toLowerCase()])continue;c=i[f.expando];if(c){b=d[c];if(b&&b.events){for(var j in b.events)e[j]?f.event.remove(i,j):f.removeEvent(i,j,b.handle);b.handle&&(b.handle.elem=null)}g?delete i[f.expando]:i.removeAttribute&&i.removeAttribute(f.expando),delete d[c]}}}});var bq=/alpha\([^)]*\)/i,br=/opacity=([^)]*)/,bs=/([A-Z]|^ms)/g,bt=/^-?\d+(?:px)?$/i,bu=/^-?\d/,bv=/^([\-+])=([\-+.\de]+)/,bw={position:"absolute",visibility:"hidden",display:"block"},bx=["Left","Right"],by=["Top","Bottom"],bz,bA,bB;f.fn.css=function(a,c){if(arguments.length===2&&c===b)return this;return f.access(this,a,c,!0,function(a,c,d){return d!==b?f.style(a,c,d):f.css(a,c)})},f.extend({cssHooks:{opacity:{get:function(a,b){if(b){var c=bz(a,"opacity","opacity");return c===""?"1":c}return a.style.opacity}}},cssNumber:{fillOpacity:!0,fontWeight:!0,lineHeight:!0,opacity:!0,orphans:!0,widows:!0,zIndex:!0,zoom:!0},cssProps:{"float":f.support.cssFloat?"cssFloat":"styleFloat"},style:function(a,c,d,e){if(!!a&&a.nodeType!==3&&a.nodeType!==8&&!!a.style){var g,h,i=f.camelCase(c),j=a.style,k=f.cssHooks[i];c=f.cssProps[i]||i;if(d===b){if(k&&"get"in k&&(g=k.get(a,!1,e))!==b)return g;return j[c]}h=typeof d,h==="string"&&(g=bv.exec(d))&&(d=+(g[1]+1)*+g[2]+parseFloat(f.css(a,c)),h="number");if(d==null||h==="number"&&isNaN(d))return;h==="number"&&!f.cssNumber[i]&&(d+="px");if(!k||!("set"in k)||(d=k.set(a,d))!==b)try{j[c]=d}catch(l){}}},css:function(a,c,d){var e,g;c=f.camelCase(c),g=f.cssHooks[c],c=f.cssProps[c]||c,c==="cssFloat"&&(c="float");if(g&&"get"in g&&(e=g.get(a,!0,d))!==b)return e;if(bz)return bz(a,c)},swap:function(a,b,c){var d={};for(var e in b)d[e]=a.style[e],a.style[e]=b[e];c.call(a);for(e in b)a.style[e]=d[e]}}),f.curCSS=f.css,f.each(["height","width"],function(a,b){f.cssHooks[b]={get:function(a,c,d){var e;if(c){if(a.offsetWidth!==0)return bC(a,b,d);f.swap(a,bw,function(){e=bC(a,b,d)});return e}},set:function(a,b){if(!bt.test(b))return b;b=parseFloat(b);if(b>=0)return b+"px"}}}),f.support.opacity||(f.cssHooks.opacity={get:function(a,b){return br.test((b&&a.currentStyle?a.currentStyle.filter:a.style.filter)||"")?parseFloat(RegExp.$1)/100+"":b?"1":""},set:function(a,b){var c=a.style,d=a.currentStyle,e=f.isNumeric(b)?"alpha(opacity="+b*100+")":"",g=d&&d.filter||c.filter||"";c.zoom=1;if(b>=1&&f.trim(g.replace(bq,""))===""){c.removeAttribute("filter");if(d&&!d.filter)return}c.filter=bq.test(g)?g.replace(bq,e):g+" "+e}}),f(function(){f.support.reliableMarginRight||(f.cssHooks.marginRight={get:function(a,b){var c;f.swap(a,{display:"inline-block"},function(){b?c=bz(a,"margin-right","marginRight"):c=a.style.marginRight});return c}})}),c.defaultView&&c.defaultView.getComputedStyle&&(bA=function(a,b){var c,d,e;b=b.replace(bs,"-$1").toLowerCase(),(d=a.ownerDocument.defaultView)&&(e=d.getComputedStyle(a,null))&&(c=e.getPropertyValue(b),c===""&&!f.contains(a.ownerDocument.documentElement,a)&&(c=f.style(a,b)));return c}),c.documentElement.currentStyle&&(bB=function(a,b){var c,d,e,f=a.currentStyle&&a.currentStyle[b],g=a.style;f===null&&g&&(e=g[b])&&(f=e),!bt.test(f)&&bu.test(f)&&(c=g.left,d=a.runtimeStyle&&a.runtimeStyle.left,d&&(a.runtimeStyle.left=a.currentStyle.left),g.left=b==="fontSize"?"1em":f||0,f=g.pixelLeft+"px",g.left=c,d&&(a.runtimeStyle.left=d));return f===""?"auto":f}),bz=bA||bB,f.expr&&f.expr.filters&&(f.expr.filters.hidden=function(a){var b=a.offsetWidth,c=a.offsetHeight;return b===0&&c===0||!f.support.reliableHiddenOffsets&&(a.style&&a.style.display||f.css(a,"display"))==="none"},f.expr.filters.visible=function(a){return!f.expr.filters.hidden(a)});var bD=/%20/g,bE=/\[\]$/,bF=/\r?\n/g,bG=/#.*$/,bH=/^(.*?):[ \t]*([^\r\n]*)\r?$/mg,bI=/^(?:color|date|datetime|datetime-local|email|hidden|month|number|password|range|search|tel|text|time|url|week)$/i,bJ=/^(?:about|app|app\-storage|.+\-extension|file|res|widget):$/,bK=/^(?:GET|HEAD)$/,bL=/^\/\//,bM=/\?/,bN=/<script\b[^<]*(?:(?!<\/script>)<[^<]*)*<\/script>/gi,bO=/^(?:select|textarea)/i,bP=/\s+/,bQ=/([?&])_=[^&]*/,bR=/^([\w\+\.\-]+:)(?:\/\/([^\/?#:]*)(?::(\d+))?)?/,bS=f.fn.load,bT={},bU={},bV,bW,bX=["*/"]+["*"];try{bV=e.href}catch(bY){bV=c.createElement("a"),bV.href="",bV=bV.href}bW=bR.exec(bV.toLowerCase())||[],f.fn.extend({load:function(a,c,d){if(typeof a!="string"&&bS)return bS.apply(this,arguments);if(!this.length)return this;var e=a.indexOf(" ");if(e>=0){var g=a.slice(e,a.length);a=a.slice(0,e)}var h="GET";c&&(f.isFunction(c)?(d=c,c=b):typeof c=="object"&&(c=f.param(c,f.ajaxSettings.traditional),h="POST"));var i=this;f.ajax({url:a,type:h,dataType:"html",data:c,complete:function(a,b,c){c=a.responseText,a.isResolved()&&(a.done(function(a){c=a}),i.html(g?f("<div>").append(c.replace(bN,"")).find(g):c)),d&&i.each(d,[c,b,a])}});return this},serialize:function(){return f.param(this.serializeArray())},serializeArray:function(){return this.map(function(){return this.elements?f.makeArray(this.elements):this}).filter(function(){return this.name&&!this.disabled&&(this.checked||bO.test(this.nodeName)||bI.test(this.type))}).map(function(a,b){var c=f(this).val();return c==null?null:f.isArray(c)?f.map(c,function(a,c){return{name:b.name,value:a.replace(bF,"\r\n")}}):{name:b.name,value:c.replace(bF,"\r\n")}}).get()}}),f.each("ajaxStart ajaxStop ajaxComplete ajaxError ajaxSuccess ajaxSend".split(" "),function(a,b){f.fn[b]=function(a){return this.on(b,a)}}),f.each(["get","post"],function(a,c){f[c]=function(a,d,e,g){f.isFunction(d)&&(g=g||e,e=d,d=b);return f.ajax({type:c,url:a,data:d,success:e,dataType:g})}}),f.extend({getScript:function(a,c){return f.get(a,b,c,"script")},getJSON:function(a,b,c){return f.get(a,b,c,"json")},ajaxSetup:function(a,b){b?b_(a,f.ajaxSettings):(b=a,a=f.ajaxSettings),b_(a,b);return a},ajaxSettings:{url:bV,isLocal:bJ.test(bW[1]),global:!0,type:"GET",contentType:"application/x-www-form-urlencoded",processData:!0,async:!0,accepts:{xml:"application/xml, text/xml",html:"text/html",text:"text/plain",json:"application/json, text/javascript","*":bX},contents:{xml:/xml/,html:/html/,json:/json/},responseFields:{xml:"responseXML",text:"responseText"},converters:{"* text":a.String,"text html":!0,"text json":f.parseJSON,"text xml":f.parseXML},flatOptions:{context:!0,url:!0}},ajaxPrefilter:bZ(bT),ajaxTransport:bZ(bU),ajax:function(a,c){function w(a,c,l,m){if(s!==2){s=2,q&&clearTimeout(q),p=b,n=m||"",v.readyState=a>0?4:0;var o,r,u,w=c,x=l?cb(d,v,l):b,y,z;if(a>=200&&a<300||a===304){if(d.ifModified){if(y=v.getResponseHeader("Last-Modified"))f.lastModified[k]=y;if(z=v.getResponseHeader("Etag"))f.etag[k]=z}if(a===304)w="notmodified",o=!0;else try{r=cc(d,x),w="success",o=!0}catch(A){w="parsererror",u=A}}else{u=w;if(!w||a)w="error",a<0&&(a=0)}v.status=a,v.statusText=""+(c||w),o?h.resolveWith(e,[r,w,v]):h.rejectWith(e,[v,w,u]),v.statusCode(j),j=b,t&&g.trigger("ajax"+(o?"Success":"Error"),[v,d,o?r:u]),i.fireWith(e,[v,w]),t&&(g.trigger("ajaxComplete",[v,d]),--f.active||f.event.trigger("ajaxStop"))}}typeof a=="object"&&(c=a,a=b),c=c||{};var d=f.ajaxSetup({},c),e=d.context||d,g=e!==d&&(e.nodeType||e instanceof f)?f(e):f.event,h=f.Deferred(),i=f.Callbacks("once memory"),j=d.statusCode||{},k,l={},m={},n,o,p,q,r,s=0,t,u,v={readyState:0,setRequestHeader:function(a,b){if(!s){var c=a.toLowerCase();a=m[c]=m[c]||a,l[a]=b}return this},getAllResponseHeaders:function(){return s===2?n:null},getResponseHeader:function(a){var c;if(s===2){if(!o){o={};while(c=bH.exec(n))o[c[1].toLowerCase()]=c[2]}c=o[a.toLowerCase()]}return c===b?null:c},overrideMimeType:function(a){s||(d.mimeType=a);return this},abort:function(a){a=a||"abort",p&&p.abort(a),w(0,a);return this}};h.promise(v),v.success=v.done,v.error=v.fail,v.complete=i.add,v.statusCode=function(a){if(a){var b;if(s<2)for(b in a)j[b]=[j[b],a[b]];else b=a[v.status],v.then(b,b)}return this},d.url=((a||d.url)+"").replace(bG,"").replace(bL,bW[1]+"//"),d.dataTypes=f.trim(d.dataType||"*").toLowerCase().split(bP),d.crossDomain==null&&(r=bR.exec(d.url.toLowerCase()),d.crossDomain=!(!r||r[1]==bW[1]&&r[2]==bW[2]&&(r[3]||(r[1]==="http:"?80:443))==(bW[3]||(bW[1]==="http:"?80:443)))),d.data&&d.processData&&typeof d.data!="string"&&(d.data=f.param(d.data,d.traditional)),b$(bT,d,c,v);if(s===2)return!1;t=d.global,d.type=d.type.toUpperCase(),d.hasContent=!bK.test(d.type),t&&f.active++===0&&f.event.trigger("ajaxStart");if(!d.hasContent){d.data&&(d.url+=(bM.test(d.url)?"&":"?")+d.data,delete d.data),k=d.url;if(d.cache===!1){var x=f.now(),y=d.url.replace(bQ,"$1_="+x);d.url=y+(y===d.url?(bM.test(d.url)?"&":"?")+"_="+x:"")}}(d.data&&d.hasContent&&d.contentType!==!1||c.contentType)&&v.setRequestHeader("Content-Type",d.contentType),d.ifModified&&(k=k||d.url,f.lastModified[k]&&v.setRequestHeader("If-Modified-Since",f.lastModified[k]),f.etag[k]&&v.setRequestHeader("If-None-Match",f.etag[k])),v.setRequestHeader("Accept",d.dataTypes[0]&&d.accepts[d.dataTypes[0]]?d.accepts[d.dataTypes[0]]+(d.dataTypes[0]!=="*"?", "+bX+"; q=0.01":""):d.accepts["*"]);for(u in d.headers)v.setRequestHeader(u,d.headers[u]);if(d.beforeSend&&(d.beforeSend.call(e,v,d)===!1||s===2)){v.abort();return!1}for(u in{success:1,error:1,complete:1})v[u](d[u]);p=b$(bU,d,c,v);if(!p)w(-1,"No Transport");else{v.readyState=1,t&&g.trigger("ajaxSend",[v,d]),d.async&&d.timeout>0&&(q=setTimeout(function(){v.abort("timeout")},d.timeout));try{s=1,p.send(l,w)}catch(z){if(s<2)w(-1,z);else throw z}}return v},param:function(a,c){var d=[],e=function(a,b){b=f.isFunction(b)?b():b,d[d.length]=encodeURIComponent(a)+"="+encodeURIComponent(b)};c===b&&(c=f.ajaxSettings.traditional);if(f.isArray(a)||a.jquery&&!f.isPlainObject(a))f.each(a,function(){e(this.name,this.value)});else for(var g in a)ca(g,a[g],c,e);return d.join("&").replace(bD,"+")}}),f.extend({active:0,lastModified:{},etag:{}});var cd=f.now(),ce=/(\=)\?(&|$)|\?\?/i;f.ajaxSetup({jsonp:"callback",jsonpCallback:function(){return f.expando+"_"+cd++}}),f.ajaxPrefilter("json jsonp",function(b,c,d){var e=b.contentType==="application/x-www-form-urlencoded"&&typeof b.data=="string";if(b.dataTypes[0]==="jsonp"||b.jsonp!==!1&&(ce.test(b.url)||e&&ce.test(b.data))){var g,h=b.jsonpCallback=f.isFunction(b.jsonpCallback)?b.jsonpCallback():b.jsonpCallback,i=a[h],j=b.url,k=b.data,l="$1"+h+"$2";b.jsonp!==!1&&(j=j.replace(ce,l),b.url===j&&(e&&(k=k.replace(ce,l)),b.data===k&&(j+=(/\?/.test(j)?"&":"?")+b.jsonp+"="+h))),b.url=j,b.data=k,a[h]=function(a){g=[a]},d.always(function(){a[h]=i,g&&f.isFunction(i)&&a[h](g[0])}),b.converters["script json"]=function(){g||f.error(h+" was not called");return g[0]},b.dataTypes[0]="json";return"script"}}),f.ajaxSetup({accepts:{script:"text/javascript, application/javascript, application/ecmascript, application/x-ecmascript"},contents:{script:/javascript|ecmascript/},converters:{"text script":function(a){f.globalEval(a);return a}}}),f.ajaxPrefilter("script",function(a){a.cache===b&&(a.cache=!1),a.crossDomain&&(a.type="GET",a.global=!1)}),f.ajaxTransport("script",function(a){if(a.crossDomain){var d,e=c.head||c.getElementsByTagName("head")[0]||c.documentElement;return{send:function(f,g){d=c.createElement("script"),d.async="async",a.scriptCharset&&(d.charset=a.scriptCharset),d.src=a.url,d.onload=d.onreadystatechange=function(a,c){if(c||!d.readyState||/loaded|complete/.test(d.readyState))d.onload=d.onreadystatechange=null,e&&d.parentNode&&e.removeChild(d),d=b,c||g(200,"success")},e.insertBefore(d,e.firstChild)},abort:function(){d&&d.onload(0,1)}}}});var cf=a.ActiveXObject?function(){for(var a in ch)ch[a](0,1)}:!1,cg=0,ch;f.ajaxSettings.xhr=a.ActiveXObject?function(){return!this.isLocal&&ci()||cj()}:ci,function(a){f.extend(f.support,{ajax:!!a,cors:!!a&&"withCredentials"in a})}(f.ajaxSettings.xhr()),f.support.ajax&&f.ajaxTransport(function(c){if(!c.crossDomain||f.support.cors){var d;return{send:function(e,g){var h=c.xhr(),i,j;c.username?h.open(c.type,c.url,c.async,c.username,c.password):h.open(c.type,c.url,c.async);if(c.xhrFields)for(j in c.xhrFields)h[j]=c.xhrFields[j];c.mimeType&&h.overrideMimeType&&h.overrideMimeType(c.mimeType),!c.crossDomain&&!e["X-Requested-With"]&&(e["X-Requested-With"]="XMLHttpRequest");try{for(j in e)h.setRequestHeader(j,e[j])}catch(k){}h.send(c.hasContent&&c.data||null),d=function(a,e){var j,k,l,m,n;try{if(d&&(e||h.readyState===4)){d=b,i&&(h.onreadystatechange=f.noop,cf&&delete ch[i]);if(e)h.readyState!==4&&h.abort();else{j=h.status,l=h.getAllResponseHeaders(),m={},n=h.responseXML,n&&n.documentElement&&(m.xml=n),m.text=h.responseText;try{k=h.statusText}catch(o){k=""}!j&&c.isLocal&&!c.crossDomain?j=m.text?200:404:j===1223&&(j=204)}}}catch(p){e||g(-1,p)}m&&g(j,k,m,l)},!c.async||h.readyState===4?d():(i=++cg,cf&&(ch||(ch={},f(a).unload(cf)),ch[i]=d),h.onreadystatechange=d)},abort:function(){d&&d(0,1)}}}});var ck={},cl,cm,cn=/^(?:toggle|show|hide)$/,co=/^([+\-]=)?([\d+.\-]+)([a-z%]*)$/i,cp,cq=[["height","marginTop","marginBottom","paddingTop","paddingBottom"],["width","marginLeft","marginRight","paddingLeft","paddingRight"],["opacity"]],cr;f.fn.extend({show:function(a,b,c){var d,e;if(a||a===0)return this.animate(cu("show",3),a,b,c);for(var g=0,h=this.length;g<h;g++)d=this[g],d.style&&(e=d.style.display,!f._data(d,"olddisplay")&&e==="none"&&(e=d.style.display=""),e===""&&f.css(d,"display")==="none"&&f._data(d,"olddisplay",cv(d.nodeName)));for(g=0;g<h;g++){d=this[g];if(d.style){e=d.style.display;if(e===""||e==="none")d.style.display=f._data(d,"olddisplay")||""}}return this},hide:function(a,b,c){if(a||a===0)return this.animate(cu("hide",3),a,b,c);var d,e,g=0,h=this.length;for(;g<h;g++)d=this[g],d.style&&(e=f.css(d,"display"),e!=="none"&&!f._data(d,"olddisplay")&&f._data(d,"olddisplay",e));for(g=0;g<h;g++)this[g].style&&(this[g].style.display="none");return this},_toggle:f.fn.toggle,toggle:function(a,b,c){var d=typeof a=="boolean";f.isFunction(a)&&f.isFunction(b)?this._toggle.apply(this,arguments):a==null||d?this.each(function(){var b=d?a:f(this).is(":hidden");f(this)[b?"show":"hide"]()}):this.animate(cu("toggle",3),a,b,c);return this},fadeTo:function(a,b,c,d){return this.filter(":hidden").css("opacity",0).show().end().animate({opacity:b},a,c,d)},animate:function(a,b,c,d){function g(){e.queue===!1&&f._mark(this);var b=f.extend({},e),c=this.nodeType===1,d=c&&f(this).is(":hidden"),g,h,i,j,k,l,m,n,o;b.animatedProperties={};for(i in a){g=f.camelCase(i),i!==g&&(a[g]=a[i],delete a[i]),h=a[g],f.isArray(h)?(b.animatedProperties[g]=h[1],h=a[g]=h[0]):b.animatedProperties[g]=b.specialEasing&&b.specialEasing[g]||b.easing||"swing";if(h==="hide"&&d||h==="show"&&!d)return b.complete.call(this);c&&(g==="height"||g==="width")&&(b.overflow=[this.style.overflow,this.style.overflowX,this.style.overflowY],f.css(this,"display")==="inline"&&f.css(this,"float")==="none"&&(!f.support.inlineBlockNeedsLayout||cv(this.nodeName)==="inline"?this.style.display="inline-block":this.style.zoom=1))}b.overflow!=null&&(this.style.overflow="hidden");for(i in a)j=new f.fx(this,b,i),h=a[i],cn.test(h)?(o=f._data(this,"toggle"+i)||(h==="toggle"?d?"show":"hide":0),o?(f._data(this,"toggle"+i,o==="show"?"hide":"show"),j[o]()):j[h]()):(k=co.exec(h),l=j.cur(),k?(m=parseFloat(k[2]),n=k[3]||(f.cssNumber[i]?"":"px"),n!=="px"&&(f.style(this,i,(m||1)+n),l=(m||1)/j.cur()*l,f.style(this,i,l+n)),k[1]&&(m=(k[1]==="-="?-1:1)*m+l),j.custom(l,m,n)):j.custom(l,h,""));return!0}var e=f.speed(b,c,d);if(f.isEmptyObject(a))return this.each(e.complete,[!1]);a=f.extend({},a);return e.queue===!1?this.each(g):this.queue(e.queue,g)},stop:function(a,c,d){typeof a!="string"&&(d=c,c=a,a=b),c&&a!==!1&&this.queue(a||"fx",[]);return this.each(function(){function h(a,b,c){var e=b[c];f.removeData(a,c,!0),e.stop(d)}var b,c=!1,e=f.timers,g=f._data(this);d||f._unmark(!0,this);if(a==null)for(b in g)g[b]&&g[b].stop&&b.indexOf(".run")===b.length-4&&h(this,g,b);else g[b=a+".run"]&&g[b].stop&&h(this,g,b);for(b=e.length;b--;)e[b].elem===this&&(a==null||e[b].queue===a)&&(d?e[b](!0):e[b].saveState(),c=!0,e.splice(b,1));(!d||!c)&&f.dequeue(this,a)})}}),f.each({slideDown:cu("show",1),slideUp:cu("hide",1),slideToggle:cu("toggle",1),fadeIn:{opacity:"show"},fadeOut:{opacity:"hide"},fadeToggle:{opacity:"toggle"}},function(a,b){f.fn[a]=function(a,c,d){return this.animate(b,a,c,d)}}),f.extend({speed:function(a,b,c){var d=a&&typeof a=="object"?f.extend({},a):{complete:c||!c&&b||f.isFunction(a)&&a,duration:a,easing:c&&b||b&&!f.isFunction(b)&&b};d.duration=f.fx.off?0:typeof d.duration=="number"?d.duration:d.duration in f.fx.speeds?f.fx.speeds[d.duration]:f.fx.speeds._default;if(d.queue==null||d.queue===!0)d.queue="fx";d.old=d.complete,d.complete=function(a){f.isFunction(d.old)&&d.old.call(this),d.queue?f.dequeue(this,d.queue):a!==!1&&f._unmark(this)};return d},easing:{linear:function(a,b,c,d){return c+d*a},swing:function(a,b,c,d){return(-Math.cos(a*Math.PI)/2+.5)*d+c}},timers:[],fx:function(a,b,c){this.options=b,this.elem=a,this.prop=c,b.orig=b.orig||{}}}),f.fx.prototype={update:function(){this.options.step&&this.options.step.call(this.elem,this.now,this),(f.fx.step[this.prop]||f.fx.step._default)(this)},cur:function(){if(this.elem[this.prop]!=null&&(!this.elem.style||this.elem.style[this.prop]==null))return this.elem[this.prop];var a,b=f.css(this.elem,this.prop);return isNaN(a=parseFloat(b))?!b||b==="auto"?0:b:a},custom:function(a,c,d){function h(a){return e.step(a)}var e=this,g=f.fx;this.startTime=cr||cs(),this.end=c,this.now=this.start=a,this.pos=this.state=0,this.unit=d||this.unit||(f.cssNumber[this.prop]?"":"px"),h.queue=this.options.queue,h.elem=this.elem,h.saveState=function(){e.options.hide&&f._data(e.elem,"fxshow"+e.prop)===b&&f._data(e.elem,"fxshow"+e.prop,e.start)},h()&&f.timers.push(h)&&!cp&&(cp=setInterval(g.tick,g.interval))},show:function(){var a=f._data(this.elem,"fxshow"+this.prop);this.options.orig[this.prop]=a||f.style(this.elem,this.prop),this.options.show=!0,a!==b?this.custom(this.cur(),a):this.custom(this.prop==="width"||this.prop==="height"?1:0,this.cur()),f(this.elem).show()},hide:function(){this.options.orig[this.prop]=f._data(this.elem,"fxshow"+this.prop)||f.style(this.elem,this.prop),this.options.hide=!0,this.custom(this.cur(),0)},step:function(a){var b,c,d,e=cr||cs(),g=!0,h=this.elem,i=this.options;if(a||e>=i.duration+this.startTime){this.now=this.end,this.pos=this.state=1,this.update(),i.animatedProperties[this.prop]=!0;for(b in i.animatedProperties)i.animatedProperties[b]!==!0&&(g=!1);if(g){i.overflow!=null&&!f.support.shrinkWrapBlocks&&f.each(["","X","Y"],function(a,b){h.style["overflow"+b]=i.overflow[a]}),i.hide&&f(h).hide();if(i.hide||i.show)for(b in i.animatedProperties)f.style(h,b,i.orig[b]),f.removeData(h,"fxshow"+b,!0),f.removeData(h,"toggle"+b,!0);d=i.complete,d&&(i.complete=!1,d.call(h))}return!1}i.duration==Infinity?this.now=e:(c=e-this.startTime,this.state=c/i.duration,this.pos=f.easing[i.animatedProperties[this.prop]](this.state,c,0,1,i.duration),this.now=this.start+(this.end-this.start)*this.pos),this.update();return!0}},f.extend(f.fx,{tick:function(){var a,b=f.timers,c=0;for(;c<b.length;c++)a=b[c],!a()&&b[c]===a&&b.splice(c--,1);b.length||f.fx.stop()},interval:13,stop:function(){clearInterval(cp),cp=null},speeds:{slow:600,fast:200,_default:400},step:{opacity:function(a){f.style(a.elem,"opacity",a.now)},_default:function(a){a.elem.style&&a.elem.style[a.prop]!=null?a.elem.style[a.prop]=a.now+a.unit:a.elem[a.prop]=a.now}}}),f.each(["width","height"],function(a,b){f.fx.step[b]=function(a){f.style(a.elem,b,Math.max(0,a.now)+a.unit)}}),f.expr&&f.expr.filters&&(f.expr.filters.animated=function(a){return f.grep(f.timers,function(b){return a===b.elem}).length});var cw=/^t(?:able|d|h)$/i,cx=/^(?:body|html)$/i;"getBoundingClientRect"in c.documentElement?f.fn.offset=function(a){var b=this[0],c;if(a)return this.each(function(b){f.offset.setOffset(this,a,b)});if(!b||!b.ownerDocument)return null;if(b===b.ownerDocument.body)return f.offset.bodyOffset(b);try{c=b.getBoundingClientRect()}catch(d){}var e=b.ownerDocument,g=e.documentElement;if(!c||!f.contains(g,b))return c?{top:c.top,left:c.left}:{top:0,left:0};var h=e.body,i=cy(e),j=g.clientTop||h.clientTop||0,k=g.clientLeft||h.clientLeft||0,l=i.pageYOffset||f.support.boxModel&&g.scrollTop||h.scrollTop,m=i.pageXOffset||f.support.boxModel&&g.scrollLeft||h.scrollLeft,n=c.top+l-j,o=c.left+m-k;return{top:n,left:o}}:f.fn.offset=function(a){var b=this[0];if(a)return this.each(function(b){f.offset.setOffset(this,a,b)});if(!b||!b.ownerDocument)return null;if(b===b.ownerDocument.body)return f.offset.bodyOffset(b);var c,d=b.offsetParent,e=b,g=b.ownerDocument,h=g.documentElement,i=g.body,j=g.defaultView,k=j?j.getComputedStyle(b,null):b.currentStyle,l=b.offsetTop,m=b.offsetLeft;while((b=b.parentNode)&&b!==i&&b!==h){if(f.support.fixedPosition&&k.position==="fixed")break;c=j?j.getComputedStyle(b,null):b.currentStyle,l-=b.scrollTop,m-=b.scrollLeft,b===d&&(l+=b.offsetTop,m+=b.offsetLeft,f.support.doesNotAddBorder&&(!f.support.doesAddBorderForTableAndCells||!cw.test(b.nodeName))&&(l+=parseFloat(c.borderTopWidth)||0,m+=parseFloat(c.borderLeftWidth)||0),e=d,d=b.offsetParent),f.support.subtractsBorderForOverflowNotVisible&&c.overflow!=="visible"&&(l+=parseFloat(c.borderTopWidth)||0,m+=parseFloat(c.borderLeftWidth)||0),k=c}if(k.position==="relative"||k.position==="static")l+=i.offsetTop,m+=i.offsetLeft;f.support.fixedPosition&&k.position==="fixed"&&(l+=Math.max(h.scrollTop,i.scrollTop),m+=Math.max(h.scrollLeft,i.scrollLeft));return{top:l,left:m}},f.offset={bodyOffset:function(a){var b=a.offsetTop,c=a.offsetLeft;f.support.doesNotIncludeMarginInBodyOffset&&(b+=parseFloat(f.css(a,"marginTop"))||0,c+=parseFloat(f.css(a,"marginLeft"))||0);return{top:b,left:c}},setOffset:function(a,b,c){var d=f.css(a,"position");d==="static"&&(a.style.position="relative");var e=f(a),g=e.offset(),h=f.css(a,"top"),i=f.css(a,"left"),j=(d==="absolute"||d==="fixed")&&f.inArray("auto",[h,i])>-1,k={},l={},m,n;j?(l=e.position(),m=l.top,n=l.left):(m=parseFloat(h)||0,n=parseFloat(i)||0),f.isFunction(b)&&(b=b.call(a,c,g)),b.top!=null&&(k.top=b.top-g.top+m),b.left!=null&&(k.left=b.left-g.left+n),"using"in b?b.using.call(a,k):e.css(k)}},f.fn.extend({position:function(){if(!this[0])return null;var a=this[0],b=this.offsetParent(),c=this.offset(),d=cx.test(b[0].nodeName)?{top:0,left:0}:b.offset();c.top-=parseFloat(f.css(a,"marginTop"))||0,c.left-=parseFloat(f.css(a,"marginLeft"))||0,d.top+=parseFloat(f.css(b[0],"borderTopWidth"))||0,d.left+=parseFloat(f.css(b[0],"borderLeftWidth"))||0;return{top:c.top-d.top,left:c.left-d.left}},offsetParent:function(){return this.map(function(){var a=this.offsetParent||c.body;while(a&&!cx.test(a.nodeName)&&f.css(a,"position")==="static")a=a.offsetParent;return a})}}),f.each(["Left","Top"],function(a,c){var d="scroll"+c;f.fn[d]=function(c){var e,g;if(c===b){e=this[0];if(!e)return null;g=cy(e);return g?"pageXOffset"in g?g[a?"pageYOffset":"pageXOffset"]:f.support.boxModel&&g.document.documentElement[d]||g.document.body[d]:e[d]}return this.each(function(){g=cy(this),g?g.scrollTo(a?f(g).scrollLeft():c,a?c:f(g).scrollTop()):this[d]=c})}}),f.each(["Height","Width"],function(a,c){var d=c.toLowerCase();f.fn["inner"+c]=function(){var a=this[0];return a?a.style?parseFloat(f.css(a,d,"padding")):this[d]():null},f.fn["outer"+c]=function(a){var b=this[0];return b?b.style?parseFloat(f.css(b,d,a?"margin":"border")):this[d]():null},f.fn[d]=function(a){var e=this[0];if(!e)return a==null?null:this;if(f.isFunction(a))return this.each(function(b){var c=f(this);c[d](a.call(this,b,c[d]()))});if(f.isWindow(e)){var g=e.document.documentElement["client"+c],h=e.document.body;return e.document.compatMode==="CSS1Compat"&&g||h&&h["client"+c]||g}if(e.nodeType===9)return Math.max(e.documentElement["client"+c],e.body["scroll"+c],e.documentElement["scroll"+c],e.body["offset"+c],e.documentElement["offset"+c]);if(a===b){var i=f.css(e,d),j=parseFloat(i);return f.isNumeric(j)?j:i}return this.css(d,typeof a=="string"?a:a+"px")}}),a.jQuery=a.$=f,typeof define=="function"&&define.amd&&define.amd.jQuery&&define("jquery",[],function(){return f})})(window);



OEBPS/images/SR-IOV-icon.png





OEBPS/Common_Content/fonts/overpass_bold-web.eot


OEBPS/Common_Content/fonts/portal/nimbus/iconfont.eot


OEBPS/Common_Content/fonts/redhat/text/RedHatText-MediumItalic.woff


OEBPS/Common_Content/scripts/highlight.js/CHANGES.md
## Version 8.4

We've got the new [demo page][]! The obvious new feature is the new look, but
apart from that it's got smarter: by presenting languages in groups it avoids
running 10000 highlighting attempts after first load which was slowing it down
and giving bad overall impression. It is now also being generated from test
code snippets so the authors of new languages don't have to update both tests
and the demo page with the same thing.

Other notable changes:

- The `template_comment` class is gone in favor of the more general `comment`.
- Number parsing unified and improved across languages.
- C++, Java and C# now use unified grammar to highlight titles in
  function/method definitions.
- The browser build is now usable as an AMD module, there's no separate build
  target for that anymore.
- OCaml has got a [comprehensive overhaul][ocaml] by [Mickaël Delahaye][].
- Clojure's data structures and literals are now highlighted outside of lists
  and we can now highlight Clojure's REPL sessions.

New languages:

- *AspectJ* by [Hakan Özler][]
- *STEP Part 21* by [Adam Joseph Cook][]
- *SML* derived by [Edwin Dalorzo][] from OCaml definition
- *Mercury* by [mucaho][]
- *Smali* by [Dennis Titze][]
- *Verilog* by [Jon Evans][]
- *Stata* by [Brian Quistorff][]

[Hakan Özler]: https://github.com/ozlerhakan
[Adam Joseph Cook]: https://github.com/adamjcook
[demo page]: https://highlightjs.org/static/demo/
[Ivan Sagalaev]: https://github.com/isagalaev
[Edwin Dalorzo]: https://github.com/edalorzo
[mucaho]: https://github.com/mucaho
[Dennis Titze]: https://github.com/titze
[Jon Evans]: https://github.com/craftyjon
[Brian Quistorff]: https://github.com/bquistorff
[ocaml]: https://github.com/isagalaev/highlight.js/pull/608#issue-46190207
[Mickaël Delahaye]: https://github.com/polazarus


## Version 8.3

We streamlined our tool chain, it is now based entirely on node.js instead of
being a mix of node.js, Python and Java. The build script options and arguments
remained the same, and we've noted all the changes in the [documentation][b].
Apart from reducing complexity, the new build script is also faster from not
having to start Java machine repeatedly. The credits for the work go to [Jeremy
Hull][].

Some notable fixes:

- PHP and JavaScript mixed in HTML now live happily with each other.
- JavaScript regexes now understand ES6 flags "u" and "y".
- `throw` keyword is no longer detected as a method name in Java.
- Fixed parsing of numbers and symbols in Clojure thanks to [input from Ivan
  Kleshnin][ik].

New languages in this release:

- *Less* by [Max Mikhailov][]
- *Stylus* by [Bryant Williams][]
- *Tcl* by [Radek Liska][]
- *Puppet* by [Jose Molina Colmenero][]
- *Processing* by [Erik Paluka][]
- *Twig* templates by [Luke Holder][]
- *PowerShell* by [David Mohundro][], based on [the work of Nicholas
  Blumhardt][ps]
- *XL* by [Christophe de Dinechin][]
- *LiveScript* by [Taneli Vatanen][] and [Jen Evers-Corvina][]
- *ERB* (Ruby in HTML) by [Lucas Mazza][]
- *Roboconf* by [Vincent Zurczak][]

[b]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[Jeremy Hull]: https://github.com/sourrust
[ik]: https://twitter.com/IvanKleshnin/status/514041599484231680
[Max Mikhailov]: https://github.com/seven-phases-max
[Bryant Williams]: https://github.com/scien
[Radek Liska]: https://github.com/Nindaleth
[Jose Molina Colmenero]: https://github.com/Moliholy
[Erik Paluka]: https://github.com/paluka
[Luke Holder]: https://github.com/lukeholder
[David Mohundro]: https://github.com/drmohundro
[ps]: https://github.com/OctopusDeploy/Library/blob/master/app/shared/presentation/highlighting/powershell.js
[Christophe de Dinechin]: https://github.com/c3d
[Taneli Vatanen]: https://github.com/Daiz-
[Jen Evers-Corvina]: https://github.com/sevvie
[Lucas Mazza]: https://github.com/lucasmazza
[Vincent Zurczak]: https://github.com/vincent-zurczak

## Version 8.2

We've finally got [real tests][test] and [continuous testing on Travis][ci]
thanks to [Jeremy Hull][] and [Chris Eidhof][]. The tests designed to cover
everything: language detection, correct parsing of individual language features
and various special cases. This is a very important change that gives us
confidence in extending language definitions and refactoring library core.

We're going to redesign the old [demo/test suite][demo] into an interactive
demo web app. If you're confident front-end developer or designer and want to
help us with it, drop a comment into [the issue][#542] on GitHub.

[test]: https://github.com/isagalaev/highlight.js/tree/master/test
[demo]: https://highlightjs.org/static/test.html
[#542]: https://github.com/isagalaev/highlight.js/issues/542
[ci]: https://travis-ci.org/isagalaev/highlight.js
[Jeremy Hull]: https://github.com/sourrust
[Chris Eidhof]: https://github.com/chriseidhof

As usually there's a handful of new languages in this release:

- *Groovy* by [Guillaume Laforge][]
- *Dart* by [Maxim Dikun][]
- *Dust* by [Michael Allen][]
- *Scheme* by [JP Verkamp][]
- *G-Code* by [Adam Joseph Cook][]
- *Q* from Kx Systems by [Sergey Vidyuk][]

[Guillaume Laforge]: https://github.com/glaforge
[Maxim Dikun]: https://github.com/dikmax
[Michael Allen]: https://github.com/bfui
[JP Verkamp]: https://github.com/jpverkamp
[Adam Joseph Cook]: https://github.com/adamjcook
[Sergey Vidyuk]: https://github.com/sv

Other improvements:

- [Erik Osheim][] heavily reworked Scala definitions making it richer.
- [Lucas Mazza][] fixed Ruby hashes highlighting
- Lisp variants (Lisp, Clojure and Scheme) are unified in regard to naming
  the first symbol in parentheses: it's "keyword" in general case and also
  "built_in" for built-in functions in Clojure and Scheme.

[Erik Osheim]: https://github.com/non
[Lucas Mazza]: https://github.com/lucasmazza

## Version 8.1

New languages:

- *Gherkin* by [Sam Pikesley][]
- *Elixir* by [Josh Adams][]
- *NSIS* by [Jan T. Sott][]
- *VIM script* by [Jun Yang][]
- *Protocol Buffers* by [Dan Tao][]
- *Nix* by [Domen Kožar][]
- *x86asm* by [innocenat][]
- *Cap’n Proto* and *Thrift* by [Oleg Efimov][]
- *Monkey* by [Arthur Bikmullin][]
- *TypeScript* by [Panu Horsmalahti][]
- *Nimrod* by [Flaviu Tamas][]
- *Gradle* by [Damian Mee][]
- *Haxe* by [Christopher Kaster][]
- *Swift* by [Chris Eidhof][] and [Nate Cook][]

New styles:

- *Kimbie*, light and dark variants by [Jan T. Sott][]
- *Color brewer* by [Fabrício Tavares de Oliveira][]
- *Codepen.io embed* by [Justin Perry][]
- *Hybrid* by [Nic West][]

[Sam Pikesley]: https://github.com/pikesley
[Sindre Sorhus]: https://github.com/sindresorhus
[Josh Adams]: https://github.com/knewter
[Jan T. Sott]: https://github.com/idleberg
[Jun Yang]: https://github.com/harttle
[Dan Tao]: https://github.com/dtao
[Domen Kožar]: https://github.com/iElectric
[innocenat]: https://github.com/innocenat
[Oleg Efimov]: https://github.com/Sannis
[Arthur Bikmullin]: https://github.com/devolonter
[Panu Horsmalahti]: https://github.com/panuhorsmalahti
[Flaviu Tamas]: https://github.com/flaviut
[Damian Mee]: https://github.com/chester1000
[Christopher Kaster]: http://christopher.kaster.ws
[Fabrício Tavares de Oliveira]: https://github.com/fabriciotav
[Justin Perry]: https://github.com/ourmaninamsterdam
[Nic West]: https://github.com/nicwest
[Chris Eidhof]: https://github.com/chriseidhof
[Nate Cook]: https://github.com/natecook1000

Other improvements:

- The README is heavily reworked and brought up to date by [Jeremy Hull][].
- Added [`listLanguages()`][ll] method in the API.
- Improved C/C++/C# detection.
- Added a bunch of new language aliases, documented the existing ones. Thanks to
  [Sindre Sorhus][] for background research.
- Added phrasal English words to boost relevance in comments.
- Many improvements to SQL definition made by [Heiko August][],
  [Nikolay Lisienko][] and [Travis Odom][].
- The shorter `lang-` prefix for language names in HTML classes supported
  alongside `language-`. Thanks to [Jeff Escalante][].
- Ruby's got support for interactive console sessions. Thanks to
  [Pascal Hurni][].
- Added built-in functions for R language. Thanks to [Artem A. Klevtsov][].
- Rust's got definition for lifetime parameters and improved string syntax.
  Thanks to [Roman Shmatov][].
- Various improvements to Objective-C definition by [Matt Diephouse][].
- Fixed highlighting of generics in Java.

[ll]: http://highlightjs.readthedocs.org/en/latest/api.html#listlanguages
[Sindre Sorhus]: https://github.com/sindresorhus
[Heiko August]: https://github.com/auge8472
[Nikolay Lisienko]: https://github.com/neor-ru
[Travis Odom]: https://github.com/Burstaholic
[Jeff Escalante]: https://github.com/jenius
[Pascal Hurni]: https://github.com/phurni
[Jiyin Yiyong]: https://github.com/jiyinyiyong
[Artem A. Klevtsov]: https://github.com/unikum
[Roman Shmatov]: https://github.com/shmatov
[Jeremy Hull]: https://github.com/sourrust
[Matt Diephouse]: https://github.com/mdiep


## Version 8.0

This new major release is quite a big overhaul bringing both new features and
some backwards incompatible changes. However, chances are that the majority of
users won't be affected by the latter: the basic scenario described in the
README is left intact.

Here's what did change in an incompatible way:

- We're now prefixing all classes located in [CSS classes reference][cr] with
  `hljs-`, by default, because some class names would collide with other
  people's stylesheets. If you were using an older version, you might still want
  the previous behavior, but still want to upgrade. To suppress this new
  behavior, you would initialize like so:

  ```html
  <script type="text/javascript">
    hljs.configure({classPrefix: ''});
    hljs.initHighlightingOnLoad();
  </script>
  ```

- `tabReplace` and `useBR` that were used in different places are also unified
  into the global options object and are to be set using `configure(options)`.
  This function is documented in our [API docs][]. Also note that these
  parameters are gone from `highlightBlock` and `fixMarkup` which are now also
  rely on `configure`.

- We removed public-facing (though undocumented) object `hljs.LANGUAGES` which
  was used to register languages with the library in favor of two new methods:
  `registerLanguage` and `getLanguage`. Both are documented in our [API docs][].

- Result returned from `highlight` and `highlightAuto` no longer contains two
  separate attributes contributing to relevance score, `relevance` and
  `keyword_count`. They are now unified in `relevance`.

Another technically compatible change that nonetheless might need attention:

- The structure of the NPM package was refactored, so if you had installed it
  locally, you'll have to update your paths. The usual `require('highlight.js')`
  works as before. This is contributed by [Dmitry Smolin][].

New features:

- Languages now can be recognized by multiple names like "js" for JavaScript or
  "html" for, well, HTML (which earlier insisted on calling it "xml"). These
  aliases can be specified in the class attribute of the code container in your
  HTML as well as in various API calls. For now there are only a few very common
  aliases but we'll expand it in the future. All of them are listed in the
  [class reference][cr].

- Language detection can now be restricted to a subset of languages relevant in
  a given context — a web page or even a single highlighting call. This is
  especially useful for node.js build that includes all the known languages.
  Another example is a StackOverflow-style site where users specify languages
  as tags rather than in the markdown-formatted code snippets. This is
  documented in the [API reference][] (see methods `highlightAuto` and
  `configure`).

- Language definition syntax streamlined with [variants][] and
  [beginKeywords][].

New languages and styles:

- *Oxygene* by [Carlo Kok][]
- *Mathematica* by [Daniel Kvasnička][]
- *Autohotkey* by [Seongwon Lee][]
- *Atelier* family of styles in 10 variants by [Bram de Haan][]
- *Paraíso* styles by [Jan T. Sott][]

Miscellaneous improvements:

- Highlighting `=>` prompts in Clojure.
- [Jeremy Hull][] fixed a lot of styles for consistency.
- Finally, highlighting PHP and HTML [mixed in peculiar ways][php-html].
- Objective C and C# now properly highlight titles in method definition.
- Big overhaul of relevance counting for a number of languages. Please do report
  bugs about mis-detection of non-trivial code snippets!

[API reference]: http://highlightjs.readthedocs.org/en/latest/api.html

[cr]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[api docs]: http://highlightjs.readthedocs.org/en/latest/api.html
[variants]: https://groups.google.com/d/topic/highlightjs/VoGC9-1p5vk/discussion
[beginKeywords]: https://github.com/isagalaev/highlight.js/commit/6c7fdea002eb3949577a85b3f7930137c7c3038d
[php-html]: https://twitter.com/highlightjs/status/408890903017689088

[Carlo Kok]: https://github.com/carlokok
[Bram de Haan]: https://github.com/atelierbram
[Daniel Kvasnička]: https://github.com/dkvasnicka
[Dmitry Smolin]: https://github.com/dimsmol
[Jeremy Hull]: https://github.com/sourrust
[Seongwon Lee]: https://github.com/dlimpid
[Jan T. Sott]: https://github.com/idleberg


## Version 7.5

A catch-up release dealing with some of the accumulated contributions. This one
is probably will be the last before the 8.0 which will be slightly backwards
incompatible regarding some advanced use-cases.

One outstanding change in this version is the addition of 6 languages to the
[hosted script][d]: Markdown, ObjectiveC, CoffeeScript, Apache, Nginx and
Makefile. It now weighs about 6K more but we're going to keep it under 30K.

New languages:

- OCaml by [Mehdi Dogguy][mehdid] and [Nicolas Braud-Santoni][nbraud]
- [LiveCode Server][lcs] by [Ralf Bitter][revig]
- Scilab by [Sylvestre Ledru][sylvestre]
- basic support for Makefile by [Ivan Sagalaev][isagalaev]

Improvements:

- Ruby's got support for characters like `?A`, `?1`, `?\012` etc. and `%r{..}`
  regexps.
- Clojure now allows a function call in the beginning of s-expressions
  `(($filter "myCount") (arr 1 2 3 4 5))`.
- Haskell's got new keywords and now recognizes more things like pragmas,
  preprocessors, modules, containers, FFIs etc. Thanks to [Zena Treep][treep]
  for the implementation and to [Jeremy Hull][sourrust] for guiding it.
- Miscellaneous fixes in PHP, Brainfuck, SCSS, Asciidoc, CMake, Python and F#.

[mehdid]: https://github.com/mehdid
[nbraud]: https://github.com/nbraud
[revig]: https://github.com/revig
[lcs]: http://livecode.com/developers/guides/server/
[sylvestre]: https://github.com/sylvestre
[isagalaev]: https://github.com/isagalaev
[treep]: https://github.com/treep
[sourrust]: https://github.com/sourrust
[d]: http://highlightjs.org/download/


## New core developers

The latest long period of almost complete inactivity in the project coincided
with growing interest to it led to a decision that now seems completely obvious:
we need more core developers.

So without further ado let me welcome to the core team two long-time
contributors: [Jeremy Hull][] and [Oleg
Efimov][].

Hope now we'll be able to work through stuff faster!

P.S. The historical commit is [here][1] for the record.

[Jeremy Hull]: https://github.com/sourrust
[Oleg Efimov]: https://github.com/sannis
[1]: https://github.com/isagalaev/highlight.js/commit/f3056941bda56d2b72276b97bc0dd5f230f2473f


## Version 7.4

This long overdue version is a snapshot of the current source tree with all the
changes that happened during the past year. Sorry for taking so long!

Along with the changes in code highlight.js has finally got its new home at
<http://highlightjs.org/>, moving from its cradle on Software Maniacs which it
outgrew a long time ago. Be sure to report any bugs about the site to
<mailto:info@highlightjs.org>.

On to what's new…

New languages:

- Handlebars templates by [Robin Ward][]
- Oracle Rules Language by [Jason Jacobson][]
- F# by [Joans Follesø][]
- AsciiDoc and Haml by [Dan Allen][]
- Lasso by [Eric Knibbe][]
- SCSS by [Kurt Emch][]
- VB.NET by [Poren Chiang][]
- Mizar by [Kelley van Evert][]

[Robin Ward]: https://github.com/eviltrout
[Jason Jacobson]: https://github.com/jayce7
[Joans Follesø]: https://github.com/follesoe
[Dan Allen]: https://github.com/mojavelinux
[Eric Knibbe]: https://github.com/EricFromCanada
[Kurt Emch]: https://github.com/kemch
[Poren Chiang]: https://github.com/rschiang
[Kelley van Evert]: https://github.com/kelleyvanevert

New style themes:

- Monokai Sublime by [noformnocontent][]
- Railscasts by [Damien White][]
- Obsidian by [Alexander Marenin][]
- Docco by [Simon Madine][]
- Mono Blue by [Ivan Sagalaev][] (uses a single color hue for everything)
- Foundation by [Dan Allen][]

[noformnocontent]: http://nn.mit-license.org/
[Damien White]: https://github.com/visoft
[Alexander Marenin]: https://github.com/ioncreature
[Simon Madine]: https://github.com/thingsinjars
[Ivan Sagalaev]: https://github.com/isagalaev

Other notable changes:

- Corrected many corner cases in CSS.
- Dropped Python 2 version of the build tool.
- Implemented building for the AMD format.
- Updated Rust keywords (thanks to [Dmitry Medvinsky][]).
- Literal regexes can now be used in language definitions.
- CoffeeScript highlighting is now significantly more robust and rich due to
  input from [Cédric Néhémie][].

[Dmitry Medvinsky]: https://github.com/dmedvinsky
[Cédric Néhémie]: https://github.com/abe33


## Version 7.3

- Since this version highlight.js no longer works in IE version 8 and older.
  It's made it possible to reduce the library size and dramatically improve code
  readability and made it easier to maintain. Time to go forward!

- New languages: AppleScript (by [Nathan Grigg][ng] and [Dr. Drang][dd]) and
  Brainfuck (by [Evgeny Stepanischev][bolk]).

- Improvements to existing languages:

    - interpreter prompt in Python (`>>>` and `...`)
    - @-properties and classes in CoffeeScript
    - E4X in JavaScript (by [Oleg Efimov][oe])
    - new keywords in Perl (by [Kirk Kimmel][kk])
    - big Ruby syntax update (by [Vasily Polovnyov][vast])
    - small fixes in Bash

- Also Oleg Efimov did a great job of moving all the docs for language and style
  developers and contributors from the old wiki under the source code in the
  "docs" directory. Now these docs are nicely presented at
  <http://highlightjs.readthedocs.org/>.

[ng]: https://github.com/nathan11g
[dd]: https://github.com/drdrang
[bolk]: https://github.com/bolknote
[oe]: https://github.com/Sannis
[kk]: https://github.com/kimmel
[vast]: https://github.com/vast


## Version 7.2

A regular bug-fix release without any significant new features. Enjoy!


## Version 7.1

A Summer crop:

- [Marc Fornos][mf] made the definition for Clojure along with the matching
  style Rainbow (which, of course, works for other languages too).
- CoffeeScript support continues to improve getting support for regular
  expressions.
- Yoshihide Jimbo ported to highlight.js [five Tomorrow styles][tm] from the
  [project by Chris Kempson][tm0].
- Thanks to [Casey Duncun][cd] the library can now be built in the popular
  [AMD format][amd].
- And last but not least, we've got a fair number of correctness and consistency
  fixes, including a pretty significant refactoring of Ruby.

[mf]: https://github.com/mfornos
[tm]: http://jmblog.github.com/color-themes-for-highlightjs/
[tm0]: https://github.com/ChrisKempson/Tomorrow-Theme
[cd]: https://github.com/caseman
[amd]: http://requirejs.org/docs/whyamd.html


## Version 7.0

The reason for the new major version update is a global change of keyword syntax
which resulted in the library getting smaller once again. For example, the
hosted build is 2K less than at the previous version while supporting two new
languages.

Notable changes:

- The library now works not only in a browser but also with [node.js][]. It is
  installable with `npm install highlight.js`. [API][] docs are available on our
  wiki.

- The new unique feature (apparently) among syntax highlighters is highlighting
  *HTTP* headers and an arbitrary language in the request body. The most useful
  languages here are *XML* and *JSON* both of which highlight.js does support.
  Here's [the detailed post][p] about the feature.

- Two new style themes: a dark "south" *[Pojoaque][]* by Jason Tate and an
  emulation of*XCode* IDE by [Angel Olloqui][ao].

- Three new languages: *D* by [Aleksandar Ružičić][ar], *R* by [Joe Cheng][jc]
  and *GLSL* by [Sergey Tikhomirov][st].

- *Nginx* syntax has become a million times smaller and more universal thanks to
  remaking it in a more generic manner that doesn't require listing all the
  directives in the known universe.

- Function titles are now highlighted in *PHP*.

- *Haskell* and *VHDL* were significantly reworked to be more rich and correct
  by their respective maintainers [Jeremy Hull][sr] and [Igor Kalnitsky][ik].

And last but not least, many bugs have been fixed around correctness and
language detection.

Overall highlight.js currently supports 51 languages and 20 style themes.

[node.js]: http://nodejs.org/
[api]: http://softwaremaniacs.org/wiki/doku.php/highlight.js:api
[p]: http://softwaremaniacs.org/blog/2012/05/10/http-and-json-in-highlight-js/en/
[pojoaque]: http://web-cms-designs.com/ftopict-10-pojoaque-style-for-highlight-js-code-highlighter.html
[ao]: https://github.com/angelolloqui
[ar]: https://github.com/raleksandar
[jc]: https://github.com/jcheng5
[st]: https://github.com/tikhomirov
[sr]: https://github.com/sourrust
[ik]: https://github.com/ikalnitsky


## Version 6.2

A lot of things happened in highlight.js since the last version! We've got nine
new contributors, the discussion group came alive, and the main branch on GitHub
now counts more than 350 followers. Here are most significant results coming
from all this activity:

- 5 (five!) new languages: Rust, ActionScript, CoffeeScript, MatLab and
  experimental support for markdown. Thanks go to [Andrey Vlasovskikh][av],
  [Alexander Myadzel][am], [Dmytrii Nagirniak][dn], [Oleg Efimov][oe], [Denis
  Bardadym][db] and [John Crepezzi][jc].

- 2 new style themes: Monokai by [Luigi Maselli][lm] and stylistic imitation of
  another well-known highlighter Google Code Prettify by [Aahan Krish][ak].

- A vast number of [correctness fixes and code refactorings][log], mostly made
  by [Oleg Efimov][oe] and [Evgeny Stepanischev][es].

[av]: https://github.com/vlasovskikh
[am]: https://github.com/myadzel
[dn]: https://github.com/dnagir
[oe]: https://github.com/Sannis
[db]: https://github.com/btd
[jc]: https://github.com/seejohnrun
[lm]: http://grigio.org/
[ak]: https://github.com/geekpanth3r
[es]: https://github.com/bolknote
[log]: https://github.com/isagalaev/highlight.js/commits/


## Version 6.1 — Solarized

[Jeremy Hull][jh] has implemented my dream feature — a port of [Solarized][]
style theme famous for being based on the intricate color theory to achieve
correct contrast and color perception. It is now available for highlight.js in
both variants — light and dark.

This version also adds a new original style Arta. Its author pumbur maintains a
[heavily modified fork of highlight.js][pb] on GitHub.

[jh]: https://github.com/sourrust
[solarized]: http://ethanschoonover.com/solarized
[pb]: https://github.com/pumbur/highlight.js


## Version 6.0

New major version of the highlighter has been built on a significantly
refactored syntax. Due to this it's even smaller than the previous one while
supporting more languages!

New languages are:

- Haskell by [Jeremy Hull][sourrust]
- Erlang in two varieties — module and REPL — made collectively by [Nikolay
  Zakharov][desh], [Dmitry Kovega][arhibot] and [Sergey Ignatov][ignatov]
- Objective C by [Valerii Hiora][vhbit]
- Vala by [Antono Vasiljev][antono]
- Go by [Stephan Kountso][steplg]

[sourrust]: https://github.com/sourrust
[desh]: http://desh.su/
[arhibot]: https://github.com/arhibot
[ignatov]: https://github.com/ignatov
[vhbit]: https://github.com/vhbit
[antono]: https://github.com/antono
[steplg]: https://github.com/steplg

Also this version is marginally faster and fixes a number of small long-standing
bugs.

Developer overview of the new language syntax is available in a [blog post about
recent beta release][beta].

[beta]: http://softwaremaniacs.org/blog/2011/04/25/highlight-js-60-beta/en/

P.S. New version is not yet available on a Yandex CDN, so for now you have to
download [your own copy][d].

[d]: /soft/highlight/en/download/


## Version 5.14

Fixed bugs in HTML/XML detection and relevance introduced in previous
refactoring.

Also test.html now shows the second best result of language detection by
relevance.


## Version 5.13

Past weekend began with a couple of simple additions for existing languages but
ended up in a big code refactoring bringing along nice improvements for language
developers.

### For users

- Description of C++ has got new keywords from the upcoming [C++ 0x][] standard.
- Description of HTML has got new tags from [HTML 5][].
- CSS-styles have been unified to use consistent padding and also have lost
  pop-outs with names of detected languages.
- [Igor Kalnitsky][ik] has sent two new language descriptions: CMake & VHDL.

This makes total number of languages supported by highlight.js to reach 35.

Bug fixes:

- Custom classes on `<pre>` tags are not being overridden anymore
- More correct highlighting of code blocks inside non-`<pre>` containers:
  highlighter now doesn't insist on replacing them with its own container and
  just replaces the contents.
- Small fixes in browser compatibility and heuristics.

[c++ 0x]: http://ru.wikipedia.org/wiki/C%2B%2B0x
[html 5]: http://en.wikipedia.org/wiki/HTML5
[ik]: http://kalnitsky.org.ua/

### For developers

The most significant change is the ability to include language submodes right
under `contains` instead of defining explicit named submodes in the main array:

    contains: [
      'string',
      'number',
      {begin: '\\n', end: hljs.IMMEDIATE_RE}
    ]

This is useful for auxiliary modes needed only in one place to define parsing.
Note that such modes often don't have `className` and hence won't generate a
separate `<span>` in the resulting markup. This is similar in effect to
`noMarkup: true`. All existing languages have been refactored accordingly.

Test file test.html has at last become a real test. Now it not only puts the
detected language name under the code snippet but also tests if it matches the
expected one. Test summary is displayed right above all language snippets.


## CDN

Fine people at [Yandex][] agreed to host highlight.js on their big fast servers.
[Link up][l]!

[yandex]: http://yandex.com/
[l]: http://softwaremaniacs.org/soft/highlight/en/download/


## Version 5.10 — "Paris".

Though I'm on a vacation in Paris, I decided to release a new version with a
couple of small fixes:

- Tomas Vitvar discovered that TAB replacement doesn't always work when used
  with custom markup in code
- SQL parsing is even more rigid now and doesn't step over SmallTalk in tests


## Version 5.9

A long-awaited version is finally released.

New languages:

- Andrew Fedorov made a definition for Lua
- a long-time highlight.js contributor [Peter Leonov][pl] made a definition for
  Nginx config
- [Vladimir Moskva][vm] made a definition for TeX

[pl]: http://kung-fu-tzu.ru/
[vm]: http://fulc.ru/

Fixes for existing languages:

- [Loren Segal][ls] reworked the Ruby definition and added highlighting for
  [YARD][] inline documentation
- the definition of SQL has become more solid and now it shouldn't be overly
  greedy when it comes to language detection

[ls]: http://gnuu.org/
[yard]: http://yardoc.org/

The highlighter has become more usable as a library allowing to do highlighting
from initialization code of JS frameworks and in ajax methods (see.
readme.eng.txt).

Also this version drops support for the [WordPress][wp] plugin. Everyone is
welcome to [pick up its maintenance][p] if needed.

[wp]: http://wordpress.org/
[p]: http://bazaar.launchpad.net/~isagalaev/+junk/highlight/annotate/342/src/wp_highlight.js.php


## Version 5.8

- Jan Berkel has contributed a definition for Scala. +1 to hotness!
- All CSS-styles are rewritten to work only inside `<pre>` tags to avoid
  conflicts with host site styles.


## Version 5.7.

Fixed escaping of quotes in VBScript strings.


## Version 5.5

This version brings a small change: now .ini-files allow digits, underscores and
square brackets in key names.


## Version 5.4

Fixed small but upsetting bug in the packer which caused incorrect highlighting
of explicitly specified languages. Thanks to Andrew Fedorov for precise
diagnostics!


## Version 5.3

The version to fulfil old promises.

The most significant change is that highlight.js now preserves custom user
markup in code along with its own highlighting markup. This means that now it's
possible to use, say, links in code. Thanks to [Vladimir Dolzhenko][vd] for the
[initial proposal][1] and for making a proof-of-concept patch.

Also in this version:

- [Vasily Polovnyov][vp] has sent a GitHub-like style and has implemented
  support for CSS @-rules and Ruby symbols.
- Yura Zaripov has sent two styles: Brown Paper and School Book.
- Oleg Volchkov has sent a definition for [Parser 3][p3].

[1]: http://softwaremaniacs.org/forum/highlightjs/6612/
[p3]: http://www.parser.ru/
[vp]: http://vasily.polovnyov.ru/
[vd]: http://dolzhenko.blogspot.com/


## Version 5.2

- at last it's possible to replace indentation TABs with something sensible
  (e.g. 2 or 4 spaces)
- new keywords and built-ins for 1C by Sergey Baranov
- a couple of small fixes to Apache highlighting


## Version 5.1

This is one of those nice version consisting entirely of new and shiny
contributions!

- [Vladimir Ermakov][vooon] created highlighting for AVR Assembler
- [Ruslan Keba][rukeba] created highlighting for Apache config file. Also his
  original visual style for it is now available for all highlight.js languages
  under the name "Magula".
- [Shuen-Huei Guan][drake] (aka Drake) sent new keywords for RenderMan
  languages. Also thanks go to [Konstantin Evdokimenko][ke] for his advice on
  the matter.

[vooon]: http://vehq.ru/about/
[rukeba]: http://rukeba.com/
[drake]: http://drakeguan.org/
[ke]: http://k-evdokimenko.moikrug.ru/


## Version 5.0

The main change in the new major version of highlight.js is a mechanism for
packing several languages along with the library itself into a single compressed
file. Now sites using several languages will load considerably faster because
the library won't dynamically include additional files while loading.

Also this version fixes a long-standing bug with Javascript highlighting that
couldn't distinguish between regular expressions and division operations.

And as usually there were a couple of minor correctness fixes.

Great thanks to all contributors! Keep using highlight.js.


## Version 4.3

This version comes with two contributions from [Jason Diamond][jd]:

- language definition for C# (yes! it was a long-missed thing!)
- Visual Studio-like highlighting style

Plus there are a couple of minor bug fixes for parsing HTML and XML attributes.

[jd]: http://jason.diamond.name/weblog/


## Version 4.2

The biggest news is highlighting for Lisp, courtesy of Vasily Polovnyov. It's
somewhat experimental meaning that for highlighting "keywords" it doesn't use
any pre-defined set of a Lisp dialect. Instead it tries to highlight first word
in parentheses wherever it makes sense. I'd like to ask people programming in
Lisp to confirm if it's a good idea and send feedback to [the forum][f].

Other changes:

- Smalltalk was excluded from DEFAULT_LANGUAGES to save traffic
- [Vladimir Epifanov][voldmar] has implemented javascript style switcher for
  test.html
- comments now allowed inside Ruby function definition
- [MEL][] language from [Shuen-Huei Guan][drake]
- whitespace now allowed between `<pre>` and `<code>`
- better auto-detection of C++ and PHP
- HTML allows embedded VBScript (`<% .. %>`)

[f]: http://softwaremaniacs.org/forum/highlightjs/
[voldmar]: http://voldmar.ya.ru/
[mel]: http://en.wikipedia.org/wiki/Maya_Embedded_Language
[drake]: http://drakeguan.org/


## Version 4.1

Languages:

- Bash from Vah
- DOS bat-files from Alexander Makarov (Sam)
- Diff files from Vasily Polovnyov
- Ini files from myself though initial idea was from Sam

Styles:

- Zenburn from Vladimir Epifanov, this is an imitation of a
  [well-known theme for Vim][zenburn].
- Ascetic from myself, as a realization of ideals of non-flashy highlighting:
  just one color in only three gradations :-)

In other news. [One small bug][bug] was fixed, built-in keywords were added for
Python and C++ which improved auto-detection for the latter (it was shame that
[my wife's blog][alenacpp] had issues with it from time to time). And lastly
thanks go to Sam for getting rid of my stylistic comments in code that were
getting in the way of [JSMin][].

[zenburn]: http://en.wikipedia.org/wiki/Zenburn
[alenacpp]: http://alenacpp.blogspot.com/
[bug]: http://softwaremaniacs.org/forum/viewtopic.php?id=1823
[jsmin]: http://code.google.com/p/jsmin-php/


## Version 4.0

New major version is a result of vast refactoring and of many contributions.

Visible new features:

- Highlighting of embedded languages. Currently is implemented highlighting of
  Javascript and CSS inside HTML.
- Bundled 5 ready-made style themes!

Invisible new features:

- Highlight.js no longer pollutes global namespace. Only one object and one
  function for backward compatibility.
- Performance is further increased by about 15%.

Changing of a major version number caused by a new format of language definition
files. If you use some third-party language files they should be updated.


## Version 3.5

A very nice version in my opinion fixing a number of small bugs and slightly
increased speed in a couple of corner cases. Thanks to everybody who reports
bugs in he [forum][f] and by email!

There is also a new language — XML. A custom XML formerly was detected as HTML
and didn't highlight custom tags. In this version I tried to make custom XML to
be detected and highlighted by its own rules. Which by the way include such
things as CDATA sections and processing instructions (`<? ... ?>`).

[f]: http://softwaremaniacs.org/forum/viewforum.php?id=6


## Version 3.3

[Vladimir Gubarkov][xonix] has provided an interesting and useful addition.
File export.html contains a little program that shows and allows to copy and
paste an HTML code generated by the highlighter for any code snippet. This can
be useful in situations when one can't use the script itself on a site.


[xonix]: http://xonixx.blogspot.com/


## Version 3.2 consists completely of contributions:

- Vladimir Gubarkov has described SmallTalk
- Yuri Ivanov has described 1C
- Peter Leonov has packaged the highlighter as a Firefox extension
- Vladimir Ermakov has compiled a mod for phpBB

Many thanks to you all!


## Version 3.1

Three new languages are available: Django templates, SQL and Axapta. The latter
two are sent by [Dmitri Roudakov][1]. However I've almost entirely rewrote an
SQL definition but I'd never started it be it from the ground up :-)

The engine itself has got a long awaited feature of grouping keywords
("keyword", "built-in function", "literal"). No more hacks!

[1]: http://roudakov.ru/


## Version 3.0

It is major mainly because now highlight.js has grown large and has become
modular. Now when you pass it a list of languages to highlight it will
dynamically load into a browser only those languages.

Also:

- Konstantin Evdokimenko of [RibKit][] project has created a highlighting for
  RenderMan Shading Language and RenderMan Interface Bytestream. Yay for more
  languages!
- Heuristics for C++ and HTML got better.
- I've implemented (at last) a correct handling of backslash escapes in C-like
  languages.

There is also a small backwards incompatible change in the new version. The
function initHighlighting that was used to initialize highlighting instead of
initHighlightingOnLoad a long time ago no longer works. If you by chance still
use it — replace it with the new one.

[RibKit]: http://ribkit.sourceforge.net/


## Version 2.9

Highlight.js is a parser, not just a couple of regular expressions. That said
I'm glad to announce that in the new version 2.9 has support for:

- in-string substitutions for Ruby -- `#{...}`
- strings from from numeric symbol codes (like #XX) for Delphi


## Version 2.8

A maintenance release with more tuned heuristics. Fully backwards compatible.


## Version 2.7

- Nikita Ledyaev presents highlighting for VBScript, yay!
- A couple of bugs with escaping in strings were fixed thanks to Mickle
- Ongoing tuning of heuristics

Fixed bugs were rather unpleasant so I encourage everyone to upgrade!


## Version 2.4

- Peter Leonov provides another improved highlighting for Perl
- Javascript gets a new kind of keywords — "literals". These are the words
  "true", "false" and "null"

Also highlight.js homepage now lists sites that use the library. Feel free to
add your site by [dropping me a message][mail] until I find the time to build a
submit form.

[mail]: mailto:Maniac@SoftwareManiacs.Org


## Version 2.3

This version fixes IE breakage in previous version. My apologies to all who have
already downloaded that one!


## Version 2.2

- added highlighting for Javascript
- at last fixed parsing of Delphi's escaped apostrophes in strings
- in Ruby fixed highlighting of keywords 'def' and 'class', same for 'sub' in
  Perl


## Version 2.0

- Ruby support by [Anton Kovalyov][ak]
- speed increased by orders of magnitude due to new way of parsing
- this same way allows now correct highlighting of keywords in some tricky
  places (like keyword "End" at the end of Delphi classes)

[ak]: http://anton.kovalyov.net/


## Version 1.0

Version 1.0 of javascript syntax highlighter is released!

It's the first version available with English description. Feel free to post
your comments and question to [highlight.js forum][forum]. And don't be afraid
if you find there some fancy Cyrillic letters -- it's for Russian users too :-)

[forum]: http://softwaremaniacs.org/forum/viewforum.php?id=6
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# Highlight.js

[![Build Status](https://travis-ci.org/isagalaev/highlight.js.svg?branch=master)](https://travis-ci.org/isagalaev/highlight.js)

Highlight.js is a syntax highlighter written in JavaScript. It works in the
browser as well as on the server. It works with pretty much any markup,
doesn't depend on any framework and has automatic language detection.


## Getting Started

The bare minimum for using highlight.js on a web page is linking to the library
along with one of the styles and calling [`initHighlightingOnLoad`][1]:

```html
<link rel="stylesheet" href="/path/to/styles/default.css">
<script src="/path/to/highlight.pack.js"></script>
<script>hljs.initHighlightingOnLoad();</script>
```

This will find and highlight code inside of `<pre><code>` tags trying to detect
the language automatically. If automatic detection doesn't work for you, you can
specify the language in the class attribute:

```html
<pre><code class="html">...</code></pre>
```

The list of supported language classes is available in the [class reference][8].
Classes can also be prefixed with either `language-` or `lang-`.

To disable highlighting altogether use the `nohighlight` class:

```html
<pre><code class="nohighlight">...</code></pre>
```

## Custom Initialization

When you need a bit more control over the initialization of
highlight.js, you can use the [`highlightBlock`][2] and [`configure`][3]
functions. This allows you to control *what* to highlight and *when*.

Here's an equivalent way to calling [`initHighlightingOnLoad`][1] using jQuery:

```javascript
$(document).ready(function() {
  $('pre code').each(function(i, block) {
    hljs.highlightBlock(block);
  });
});
```

You can use any tags instead of `<pre><code>` to mark up your code. If you don't
use a container that preserve line breaks you will need to configure
highlight.js to use the `<br>` tag:

```javascript
hljs.configure({useBR: true});

$('div.code').each(function(i, block) {
  hljs.highlightBlock(block);
});
```

For other options refer to the documentation for [`configure`][3].


## Getting the Library

You can get highlight.js as a hosted or custom-build browser script or as a
server module. Head over to the [download page][4] for all the options.

Note, that the library is not supposed to work straight from the source on
GitHub, it requires building. If none of the pre-packaged options work for you
refer to the [building documentation][5].


## License

Highlight.js is released under the BSD License. See [LICENSE][10] file for
details.


## Links

The official site for the library is at <https://highlightjs.org/>.

Further in-depth documentation for the API and other topics is at
<http://highlightjs.readthedocs.org/>.

Authors and contributors are listed in the [AUTHORS.en.txt][9] file.

[1]: http://highlightjs.readthedocs.org/en/latest/api.html#inithighlightingonload
[2]: http://highlightjs.readthedocs.org/en/latest/api.html#highlightblock-block
[3]: http://highlightjs.readthedocs.org/en/latest/api.html#configure-options
[4]: https://highlightjs.org/download/
[5]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[8]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[9]: https://github.com/isagalaev/highlight.js/blob/master/AUTHORS.en.txt
[10]: https://github.com/isagalaev/highlight.js/blob/master/LICENSE
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/*! highlight.js v9.2.0 | BSD3 License | git.io/hljslicense */
!function(e){var n="object"==typeof window&&window||"object"==typeof self&&self;"undefined"!=typeof exports?e(exports):n&&(n.hljs=e({}),"function"==typeof define&&define.amd&&define([],function(){return n.hljs}))}(function(e){function n(e){return e.replace(/&/gm,"&amp;").replace(/</gm,"&lt;").replace(/>/gm,"&gt;")}function t(e){return e.nodeName.toLowerCase()}function r(e,n){var t=e&&e.exec(n);return t&&0==t.index}function a(e){return/^(no-?highlight|plain|text)$/i.test(e)}function i(e){var n,t,r,i=e.className+" ";if(i+=e.parentNode?e.parentNode.className:"",t=/\blang(?:uage)?-([\w-]+)\b/i.exec(i))return w(t[1])?t[1]:"no-highlight";for(i=i.split(/\s+/),n=0,r=i.length;r>n;n++)if(w(i[n])||a(i[n]))return i[n]}function o(e,n){var t,r={};for(t in e)r[t]=e[t];if(n)for(t in n)r[t]=n[t];return r}function u(e){var n=[];return function r(e,a){for(var i=e.firstChild;i;i=i.nextSibling)3==i.nodeType?a+=i.nodeValue.length:1==i.nodeType&&(n.push({event:"start",offset:a,node:i}),a=r(i,a),t(i).match(/br|hr|img|input/)||n.push({event:"stop",offset:a,node:i}));return a}(e,0),n}function c(e,r,a){function i(){return e.length&&r.length?e[0].offset!=r[0].offset?e[0].offset<r[0].offset?e:r:"start"==r[0].event?e:r:e.length?e:r}function o(e){function r(e){return" "+e.nodeName+'="'+n(e.value)+'"'}f+="<"+t(e)+Array.prototype.map.call(e.attributes,r).join("")+">"}function u(e){f+="</"+t(e)+">"}function c(e){("start"==e.event?o:u)(e.node)}for(var s=0,f="",l=[];e.length||r.length;){var g=i();if(f+=n(a.substr(s,g[0].offset-s)),s=g[0].offset,g==e){l.reverse().forEach(u);do c(g.splice(0,1)[0]),g=i();while(g==e&&g.length&&g[0].offset==s);l.reverse().forEach(o)}else"start"==g[0].event?l.push(g[0].node):l.pop(),c(g.splice(0,1)[0])}return f+n(a.substr(s))}function s(e){function n(e){return e&&e.source||e}function t(t,r){return new RegExp(n(t),"m"+(e.cI?"i":"")+(r?"g":""))}function r(a,i){if(!a.compiled){if(a.compiled=!0,a.k=a.k||a.bK,a.k){var u={},c=function(n,t){e.cI&&(t=t.toLowerCase()),t.split(" ").forEach(function(e){var t=e.split("|");u[t[0]]=[n,t[1]?Number(t[1]):1]})};"string"==typeof a.k?c("keyword",a.k):Object.keys(a.k).forEach(function(e){c(e,a.k[e])}),a.k=u}a.lR=t(a.l||/\b\w+\b/,!0),i&&(a.bK&&(a.b="\\b("+a.bK.split(" ").join("|")+")\\b"),a.b||(a.b=/\B|\b/),a.bR=t(a.b),a.e||a.eW||(a.e=/\B|\b/),a.e&&(a.eR=t(a.e)),a.tE=n(a.e)||"",a.eW&&i.tE&&(a.tE+=(a.e?"|":"")+i.tE)),a.i&&(a.iR=t(a.i)),void 0===a.r&&(a.r=1),a.c||(a.c=[]);var s=[];a.c.forEach(function(e){e.v?e.v.forEach(function(n){s.push(o(e,n))}):s.push("self"==e?a:e)}),a.c=s,a.c.forEach(function(e){r(e,a)}),a.starts&&r(a.starts,i);var f=a.c.map(function(e){return e.bK?"\\.?("+e.b+")\\.?":e.b}).concat([a.tE,a.i]).map(n).filter(Boolean);a.t=f.length?t(f.join("|"),!0):{exec:function(){return null}}}}r(e)}function f(e,t,a,i){function o(e,n){for(var t=0;t<n.c.length;t++)if(r(n.c[t].bR,e))return n.c[t]}function u(e,n){if(r(e.eR,n)){for(;e.endsParent&&e.parent;)e=e.parent;return e}return e.eW?u(e.parent,n):void 0}function c(e,n){return!a&&r(n.iR,e)}function g(e,n){var t=N.cI?n[0].toLowerCase():n[0];return e.k.hasOwnProperty(t)&&e.k[t]}function p(e,n,t,r){var a=r?"":E.classPrefix,i='<span class="'+a,o=t?"":"</span>";return i+=e+'">',i+n+o}function h(){if(!k.k)return n(M);var e="",t=0;k.lR.lastIndex=0;for(var r=k.lR.exec(M);r;){e+=n(M.substr(t,r.index-t));var a=g(k,r);a?(B+=a[1],e+=p(a[0],n(r[0]))):e+=n(r[0]),t=k.lR.lastIndex,r=k.lR.exec(M)}return e+n(M.substr(t))}function d(){var e="string"==typeof k.sL;if(e&&!R[k.sL])return n(M);var t=e?f(k.sL,M,!0,y[k.sL]):l(M,k.sL.length?k.sL:void 0);return k.r>0&&(B+=t.r),e&&(y[k.sL]=t.top),p(t.language,t.value,!1,!0)}function b(){L+=void 0!==k.sL?d():h(),M=""}function v(e,n){L+=e.cN?p(e.cN,"",!0):"",k=Object.create(e,{parent:{value:k}})}function m(e,n){if(M+=e,void 0===n)return b(),0;var t=o(n,k);if(t)return t.skip?M+=n:(t.eB&&(M+=n),b(),t.rB||t.eB||(M=n)),v(t,n),t.rB?0:n.length;var r=u(k,n);if(r){var a=k;a.skip?M+=n:(a.rE||a.eE||(M+=n),b(),a.eE&&(M=n));do k.cN&&(L+="</span>"),k.skip||(B+=k.r),k=k.parent;while(k!=r.parent);return r.starts&&v(r.starts,""),a.rE?0:n.length}if(c(n,k))throw new Error('Illegal lexeme "'+n+'" for mode "'+(k.cN||"<unnamed>")+'"');return M+=n,n.length||1}var N=w(e);if(!N)throw new Error('Unknown language: "'+e+'"');s(N);var x,k=i||N,y={},L="";for(x=k;x!=N;x=x.parent)x.cN&&(L=p(x.cN,"",!0)+L);var M="",B=0;try{for(var C,j,I=0;;){if(k.t.lastIndex=I,C=k.t.exec(t),!C)break;j=m(t.substr(I,C.index-I),C[0]),I=C.index+j}for(m(t.substr(I)),x=k;x.parent;x=x.parent)x.cN&&(L+="</span>");return{r:B,value:L,language:e,top:k}}catch(O){if(-1!=O.message.indexOf("Illegal"))return{r:0,value:n(t)};throw O}}function l(e,t){t=t||E.languages||Object.keys(R);var r={r:0,value:n(e)},a=r;return t.forEach(function(n){if(w(n)){var t=f(n,e,!1);t.language=n,t.r>a.r&&(a=t),t.r>r.r&&(a=r,r=t)}}),a.language&&(r.second_best=a),r}function g(e){return E.tabReplace&&(e=e.replace(/^((<[^>]+>|\t)+)/gm,function(e,n){return n.replace(/\t/g,E.tabReplace)})),E.useBR&&(e=e.replace(/\n/g,"<br>")),e}function p(e,n,t){var r=n?x[n]:t,a=[e.trim()];return e.match(/\bhljs\b/)||a.push("hljs"),-1===e.indexOf(r)&&a.push(r),a.join(" ").trim()}function h(e){var n=i(e);if(!a(n)){var t;E.useBR?(t=document.createElementNS("http://www.w3.org/1999/xhtml","div"),t.innerHTML=e.innerHTML.replace(/\n/g,"").replace(/<br[ \/]*>/g,"\n")):t=e;var r=t.textContent,o=n?f(n,r,!0):l(r),s=u(t);if(s.length){var h=document.createElementNS("http://www.w3.org/1999/xhtml","div");h.innerHTML=o.value,o.value=c(s,u(h),r)}o.value=g(o.value),e.innerHTML=o.value,e.className=p(e.className,n,o.language),e.result={language:o.language,re:o.r},o.second_best&&(e.second_best={language:o.second_best.language,re:o.second_best.r})}}function d(e){E=o(E,e)}function b(){if(!b.called){b.called=!0;var e=document.querySelectorAll("pre code");Array.prototype.forEach.call(e,h)}}function v(){addEventListener("DOMContentLoaded",b,!1),addEventListener("load",b,!1)}function m(n,t){var r=R[n]=t(e);r.aliases&&r.aliases.forEach(function(e){x[e]=n})}function N(){return Object.keys(R)}function w(e){return e=(e||"").toLowerCase(),R[e]||R[x[e]]}var E={classPrefix:"hljs-",tabReplace:null,useBR:!1,languages:void 0},R={},x={};return e.highlight=f,e.highlightAuto=l,e.fixMarkup=g,e.highlightBlock=h,e.configure=d,e.initHighlighting=b,e.initHighlightingOnLoad=v,e.registerLanguage=m,e.listLanguages=N,e.getLanguage=w,e.inherit=o,e.IR="[a-zA-Z]\\w*",e.UIR="[a-zA-Z_]\\w*",e.NR="\\b\\d+(\\.\\d+)?",e.CNR="(-?)(\\b0[xX][a-fA-F0-9]+|(\\b\\d+(\\.\\d*)?|\\.\\d+)([eE][-+]?\\d+)?)",e.BNR="\\b(0b[01]+)",e.RSR="!|!=|!==|%|%=|&|&&|&=|\\*|\\*=|\\+|\\+=|,|-|-=|/=|/|:|;|<<|<<=|<=|<|===|==|=|>>>=|>>=|>=|>>>|>>|>|\\?|\\[|\\{|\\(|\\^|\\^=|\\||\\|=|\\|\\||~",e.BE={b:"\\\\[\\s\\S]",r:0},e.ASM={cN:"string",b:"'",e:"'",i:"\\n",c:[e.BE]},e.QSM={cN:"string",b:'"',e:'"',i:"\\n",c:[e.BE]},e.PWM={b:/\b(a|an|the|are|I|I'm|isn't|don't|doesn't|won't|but|just|should|pretty|simply|enough|gonna|going|wtf|so|such|will|you|your|like)\b/},e.C=function(n,t,r){var a=e.inherit({cN:"comment",b:n,e:t,c:[]},r||{});return a.c.push(e.PWM),a.c.push({cN:"doctag",b:"(?:TODO|FIXME|NOTE|BUG|XXX):",r:0}),a},e.CLCM=e.C("//","$"),e.CBCM=e.C("/\\*","\\*/"),e.HCM=e.C("#","$"),e.NM={cN:"number",b:e.NR,r:0},e.CNM={cN:"number",b:e.CNR,r:0},e.BNM={cN:"number",b:e.BNR,r:0},e.CSSNM={cN:"number",b:e.NR+"(%|em|ex|ch|rem|vw|vh|vmin|vmax|cm|mm|in|pt|pc|px|deg|grad|rad|turn|s|ms|Hz|kHz|dpi|dpcm|dppx)?",r:0},e.RM={cN:"regexp",b:/\//,e:/\/[gimuy]*/,i:/\n/,c:[e.BE,{b:/\[/,e:/\]/,r:0,c:[e.BE]}]},e.TM={cN:"title",b:e.IR,r:0},e.UTM={cN:"title",b:e.UIR,r:0},e.METHOD_GUARD={b:"\\.\\s*"+e.UIR,r:0},e});hljs.registerLanguage("basic",function(E){return{cI:!0,i:"^.",l:"[a-zA-Z][a-zA-Z0-9_$%!#]*",k:{keyword:"ABS ASC AND ATN AUTO|0 BEEP BLOAD|10 BSAVE|10 CALL CALLS CDBL CHAIN CHDIR CHR$|10 CINT CIRCLE CLEAR CLOSE CLS COLOR COM COMMON CONT COS CSNG CSRLIN CVD CVI CVS DATA DATE$ DEFDBL DEFINT DEFSNG DEFSTR DEF|0 SEG USR DELETE DIM DRAW EDIT END ENVIRON ENVIRON$ EOF EQV ERASE ERDEV ERDEV$ ERL ERR ERROR EXP FIELD FILES FIX FOR|0 FRE GET GOSUB|10 GOTO HEX$ IF|0 THEN ELSE|0 INKEY$ INP INPUT INPUT# INPUT$ INSTR IMP INT IOCTL IOCTL$ KEY ON OFF LIST KILL LEFT$ LEN LET LINE LLIST LOAD LOC LOCATE LOF LOG LPRINT USING LSET MERGE MID$ MKDIR MKD$ MKI$ MKS$ MOD NAME NEW NEXT NOISE NOT OCT$ ON OR PEN PLAY STRIG OPEN OPTION BASE OUT PAINT PALETTE PCOPY PEEK PMAP POINT POKE POS PRINT PRINT] PSET PRESET PUT RANDOMIZE READ REM RENUM RESET|0 RESTORE RESUME RETURN|0 RIGHT$ RMDIR RND RSET RUN SAVE SCREEN SGN SHELL SIN SOUND SPACE$ SPC SQR STEP STICK STOP STR$ STRING$ SWAP SYSTEM TAB TAN TIME$ TIMER TROFF TRON TO USR VAL VARPTR VARPTR$ VIEW WAIT WHILE WEND WIDTH WINDOW WRITE XOR"},c:[E.QSM,E.C("REM","$",{r:10}),E.C("'","$",{r:0}),{cN:"symbol",b:"^[0-9]+ ",r:10},{cN:"number",b:"\\b([0-9]+[0-9edED.]*[#!]?)",r:0},{cN:"number",b:"(&[hH][0-9a-fA-F]{1,4})"},{cN:"number",b:"(&[oO][0-7]{1,6})"}]}});hljs.registerLanguage("vbnet",function(e){return{aliases:["vb"],cI:!0,k:{keyword:"addhandler addressof alias and andalso aggregate ansi as assembly auto binary by byref byval call case catch class compare const continue custom declare default delegate dim distinct do each equals else elseif end enum erase error event exit explicit finally for friend from function get global goto group handles if implements imports in inherits interface into is isfalse isnot istrue join key let lib like loop me mid mod module mustinherit mustoverride mybase myclass namespace narrowing new next not notinheritable notoverridable of off on operator option optional or order orelse overloads overridable overrides paramarray partial preserve private property protected public raiseevent readonly redim rem removehandler resume return select set shadows shared skip static step stop structure strict sub synclock take text then throw to try unicode until using when where while widening with withevents writeonly xor",built_in:"boolean byte cbool cbyte cchar cdate cdec cdbl char cint clng cobj csbyte cshort csng cstr ctype date decimal directcast double gettype getxmlnamespace iif integer long object sbyte short single string trycast typeof uinteger ulong ushort",literal:"true false nothing"},i:"//|{|}|endif|gosub|variant|wend",c:[e.inherit(e.QSM,{c:[{b:'""'}]}),e.C("'","$",{rB:!0,c:[{cN:"doctag",b:"'''|<!--|-->",c:[e.PWM]},{cN:"doctag",b:"</?",e:">",c:[e.PWM]}]}),e.CNM,{cN:"meta",b:"#",e:"$",k:{"meta-keyword":"if else elseif end region externalsource"}}]}});hljs.registerLanguage("dockerfile",function(e){return{aliases:["docker"],cI:!0,k:"from maintainer cmd expose add copy entrypoint volume user workdir onbuild run env label",c:[e.HCM,{k:"run cmd entrypoint volume add copy workdir onbuild label",b:/^ *(onbuild +)?(run|cmd|entrypoint|volume|add|copy|workdir|label) +/,starts:{e:/[^\\]\n/,sL:"bash"}},{k:"from maintainer expose env user onbuild",b:/^ *(onbuild +)?(from|maintainer|expose|env|user|onbuild) +/,e:/[^\\]\n/,c:[e.ASM,e.QSM,e.NM,e.HCM]}]}});hljs.registerLanguage("php",function(e){var c={b:"\\$+[a-zA-Z_�-ÿ][a-zA-Z0-9_�-ÿ]*"},a={cN:"meta",b:/<\?(php)?|\?>/},i={cN:"string",c:[e.BE,a],v:[{b:'b"',e:'"'},{b:"b'",e:"'"},e.inherit(e.ASM,{i:null}),e.inherit(e.QSM,{i:null})]},t={v:[e.BNM,e.CNM]};return{aliases:["php3","php4","php5","php6"],cI:!0,k:"and include_once list abstract global private echo interface as static endswitch array null if endwhile or const for endforeach self var while isset public protected exit foreach throw elseif include __FILE__ empty require_once do xor return parent clone use __CLASS__ __LINE__ else break print eval new catch __METHOD__ case exception default die require __FUNCTION__ enddeclare final try switch continue endfor endif declare unset true false trait goto instanceof insteadof __DIR__ __NAMESPACE__ yield finally",c:[e.HCM,e.C("//","$",{c:[a]}),e.C("/\\*","\\*/",{c:[{cN:"doctag",b:"@[A-Za-z]+"}]}),e.C("__halt_compiler.+?;",!1,{eW:!0,k:"__halt_compiler",l:e.UIR}),{cN:"string",b:/<<<['"]?\w+['"]?$/,e:/^\w+;?$/,c:[e.BE,{cN:"subst",v:[{b:/\$\w+/},{b:/\{\$/,e:/\}/}]}]},a,c,{b:/(::|->)+[a-zA-Z_\x7f-\xff][a-zA-Z0-9_\x7f-\xff]*/},{cN:"function",bK:"function",e:/[;{]/,eE:!0,i:"\\$|\\[|%",c:[e.UTM,{cN:"params",b:"\\(",e:"\\)",c:["self",c,e.CBCM,i,t]}]},{cN:"class",bK:"class interface",e:"{",eE:!0,i:/[:\(\$"]/,c:[{bK:"extends implements"},e.UTM]},{bK:"namespace",e:";",i:/[\.']/,c:[e.UTM]},{bK:"use",e:";",c:[e.UTM]},{b:"=>"},i,t]}});hljs.registerLanguage("haml",function(s){return{cI:!0,c:[{cN:"meta",b:"^!!!( (5|1\\.1|Strict|Frameset|Basic|Mobile|RDFa|XML\\b.*))?$",r:10},s.C("^\\s*(!=#|=#|-#|/).*$",!1,{r:0}),{b:"^\\s*(-|=|!=)(?!#)",starts:{e:"\\n",sL:"ruby"}},{cN:"tag",b:"^\\s*%",c:[{cN:"selector-tag",b:"\\w+"},{cN:"selector-id",b:"#[\\w-]+"},{cN:"selector-class",b:"\\.[\\w-]+"},{b:"{\\s*",e:"\\s*}",c:[{b:":\\w+\\s*=>",e:",\\s+",rB:!0,eW:!0,c:[{cN:"attr",b:":\\w+"},s.ASM,s.QSM,{b:"\\w+",r:0}]}]},{b:"\\(\\s*",e:"\\s*\\)",eE:!0,c:[{b:"\\w+\\s*=",e:"\\s+",rB:!0,eW:!0,c:[{cN:"attr",b:"\\w+",r:0},s.ASM,s.QSM,{b:"\\w+",r:0}]}]}]},{b:"^\\s*[=~]\\s*"},{b:"#{",starts:{e:"}",sL:"ruby"}}]}});hljs.registerLanguage("perl",function(e){var t="getpwent getservent quotemeta msgrcv scalar kill dbmclose undef lc ma syswrite tr send umask sysopen shmwrite vec qx utime local oct semctl localtime readpipe do return format read sprintf dbmopen pop getpgrp not getpwnam rewinddir qqfileno qw endprotoent wait sethostent bless s|0 opendir continue each sleep endgrent shutdown dump chomp connect getsockname die socketpair close flock exists index shmgetsub for endpwent redo lstat msgctl setpgrp abs exit select print ref gethostbyaddr unshift fcntl syscall goto getnetbyaddr join gmtime symlink semget splice x|0 getpeername recv log setsockopt cos last reverse gethostbyname getgrnam study formline endhostent times chop length gethostent getnetent pack getprotoent getservbyname rand mkdir pos chmod y|0 substr endnetent printf next open msgsnd readdir use unlink getsockopt getpriority rindex wantarray hex system getservbyport endservent int chr untie rmdir prototype tell listen fork shmread ucfirst setprotoent else sysseek link getgrgid shmctl waitpid unpack getnetbyname reset chdir grep split require caller lcfirst until warn while values shift telldir getpwuid my getprotobynumber delete and sort uc defined srand accept package seekdir getprotobyname semop our rename seek if q|0 chroot sysread setpwent no crypt getc chown sqrt write setnetent setpriority foreach tie sin msgget map stat getlogin unless elsif truncate exec keys glob tied closedirioctl socket readlink eval xor readline binmode setservent eof ord bind alarm pipe atan2 getgrent exp time push setgrent gt lt or ne m|0 break given say state when",r={cN:"subst",b:"[$@]\\{",e:"\\}",k:t},s={b:"->{",e:"}"},n={v:[{b:/\$\d/},{b:/[\$%@](\^\w\b|#\w+(::\w+)*|{\w+}|\w+(::\w*)*)/},{b:/[\$%@][^\s\w{]/,r:0}]},i=[e.BE,r,n],o=[n,e.HCM,e.C("^\\=\\w","\\=cut",{eW:!0}),s,{cN:"string",c:i,v:[{b:"q[qwxr]?\\s*\\(",e:"\\)",r:5},{b:"q[qwxr]?\\s*\\[",e:"\\]",r:5},{b:"q[qwxr]?\\s*\\{",e:"\\}",r:5},{b:"q[qwxr]?\\s*\\|",e:"\\|",r:5},{b:"q[qwxr]?\\s*\\<",e:"\\>",r:5},{b:"qw\\s+q",e:"q",r:5},{b:"'",e:"'",c:[e.BE]},{b:'"',e:'"'},{b:"`",e:"`",c:[e.BE]},{b:"{\\w+}",c:[],r:0},{b:"-?\\w+\\s*\\=\\>",c:[],r:0}]},{cN:"number",b:"(\\b0[0-7_]+)|(\\b0x[0-9a-fA-F_]+)|(\\b[1-9][0-9_]*(\\.[0-9_]+)?)|[0_]\\b",r:0},{b:"(\\/\\/|"+e.RSR+"|\\b(split|return|print|reverse|grep)\\b)\\s*",k:"split return print reverse grep",r:0,c:[e.HCM,{cN:"regexp",b:"(s|tr|y)/(\\\\.|[^/])*/(\\\\.|[^/])*/[a-z]*",r:10},{cN:"regexp",b:"(m|qr)?/",e:"/[a-z]*",c:[e.BE],r:0}]},{cN:"function",bK:"sub",e:"(\\s*\\(.*?\\))?[;{]",eE:!0,r:5,c:[e.TM]},{b:"-\\w\\b",r:0},{b:"^__DATA__$",e:"^__END__$",sL:"mojolicious",c:[{b:"^@@.*",e:"$",cN:"comment"}]}];return r.c=o,s.c=o,{aliases:["pl"],k:t,c:o}});hljs.registerLanguage("accesslog",function(T){return{c:[{cN:"number",b:"\\b\\d{1,3}\\.\\d{1,3}\\.\\d{1,3}\\.\\d{1,3}(:\\d{1,5})?\\b"},{cN:"number",b:"\\b\\d+\\b",r:0},{cN:"string",b:'"(GET|POST|HEAD|PUT|DELETE|CONNECT|OPTIONS|PATCH|TRACE)',e:'"',k:"GET POST HEAD PUT DELETE CONNECT OPTIONS PATCH TRACE",i:"\\n",r:10},{cN:"string",b:/\[/,e:/\]/,i:"\\n"},{cN:"string",b:'"',e:'"',i:"\\n"}]}});hljs.registerLanguage("d",function(e){var t={keyword:"abstract alias align asm assert auto body break byte case cast catch class const continue debug default delete deprecated do else enum export extern final finally for foreach foreach_reverse|10 goto if immutable import in inout int interface invariant is lazy macro mixin module new nothrow out override package pragma private protected public pure ref return scope shared static struct super switch synchronized template this throw try typedef typeid typeof union unittest version void volatile while with __FILE__ __LINE__ __gshared|10 __thread __traits __DATE__ __EOF__ __TIME__ __TIMESTAMP__ __VENDOR__ __VERSION__",built_in:"bool cdouble cent cfloat char creal dchar delegate double dstring float function idouble ifloat ireal long real short string ubyte ucent uint ulong ushort wchar wstring",literal:"false null true"},r="(0|[1-9][\\d_]*)",a="(0|[1-9][\\d_]*|\\d[\\d_]*|[\\d_]+?\\d)",i="0[bB][01_]+",n="([\\da-fA-F][\\da-fA-F_]*|_[\\da-fA-F][\\da-fA-F_]*)",_="0[xX]"+n,c="([eE][+-]?"+a+")",d="("+a+"(\\.\\d*|"+c+")|\\d+\\."+a+a+"|\\."+r+c+"?)",o="(0[xX]("+n+"\\."+n+"|\\.?"+n+")[pP][+-]?"+a+")",s="("+r+"|"+i+"|"+_+")",l="("+o+"|"+d+")",u="\\\\(['\"\\?\\\\abfnrtv]|u[\\dA-Fa-f]{4}|[0-7]{1,3}|x[\\dA-Fa-f]{2}|U[\\dA-Fa-f]{8})|&[a-zA-Z\\d]{2,};",b={cN:"number",b:"\\b"+s+"(L|u|U|Lu|LU|uL|UL)?",r:0},f={cN:"number",b:"\\b("+l+"([fF]|L|i|[fF]i|Li)?|"+s+"(i|[fF]i|Li))",r:0},g={cN:"string",b:"'("+u+"|.)",e:"'",i:"."},h={b:u,r:0},p={cN:"string",b:'"',c:[h],e:'"[cwd]?'},m={cN:"string",b:'[rq]"',e:'"[cwd]?',r:5},w={cN:"string",b:"`",e:"`[cwd]?"},N={cN:"string",b:'x"[\\da-fA-F\\s\\n\\r]*"[cwd]?',r:10},A={cN:"string",b:'q"\\{',e:'\\}"'},F={cN:"meta",b:"^#!",e:"$",r:5},y={cN:"meta",b:"#(line)",e:"$",r:5},L={cN:"keyword",b:"@[a-zA-Z_][a-zA-Z_\\d]*"},v=e.C("\\/\\+","\\+\\/",{c:["self"],r:10});return{l:e.UIR,k:t,c:[e.CLCM,e.CBCM,v,N,p,m,w,A,f,b,g,F,y,L]}});hljs.registerLanguage("csp",function(r){return{cI:!1,l:"[a-zA-Z][a-zA-Z0-9_-]*",k:{keyword:"base-uri child-src connect-src default-src font-src form-action frame-ancestors frame-src img-src media-src object-src plugin-types report-uri sandbox script-src style-src"},c:[{cN:"string",b:"'",e:"'"},{cN:"attribute",b:"^Content",e:":",eE:!0}]}});hljs.registerLanguage("apache",function(e){var r={cN:"number",b:"[\\$%]\\d+"};return{aliases:["apacheconf"],cI:!0,c:[e.HCM,{cN:"section",b:"</?",e:">"},{cN:"attribute",b:/\w+/,r:0,k:{nomarkup:"order deny allow setenv rewriterule rewriteengine rewritecond documentroot sethandler errordocument loadmodule options header listen serverroot servername"},starts:{e:/$/,r:0,k:{literal:"on off all"},c:[{cN:"meta",b:"\\s\\[",e:"\\]$"},{cN:"variable",b:"[\\$%]\\{",e:"\\}",c:["self",r]},r,e.QSM]}}],i:/\S/}});hljs.registerLanguage("prolog",function(c){var b={b:/[a-z][A-Za-z0-9_]*/,r:0},r={cN:"symbol",v:[{b:/[A-Z][a-zA-Z0-9_]*/},{b:/_[A-Za-z0-9_]*/}],r:0},e={b:/\(/,e:/\)/,r:0},n={b:/\[/,e:/\]/},a={cN:"comment",b:/%/,e:/$/,c:[c.PWM]},t={cN:"string",b:/`/,e:/`/,c:[c.BE]},g={cN:"string",b:/0\'(\\\'|.)/},s={cN:"string",b:/0\'\\s/},o={b:/:-/},N=[b,r,e,o,n,a,c.CBCM,c.QSM,c.ASM,t,g,s,c.CNM];return e.c=N,n.c=N,{c:N.concat([{b:/\.$/}])}});hljs.registerLanguage("lisp",function(b){var e="[a-zA-Z_\\-\\+\\*\\/\\<\\=\\>\\&\\#][a-zA-Z0-9_\\-\\+\\*\\/\\<\\=\\>\\&\\#!]*",c="\\|[^]*?\\|",r="(\\-|\\+)?\\d+(\\.\\d+|\\/\\d+)?((d|e|f|l|s|D|E|F|L|S)(\\+|\\-)?\\d+)?",a={cN:"meta",b:"^#!",e:"$"},l={cN:"literal",b:"\\b(t{1}|nil)\\b"},n={cN:"number",v:[{b:r,r:0},{b:"#(b|B)[0-1]+(/[0-1]+)?"},{b:"#(o|O)[0-7]+(/[0-7]+)?"},{b:"#(x|X)[0-9a-fA-F]+(/[0-9a-fA-F]+)?"},{b:"#(c|C)\\("+r+" +"+r,e:"\\)"}]},i=b.inherit(b.QSM,{i:null}),t=b.C(";","$",{r:0}),s={b:"\\*",e:"\\*"},u={cN:"symbol",b:"[:&]"+e},d={b:e,r:0},f={b:c},m={b:"\\(",e:"\\)",c:["self",l,i,n,d]},o={c:[n,i,s,u,m,d],v:[{b:"['`]\\(",e:"\\)"},{b:"\\(quote ",e:"\\)",k:{name:"quote"}},{b:"'"+c}]},v={v:[{b:"'"+e},{b:"#'"+e+"(::"+e+")*"}]},N={b:"\\(\\s*",e:"\\)"},A={eW:!0,r:0};return N.c=[{cN:"name",v:[{b:e},{b:c}]},A],A.c=[o,v,N,l,n,i,t,s,u,f,d],{i:/\S/,c:[n,a,l,i,t,o,v,N,d]}});hljs.registerLanguage("swift",function(e){var i={keyword:"__COLUMN__ __FILE__ __FUNCTION__ __LINE__ as as! as? associativity break case catch class continue convenience default defer deinit didSet do dynamic dynamicType else enum extension fallthrough false final for func get guard if import in indirect infix init inout internal is lazy left let mutating nil none nonmutating operator optional override postfix precedence prefix private protocol Protocol public repeat required rethrows return right self Self set static struct subscript super switch throw throws true try try! try? Type typealias unowned var weak where while willSet",literal:"true false nil",built_in:"abs advance alignof alignofValue anyGenerator assert assertionFailure bridgeFromObjectiveC bridgeFromObjectiveCUnconditional bridgeToObjectiveC bridgeToObjectiveCUnconditional c contains count countElements countLeadingZeros debugPrint debugPrintln distance dropFirst dropLast dump encodeBitsAsWords enumerate equal fatalError filter find getBridgedObjectiveCType getVaList indices insertionSort isBridgedToObjectiveC isBridgedVerbatimToObjectiveC isUniquelyReferenced isUniquelyReferencedNonObjC join lazy lexicographicalCompare map max maxElement min minElement numericCast overlaps partition posix precondition preconditionFailure print println quickSort readLine reduce reflect reinterpretCast reverse roundUpToAlignment sizeof sizeofValue sort split startsWith stride strideof strideofValue swap toString transcode underestimateCount unsafeAddressOf unsafeBitCast unsafeDowncast unsafeUnwrap unsafeReflect withExtendedLifetime withObjectAtPlusZero withUnsafePointer withUnsafePointerToObject withUnsafeMutablePointer withUnsafeMutablePointers withUnsafePointer withUnsafePointers withVaList zip"},t={cN:"type",b:"\\b[A-Z][\\w']*",r:0},n=e.C("/\\*","\\*/",{c:["self"]}),r={cN:"subst",b:/\\\(/,e:"\\)",k:i,c:[]},a={cN:"number",b:"\\b([\\d_]+(\\.[\\deE_]+)?|0x[a-fA-F0-9_]+(\\.[a-fA-F0-9p_]+)?|0b[01_]+|0o[0-7_]+)\\b",r:0},o=e.inherit(e.QSM,{c:[r,e.BE]});return r.c=[a],{k:i,c:[o,e.CLCM,n,t,a,{cN:"function",bK:"func",e:"{",eE:!0,c:[e.inherit(e.TM,{b:/[A-Za-z$_][0-9A-Za-z$_]*/,i:/\(/}),{b:/</,e:/>/,i:/>/},{cN:"params",b:/\(/,e:/\)/,endsParent:!0,k:i,c:["self",a,o,e.CBCM,{b:":"}],i:/["']/}],i:/\[|%/},{cN:"class",bK:"struct protocol class extension enum",k:i,e:"\\{",eE:!0,c:[e.inherit(e.TM,{b:/[A-Za-z$_][0-9A-Za-z$_]*/})]},{cN:"meta",b:"(@warn_unused_result|@exported|@lazy|@noescape|@NSCopying|@NSManaged|@objc|@convention|@required|@noreturn|@IBAction|@IBDesignable|@IBInspectable|@IBOutlet|@infix|@prefix|@postfix|@autoclosure|@testable|@available|@nonobjc|@NSApplicationMain|@UIApplicationMain)"},{bK:"import",e:/$/,c:[e.CLCM,n]}]}});hljs.registerLanguage("java",function(e){var a=e.UIR+"(<"+e.UIR+"(\\s*,\\s*"+e.UIR+")*>)?",t="false synchronized int abstract float private char boolean static null if const for true while long strictfp finally protected import native final void enum else break transient catch instanceof byte super volatile case assert short package default double public try this switch continue throws protected public private",r="\\b(0[bB]([01]+[01_]+[01]+|[01]+)|0[xX]([a-fA-F0-9]+[a-fA-F0-9_]+[a-fA-F0-9]+|[a-fA-F0-9]+)|(([\\d]+[\\d_]+[\\d]+|[\\d]+)(\\.([\\d]+[\\d_]+[\\d]+|[\\d]+))?|\\.([\\d]+[\\d_]+[\\d]+|[\\d]+))([eE][-+]?\\d+)?)[lLfF]?",c={cN:"number",b:r,r:0};return{aliases:["jsp"],k:t,i:/<\/|#/,c:[e.C("/\\*\\*","\\*/",{r:0,c:[{b:/\w+@/,r:0},{cN:"doctag",b:"@[A-Za-z]+"}]}),e.CLCM,e.CBCM,e.ASM,e.QSM,{cN:"class",bK:"class interface",e:/[{;=]/,eE:!0,k:"class interface",i:/[:"\[\]]/,c:[{bK:"extends implements"},e.UTM]},{bK:"new throw return else",r:0},{cN:"function",b:"("+a+"\\s+)+"+e.UIR+"\\s*\\(",rB:!0,e:/[{;=]/,eE:!0,k:t,c:[{b:e.UIR+"\\s*\\(",rB:!0,r:0,c:[e.UTM]},{cN:"params",b:/\(/,e:/\)/,k:t,r:0,c:[e.ASM,e.QSM,e.CNM,e.CBCM]},e.CLCM,e.CBCM]},c,{cN:"meta",b:"@[A-Za-z]+"}]}});hljs.registerLanguage("objectivec",function(e){var t={cN:"built_in",b:"(AV|CA|CF|CG|CI|MK|MP|NS|UI|XC)\\w+"},i={keyword:"int float while char export sizeof typedef const struct for union unsigned long volatile static bool mutable if do return goto void enum else break extern asm case short default double register explicit signed typename this switch continue wchar_t inline readonly assign readwrite self @synchronized id typeof nonatomic super unichar IBOutlet IBAction strong weak copy in out inout bycopy byref oneway __strong __weak __block __autoreleasing @private @protected @public @try @property @end @throw @catch @finally @autoreleasepool @synthesize @dynamic @selector @optional @required",literal:"false true FALSE TRUE nil YES NO NULL",built_in:"BOOL dispatch_once_t dispatch_queue_t dispatch_sync dispatch_async dispatch_once"},n=/[a-zA-Z@][a-zA-Z0-9_]*/,o="@interface @class @protocol @implementation";return{aliases:["mm","objc","obj-c"],k:i,l:n,i:"</",c:[t,e.CLCM,e.CBCM,e.CNM,e.QSM,{cN:"string",v:[{b:'@"',e:'"',i:"\\n",c:[e.BE]},{b:"'",e:"[^\\\\]'",i:"[^\\\\][^']"}]},{cN:"meta",b:"#",e:"$",c:[{cN:"meta-string",v:[{b:'"',e:'"'},{b:"<",e:">"}]}]},{cN:"class",b:"("+o.split(" ").join("|")+")\\b",e:"({|$)",eE:!0,k:o,l:n,c:[e.UTM]},{b:"\\."+e.UIR,r:0}]}});hljs.registerLanguage("json",function(e){var i={literal:"true false null"},n=[e.QSM,e.CNM],r={e:",",eW:!0,eE:!0,c:n,k:i},t={b:"{",e:"}",c:[{cN:"attr",b:/"/,e:/"/,c:[e.BE],i:"\\n"},e.inherit(r,{b:/:/})],i:"\\S"},c={b:"\\[",e:"\\]",c:[e.inherit(r)],i:"\\S"};return n.splice(n.length,0,t,c),{c:n,k:i,i:"\\S"}});hljs.registerLanguage("cmake",function(e){return{aliases:["cmake.in"],cI:!0,k:{keyword:"add_custom_command add_custom_target add_definitions add_dependencies add_executable add_library add_subdirectory add_test aux_source_directory break build_command cmake_minimum_required cmake_policy configure_file create_test_sourcelist define_property else elseif enable_language enable_testing endforeach endfunction endif endmacro endwhile execute_process export find_file find_library find_package find_path find_program fltk_wrap_ui foreach function get_cmake_property get_directory_property get_filename_component get_property get_source_file_property get_target_property get_test_property if include include_directories include_external_msproject include_regular_expression install link_directories load_cache load_command macro mark_as_advanced message option output_required_files project qt_wrap_cpp qt_wrap_ui remove_definitions return separate_arguments set set_directory_properties set_property set_source_files_properties set_target_properties set_tests_properties site_name source_group string target_link_libraries try_compile try_run unset variable_watch while build_name exec_program export_library_dependencies install_files install_programs install_targets link_libraries make_directory remove subdir_depends subdirs use_mangled_mesa utility_source variable_requires write_file qt5_use_modules qt5_use_package qt5_wrap_cpp on off true false and or equal less greater strless strgreater strequal matches"},c:[{cN:"variable",b:"\\${",e:"}"},e.HCM,e.QSM,e.NM]}});hljs.registerLanguage("bash",function(e){var t={cN:"variable",v:[{b:/\$[\w\d#@][\w\d_]*/},{b:/\$\{(.*?)}/}]},s={cN:"string",b:/"/,e:/"/,c:[e.BE,t,{cN:"variable",b:/\$\(/,e:/\)/,c:[e.BE]}]},a={cN:"string",b:/'/,e:/'/};return{aliases:["sh","zsh"],l:/-?[a-z\.]+/,k:{keyword:"if then else elif fi for while in do done case esac function",literal:"true false",built_in:"break cd continue eval exec exit export getopts hash pwd readonly return shift test times trap umask unset alias bind builtin caller command declare echo enable help let local logout mapfile printf read readarray source type typeset ulimit unalias set shopt autoload bg bindkey bye cap chdir clone comparguments compcall compctl compdescribe compfiles compgroups compquote comptags comptry compvalues dirs disable disown echotc echoti emulate fc fg float functions getcap getln history integer jobs kill limit log noglob popd print pushd pushln rehash sched setcap setopt stat suspend ttyctl unfunction unhash unlimit unsetopt vared wait whence where which zcompile zformat zftp zle zmodload zparseopts zprof zpty zregexparse zsocket zstyle ztcp",_:"-ne -eq -lt -gt -f -d -e -s -l -a"},c:[{cN:"meta",b:/^#![^\n]+sh\s*$/,r:10},{cN:"function",b:/\w[\w\d_]*\s*\(\s*\)\s*\{/,rB:!0,c:[e.inherit(e.TM,{b:/\w[\w\d_]*/})],r:0},e.HCM,s,a,t]}});hljs.registerLanguage("cs",function(e){var t="abstract as base bool break byte case catch char checked const continue decimal dynamic default delegate do double else enum event explicit extern false finally fixed float for foreach goto if implicit in int interface internal is lock long null when object operator out override params private protected public readonly ref sbyte sealed short sizeof stackalloc static string struct switch this true try typeof uint ulong unchecked unsafe ushort using virtual volatile void while async protected public private internal ascending descending from get group into join let orderby partial select set value var where yield",r=e.IR+"(<"+e.IR+">)?";return{aliases:["csharp"],k:t,i:/::/,c:[e.C("///","$",{rB:!0,c:[{cN:"doctag",v:[{b:"///",r:0},{b:"<!--|-->"},{b:"</?",e:">"}]}]}),e.CLCM,e.CBCM,{cN:"meta",b:"#",e:"$",k:{"meta-keyword":"if else elif endif define undef warning error line region endregion pragma checksum"}},{cN:"string",b:'@"',e:'"',c:[{b:'""'}]},e.ASM,e.QSM,e.CNM,{bK:"class interface",e:/[{;=]/,i:/[^\s:]/,c:[e.TM,e.CLCM,e.CBCM]},{bK:"namespace",e:/[{;=]/,i:/[^\s:]/,c:[e.inherit(e.TM,{b:"[a-zA-Z](\\.?\\w)*"}),e.CLCM,e.CBCM]},{bK:"new return throw await",r:0},{cN:"function",b:"("+r+"\\s+)+"+e.IR+"\\s*\\(",rB:!0,e:/[{;=]/,eE:!0,k:t,c:[{b:e.IR+"\\s*\\(",rB:!0,c:[e.TM],r:0},{cN:"params",b:/\(/,e:/\)/,eB:!0,eE:!0,k:t,r:0,c:[e.ASM,e.QSM,e.CNM,e.CBCM]},e.CLCM,e.CBCM]}]}});hljs.registerLanguage("livescript",function(e){var t={keyword:"in if for while finally new do return else break catch instanceof throw try this switch continue typeof delete debugger case default function var with then unless until loop of by when and or is isnt not it that otherwise from to til fallthrough super case default function var void const let enum export import native __hasProp __extends __slice __bind __indexOf",literal:"true false null undefined yes no on off it that void",built_in:"npm require console print module global window document"},s="[A-Za-z$_](?:-[0-9A-Za-z$_]|[0-9A-Za-z$_])*",n=e.inherit(e.TM,{b:s}),i={cN:"subst",b:/#\{/,e:/}/,k:t},r={cN:"subst",b:/#[A-Za-z$_]/,e:/(?:\-[0-9A-Za-z$_]|[0-9A-Za-z$_])*/,k:t},c=[e.BNM,{cN:"number",b:"(\\b0[xX][a-fA-F0-9_]+)|(\\b\\d(\\d|_\\d)*(\\.(\\d(\\d|_\\d)*)?)?(_*[eE]([-+]\\d(_\\d|\\d)*)?)?[_a-z]*)",r:0,starts:{e:"(\\s*/)?",r:0}},{cN:"string",v:[{b:/'''/,e:/'''/,c:[e.BE]},{b:/'/,e:/'/,c:[e.BE]},{b:/"""/,e:/"""/,c:[e.BE,i,r]},{b:/"/,e:/"/,c:[e.BE,i,r]},{b:/\\/,e:/(\s|$)/,eE:!0}]},{cN:"regexp",v:[{b:"//",e:"//[gim]*",c:[i,e.HCM]},{b:/\/(?![ *])(\\\/|.)*?\/[gim]*(?=\W|$)/}]},{b:"@"+s},{b:"``",e:"``",eB:!0,eE:!0,sL:"javascript"}];i.c=c;var a={cN:"params",b:"\\(",rB:!0,c:[{b:/\(/,e:/\)/,k:t,c:["self"].concat(c)}]};return{aliases:["ls"],k:t,i:/\/\*/,c:c.concat([e.C("\\/\\*","\\*\\/"),e.HCM,{cN:"function",c:[n,a],rB:!0,v:[{b:"("+s+"\\s*(?:=|:=)\\s*)?(\\(.*\\))?\\s*\\B\\->\\*?",e:"\\->\\*?"},{b:"("+s+"\\s*(?:=|:=)\\s*)?!?(\\(.*\\))?\\s*\\B[-~]{1,2}>\\*?",e:"[-~]{1,2}>\\*?"},{b:"("+s+"\\s*(?:=|:=)\\s*)?(\\(.*\\))?\\s*\\B!?[-~]{1,2}>\\*?",e:"!?[-~]{1,2}>\\*?"}]},{cN:"class",bK:"class",e:"$",i:/[:="\[\]]/,c:[{bK:"extends",eW:!0,i:/[:="\[\]]/,c:[n]},n]},{b:s+":",e:":",rB:!0,rE:!0,r:0}])}});hljs.registerLanguage("makefile",function(e){var a={cN:"variable",b:/\$\(/,e:/\)/,c:[e.BE]};return{aliases:["mk","mak"],c:[e.HCM,{b:/^\w+\s*\W*=/,rB:!0,r:0,starts:{e:/\s*\W*=/,eE:!0,starts:{e:/$/,r:0,c:[a]}}},{cN:"section",b:/^[\w]+:\s*$/},{cN:"meta",b:/^\.PHONY:/,e:/$/,k:{"meta-keyword":".PHONY"},l:/[\.\w]+/},{b:/^\t+/,e:/$/,r:0,c:[e.QSM,a]}]}});hljs.registerLanguage("yaml",function(e){var a={literal:"{ } true false yes no Yes No True False null"},b="^[ \\-]*",r="[a-zA-Z_][\\w\\-]*",t={cN:"attr",v:[{b:b+r+":"},{b:b+'"'+r+'":'},{b:b+"'"+r+"':"}]},c={cN:"template-variable",v:[{b:"{{",e:"}}"},{b:"%{",e:"}"}]},l={cN:"string",r:0,v:[{b:/'/,e:/'/},{b:/"/,e:/"/}],c:[e.BE,c]};return{cI:!0,aliases:["yml","YAML","yaml"],c:[t,{cN:"meta",b:"^---s*$",r:10},{cN:"string",b:"[\\|>] *$",rE:!0,c:l.c,e:t.v[0].b},{b:"<%[%=-]?",e:"[%-]?%>",sL:"ruby",eB:!0,eE:!0,r:0},{cN:"type",b:"!!"+e.UIR},{cN:"meta",b:"&"+e.UIR+"$"},{cN:"meta",b:"\\*"+e.UIR+"$"},{cN:"bullet",b:"^ *-",r:0},l,e.HCM,e.CNM],k:a}});hljs.registerLanguage("dns",function(d){return{aliases:["bind","zone"],k:{keyword:"IN A AAAA AFSDB APL CAA CDNSKEY CDS CERT CNAME DHCID DLV DNAME DNSKEY DS HIP IPSECKEY KEY KX LOC MX NAPTR NS NSEC NSEC3 NSEC3PARAM PTR RRSIG RP SIG SOA SRV SSHFP TA TKEY TLSA TSIG TXT"},c:[d.C(";","$"),{cN:"meta",b:/^\$(TTL|GENERATE|INCLUDE|ORIGIN)\b/},{cN:"number",b:"((([0-9A-Fa-f]{1,4}:){7}([0-9A-Fa-f]{1,4}|:))|(([0-9A-Fa-f]{1,4}:){6}(:[0-9A-Fa-f]{1,4}|((25[0-5]|2[0-4]\\d|1\\d\\d|[1-9]?\\d)(\\.(25[0-5]|2[0-4]\\d|1\\d\\d|[1-9]?\\d)){3})|:))|(([0-9A-Fa-f]{1,4}:){5}(((:[0-9A-Fa-f]{1,4}){1,2})|:((25[0-5]|2[0-4]\\d|1\\d\\d|[1-9]?\\d)(\\.(25[0-5]|2[0-4]\\d|1\\d\\d|[1-9]?\\d)){3})|:))|(([0-9A-Fa-f]{1,4}:){4}(((:[0-9A-Fa-f]{1,4}){1,3})|((:[0-9A-Fa-f]{1,4})?:((25[0-5]|2[0-4]\\d|1\\d\\d|[1-9]?\\d)(\\.(25[0-5]|2[0-4]\\d|1\\d\\d|[1-9]?\\d)){3}))|:))|(([0-9A-Fa-f]{1,4}:){3}(((:[0-9A-Fa-f]{1,4}){1,4})|((:[0-9A-Fa-f]{1,4}){0,2}:((25[0-5]|2[0-4]\\d|1\\d\\d|[1-9]?\\d)(\\.(25[0-5]|2[0-4]\\d|1\\d\\d|[1-9]?\\d)){3}))|:))|(([0-9A-Fa-f]{1,4}:){2}(((:[0-9A-Fa-f]{1,4}){1,5})|((:[0-9A-Fa-f]{1,4}){0,3}:((25[0-5]|2[0-4]\\d|1\\d\\d|[1-9]?\\d)(\\.(25[0-5]|2[0-4]\\d|1\\d\\d|[1-9]?\\d)){3}))|:))|(([0-9A-Fa-f]{1,4}:){1}(((:[0-9A-Fa-f]{1,4}){1,6})|((:[0-9A-Fa-f]{1,4}){0,4}:((25[0-5]|2[0-4]\\d|1\\d\\d|[1-9]?\\d)(\\.(25[0-5]|2[0-4]\\d|1\\d\\d|[1-9]?\\d)){3}))|:))|(:(((:[0-9A-Fa-f]{1,4}){1,7})|((:[0-9A-Fa-f]{1,4}){0,5}:((25[0-5]|2[0-4]\\d|1\\d\\d|[1-9]?\\d)(\\.(25[0-5]|2[0-4]\\d|1\\d\\d|[1-9]?\\d)){3}))|:)))\\b"},{cN:"number",b:"((25[0-5]|(2[0-4]|1{0,1}[0-9]){0,1}[0-9]).){3,3}(25[0-5]|(2[0-4]|1{0,1}[0-9]){0,1}[0-9])\\b"},d.inherit(d.NM,{b:/\b\d+[dhwm]?/})]}});hljs.registerLanguage("sql",function(e){var t=e.C("--","$");return{cI:!0,i:/[<>{}*]/,c:[{bK:"begin end start commit rollback savepoint lock alter create drop rename call delete do handler insert load replace select truncate update set show pragma grant merge describe use explain help declare prepare execute deallocate release unlock purge reset change stop analyze cache flush optimize repair kill install uninstall checksum restore check backup revoke",e:/;/,eW:!0,k:{keyword:"abort abs absolute acc acce accep accept access accessed accessible account acos action activate add addtime admin administer advanced advise aes_decrypt aes_encrypt after agent aggregate ali alia alias allocate allow alter always analyze ancillary and any anydata anydataset anyschema anytype apply archive archived archivelog are as asc ascii asin assembly assertion associate asynchronous at atan atn2 attr attri attrib attribu attribut attribute attributes audit authenticated authentication authid authors auto autoallocate autodblink autoextend automatic availability avg backup badfile basicfile before begin beginning benchmark between bfile bfile_base big bigfile bin binary_double binary_float binlog bit_and bit_count bit_length bit_or bit_xor bitmap blob_base block blocksize body both bound buffer_cache buffer_pool build bulk by byte byteordermark bytes cache caching call calling cancel capacity cascade cascaded case cast catalog category ceil ceiling chain change changed char_base char_length character_length characters characterset charindex charset charsetform charsetid check checksum checksum_agg child choose chr chunk class cleanup clear client clob clob_base clone close cluster_id cluster_probability cluster_set clustering coalesce coercibility col collate collation collect colu colum column column_value columns columns_updated comment commit compact compatibility compiled complete composite_limit compound compress compute concat concat_ws concurrent confirm conn connec connect connect_by_iscycle connect_by_isleaf connect_by_root connect_time connection consider consistent constant constraint constraints constructor container content contents context contributors controlfile conv convert convert_tz corr corr_k corr_s corresponding corruption cos cost count count_big counted covar_pop covar_samp cpu_per_call cpu_per_session crc32 create creation critical cross cube cume_dist curdate current current_date current_time current_timestamp current_user cursor curtime customdatum cycle data database databases datafile datafiles datalength date_add date_cache date_format date_sub dateadd datediff datefromparts datename datepart datetime2fromparts day day_to_second dayname dayofmonth dayofweek dayofyear days db_role_change dbtimezone ddl deallocate declare decode decompose decrement decrypt deduplicate def defa defau defaul default defaults deferred defi defin define degrees delayed delegate delete delete_all delimited demand dense_rank depth dequeue des_decrypt des_encrypt des_key_file desc descr descri describ describe descriptor deterministic diagnostics difference dimension direct_load directory disable disable_all disallow disassociate discardfile disconnect diskgroup distinct distinctrow distribute distributed div do document domain dotnet double downgrade drop dumpfile duplicate duration each edition editionable editions element ellipsis else elsif elt empty enable enable_all enclosed encode encoding encrypt end end-exec endian enforced engine engines enqueue enterprise entityescaping eomonth error errors escaped evalname evaluate event eventdata events except exception exceptions exchange exclude excluding execu execut execute exempt exists exit exp expire explain export export_set extended extent external external_1 external_2 externally extract failed failed_login_attempts failover failure far fast feature_set feature_value fetch field fields file file_name_convert filesystem_like_logging final finish first first_value fixed flash_cache flashback floor flush following follows for forall force form forma format found found_rows freelist freelists freepools fresh from from_base64 from_days ftp full function general generated get get_format get_lock getdate getutcdate global global_name globally go goto grant grants greatest group group_concat group_id grouping grouping_id groups gtid_subtract guarantee guard handler hash hashkeys having hea head headi headin heading heap help hex hierarchy high high_priority hosts hour http id ident_current ident_incr ident_seed identified identity idle_time if ifnull ignore iif ilike ilm immediate import in include including increment index indexes indexing indextype indicator indices inet6_aton inet6_ntoa inet_aton inet_ntoa infile initial initialized initially initrans inmemory inner innodb input insert install instance instantiable instr interface interleaved intersect into invalidate invisible is is_free_lock is_ipv4 is_ipv4_compat is_not is_not_null is_used_lock isdate isnull isolation iterate java join json json_exists keep keep_duplicates key keys kill language large last last_day last_insert_id last_value lax lcase lead leading least leaves left len lenght length less level levels library like like2 like4 likec limit lines link list listagg little ln load load_file lob lobs local localtime localtimestamp locate locator lock locked log log10 log2 logfile logfiles logging logical logical_reads_per_call logoff logon logs long loop low low_priority lower lpad lrtrim ltrim main make_set makedate maketime managed management manual map mapping mask master master_pos_wait match matched materialized max maxextents maximize maxinstances maxlen maxlogfiles maxloghistory maxlogmembers maxsize maxtrans md5 measures median medium member memcompress memory merge microsecond mid migration min minextents minimum mining minus minute minvalue missing mod mode model modification modify module monitoring month months mount move movement multiset mutex name name_const names nan national native natural nav nchar nclob nested never new newline next nextval no no_write_to_binlog noarchivelog noaudit nobadfile nocheck nocompress nocopy nocycle nodelay nodiscardfile noentityescaping noguarantee nokeep nologfile nomapping nomaxvalue nominimize nominvalue nomonitoring none noneditionable nonschema noorder nopr nopro noprom nopromp noprompt norely noresetlogs noreverse normal norowdependencies noschemacheck noswitch not nothing notice notrim novalidate now nowait nth_value nullif nulls num numb numbe nvarchar nvarchar2 object ocicoll ocidate ocidatetime ociduration ociinterval ociloblocator ocinumber ociref ocirefcursor ocirowid ocistring ocitype oct octet_length of off offline offset oid oidindex old on online only opaque open operations operator optimal optimize option optionally or oracle oracle_date oradata ord ordaudio orddicom orddoc order ordimage ordinality ordvideo organization orlany orlvary out outer outfile outline output over overflow overriding package pad parallel parallel_enable parameters parent parse partial partition partitions pascal passing password password_grace_time password_lock_time password_reuse_max password_reuse_time password_verify_function patch path patindex pctincrease pctthreshold pctused pctversion percent percent_rank percentile_cont percentile_disc performance period period_add period_diff permanent physical pi pipe pipelined pivot pluggable plugin policy position post_transaction pow power pragma prebuilt precedes preceding precision prediction prediction_cost prediction_details prediction_probability prediction_set prepare present preserve prior priority private private_sga privileges procedural procedure procedure_analyze processlist profiles project prompt protection public publishingservername purge quarter query quick quiesce quota quotename radians raise rand range rank raw read reads readsize rebuild record records recover recovery recursive recycle redo reduced ref reference referenced references referencing refresh regexp_like register regr_avgx regr_avgy regr_count regr_intercept regr_r2 regr_slope regr_sxx regr_sxy reject rekey relational relative relaylog release release_lock relies_on relocate rely rem remainder rename repair repeat replace replicate replication required reset resetlogs resize resource respect restore restricted result result_cache resumable resume retention return returning returns reuse reverse revoke right rlike role roles rollback rolling rollup round row row_count rowdependencies rowid rownum rows rtrim rules safe salt sample save savepoint sb1 sb2 sb4 scan schema schemacheck scn scope scroll sdo_georaster sdo_topo_geometry search sec_to_time second section securefile security seed segment select self sequence sequential serializable server servererror session session_user sessions_per_user set sets settings sha sha1 sha2 share shared shared_pool short show shrink shutdown si_averagecolor si_colorhistogram si_featurelist si_positionalcolor si_stillimage si_texture siblings sid sign sin size size_t sizes skip slave sleep smalldatetimefromparts smallfile snapshot some soname sort soundex source space sparse spfile split sql sql_big_result sql_buffer_result sql_cache sql_calc_found_rows sql_small_result sql_variant_property sqlcode sqldata sqlerror sqlname sqlstate sqrt square standalone standby start starting startup statement static statistics stats_binomial_test stats_crosstab stats_ks_test stats_mode stats_mw_test stats_one_way_anova stats_t_test_ stats_t_test_indep stats_t_test_one stats_t_test_paired stats_wsr_test status std stddev stddev_pop stddev_samp stdev stop storage store stored str str_to_date straight_join strcmp strict string struct stuff style subdate subpartition subpartitions substitutable substr substring subtime subtring_index subtype success sum suspend switch switchoffset switchover sync synchronous synonym sys sys_xmlagg sysasm sysaux sysdate sysdatetimeoffset sysdba sysoper system system_user sysutcdatetime table tables tablespace tan tdo template temporary terminated tertiary_weights test than then thread through tier ties time time_format time_zone timediff timefromparts timeout timestamp timestampadd timestampdiff timezone_abbr timezone_minute timezone_region to to_base64 to_date to_days to_seconds todatetimeoffset trace tracking transaction transactional translate translation treat trigger trigger_nestlevel triggers trim truncate try_cast try_convert try_parse type ub1 ub2 ub4 ucase unarchived unbounded uncompress under undo unhex unicode uniform uninstall union unique unix_timestamp unknown unlimited unlock unpivot unrecoverable unsafe unsigned until untrusted unusable unused update updated upgrade upped upper upsert url urowid usable usage use use_stored_outlines user user_data user_resources users using utc_date utc_timestamp uuid uuid_short validate validate_password_strength validation valist value values var var_samp varcharc vari varia variab variabl variable variables variance varp varraw varrawc varray verify version versions view virtual visible void wait wallet warning warnings week weekday weekofyear wellformed when whene whenev wheneve whenever where while whitespace with within without work wrapped xdb xml xmlagg xmlattributes xmlcast xmlcolattval xmlelement xmlexists xmlforest xmlindex xmlnamespaces xmlpi xmlquery xmlroot xmlschema xmlserialize xmltable xmltype xor year year_to_month years yearweek",literal:"true false null",built_in:"array bigint binary bit blob boolean char character date dec decimal float int int8 integer interval number numeric real record serial serial8 smallint text varchar varying void"},c:[{cN:"string",b:"'",e:"'",c:[e.BE,{b:"''"}]},{cN:"string",b:'"',e:'"',c:[e.BE,{b:'""'}]},{cN:"string",b:"`",e:"`",c:[e.BE]},e.CNM,e.CBCM,t]},e.CBCM,t]}});hljs.registerLanguage("python",function(e){var r={cN:"meta",b:/^(>>>|\.\.\.) /},b={cN:"string",c:[e.BE],v:[{b:/(u|b)?r?'''/,e:/'''/,c:[r],r:10},{b:/(u|b)?r?"""/,e:/"""/,c:[r],r:10},{b:/(u|r|ur)'/,e:/'/,r:10},{b:/(u|r|ur)"/,e:/"/,r:10},{b:/(b|br)'/,e:/'/},{b:/(b|br)"/,e:/"/},e.ASM,e.QSM]},a={cN:"number",r:0,v:[{b:e.BNR+"[lLjJ]?"},{b:"\\b(0o[0-7]+)[lLjJ]?"},{b:e.CNR+"[lLjJ]?"}]},l={cN:"params",b:/\(/,e:/\)/,c:["self",r,a,b]};return{aliases:["py","gyp"],k:{keyword:"and elif is global as in if from raise for except finally print import pass return exec else break not with class assert yield try while continue del or def lambda async await nonlocal|10 None True False",built_in:"Ellipsis NotImplemented"},i:/(<\/|->|\?)/,c:[r,a,b,e.HCM,{v:[{cN:"function",bK:"def",r:10},{cN:"class",bK:"class"}],e:/:/,i:/[${=;\n,]/,c:[e.UTM,l,{b:/->/,eW:!0,k:"None"}]},{cN:"meta",b:/^[\t ]*@/,e:/$/},{b:/\b(print|exec)\(/}]}});hljs.registerLanguage("mercury",function(e){var i={keyword:"module use_module import_module include_module end_module initialise mutable initialize finalize finalise interface implementation pred mode func type inst solver any_pred any_func is semidet det nondet multi erroneous failure cc_nondet cc_multi typeclass instance where pragma promise external trace atomic or_else require_complete_switch require_det require_semidet require_multi require_nondet require_cc_multi require_cc_nondet require_erroneous require_failure",meta:"inline no_inline type_spec source_file fact_table obsolete memo loop_check minimal_model terminates does_not_terminate check_termination promise_equivalent_clauses foreign_proc foreign_decl foreign_code foreign_type foreign_import_module foreign_export_enum foreign_export foreign_enum may_call_mercury will_not_call_mercury thread_safe not_thread_safe maybe_thread_safe promise_pure promise_semipure tabled_for_io local untrailed trailed attach_to_io_state can_pass_as_mercury_type stable will_not_throw_exception may_modify_trail will_not_modify_trail may_duplicate may_not_duplicate affects_liveness does_not_affect_liveness doesnt_affect_liveness no_sharing unknown_sharing sharing",built_in:"some all not if then else true fail false try catch catch_any semidet_true semidet_false semidet_fail impure_true impure semipure"},r=e.C("%","$"),t={cN:"number",b:"0'.\\|0[box][0-9a-fA-F]*"},_=e.inherit(e.ASM,{r:0}),n=e.inherit(e.QSM,{r:0}),a={cN:"subst",b:"\\\\[abfnrtv]\\|\\\\x[0-9a-fA-F]*\\\\\\|%[-+# *.0-9]*[dioxXucsfeEgGp]",r:0};n.c.push(a);var o={cN:"built_in",v:[{b:"<=>"},{b:"<=",r:0},{b:"=>",r:0},{b:"/\\\\"},{b:"\\\\/"}]},l={cN:"built_in",v:[{b:":-\\|-->"},{b:"=",r:0}]};return{aliases:["m","moo"],k:i,c:[o,l,r,e.CBCM,t,e.NM,_,n,{b:/:-/}]}});hljs.registerLanguage("haskell",function(e){var i={v:[e.C("--","$"),e.C("{-","-}",{c:["self"]})]},a={cN:"meta",b:"{-#",e:"#-}"},l={cN:"meta",b:"^#",e:"$"},c={cN:"type",b:"\\b[A-Z][\\w']*",r:0},n={b:"\\(",e:"\\)",i:'"',c:[a,l,{cN:"type",b:"\\b[A-Z][\\w]*(\\((\\.\\.|,|\\w+)\\))?"},e.inherit(e.TM,{b:"[_a-z][\\w']*"}),i]},s={b:"{",e:"}",c:n.c};return{aliases:["hs"],k:"let in if then else case of where do module import hiding qualified type data newtype deriving class instance as default infix infixl infixr foreign export ccall stdcall cplusplus jvm dotnet safe unsafe family forall mdo proc rec",c:[{bK:"module",e:"where",k:"module where",c:[n,i],i:"\\W\\.|;"},{b:"\\bimport\\b",e:"$",k:"import qualified as hiding",c:[n,i],i:"\\W\\.|;"},{cN:"class",b:"^(\\s*)?(class|instance)\\b",e:"where",k:"class family instance where",c:[c,n,i]},{cN:"class",b:"\\b(data|(new)?type)\\b",e:"$",k:"data family type newtype deriving",c:[a,c,n,s,i]},{bK:"default",e:"$",c:[c,n,i]},{bK:"infix infixl infixr",e:"$",c:[e.CNM,i]},{b:"\\bforeign\\b",e:"$",k:"foreign import export ccall stdcall cplusplus jvm dotnet safe unsafe",c:[c,e.QSM,i]},{cN:"meta",b:"#!\\/usr\\/bin\\/env runhaskell",e:"$"},a,l,e.QSM,e.CNM,c,e.inherit(e.TM,{b:"^[_a-z][\\w']*"}),i,{b:"->|<-"}]}});hljs.registerLanguage("applescript",function(e){var t=e.inherit(e.QSM,{i:""}),r={cN:"params",b:"\\(",e:"\\)",c:["self",e.CNM,t]},i=e.C("--","$"),o=e.C("\\(\\*","\\*\\)",{c:["self",i]}),n=[i,o,e.HCM];return{aliases:["osascript"],k:{keyword:"about above after against and around as at back before beginning behind below beneath beside between but by considering contain contains continue copy div does eighth else end equal equals error every exit fifth first for fourth from front get given global if ignoring in into is it its last local me middle mod my ninth not of on onto or over prop property put ref reference repeat returning script second set seventh since sixth some tell tenth that the|0 then third through thru timeout times to transaction try until where while whose with without",literal:"AppleScript false linefeed return pi quote result space tab true",built_in:"alias application boolean class constant date file integer list number real record string text activate beep count delay launch log offset read round run say summarize write character characters contents day frontmost id item length month name paragraph paragraphs rest reverse running time version weekday word words year"},c:[t,e.CNM,{cN:"built_in",b:"\\b(clipboard info|the clipboard|info for|list (disks|folder)|mount volume|path to|(close|open for) access|(get|set) eof|current date|do shell script|get volume settings|random number|set volume|system attribute|system info|time to GMT|(load|run|store) script|scripting components|ASCII (character|number)|localized string|choose (application|color|file|file name|folder|from list|remote application|URL)|display (alert|dialog))\\b|^\\s*return\\b"},{cN:"literal",b:"\\b(text item delimiters|current application|missing value)\\b"},{cN:"keyword",b:"\\b(apart from|aside from|instead of|out of|greater than|isn't|(doesn't|does not) (equal|come before|come after|contain)|(greater|less) than( or equal)?|(starts?|ends|begins?) with|contained by|comes (before|after)|a (ref|reference)|POSIX file|POSIX path|(date|time) string|quoted form)\\b"},{bK:"on",i:"[${=;\\n]",c:[e.UTM,r]}].concat(n),i:"//|->|=>|\\[\\["}});hljs.registerLanguage("scala",function(e){var t={cN:"meta",b:"@[A-Za-z]+"},a={cN:"subst",v:[{b:"\\$[A-Za-z0-9_]+"},{b:"\\${",e:"}"}]},r={cN:"string",v:[{b:'"',e:'"',i:"\\n",c:[e.BE]},{b:'"""',e:'"""',r:10},{b:'[a-z]+"',e:'"',i:"\\n",c:[e.BE,a]},{cN:"string",b:'[a-z]+"""',e:'"""',c:[a],r:10}]},c={cN:"symbol",b:"'\\w[\\w\\d_]*(?!')"},i={cN:"type",b:"\\b[A-Z][A-Za-z0-9_]*",r:0},s={cN:"title",b:/[^0-9\n\t "'(),.`{}\[\]:;][^\n\t "'(),.`{}\[\]:;]+|[^0-9\n\t "'(),.`{}\[\]:;=]/,r:0},n={cN:"class",bK:"class object trait type",e:/[:={\[\n;]/,eE:!0,c:[{bK:"extends with",r:10},{b:/\[/,e:/\]/,eB:!0,eE:!0,r:0,c:[i]},{cN:"params",b:/\(/,e:/\)/,eB:!0,eE:!0,r:0,c:[i]},s]},l={cN:"function",bK:"def",e:/[:={\[(\n;]/,eE:!0,c:[s]};return{k:{literal:"true false null",keyword:"type yield lazy override def with val var sealed abstract private trait object if forSome for while throw finally protected extends import final return else break new catch super class case package default try this match continue throws implicit"},c:[e.CLCM,e.CBCM,r,c,i,l,n,e.CNM,t]}});hljs.registerLanguage("erlang",function(e){var r="[a-z'][a-zA-Z0-9_']*",c="("+r+":"+r+"|"+r+")",b={keyword:"after and andalso|10 band begin bnot bor bsl bzr bxor case catch cond div end fun if let not of orelse|10 query receive rem try when xor",literal:"false true"},i=e.C("%","$"),n={cN:"number",b:"\\b(\\d+#[a-fA-F0-9]+|\\d+(\\.\\d+)?([eE][-+]?\\d+)?)",r:0},a={b:"fun\\s+"+r+"/\\d+"},d={b:c+"\\(",e:"\\)",rB:!0,r:0,c:[{b:c,r:0},{b:"\\(",e:"\\)",eW:!0,rE:!0,r:0}]},o={b:"{",e:"}",r:0},t={b:"\\b_([A-Z][A-Za-z0-9_]*)?",r:0},f={b:"[A-Z][a-zA-Z0-9_]*",r:0},l={b:"#"+e.UIR,r:0,rB:!0,c:[{b:"#"+e.UIR,r:0},{b:"{",e:"}",r:0}]},s={bK:"fun receive if try case",e:"end",k:b};s.c=[i,a,e.inherit(e.ASM,{cN:""}),s,d,e.QSM,n,o,t,f,l];var u=[i,a,s,d,e.QSM,n,o,t,f,l];d.c[1].c=u,o.c=u,l.c[1].c=u;var h={cN:"params",b:"\\(",e:"\\)",c:u};return{aliases:["erl"],k:b,i:"(</|\\*=|\\+=|-=|/\\*|\\*/|\\(\\*|\\*\\))",c:[{cN:"function",b:"^"+r+"\\s*\\(",e:"->",rB:!0,i:"\\(|#|//|/\\*|\\\\|:|;",c:[h,e.inherit(e.TM,{b:r})],starts:{e:";|\\.",k:b,c:u}},i,{b:"^-",e:"\\.",r:0,eE:!0,rB:!0,l:"-"+e.IR,k:"-module -record -undef -export -ifdef -ifndef -author -copyright -doc -vsn -import -include -include_lib -compile -define -else -endif -file -behaviour -behavior -spec",c:[h]},n,e.QSM,l,t,f,o,{b:/\.$/}]}});hljs.registerLanguage("powershell",function(e){var t={b:"`[\\s\\S]",r:0},r={cN:"variable",v:[{b:/\$[\w\d][\w\d_:]*/}]},o={cN:"literal",b:/\$(null|true|false)\b/},a={cN:"string",b:/"/,e:/"/,c:[t,r,{cN:"variable",b:/\$[A-z]/,e:/[^A-z]/}]},i={cN:"string",b:/'/,e:/'/};return{aliases:["ps"],l:/-?[A-z\.\-]+/,cI:!0,k:{keyword:"if else foreach return function do while until elseif begin for trap data dynamicparam end break throw param continue finally in switch exit filter try process catch",built_in:"Add-Content Add-History Add-Member Add-PSSnapin Clear-Content Clear-Item Clear-Item Property Clear-Variable Compare-Object ConvertFrom-SecureString Convert-Path ConvertTo-Html ConvertTo-SecureString Copy-Item Copy-ItemProperty Export-Alias Export-Clixml Export-Console Export-Csv ForEach-Object Format-Custom Format-List Format-Table Format-Wide Get-Acl Get-Alias Get-AuthenticodeSignature Get-ChildItem Get-Command Get-Content Get-Credential Get-Culture Get-Date Get-EventLog Get-ExecutionPolicy Get-Help Get-History Get-Host Get-Item Get-ItemProperty Get-Location Get-Member Get-PfxCertificate Get-Process Get-PSDrive Get-PSProvider Get-PSSnapin Get-Service Get-TraceSource Get-UICulture Get-Unique Get-Variable Get-WmiObject Group-Object Import-Alias Import-Clixml Import-Csv Invoke-Expression Invoke-History Invoke-Item Join-Path Measure-Command Measure-Object Move-Item Move-ItemProperty New-Alias New-Item New-ItemProperty New-Object New-PSDrive New-Service New-TimeSpan New-Variable Out-Default Out-File Out-Host Out-Null Out-Printer Out-String Pop-Location Push-Location Read-Host Remove-Item Remove-ItemProperty Remove-PSDrive Remove-PSSnapin Remove-Variable Rename-Item Rename-ItemProperty Resolve-Path Restart-Service Resume-Service Select-Object Select-String Set-Acl Set-Alias Set-AuthenticodeSignature Set-Content Set-Date Set-ExecutionPolicy Set-Item Set-ItemProperty Set-Location Set-PSDebug Set-Service Set-TraceSource Set-Variable Sort-Object Split-Path Start-Service Start-Sleep Start-Transcript Stop-Process Stop-Service Stop-Transcript Suspend-Service Tee-Object Test-Path Trace-Command Update-FormatData Update-TypeData Where-Object Write-Debug Write-Error Write-Host Write-Output Write-Progress Write-Verbose Write-Warning",nomarkup:"-ne -eq -lt -gt -ge -le -not -like -notlike -match -notmatch -contains -notcontains -in -notin -replace"},c:[e.HCM,e.NM,a,i,o,r]}});hljs.registerLanguage("dust",function(e){var t="if eq ne lt lte gt gte select default math sep";return{aliases:["dst"],cI:!0,sL:"xml",c:[{cN:"template-tag",b:/\{[#\/]/,e:/\}/,i:/;/,c:[{cN:"name",b:/[a-zA-Z\.-]+/,starts:{eW:!0,r:0,c:[e.QSM]}}]},{cN:"template-variable",b:/\{/,e:/\}/,i:/;/,k:t}]}});hljs.registerLanguage("clojure",function(e){var t={"builtin-name":"def defonce cond apply if-not if-let if not not= = < > <= >= == + / * - rem quot neg? pos? delay? symbol? keyword? true? false? integer? empty? coll? list? set? ifn? fn? associative? sequential? sorted? counted? reversible? number? decimal? class? distinct? isa? float? rational? reduced? ratio? odd? even? char? seq? vector? string? map? nil? contains? zero? instance? not-every? not-any? libspec? -> ->> .. . inc compare do dotimes mapcat take remove take-while drop letfn drop-last take-last drop-while while intern condp case reduced cycle split-at split-with repeat replicate iterate range merge zipmap declare line-seq sort comparator sort-by dorun doall nthnext nthrest partition eval doseq await await-for let agent atom send send-off release-pending-sends add-watch mapv filterv remove-watch agent-error restart-agent set-error-handler error-handler set-error-mode! error-mode shutdown-agents quote var fn loop recur throw try monitor-enter monitor-exit defmacro defn defn- macroexpand macroexpand-1 for dosync and or when when-not when-let comp juxt partial sequence memoize constantly complement identity assert peek pop doto proxy defstruct first rest cons defprotocol cast coll deftype defrecord last butlast sigs reify second ffirst fnext nfirst nnext defmulti defmethod meta with-meta ns in-ns create-ns import refer keys select-keys vals key val rseq name namespace promise into transient persistent! conj! assoc! dissoc! pop! disj! use class type num float double short byte boolean bigint biginteger bigdec print-method print-dup throw-if printf format load compile get-in update-in pr pr-on newline flush read slurp read-line subvec with-open memfn time re-find re-groups rand-int rand mod locking assert-valid-fdecl alias resolve ref deref refset swap! reset! set-validator! compare-and-set! alter-meta! reset-meta! commute get-validator alter ref-set ref-history-count ref-min-history ref-max-history ensure sync io! new next conj set! to-array future future-call into-array aset gen-class reduce map filter find empty hash-map hash-set sorted-map sorted-map-by sorted-set sorted-set-by vec vector seq flatten reverse assoc dissoc list disj get union difference intersection extend extend-type extend-protocol int nth delay count concat chunk chunk-buffer chunk-append chunk-first chunk-rest max min dec unchecked-inc-int unchecked-inc unchecked-dec-inc unchecked-dec unchecked-negate unchecked-add-int unchecked-add unchecked-subtract-int unchecked-subtract chunk-next chunk-cons chunked-seq? prn vary-meta lazy-seq spread list* str find-keyword keyword symbol gensym force rationalize"},r="a-zA-Z_\\-!.?+*=<>&#'",n="["+r+"]["+r+"0-9/;:]*",a="[-+]?\\d+(\\.\\d+)?",o={b:n,r:0},s={cN:"number",b:a,r:0},i=e.inherit(e.QSM,{i:null}),c=e.C(";","$",{r:0}),d={cN:"literal",b:/\b(true|false|nil)\b/},l={b:"[\\[\\{]",e:"[\\]\\}]"},m={cN:"comment",b:"\\^"+n},p=e.C("\\^\\{","\\}"),u={cN:"symbol",b:"[:]"+n},f={b:"\\(",e:"\\)"},h={eW:!0,r:0},y={k:t,l:n,cN:"name",b:n,starts:h},b=[f,i,m,p,c,u,l,s,d,o];return f.c=[e.C("comment",""),y,h],h.c=b,l.c=b,{aliases:["clj"],i:/\S/,c:[f,i,m,p,c,u,l,s,d]}});hljs.registerLanguage("go",function(e){var t={keyword:"break default func interface select case map struct chan else goto package switch const fallthrough if range type continue for import return var go defer bool byte complex64 complex128 float32 float64 int8 int16 int32 int64 string uint8 uint16 uint32 uint64 int uint uintptr rune",literal:"true false iota nil",built_in:"append cap close complex copy imag len make new panic print println real recover delete"};return{aliases:["golang"],k:t,i:"</",c:[e.CLCM,e.CBCM,e.QSM,{cN:"string",b:"'",e:"[^\\\\]'"},{cN:"string",b:"`",e:"`"},{cN:"number",b:e.CNR+"[dflsi]?",r:0},e.CNM]}});hljs.registerLanguage("tcl",function(e){return{aliases:["tk"],k:"after append apply array auto_execok auto_import auto_load auto_mkindex auto_mkindex_old auto_qualify auto_reset bgerror binary break catch cd chan clock close concat continue dde dict encoding eof error eval exec exit expr fblocked fconfigure fcopy file fileevent filename flush for foreach format gets glob global history http if incr info interp join lappend|10 lassign|10 lindex|10 linsert|10 list llength|10 load lrange|10 lrepeat|10 lreplace|10 lreverse|10 lsearch|10 lset|10 lsort|10 mathfunc mathop memory msgcat namespace open package parray pid pkg::create pkg_mkIndex platform platform::shell proc puts pwd read refchan regexp registry regsub|10 rename return safe scan seek set socket source split string subst switch tcl_endOfWord tcl_findLibrary tcl_startOfNextWord tcl_startOfPreviousWord tcl_wordBreakAfter tcl_wordBreakBefore tcltest tclvars tell time tm trace unknown unload unset update uplevel upvar variable vwait while",c:[e.C(";[ \\t]*#","$"),e.C("^[ \\t]*#","$"),{bK:"proc",e:"[\\{]",eE:!0,c:[{cN:"title",b:"[ \\t\\n\\r]+(::)?[a-zA-Z_]((::)?[a-zA-Z0-9_])*",e:"[ \\t\\n\\r]",eW:!0,eE:!0}]},{eE:!0,v:[{b:"\\$(\\{)?(::)?[a-zA-Z_]((::)?[a-zA-Z0-9_])*\\(([a-zA-Z0-9_])*\\)",e:"[^a-zA-Z0-9_\\}\\$]"},{b:"\\$(\\{)?(::)?[a-zA-Z_]((::)?[a-zA-Z0-9_])*",e:"(\\))?[^a-zA-Z0-9_\\}\\$]"}]},{cN:"string",c:[e.BE],v:[e.inherit(e.ASM,{i:null}),e.inherit(e.QSM,{i:null})]},{cN:"number",v:[e.BNM,e.CNM]}]}});hljs.registerLanguage("twig",function(e){var t={cN:"params",b:"\\(",e:"\\)"},a="attribute block constant cycle date dump include max min parent random range source template_from_string",r={bK:a,k:{name:a},r:0,c:[t]},c={b:/\|[A-Za-z_]+:?/,k:"abs batch capitalize convert_encoding date date_modify default escape first format join json_encode keys last length lower merge nl2br number_format raw replace reverse round slice sort split striptags title trim upper url_encode",c:[r]},s="autoescape block do embed extends filter flush for if import include macro sandbox set spaceless use verbatim";return s=s+" "+s.split(" ").map(function(e){return"end"+e}).join(" "),{aliases:["craftcms"],cI:!0,sL:"xml",c:[e.C(/\{#/,/#}/),{cN:"template-tag",b:/\{%/,e:/%}/,c:[{cN:"name",b:/\w+/,k:s,starts:{eW:!0,c:[c,r],r:0}}]},{cN:"template-variable",b:/\{\{/,e:/}}/,c:["self",c,r]}]}});hljs.registerLanguage("vhdl",function(e){var r="\\d(_|\\d)*",t="[eE][-+]?"+r,o=r+"(\\."+r+")?("+t+")?",n="\\w+",i=r+"#"+n+"(\\."+n+")?#("+t+")?",a="\\b("+i+"|"+o+")";return{cI:!0,k:{keyword:"abs access after alias all and architecture array assert attribute begin block body buffer bus case component configuration constant context cover disconnect downto default else elsif end entity exit fairness file for force function generate generic group guarded if impure in inertial inout is label library linkage literal loop map mod nand new next nor not null of on open or others out package port postponed procedure process property protected pure range record register reject release rem report restrict restrict_guarantee return rol ror select sequence severity shared signal sla sll sra srl strong subtype then to transport type unaffected units until use variable vmode vprop vunit wait when while with xnor xor",built_in:"boolean bit character severity_level integer time delay_length natural positive string bit_vector file_open_kind file_open_status std_ulogic std_ulogic_vector std_logic std_logic_vector unsigned signed boolean_vector integer_vector real_vector time_vector"},i:"{",c:[e.CBCM,e.C("--","$"),e.QSM,{cN:"number",b:a,r:0},{cN:"literal",b:"'(U|X|0|1|Z|W|L|H|-)'",c:[e.BE]},{cN:"symbol",b:"'[A-Za-z](_?[A-Za-z0-9])*",c:[e.BE]}]}});hljs.registerLanguage("javascript",function(e){return{aliases:["js","jsx"],k:{keyword:"in of if for while finally var new function do return void else break catch instanceof with throw case default try this switch continue typeof delete let yield const export super debugger as async await static import from as",literal:"true false null undefined NaN Infinity",built_in:"eval isFinite isNaN parseFloat parseInt decodeURI decodeURIComponent encodeURI encodeURIComponent escape unescape Object Function Boolean Error EvalError InternalError RangeError ReferenceError StopIteration SyntaxError TypeError URIError Number Math Date String RegExp Array Float32Array Float64Array Int16Array Int32Array Int8Array Uint16Array Uint32Array Uint8Array Uint8ClampedArray ArrayBuffer DataView JSON Intl arguments require module console window document Symbol Set Map WeakSet WeakMap Proxy Reflect Promise"},c:[{cN:"meta",r:10,b:/^\s*['"]use (strict|asm)['"]/},{cN:"meta",b:/^#!/,e:/$/},e.ASM,e.QSM,{cN:"string",b:"`",e:"`",c:[e.BE,{cN:"subst",b:"\\$\\{",e:"\\}"}]},e.CLCM,e.CBCM,{cN:"number",v:[{b:"\\b(0[bB][01]+)"},{b:"\\b(0[oO][0-7]+)"},{b:e.CNR}],r:0},{b:"("+e.RSR+"|\\b(case|return|throw)\\b)\\s*",k:"return throw case",c:[e.CLCM,e.CBCM,e.RM,{b:/</,e:/(\/\w+|\w+\/)>/,sL:"xml",c:[{b:/<\w+\/>/,skip:!0},{b:/<\w+/,e:/(\/\w+|\w+\/)>/,skip:!0,c:["self"]}]}],r:0},{cN:"function",bK:"function",e:/\{/,eE:!0,c:[e.inherit(e.TM,{b:/[A-Za-z$_][0-9A-Za-z$_]*/}),{cN:"params",b:/\(/,e:/\)/,eB:!0,eE:!0,c:[e.CLCM,e.CBCM]}],i:/\[|%/},{b:/\$[(.]/},e.METHOD_GUARD,{cN:"class",bK:"class",e:/[{;=]/,eE:!0,i:/[:"\[\]]/,c:[{bK:"extends"},e.UTM]},{bK:"constructor",e:/\{/,eE:!0}],i:/#(?!!)/}});hljs.registerLanguage("less",function(e){var r="[\\w-]+",t="("+r+"|@{"+r+"})",a=[],c=[],s=function(e){return{cN:"string",b:"~?"+e+".*?"+e}},b=function(e,r,t){return{cN:e,b:r,r:t}},i={b:"\\(",e:"\\)",c:c,r:0};c.push(e.CLCM,e.CBCM,s("'"),s('"'),e.CSSNM,{b:"(url|data-uri)\\(",starts:{cN:"string",e:"[\\)\\n]",eE:!0}},b("number","#[0-9A-Fa-f]+\\b"),i,b("variable","@@?"+r,10),b("variable","@{"+r+"}"),b("built_in","~?`[^`]*?`"),{cN:"attribute",b:r+"\\s*:",e:":",rB:!0,eE:!0},{cN:"meta",b:"!important"});var n=c.concat({b:"{",e:"}",c:a}),o={bK:"when",eW:!0,c:[{bK:"and not"}].concat(c)},u={cN:"attribute",b:t,e:":",eE:!0,c:[e.CLCM,e.CBCM],i:/\S/,starts:{e:"[;}]",rE:!0,c:c,i:"[<=$]"}},C={cN:"keyword",b:"@(import|media|charset|font-face|(-[a-z]+-)?keyframes|supports|document|namespace|page|viewport|host)\\b",starts:{e:"[;{}]",rE:!0,c:c,r:0}},l={cN:"variable",v:[{b:"@"+r+"\\s*:",r:15},{b:"@"+r}],starts:{e:"[;}]",rE:!0,c:n}},p={v:[{b:"[\\.#:&\\[]",e:"[;{}]"},{b:t+"[^;]*{",e:"{"}],rB:!0,rE:!0,i:"[<='$\"]",c:[e.CLCM,e.CBCM,o,b("keyword","all\\b"),b("variable","@{"+r+"}"),b("selector-tag",t+"%?",0),b("selector-id","#"+t),b("selector-class","\\."+t,0),b("selector-tag","&",0),{cN:"selector-attr",b:"\\[",e:"\\]"},{b:"\\(",e:"\\)",c:n},{b:"!important"}]};return a.push(e.CLCM,e.CBCM,C,l,p,u),{cI:!0,i:"[=>'/<($\"]",c:a}});hljs.registerLanguage("q",function(e){var s={keyword:"do while select delete by update from",literal:"0b 1b",built_in:"neg not null string reciprocal floor ceiling signum mod xbar xlog and or each scan over prior mmu lsq inv md5 ltime gtime count first var dev med cov cor all any rand sums prds mins maxs fills deltas ratios avgs differ prev next rank reverse iasc idesc asc desc msum mcount mavg mdev xrank mmin mmax xprev rotate distinct group where flip type key til get value attr cut set upsert raze union inter except cross sv vs sublist enlist read0 read1 hopen hclose hdel hsym hcount peach system ltrim rtrim trim lower upper ssr view tables views cols xcols keys xkey xcol xasc xdesc fkeys meta lj aj aj0 ij pj asof uj ww wj wj1 fby xgroup ungroup ej save load rsave rload show csv parse eval min max avg wavg wsum sin cos tan sum",type:"`float `double int `timestamp `timespan `datetime `time `boolean `symbol `char `byte `short `long `real `month `date `minute `second `guid"};return{aliases:["k","kdb"],k:s,l:/(`?)[A-Za-z0-9_]+\b/,c:[e.CLCM,e.QSM,e.CNM]}});hljs.registerLanguage("gherkin",function(e){return{aliases:["feature"],k:"Feature Background Ability Business Need Scenario Scenarios Scenario Outline Scenario Template Examples Given And Then But When",c:[{cN:"keyword",b:"\\*"},{cN:"meta",b:"@[^@\\s]+"},{b:"\\|",e:"\\|\\w*$",c:[{cN:"string",b:"[^|]+"}]},{cN:"variable",b:"<",e:">"},e.HCM,{cN:"string",b:'"""',e:'"""'},e.QSM]}});hljs.registerLanguage("nginx",function(e){var r={cN:"variable",v:[{b:/\$\d+/},{b:/\$\{/,e:/}/},{b:"[\\$\\@]"+e.UIR}]},b={eW:!0,l:"[a-z/_]+",k:{literal:"on off yes no true false none blocked debug info notice warn error crit select break last permanent redirect kqueue rtsig epoll poll /dev/poll"},r:0,i:"=>",c:[e.HCM,{cN:"string",c:[e.BE,r],v:[{b:/"/,e:/"/},{b:/'/,e:/'/}]},{b:"([a-z]+):/",e:"\\s",eW:!0,eE:!0,c:[r]},{cN:"regexp",c:[e.BE,r],v:[{b:"\\s\\^",e:"\\s|{|;",rE:!0},{b:"~\\*?\\s+",e:"\\s|{|;",rE:!0},{b:"\\*(\\.[a-z\\-]+)+"},{b:"([a-z\\-]+\\.)+\\*"}]},{cN:"number",b:"\\b\\d{1,3}\\.\\d{1,3}\\.\\d{1,3}\\.\\d{1,3}(:\\d{1,5})?\\b"},{cN:"number",b:"\\b\\d+[kKmMgGdshdwy]*\\b",r:0},r]};return{aliases:["nginxconf"],c:[e.HCM,{b:e.UIR+"\\s+{",rB:!0,e:"{",c:[{cN:"section",b:e.UIR}],r:0},{b:e.UIR+"\\s",e:";|{",rB:!0,c:[{cN:"attribute",b:e.UIR,starts:b}],r:0}],i:"[^\\s\\}]"}});hljs.registerLanguage("rust",function(e){var t="([uif](8|16|32|64|size))?",r=e.inherit(e.CBCM);r.c.push("self");var n="Copy Send Sized Sync Drop Fn FnMut FnOnce drop Box ToOwned Clone PartialEq PartialOrd Eq Ord AsRef AsMut Into From Default Iterator Extend IntoIterator DoubleEndedIterator ExactSizeIterator Option Result SliceConcatExt String ToString Vec assert! assert_eq! bitflags! bytes! cfg! col! concat! concat_idents! debug_assert! debug_assert_eq! env! panic! file! format! format_args! include_bin! include_str! line! local_data_key! module_path! option_env! print! println! select! stringify! try! unimplemented! unreachable! vec! write! writeln! macro_rules!";return{aliases:["rs"],k:{keyword:"alignof as be box break const continue crate do else enum extern false fn for if impl in let loop match mod mut offsetof once priv proc pub pure ref return self Self sizeof static struct super trait true type typeof unsafe unsized use virtual while where yield int i8 i16 i32 i64 uint u8 u32 u64 float f32 f64 str char bool",literal:"true false Some None Ok Err",built_in:n},l:e.IR+"!?",i:"</",c:[e.CLCM,r,e.inherit(e.QSM,{b:/b?"/,i:null}),{cN:"string",v:[{b:/r(#*)".*?"\1(?!#)/},{b:/b?'\\?(x\w{2}|u\w{4}|U\w{8}|.)'/}]},{cN:"symbol",b:/'[a-zA-Z_][a-zA-Z0-9_]*/},{cN:"number",v:[{b:"\\b0b([01_]+)"+t},{b:"\\b0o([0-7_]+)"+t},{b:"\\b0x([A-Fa-f0-9_]+)"+t},{b:"\\b(\\d[\\d_]*(\\.[0-9_]+)?([eE][+-]?[0-9_]+)?)"+t}],r:0},{cN:"function",bK:"fn",e:"(\\(|<)",eE:!0,c:[e.UTM]},{cN:"meta",b:"#\\!?\\[",e:"\\]",c:[{cN:"meta-string",b:/"/,e:/"/}]},{cN:"class",bK:"type",e:";",c:[e.inherit(e.UTM,{endsParent:!0})],i:"\\S"},{cN:"class",bK:"trait enum struct",e:"{",c:[e.inherit(e.UTM,{endsParent:!0})],i:"[\\w\\d]"},{b:e.IR+"::",k:{built_in:n}},{b:"->"}]}});hljs.registerLanguage("groovy",function(e){return{k:{literal:"true false null",keyword:"byte short char int long boolean float double void def as in assert trait super this abstract static volatile transient public private protected synchronized final class interface enum if else for while switch case break default continue throw throws try catch finally implements extends new import package return instanceof"},c:[e.C("/\\*\\*","\\*/",{r:0,c:[{b:/\w+@/,r:0},{cN:"doctag",b:"@[A-Za-z]+"}]}),e.CLCM,e.CBCM,{cN:"string",b:'"""',e:'"""'},{cN:"string",b:"'''",e:"'''"},{cN:"string",b:"\\$/",e:"/\\$",r:10},e.ASM,{cN:"regexp",b:/~?\/[^\/\n]+\//,c:[e.BE]},e.QSM,{cN:"meta",b:"^#!/usr/bin/env",e:"$",i:"\n"},e.BNM,{cN:"class",bK:"class interface trait enum",e:"{",i:":",c:[{bK:"extends implements"},e.UTM]},e.CNM,{cN:"meta",b:"@[A-Za-z]+"},{cN:"string",b:/[^\?]{0}[A-Za-z0-9_$]+ *:/},{b:/\?/,e:/\:/},{cN:"symbol",b:"^\\s*[A-Za-z0-9_$]+:",r:0}],i:/#|<\//}});hljs.registerLanguage("aspectj",function(e){var t="false synchronized int abstract float private char boolean static null if const for true while long throw strictfp finally protected import native final return void enum else extends implements break transient new catch instanceof byte super volatile case assert short package default double public try this switch continue throws privileged aspectOf adviceexecution proceed cflowbelow cflow initialization preinitialization staticinitialization withincode target within execution getWithinTypeName handler thisJoinPoint thisJoinPointStaticPart thisEnclosingJoinPointStaticPart declare parents warning error soft precedence thisAspectInstance",i="get set args call";return{k:t,i:/<\/|#/,c:[e.C("/\\*\\*","\\*/",{r:0,c:[{b:/\w+@/,r:0},{cN:"doctag",b:"@[A-Za-z]+"}]}),e.CLCM,e.CBCM,e.ASM,e.QSM,{cN:"class",bK:"aspect",e:/[{;=]/,eE:!0,i:/[:;"\[\]]/,c:[{bK:"extends implements pertypewithin perthis pertarget percflowbelow percflow issingleton"},e.UTM,{b:/\([^\)]*/,e:/[)]+/,k:t+" "+i,eE:!1}]},{cN:"class",bK:"class interface",e:/[{;=]/,eE:!0,r:0,k:"class interface",i:/[:"\[\]]/,c:[{bK:"extends implements"},e.UTM]},{bK:"pointcut after before around throwing returning",e:/[)]/,eE:!1,i:/["\[\]]/,c:[{b:e.UIR+"\\s*\\(",rB:!0,c:[e.UTM]}]},{b:/[:]/,rB:!0,e:/[{;]/,r:0,eE:!1,k:t,i:/["\[\]]/,c:[{b:e.UIR+"\\s*\\(",k:t+" "+i},e.QSM]},{bK:"new throw",r:0},{cN:"function",b:/\w+ +\w+(\.)?\w+\s*\([^\)]*\)\s*((throws)[\w\s,]+)?[\{;]/,rB:!0,e:/[{;=]/,k:t,eE:!0,c:[{b:e.UIR+"\\s*\\(",rB:!0,r:0,c:[e.UTM]},{cN:"params",b:/\(/,e:/\)/,r:0,k:t,c:[e.ASM,e.QSM,e.CNM,e.CBCM]},e.CLCM,e.CBCM]},e.CNM,{cN:"meta",b:"@[A-Za-z]+"}]}});hljs.registerLanguage("actionscript",function(e){var a="[a-zA-Z_$][a-zA-Z0-9_$]*",t="([*]|[a-zA-Z_$][a-zA-Z0-9_$]*)",c={cN:"rest_arg",b:"[.]{3}",e:a,r:10};return{aliases:["as"],k:{keyword:"as break case catch class const continue default delete do dynamic each else extends final finally for function get if implements import in include instanceof interface internal is namespace native new override package private protected public return set static super switch this throw try typeof use var void while with",literal:"true false null undefined"},c:[e.ASM,e.QSM,e.CLCM,e.CBCM,e.CNM,{cN:"class",bK:"package",e:"{",c:[e.TM]},{cN:"class",bK:"class interface",e:"{",eE:!0,c:[{bK:"extends implements"},e.TM]},{cN:"meta",bK:"import include",e:";",k:{"meta-keyword":"import include"}},{cN:"function",bK:"function",e:"[{;]",eE:!0,i:"\\S",c:[e.TM,{cN:"params",b:"\\(",e:"\\)",c:[e.ASM,e.QSM,e.CLCM,e.CBCM,c]},{b:":\\s*"+t}]},e.METHOD_GUARD],i:/#/}});hljs.registerLanguage("diff",function(e){return{aliases:["patch"],c:[{cN:"meta",r:10,v:[{b:/^@@ +\-\d+,\d+ +\+\d+,\d+ +@@$/},{b:/^\*\*\* +\d+,\d+ +\*\*\*\*$/},{b:/^\-\-\- +\d+,\d+ +\-\-\-\-$/}]},{cN:"comment",v:[{b:/Index: /,e:/$/},{b:/=====/,e:/=====$/},{b:/^\-\-\-/,e:/$/},{b:/^\*{3} /,e:/$/},{b:/^\+\+\+/,e:/$/},{b:/\*{5}/,e:/\*{5}$/}]},{cN:"addition",b:"^\\+",e:"$"},{cN:"deletion",b:"^\\-",e:"$"},{cN:"addition",b:"^\\!",e:"$"}]}});hljs.registerLanguage("ini",function(e){var b={cN:"string",c:[e.BE],v:[{b:"'''",e:"'''",r:10},{b:'"""',e:'"""',r:10},{b:'"',e:'"'},{b:"'",e:"'"}]};return{aliases:["toml"],cI:!0,i:/\S/,c:[e.C(";","$"),e.HCM,{cN:"section",b:/^\s*\[+/,e:/\]+/},{b:/^[a-z0-9\[\]_-]+\s*=\s*/,e:"$",rB:!0,c:[{cN:"attr",b:/[a-z0-9\[\]_-]+/},{b:/=/,eW:!0,r:0,c:[{cN:"literal",b:/\bon|off|true|false|yes|no\b/},{cN:"variable",v:[{b:/\$[\w\d"][\w\d_]*/},{b:/\$\{(.*?)}/}]},b,{cN:"number",b:/([\+\-]+)?[\d]+_[\d_]+/},e.NM]}]}]}});hljs.registerLanguage("fortran",function(e){var t={cN:"params",b:"\\(",e:"\\)"},n={literal:".False. .True.",keyword:"kind do while private call intrinsic where elsewhere type endtype endmodule endselect endinterface end enddo endif if forall endforall only contains default return stop then public subroutine|10 function program .and. .or. .not. .le. .eq. .ge. .gt. .lt. goto save else use module select case access blank direct exist file fmt form formatted iostat name named nextrec number opened rec recl sequential status unformatted unit continue format pause cycle exit c_null_char c_alert c_backspace c_form_feed flush wait decimal round iomsg synchronous nopass non_overridable pass protected volatile abstract extends import non_intrinsic value deferred generic final enumerator class associate bind enum c_int c_short c_long c_long_long c_signed_char c_size_t c_int8_t c_int16_t c_int32_t c_int64_t c_int_least8_t c_int_least16_t c_int_least32_t c_int_least64_t c_int_fast8_t c_int_fast16_t c_int_fast32_t c_int_fast64_t c_intmax_t C_intptr_t c_float c_double c_long_double c_float_complex c_double_complex c_long_double_complex c_bool c_char c_null_ptr c_null_funptr c_new_line c_carriage_return c_horizontal_tab c_vertical_tab iso_c_binding c_loc c_funloc c_associated  c_f_pointer c_ptr c_funptr iso_fortran_env character_storage_size error_unit file_storage_size input_unit iostat_end iostat_eor numeric_storage_size output_unit c_f_procpointer ieee_arithmetic ieee_support_underflow_control ieee_get_underflow_mode ieee_set_underflow_mode newunit contiguous recursive pad position action delim readwrite eor advance nml interface procedure namelist include sequence elemental pure integer real character complex logical dimension allocatable|10 parameter external implicit|10 none double precision assign intent optional pointer target in out common equivalence data",built_in:"alog alog10 amax0 amax1 amin0 amin1 amod cabs ccos cexp clog csin csqrt dabs dacos dasin datan datan2 dcos dcosh ddim dexp dint dlog dlog10 dmax1 dmin1 dmod dnint dsign dsin dsinh dsqrt dtan dtanh float iabs idim idint idnint ifix isign max0 max1 min0 min1 sngl algama cdabs cdcos cdexp cdlog cdsin cdsqrt cqabs cqcos cqexp cqlog cqsin cqsqrt dcmplx dconjg derf derfc dfloat dgamma dimag dlgama iqint qabs qacos qasin qatan qatan2 qcmplx qconjg qcos qcosh qdim qerf qerfc qexp qgamma qimag qlgama qlog qlog10 qmax1 qmin1 qmod qnint qsign qsin qsinh qsqrt qtan qtanh abs acos aimag aint anint asin atan atan2 char cmplx conjg cos cosh exp ichar index int log log10 max min nint sign sin sinh sqrt tan tanh print write dim lge lgt lle llt mod nullify allocate deallocate adjustl adjustr all allocated any associated bit_size btest ceiling count cshift date_and_time digits dot_product eoshift epsilon exponent floor fraction huge iand ibclr ibits ibset ieor ior ishft ishftc lbound len_trim matmul maxexponent maxloc maxval merge minexponent minloc minval modulo mvbits nearest pack present product radix random_number random_seed range repeat reshape rrspacing scale scan selected_int_kind selected_real_kind set_exponent shape size spacing spread sum system_clock tiny transpose trim ubound unpack verify achar iachar transfer dble entry dprod cpu_time command_argument_count get_command get_command_argument get_environment_variable is_iostat_end ieee_arithmetic ieee_support_underflow_control ieee_get_underflow_mode ieee_set_underflow_mode is_iostat_eor move_alloc new_line selected_char_kind same_type_as extends_type_ofacosh asinh atanh bessel_j0 bessel_j1 bessel_jn bessel_y0 bessel_y1 bessel_yn erf erfc erfc_scaled gamma log_gamma hypot norm2 atomic_define atomic_ref execute_command_line leadz trailz storage_size merge_bits bge bgt ble blt dshiftl dshiftr findloc iall iany iparity image_index lcobound ucobound maskl maskr num_images parity popcnt poppar shifta shiftl shiftr this_image"};return{cI:!0,aliases:["f90","f95"],k:n,i:/\/\*/,c:[e.inherit(e.ASM,{cN:"string",r:0}),e.inherit(e.QSM,{cN:"string",r:0}),{cN:"function",bK:"subroutine function program",i:"[${=\\n]",c:[e.UTM,t]},e.C("!","$",{r:0}),{cN:"number",b:"(?=\\b|\\+|\\-|\\.)(?=\\.\\d|\\d)(?:\\d+)?(?:\\.?\\d*)(?:[de][+-]?\\d+)?\\b\\.?",r:0}]}});hljs.registerLanguage("tex",function(c){var e={cN:"tag",b:/\\/,r:0,c:[{cN:"name",v:[{b:/[a-zA-Zа-яА-я]+[*]?/},{b:/[^a-zA-Zа-яА-я0-9]/}],starts:{eW:!0,r:0,c:[{cN:"string",v:[{b:/\[/,e:/\]/},{b:/\{/,e:/\}/}]},{b:/\s*=\s*/,eW:!0,r:0,c:[{cN:"number",b:/-?\d*\.?\d+(pt|pc|mm|cm|in|dd|cc|ex|em)?/}]}]}}]};return{c:[e,{cN:"formula",c:[e],r:0,v:[{b:/\$\$/,e:/\$\$/},{b:/\$/,e:/\$/}]},c.C("%","$",{r:0})]}});hljs.registerLanguage("typescript",function(e){var r={keyword:"in if for while finally var new function do return void else break catch instanceof with throw case default try this switch continue typeof delete let yield const class public private protected get set super static implements enum export import declare type namespace abstract",literal:"true false null undefined NaN Infinity",built_in:"eval isFinite isNaN parseFloat parseInt decodeURI decodeURIComponent encodeURI encodeURIComponent escape unescape Object Function Boolean Error EvalError InternalError RangeError ReferenceError StopIteration SyntaxError TypeError URIError Number Math Date String RegExp Array Float32Array Float64Array Int16Array Int32Array Int8Array Uint16Array Uint32Array Uint8Array Uint8ClampedArray ArrayBuffer DataView JSON Intl arguments require module console window document any number boolean string void"};return{aliases:["ts"],k:r,c:[{cN:"meta",b:/^\s*['"]use strict['"]/},e.ASM,e.QSM,{cN:"string",b:"`",e:"`",c:[e.BE,{cN:"subst",b:"\\$\\{",e:"\\}"}]},e.CLCM,e.CBCM,{cN:"number",v:[{b:"\\b(0[bB][01]+)"},{b:"\\b(0[oO][0-7]+)"},{b:e.CNR}],r:0},{b:"("+e.RSR+"|\\b(case|return|throw)\\b)\\s*",k:"return throw case",c:[e.CLCM,e.CBCM,e.RM],r:0},{cN:"function",b:"function",e:/[\{;]/,eE:!0,k:r,c:["self",e.inherit(e.TM,{b:/[A-Za-z$_][0-9A-Za-z$_]*/}),{cN:"params",b:/\(/,e:/\)/,eB:!0,eE:!0,k:r,c:[e.CLCM,e.CBCM],i:/["'\(]/}],i:/\[|%/,r:0},{bK:"constructor",e:/\{/,eE:!0},{bK:"module",e:/\{/,eE:!0},{bK:"interface",e:/\{/,eE:!0,k:"interface extends"},{b:/\$[(.]/},{b:"\\."+e.IR,r:0}]}});hljs.registerLanguage("scss",function(e){var t="[a-zA-Z-][a-zA-Z0-9_-]*",i={cN:"variable",b:"(\\$"+t+")\\b"},r={cN:"number",b:"#[0-9A-Fa-f]+"};({cN:"attribute",b:"[A-Z\\_\\.\\-]+",e:":",eE:!0,i:"[^\\s]",starts:{eW:!0,eE:!0,c:[r,e.CSSNM,e.QSM,e.ASM,e.CBCM,{cN:"meta",b:"!important"}]}});return{cI:!0,i:"[=/|']",c:[e.CLCM,e.CBCM,{cN:"selector-id",b:"\\#[A-Za-z0-9_-]+",r:0},{cN:"selector-class",b:"\\.[A-Za-z0-9_-]+",r:0},{cN:"selector-attr",b:"\\[",e:"\\]",i:"$"},{cN:"selector-tag",b:"\\b(a|abbr|acronym|address|area|article|aside|audio|b|base|big|blockquote|body|br|button|canvas|caption|cite|code|col|colgroup|command|datalist|dd|del|details|dfn|div|dl|dt|em|embed|fieldset|figcaption|figure|footer|form|frame|frameset|(h[1-6])|head|header|hgroup|hr|html|i|iframe|img|input|ins|kbd|keygen|label|legend|li|link|map|mark|meta|meter|nav|noframes|noscript|object|ol|optgroup|option|output|p|param|pre|progress|q|rp|rt|ruby|samp|script|section|select|small|span|strike|strong|style|sub|sup|table|tbody|td|textarea|tfoot|th|thead|time|title|tr|tt|ul|var|video)\\b",r:0},{b:":(visited|valid|root|right|required|read-write|read-only|out-range|optional|only-of-type|only-child|nth-of-type|nth-last-of-type|nth-last-child|nth-child|not|link|left|last-of-type|last-child|lang|invalid|indeterminate|in-range|hover|focus|first-of-type|first-line|first-letter|first-child|first|enabled|empty|disabled|default|checked|before|after|active)"},{b:"::(after|before|choices|first-letter|first-line|repeat-index|repeat-item|selection|value)"},i,{cN:"attribute",b:"\\b(z-index|word-wrap|word-spacing|word-break|width|widows|white-space|visibility|vertical-align|unicode-bidi|transition-timing-function|transition-property|transition-duration|transition-delay|transition|transform-style|transform-origin|transform|top|text-underline-position|text-transform|text-shadow|text-rendering|text-overflow|text-indent|text-decoration-style|text-decoration-line|text-decoration-color|text-decoration|text-align-last|text-align|tab-size|table-layout|right|resize|quotes|position|pointer-events|perspective-origin|perspective|page-break-inside|page-break-before|page-break-after|padding-top|padding-right|padding-left|padding-bottom|padding|overflow-y|overflow-x|overflow-wrap|overflow|outline-width|outline-style|outline-offset|outline-color|outline|orphans|order|opacity|object-position|object-fit|normal|none|nav-up|nav-right|nav-left|nav-index|nav-down|min-width|min-height|max-width|max-height|mask|marks|margin-top|margin-right|margin-left|margin-bottom|margin|list-style-type|list-style-position|list-style-image|list-style|line-height|letter-spacing|left|justify-content|initial|inherit|ime-mode|image-orientation|image-resolution|image-rendering|icon|hyphens|height|font-weight|font-variant-ligatures|font-variant|font-style|font-stretch|font-size-adjust|font-size|font-language-override|font-kerning|font-feature-settings|font-family|font|float|flex-wrap|flex-shrink|flex-grow|flex-flow|flex-direction|flex-basis|flex|filter|empty-cells|display|direction|cursor|counter-reset|counter-increment|content|column-width|column-span|column-rule-width|column-rule-style|column-rule-color|column-rule|column-gap|column-fill|column-count|columns|color|clip-path|clip|clear|caption-side|break-inside|break-before|break-after|box-sizing|box-shadow|box-decoration-break|bottom|border-width|border-top-width|border-top-style|border-top-right-radius|border-top-left-radius|border-top-color|border-top|border-style|border-spacing|border-right-width|border-right-style|border-right-color|border-right|border-radius|border-left-width|border-left-style|border-left-color|border-left|border-image-width|border-image-source|border-image-slice|border-image-repeat|border-image-outset|border-image|border-color|border-collapse|border-bottom-width|border-bottom-style|border-bottom-right-radius|border-bottom-left-radius|border-bottom-color|border-bottom|border|background-size|background-repeat|background-position|background-origin|background-image|background-color|background-clip|background-attachment|background-blend-mode|background|backface-visibility|auto|animation-timing-function|animation-play-state|animation-name|animation-iteration-count|animation-fill-mode|animation-duration|animation-direction|animation-delay|animation|align-self|align-items|align-content)\\b",i:"[^\\s]"},{b:"\\b(whitespace|wait|w-resize|visible|vertical-text|vertical-ideographic|uppercase|upper-roman|upper-alpha|underline|transparent|top|thin|thick|text|text-top|text-bottom|tb-rl|table-header-group|table-footer-group|sw-resize|super|strict|static|square|solid|small-caps|separate|se-resize|scroll|s-resize|rtl|row-resize|ridge|right|repeat|repeat-y|repeat-x|relative|progress|pointer|overline|outside|outset|oblique|nowrap|not-allowed|normal|none|nw-resize|no-repeat|no-drop|newspaper|ne-resize|n-resize|move|middle|medium|ltr|lr-tb|lowercase|lower-roman|lower-alpha|loose|list-item|line|line-through|line-edge|lighter|left|keep-all|justify|italic|inter-word|inter-ideograph|inside|inset|inline|inline-block|inherit|inactive|ideograph-space|ideograph-parenthesis|ideograph-numeric|ideograph-alpha|horizontal|hidden|help|hand|groove|fixed|ellipsis|e-resize|double|dotted|distribute|distribute-space|distribute-letter|distribute-all-lines|disc|disabled|default|decimal|dashed|crosshair|collapse|col-resize|circle|char|center|capitalize|break-word|break-all|bottom|both|bolder|bold|block|bidi-override|below|baseline|auto|always|all-scroll|absolute|table|table-cell)\\b"},{b:":",e:";",c:[i,r,e.CSSNM,e.QSM,e.ASM,{cN:"meta",b:"!important"}]},{b:"@",e:"[{;]",k:"mixin include extend for if else each while charset import debug media page content font-face namespace warn",c:[i,e.QSM,e.ASM,r,e.CSSNM,{b:"\\s[A-Za-z0-9_.-]+",r:0}]}]}});hljs.registerLanguage("puppet",function(e){var s={keyword:"and case default else elsif false if in import enherits node or true undef unless main settings $string ",literal:"alias audit before loglevel noop require subscribe tag owner ensure group mode name|0 changes context force incl lens load_path onlyif provider returns root show_diff type_check en_address ip_address realname command environment hour monute month monthday special target weekday creates cwd ogoutput refresh refreshonly tries try_sleep umask backup checksum content ctime force ignore links mtime purge recurse recurselimit replace selinux_ignore_defaults selrange selrole seltype seluser source souirce_permissions sourceselect validate_cmd validate_replacement allowdupe attribute_membership auth_membership forcelocal gid ia_load_module members system host_aliases ip allowed_trunk_vlans description device_url duplex encapsulation etherchannel native_vlan speed principals allow_root auth_class auth_type authenticate_user k_of_n mechanisms rule session_owner shared options device fstype enable hasrestart directory present absent link atboot blockdevice device dump pass remounts poller_tag use message withpath adminfile allow_virtual allowcdrom category configfiles flavor install_options instance package_settings platform responsefile status uninstall_options vendor unless_system_user unless_uid binary control flags hasstatus manifest pattern restart running start stop allowdupe auths expiry gid groups home iterations key_membership keys managehome membership password password_max_age password_min_age profile_membership profiles project purge_ssh_keys role_membership roles salt shell uid baseurl cost descr enabled enablegroups exclude failovermethod gpgcheck gpgkey http_caching include includepkgs keepalive metadata_expire metalink mirrorlist priority protect proxy proxy_password proxy_username repo_gpgcheck s3_enabled skip_if_unavailable sslcacert sslclientcert sslclientkey sslverify mounted",built_in:"architecture augeasversion blockdevices boardmanufacturer boardproductname boardserialnumber cfkey dhcp_servers domain ec2_ ec2_userdata facterversion filesystems ldom fqdn gid hardwareisa hardwaremodel hostname id|0 interfaces ipaddress ipaddress_ ipaddress6 ipaddress6_ iphostnumber is_virtual kernel kernelmajversion kernelrelease kernelversion kernelrelease kernelversion lsbdistcodename lsbdistdescription lsbdistid lsbdistrelease lsbmajdistrelease lsbminordistrelease lsbrelease macaddress macaddress_ macosx_buildversion macosx_productname macosx_productversion macosx_productverson_major macosx_productversion_minor manufacturer memoryfree memorysize netmask metmask_ network_ operatingsystem operatingsystemmajrelease operatingsystemrelease osfamily partitions path physicalprocessorcount processor processorcount productname ps puppetversion rubysitedir rubyversion selinux selinux_config_mode selinux_config_policy selinux_current_mode selinux_current_mode selinux_enforced selinux_policyversion serialnumber sp_ sshdsakey sshecdsakey sshrsakey swapencrypted swapfree swapsize timezone type uniqueid uptime uptime_days uptime_hours uptime_seconds uuid virtual vlans xendomains zfs_version zonenae zones zpool_version"},r=e.C("#","$"),a="([A-Za-z_]|::)(\\w|::)*",i=e.inherit(e.TM,{b:a}),o={cN:"variable",b:"\\$"+a},t={cN:"string",c:[e.BE,o],v:[{b:/'/,e:/'/},{b:/"/,e:/"/}]};return{aliases:["pp"],c:[r,o,t,{bK:"class",e:"\\{|;",i:/=/,c:[i,r]},{bK:"define",e:/\{/,c:[{cN:"section",b:e.IR,endsParent:!0}]},{b:e.IR+"\\s+\\{",rB:!0,e:/\S/,c:[{cN:"keyword",b:e.IR},{b:/\{/,e:/\}/,k:s,r:0,c:[t,r,{b:"[a-zA-Z_]+\\s*=>",rB:!0,e:"=>",c:[{cN:"attr",b:e.IR}]},{cN:"number",b:"(\\b0[0-7_]+)|(\\b0x[0-9a-fA-F_]+)|(\\b[1-9][0-9_]*(\\.[0-9_]+)?)|[0_]\\b",r:0},o]}],r:0}]}});hljs.registerLanguage("cpp",function(t){var e={cN:"keyword",b:"\\b[a-z\\d_]*_t\\b"},r={cN:"string",v:[t.inherit(t.QSM,{b:'((u8?|U)|L)?"'}),{b:'(u8?|U)?R"',e:'"',c:[t.BE]},{b:"'\\\\?.",e:"'",i:"."}]},i={cN:"number",v:[{b:"\\b(\\d+(\\.\\d*)?|\\.\\d+)(u|U|l|L|ul|UL|f|F)"},{b:t.CNR}],r:0},s={cN:"meta",b:"#",e:"$",k:{"meta-keyword":"if else elif endif define undef warning error line pragma ifdef ifndef"},c:[{b:/\\\n/,r:0},{bK:"include",e:"$",k:{"meta-keyword":"include"},c:[t.inherit(r,{cN:"meta-string"}),{cN:"meta-string",b:"<",e:">",i:"\\n"}]},r,t.CLCM,t.CBCM]},a=t.IR+"\\s*\\(",c={keyword:"int float while private char catch export virtual operator sizeof dynamic_cast|10 typedef const_cast|10 const struct for static_cast|10 union namespace unsigned long volatile static protected bool template mutable if public friend do goto auto void enum else break extern using class asm case typeid short reinterpret_cast|10 default double register explicit signed typename try this switch continue inline delete alignof constexpr decltype noexcept static_assert thread_local restrict _Bool complex _Complex _Imaginary atomic_bool atomic_char atomic_schar atomic_uchar atomic_short atomic_ushort atomic_int atomic_uint atomic_long atomic_ulong atomic_llong atomic_ullong",built_in:"std string cin cout cerr clog stdin stdout stderr stringstream istringstream ostringstream auto_ptr deque list queue stack vector map set bitset multiset multimap unordered_set unordered_map unordered_multiset unordered_multimap array shared_ptr abort abs acos asin atan2 atan calloc ceil cosh cos exit exp fabs floor fmod fprintf fputs free frexp fscanf isalnum isalpha iscntrl isdigit isgraph islower isprint ispunct isspace isupper isxdigit tolower toupper labs ldexp log10 log malloc realloc memchr memcmp memcpy memset modf pow printf putchar puts scanf sinh sin snprintf sprintf sqrt sscanf strcat strchr strcmp strcpy strcspn strlen strncat strncmp strncpy strpbrk strrchr strspn strstr tanh tan vfprintf vprintf vsprintf endl initializer_list unique_ptr",literal:"true false nullptr NULL"};return{aliases:["c","cc","h","c++","h++","hpp"],k:c,i:"</",c:[e,t.CLCM,t.CBCM,i,r,s,{b:"\\b(deque|list|queue|stack|vector|map|set|bitset|multiset|multimap|unordered_map|unordered_set|unordered_multiset|unordered_multimap|array)\\s*<",e:">",k:c,c:["self",e]},{b:t.IR+"::",k:c},{bK:"new throw return else",r:0},{cN:"function",b:"("+t.IR+"[\\*&\\s]+)+"+a,rB:!0,e:/[{;=]/,eE:!0,k:c,i:/[^\w\s\*&]/,c:[{b:a,rB:!0,c:[t.TM],r:0},{cN:"params",b:/\(/,e:/\)/,k:c,r:0,c:[t.CLCM,t.CBCM,r,i]},t.CLCM,t.CBCM,s]}]}});hljs.registerLanguage("gradle",function(e){return{cI:!0,k:{keyword:"task project allprojects subprojects artifacts buildscript configurations dependencies repositories sourceSets description delete from into include exclude source classpath destinationDir includes options sourceCompatibility targetCompatibility group flatDir doLast doFirst flatten todir fromdir ant def abstract break case catch continue default do else extends final finally for if implements instanceof native new private protected public return static switch synchronized throw throws transient try volatile while strictfp package import false null super this true antlrtask checkstyle codenarc copy boolean byte char class double float int interface long short void compile runTime file fileTree abs any append asList asWritable call collect compareTo count div dump each eachByte eachFile eachLine every find findAll flatten getAt getErr getIn getOut getText grep immutable inject inspect intersect invokeMethods isCase join leftShift minus multiply newInputStream newOutputStream newPrintWriter newReader newWriter next plus pop power previous print println push putAt read readBytes readLines reverse reverseEach round size sort splitEachLine step subMap times toInteger toList tokenize upto waitForOrKill withPrintWriter withReader withStream withWriter withWriterAppend write writeLine"},c:[e.CLCM,e.CBCM,e.ASM,e.QSM,e.NM,e.RM]}});hljs.registerLanguage("elixir",function(e){var r="[a-zA-Z_][a-zA-Z0-9_]*(\\!|\\?)?",n="[a-zA-Z_]\\w*[!?=]?|[-+~]\\@|<<|>>|=~|===?|<=>|[<>]=?|\\*\\*|[-/+%^&*~`|]|\\[\\]=?",b="and false then defined module in return redo retry end for true self when next until do begin unless nil break not case cond alias while ensure or include use alias fn quote",c={cN:"subst",b:"#\\{",e:"}",l:r,k:b},a={cN:"string",c:[e.BE,c],v:[{b:/'/,e:/'/},{b:/"/,e:/"/}]},i={cN:"function",bK:"def defp defmacro",e:/\B\b/,c:[e.inherit(e.TM,{b:r,endsParent:!0})]},s=e.inherit(i,{cN:"class",bK:"defmodule defrecord",e:/\bdo\b|$|;/}),l=[a,e.HCM,s,i,{cN:"symbol",b:":",c:[a,{b:n}],r:0},{cN:"symbol",b:r+":",r:0},{cN:"number",b:"(\\b0[0-7_]+)|(\\b0x[0-9a-fA-F_]+)|(\\b[1-9][0-9_]*(\\.[0-9_]+)?)|[0_]\\b",r:0},{cN:"variable",b:"(\\$\\W)|((\\$|\\@\\@?)(\\w+))"},{b:"->"},{b:"("+e.RSR+")\\s*",c:[e.HCM,{cN:"regexp",i:"\\n",c:[e.BE,c],v:[{b:"/",e:"/[a-z]*"},{b:"%r\\[",e:"\\][a-z]*"}]}],r:0}];return c.c=l,{l:r,k:b,c:l}});hljs.registerLanguage("http",function(e){var t="HTTP/[0-9\\.]+";return{aliases:["https"],i:"\\S",c:[{b:"^"+t,e:"$",c:[{cN:"number",b:"\\b\\d{3}\\b"}]},{b:"^[A-Z]+ (.*?) "+t+"$",rB:!0,e:"$",c:[{cN:"string",b:" ",e:" ",eB:!0,eE:!0},{b:t},{cN:"keyword",b:"[A-Z]+"}]},{cN:"attribute",b:"^\\w",e:": ",eE:!0,i:"\\n|\\s|=",starts:{e:"$",r:0}},{b:"\\n\\n",starts:{sL:[],eW:!0}}]}});hljs.registerLanguage("delphi",function(e){var r="exports register file shl array record property for mod while set ally label uses raise not stored class safecall var interface or private static exit index inherited to else stdcall override shr asm far resourcestring finalization packed virtual out and protected library do xorwrite goto near function end div overload object unit begin string on inline repeat until destructor write message program with read initialization except default nil if case cdecl in downto threadvar of try pascal const external constructor type public then implementation finally published procedure",t=[e.CLCM,e.C(/\{/,/\}/,{r:0}),e.C(/\(\*/,/\*\)/,{r:10})],a={cN:"string",b:/'/,e:/'/,c:[{b:/''/}]},i={cN:"string",b:/(#\d+)+/},c={b:e.IR+"\\s*=\\s*class\\s*\\(",rB:!0,c:[e.TM]},o={cN:"function",bK:"function constructor destructor procedure",e:/[:;]/,k:"function constructor|10 destructor|10 procedure|10",c:[e.TM,{cN:"params",b:/\(/,e:/\)/,k:r,c:[a,i]}].concat(t)};return{aliases:["dpr","dfm","pas","pascal","freepascal","lazarus","lpr","lfm"],cI:!0,k:r,i:/"|\$[G-Zg-z]|\/\*|<\/|\|/,c:[a,i,e.NM,c,o].concat(t)}});hljs.registerLanguage("ruby",function(e){var b="[a-zA-Z_]\\w*[!?=]?|[-+~]\\@|<<|>>|=~|===?|<=>|[<>]=?|\\*\\*|[-/+%^&*~`|]|\\[\\]=?",c="and false then defined module in return redo if BEGIN retry end for true self when next until do begin unless END rescue nil else break undef not super class case require yield alias while ensure elsif or include attr_reader attr_writer attr_accessor",r={cN:"doctag",b:"@[A-Za-z]+"},a={b:"#<",e:">"},s=[e.C("#","$",{c:[r]}),e.C("^\\=begin","^\\=end",{c:[r],r:10}),e.C("^__END__","\\n$")],n={cN:"subst",b:"#\\{",e:"}",k:c},t={cN:"string",c:[e.BE,n],v:[{b:/'/,e:/'/},{b:/"/,e:/"/},{b:/`/,e:/`/},{b:"%[qQwWx]?\\(",e:"\\)"},{b:"%[qQwWx]?\\[",e:"\\]"},{b:"%[qQwWx]?{",e:"}"},{b:"%[qQwWx]?<",e:">"},{b:"%[qQwWx]?/",e:"/"},{b:"%[qQwWx]?%",e:"%"},{b:"%[qQwWx]?-",e:"-"},{b:"%[qQwWx]?\\|",e:"\\|"},{b:/\B\?(\\\d{1,3}|\\x[A-Fa-f0-9]{1,2}|\\u[A-Fa-f0-9]{4}|\\?\S)\b/}]},i={cN:"params",b:"\\(",e:"\\)",endsParent:!0,k:c},d=[t,a,{cN:"class",bK:"class module",e:"$|;",i:/=/,c:[e.inherit(e.TM,{b:"[A-Za-z_]\\w*(::\\w+)*(\\?|\\!)?"}),{b:"<\\s*",c:[{b:"("+e.IR+"::)?"+e.IR}]}].concat(s)},{cN:"function",bK:"def",e:"$|;",c:[e.inherit(e.TM,{b:b}),i].concat(s)},{cN:"symbol",b:e.UIR+"(\\!|\\?)?:",r:0},{cN:"symbol",b:":",c:[t,{b:b}],r:0},{cN:"number",b:"(\\b0[0-7_]+)|(\\b0x[0-9a-fA-F_]+)|(\\b[1-9][0-9_]*(\\.[0-9_]+)?)|[0_]\\b",r:0},{b:"(\\$\\W)|((\\$|\\@\\@?)(\\w+))"},{b:"("+e.RSR+")\\s*",c:[a,{cN:"regexp",c:[e.BE,n],i:/\n/,v:[{b:"/",e:"/[a-z]*"},{b:"%r{",e:"}[a-z]*"},{b:"%r\\(",e:"\\)[a-z]*"},{b:"%r!",e:"![a-z]*"},{b:"%r\\[",e:"\\][a-z]*"}]}].concat(s),r:0}].concat(s);n.c=d,i.c=d;var o="[>?]>",l="[\\w#]+\\(\\w+\\):\\d+:\\d+>",u="(\\w+-)?\\d+\\.\\d+\\.\\d(p\\d+)?[^>]+>",w=[{b:/^\s*=>/,starts:{e:"$",c:d}},{cN:"meta",b:"^("+o+"|"+l+"|"+u+")",starts:{e:"$",c:d}}];return{aliases:["rb","gemspec","podspec","thor","irb"],k:c,i:/\/\*/,c:s.concat(w).concat(d)}});hljs.registerLanguage("ceylon",function(e){var a="assembly module package import alias class interface object given value assign void function new of extends satisfies abstracts in out return break continue throw assert dynamic if else switch case for while try catch finally then let this outer super is exists nonempty",t="shared abstract formal default actual variable late native deprecatedfinal sealed annotation suppressWarnings small",s="doc by license see throws tagged",n={cN:"subst",eB:!0,eE:!0,b:/``/,e:/``/,k:a,r:10},r=[{cN:"string",b:'"""',e:'"""',r:10},{cN:"string",b:'"',e:'"',c:[n]},{cN:"string",b:"'",e:"'"},{cN:"number",b:"#[0-9a-fA-F_]+|\\$[01_]+|[0-9_]+(?:\\.[0-9_](?:[eE][+-]?\\d+)?)?[kMGTPmunpf]?",r:0}];return n.c=r,{k:{keyword:a+" "+t,meta:s},i:"\\$[^01]|#[^0-9a-fA-F]",c:[e.CLCM,e.C("/\\*","\\*/",{c:["self"]}),{cN:"meta",b:'@[a-z]\\w*(?:\\:"[^"]*")?'}].concat(r)}});hljs.registerLanguage("dts",function(e){var a={cN:"string",v:[e.inherit(e.QSM,{b:'((u8?|U)|L)?"'}),{b:'(u8?|U)?R"',e:'"',c:[e.BE]},{b:"'\\\\?.",e:"'",i:"."}]},c={cN:"number",v:[{b:"\\b(\\d+(\\.\\d*)?|\\.\\d+)(u|U|l|L|ul|UL|f|F)"},{b:e.CNR}],r:0},b={cN:"meta",b:"#",e:"$",k:{"meta-keyword":"if else elif endif define undef ifdef ifndef"},c:[{b:/\\\n/,r:0},{bK:"include",e:"$",k:{"meta-keyword":"include"},c:[e.inherit(a,{cN:"meta-string"}),{cN:"meta-string",b:"<",e:">",i:"\\n"}]},a,e.CLCM,e.CBCM]},i={cN:"variable",b:"\\&[a-z\\d_]*\\b"},r={cN:"meta-keyword",b:"/[a-z][a-z\\d-]*/"},d={cN:"symbol",b:"^\\s*[a-zA-Z_][a-zA-Z\\d_]*:"},n={cN:"params",b:"<",e:">",c:[c,i]},s={cN:"class",b:/[a-zA-Z_][a-zA-Z\d_@]*\s{/,e:/[{;=]/,rB:!0,eE:!0},t={cN:"class",b:"/\\s*{",e:"};",r:10,c:[i,r,d,s,n,e.CLCM,e.CBCM,c,a]};return{k:"",c:[t,i,r,d,s,n,e.CLCM,e.CBCM,c,a,b,{b:e.IR+"::",k:""}]}});hljs.registerLanguage("django",function(e){var t={b:/\|[A-Za-z]+:?/,k:{name:"truncatewords removetags linebreaksbr yesno get_digit timesince random striptags filesizeformat escape linebreaks length_is ljust rjust cut urlize fix_ampersands title floatformat capfirst pprint divisibleby add make_list unordered_list urlencode timeuntil urlizetrunc wordcount stringformat linenumbers slice date dictsort dictsortreversed default_if_none pluralize lower join center default truncatewords_html upper length phone2numeric wordwrap time addslashes slugify first escapejs force_escape iriencode last safe safeseq truncatechars localize unlocalize localtime utc timezone"},c:[e.QSM,e.ASM]};return{aliases:["jinja"],cI:!0,sL:"xml",c:[e.C(/\{%\s*comment\s*%}/,/\{%\s*endcomment\s*%}/),e.C(/\{#/,/#}/),{cN:"template-tag",b:/\{%/,e:/%}/,c:[{cN:"name",b:/\w+/,k:{name:"comment endcomment load templatetag ifchanged endifchanged if endif firstof for endfor ifnotequal endifnotequal widthratio extends include spaceless endspaceless regroup ifequal endifequal ssi now with cycle url filter endfilter debug block endblock else autoescape endautoescape csrf_token empty elif endwith static trans blocktrans endblocktrans get_static_prefix get_media_prefix plural get_current_language language get_available_languages get_current_language_bidi get_language_info get_language_info_list localize endlocalize localtime endlocaltime timezone endtimezone get_current_timezone verbatim"},starts:{eW:!0,k:"in by as",c:[t],r:0}}]},{cN:"template-variable",b:/\{\{/,e:/}}/,c:[t]}]}});hljs.registerLanguage("css",function(e){var c="[a-zA-Z-][a-zA-Z0-9_-]*",t={b:/[A-Z\_\.\-]+\s*:/,rB:!0,e:";",eW:!0,c:[{cN:"attribute",b:/\S/,e:":",eE:!0,starts:{eW:!0,eE:!0,c:[{b:/[\w-]+\(/,rB:!0,c:[{cN:"built_in",b:/[\w-]+/},{b:/\(/,e:/\)/,c:[e.ASM,e.QSM]}]},e.CSSNM,e.QSM,e.ASM,e.CBCM,{cN:"number",b:"#[0-9A-Fa-f]+"},{cN:"meta",b:"!important"}]}}]};return{cI:!0,i:/[=\/|'\$]/,c:[e.CBCM,{cN:"selector-id",b:/#[A-Za-z0-9_-]+/},{cN:"selector-class",b:/\.[A-Za-z0-9_-]+/},{cN:"selector-attr",b:/\[/,e:/\]/,i:"$"},{cN:"selector-pseudo",b:/:(:)?[a-zA-Z0-9\_\-\+\(\)"'.]+/},{b:"@(font-face|page)",l:"[a-z-]+",k:"font-face page"},{b:"@",e:"[{;]",c:[{cN:"keyword",b:/\S+/},{b:/\s/,eW:!0,eE:!0,r:0,c:[e.ASM,e.QSM,e.CSSNM]}]},{cN:"selector-tag",b:c,r:0},{b:"{",e:"}",i:/\S/,c:[e.CBCM,t]}]}});hljs.registerLanguage("qml",function(r){var e={keyword:"in of on if for while finally var new function do return void else break catch instanceof with throw case default try this switch continue typeof delete let yield const export super debugger as async await",literal:"true false null undefined NaN Infinity",built_in:"eval isFinite isNaN parseFloat parseInt decodeURI decodeURIComponent encodeURI encodeURIComponent escape unescape Object Function Boolean Error EvalError InternalError RangeError ReferenceError StopIteration SyntaxError TypeError URIError Number Math Date String RegExp Array Float32Array Float64Array Int16Array Int32Array Int8Array Uint16Array Uint32Array Uint8Array Uint8ClampedArray ArrayBuffer DataView JSON Intl arguments require module console window document Symbol Set Map WeakSet WeakMap Proxy Reflect Behavior bool color coordinate date double enumeration font geocircle georectangle geoshape int list matrix4x4 parent point quaternion real rect size string url var variant vector2d vector3d vector4dPromise"},t="[a-zA-Z_][a-zA-Z0-9\\._]*",a={cN:"string",b:"(\\b|\"|')",e:"(//|/\\*|$)",i:"\\n",c:[r.BE]},n={bK:"import",e:"$",starts:{cN:"string",e:"(//|/\\*|$)",rE:!0},c:[a]},o={cN:"keyword",b:"\\bproperty\\b",starts:{cN:"string",e:"(:|=|;|,|//|/\\*|$)",rE:!0},r:0},i={cN:"keyword",b:"\\bsignal\\b",starts:{cN:"string",e:"(\\(|:|=|;|,|//|/\\*|$)",rE:!0},r:10},c={cN:"attribute",b:"\\bid\\s*:",starts:{cN:"emphasis",e:t,rE:!1},r:10},s={b:t+"\\s*:",rB:!0,c:[{cN:"attribute",b:t,includeBegin:!0,e:"\\s*:",eE:!0}],r:0},b={b:t+"\\s*{",rB:!0,c:[{cN:"decorator",k:e,b:t,includeBegin:!0,e:"\\s*{",eE:!0}],r:0};return{aliases:["qt"],cI:!1,k:e,c:[{cN:"pi",b:/^\s*['"]use (strict|asm)['"]/},r.ASM,r.QSM,{cN:"string",b:"`",e:"`",c:[r.BE,{cN:"subst",b:"\\$\\{",e:"\\}"}]},r.CLCM,r.CBCM,{cN:"number",v:[{b:"\\b(0[bB][01]+)"},{b:"\\b(0[oO][0-7]+)"},{b:r.CNR}],r:0},{b:"("+r.RSR+"|\\b(case|return|throw)\\b)\\s*",k:"return throw case",c:[r.CLCM,r.CBCM,r.RM,{b:/</,e:/>\s*[);\]]/,r:0,sL:"xml"}],r:0},n,i,o,{cN:"function",bK:"function",e:/\{/,eE:!0,c:[r.inherit(r.TM,{b:/[A-Za-z$_][0-9A-Za-z$_]*/}),{cN:"params",b:/\(/,e:/\)/,eB:!0,eE:!0,c:[r.CLCM,r.CBCM]}],i:/\[|%/},{b:"\\."+r.IR,r:0},c,s,b],i:/#/}});hljs.registerLanguage("coffeescript",function(e){var c={keyword:"in if for while finally new do return else break catch instanceof throw try this switch continue typeof delete debugger super then unless until loop of by when and or is isnt not",literal:"true false null undefined yes no on off",built_in:"npm require console print module global window document"},n="[A-Za-z$_][0-9A-Za-z$_]*",r={cN:"subst",b:/#\{/,e:/}/,k:c},s=[e.BNM,e.inherit(e.CNM,{starts:{e:"(\\s*/)?",r:0}}),{cN:"string",v:[{b:/'''/,e:/'''/,c:[e.BE]},{b:/'/,e:/'/,c:[e.BE]},{b:/"""/,e:/"""/,c:[e.BE,r]},{b:/"/,e:/"/,c:[e.BE,r]}]},{cN:"regexp",v:[{b:"///",e:"///",c:[r,e.HCM]},{b:"//[gim]*",r:0},{b:/\/(?![ *])(\\\/|.)*?\/[gim]*(?=\W|$)/}]},{b:"@"+n},{b:"`",e:"`",eB:!0,eE:!0,sL:"javascript"}];r.c=s;var i=e.inherit(e.TM,{b:n}),t="(\\(.*\\))?\\s*\\B[-=]>",o={cN:"params",b:"\\([^\\(]",rB:!0,c:[{b:/\(/,e:/\)/,k:c,c:["self"].concat(s)}]};return{aliases:["coffee","cson","iced"],k:c,i:/\/\*/,c:s.concat([e.C("###","###"),e.HCM,{cN:"function",b:"^\\s*"+n+"\\s*=\\s*"+t,e:"[-=]>",rB:!0,c:[i,o]},{b:/[:\(,=]\s*/,r:0,c:[{cN:"function",b:t,e:"[-=]>",rB:!0,c:[o]}]},{cN:"class",bK:"class",e:"$",i:/[:="\[\]]/,c:[{bK:"extends",eW:!0,i:/[:="\[\]]/,c:[i]},i]},{b:n+":",e:":",rB:!0,rE:!0,r:0}])}});hljs.registerLanguage("vbscript",function(e){return{aliases:["vbs"],cI:!0,k:{keyword:"call class const dim do loop erase execute executeglobal exit for each next function if then else on error option explicit new private property let get public randomize redim rem select case set stop sub while wend with end to elseif is or xor and not class_initialize class_terminate default preserve in me byval byref step resume goto",built_in:"lcase month vartype instrrev ubound setlocale getobject rgb getref string weekdayname rnd dateadd monthname now day minute isarray cbool round formatcurrency conversions csng timevalue second year space abs clng timeserial fixs len asc isempty maths dateserial atn timer isobject filter weekday datevalue ccur isdate instr datediff formatdatetime replace isnull right sgn array snumeric log cdbl hex chr lbound msgbox ucase getlocale cos cdate cbyte rtrim join hour oct typename trim strcomp int createobject loadpicture tan formatnumber mid scriptenginebuildversion scriptengine split scriptengineminorversion cint sin datepart ltrim sqr scriptenginemajorversion time derived eval date formatpercent exp inputbox left ascw chrw regexp server response request cstr err",literal:"true false null nothing empty"},i:"//",c:[e.inherit(e.QSM,{c:[{b:'""'}]}),e.C(/'/,/$/,{r:0}),e.CNM]}});hljs.registerLanguage("fsharp",function(e){var t={b:"<",e:">",c:[e.inherit(e.TM,{b:/'[a-zA-Z0-9_]+/})]};return{aliases:["fs"],k:"abstract and as assert base begin class default delegate do done downcast downto elif else end exception extern false finally for fun function global if in inherit inline interface internal lazy let match member module mutable namespace new null of open or override private public rec return sig static struct then to true try type upcast use val void when while with yield",i:/\/\*/,c:[{cN:"keyword",b:/\b(yield|return|let|do)!/},{cN:"string",b:'@"',e:'"',c:[{b:'""'}]},{cN:"string",b:'"""',e:'"""'},e.C("\\(\\*","\\*\\)"),{cN:"class",bK:"type",e:"\\(|=|$",eE:!0,c:[e.UTM,t]},{cN:"meta",b:"\\[<",e:">\\]",r:10},{cN:"symbol",b:"\\B('[A-Za-z])\\b",c:[e.BE]},e.CLCM,e.inherit(e.QSM,{i:null}),e.CNM]}});hljs.registerLanguage("dart",function(e){var t={cN:"subst",b:"\\$\\{",e:"}",k:"true false null this is new super"},r={cN:"string",v:[{b:"r'''",e:"'''"},{b:'r"""',e:'"""'},{b:"r'",e:"'",i:"\\n"},{b:'r"',e:'"',i:"\\n"},{b:"'''",e:"'''",c:[e.BE,t]},{b:'"""',e:'"""',c:[e.BE,t]},{b:"'",e:"'",i:"\\n",c:[e.BE,t]},{b:'"',e:'"',i:"\\n",c:[e.BE,t]}]};t.c=[e.CNM,r];var n={keyword:"assert async await break case catch class const continue default do else enum extends false final finally for if in is new null rethrow return super switch sync this throw true try var void while with yield abstract as dynamic export external factory get implements import library operator part set static typedef",built_in:"print Comparable DateTime Duration Function Iterable Iterator List Map Match Null Object Pattern RegExp Set Stopwatch String StringBuffer StringSink Symbol Type Uri bool double int num document window querySelector querySelectorAll Element ElementList"};return{k:n,c:[r,e.C("/\\*\\*","\\*/",{sL:"markdown"}),e.C("///","$",{sL:"markdown"}),e.CLCM,e.CBCM,{cN:"class",bK:"class interface",e:"{",eE:!0,c:[{bK:"extends implements"},e.UTM]},e.CNM,{cN:"meta",b:"@[A-Za-z]+"},{b:"=>"}]}});hljs.registerLanguage("asciidoc",function(e){return{aliases:["adoc"],c:[e.C("^/{4,}\\n","\\n/{4,}$",{r:10}),e.C("^//","$",{r:0}),{cN:"title",b:"^\\.\\w.*$"},{b:"^[=\\*]{4,}\\n",e:"\\n^[=\\*]{4,}$",r:10},{cN:"section",r:10,v:[{b:"^(={1,5}) .+?( \\1)?$"},{b:"^[^\\[\\]\\n]+?\\n[=\\-~\\^\\+]{2,}$"}]},{cN:"meta",b:"^:.+?:",e:"\\s",eE:!0,r:10},{cN:"meta",b:"^\\[.+?\\]$",r:0},{cN:"quote",b:"^_{4,}\\n",e:"\\n_{4,}$",r:10},{cN:"code",b:"^[\\-\\.]{4,}\\n",e:"\\n[\\-\\.]{4,}$",r:10},{b:"^\\+{4,}\\n",e:"\\n\\+{4,}$",c:[{b:"<",e:">",sL:"xml",r:0}],r:10},{cN:"bullet",b:"^(\\*+|\\-+|\\.+|[^\\n]+?::)\\s+"},{cN:"symbol",b:"^(NOTE|TIP|IMPORTANT|WARNING|CAUTION):\\s+",r:10},{cN:"strong",b:"\\B\\*(?![\\*\\s])",e:"(\\n{2}|\\*)",c:[{b:"\\\\*\\w",r:0}]},{cN:"emphasis",b:"\\B'(?!['\\s])",e:"(\\n{2}|')",c:[{b:"\\\\'\\w",r:0}],r:0},{cN:"emphasis",b:"_(?![_\\s])",e:"(\\n{2}|_)",r:0},{cN:"string",v:[{b:"``.+?''"},{b:"`.+?'"}]},{cN:"code",b:"(`.+?`|\\+.+?\\+)",r:0},{cN:"code",b:"^[ \\t]",e:"$",r:0},{b:"^'{3,}[ \\t]*$",r:10},{b:"(link:)?(http|https|ftp|file|irc|image:?):\\S+\\[.*?\\]",rB:!0,c:[{b:"(link|image:?):",r:0},{cN:"link",b:"\\w",e:"[^\\[]+",r:0},{cN:"string",b:"\\[",e:"\\]",eB:!0,eE:!0,r:0}],r:10}]}});hljs.registerLanguage("dos",function(e){var r=e.C(/@?rem\b/,/$/,{r:10}),t={cN:"symbol",b:"^\\s*[A-Za-z._?][A-Za-z0-9_$#@~.?]*(:|\\s+label)",r:0};return{aliases:["bat","cmd"],cI:!0,i:/\/\*/,k:{keyword:"if else goto for in do call exit not exist errorlevel defined equ neq lss leq gtr geq",built_in:"prn nul lpt3 lpt2 lpt1 con com4 com3 com2 com1 aux shift cd dir echo setlocal endlocal set pause copy append assoc at attrib break cacls cd chcp chdir chkdsk chkntfs cls cmd color comp compact convert date dir diskcomp diskcopy doskey erase fs find findstr format ftype graftabl help keyb label md mkdir mode more move path pause print popd pushd promt rd recover rem rename replace restore rmdir shiftsort start subst time title tree type ver verify vol ping net ipconfig taskkill xcopy ren del"},c:[{cN:"variable",b:/%%[^ ]|%[^ ]+?%|![^ ]+?!/},{cN:"function",b:t.b,e:"goto:eof",c:[e.inherit(e.TM,{b:"([_a-zA-Z]\\w*\\.)*([_a-zA-Z]\\w*:)?[_a-zA-Z]\\w*"}),r]},{cN:"number",b:"\\b\\d+",r:0},r]}});hljs.registerLanguage("lua",function(e){var t="\\[=*\\[",a="\\]=*\\]",r={b:t,e:a,c:["self"]},n=[e.C("--(?!"+t+")","$"),e.C("--"+t,a,{c:[r],r:10})];return{l:e.UIR,k:{keyword:"and break do else elseif end false for if in local nil not or repeat return then true until while",built_in:"_G _VERSION assert collectgarbage dofile error getfenv getmetatable ipairs load loadfile loadstring module next pairs pcall print rawequal rawget rawset require select setfenv setmetatable tonumber tostring type unpack xpcall coroutine debug io math os package string table"},c:n.concat([{cN:"function",bK:"function",e:"\\)",c:[e.inherit(e.TM,{b:"([_a-zA-Z]\\w*\\.)*([_a-zA-Z]\\w*:)?[_a-zA-Z]\\w*"}),{cN:"params",b:"\\(",eW:!0,c:n}].concat(n)},e.CNM,e.ASM,e.QSM,{cN:"string",b:t,e:a,c:[r],r:5}])}});hljs.registerLanguage("julia",function(e){var r={keyword:"in abstract baremodule begin bitstype break catch ccall const continue do else elseif end export finally for function global if immutable import importall let local macro module quote return try type typealias using while",literal:"true false ARGS CPU_CORES C_NULL DL_LOAD_PATH DevNull ENDIAN_BOM ENV I|0 Inf Inf16 Inf32 InsertionSort JULIA_HOME LOAD_PATH MS_ASYNC MS_INVALIDATE MS_SYNC MergeSort NaN NaN16 NaN32 OS_NAME QuickSort RTLD_DEEPBIND RTLD_FIRST RTLD_GLOBAL RTLD_LAZY RTLD_LOCAL RTLD_NODELETE RTLD_NOLOAD RTLD_NOW RoundDown RoundFromZero RoundNearest RoundToZero RoundUp STDERR STDIN STDOUT VERSION WORD_SIZE catalan cglobal e|0 eu|0 eulergamma golden im nothing pi γ π φ Inf64 NaN64 RoundNearestTiesAway RoundNearestTiesUp ",built_in:"ANY ASCIIString AbstractArray AbstractRNG AbstractSparseArray Any ArgumentError Array Associative Base64Pipe Bidiagonal BigFloat BigInt BitArray BitMatrix BitVector Bool BoundsError Box CFILE Cchar Cdouble Cfloat Char CharString Cint Clong Clonglong ClusterManager Cmd Coff_t Colon Complex Complex128 Complex32 Complex64 Condition Cptrdiff_t Cshort Csize_t Cssize_t Cuchar Cuint Culong Culonglong Cushort Cwchar_t DArray DataType DenseArray Diagonal Dict DimensionMismatch DirectIndexString Display DivideError DomainError EOFError EachLine Enumerate ErrorException Exception Expr Factorization FileMonitor FileOffset Filter Float16 Float32 Float64 FloatRange FloatingPoint Function GetfieldNode GotoNode Hermitian IO IOBuffer IOStream IPv4 IPv6 InexactError Int Int128 Int16 Int32 Int64 Int8 IntSet Integer InterruptException IntrinsicFunction KeyError LabelNode LambdaStaticData LineNumberNode LoadError LocalProcess MIME MathConst MemoryError MersenneTwister Method MethodError MethodTable Module NTuple NewvarNode Nothing Number ObjectIdDict OrdinalRange OverflowError ParseError PollingFileWatcher ProcessExitedException ProcessGroup Ptr QuoteNode Range Range1 Ranges Rational RawFD Real Regex RegexMatch RemoteRef RepString RevString RopeString RoundingMode Set SharedArray Signed SparseMatrixCSC StackOverflowError Stat StatStruct StepRange String SubArray SubString SymTridiagonal Symbol SymbolNode Symmetric SystemError Task TextDisplay Timer TmStruct TopNode Triangular Tridiagonal Type TypeConstructor TypeError TypeName TypeVar UTF16String UTF32String UTF8String UdpSocket Uint Uint128 Uint16 Uint32 Uint64 Uint8 UndefRefError UndefVarError UniformScaling UnionType UnitRange Unsigned Vararg VersionNumber WString WeakKeyDict WeakRef Woodbury Zip AbstractChannel AbstractFloat AbstractString AssertionError Base64DecodePipe Base64EncodePipe BufferStream CapturedException CartesianIndex CartesianRange Channel Cintmax_t CompositeException Cstring Cuintmax_t Cwstring Date DateTime Dims Enum GenSym GlobalRef HTML InitError InvalidStateException Irrational LinSpace LowerTriangular NullException Nullable OutOfMemoryError Pair PartialQuickSort Pipe RandomDevice ReadOnlyMemoryError ReentrantLock Ref RemoteException SegmentationFault SerializationState SimpleVector TCPSocket Text Tuple UDPSocket UInt UInt128 UInt16 UInt32 UInt64 UInt8 UnicodeError Union UpperTriangular Val Void WorkerConfig AbstractMatrix AbstractSparseMatrix AbstractSparseVector AbstractVecOrMat AbstractVector DenseMatrix DenseVecOrMat DenseVector Matrix SharedMatrix SharedVector StridedArray StridedMatrix StridedVecOrMat StridedVector VecOrMat Vector "},t="[A-Za-z_\\u00A1-\\uFFFF][A-Za-z_0-9\\u00A1-\\uFFFF]*",a={l:t,k:r,i:/<\//},n={cN:"type",b:/::/},o={cN:"type",b:/<:/},i={cN:"number",b:/(\b0x[\d_]*(\.[\d_]*)?|0x\.\d[\d_]*)p[-+]?\d+|\b0[box][a-fA-F0-9][a-fA-F0-9_]*|(\b\d[\d_]*(\.[\d_]*)?|\.\d[\d_]*)([eEfF][-+]?\d+)?/,r:0},l={cN:"string",b:/'(.|\\[xXuU][a-zA-Z0-9]+)'/},c={cN:"subst",b:/\$\(/,e:/\)/,k:r},s={cN:"variable",b:"\\$"+t},d={cN:"string",c:[e.BE,c,s],v:[{b:/\w*"""/,e:/"""\w*/,r:10},{b:/\w*"/,e:/"\w*/}]},S={cN:"string",c:[e.BE,c,s],b:"`",e:"`"},u={cN:"meta",b:"@"+t},g={cN:"comment",v:[{b:"#=",e:"=#",r:10},{b:"#",e:"$"}]};return a.c=[i,l,n,o,d,S,u,g,e.HCM],c.c=a.c,a});hljs.registerLanguage("matlab",function(e){var a=[e.CNM,{cN:"string",b:"'",e:"'",c:[e.BE,{b:"''"}]}],s={r:0,c:[{b:/'['\.]*/}]};return{k:{keyword:"break case catch classdef continue else elseif end enumerated events for function global if methods otherwise parfor persistent properties return spmd switch try while",built_in:"sin sind sinh asin asind asinh cos cosd cosh acos acosd acosh tan tand tanh atan atand atan2 atanh sec secd sech asec asecd asech csc cscd csch acsc acscd acsch cot cotd coth acot acotd acoth hypot exp expm1 log log1p log10 log2 pow2 realpow reallog realsqrt sqrt nthroot nextpow2 abs angle complex conj imag real unwrap isreal cplxpair fix floor ceil round mod rem sign airy besselj bessely besselh besseli besselk beta betainc betaln ellipj ellipke erf erfc erfcx erfinv expint gamma gammainc gammaln psi legendre cross dot factor isprime primes gcd lcm rat rats perms nchoosek factorial cart2sph cart2pol pol2cart sph2cart hsv2rgb rgb2hsv zeros ones eye repmat rand randn linspace logspace freqspace meshgrid accumarray size length ndims numel disp isempty isequal isequalwithequalnans cat reshape diag blkdiag tril triu fliplr flipud flipdim rot90 find sub2ind ind2sub bsxfun ndgrid permute ipermute shiftdim circshift squeeze isscalar isvector ans eps realmax realmin pi i inf nan isnan isinf isfinite j why compan gallery hadamard hankel hilb invhilb magic pascal rosser toeplitz vander wilkinson"},i:'(//|"|#|/\\*|\\s+/\\w+)',c:[{cN:"function",bK:"function",e:"$",c:[e.UTM,{cN:"params",v:[{b:"\\(",e:"\\)"},{b:"\\[",e:"\\]"}]}]},{b:/[a-zA-Z_][a-zA-Z_0-9]*'['\.]*/,rB:!0,r:0,c:[{b:/[a-zA-Z_][a-zA-Z_0-9]*/,r:0},s.c[0]]},{b:"\\[",e:"\\]",c:a,r:0,starts:s},{b:"\\{",e:/}/,c:a,r:0,starts:s},{b:/\)/,r:0,starts:s},e.C("^\\s*\\%\\{\\s*$","^\\s*\\%\\}\\s*$"),e.C("\\%","$")].concat(a)}});hljs.registerLanguage("markdown",function(e){return{aliases:["md","mkdown","mkd"],c:[{cN:"section",v:[{b:"^#{1,6}",e:"$"},{b:"^.+?\\n[=-]{2,}$"}]},{b:"<",e:">",sL:"xml",r:0},{cN:"bullet",b:"^([*+-]|(\\d+\\.))\\s+"},{cN:"strong",b:"[*_]{2}.+?[*_]{2}"},{cN:"emphasis",v:[{b:"\\*.+?\\*"},{b:"_.+?_",r:0}]},{cN:"quote",b:"^>\\s+",e:"$"},{cN:"code",v:[{b:"`.+?`"},{b:"^( {4}|	)",e:"$",r:0}]},{b:"^[-\\*]{3,}",e:"$"},{b:"\\[.+?\\][\\(\\[].*?[\\)\\]]",rB:!0,c:[{cN:"string",b:"\\[",e:"\\]",eB:!0,rE:!0,r:0},{cN:"link",b:"\\]\\(",e:"\\)",eB:!0,eE:!0},{cN:"symbol",b:"\\]\\[",e:"\\]",eB:!0,eE:!0}],r:10},{b:"^\\[.+\\]:",rB:!0,c:[{cN:"symbol",b:"\\[",e:"\\]:",eB:!0,eE:!0,starts:{cN:"link",e:"$"}}]}]}});hljs.registerLanguage("vim",function(e){return{l:/[!#@\w]+/,k:{keyword:"N|0 P|0 X|0 a|0 ab abc abo al am an|0 ar arga argd arge argdo argg argl argu as au aug aun b|0 bN ba bad bd be bel bf bl bm bn bo bp br brea breaka breakd breakl bro bufdo buffers bun bw c|0 cN cNf ca cabc caddb cad caddf cal cat cb cc ccl cd ce cex cf cfir cgetb cgete cg changes chd che checkt cl cla clo cm cmapc cme cn cnew cnf cno cnorea cnoreme co col colo com comc comp con conf cope cp cpf cq cr cs cst cu cuna cunme cw delm deb debugg delc delf dif diffg diffo diffp diffpu diffs diffthis dig di dl dell dj dli do doautoa dp dr ds dsp e|0 ea ec echoe echoh echom echon el elsei em en endfo endf endt endw ene ex exe exi exu f|0 files filet fin fina fini fir fix fo foldc foldd folddoc foldo for fu go gr grepa gu gv ha helpf helpg helpt hi hid his ia iabc if ij il im imapc ime ino inorea inoreme int is isp iu iuna iunme j|0 ju k|0 keepa kee keepj lN lNf l|0 lad laddb laddf la lan lat lb lc lch lcl lcs le lefta let lex lf lfir lgetb lgete lg lgr lgrepa lh ll lla lli lmak lm lmapc lne lnew lnf ln loadk lo loc lockv lol lope lp lpf lr ls lt lu lua luad luaf lv lvimgrepa lw m|0 ma mak map mapc marks mat me menut mes mk mks mksp mkv mkvie mod mz mzf nbc nb nbs new nm nmapc nme nn nnoreme noa no noh norea noreme norm nu nun nunme ol o|0 om omapc ome on ono onoreme opt ou ounme ow p|0 profd prof pro promptr pc ped pe perld po popu pp pre prev ps pt ptN ptf ptj ptl ptn ptp ptr pts pu pw py3 python3 py3d py3f py pyd pyf quita qa rec red redi redr redraws reg res ret retu rew ri rightb rub rubyd rubyf rund ru rv sN san sa sal sav sb sbN sba sbf sbl sbm sbn sbp sbr scrip scripte scs se setf setg setl sf sfir sh sim sig sil sl sla sm smap smapc sme sn sni sno snor snoreme sor so spelld spe spelli spellr spellu spellw sp spr sre st sta startg startr star stopi stj sts sun sunm sunme sus sv sw sy synti sync tN tabN tabc tabdo tabe tabf tabfir tabl tabm tabnew tabn tabo tabp tabr tabs tab ta tags tc tcld tclf te tf th tj tl tm tn to tp tr try ts tu u|0 undoj undol una unh unl unlo unm unme uns up ve verb vert vim vimgrepa vi viu vie vm vmapc vme vne vn vnoreme vs vu vunme windo w|0 wN wa wh wi winc winp wn wp wq wqa ws wu wv x|0 xa xmapc xm xme xn xnoreme xu xunme y|0 z|0 ~ Next Print append abbreviate abclear aboveleft all amenu anoremenu args argadd argdelete argedit argglobal arglocal argument ascii autocmd augroup aunmenu buffer bNext ball badd bdelete behave belowright bfirst blast bmodified bnext botright bprevious brewind break breakadd breakdel breaklist browse bunload bwipeout change cNext cNfile cabbrev cabclear caddbuffer caddexpr caddfile call catch cbuffer cclose center cexpr cfile cfirst cgetbuffer cgetexpr cgetfile chdir checkpath checktime clist clast close cmap cmapclear cmenu cnext cnewer cnfile cnoremap cnoreabbrev cnoremenu copy colder colorscheme command comclear compiler continue confirm copen cprevious cpfile cquit crewind cscope cstag cunmap cunabbrev cunmenu cwindow delete delmarks debug debuggreedy delcommand delfunction diffupdate diffget diffoff diffpatch diffput diffsplit digraphs display deletel djump dlist doautocmd doautoall deletep drop dsearch dsplit edit earlier echo echoerr echohl echomsg else elseif emenu endif endfor endfunction endtry endwhile enew execute exit exusage file filetype find finally finish first fixdel fold foldclose folddoopen folddoclosed foldopen function global goto grep grepadd gui gvim hardcopy help helpfind helpgrep helptags highlight hide history insert iabbrev iabclear ijump ilist imap imapclear imenu inoremap inoreabbrev inoremenu intro isearch isplit iunmap iunabbrev iunmenu join jumps keepalt keepmarks keepjumps lNext lNfile list laddexpr laddbuffer laddfile last language later lbuffer lcd lchdir lclose lcscope left leftabove lexpr lfile lfirst lgetbuffer lgetexpr lgetfile lgrep lgrepadd lhelpgrep llast llist lmake lmap lmapclear lnext lnewer lnfile lnoremap loadkeymap loadview lockmarks lockvar lolder lopen lprevious lpfile lrewind ltag lunmap luado luafile lvimgrep lvimgrepadd lwindow move mark make mapclear match menu menutranslate messages mkexrc mksession mkspell mkvimrc mkview mode mzscheme mzfile nbclose nbkey nbsart next nmap nmapclear nmenu nnoremap nnoremenu noautocmd noremap nohlsearch noreabbrev noremenu normal number nunmap nunmenu oldfiles open omap omapclear omenu only onoremap onoremenu options ounmap ounmenu ownsyntax print profdel profile promptfind promptrepl pclose pedit perl perldo pop popup ppop preserve previous psearch ptag ptNext ptfirst ptjump ptlast ptnext ptprevious ptrewind ptselect put pwd py3do py3file python pydo pyfile quit quitall qall read recover redo redir redraw redrawstatus registers resize retab return rewind right rightbelow ruby rubydo rubyfile rundo runtime rviminfo substitute sNext sandbox sargument sall saveas sbuffer sbNext sball sbfirst sblast sbmodified sbnext sbprevious sbrewind scriptnames scriptencoding scscope set setfiletype setglobal setlocal sfind sfirst shell simalt sign silent sleep slast smagic smapclear smenu snext sniff snomagic snoremap snoremenu sort source spelldump spellgood spellinfo spellrepall spellundo spellwrong split sprevious srewind stop stag startgreplace startreplace startinsert stopinsert stjump stselect sunhide sunmap sunmenu suspend sview swapname syntax syntime syncbind tNext tabNext tabclose tabedit tabfind tabfirst tablast tabmove tabnext tabonly tabprevious tabrewind tag tcl tcldo tclfile tearoff tfirst throw tjump tlast tmenu tnext topleft tprevious trewind tselect tunmenu undo undojoin undolist unabbreviate unhide unlet unlockvar unmap unmenu unsilent update vglobal version verbose vertical vimgrep vimgrepadd visual viusage view vmap vmapclear vmenu vnew vnoremap vnoremenu vsplit vunmap vunmenu write wNext wall while winsize wincmd winpos wnext wprevious wqall wsverb wundo wviminfo xit xall xmapclear xmap xmenu xnoremap xnoremenu xunmap xunmenu yank",built_in:"synIDtrans atan2 range matcharg did_filetype asin feedkeys xor argv complete_check add getwinposx getqflist getwinposy screencol clearmatches empty extend getcmdpos mzeval garbagecollect setreg ceil sqrt diff_hlID inputsecret get getfperm getpid filewritable shiftwidth max sinh isdirectory synID system inputrestore winline atan visualmode inputlist tabpagewinnr round getregtype mapcheck hasmapto histdel argidx findfile sha256 exists toupper getcmdline taglist string getmatches bufnr strftime winwidth bufexists strtrans tabpagebuflist setcmdpos remote_read printf setloclist getpos getline bufwinnr float2nr len getcmdtype diff_filler luaeval resolve libcallnr foldclosedend reverse filter has_key bufname str2float strlen setline getcharmod setbufvar index searchpos shellescape undofile foldclosed setqflist buflisted strchars str2nr virtcol floor remove undotree remote_expr winheight gettabwinvar reltime cursor tabpagenr finddir localtime acos getloclist search tanh matchend rename gettabvar strdisplaywidth type abs py3eval setwinvar tolower wildmenumode log10 spellsuggest bufloaded synconcealed nextnonblank server2client complete settabwinvar executable input wincol setmatches getftype hlID inputsave searchpair or screenrow line settabvar histadd deepcopy strpart remote_peek and eval getftime submatch screenchar winsaveview matchadd mkdir screenattr getfontname libcall reltimestr getfsize winnr invert pow getbufline byte2line soundfold repeat fnameescape tagfiles sin strwidth spellbadword trunc maparg log lispindent hostname setpos globpath remote_foreground getchar synIDattr fnamemodify cscope_connection stridx winbufnr indent min complete_add nr2char searchpairpos inputdialog values matchlist items hlexists strridx browsedir expand fmod pathshorten line2byte argc count getwinvar glob foldtextresult getreg foreground cosh matchdelete has char2nr simplify histget searchdecl iconv winrestcmd pumvisible writefile foldlevel haslocaldir keys cos matchstr foldtext histnr tan tempname getcwd byteidx getbufvar islocked escape eventhandler remote_send serverlist winrestview synstack pyeval prevnonblank readfile cindent filereadable changenr exp"},i:/[{:]/,c:[e.NM,e.ASM,{cN:"string",b:/"(\\"|\n\\|[^"\n])*"/},e.C('"',"$"),{cN:"variable",b:/[bwtglsav]:[\w\d_]*/},{cN:"function",bK:"function function!",e:"$",r:0,c:[e.TM,{cN:"params",b:"\\(",e:"\\)"}]},{cN:"symbol",b:/<[\w-]+>/}]}});hljs.registerLanguage("ruleslanguage",function(T){return{k:{keyword:"BILL_PERIOD BILL_START BILL_STOP RS_EFFECTIVE_START RS_EFFECTIVE_STOP RS_JURIS_CODE RS_OPCO_CODE INTDADDATTRIBUTE|5 INTDADDVMSG|5 INTDBLOCKOP|5 INTDBLOCKOPNA|5 INTDCLOSE|5 INTDCOUNT|5 INTDCOUNTSTATUSCODE|5 INTDCREATEMASK|5 INTDCREATEDAYMASK|5 INTDCREATEFACTORMASK|5 INTDCREATEHANDLE|5 INTDCREATEOVERRIDEDAYMASK|5 INTDCREATEOVERRIDEMASK|5 INTDCREATESTATUSCODEMASK|5 INTDCREATETOUPERIOD|5 INTDDELETE|5 INTDDIPTEST|5 INTDEXPORT|5 INTDGETERRORCODE|5 INTDGETERRORMESSAGE|5 INTDISEQUAL|5 INTDJOIN|5 INTDLOAD|5 INTDLOADACTUALCUT|5 INTDLOADDATES|5 INTDLOADHIST|5 INTDLOADLIST|5 INTDLOADLISTDATES|5 INTDLOADLISTENERGY|5 INTDLOADLISTHIST|5 INTDLOADRELATEDCHANNEL|5 INTDLOADSP|5 INTDLOADSTAGING|5 INTDLOADUOM|5 INTDLOADUOMDATES|5 INTDLOADUOMHIST|5 INTDLOADVERSION|5 INTDOPEN|5 INTDREADFIRST|5 INTDREADNEXT|5 INTDRECCOUNT|5 INTDRELEASE|5 INTDREPLACE|5 INTDROLLAVG|5 INTDROLLPEAK|5 INTDSCALAROP|5 INTDSCALE|5 INTDSETATTRIBUTE|5 INTDSETDSTPARTICIPANT|5 INTDSETSTRING|5 INTDSETVALUE|5 INTDSETVALUESTATUS|5 INTDSHIFTSTARTTIME|5 INTDSMOOTH|5 INTDSORT|5 INTDSPIKETEST|5 INTDSUBSET|5 INTDTOU|5 INTDTOURELEASE|5 INTDTOUVALUE|5 INTDUPDATESTATS|5 INTDVALUE|5 STDEV INTDDELETEEX|5 INTDLOADEXACTUAL|5 INTDLOADEXCUT|5 INTDLOADEXDATES|5 INTDLOADEX|5 INTDLOADEXRELATEDCHANNEL|5 INTDSAVEEX|5 MVLOAD|5 MVLOADACCT|5 MVLOADACCTDATES|5 MVLOADACCTHIST|5 MVLOADDATES|5 MVLOADHIST|5 MVLOADLIST|5 MVLOADLISTDATES|5 MVLOADLISTHIST|5 IF FOR NEXT DONE SELECT END CALL ABORT CLEAR CHANNEL FACTOR LIST NUMBER OVERRIDE SET WEEK DISTRIBUTIONNODE ELSE WHEN THEN OTHERWISE IENUM CSV INCLUDE LEAVE RIDER SAVE DELETE NOVALUE SECTION WARN SAVE_UPDATE DETERMINANT LABEL REPORT REVENUE EACH IN FROM TOTAL CHARGE BLOCK AND OR CSV_FILE RATE_CODE AUXILIARY_DEMAND UIDACCOUNT RS BILL_PERIOD_SELECT HOURS_PER_MONTH INTD_ERROR_STOP SEASON_SCHEDULE_NAME ACCOUNTFACTOR ARRAYUPPERBOUND CALLSTOREDPROC GETADOCONNECTION GETCONNECT GETDATASOURCE GETQUALIFIER GETUSERID HASVALUE LISTCOUNT LISTOP LISTUPDATE LISTVALUE PRORATEFACTOR RSPRORATE SETBINPATH SETDBMONITOR WQ_OPEN BILLINGHOURS DATE DATEFROMFLOAT DATETIMEFROMSTRING DATETIMETOSTRING DATETOFLOAT DAY DAYDIFF DAYNAME DBDATETIME HOUR MINUTE MONTH MONTHDIFF MONTHHOURS MONTHNAME ROUNDDATE SAMEWEEKDAYLASTYEAR SECOND WEEKDAY WEEKDIFF YEAR YEARDAY YEARSTR COMPSUM HISTCOUNT HISTMAX HISTMIN HISTMINNZ HISTVALUE MAXNRANGE MAXRANGE MINRANGE COMPIKVA COMPKVA COMPKVARFROMKQKW COMPLF IDATTR FLAG LF2KW LF2KWH MAXKW POWERFACTOR READING2USAGE AVGSEASON MAXSEASON MONTHLYMERGE SEASONVALUE SUMSEASON ACCTREADDATES ACCTTABLELOAD CONFIGADD CONFIGGET CREATEOBJECT CREATEREPORT EMAILCLIENT EXPBLKMDMUSAGE EXPMDMUSAGE EXPORT_USAGE FACTORINEFFECT GETUSERSPECIFIEDSTOP INEFFECT ISHOLIDAY RUNRATE SAVE_PROFILE SETREPORTTITLE USEREXIT WATFORRUNRATE TO TABLE ACOS ASIN ATAN ATAN2 BITAND CEIL COS COSECANT COSH COTANGENT DIVQUOT DIVREM EXP FABS FLOOR FMOD FREPM FREXPN LOG LOG10 MAX MAXN MIN MINNZ MODF POW ROUND ROUND2VALUE ROUNDINT SECANT SIN SINH SQROOT TAN TANH FLOAT2STRING FLOAT2STRINGNC INSTR LEFT LEN LTRIM MID RIGHT RTRIM STRING STRINGNC TOLOWER TOUPPER TRIM NUMDAYS READ_DATE STAGING",built_in:"IDENTIFIER OPTIONS XML_ELEMENT XML_OP XML_ELEMENT_OF DOMDOCCREATE DOMDOCLOADFILE DOMDOCLOADXML DOMDOCSAVEFILE DOMDOCGETROOT DOMDOCADDPI DOMNODEGETNAME DOMNODEGETTYPE DOMNODEGETVALUE DOMNODEGETCHILDCT DOMNODEGETFIRSTCHILD DOMNODEGETSIBLING DOMNODECREATECHILDELEMENT DOMNODESETATTRIBUTE DOMNODEGETCHILDELEMENTCT DOMNODEGETFIRSTCHILDELEMENT DOMNODEGETSIBLINGELEMENT DOMNODEGETATTRIBUTECT DOMNODEGETATTRIBUTEI DOMNODEGETATTRIBUTEBYNAME DOMNODEGETBYNAME"},c:[T.CLCM,T.CBCM,T.ASM,T.QSM,T.CNM,{cN:"literal",v:[{b:"#\\s+[a-zA-Z\\ \\.]*",r:0},{b:"#[a-zA-Z\\ \\.]+"}]}]}});hljs.registerLanguage("xml",function(s){var e="[A-Za-z0-9\\._:-]+",t={eW:!0,i:/</,r:0,c:[{cN:"attr",b:e,r:0},{b:"=",r:0,c:[{cN:"string",v:[{b:/"/,e:/"/},{b:/'/,e:/'/},{b:/[^\s\/>]+/}]}]}]};return{aliases:["html","xhtml","rss","atom","xsl","plist"],cI:!0,c:[{cN:"meta",b:"<!DOCTYPE",e:">",r:10,c:[{b:"\\[",e:"\\]"}]},s.C("<!--","-->",{r:10}),{b:"<\\!\\[CDATA\\[",e:"\\]\\]>",r:10},{b:/<\?(php)?/,e:/\?>/,sL:"php",c:[{b:"/\\*",e:"\\*/",skip:!0}]},{cN:"tag",b:"<style(?=\\s|>|$)",e:">",k:{name:"style"},c:[t],starts:{e:"</style>",rE:!0,sL:["css","xml"]}},{cN:"tag",b:"<script(?=\\s|>|$)",e:">",k:{name:"script"},c:[t],starts:{e:"</script>",rE:!0,sL:["actionscript","javascript","handlebars","xml"]}},{cN:"meta",v:[{b:/<\?xml/,e:/\?>/,r:10},{b:/<\?\w+/,e:/\?>/}]},{cN:"tag",b:"</?",e:"/?>",c:[{cN:"name",b:/[^\/><\s]+/,r:0},t]}]}});hljs.registerLanguage("autoit",function(e){var t="ByRef Case Const ContinueCase ContinueLoop Default Dim Do Else ElseIf EndFunc EndIf EndSelect EndSwitch EndWith Enum Exit ExitLoop For Func Global If In Local Next ReDim Return Select Static Step Switch Then To Until Volatile WEnd While With",r="True False And Null Not Or",i="Abs ACos AdlibRegister AdlibUnRegister Asc AscW ASin Assign ATan AutoItSetOption AutoItWinGetTitle AutoItWinSetTitle Beep Binary BinaryLen BinaryMid BinaryToString BitAND BitNOT BitOR BitRotate BitShift BitXOR BlockInput Break Call CDTray Ceiling Chr ChrW ClipGet ClipPut ConsoleRead ConsoleWrite ConsoleWriteError ControlClick ControlCommand ControlDisable ControlEnable ControlFocus ControlGetFocus ControlGetHandle ControlGetPos ControlGetText ControlHide ControlListView ControlMove ControlSend ControlSetText ControlShow ControlTreeView Cos Dec DirCopy DirCreate DirGetSize DirMove DirRemove DllCall DllCallAddress DllCallbackFree DllCallbackGetPtr DllCallbackRegister DllClose DllOpen DllStructCreate DllStructGetData DllStructGetPtr DllStructGetSize DllStructSetData DriveGetDrive DriveGetFileSystem DriveGetLabel DriveGetSerial DriveGetType DriveMapAdd DriveMapDel DriveMapGet DriveSetLabel DriveSpaceFree DriveSpaceTotal DriveStatus EnvGet EnvSet EnvUpdate Eval Execute Exp FileChangeDir FileClose FileCopy FileCreateNTFSLink FileCreateShortcut FileDelete FileExists FileFindFirstFile FileFindNextFile FileFlush FileGetAttrib FileGetEncoding FileGetLongName FileGetPos FileGetShortcut FileGetShortName FileGetSize FileGetTime FileGetVersion FileInstall FileMove FileOpen FileOpenDialog FileRead FileReadLine FileReadToArray FileRecycle FileRecycleEmpty FileSaveDialog FileSelectFolder FileSetAttrib FileSetEnd FileSetPos FileSetTime FileWrite FileWriteLine Floor FtpSetProxy FuncName GUICreate GUICtrlCreateAvi GUICtrlCreateButton GUICtrlCreateCheckbox GUICtrlCreateCombo GUICtrlCreateContextMenu GUICtrlCreateDate GUICtrlCreateDummy GUICtrlCreateEdit GUICtrlCreateGraphic GUICtrlCreateGroup GUICtrlCreateIcon GUICtrlCreateInput GUICtrlCreateLabel GUICtrlCreateList GUICtrlCreateListView GUICtrlCreateListViewItem GUICtrlCreateMenu GUICtrlCreateMenuItem GUICtrlCreateMonthCal GUICtrlCreateObj GUICtrlCreatePic GUICtrlCreateProgress GUICtrlCreateRadio GUICtrlCreateSlider GUICtrlCreateTab GUICtrlCreateTabItem GUICtrlCreateTreeView GUICtrlCreateTreeViewItem GUICtrlCreateUpdown GUICtrlDelete GUICtrlGetHandle GUICtrlGetState GUICtrlRead GUICtrlRecvMsg GUICtrlRegisterListViewSort GUICtrlSendMsg GUICtrlSendToDummy GUICtrlSetBkColor GUICtrlSetColor GUICtrlSetCursor GUICtrlSetData GUICtrlSetDefBkColor GUICtrlSetDefColor GUICtrlSetFont GUICtrlSetGraphic GUICtrlSetImage GUICtrlSetLimit GUICtrlSetOnEvent GUICtrlSetPos GUICtrlSetResizing GUICtrlSetState GUICtrlSetStyle GUICtrlSetTip GUIDelete GUIGetCursorInfo GUIGetMsg GUIGetStyle GUIRegisterMsg GUISetAccelerators GUISetBkColor GUISetCoord GUISetCursor GUISetFont GUISetHelp GUISetIcon GUISetOnEvent GUISetState GUISetStyle GUIStartGroup GUISwitch Hex HotKeySet HttpSetProxy HttpSetUserAgent HWnd InetClose InetGet InetGetInfo InetGetSize InetRead IniDelete IniRead IniReadSection IniReadSectionNames IniRenameSection IniWrite IniWriteSection InputBox Int IsAdmin IsArray IsBinary IsBool IsDeclared IsDllStruct IsFloat IsFunc IsHWnd IsInt IsKeyword IsNumber IsObj IsPtr IsString Log MemGetStats Mod MouseClick MouseClickDrag MouseDown MouseGetCursor MouseGetPos MouseMove MouseUp MouseWheel MsgBox Number ObjCreate ObjCreateInterface ObjEvent ObjGet ObjName OnAutoItExitRegister OnAutoItExitUnRegister Opt Ping PixelChecksum PixelGetColor PixelSearch ProcessClose ProcessExists ProcessGetStats ProcessList ProcessSetPriority ProcessWait ProcessWaitClose ProgressOff ProgressOn ProgressSet Ptr Random RegDelete RegEnumKey RegEnumVal RegRead RegWrite Round Run RunAs RunAsWait RunWait Send SendKeepActive SetError SetExtended ShellExecute ShellExecuteWait Shutdown Sin Sleep SoundPlay SoundSetWaveVolume SplashImageOn SplashOff SplashTextOn Sqrt SRandom StatusbarGetText StderrRead StdinWrite StdioClose StdoutRead String StringAddCR StringCompare StringFormat StringFromASCIIArray StringInStr StringIsAlNum StringIsAlpha StringIsASCII StringIsDigit StringIsFloat StringIsInt StringIsLower StringIsSpace StringIsUpper StringIsXDigit StringLeft StringLen StringLower StringMid StringRegExp StringRegExpReplace StringReplace StringReverse StringRight StringSplit StringStripCR StringStripWS StringToASCIIArray StringToBinary StringTrimLeft StringTrimRight StringUpper Tan TCPAccept TCPCloseSocket TCPConnect TCPListen TCPNameToIP TCPRecv TCPSend TCPShutdown TCPStartup TimerDiff TimerInit ToolTip TrayCreateItem TrayCreateMenu TrayGetMsg TrayItemDelete TrayItemGetHandle TrayItemGetState TrayItemGetText TrayItemSetOnEvent TrayItemSetState TrayItemSetText TraySetClick TraySetIcon TraySetOnEvent TraySetPauseIcon TraySetState TraySetToolTip TrayTip UBound UDPBind UDPCloseSocket UDPOpen UDPRecv UDPSend UDPShutdown UDPStartup VarGetType WinActivate WinActive WinClose WinExists WinFlash WinGetCaretPos WinGetClassList WinGetClientSize WinGetHandle WinGetPos WinGetProcess WinGetState WinGetText WinGetTitle WinKill WinList WinMenuSelectItem WinMinimizeAll WinMinimizeAllUndo WinMove WinSetOnTop WinSetState WinSetTitle WinSetTrans WinWait WinWaitActive WinWaitClose WinWaitNotActive Array1DToHistogram ArrayAdd ArrayBinarySearch ArrayColDelete ArrayColInsert ArrayCombinations ArrayConcatenate ArrayDelete ArrayDisplay ArrayExtract ArrayFindAll ArrayInsert ArrayMax ArrayMaxIndex ArrayMin ArrayMinIndex ArrayPermute ArrayPop ArrayPush ArrayReverse ArraySearch ArrayShuffle ArraySort ArraySwap ArrayToClip ArrayToString ArrayTranspose ArrayTrim ArrayUnique Assert ChooseColor ChooseFont ClipBoard_ChangeChain ClipBoard_Close ClipBoard_CountFormats ClipBoard_Empty ClipBoard_EnumFormats ClipBoard_FormatStr ClipBoard_GetData ClipBoard_GetDataEx ClipBoard_GetFormatName ClipBoard_GetOpenWindow ClipBoard_GetOwner ClipBoard_GetPriorityFormat ClipBoard_GetSequenceNumber ClipBoard_GetViewer ClipBoard_IsFormatAvailable ClipBoard_Open ClipBoard_RegisterFormat ClipBoard_SetData ClipBoard_SetDataEx ClipBoard_SetViewer ClipPutFile ColorConvertHSLtoRGB ColorConvertRGBtoHSL ColorGetBlue ColorGetCOLORREF ColorGetGreen ColorGetRed ColorGetRGB ColorSetCOLORREF ColorSetRGB Crypt_DecryptData Crypt_DecryptFile Crypt_DeriveKey Crypt_DestroyKey Crypt_EncryptData Crypt_EncryptFile Crypt_GenRandom Crypt_HashData Crypt_HashFile Crypt_Shutdown Crypt_Startup DateAdd DateDayOfWeek DateDaysInMonth DateDiff DateIsLeapYear DateIsValid DateTimeFormat DateTimeSplit DateToDayOfWeek DateToDayOfWeekISO DateToDayValue DateToMonth Date_Time_CompareFileTime Date_Time_DOSDateTimeToArray Date_Time_DOSDateTimeToFileTime Date_Time_DOSDateTimeToStr Date_Time_DOSDateToArray Date_Time_DOSDateToStr Date_Time_DOSTimeToArray Date_Time_DOSTimeToStr Date_Time_EncodeFileTime Date_Time_EncodeSystemTime Date_Time_FileTimeToArray Date_Time_FileTimeToDOSDateTime Date_Time_FileTimeToLocalFileTime Date_Time_FileTimeToStr Date_Time_FileTimeToSystemTime Date_Time_GetFileTime Date_Time_GetLocalTime Date_Time_GetSystemTime Date_Time_GetSystemTimeAdjustment Date_Time_GetSystemTimeAsFileTime Date_Time_GetSystemTimes Date_Time_GetTickCount Date_Time_GetTimeZoneInformation Date_Time_LocalFileTimeToFileTime Date_Time_SetFileTime Date_Time_SetLocalTime Date_Time_SetSystemTime Date_Time_SetSystemTimeAdjustment Date_Time_SetTimeZoneInformation Date_Time_SystemTimeToArray Date_Time_SystemTimeToDateStr Date_Time_SystemTimeToDateTimeStr Date_Time_SystemTimeToFileTime Date_Time_SystemTimeToTimeStr Date_Time_SystemTimeToTzSpecificLocalTime Date_Time_TzSpecificLocalTimeToSystemTime DayValueToDate DebugBugReportEnv DebugCOMError DebugOut DebugReport DebugReportEx DebugReportVar DebugSetup Degree EventLog__Backup EventLog__Clear EventLog__Close EventLog__Count EventLog__DeregisterSource EventLog__Full EventLog__Notify EventLog__Oldest EventLog__Open EventLog__OpenBackup EventLog__Read EventLog__RegisterSource EventLog__Report Excel_BookAttach Excel_BookClose Excel_BookList Excel_BookNew Excel_BookOpen Excel_BookOpenText Excel_BookSave Excel_BookSaveAs Excel_Close Excel_ColumnToLetter Excel_ColumnToNumber Excel_ConvertFormula Excel_Export Excel_FilterGet Excel_FilterSet Excel_Open Excel_PictureAdd Excel_Print Excel_RangeCopyPaste Excel_RangeDelete Excel_RangeFind Excel_RangeInsert Excel_RangeLinkAddRemove Excel_RangeRead Excel_RangeReplace Excel_RangeSort Excel_RangeValidate Excel_RangeWrite Excel_SheetAdd Excel_SheetCopyMove Excel_SheetDelete Excel_SheetList FileCountLines FileCreate FileListToArray FileListToArrayRec FilePrint FileReadToArray FileWriteFromArray FileWriteLog FileWriteToLine FTP_Close FTP_Command FTP_Connect FTP_DecodeInternetStatus FTP_DirCreate FTP_DirDelete FTP_DirGetCurrent FTP_DirPutContents FTP_DirSetCurrent FTP_FileClose FTP_FileDelete FTP_FileGet FTP_FileGetSize FTP_FileOpen FTP_FilePut FTP_FileRead FTP_FileRename FTP_FileTimeLoHiToStr FTP_FindFileClose FTP_FindFileFirst FTP_FindFileNext FTP_GetLastResponseInfo FTP_ListToArray FTP_ListToArray2D FTP_ListToArrayEx FTP_Open FTP_ProgressDownload FTP_ProgressUpload FTP_SetStatusCallback GDIPlus_ArrowCapCreate GDIPlus_ArrowCapDispose GDIPlus_ArrowCapGetFillState GDIPlus_ArrowCapGetHeight GDIPlus_ArrowCapGetMiddleInset GDIPlus_ArrowCapGetWidth GDIPlus_ArrowCapSetFillState GDIPlus_ArrowCapSetHeight GDIPlus_ArrowCapSetMiddleInset GDIPlus_ArrowCapSetWidth GDIPlus_BitmapApplyEffect GDIPlus_BitmapApplyEffectEx GDIPlus_BitmapCloneArea GDIPlus_BitmapConvertFormat GDIPlus_BitmapCreateApplyEffect GDIPlus_BitmapCreateApplyEffectEx GDIPlus_BitmapCreateDIBFromBitmap GDIPlus_BitmapCreateFromFile GDIPlus_BitmapCreateFromGraphics GDIPlus_BitmapCreateFromHBITMAP GDIPlus_BitmapCreateFromHICON GDIPlus_BitmapCreateFromHICON32 GDIPlus_BitmapCreateFromMemory GDIPlus_BitmapCreateFromResource GDIPlus_BitmapCreateFromScan0 GDIPlus_BitmapCreateFromStream GDIPlus_BitmapCreateHBITMAPFromBitmap GDIPlus_BitmapDispose GDIPlus_BitmapGetHistogram GDIPlus_BitmapGetHistogramEx GDIPlus_BitmapGetHistogramSize GDIPlus_BitmapGetPixel GDIPlus_BitmapLockBits GDIPlus_BitmapSetPixel GDIPlus_BitmapUnlockBits GDIPlus_BrushClone GDIPlus_BrushCreateSolid GDIPlus_BrushDispose GDIPlus_BrushGetSolidColor GDIPlus_BrushGetType GDIPlus_BrushSetSolidColor GDIPlus_ColorMatrixCreate GDIPlus_ColorMatrixCreateGrayScale GDIPlus_ColorMatrixCreateNegative GDIPlus_ColorMatrixCreateSaturation GDIPlus_ColorMatrixCreateScale GDIPlus_ColorMatrixCreateTranslate GDIPlus_CustomLineCapClone GDIPlus_CustomLineCapCreate GDIPlus_CustomLineCapDispose GDIPlus_CustomLineCapGetStrokeCaps GDIPlus_CustomLineCapSetStrokeCaps GDIPlus_Decoders GDIPlus_DecodersGetCount GDIPlus_DecodersGetSize GDIPlus_DrawImageFX GDIPlus_DrawImageFXEx GDIPlus_DrawImagePoints GDIPlus_EffectCreate GDIPlus_EffectCreateBlur GDIPlus_EffectCreateBrightnessContrast GDIPlus_EffectCreateColorBalance GDIPlus_EffectCreateColorCurve GDIPlus_EffectCreateColorLUT GDIPlus_EffectCreateColorMatrix GDIPlus_EffectCreateHueSaturationLightness GDIPlus_EffectCreateLevels GDIPlus_EffectCreateRedEyeCorrection GDIPlus_EffectCreateSharpen GDIPlus_EffectCreateTint GDIPlus_EffectDispose GDIPlus_EffectGetParameters GDIPlus_EffectSetParameters GDIPlus_Encoders GDIPlus_EncodersGetCLSID GDIPlus_EncodersGetCount GDIPlus_EncodersGetParamList GDIPlus_EncodersGetParamListSize GDIPlus_EncodersGetSize GDIPlus_FontCreate GDIPlus_FontDispose GDIPlus_FontFamilyCreate GDIPlus_FontFamilyCreateFromCollection GDIPlus_FontFamilyDispose GDIPlus_FontFamilyGetCellAscent GDIPlus_FontFamilyGetCellDescent GDIPlus_FontFamilyGetEmHeight GDIPlus_FontFamilyGetLineSpacing GDIPlus_FontGetHeight GDIPlus_FontPrivateAddFont GDIPlus_FontPrivateAddMemoryFont GDIPlus_FontPrivateCollectionDispose GDIPlus_FontPrivateCreateCollection GDIPlus_GraphicsClear GDIPlus_GraphicsCreateFromHDC GDIPlus_GraphicsCreateFromHWND GDIPlus_GraphicsDispose GDIPlus_GraphicsDrawArc GDIPlus_GraphicsDrawBezier GDIPlus_GraphicsDrawClosedCurve GDIPlus_GraphicsDrawClosedCurve2 GDIPlus_GraphicsDrawCurve GDIPlus_GraphicsDrawCurve2 GDIPlus_GraphicsDrawEllipse GDIPlus_GraphicsDrawImage GDIPlus_GraphicsDrawImagePointsRect GDIPlus_GraphicsDrawImageRect GDIPlus_GraphicsDrawImageRectRect GDIPlus_GraphicsDrawLine GDIPlus_GraphicsDrawPath GDIPlus_GraphicsDrawPie GDIPlus_GraphicsDrawPolygon GDIPlus_GraphicsDrawRect GDIPlus_GraphicsDrawString GDIPlus_GraphicsDrawStringEx GDIPlus_GraphicsFillClosedCurve GDIPlus_GraphicsFillClosedCurve2 GDIPlus_GraphicsFillEllipse GDIPlus_GraphicsFillPath GDIPlus_GraphicsFillPie GDIPlus_GraphicsFillPolygon GDIPlus_GraphicsFillRect GDIPlus_GraphicsFillRegion GDIPlus_GraphicsGetCompositingMode GDIPlus_GraphicsGetCompositingQuality GDIPlus_GraphicsGetDC GDIPlus_GraphicsGetInterpolationMode GDIPlus_GraphicsGetSmoothingMode GDIPlus_GraphicsGetTransform GDIPlus_GraphicsMeasureCharacterRanges GDIPlus_GraphicsMeasureString GDIPlus_GraphicsReleaseDC GDIPlus_GraphicsResetClip GDIPlus_GraphicsResetTransform GDIPlus_GraphicsRestore GDIPlus_GraphicsRotateTransform GDIPlus_GraphicsSave GDIPlus_GraphicsScaleTransform GDIPlus_GraphicsSetClipPath GDIPlus_GraphicsSetClipRect GDIPlus_GraphicsSetClipRegion GDIPlus_GraphicsSetCompositingMode GDIPlus_GraphicsSetCompositingQuality GDIPlus_GraphicsSetInterpolationMode GDIPlus_GraphicsSetPixelOffsetMode GDIPlus_GraphicsSetSmoothingMode GDIPlus_GraphicsSetTextRenderingHint GDIPlus_GraphicsSetTransform GDIPlus_GraphicsTransformPoints GDIPlus_GraphicsTranslateTransform GDIPlus_HatchBrushCreate GDIPlus_HICONCreateFromBitmap GDIPlus_ImageAttributesCreate GDIPlus_ImageAttributesDispose GDIPlus_ImageAttributesSetColorKeys GDIPlus_ImageAttributesSetColorMatrix GDIPlus_ImageDispose GDIPlus_ImageGetDimension GDIPlus_ImageGetFlags GDIPlus_ImageGetGraphicsContext GDIPlus_ImageGetHeight GDIPlus_ImageGetHorizontalResolution GDIPlus_ImageGetPixelFormat GDIPlus_ImageGetRawFormat GDIPlus_ImageGetThumbnail GDIPlus_ImageGetType GDIPlus_ImageGetVerticalResolution GDIPlus_ImageGetWidth GDIPlus_ImageLoadFromFile GDIPlus_ImageLoadFromStream GDIPlus_ImageResize GDIPlus_ImageRotateFlip GDIPlus_ImageSaveToFile GDIPlus_ImageSaveToFileEx GDIPlus_ImageSaveToStream GDIPlus_ImageScale GDIPlus_LineBrushCreate GDIPlus_LineBrushCreateFromRect GDIPlus_LineBrushCreateFromRectWithAngle GDIPlus_LineBrushGetColors GDIPlus_LineBrushGetRect GDIPlus_LineBrushMultiplyTransform GDIPlus_LineBrushResetTransform GDIPlus_LineBrushSetBlend GDIPlus_LineBrushSetColors GDIPlus_LineBrushSetGammaCorrection GDIPlus_LineBrushSetLinearBlend GDIPlus_LineBrushSetPresetBlend GDIPlus_LineBrushSetSigmaBlend GDIPlus_LineBrushSetTransform GDIPlus_MatrixClone GDIPlus_MatrixCreate GDIPlus_MatrixDispose GDIPlus_MatrixGetElements GDIPlus_MatrixInvert GDIPlus_MatrixMultiply GDIPlus_MatrixRotate GDIPlus_MatrixScale GDIPlus_MatrixSetElements GDIPlus_MatrixShear GDIPlus_MatrixTransformPoints GDIPlus_MatrixTranslate GDIPlus_PaletteInitialize GDIPlus_ParamAdd GDIPlus_ParamInit GDIPlus_ParamSize GDIPlus_PathAddArc GDIPlus_PathAddBezier GDIPlus_PathAddClosedCurve GDIPlus_PathAddClosedCurve2 GDIPlus_PathAddCurve GDIPlus_PathAddCurve2 GDIPlus_PathAddCurve3 GDIPlus_PathAddEllipse GDIPlus_PathAddLine GDIPlus_PathAddLine2 GDIPlus_PathAddPath GDIPlus_PathAddPie GDIPlus_PathAddPolygon GDIPlus_PathAddRectangle GDIPlus_PathAddString GDIPlus_PathBrushCreate GDIPlus_PathBrushCreateFromPath GDIPlus_PathBrushGetCenterPoint GDIPlus_PathBrushGetFocusScales GDIPlus_PathBrushGetPointCount GDIPlus_PathBrushGetRect GDIPlus_PathBrushGetWrapMode GDIPlus_PathBrushMultiplyTransform GDIPlus_PathBrushResetTransform GDIPlus_PathBrushSetBlend GDIPlus_PathBrushSetCenterColor GDIPlus_PathBrushSetCenterPoint GDIPlus_PathBrushSetFocusScales GDIPlus_PathBrushSetGammaCorrection GDIPlus_PathBrushSetLinearBlend GDIPlus_PathBrushSetPresetBlend GDIPlus_PathBrushSetSigmaBlend GDIPlus_PathBrushSetSurroundColor GDIPlus_PathBrushSetSurroundColorsWithCount GDIPlus_PathBrushSetTransform GDIPlus_PathBrushSetWrapMode GDIPlus_PathClone GDIPlus_PathCloseFigure GDIPlus_PathCreate GDIPlus_PathCreate2 GDIPlus_PathDispose GDIPlus_PathFlatten GDIPlus_PathGetData GDIPlus_PathGetFillMode GDIPlus_PathGetLastPoint GDIPlus_PathGetPointCount GDIPlus_PathGetPoints GDIPlus_PathGetWorldBounds GDIPlus_PathIsOutlineVisiblePoint GDIPlus_PathIsVisiblePoint GDIPlus_PathIterCreate GDIPlus_PathIterDispose GDIPlus_PathIterGetSubpathCount GDIPlus_PathIterNextMarkerPath GDIPlus_PathIterNextSubpathPath GDIPlus_PathIterRewind GDIPlus_PathReset GDIPlus_PathReverse GDIPlus_PathSetFillMode GDIPlus_PathSetMarker GDIPlus_PathStartFigure GDIPlus_PathTransform GDIPlus_PathWarp GDIPlus_PathWiden GDIPlus_PathWindingModeOutline GDIPlus_PenCreate GDIPlus_PenCreate2 GDIPlus_PenDispose GDIPlus_PenGetAlignment GDIPlus_PenGetColor GDIPlus_PenGetCustomEndCap GDIPlus_PenGetDashCap GDIPlus_PenGetDashStyle GDIPlus_PenGetEndCap GDIPlus_PenGetMiterLimit GDIPlus_PenGetWidth GDIPlus_PenSetAlignment GDIPlus_PenSetColor GDIPlus_PenSetCustomEndCap GDIPlus_PenSetDashCap GDIPlus_PenSetDashStyle GDIPlus_PenSetEndCap GDIPlus_PenSetLineCap GDIPlus_PenSetLineJoin GDIPlus_PenSetMiterLimit GDIPlus_PenSetStartCap GDIPlus_PenSetWidth GDIPlus_RectFCreate GDIPlus_RegionClone GDIPlus_RegionCombinePath GDIPlus_RegionCombineRect GDIPlus_RegionCombineRegion GDIPlus_RegionCreate GDIPlus_RegionCreateFromPath GDIPlus_RegionCreateFromRect GDIPlus_RegionDispose GDIPlus_RegionGetBounds GDIPlus_RegionGetHRgn GDIPlus_RegionTransform GDIPlus_RegionTranslate GDIPlus_Shutdown GDIPlus_Startup GDIPlus_StringFormatCreate GDIPlus_StringFormatDispose GDIPlus_StringFormatGetMeasurableCharacterRangeCount GDIPlus_StringFormatSetAlign GDIPlus_StringFormatSetLineAlign GDIPlus_StringFormatSetMeasurableCharacterRanges GDIPlus_TextureCreate GDIPlus_TextureCreate2 GDIPlus_TextureCreateIA GetIP GUICtrlAVI_Close GUICtrlAVI_Create GUICtrlAVI_Destroy GUICtrlAVI_IsPlaying GUICtrlAVI_Open GUICtrlAVI_OpenEx GUICtrlAVI_Play GUICtrlAVI_Seek GUICtrlAVI_Show GUICtrlAVI_Stop GUICtrlButton_Click GUICtrlButton_Create GUICtrlButton_Destroy GUICtrlButton_Enable GUICtrlButton_GetCheck GUICtrlButton_GetFocus GUICtrlButton_GetIdealSize GUICtrlButton_GetImage GUICtrlButton_GetImageList GUICtrlButton_GetNote GUICtrlButton_GetNoteLength GUICtrlButton_GetSplitInfo GUICtrlButton_GetState GUICtrlButton_GetText GUICtrlButton_GetTextMargin GUICtrlButton_SetCheck GUICtrlButton_SetDontClick GUICtrlButton_SetFocus GUICtrlButton_SetImage GUICtrlButton_SetImageList GUICtrlButton_SetNote GUICtrlButton_SetShield GUICtrlButton_SetSize GUICtrlButton_SetSplitInfo GUICtrlButton_SetState GUICtrlButton_SetStyle GUICtrlButton_SetText GUICtrlButton_SetTextMargin GUICtrlButton_Show GUICtrlComboBoxEx_AddDir GUICtrlComboBoxEx_AddString GUICtrlComboBoxEx_BeginUpdate GUICtrlComboBoxEx_Create GUICtrlComboBoxEx_CreateSolidBitMap GUICtrlComboBoxEx_DeleteString GUICtrlComboBoxEx_Destroy GUICtrlComboBoxEx_EndUpdate GUICtrlComboBoxEx_FindStringExact GUICtrlComboBoxEx_GetComboBoxInfo GUICtrlComboBoxEx_GetComboControl GUICtrlComboBoxEx_GetCount GUICtrlComboBoxEx_GetCurSel GUICtrlComboBoxEx_GetDroppedControlRect GUICtrlComboBoxEx_GetDroppedControlRectEx GUICtrlComboBoxEx_GetDroppedState GUICtrlComboBoxEx_GetDroppedWidth GUICtrlComboBoxEx_GetEditControl GUICtrlComboBoxEx_GetEditSel GUICtrlComboBoxEx_GetEditText GUICtrlComboBoxEx_GetExtendedStyle GUICtrlComboBoxEx_GetExtendedUI GUICtrlComboBoxEx_GetImageList GUICtrlComboBoxEx_GetItem GUICtrlComboBoxEx_GetItemEx GUICtrlComboBoxEx_GetItemHeight GUICtrlComboBoxEx_GetItemImage GUICtrlComboBoxEx_GetItemIndent GUICtrlComboBoxEx_GetItemOverlayImage GUICtrlComboBoxEx_GetItemParam GUICtrlComboBoxEx_GetItemSelectedImage GUICtrlComboBoxEx_GetItemText GUICtrlComboBoxEx_GetItemTextLen GUICtrlComboBoxEx_GetList GUICtrlComboBoxEx_GetListArray GUICtrlComboBoxEx_GetLocale GUICtrlComboBoxEx_GetLocaleCountry GUICtrlComboBoxEx_GetLocaleLang GUICtrlComboBoxEx_GetLocalePrimLang GUICtrlComboBoxEx_GetLocaleSubLang GUICtrlComboBoxEx_GetMinVisible GUICtrlComboBoxEx_GetTopIndex GUICtrlComboBoxEx_GetUnicode GUICtrlComboBoxEx_InitStorage GUICtrlComboBoxEx_InsertString GUICtrlComboBoxEx_LimitText GUICtrlComboBoxEx_ReplaceEditSel GUICtrlComboBoxEx_ResetContent GUICtrlComboBoxEx_SetCurSel GUICtrlComboBoxEx_SetDroppedWidth GUICtrlComboBoxEx_SetEditSel GUICtrlComboBoxEx_SetEditText GUICtrlComboBoxEx_SetExtendedStyle GUICtrlComboBoxEx_SetExtendedUI GUICtrlComboBoxEx_SetImageList GUICtrlComboBoxEx_SetItem GUICtrlComboBoxEx_SetItemEx GUICtrlComboBoxEx_SetItemHeight GUICtrlComboBoxEx_SetItemImage GUICtrlComboBoxEx_SetItemIndent GUICtrlComboBoxEx_SetItemOverlayImage GUICtrlComboBoxEx_SetItemParam GUICtrlComboBoxEx_SetItemSelectedImage GUICtrlComboBoxEx_SetMinVisible GUICtrlComboBoxEx_SetTopIndex GUICtrlComboBoxEx_SetUnicode GUICtrlComboBoxEx_ShowDropDown GUICtrlComboBox_AddDir GUICtrlComboBox_AddString GUICtrlComboBox_AutoComplete GUICtrlComboBox_BeginUpdate GUICtrlComboBox_Create GUICtrlComboBox_DeleteString GUICtrlComboBox_Destroy GUICtrlComboBox_EndUpdate GUICtrlComboBox_FindString GUICtrlComboBox_FindStringExact GUICtrlComboBox_GetComboBoxInfo GUICtrlComboBox_GetCount GUICtrlComboBox_GetCueBanner GUICtrlComboBox_GetCurSel GUICtrlComboBox_GetDroppedControlRect GUICtrlComboBox_GetDroppedControlRectEx GUICtrlComboBox_GetDroppedState GUICtrlComboBox_GetDroppedWidth GUICtrlComboBox_GetEditSel GUICtrlComboBox_GetEditText GUICtrlComboBox_GetExtendedUI GUICtrlComboBox_GetHorizontalExtent GUICtrlComboBox_GetItemHeight GUICtrlComboBox_GetLBText GUICtrlComboBox_GetLBTextLen GUICtrlComboBox_GetList GUICtrlComboBox_GetListArray GUICtrlComboBox_GetLocale GUICtrlComboBox_GetLocaleCountry GUICtrlComboBox_GetLocaleLang GUICtrlComboBox_GetLocalePrimLang GUICtrlComboBox_GetLocaleSubLang GUICtrlComboBox_GetMinVisible GUICtrlComboBox_GetTopIndex GUICtrlComboBox_InitStorage GUICtrlComboBox_InsertString GUICtrlComboBox_LimitText GUICtrlComboBox_ReplaceEditSel GUICtrlComboBox_ResetContent GUICtrlComboBox_SelectString GUICtrlComboBox_SetCueBanner GUICtrlComboBox_SetCurSel GUICtrlComboBox_SetDroppedWidth GUICtrlComboBox_SetEditSel GUICtrlComboBox_SetEditText GUICtrlComboBox_SetExtendedUI GUICtrlComboBox_SetHorizontalExtent GUICtrlComboBox_SetItemHeight GUICtrlComboBox_SetMinVisible GUICtrlComboBox_SetTopIndex GUICtrlComboBox_ShowDropDown GUICtrlDTP_Create GUICtrlDTP_Destroy GUICtrlDTP_GetMCColor GUICtrlDTP_GetMCFont GUICtrlDTP_GetMonthCal GUICtrlDTP_GetRange GUICtrlDTP_GetRangeEx GUICtrlDTP_GetSystemTime GUICtrlDTP_GetSystemTimeEx GUICtrlDTP_SetFormat GUICtrlDTP_SetMCColor GUICtrlDTP_SetMCFont GUICtrlDTP_SetRange GUICtrlDTP_SetRangeEx GUICtrlDTP_SetSystemTime GUICtrlDTP_SetSystemTimeEx GUICtrlEdit_AppendText GUICtrlEdit_BeginUpdate GUICtrlEdit_CanUndo GUICtrlEdit_CharFromPos GUICtrlEdit_Create GUICtrlEdit_Destroy GUICtrlEdit_EmptyUndoBuffer GUICtrlEdit_EndUpdate GUICtrlEdit_Find GUICtrlEdit_FmtLines GUICtrlEdit_GetCueBanner GUICtrlEdit_GetFirstVisibleLine GUICtrlEdit_GetLimitText GUICtrlEdit_GetLine GUICtrlEdit_GetLineCount GUICtrlEdit_GetMargins GUICtrlEdit_GetModify GUICtrlEdit_GetPasswordChar GUICtrlEdit_GetRECT GUICtrlEdit_GetRECTEx GUICtrlEdit_GetSel GUICtrlEdit_GetText GUICtrlEdit_GetTextLen GUICtrlEdit_HideBalloonTip GUICtrlEdit_InsertText GUICtrlEdit_LineFromChar GUICtrlEdit_LineIndex GUICtrlEdit_LineLength GUICtrlEdit_LineScroll GUICtrlEdit_PosFromChar GUICtrlEdit_ReplaceSel GUICtrlEdit_Scroll GUICtrlEdit_SetCueBanner GUICtrlEdit_SetLimitText GUICtrlEdit_SetMargins GUICtrlEdit_SetModify GUICtrlEdit_SetPasswordChar GUICtrlEdit_SetReadOnly GUICtrlEdit_SetRECT GUICtrlEdit_SetRECTEx GUICtrlEdit_SetRECTNP GUICtrlEdit_SetRectNPEx GUICtrlEdit_SetSel GUICtrlEdit_SetTabStops GUICtrlEdit_SetText GUICtrlEdit_ShowBalloonTip GUICtrlEdit_Undo GUICtrlHeader_AddItem GUICtrlHeader_ClearFilter GUICtrlHeader_ClearFilterAll GUICtrlHeader_Create GUICtrlHeader_CreateDragImage GUICtrlHeader_DeleteItem GUICtrlHeader_Destroy GUICtrlHeader_EditFilter GUICtrlHeader_GetBitmapMargin GUICtrlHeader_GetImageList GUICtrlHeader_GetItem GUICtrlHeader_GetItemAlign GUICtrlHeader_GetItemBitmap GUICtrlHeader_GetItemCount GUICtrlHeader_GetItemDisplay GUICtrlHeader_GetItemFlags GUICtrlHeader_GetItemFormat GUICtrlHeader_GetItemImage GUICtrlHeader_GetItemOrder GUICtrlHeader_GetItemParam GUICtrlHeader_GetItemRect GUICtrlHeader_GetItemRectEx GUICtrlHeader_GetItemText GUICtrlHeader_GetItemWidth GUICtrlHeader_GetOrderArray GUICtrlHeader_GetUnicodeFormat GUICtrlHeader_HitTest GUICtrlHeader_InsertItem GUICtrlHeader_Layout GUICtrlHeader_OrderToIndex GUICtrlHeader_SetBitmapMargin GUICtrlHeader_SetFilterChangeTimeout GUICtrlHeader_SetHotDivider GUICtrlHeader_SetImageList GUICtrlHeader_SetItem GUICtrlHeader_SetItemAlign GUICtrlHeader_SetItemBitmap GUICtrlHeader_SetItemDisplay GUICtrlHeader_SetItemFlags GUICtrlHeader_SetItemFormat GUICtrlHeader_SetItemImage GUICtrlHeader_SetItemOrder GUICtrlHeader_SetItemParam GUICtrlHeader_SetItemText GUICtrlHeader_SetItemWidth GUICtrlHeader_SetOrderArray GUICtrlHeader_SetUnicodeFormat GUICtrlIpAddress_ClearAddress GUICtrlIpAddress_Create GUICtrlIpAddress_Destroy GUICtrlIpAddress_Get GUICtrlIpAddress_GetArray GUICtrlIpAddress_GetEx GUICtrlIpAddress_IsBlank GUICtrlIpAddress_Set GUICtrlIpAddress_SetArray GUICtrlIpAddress_SetEx GUICtrlIpAddress_SetFocus GUICtrlIpAddress_SetFont GUICtrlIpAddress_SetRange GUICtrlIpAddress_ShowHide GUICtrlListBox_AddFile GUICtrlListBox_AddString GUICtrlListBox_BeginUpdate GUICtrlListBox_ClickItem GUICtrlListBox_Create GUICtrlListBox_DeleteString GUICtrlListBox_Destroy GUICtrlListBox_Dir GUICtrlListBox_EndUpdate GUICtrlListBox_FindInText GUICtrlListBox_FindString GUICtrlListBox_GetAnchorIndex GUICtrlListBox_GetCaretIndex GUICtrlListBox_GetCount GUICtrlListBox_GetCurSel GUICtrlListBox_GetHorizontalExtent GUICtrlListBox_GetItemData GUICtrlListBox_GetItemHeight GUICtrlListBox_GetItemRect GUICtrlListBox_GetItemRectEx GUICtrlListBox_GetListBoxInfo GUICtrlListBox_GetLocale GUICtrlListBox_GetLocaleCountry GUICtrlListBox_GetLocaleLang GUICtrlListBox_GetLocalePrimLang GUICtrlListBox_GetLocaleSubLang GUICtrlListBox_GetSel GUICtrlListBox_GetSelCount GUICtrlListBox_GetSelItems GUICtrlListBox_GetSelItemsText GUICtrlListBox_GetText GUICtrlListBox_GetTextLen GUICtrlListBox_GetTopIndex GUICtrlListBox_InitStorage GUICtrlListBox_InsertString GUICtrlListBox_ItemFromPoint GUICtrlListBox_ReplaceString GUICtrlListBox_ResetContent GUICtrlListBox_SelectString GUICtrlListBox_SelItemRange GUICtrlListBox_SelItemRangeEx GUICtrlListBox_SetAnchorIndex GUICtrlListBox_SetCaretIndex GUICtrlListBox_SetColumnWidth GUICtrlListBox_SetCurSel GUICtrlListBox_SetHorizontalExtent GUICtrlListBox_SetItemData GUICtrlListBox_SetItemHeight GUICtrlListBox_SetLocale GUICtrlListBox_SetSel GUICtrlListBox_SetTabStops GUICtrlListBox_SetTopIndex GUICtrlListBox_Sort GUICtrlListBox_SwapString GUICtrlListBox_UpdateHScroll GUICtrlListView_AddArray GUICtrlListView_AddColumn GUICtrlListView_AddItem GUICtrlListView_AddSubItem GUICtrlListView_ApproximateViewHeight GUICtrlListView_ApproximateViewRect GUICtrlListView_ApproximateViewWidth GUICtrlListView_Arrange GUICtrlListView_BeginUpdate GUICtrlListView_CancelEditLabel GUICtrlListView_ClickItem GUICtrlListView_CopyItems GUICtrlListView_Create GUICtrlListView_CreateDragImage GUICtrlListView_CreateSolidBitMap GUICtrlListView_DeleteAllItems GUICtrlListView_DeleteColumn GUICtrlListView_DeleteItem GUICtrlListView_DeleteItemsSelected GUICtrlListView_Destroy GUICtrlListView_DrawDragImage GUICtrlListView_EditLabel GUICtrlListView_EnableGroupView GUICtrlListView_EndUpdate GUICtrlListView_EnsureVisible GUICtrlListView_FindInText GUICtrlListView_FindItem GUICtrlListView_FindNearest GUICtrlListView_FindParam GUICtrlListView_FindText GUICtrlListView_GetBkColor GUICtrlListView_GetBkImage GUICtrlListView_GetCallbackMask GUICtrlListView_GetColumn GUICtrlListView_GetColumnCount GUICtrlListView_GetColumnOrder GUICtrlListView_GetColumnOrderArray GUICtrlListView_GetColumnWidth GUICtrlListView_GetCounterPage GUICtrlListView_GetEditControl GUICtrlListView_GetExtendedListViewStyle GUICtrlListView_GetFocusedGroup GUICtrlListView_GetGroupCount GUICtrlListView_GetGroupInfo GUICtrlListView_GetGroupInfoByIndex GUICtrlListView_GetGroupRect GUICtrlListView_GetGroupViewEnabled GUICtrlListView_GetHeader GUICtrlListView_GetHotCursor GUICtrlListView_GetHotItem GUICtrlListView_GetHoverTime GUICtrlListView_GetImageList GUICtrlListView_GetISearchString GUICtrlListView_GetItem GUICtrlListView_GetItemChecked GUICtrlListView_GetItemCount GUICtrlListView_GetItemCut GUICtrlListView_GetItemDropHilited GUICtrlListView_GetItemEx GUICtrlListView_GetItemFocused GUICtrlListView_GetItemGroupID GUICtrlListView_GetItemImage GUICtrlListView_GetItemIndent GUICtrlListView_GetItemParam GUICtrlListView_GetItemPosition GUICtrlListView_GetItemPositionX GUICtrlListView_GetItemPositionY GUICtrlListView_GetItemRect GUICtrlListView_GetItemRectEx GUICtrlListView_GetItemSelected GUICtrlListView_GetItemSpacing GUICtrlListView_GetItemSpacingX GUICtrlListView_GetItemSpacingY GUICtrlListView_GetItemState GUICtrlListView_GetItemStateImage GUICtrlListView_GetItemText GUICtrlListView_GetItemTextArray GUICtrlListView_GetItemTextString GUICtrlListView_GetNextItem GUICtrlListView_GetNumberOfWorkAreas GUICtrlListView_GetOrigin GUICtrlListView_GetOriginX GUICtrlListView_GetOriginY GUICtrlListView_GetOutlineColor GUICtrlListView_GetSelectedColumn GUICtrlListView_GetSelectedCount GUICtrlListView_GetSelectedIndices GUICtrlListView_GetSelectionMark GUICtrlListView_GetStringWidth GUICtrlListView_GetSubItemRect GUICtrlListView_GetTextBkColor GUICtrlListView_GetTextColor GUICtrlListView_GetToolTips GUICtrlListView_GetTopIndex GUICtrlListView_GetUnicodeFormat GUICtrlListView_GetView GUICtrlListView_GetViewDetails GUICtrlListView_GetViewLarge GUICtrlListView_GetViewList GUICtrlListView_GetViewRect GUICtrlListView_GetViewSmall GUICtrlListView_GetViewTile GUICtrlListView_HideColumn GUICtrlListView_HitTest GUICtrlListView_InsertColumn GUICtrlListView_InsertGroup GUICtrlListView_InsertItem GUICtrlListView_JustifyColumn GUICtrlListView_MapIDToIndex GUICtrlListView_MapIndexToID GUICtrlListView_RedrawItems GUICtrlListView_RegisterSortCallBack GUICtrlListView_RemoveAllGroups GUICtrlListView_RemoveGroup GUICtrlListView_Scroll GUICtrlListView_SetBkColor GUICtrlListView_SetBkImage GUICtrlListView_SetCallBackMask GUICtrlListView_SetColumn GUICtrlListView_SetColumnOrder GUICtrlListView_SetColumnOrderArray GUICtrlListView_SetColumnWidth GUICtrlListView_SetExtendedListViewStyle GUICtrlListView_SetGroupInfo GUICtrlListView_SetHotItem GUICtrlListView_SetHoverTime GUICtrlListView_SetIconSpacing GUICtrlListView_SetImageList GUICtrlListView_SetItem GUICtrlListView_SetItemChecked GUICtrlListView_SetItemCount GUICtrlListView_SetItemCut GUICtrlListView_SetItemDropHilited GUICtrlListView_SetItemEx GUICtrlListView_SetItemFocused GUICtrlListView_SetItemGroupID GUICtrlListView_SetItemImage GUICtrlListView_SetItemIndent GUICtrlListView_SetItemParam GUICtrlListView_SetItemPosition GUICtrlListView_SetItemPosition32 GUICtrlListView_SetItemSelected GUICtrlListView_SetItemState GUICtrlListView_SetItemStateImage GUICtrlListView_SetItemText GUICtrlListView_SetOutlineColor GUICtrlListView_SetSelectedColumn GUICtrlListView_SetSelectionMark GUICtrlListView_SetTextBkColor GUICtrlListView_SetTextColor GUICtrlListView_SetToolTips GUICtrlListView_SetUnicodeFormat GUICtrlListView_SetView GUICtrlListView_SetWorkAreas GUICtrlListView_SimpleSort GUICtrlListView_SortItems GUICtrlListView_SubItemHitTest GUICtrlListView_UnRegisterSortCallBack GUICtrlMenu_AddMenuItem GUICtrlMenu_AppendMenu GUICtrlMenu_CalculatePopupWindowPosition GUICtrlMenu_CheckMenuItem GUICtrlMenu_CheckRadioItem GUICtrlMenu_CreateMenu GUICtrlMenu_CreatePopup GUICtrlMenu_DeleteMenu GUICtrlMenu_DestroyMenu GUICtrlMenu_DrawMenuBar GUICtrlMenu_EnableMenuItem GUICtrlMenu_FindItem GUICtrlMenu_FindParent GUICtrlMenu_GetItemBmp GUICtrlMenu_GetItemBmpChecked GUICtrlMenu_GetItemBmpUnchecked GUICtrlMenu_GetItemChecked GUICtrlMenu_GetItemCount GUICtrlMenu_GetItemData GUICtrlMenu_GetItemDefault GUICtrlMenu_GetItemDisabled GUICtrlMenu_GetItemEnabled GUICtrlMenu_GetItemGrayed GUICtrlMenu_GetItemHighlighted GUICtrlMenu_GetItemID GUICtrlMenu_GetItemInfo GUICtrlMenu_GetItemRect GUICtrlMenu_GetItemRectEx GUICtrlMenu_GetItemState GUICtrlMenu_GetItemStateEx GUICtrlMenu_GetItemSubMenu GUICtrlMenu_GetItemText GUICtrlMenu_GetItemType GUICtrlMenu_GetMenu GUICtrlMenu_GetMenuBackground GUICtrlMenu_GetMenuBarInfo GUICtrlMenu_GetMenuContextHelpID GUICtrlMenu_GetMenuData GUICtrlMenu_GetMenuDefaultItem GUICtrlMenu_GetMenuHeight GUICtrlMenu_GetMenuInfo GUICtrlMenu_GetMenuStyle GUICtrlMenu_GetSystemMenu GUICtrlMenu_InsertMenuItem GUICtrlMenu_InsertMenuItemEx GUICtrlMenu_IsMenu GUICtrlMenu_LoadMenu GUICtrlMenu_MapAccelerator GUICtrlMenu_MenuItemFromPoint GUICtrlMenu_RemoveMenu GUICtrlMenu_SetItemBitmaps GUICtrlMenu_SetItemBmp GUICtrlMenu_SetItemBmpChecked GUICtrlMenu_SetItemBmpUnchecked GUICtrlMenu_SetItemChecked GUICtrlMenu_SetItemData GUICtrlMenu_SetItemDefault GUICtrlMenu_SetItemDisabled GUICtrlMenu_SetItemEnabled GUICtrlMenu_SetItemGrayed GUICtrlMenu_SetItemHighlighted GUICtrlMenu_SetItemID GUICtrlMenu_SetItemInfo GUICtrlMenu_SetItemState GUICtrlMenu_SetItemSubMenu GUICtrlMenu_SetItemText GUICtrlMenu_SetItemType GUICtrlMenu_SetMenu GUICtrlMenu_SetMenuBackground GUICtrlMenu_SetMenuContextHelpID GUICtrlMenu_SetMenuData GUICtrlMenu_SetMenuDefaultItem GUICtrlMenu_SetMenuHeight GUICtrlMenu_SetMenuInfo GUICtrlMenu_SetMenuStyle GUICtrlMenu_TrackPopupMenu GUICtrlMonthCal_Create GUICtrlMonthCal_Destroy GUICtrlMonthCal_GetCalendarBorder GUICtrlMonthCal_GetCalendarCount GUICtrlMonthCal_GetColor GUICtrlMonthCal_GetColorArray GUICtrlMonthCal_GetCurSel GUICtrlMonthCal_GetCurSelStr GUICtrlMonthCal_GetFirstDOW GUICtrlMonthCal_GetFirstDOWStr GUICtrlMonthCal_GetMaxSelCount GUICtrlMonthCal_GetMaxTodayWidth GUICtrlMonthCal_GetMinReqHeight GUICtrlMonthCal_GetMinReqRect GUICtrlMonthCal_GetMinReqRectArray GUICtrlMonthCal_GetMinReqWidth GUICtrlMonthCal_GetMonthDelta GUICtrlMonthCal_GetMonthRange GUICtrlMonthCal_GetMonthRangeMax GUICtrlMonthCal_GetMonthRangeMaxStr GUICtrlMonthCal_GetMonthRangeMin GUICtrlMonthCal_GetMonthRangeMinStr GUICtrlMonthCal_GetMonthRangeSpan GUICtrlMonthCal_GetRange GUICtrlMonthCal_GetRangeMax GUICtrlMonthCal_GetRangeMaxStr GUICtrlMonthCal_GetRangeMin GUICtrlMonthCal_GetRangeMinStr GUICtrlMonthCal_GetSelRange GUICtrlMonthCal_GetSelRangeMax GUICtrlMonthCal_GetSelRangeMaxStr GUICtrlMonthCal_GetSelRangeMin GUICtrlMonthCal_GetSelRangeMinStr GUICtrlMonthCal_GetToday GUICtrlMonthCal_GetTodayStr GUICtrlMonthCal_GetUnicodeFormat GUICtrlMonthCal_HitTest GUICtrlMonthCal_SetCalendarBorder GUICtrlMonthCal_SetColor GUICtrlMonthCal_SetCurSel GUICtrlMonthCal_SetDayState GUICtrlMonthCal_SetFirstDOW GUICtrlMonthCal_SetMaxSelCount GUICtrlMonthCal_SetMonthDelta GUICtrlMonthCal_SetRange GUICtrlMonthCal_SetSelRange GUICtrlMonthCal_SetToday GUICtrlMonthCal_SetUnicodeFormat GUICtrlRebar_AddBand GUICtrlRebar_AddToolBarBand GUICtrlRebar_BeginDrag GUICtrlRebar_Create GUICtrlRebar_DeleteBand GUICtrlRebar_Destroy GUICtrlRebar_DragMove GUICtrlRebar_EndDrag GUICtrlRebar_GetBandBackColor GUICtrlRebar_GetBandBorders GUICtrlRebar_GetBandBordersEx GUICtrlRebar_GetBandChildHandle GUICtrlRebar_GetBandChildSize GUICtrlRebar_GetBandCount GUICtrlRebar_GetBandForeColor GUICtrlRebar_GetBandHeaderSize GUICtrlRebar_GetBandID GUICtrlRebar_GetBandIdealSize GUICtrlRebar_GetBandLength GUICtrlRebar_GetBandLParam GUICtrlRebar_GetBandMargins GUICtrlRebar_GetBandMarginsEx GUICtrlRebar_GetBandRect GUICtrlRebar_GetBandRectEx GUICtrlRebar_GetBandStyle GUICtrlRebar_GetBandStyleBreak GUICtrlRebar_GetBandStyleChildEdge GUICtrlRebar_GetBandStyleFixedBMP GUICtrlRebar_GetBandStyleFixedSize GUICtrlRebar_GetBandStyleGripperAlways GUICtrlRebar_GetBandStyleHidden GUICtrlRebar_GetBandStyleHideTitle GUICtrlRebar_GetBandStyleNoGripper GUICtrlRebar_GetBandStyleTopAlign GUICtrlRebar_GetBandStyleUseChevron GUICtrlRebar_GetBandStyleVariableHeight GUICtrlRebar_GetBandText GUICtrlRebar_GetBarHeight GUICtrlRebar_GetBarInfo GUICtrlRebar_GetBKColor GUICtrlRebar_GetColorScheme GUICtrlRebar_GetRowCount GUICtrlRebar_GetRowHeight GUICtrlRebar_GetTextColor GUICtrlRebar_GetToolTips GUICtrlRebar_GetUnicodeFormat GUICtrlRebar_HitTest GUICtrlRebar_IDToIndex GUICtrlRebar_MaximizeBand GUICtrlRebar_MinimizeBand GUICtrlRebar_MoveBand GUICtrlRebar_SetBandBackColor GUICtrlRebar_SetBandForeColor GUICtrlRebar_SetBandHeaderSize GUICtrlRebar_SetBandID GUICtrlRebar_SetBandIdealSize GUICtrlRebar_SetBandLength GUICtrlRebar_SetBandLParam GUICtrlRebar_SetBandStyle GUICtrlRebar_SetBandStyleBreak GUICtrlRebar_SetBandStyleChildEdge GUICtrlRebar_SetBandStyleFixedBMP GUICtrlRebar_SetBandStyleFixedSize GUICtrlRebar_SetBandStyleGripperAlways GUICtrlRebar_SetBandStyleHidden GUICtrlRebar_SetBandStyleHideTitle GUICtrlRebar_SetBandStyleNoGripper GUICtrlRebar_SetBandStyleTopAlign GUICtrlRebar_SetBandStyleUseChevron GUICtrlRebar_SetBandStyleVariableHeight GUICtrlRebar_SetBandText GUICtrlRebar_SetBarInfo GUICtrlRebar_SetBKColor GUICtrlRebar_SetColorScheme GUICtrlRebar_SetTextColor GUICtrlRebar_SetToolTips GUICtrlRebar_SetUnicodeFormat GUICtrlRebar_ShowBand GUICtrlRichEdit_AppendText GUICtrlRichEdit_AutoDetectURL GUICtrlRichEdit_CanPaste GUICtrlRichEdit_CanPasteSpecial GUICtrlRichEdit_CanRedo GUICtrlRichEdit_CanUndo GUICtrlRichEdit_ChangeFontSize GUICtrlRichEdit_Copy GUICtrlRichEdit_Create GUICtrlRichEdit_Cut GUICtrlRichEdit_Deselect GUICtrlRichEdit_Destroy GUICtrlRichEdit_EmptyUndoBuffer GUICtrlRichEdit_FindText GUICtrlRichEdit_FindTextInRange GUICtrlRichEdit_GetBkColor GUICtrlRichEdit_GetCharAttributes GUICtrlRichEdit_GetCharBkColor GUICtrlRichEdit_GetCharColor GUICtrlRichEdit_GetCharPosFromXY GUICtrlRichEdit_GetCharPosOfNextWord GUICtrlRichEdit_GetCharPosOfPreviousWord GUICtrlRichEdit_GetCharWordBreakInfo GUICtrlRichEdit_GetFirstCharPosOnLine GUICtrlRichEdit_GetFont GUICtrlRichEdit_GetLineCount GUICtrlRichEdit_GetLineLength GUICtrlRichEdit_GetLineNumberFromCharPos GUICtrlRichEdit_GetNextRedo GUICtrlRichEdit_GetNextUndo GUICtrlRichEdit_GetNumberOfFirstVisibleLine GUICtrlRichEdit_GetParaAlignment GUICtrlRichEdit_GetParaAttributes GUICtrlRichEdit_GetParaBorder GUICtrlRichEdit_GetParaIndents GUICtrlRichEdit_GetParaNumbering GUICtrlRichEdit_GetParaShading GUICtrlRichEdit_GetParaSpacing GUICtrlRichEdit_GetParaTabStops GUICtrlRichEdit_GetPasswordChar GUICtrlRichEdit_GetRECT GUICtrlRichEdit_GetScrollPos GUICtrlRichEdit_GetSel GUICtrlRichEdit_GetSelAA GUICtrlRichEdit_GetSelText GUICtrlRichEdit_GetSpaceUnit GUICtrlRichEdit_GetText GUICtrlRichEdit_GetTextInLine GUICtrlRichEdit_GetTextInRange GUICtrlRichEdit_GetTextLength GUICtrlRichEdit_GetVersion GUICtrlRichEdit_GetXYFromCharPos GUICtrlRichEdit_GetZoom GUICtrlRichEdit_GotoCharPos GUICtrlRichEdit_HideSelection GUICtrlRichEdit_InsertText GUICtrlRichEdit_IsModified GUICtrlRichEdit_IsTextSelected GUICtrlRichEdit_Paste GUICtrlRichEdit_PasteSpecial GUICtrlRichEdit_PauseRedraw GUICtrlRichEdit_Redo GUICtrlRichEdit_ReplaceText GUICtrlRichEdit_ResumeRedraw GUICtrlRichEdit_ScrollLineOrPage GUICtrlRichEdit_ScrollLines GUICtrlRichEdit_ScrollToCaret GUICtrlRichEdit_SetBkColor GUICtrlRichEdit_SetCharAttributes GUICtrlRichEdit_SetCharBkColor GUICtrlRichEdit_SetCharColor GUICtrlRichEdit_SetEventMask GUICtrlRichEdit_SetFont GUICtrlRichEdit_SetLimitOnText GUICtrlRichEdit_SetModified GUICtrlRichEdit_SetParaAlignment GUICtrlRichEdit_SetParaAttributes GUICtrlRichEdit_SetParaBorder GUICtrlRichEdit_SetParaIndents GUICtrlRichEdit_SetParaNumbering GUICtrlRichEdit_SetParaShading GUICtrlRichEdit_SetParaSpacing GUICtrlRichEdit_SetParaTabStops GUICtrlRichEdit_SetPasswordChar GUICtrlRichEdit_SetReadOnly GUICtrlRichEdit_SetRECT GUICtrlRichEdit_SetScrollPos GUICtrlRichEdit_SetSel GUICtrlRichEdit_SetSpaceUnit GUICtrlRichEdit_SetTabStops GUICtrlRichEdit_SetText GUICtrlRichEdit_SetUndoLimit GUICtrlRichEdit_SetZoom GUICtrlRichEdit_StreamFromFile GUICtrlRichEdit_StreamFromVar GUICtrlRichEdit_StreamToFile GUICtrlRichEdit_StreamToVar GUICtrlRichEdit_Undo GUICtrlSlider_ClearSel GUICtrlSlider_ClearTics GUICtrlSlider_Create GUICtrlSlider_Destroy GUICtrlSlider_GetBuddy GUICtrlSlider_GetChannelRect GUICtrlSlider_GetChannelRectEx GUICtrlSlider_GetLineSize GUICtrlSlider_GetLogicalTics GUICtrlSlider_GetNumTics GUICtrlSlider_GetPageSize GUICtrlSlider_GetPos GUICtrlSlider_GetRange GUICtrlSlider_GetRangeMax GUICtrlSlider_GetRangeMin GUICtrlSlider_GetSel GUICtrlSlider_GetSelEnd GUICtrlSlider_GetSelStart GUICtrlSlider_GetThumbLength GUICtrlSlider_GetThumbRect GUICtrlSlider_GetThumbRectEx GUICtrlSlider_GetTic GUICtrlSlider_GetTicPos GUICtrlSlider_GetToolTips GUICtrlSlider_GetUnicodeFormat GUICtrlSlider_SetBuddy GUICtrlSlider_SetLineSize GUICtrlSlider_SetPageSize GUICtrlSlider_SetPos GUICtrlSlider_SetRange GUICtrlSlider_SetRangeMax GUICtrlSlider_SetRangeMin GUICtrlSlider_SetSel GUICtrlSlider_SetSelEnd GUICtrlSlider_SetSelStart GUICtrlSlider_SetThumbLength GUICtrlSlider_SetTic GUICtrlSlider_SetTicFreq GUICtrlSlider_SetTipSide GUICtrlSlider_SetToolTips GUICtrlSlider_SetUnicodeFormat GUICtrlStatusBar_Create GUICtrlStatusBar_Destroy GUICtrlStatusBar_EmbedControl GUICtrlStatusBar_GetBorders GUICtrlStatusBar_GetBordersHorz GUICtrlStatusBar_GetBordersRect GUICtrlStatusBar_GetBordersVert GUICtrlStatusBar_GetCount GUICtrlStatusBar_GetHeight GUICtrlStatusBar_GetIcon GUICtrlStatusBar_GetParts GUICtrlStatusBar_GetRect GUICtrlStatusBar_GetRectEx GUICtrlStatusBar_GetText GUICtrlStatusBar_GetTextFlags GUICtrlStatusBar_GetTextLength GUICtrlStatusBar_GetTextLengthEx GUICtrlStatusBar_GetTipText GUICtrlStatusBar_GetUnicodeFormat GUICtrlStatusBar_GetWidth GUICtrlStatusBar_IsSimple GUICtrlStatusBar_Resize GUICtrlStatusBar_SetBkColor GUICtrlStatusBar_SetIcon GUICtrlStatusBar_SetMinHeight GUICtrlStatusBar_SetParts GUICtrlStatusBar_SetSimple GUICtrlStatusBar_SetText GUICtrlStatusBar_SetTipText GUICtrlStatusBar_SetUnicodeFormat GUICtrlStatusBar_ShowHide GUICtrlTab_ActivateTab GUICtrlTab_ClickTab GUICtrlTab_Create GUICtrlTab_DeleteAllItems GUICtrlTab_DeleteItem GUICtrlTab_DeselectAll GUICtrlTab_Destroy GUICtrlTab_FindTab GUICtrlTab_GetCurFocus GUICtrlTab_GetCurSel GUICtrlTab_GetDisplayRect GUICtrlTab_GetDisplayRectEx GUICtrlTab_GetExtendedStyle GUICtrlTab_GetImageList GUICtrlTab_GetItem GUICtrlTab_GetItemCount GUICtrlTab_GetItemImage GUICtrlTab_GetItemParam GUICtrlTab_GetItemRect GUICtrlTab_GetItemRectEx GUICtrlTab_GetItemState GUICtrlTab_GetItemText GUICtrlTab_GetRowCount GUICtrlTab_GetToolTips GUICtrlTab_GetUnicodeFormat GUICtrlTab_HighlightItem GUICtrlTab_HitTest GUICtrlTab_InsertItem GUICtrlTab_RemoveImage GUICtrlTab_SetCurFocus GUICtrlTab_SetCurSel GUICtrlTab_SetExtendedStyle GUICtrlTab_SetImageList GUICtrlTab_SetItem GUICtrlTab_SetItemImage GUICtrlTab_SetItemParam GUICtrlTab_SetItemSize GUICtrlTab_SetItemState GUICtrlTab_SetItemText GUICtrlTab_SetMinTabWidth GUICtrlTab_SetPadding GUICtrlTab_SetToolTips GUICtrlTab_SetUnicodeFormat GUICtrlToolbar_AddBitmap GUICtrlToolbar_AddButton GUICtrlToolbar_AddButtonSep GUICtrlToolbar_AddString GUICtrlToolbar_ButtonCount GUICtrlToolbar_CheckButton GUICtrlToolbar_ClickAccel GUICtrlToolbar_ClickButton GUICtrlToolbar_ClickIndex GUICtrlToolbar_CommandToIndex GUICtrlToolbar_Create GUICtrlToolbar_Customize GUICtrlToolbar_DeleteButton GUICtrlToolbar_Destroy GUICtrlToolbar_EnableButton GUICtrlToolbar_FindToolbar GUICtrlToolbar_GetAnchorHighlight GUICtrlToolbar_GetBitmapFlags GUICtrlToolbar_GetButtonBitmap GUICtrlToolbar_GetButtonInfo GUICtrlToolbar_GetButtonInfoEx GUICtrlToolbar_GetButtonParam GUICtrlToolbar_GetButtonRect GUICtrlToolbar_GetButtonRectEx GUICtrlToolbar_GetButtonSize GUICtrlToolbar_GetButtonState GUICtrlToolbar_GetButtonStyle GUICtrlToolbar_GetButtonText GUICtrlToolbar_GetColorScheme GUICtrlToolbar_GetDisabledImageList GUICtrlToolbar_GetExtendedStyle GUICtrlToolbar_GetHotImageList GUICtrlToolbar_GetHotItem GUICtrlToolbar_GetImageList GUICtrlToolbar_GetInsertMark GUICtrlToolbar_GetInsertMarkColor GUICtrlToolbar_GetMaxSize GUICtrlToolbar_GetMetrics GUICtrlToolbar_GetPadding GUICtrlToolbar_GetRows GUICtrlToolbar_GetString GUICtrlToolbar_GetStyle GUICtrlToolbar_GetStyleAltDrag GUICtrlToolbar_GetStyleCustomErase GUICtrlToolbar_GetStyleFlat GUICtrlToolbar_GetStyleList GUICtrlToolbar_GetStyleRegisterDrop GUICtrlToolbar_GetStyleToolTips GUICtrlToolbar_GetStyleTransparent GUICtrlToolbar_GetStyleWrapable GUICtrlToolbar_GetTextRows GUICtrlToolbar_GetToolTips GUICtrlToolbar_GetUnicodeFormat GUICtrlToolbar_HideButton GUICtrlToolbar_HighlightButton GUICtrlToolbar_HitTest GUICtrlToolbar_IndexToCommand GUICtrlToolbar_InsertButton GUICtrlToolbar_InsertMarkHitTest GUICtrlToolbar_IsButtonChecked GUICtrlToolbar_IsButtonEnabled GUICtrlToolbar_IsButtonHidden GUICtrlToolbar_IsButtonHighlighted GUICtrlToolbar_IsButtonIndeterminate GUICtrlToolbar_IsButtonPressed GUICtrlToolbar_LoadBitmap GUICtrlToolbar_LoadImages GUICtrlToolbar_MapAccelerator GUICtrlToolbar_MoveButton GUICtrlToolbar_PressButton GUICtrlToolbar_SetAnchorHighlight GUICtrlToolbar_SetBitmapSize GUICtrlToolbar_SetButtonBitMap GUICtrlToolbar_SetButtonInfo GUICtrlToolbar_SetButtonInfoEx GUICtrlToolbar_SetButtonParam GUICtrlToolbar_SetButtonSize GUICtrlToolbar_SetButtonState GUICtrlToolbar_SetButtonStyle GUICtrlToolbar_SetButtonText GUICtrlToolbar_SetButtonWidth GUICtrlToolbar_SetCmdID GUICtrlToolbar_SetColorScheme GUICtrlToolbar_SetDisabledImageList GUICtrlToolbar_SetDrawTextFlags GUICtrlToolbar_SetExtendedStyle GUICtrlToolbar_SetHotImageList GUICtrlToolbar_SetHotItem GUICtrlToolbar_SetImageList GUICtrlToolbar_SetIndent GUICtrlToolbar_SetIndeterminate GUICtrlToolbar_SetInsertMark GUICtrlToolbar_SetInsertMarkColor GUICtrlToolbar_SetMaxTextRows GUICtrlToolbar_SetMetrics GUICtrlToolbar_SetPadding GUICtrlToolbar_SetParent GUICtrlToolbar_SetRows GUICtrlToolbar_SetStyle GUICtrlToolbar_SetStyleAltDrag GUICtrlToolbar_SetStyleCustomErase GUICtrlToolbar_SetStyleFlat GUICtrlToolbar_SetStyleList GUICtrlToolbar_SetStyleRegisterDrop GUICtrlToolbar_SetStyleToolTips GUICtrlToolbar_SetStyleTransparent GUICtrlToolbar_SetStyleWrapable GUICtrlToolbar_SetToolTips GUICtrlToolbar_SetUnicodeFormat GUICtrlToolbar_SetWindowTheme GUICtrlTreeView_Add GUICtrlTreeView_AddChild GUICtrlTreeView_AddChildFirst GUICtrlTreeView_AddFirst GUICtrlTreeView_BeginUpdate GUICtrlTreeView_ClickItem GUICtrlTreeView_Create GUICtrlTreeView_CreateDragImage GUICtrlTreeView_CreateSolidBitMap GUICtrlTreeView_Delete GUICtrlTreeView_DeleteAll GUICtrlTreeView_DeleteChildren GUICtrlTreeView_Destroy GUICtrlTreeView_DisplayRect GUICtrlTreeView_DisplayRectEx GUICtrlTreeView_EditText GUICtrlTreeView_EndEdit GUICtrlTreeView_EndUpdate GUICtrlTreeView_EnsureVisible GUICtrlTreeView_Expand GUICtrlTreeView_ExpandedOnce GUICtrlTreeView_FindItem GUICtrlTreeView_FindItemEx GUICtrlTreeView_GetBkColor GUICtrlTreeView_GetBold GUICtrlTreeView_GetChecked GUICtrlTreeView_GetChildCount GUICtrlTreeView_GetChildren GUICtrlTreeView_GetCount GUICtrlTreeView_GetCut GUICtrlTreeView_GetDropTarget GUICtrlTreeView_GetEditControl GUICtrlTreeView_GetExpanded GUICtrlTreeView_GetFirstChild GUICtrlTreeView_GetFirstItem GUICtrlTreeView_GetFirstVisible GUICtrlTreeView_GetFocused GUICtrlTreeView_GetHeight GUICtrlTreeView_GetImageIndex GUICtrlTreeView_GetImageListIconHandle GUICtrlTreeView_GetIndent GUICtrlTreeView_GetInsertMarkColor GUICtrlTreeView_GetISearchString GUICtrlTreeView_GetItemByIndex GUICtrlTreeView_GetItemHandle GUICtrlTreeView_GetItemParam GUICtrlTreeView_GetLastChild GUICtrlTreeView_GetLineColor GUICtrlTreeView_GetNext GUICtrlTreeView_GetNextChild GUICtrlTreeView_GetNextSibling GUICtrlTreeView_GetNextVisible GUICtrlTreeView_GetNormalImageList GUICtrlTreeView_GetParentHandle GUICtrlTreeView_GetParentParam GUICtrlTreeView_GetPrev GUICtrlTreeView_GetPrevChild GUICtrlTreeView_GetPrevSibling GUICtrlTreeView_GetPrevVisible GUICtrlTreeView_GetScrollTime GUICtrlTreeView_GetSelected GUICtrlTreeView_GetSelectedImageIndex GUICtrlTreeView_GetSelection GUICtrlTreeView_GetSiblingCount GUICtrlTreeView_GetState GUICtrlTreeView_GetStateImageIndex GUICtrlTreeView_GetStateImageList GUICtrlTreeView_GetText GUICtrlTreeView_GetTextColor GUICtrlTreeView_GetToolTips GUICtrlTreeView_GetTree GUICtrlTreeView_GetUnicodeFormat GUICtrlTreeView_GetVisible GUICtrlTreeView_GetVisibleCount GUICtrlTreeView_HitTest GUICtrlTreeView_HitTestEx GUICtrlTreeView_HitTestItem GUICtrlTreeView_Index GUICtrlTreeView_InsertItem GUICtrlTreeView_IsFirstItem GUICtrlTreeView_IsParent GUICtrlTreeView_Level GUICtrlTreeView_SelectItem GUICtrlTreeView_SelectItemByIndex GUICtrlTreeView_SetBkColor GUICtrlTreeView_SetBold GUICtrlTreeView_SetChecked GUICtrlTreeView_SetCheckedByIndex GUICtrlTreeView_SetChildren GUICtrlTreeView_SetCut GUICtrlTreeView_SetDropTarget GUICtrlTreeView_SetFocused GUICtrlTreeView_SetHeight GUICtrlTreeView_SetIcon GUICtrlTreeView_SetImageIndex GUICtrlTreeView_SetIndent GUICtrlTreeView_SetInsertMark GUICtrlTreeView_SetInsertMarkColor GUICtrlTreeView_SetItemHeight GUICtrlTreeView_SetItemParam GUICtrlTreeView_SetLineColor GUICtrlTreeView_SetNormalImageList GUICtrlTreeView_SetScrollTime GUICtrlTreeView_SetSelected GUICtrlTreeView_SetSelectedImageIndex GUICtrlTreeView_SetState GUICtrlTreeView_SetStateImageIndex GUICtrlTreeView_SetStateImageList GUICtrlTreeView_SetText GUICtrlTreeView_SetTextColor GUICtrlTreeView_SetToolTips GUICtrlTreeView_SetUnicodeFormat GUICtrlTreeView_Sort GUIImageList_Add GUIImageList_AddBitmap GUIImageList_AddIcon GUIImageList_AddMasked GUIImageList_BeginDrag GUIImageList_Copy GUIImageList_Create GUIImageList_Destroy GUIImageList_DestroyIcon GUIImageList_DragEnter GUIImageList_DragLeave GUIImageList_DragMove GUIImageList_Draw GUIImageList_DrawEx GUIImageList_Duplicate GUIImageList_EndDrag GUIImageList_GetBkColor GUIImageList_GetIcon GUIImageList_GetIconHeight GUIImageList_GetIconSize GUIImageList_GetIconSizeEx GUIImageList_GetIconWidth GUIImageList_GetImageCount GUIImageList_GetImageInfoEx GUIImageList_Remove GUIImageList_ReplaceIcon GUIImageList_SetBkColor GUIImageList_SetIconSize GUIImageList_SetImageCount GUIImageList_Swap GUIScrollBars_EnableScrollBar GUIScrollBars_GetScrollBarInfoEx GUIScrollBars_GetScrollBarRect GUIScrollBars_GetScrollBarRGState GUIScrollBars_GetScrollBarXYLineButton GUIScrollBars_GetScrollBarXYThumbBottom GUIScrollBars_GetScrollBarXYThumbTop GUIScrollBars_GetScrollInfo GUIScrollBars_GetScrollInfoEx GUIScrollBars_GetScrollInfoMax GUIScrollBars_GetScrollInfoMin GUIScrollBars_GetScrollInfoPage GUIScrollBars_GetScrollInfoPos GUIScrollBars_GetScrollInfoTrackPos GUIScrollBars_GetScrollPos GUIScrollBars_GetScrollRange GUIScrollBars_Init GUIScrollBars_ScrollWindow GUIScrollBars_SetScrollInfo GUIScrollBars_SetScrollInfoMax GUIScrollBars_SetScrollInfoMin GUIScrollBars_SetScrollInfoPage GUIScrollBars_SetScrollInfoPos GUIScrollBars_SetScrollRange GUIScrollBars_ShowScrollBar GUIToolTip_Activate GUIToolTip_AddTool GUIToolTip_AdjustRect GUIToolTip_BitsToTTF GUIToolTip_Create GUIToolTip_Deactivate GUIToolTip_DelTool GUIToolTip_Destroy GUIToolTip_EnumTools GUIToolTip_GetBubbleHeight GUIToolTip_GetBubbleSize GUIToolTip_GetBubbleWidth GUIToolTip_GetCurrentTool GUIToolTip_GetDelayTime GUIToolTip_GetMargin GUIToolTip_GetMarginEx GUIToolTip_GetMaxTipWidth GUIToolTip_GetText GUIToolTip_GetTipBkColor GUIToolTip_GetTipTextColor GUIToolTip_GetTitleBitMap GUIToolTip_GetTitleText GUIToolTip_GetToolCount GUIToolTip_GetToolInfo GUIToolTip_HitTest GUIToolTip_NewToolRect GUIToolTip_Pop GUIToolTip_PopUp GUIToolTip_SetDelayTime GUIToolTip_SetMargin GUIToolTip_SetMaxTipWidth GUIToolTip_SetTipBkColor GUIToolTip_SetTipTextColor GUIToolTip_SetTitle GUIToolTip_SetToolInfo GUIToolTip_SetWindowTheme GUIToolTip_ToolExists GUIToolTip_ToolToArray GUIToolTip_TrackActivate GUIToolTip_TrackPosition GUIToolTip_Update GUIToolTip_UpdateTipText HexToString IEAction IEAttach IEBodyReadHTML IEBodyReadText IEBodyWriteHTML IECreate IECreateEmbedded IEDocGetObj IEDocInsertHTML IEDocInsertText IEDocReadHTML IEDocWriteHTML IEErrorNotify IEFormElementCheckBoxSelect IEFormElementGetCollection IEFormElementGetObjByName IEFormElementGetValue IEFormElementOptionSelect IEFormElementRadioSelect IEFormElementSetValue IEFormGetCollection IEFormGetObjByName IEFormImageClick IEFormReset IEFormSubmit IEFrameGetCollection IEFrameGetObjByName IEGetObjById IEGetObjByName IEHeadInsertEventScript IEImgClick IEImgGetCollection IEIsFrameSet IELinkClickByIndex IELinkClickByText IELinkGetCollection IELoadWait IELoadWaitTimeout IENavigate IEPropertyGet IEPropertySet IEQuit IETableGetCollection IETableWriteToArray IETagNameAllGetCollection IETagNameGetCollection IE_Example IE_Introduction IE_VersionInfo INetExplorerCapable INetGetSource INetMail INetSmtpMail IsPressed MathCheckDiv Max MemGlobalAlloc MemGlobalFree MemGlobalLock MemGlobalSize MemGlobalUnlock MemMoveMemory MemVirtualAlloc MemVirtualAllocEx MemVirtualFree MemVirtualFreeEx Min MouseTrap NamedPipes_CallNamedPipe NamedPipes_ConnectNamedPipe NamedPipes_CreateNamedPipe NamedPipes_CreatePipe NamedPipes_DisconnectNamedPipe NamedPipes_GetNamedPipeHandleState NamedPipes_GetNamedPipeInfo NamedPipes_PeekNamedPipe NamedPipes_SetNamedPipeHandleState NamedPipes_TransactNamedPipe NamedPipes_WaitNamedPipe Net_Share_ConnectionEnum Net_Share_FileClose Net_Share_FileEnum Net_Share_FileGetInfo Net_Share_PermStr Net_Share_ResourceStr Net_Share_SessionDel Net_Share_SessionEnum Net_Share_SessionGetInfo Net_Share_ShareAdd Net_Share_ShareCheck Net_Share_ShareDel Net_Share_ShareEnum Net_Share_ShareGetInfo Net_Share_ShareSetInfo Net_Share_StatisticsGetSvr Net_Share_StatisticsGetWrk Now NowCalc NowCalcDate NowDate NowTime PathFull PathGetRelative PathMake PathSplit ProcessGetName ProcessGetPriority Radian ReplaceStringInFile RunDos ScreenCapture_Capture ScreenCapture_CaptureWnd ScreenCapture_SaveImage ScreenCapture_SetBMPFormat ScreenCapture_SetJPGQuality ScreenCapture_SetTIFColorDepth ScreenCapture_SetTIFCompression Security__AdjustTokenPrivileges Security__CreateProcessWithToken Security__DuplicateTokenEx Security__GetAccountSid Security__GetLengthSid Security__GetTokenInformation Security__ImpersonateSelf Security__IsValidSid Security__LookupAccountName Security__LookupAccountSid Security__LookupPrivilegeValue Security__OpenProcessToken Security__OpenThreadToken Security__OpenThreadTokenEx Security__SetPrivilege Security__SetTokenInformation Security__SidToStringSid Security__SidTypeStr Security__StringSidToSid SendMessage SendMessageA SetDate SetTime Singleton SoundClose SoundLength SoundOpen SoundPause SoundPlay SoundPos SoundResume SoundSeek SoundStatus SoundStop SQLite_Changes SQLite_Close SQLite_Display2DResult SQLite_Encode SQLite_ErrCode SQLite_ErrMsg SQLite_Escape SQLite_Exec SQLite_FastEncode SQLite_FastEscape SQLite_FetchData SQLite_FetchNames SQLite_GetTable SQLite_GetTable2d SQLite_LastInsertRowID SQLite_LibVersion SQLite_Open SQLite_Query SQLite_QueryFinalize SQLite_QueryReset SQLite_QuerySingleRow SQLite_SafeMode SQLite_SetTimeout SQLite_Shutdown SQLite_SQLiteExe SQLite_Startup SQLite_TotalChanges StringBetween StringExplode StringInsert StringProper StringRepeat StringTitleCase StringToHex TCPIpToName TempFile TicksToTime Timer_Diff Timer_GetIdleTime Timer_GetTimerID Timer_Init Timer_KillAllTimers Timer_KillTimer Timer_SetTimer TimeToTicks VersionCompare viClose viExecCommand viFindGpib viGpibBusReset viGTL viInteractiveControl viOpen viSetAttribute viSetTimeout WeekNumberISO WinAPI_AbortPath WinAPI_ActivateKeyboardLayout WinAPI_AddClipboardFormatListener WinAPI_AddFontMemResourceEx WinAPI_AddFontResourceEx WinAPI_AddIconOverlay WinAPI_AddIconTransparency WinAPI_AddMRUString WinAPI_AdjustBitmap WinAPI_AdjustTokenPrivileges WinAPI_AdjustWindowRectEx WinAPI_AlphaBlend WinAPI_AngleArc WinAPI_AnimateWindow WinAPI_Arc WinAPI_ArcTo WinAPI_ArrayToStruct WinAPI_AssignProcessToJobObject WinAPI_AssocGetPerceivedType WinAPI_AssocQueryString WinAPI_AttachConsole WinAPI_AttachThreadInput WinAPI_BackupRead WinAPI_BackupReadAbort WinAPI_BackupSeek WinAPI_BackupWrite WinAPI_BackupWriteAbort WinAPI_Beep WinAPI_BeginBufferedPaint WinAPI_BeginDeferWindowPos WinAPI_BeginPaint WinAPI_BeginPath WinAPI_BeginUpdateResource WinAPI_BitBlt WinAPI_BringWindowToTop WinAPI_BroadcastSystemMessage WinAPI_BrowseForFolderDlg WinAPI_BufferedPaintClear WinAPI_BufferedPaintInit WinAPI_BufferedPaintSetAlpha WinAPI_BufferedPaintUnInit WinAPI_CallNextHookEx WinAPI_CallWindowProc WinAPI_CallWindowProcW WinAPI_CascadeWindows WinAPI_ChangeWindowMessageFilterEx WinAPI_CharToOem WinAPI_ChildWindowFromPointEx WinAPI_ClientToScreen WinAPI_ClipCursor WinAPI_CloseDesktop WinAPI_CloseEnhMetaFile WinAPI_CloseFigure WinAPI_CloseHandle WinAPI_CloseThemeData WinAPI_CloseWindow WinAPI_CloseWindowStation WinAPI_CLSIDFromProgID WinAPI_CoInitialize WinAPI_ColorAdjustLuma WinAPI_ColorHLSToRGB WinAPI_ColorRGBToHLS WinAPI_CombineRgn WinAPI_CombineTransform WinAPI_CommandLineToArgv WinAPI_CommDlgExtendedError WinAPI_CommDlgExtendedErrorEx WinAPI_CompareString WinAPI_CompressBitmapBits WinAPI_CompressBuffer WinAPI_ComputeCrc32 WinAPI_ConfirmCredentials WinAPI_CopyBitmap WinAPI_CopyCursor WinAPI_CopyEnhMetaFile WinAPI_CopyFileEx WinAPI_CopyIcon WinAPI_CopyImage WinAPI_CopyRect WinAPI_CopyStruct WinAPI_CoTaskMemAlloc WinAPI_CoTaskMemFree WinAPI_CoTaskMemRealloc WinAPI_CoUninitialize WinAPI_Create32BitHBITMAP WinAPI_Create32BitHICON WinAPI_CreateANDBitmap WinAPI_CreateBitmap WinAPI_CreateBitmapIndirect WinAPI_CreateBrushIndirect WinAPI_CreateBuffer WinAPI_CreateBufferFromStruct WinAPI_CreateCaret WinAPI_CreateColorAdjustment WinAPI_CreateCompatibleBitmap WinAPI_CreateCompatibleBitmapEx WinAPI_CreateCompatibleDC WinAPI_CreateDesktop WinAPI_CreateDIB WinAPI_CreateDIBColorTable WinAPI_CreateDIBitmap WinAPI_CreateDIBSection WinAPI_CreateDirectory WinAPI_CreateDirectoryEx WinAPI_CreateEllipticRgn WinAPI_CreateEmptyIcon WinAPI_CreateEnhMetaFile WinAPI_CreateEvent WinAPI_CreateFile WinAPI_CreateFileEx WinAPI_CreateFileMapping WinAPI_CreateFont WinAPI_CreateFontEx WinAPI_CreateFontIndirect WinAPI_CreateGUID WinAPI_CreateHardLink WinAPI_CreateIcon WinAPI_CreateIconFromResourceEx WinAPI_CreateIconIndirect WinAPI_CreateJobObject WinAPI_CreateMargins WinAPI_CreateMRUList WinAPI_CreateMutex WinAPI_CreateNullRgn WinAPI_CreateNumberFormatInfo WinAPI_CreateObjectID WinAPI_CreatePen WinAPI_CreatePoint WinAPI_CreatePolygonRgn WinAPI_CreateProcess WinAPI_CreateProcessWithToken WinAPI_CreateRect WinAPI_CreateRectEx WinAPI_CreateRectRgn WinAPI_CreateRectRgnIndirect WinAPI_CreateRoundRectRgn WinAPI_CreateSemaphore WinAPI_CreateSize WinAPI_CreateSolidBitmap WinAPI_CreateSolidBrush WinAPI_CreateStreamOnHGlobal WinAPI_CreateString WinAPI_CreateSymbolicLink WinAPI_CreateTransform WinAPI_CreateWindowEx WinAPI_CreateWindowStation WinAPI_DecompressBuffer WinAPI_DecryptFile WinAPI_DeferWindowPos WinAPI_DefineDosDevice WinAPI_DefRawInputProc WinAPI_DefSubclassProc WinAPI_DefWindowProc WinAPI_DefWindowProcW WinAPI_DeleteDC WinAPI_DeleteEnhMetaFile WinAPI_DeleteFile WinAPI_DeleteObject WinAPI_DeleteObjectID WinAPI_DeleteVolumeMountPoint WinAPI_DeregisterShellHookWindow WinAPI_DestroyCaret WinAPI_DestroyCursor WinAPI_DestroyIcon WinAPI_DestroyWindow WinAPI_DeviceIoControl WinAPI_DisplayStruct WinAPI_DllGetVersion WinAPI_DllInstall WinAPI_DllUninstall WinAPI_DPtoLP WinAPI_DragAcceptFiles WinAPI_DragFinish WinAPI_DragQueryFileEx WinAPI_DragQueryPoint WinAPI_DrawAnimatedRects WinAPI_DrawBitmap WinAPI_DrawEdge WinAPI_DrawFocusRect WinAPI_DrawFrameControl WinAPI_DrawIcon WinAPI_DrawIconEx WinAPI_DrawLine WinAPI_DrawShadowText WinAPI_DrawText WinAPI_DrawThemeBackground WinAPI_DrawThemeEdge WinAPI_DrawThemeIcon WinAPI_DrawThemeParentBackground WinAPI_DrawThemeText WinAPI_DrawThemeTextEx WinAPI_DuplicateEncryptionInfoFile WinAPI_DuplicateHandle WinAPI_DuplicateTokenEx WinAPI_DwmDefWindowProc WinAPI_DwmEnableBlurBehindWindow WinAPI_DwmEnableComposition WinAPI_DwmExtendFrameIntoClientArea WinAPI_DwmGetColorizationColor WinAPI_DwmGetColorizationParameters WinAPI_DwmGetWindowAttribute WinAPI_DwmInvalidateIconicBitmaps WinAPI_DwmIsCompositionEnabled WinAPI_DwmQueryThumbnailSourceSize WinAPI_DwmRegisterThumbnail WinAPI_DwmSetColorizationParameters WinAPI_DwmSetIconicLivePreviewBitmap WinAPI_DwmSetIconicThumbnail WinAPI_DwmSetWindowAttribute WinAPI_DwmUnregisterThumbnail WinAPI_DwmUpdateThumbnailProperties WinAPI_DWordToFloat WinAPI_DWordToInt WinAPI_EjectMedia WinAPI_Ellipse WinAPI_EmptyWorkingSet WinAPI_EnableWindow WinAPI_EncryptFile WinAPI_EncryptionDisable WinAPI_EndBufferedPaint WinAPI_EndDeferWindowPos WinAPI_EndPaint WinAPI_EndPath WinAPI_EndUpdateResource WinAPI_EnumChildProcess WinAPI_EnumChildWindows WinAPI_EnumDesktops WinAPI_EnumDesktopWindows WinAPI_EnumDeviceDrivers WinAPI_EnumDisplayDevices WinAPI_EnumDisplayMonitors WinAPI_EnumDisplaySettings WinAPI_EnumDllProc WinAPI_EnumFiles WinAPI_EnumFileStreams WinAPI_EnumFontFamilies WinAPI_EnumHardLinks WinAPI_EnumMRUList WinAPI_EnumPageFiles WinAPI_EnumProcessHandles WinAPI_EnumProcessModules WinAPI_EnumProcessThreads WinAPI_EnumProcessWindows WinAPI_EnumRawInputDevices WinAPI_EnumResourceLanguages WinAPI_EnumResourceNames WinAPI_EnumResourceTypes WinAPI_EnumSystemGeoID WinAPI_EnumSystemLocales WinAPI_EnumUILanguages WinAPI_EnumWindows WinAPI_EnumWindowsPopup WinAPI_EnumWindowStations WinAPI_EnumWindowsTop WinAPI_EqualMemory WinAPI_EqualRect WinAPI_EqualRgn WinAPI_ExcludeClipRect WinAPI_ExpandEnvironmentStrings WinAPI_ExtCreatePen WinAPI_ExtCreateRegion WinAPI_ExtFloodFill WinAPI_ExtractIcon WinAPI_ExtractIconEx WinAPI_ExtSelectClipRgn WinAPI_FatalAppExit WinAPI_FatalExit WinAPI_FileEncryptionStatus WinAPI_FileExists WinAPI_FileIconInit WinAPI_FileInUse WinAPI_FillMemory WinAPI_FillPath WinAPI_FillRect WinAPI_FillRgn WinAPI_FindClose WinAPI_FindCloseChangeNotification WinAPI_FindExecutable WinAPI_FindFirstChangeNotification WinAPI_FindFirstFile WinAPI_FindFirstFileName WinAPI_FindFirstStream WinAPI_FindNextChangeNotification WinAPI_FindNextFile WinAPI_FindNextFileName WinAPI_FindNextStream WinAPI_FindResource WinAPI_FindResourceEx WinAPI_FindTextDlg WinAPI_FindWindow WinAPI_FlashWindow WinAPI_FlashWindowEx WinAPI_FlattenPath WinAPI_FloatToDWord WinAPI_FloatToInt WinAPI_FlushFileBuffers WinAPI_FlushFRBuffer WinAPI_FlushViewOfFile WinAPI_FormatDriveDlg WinAPI_FormatMessage WinAPI_FrameRect WinAPI_FrameRgn WinAPI_FreeLibrary WinAPI_FreeMemory WinAPI_FreeMRUList WinAPI_FreeResource WinAPI_GdiComment WinAPI_GetActiveWindow WinAPI_GetAllUsersProfileDirectory WinAPI_GetAncestor WinAPI_GetApplicationRestartSettings WinAPI_GetArcDirection WinAPI_GetAsyncKeyState WinAPI_GetBinaryType WinAPI_GetBitmapBits WinAPI_GetBitmapDimension WinAPI_GetBitmapDimensionEx WinAPI_GetBkColor WinAPI_GetBkMode WinAPI_GetBoundsRect WinAPI_GetBrushOrg WinAPI_GetBufferedPaintBits WinAPI_GetBufferedPaintDC WinAPI_GetBufferedPaintTargetDC WinAPI_GetBufferedPaintTargetRect WinAPI_GetBValue WinAPI_GetCaretBlinkTime WinAPI_GetCaretPos WinAPI_GetCDType WinAPI_GetClassInfoEx WinAPI_GetClassLongEx WinAPI_GetClassName WinAPI_GetClientHeight WinAPI_GetClientRect WinAPI_GetClientWidth WinAPI_GetClipboardSequenceNumber WinAPI_GetClipBox WinAPI_GetClipCursor WinAPI_GetClipRgn WinAPI_GetColorAdjustment WinAPI_GetCompressedFileSize WinAPI_GetCompression WinAPI_GetConnectedDlg WinAPI_GetCurrentDirectory WinAPI_GetCurrentHwProfile WinAPI_GetCurrentObject WinAPI_GetCurrentPosition WinAPI_GetCurrentProcess WinAPI_GetCurrentProcessExplicitAppUserModelID WinAPI_GetCurrentProcessID WinAPI_GetCurrentThemeName WinAPI_GetCurrentThread WinAPI_GetCurrentThreadId WinAPI_GetCursor WinAPI_GetCursorInfo WinAPI_GetDateFormat WinAPI_GetDC WinAPI_GetDCEx WinAPI_GetDefaultPrinter WinAPI_GetDefaultUserProfileDirectory WinAPI_GetDesktopWindow WinAPI_GetDeviceCaps WinAPI_GetDeviceDriverBaseName WinAPI_GetDeviceDriverFileName WinAPI_GetDeviceGammaRamp WinAPI_GetDIBColorTable WinAPI_GetDIBits WinAPI_GetDiskFreeSpaceEx WinAPI_GetDlgCtrlID WinAPI_GetDlgItem WinAPI_GetDllDirectory WinAPI_GetDriveBusType WinAPI_GetDriveGeometryEx WinAPI_GetDriveNumber WinAPI_GetDriveType WinAPI_GetDurationFormat WinAPI_GetEffectiveClientRect WinAPI_GetEnhMetaFile WinAPI_GetEnhMetaFileBits WinAPI_GetEnhMetaFileDescription WinAPI_GetEnhMetaFileDimension WinAPI_GetEnhMetaFileHeader WinAPI_GetErrorMessage WinAPI_GetErrorMode WinAPI_GetExitCodeProcess WinAPI_GetExtended WinAPI_GetFileAttributes WinAPI_GetFileID WinAPI_GetFileInformationByHandle WinAPI_GetFileInformationByHandleEx WinAPI_GetFilePointerEx WinAPI_GetFileSizeEx WinAPI_GetFileSizeOnDisk WinAPI_GetFileTitle WinAPI_GetFileType WinAPI_GetFileVersionInfo WinAPI_GetFinalPathNameByHandle WinAPI_GetFinalPathNameByHandleEx WinAPI_GetFocus WinAPI_GetFontMemoryResourceInfo WinAPI_GetFontName WinAPI_GetFontResourceInfo WinAPI_GetForegroundWindow WinAPI_GetFRBuffer WinAPI_GetFullPathName WinAPI_GetGeoInfo WinAPI_GetGlyphOutline WinAPI_GetGraphicsMode WinAPI_GetGuiResources WinAPI_GetGUIThreadInfo WinAPI_GetGValue WinAPI_GetHandleInformation WinAPI_GetHGlobalFromStream WinAPI_GetIconDimension WinAPI_GetIconInfo WinAPI_GetIconInfoEx WinAPI_GetIdleTime WinAPI_GetKeyboardLayout WinAPI_GetKeyboardLayoutList WinAPI_GetKeyboardState WinAPI_GetKeyboardType WinAPI_GetKeyNameText WinAPI_GetKeyState WinAPI_GetLastActivePopup WinAPI_GetLastError WinAPI_GetLastErrorMessage WinAPI_GetLayeredWindowAttributes WinAPI_GetLocaleInfo WinAPI_GetLogicalDrives WinAPI_GetMapMode WinAPI_GetMemorySize WinAPI_GetMessageExtraInfo WinAPI_GetModuleFileNameEx WinAPI_GetModuleHandle WinAPI_GetModuleHandleEx WinAPI_GetModuleInformation WinAPI_GetMonitorInfo WinAPI_GetMousePos WinAPI_GetMousePosX WinAPI_GetMousePosY WinAPI_GetMUILanguage WinAPI_GetNumberFormat WinAPI_GetObject WinAPI_GetObjectID WinAPI_GetObjectInfoByHandle WinAPI_GetObjectNameByHandle WinAPI_GetObjectType WinAPI_GetOpenFileName WinAPI_GetOutlineTextMetrics WinAPI_GetOverlappedResult WinAPI_GetParent WinAPI_GetParentProcess WinAPI_GetPerformanceInfo WinAPI_GetPEType WinAPI_GetPhysicallyInstalledSystemMemory WinAPI_GetPixel WinAPI_GetPolyFillMode WinAPI_GetPosFromRect WinAPI_GetPriorityClass WinAPI_GetProcAddress WinAPI_GetProcessAffinityMask WinAPI_GetProcessCommandLine WinAPI_GetProcessFileName WinAPI_GetProcessHandleCount WinAPI_GetProcessID WinAPI_GetProcessIoCounters WinAPI_GetProcessMemoryInfo WinAPI_GetProcessName WinAPI_GetProcessShutdownParameters WinAPI_GetProcessTimes WinAPI_GetProcessUser WinAPI_GetProcessWindowStation WinAPI_GetProcessWorkingDirectory WinAPI_GetProfilesDirectory WinAPI_GetPwrCapabilities WinAPI_GetRawInputBuffer WinAPI_GetRawInputBufferLength WinAPI_GetRawInputData WinAPI_GetRawInputDeviceInfo WinAPI_GetRegionData WinAPI_GetRegisteredRawInputDevices WinAPI_GetRegKeyNameByHandle WinAPI_GetRgnBox WinAPI_GetROP2 WinAPI_GetRValue WinAPI_GetSaveFileName WinAPI_GetShellWindow WinAPI_GetStartupInfo WinAPI_GetStdHandle WinAPI_GetStockObject WinAPI_GetStretchBltMode WinAPI_GetString WinAPI_GetSysColor WinAPI_GetSysColorBrush WinAPI_GetSystemDefaultLangID WinAPI_GetSystemDefaultLCID WinAPI_GetSystemDefaultUILanguage WinAPI_GetSystemDEPPolicy WinAPI_GetSystemInfo WinAPI_GetSystemMetrics WinAPI_GetSystemPowerStatus WinAPI_GetSystemTimes WinAPI_GetSystemWow64Directory WinAPI_GetTabbedTextExtent WinAPI_GetTempFileName WinAPI_GetTextAlign WinAPI_GetTextCharacterExtra WinAPI_GetTextColor WinAPI_GetTextExtentPoint32 WinAPI_GetTextFace WinAPI_GetTextMetrics WinAPI_GetThemeAppProperties WinAPI_GetThemeBackgroundContentRect WinAPI_GetThemeBackgroundExtent WinAPI_GetThemeBackgroundRegion WinAPI_GetThemeBitmap WinAPI_GetThemeBool WinAPI_GetThemeColor WinAPI_GetThemeDocumentationProperty WinAPI_GetThemeEnumValue WinAPI_GetThemeFilename WinAPI_GetThemeFont WinAPI_GetThemeInt WinAPI_GetThemeMargins WinAPI_GetThemeMetric WinAPI_GetThemePartSize WinAPI_GetThemePosition WinAPI_GetThemePropertyOrigin WinAPI_GetThemeRect WinAPI_GetThemeString WinAPI_GetThemeSysBool WinAPI_GetThemeSysColor WinAPI_GetThemeSysColorBrush WinAPI_GetThemeSysFont WinAPI_GetThemeSysInt WinAPI_GetThemeSysSize WinAPI_GetThemeSysString WinAPI_GetThemeTextExtent WinAPI_GetThemeTextMetrics WinAPI_GetThemeTransitionDuration WinAPI_GetThreadDesktop WinAPI_GetThreadErrorMode WinAPI_GetThreadLocale WinAPI_GetThreadUILanguage WinAPI_GetTickCount WinAPI_GetTickCount64 WinAPI_GetTimeFormat WinAPI_GetTopWindow WinAPI_GetUDFColorMode WinAPI_GetUpdateRect WinAPI_GetUpdateRgn WinAPI_GetUserDefaultLangID WinAPI_GetUserDefaultLCID WinAPI_GetUserDefaultUILanguage WinAPI_GetUserGeoID WinAPI_GetUserObjectInformation WinAPI_GetVersion WinAPI_GetVersionEx WinAPI_GetVolumeInformation WinAPI_GetVolumeInformationByHandle WinAPI_GetVolumeNameForVolumeMountPoint WinAPI_GetWindow WinAPI_GetWindowDC WinAPI_GetWindowDisplayAffinity WinAPI_GetWindowExt WinAPI_GetWindowFileName WinAPI_GetWindowHeight WinAPI_GetWindowInfo WinAPI_GetWindowLong WinAPI_GetWindowOrg WinAPI_GetWindowPlacement WinAPI_GetWindowRect WinAPI_GetWindowRgn WinAPI_GetWindowRgnBox WinAPI_GetWindowSubclass WinAPI_GetWindowText WinAPI_GetWindowTheme WinAPI_GetWindowThreadProcessId WinAPI_GetWindowWidth WinAPI_GetWorkArea WinAPI_GetWorldTransform WinAPI_GetXYFromPoint WinAPI_GlobalMemoryStatus WinAPI_GradientFill WinAPI_GUIDFromString WinAPI_GUIDFromStringEx WinAPI_HashData WinAPI_HashString WinAPI_HiByte WinAPI_HideCaret WinAPI_HiDWord WinAPI_HiWord WinAPI_InflateRect WinAPI_InitMUILanguage WinAPI_InProcess WinAPI_IntersectClipRect WinAPI_IntersectRect WinAPI_IntToDWord WinAPI_IntToFloat WinAPI_InvalidateRect WinAPI_InvalidateRgn WinAPI_InvertANDBitmap WinAPI_InvertColor WinAPI_InvertRect WinAPI_InvertRgn WinAPI_IOCTL WinAPI_IsAlphaBitmap WinAPI_IsBadCodePtr WinAPI_IsBadReadPtr WinAPI_IsBadStringPtr WinAPI_IsBadWritePtr WinAPI_IsChild WinAPI_IsClassName WinAPI_IsDoorOpen WinAPI_IsElevated WinAPI_IsHungAppWindow WinAPI_IsIconic WinAPI_IsInternetConnected WinAPI_IsLoadKBLayout WinAPI_IsMemory WinAPI_IsNameInExpression WinAPI_IsNetworkAlive WinAPI_IsPathShared WinAPI_IsProcessInJob WinAPI_IsProcessorFeaturePresent WinAPI_IsRectEmpty WinAPI_IsThemeActive WinAPI_IsThemeBackgroundPartiallyTransparent WinAPI_IsThemePartDefined WinAPI_IsValidLocale WinAPI_IsWindow WinAPI_IsWindowEnabled WinAPI_IsWindowUnicode WinAPI_IsWindowVisible WinAPI_IsWow64Process WinAPI_IsWritable WinAPI_IsZoomed WinAPI_Keybd_Event WinAPI_KillTimer WinAPI_LineDDA WinAPI_LineTo WinAPI_LoadBitmap WinAPI_LoadCursor WinAPI_LoadCursorFromFile WinAPI_LoadIcon WinAPI_LoadIconMetric WinAPI_LoadIconWithScaleDown WinAPI_LoadImage WinAPI_LoadIndirectString WinAPI_LoadKeyboardLayout WinAPI_LoadLibrary WinAPI_LoadLibraryEx WinAPI_LoadMedia WinAPI_LoadResource WinAPI_LoadShell32Icon WinAPI_LoadString WinAPI_LoadStringEx WinAPI_LoByte WinAPI_LocalFree WinAPI_LockDevice WinAPI_LockFile WinAPI_LockResource WinAPI_LockWindowUpdate WinAPI_LockWorkStation WinAPI_LoDWord WinAPI_LongMid WinAPI_LookupIconIdFromDirectoryEx WinAPI_LoWord WinAPI_LPtoDP WinAPI_MAKELANGID WinAPI_MAKELCID WinAPI_MakeLong WinAPI_MakeQWord WinAPI_MakeWord WinAPI_MapViewOfFile WinAPI_MapVirtualKey WinAPI_MaskBlt WinAPI_MessageBeep WinAPI_MessageBoxCheck WinAPI_MessageBoxIndirect WinAPI_MirrorIcon WinAPI_ModifyWorldTransform WinAPI_MonitorFromPoint WinAPI_MonitorFromRect WinAPI_MonitorFromWindow WinAPI_Mouse_Event WinAPI_MoveFileEx WinAPI_MoveMemory WinAPI_MoveTo WinAPI_MoveToEx WinAPI_MoveWindow WinAPI_MsgBox WinAPI_MulDiv WinAPI_MultiByteToWideChar WinAPI_MultiByteToWideCharEx WinAPI_NtStatusToDosError WinAPI_OemToChar WinAPI_OffsetClipRgn WinAPI_OffsetPoints WinAPI_OffsetRect WinAPI_OffsetRgn WinAPI_OffsetWindowOrg WinAPI_OpenDesktop WinAPI_OpenFileById WinAPI_OpenFileDlg WinAPI_OpenFileMapping WinAPI_OpenIcon WinAPI_OpenInputDesktop WinAPI_OpenJobObject WinAPI_OpenMutex WinAPI_OpenProcess WinAPI_OpenProcessToken WinAPI_OpenSemaphore WinAPI_OpenThemeData WinAPI_OpenWindowStation WinAPI_PageSetupDlg WinAPI_PaintDesktop WinAPI_PaintRgn WinAPI_ParseURL WinAPI_ParseUserName WinAPI_PatBlt WinAPI_PathAddBackslash WinAPI_PathAddExtension WinAPI_PathAppend WinAPI_PathBuildRoot WinAPI_PathCanonicalize WinAPI_PathCommonPrefix WinAPI_PathCompactPath WinAPI_PathCompactPathEx WinAPI_PathCreateFromUrl WinAPI_PathFindExtension WinAPI_PathFindFileName WinAPI_PathFindNextComponent WinAPI_PathFindOnPath WinAPI_PathGetArgs WinAPI_PathGetCharType WinAPI_PathGetDriveNumber WinAPI_PathIsContentType WinAPI_PathIsDirectory WinAPI_PathIsDirectoryEmpty WinAPI_PathIsExe WinAPI_PathIsFileSpec WinAPI_PathIsLFNFileSpec WinAPI_PathIsRelative WinAPI_PathIsRoot WinAPI_PathIsSameRoot WinAPI_PathIsSystemFolder WinAPI_PathIsUNC WinAPI_PathIsUNCServer WinAPI_PathIsUNCServerShare WinAPI_PathMakeSystemFolder WinAPI_PathMatchSpec WinAPI_PathParseIconLocation WinAPI_PathRelativePathTo WinAPI_PathRemoveArgs WinAPI_PathRemoveBackslash WinAPI_PathRemoveExtension WinAPI_PathRemoveFileSpec WinAPI_PathRenameExtension WinAPI_PathSearchAndQualify WinAPI_PathSkipRoot WinAPI_PathStripPath WinAPI_PathStripToRoot WinAPI_PathToRegion WinAPI_PathUndecorate WinAPI_PathUnExpandEnvStrings WinAPI_PathUnmakeSystemFolder WinAPI_PathUnquoteSpaces WinAPI_PathYetAnotherMakeUniqueName WinAPI_PickIconDlg WinAPI_PlayEnhMetaFile WinAPI_PlaySound WinAPI_PlgBlt WinAPI_PointFromRect WinAPI_PolyBezier WinAPI_PolyBezierTo WinAPI_PolyDraw WinAPI_Polygon WinAPI_PostMessage WinAPI_PrimaryLangId WinAPI_PrintDlg WinAPI_PrintDlgEx WinAPI_PrintWindow WinAPI_ProgIDFromCLSID WinAPI_PtInRect WinAPI_PtInRectEx WinAPI_PtInRegion WinAPI_PtVisible WinAPI_QueryDosDevice WinAPI_QueryInformationJobObject WinAPI_QueryPerformanceCounter WinAPI_QueryPerformanceFrequency WinAPI_RadialGradientFill WinAPI_ReadDirectoryChanges WinAPI_ReadFile WinAPI_ReadProcessMemory WinAPI_Rectangle WinAPI_RectInRegion WinAPI_RectIsEmpty WinAPI_RectVisible WinAPI_RedrawWindow WinAPI_RegCloseKey WinAPI_RegConnectRegistry WinAPI_RegCopyTree WinAPI_RegCopyTreeEx WinAPI_RegCreateKey WinAPI_RegDeleteEmptyKey WinAPI_RegDeleteKey WinAPI_RegDeleteKeyValue WinAPI_RegDeleteTree WinAPI_RegDeleteTreeEx WinAPI_RegDeleteValue WinAPI_RegDisableReflectionKey WinAPI_RegDuplicateHKey WinAPI_RegEnableReflectionKey WinAPI_RegEnumKey WinAPI_RegEnumValue WinAPI_RegFlushKey WinAPI_RegisterApplicationRestart WinAPI_RegisterClass WinAPI_RegisterClassEx WinAPI_RegisterHotKey WinAPI_RegisterPowerSettingNotification WinAPI_RegisterRawInputDevices WinAPI_RegisterShellHookWindow WinAPI_RegisterWindowMessage WinAPI_RegLoadMUIString WinAPI_RegNotifyChangeKeyValue WinAPI_RegOpenKey WinAPI_RegQueryInfoKey WinAPI_RegQueryLastWriteTime WinAPI_RegQueryMultipleValues WinAPI_RegQueryReflectionKey WinAPI_RegQueryValue WinAPI_RegRestoreKey WinAPI_RegSaveKey WinAPI_RegSetValue WinAPI_ReleaseCapture WinAPI_ReleaseDC WinAPI_ReleaseMutex WinAPI_ReleaseSemaphore WinAPI_ReleaseStream WinAPI_RemoveClipboardFormatListener WinAPI_RemoveDirectory WinAPI_RemoveFontMemResourceEx WinAPI_RemoveFontResourceEx WinAPI_RemoveWindowSubclass WinAPI_ReOpenFile WinAPI_ReplaceFile WinAPI_ReplaceTextDlg WinAPI_ResetEvent WinAPI_RestartDlg WinAPI_RestoreDC WinAPI_RGB WinAPI_RotatePoints WinAPI_RoundRect WinAPI_SaveDC WinAPI_SaveFileDlg WinAPI_SaveHBITMAPToFile WinAPI_SaveHICONToFile WinAPI_ScaleWindowExt WinAPI_ScreenToClient WinAPI_SearchPath WinAPI_SelectClipPath WinAPI_SelectClipRgn WinAPI_SelectObject WinAPI_SendMessageTimeout WinAPI_SetActiveWindow WinAPI_SetArcDirection WinAPI_SetBitmapBits WinAPI_SetBitmapDimensionEx WinAPI_SetBkColor WinAPI_SetBkMode WinAPI_SetBoundsRect WinAPI_SetBrushOrg WinAPI_SetCapture WinAPI_SetCaretBlinkTime WinAPI_SetCaretPos WinAPI_SetClassLongEx WinAPI_SetColorAdjustment WinAPI_SetCompression WinAPI_SetCurrentDirectory WinAPI_SetCurrentProcessExplicitAppUserModelID WinAPI_SetCursor WinAPI_SetDCBrushColor WinAPI_SetDCPenColor WinAPI_SetDefaultPrinter WinAPI_SetDeviceGammaRamp WinAPI_SetDIBColorTable WinAPI_SetDIBits WinAPI_SetDIBitsToDevice WinAPI_SetDllDirectory WinAPI_SetEndOfFile WinAPI_SetEnhMetaFileBits WinAPI_SetErrorMode WinAPI_SetEvent WinAPI_SetFileAttributes WinAPI_SetFileInformationByHandleEx WinAPI_SetFilePointer WinAPI_SetFilePointerEx WinAPI_SetFileShortName WinAPI_SetFileValidData WinAPI_SetFocus WinAPI_SetFont WinAPI_SetForegroundWindow WinAPI_SetFRBuffer WinAPI_SetGraphicsMode WinAPI_SetHandleInformation WinAPI_SetInformationJobObject WinAPI_SetKeyboardLayout WinAPI_SetKeyboardState WinAPI_SetLastError WinAPI_SetLayeredWindowAttributes WinAPI_SetLocaleInfo WinAPI_SetMapMode WinAPI_SetMessageExtraInfo WinAPI_SetParent WinAPI_SetPixel WinAPI_SetPolyFillMode WinAPI_SetPriorityClass WinAPI_SetProcessAffinityMask WinAPI_SetProcessShutdownParameters WinAPI_SetProcessWindowStation WinAPI_SetRectRgn WinAPI_SetROP2 WinAPI_SetSearchPathMode WinAPI_SetStretchBltMode WinAPI_SetSysColors WinAPI_SetSystemCursor WinAPI_SetTextAlign WinAPI_SetTextCharacterExtra WinAPI_SetTextColor WinAPI_SetTextJustification WinAPI_SetThemeAppProperties WinAPI_SetThreadDesktop WinAPI_SetThreadErrorMode WinAPI_SetThreadExecutionState WinAPI_SetThreadLocale WinAPI_SetThreadUILanguage WinAPI_SetTimer WinAPI_SetUDFColorMode WinAPI_SetUserGeoID WinAPI_SetUserObjectInformation WinAPI_SetVolumeMountPoint WinAPI_SetWindowDisplayAffinity WinAPI_SetWindowExt WinAPI_SetWindowLong WinAPI_SetWindowOrg WinAPI_SetWindowPlacement WinAPI_SetWindowPos WinAPI_SetWindowRgn WinAPI_SetWindowsHookEx WinAPI_SetWindowSubclass WinAPI_SetWindowText WinAPI_SetWindowTheme WinAPI_SetWinEventHook WinAPI_SetWorldTransform WinAPI_SfcIsFileProtected WinAPI_SfcIsKeyProtected WinAPI_ShellAboutDlg WinAPI_ShellAddToRecentDocs WinAPI_ShellChangeNotify WinAPI_ShellChangeNotifyDeregister WinAPI_ShellChangeNotifyRegister WinAPI_ShellCreateDirectory WinAPI_ShellEmptyRecycleBin WinAPI_ShellExecute WinAPI_ShellExecuteEx WinAPI_ShellExtractAssociatedIcon WinAPI_ShellExtractIcon WinAPI_ShellFileOperation WinAPI_ShellFlushSFCache WinAPI_ShellGetFileInfo WinAPI_ShellGetIconOverlayIndex WinAPI_ShellGetImageList WinAPI_ShellGetKnownFolderIDList WinAPI_ShellGetKnownFolderPath WinAPI_ShellGetLocalizedName WinAPI_ShellGetPathFromIDList WinAPI_ShellGetSetFolderCustomSettings WinAPI_ShellGetSettings WinAPI_ShellGetSpecialFolderLocation WinAPI_ShellGetSpecialFolderPath WinAPI_ShellGetStockIconInfo WinAPI_ShellILCreateFromPath WinAPI_ShellNotifyIcon WinAPI_ShellNotifyIconGetRect WinAPI_ShellObjectProperties WinAPI_ShellOpenFolderAndSelectItems WinAPI_ShellOpenWithDlg WinAPI_ShellQueryRecycleBin WinAPI_ShellQueryUserNotificationState WinAPI_ShellRemoveLocalizedName WinAPI_ShellRestricted WinAPI_ShellSetKnownFolderPath WinAPI_ShellSetLocalizedName WinAPI_ShellSetSettings WinAPI_ShellStartNetConnectionDlg WinAPI_ShellUpdateImage WinAPI_ShellUserAuthenticationDlg WinAPI_ShellUserAuthenticationDlgEx WinAPI_ShortToWord WinAPI_ShowCaret WinAPI_ShowCursor WinAPI_ShowError WinAPI_ShowLastError WinAPI_ShowMsg WinAPI_ShowOwnedPopups WinAPI_ShowWindow WinAPI_ShutdownBlockReasonCreate WinAPI_ShutdownBlockReasonDestroy WinAPI_ShutdownBlockReasonQuery WinAPI_SizeOfResource WinAPI_StretchBlt WinAPI_StretchDIBits WinAPI_StrFormatByteSize WinAPI_StrFormatByteSizeEx WinAPI_StrFormatKBSize WinAPI_StrFromTimeInterval WinAPI_StringFromGUID WinAPI_StringLenA WinAPI_StringLenW WinAPI_StrLen WinAPI_StrokeAndFillPath WinAPI_StrokePath WinAPI_StructToArray WinAPI_SubLangId WinAPI_SubtractRect WinAPI_SwapDWord WinAPI_SwapQWord WinAPI_SwapWord WinAPI_SwitchColor WinAPI_SwitchDesktop WinAPI_SwitchToThisWindow WinAPI_SystemParametersInfo WinAPI_TabbedTextOut WinAPI_TerminateJobObject WinAPI_TerminateProcess WinAPI_TextOut WinAPI_TileWindows WinAPI_TrackMouseEvent WinAPI_TransparentBlt WinAPI_TwipsPerPixelX WinAPI_TwipsPerPixelY WinAPI_UnhookWindowsHookEx WinAPI_UnhookWinEvent WinAPI_UnionRect WinAPI_UnionStruct WinAPI_UniqueHardwareID WinAPI_UnloadKeyboardLayout WinAPI_UnlockFile WinAPI_UnmapViewOfFile WinAPI_UnregisterApplicationRestart WinAPI_UnregisterClass WinAPI_UnregisterHotKey WinAPI_UnregisterPowerSettingNotification WinAPI_UpdateLayeredWindow WinAPI_UpdateLayeredWindowEx WinAPI_UpdateLayeredWindowIndirect WinAPI_UpdateResource WinAPI_UpdateWindow WinAPI_UrlApplyScheme WinAPI_UrlCanonicalize WinAPI_UrlCombine WinAPI_UrlCompare WinAPI_UrlCreateFromPath WinAPI_UrlFixup WinAPI_UrlGetPart WinAPI_UrlHash WinAPI_UrlIs WinAPI_UserHandleGrantAccess WinAPI_ValidateRect WinAPI_ValidateRgn WinAPI_VerQueryRoot WinAPI_VerQueryValue WinAPI_VerQueryValueEx WinAPI_WaitForInputIdle WinAPI_WaitForMultipleObjects WinAPI_WaitForSingleObject WinAPI_WideCharToMultiByte WinAPI_WidenPath WinAPI_WindowFromDC WinAPI_WindowFromPoint WinAPI_WordToShort WinAPI_Wow64EnableWow64FsRedirection WinAPI_WriteConsole WinAPI_WriteFile WinAPI_WriteProcessMemory WinAPI_ZeroMemory WinNet_AddConnection WinNet_AddConnection2 WinNet_AddConnection3 WinNet_CancelConnection WinNet_CancelConnection2 WinNet_CloseEnum WinNet_ConnectionDialog WinNet_ConnectionDialog1 WinNet_DisconnectDialog WinNet_DisconnectDialog1 WinNet_EnumResource WinNet_GetConnection WinNet_GetConnectionPerformance WinNet_GetLastError WinNet_GetNetworkInformation WinNet_GetProviderName WinNet_GetResourceInformation WinNet_GetResourceParent WinNet_GetUniversalName WinNet_GetUser WinNet_OpenEnum WinNet_RestoreConnection WinNet_UseConnection Word_Create Word_DocAdd Word_DocAttach Word_DocClose Word_DocExport Word_DocFind Word_DocFindReplace Word_DocGet Word_DocLinkAdd Word_DocLinkGet Word_DocOpen Word_DocPictureAdd Word_DocPrint Word_DocRangeSet Word_DocSave Word_DocSaveAs Word_DocTableRead Word_DocTableWrite Word_Quit",I={
v:[e.C(";","$",{r:0}),e.C("#cs","#ce"),e.C("#comments-start","#comments-end")]},n={b:"\\$[A-z0-9_]+"},l={cN:"string",v:[{b:/"/,e:/"/,c:[{b:/""/,r:0}]},{b:/'/,e:/'/,c:[{b:/''/,r:0}]}]},o={v:[e.BNM,e.CNM]},a={cN:"meta",b:"#",e:"$",k:{"meta-keyword":"include include-once NoTrayIcon OnAutoItStartRegister RequireAdmin pragma Au3Stripper_Ignore_Funcs Au3Stripper_Ignore_Variables Au3Stripper_Off Au3Stripper_On Au3Stripper_Parameters AutoIt3Wrapper_Add_Constants AutoIt3Wrapper_Au3Check_Parameters AutoIt3Wrapper_Au3Check_Stop_OnWarning AutoIt3Wrapper_Aut2Exe AutoIt3Wrapper_AutoIt3 AutoIt3Wrapper_AutoIt3Dir AutoIt3Wrapper_Change2CUI AutoIt3Wrapper_Compile_Both AutoIt3Wrapper_Compression AutoIt3Wrapper_EndIf AutoIt3Wrapper_Icon AutoIt3Wrapper_If_Compile AutoIt3Wrapper_If_Run AutoIt3Wrapper_Jump_To_First_Error AutoIt3Wrapper_OutFile AutoIt3Wrapper_OutFile_Type AutoIt3Wrapper_OutFile_X64 AutoIt3Wrapper_PlugIn_Funcs AutoIt3Wrapper_Res_Comment Autoit3Wrapper_Res_Compatibility AutoIt3Wrapper_Res_Description AutoIt3Wrapper_Res_Field AutoIt3Wrapper_Res_File_Add AutoIt3Wrapper_Res_FileVersion AutoIt3Wrapper_Res_FileVersion_AutoIncrement AutoIt3Wrapper_Res_Icon_Add AutoIt3Wrapper_Res_Language AutoIt3Wrapper_Res_LegalCopyright AutoIt3Wrapper_Res_ProductVersion AutoIt3Wrapper_Res_requestedExecutionLevel AutoIt3Wrapper_Res_SaveSource AutoIt3Wrapper_Run_After AutoIt3Wrapper_Run_Au3Check AutoIt3Wrapper_Run_Au3Stripper AutoIt3Wrapper_Run_Before AutoIt3Wrapper_Run_Debug_Mode AutoIt3Wrapper_Run_SciTE_Minimized AutoIt3Wrapper_Run_SciTE_OutputPane_Minimized AutoIt3Wrapper_Run_Tidy AutoIt3Wrapper_ShowProgress AutoIt3Wrapper_Testing AutoIt3Wrapper_Tidy_Stop_OnError AutoIt3Wrapper_UPX_Parameters AutoIt3Wrapper_UseUPX AutoIt3Wrapper_UseX64 AutoIt3Wrapper_Version AutoIt3Wrapper_Versioning AutoIt3Wrapper_Versioning_Parameters Tidy_Off Tidy_On Tidy_Parameters EndRegion Region"},c:[{b:/\\\n/,r:0},{bK:"include",k:{"meta-keyword":"include"},e:"$",c:[l,{cN:"meta-string",v:[{b:"<",e:">"},{b:/"/,e:/"/,c:[{b:/""/,r:0}]},{b:/'/,e:/'/,c:[{b:/''/,r:0}]}]}]},l,I]},_={cN:"symbol",b:"@[A-z0-9_]+"},G={cN:"function",bK:"Func",e:"$",i:"\\$|\\[|%",c:[e.UTM,{cN:"params",b:"\\(",e:"\\)",c:[n,l,o]}]};return{cI:!0,i:/\/\*/,k:{keyword:t,built_in:i,literal:r},c:[I,n,l,o,a,_,G]}});hljs.registerLanguage("r",function(e){var r="([a-zA-Z]|\\.[a-zA-Z.])[a-zA-Z0-9._]*";return{c:[e.HCM,{b:r,l:r,k:{keyword:"function if in break next repeat else for return switch while try tryCatch stop warning require library attach detach source setMethod setGeneric setGroupGeneric setClass ...",literal:"NULL NA TRUE FALSE T F Inf NaN NA_integer_|10 NA_real_|10 NA_character_|10 NA_complex_|10"},r:0},{cN:"number",b:"0[xX][0-9a-fA-F]+[Li]?\\b",r:0},{cN:"number",b:"\\d+(?:[eE][+\\-]?\\d*)?L\\b",r:0},{cN:"number",b:"\\d+\\.(?!\\d)(?:i\\b)?",r:0},{cN:"number",b:"\\d+(?:\\.\\d*)?(?:[eE][+\\-]?\\d*)?i?\\b",r:0},{cN:"number",b:"\\.\\d+(?:[eE][+\\-]?\\d*)?i?\\b",r:0},{b:"`",e:"`",r:0},{cN:"string",c:[e.BE],v:[{b:'"',e:'"'},{b:"'",e:"'"}]}]}});



OEBPS/Common_Content/images/title_logo.png
& RedHat





OEBPS/images/Info.png





OEBPS/Common_Content/images/7.png





OEBPS/images/496.png
Permission 1

Permission 2

Permission 3

Permission 4

Permission 5

Permission 2

Permission 4

Permission 5

RHV_453537_0219





OEBPS/Common_Content/images/warning.png





OEBPS/images/UserManagerRole.png
New Role x

Name Description

UserManager

Account Type:

Check Boxes to Allow Action

Expand All | Collapse All
¥ Usystem

v Cconfigure System

[(MManipulate Users

[MManipulate Permissions

([Cladd users and groups from directory while adding permissions
[(MManipulate Roles

(Chogin Permissions

(Chrag management Permissions

[rnnkmark manasement Parmissions





OEBPS/images/Dashboard_Storage_Utilization.png
Storage Utilization

Storage

Woo0s M7S90% [ 6sTS%  <65%






OEBPS/Common_Content/fonts/redhat/text/RedHatText-Medium.woff


OEBPS/Common_Content/images/important.png





OEBPS/Common_Content/images/35.png





OEBPS/images/out-of-sync-setup.png





OEBPS/Common_Content/images/19.png





OEBPS/images/Dashboard_No_Items.png





OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-Bold.woff


OEBPS/images/Dashboard_Up.png





OEBPS/Common_Content/images/10.png





OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-Regular.woff


OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-MediumItalic.woff


OEBPS/Common_Content/images/2.png





OEBPS/Common_Content/scripts/highlight.js/LICENSE
Copyright (c) 2006, Ivan Sagalaev
All rights reserved.
Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright
      notice, this list of conditions and the following disclaimer.
    * Redistributions in binary form must reproduce the above copyright
      notice, this list of conditions and the following disclaimer in the
      documentation and/or other materials provided with the distribution.
    * Neither the name of highlight.js nor the names of its contributors 
      may be used to endorse or promote products derived from this software 
      without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE REGENTS AND CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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OEBPS/Common_Content/scripts/utils.js
var work = 1;

function pop(entity) {
	if(entity) {
		var my_parent = entity.parentNode;
		var my_class = my_parent.className;
		my_parent.className = my_class.replace(/popper/,"popped");
	}
}
function unpop(entity) {
	if(entity) {
		var my_parent = entity.parentNode;
		var my_class = my_parent.className;
		my_parent.className = my_class.replace(/popped/,"popper");
	}
}

function siblings(entity){
	var r = [];
	for ( var n = entity.parentNode.firstChild; n; n = n.nextSibling ) 
		if ( n.nodeType == 1 && n != entity)
			r.push( n );		
	return r;
}

/* This activates an element and deactivates all it's siblings */
function activateElement(id) {
	var entity = document.getElementById(id);
	if(entity.className.indexOf("active") == -1) {
		entity.className = entity.className + " active";
	}
	var sibs = siblings(entity);

	for(var i=0; i < sibs.length; i++) {
		if(sibs[i].className.indexOf("active") != -1) {
			deactivateElement(sibs[i]);
		}
	}
}

function deactivateElement(entity) {
	if(entity.className.indexOf("active") != -1) {
		 entity.className = entity.className.replace(/[ ]*active/, '');
	}
}

function getCookie(name) {
	var name_c = window.location.hostname + '-' + name;

	if(document.cookie) {
		var cookies = document.cookie.split(/ *; */);
		for(var i=0; i < cookies.length; i++) {
			var current_c = cookies[i].split("=");
			if(current_c[0] == name_c) {
				return(current_c[1]);
				break;
			}
		}
	}
	return('');
}

function setCookie(name, value, expires, path) {
	name = window.location.hostname + '-' + name;

	var curCookie = name + "=" + value + 
		((expires) ? ";expires=" + expires.toGMTString() : "") + 
		((path) ? ";path=" + path : "");
	document.cookie = curCookie; 
}

function setDefLangCookie(entity) {
	setCookie('switchery', entity.options[entity.selectedIndex].value, '', '/');
}

function initSwitchery() {
	var divs = document.getElementsByTagName('div');
	for(i in divs) {
		if(typeof(divs[i].className) != 'undefined' && divs[i].className.indexOf("switchery") != -1) {
			var lang = getCookie('switchery');
			if(lang != '') {
				var entity = document.getElementById(divs[i].id + '-' + lang);
				if(entity) {
					entity.onclick();
					entity.parentNode.lastChild.value = lang;
				} else {
					divs[i].firstChild.firstChild.onclick();
				}
			} else {
				divs[i].firstChild.firstChild.onclick();
			}
		}
	}

}

function showhide(id) {
	if(work) {
		work = 0;
		var entity = document.getElementById(id);
		if(entity) {
			var my_class = entity.className;
			if(my_class.indexOf("hidden") != -1) {
				entity.className = my_class.replace(/hidden/,"visible");
			}
			else if(my_class.indexOf("visible") != -1) {
				entity.className = my_class.replace(/visible/,"hidden");
			}
		}
	}

	return false;
}

function hide(id) {
	if(work) {
		work = 0;
		var entity = document.getElementById(id);
		if(entity) {
			var my_class = entity.className;
			if(my_class.indexOf("visible") != -1) {
				entity.className = my_class.replace(/visible/,"hidden");
			}
		}
	} else {
		work=1;
	}
}

var preventReset = 0;

function dehighlightTarget(entity) {
	if(preventReset == 0 && entity) {
		var id = entity.href;
		if(id.indexOf("#") != -1) {
			id = id.substr(id.indexOf('#')+1);
		}
		var target = document.getElementById(id);
		if(target) {
			deactivateElement(target);
		}
		}
}

function highlightTarget(entity, norefresh) {
	if(entity) {
		var id = entity.href;
		if(id.indexOf("#") != -1) {
			id = id.substr(id.indexOf('#')+1);
		}
		activateElement(id);
		preventReset = 0;
	} 
	if(norefresh == 1) {
		preventReset=1;
	}
}
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